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System Training 

A well-trained workforce is critical to the success of your operation. Knowing how to 
correctly install, configure, program, calibrate, and trouble-shoot your Emerson equipment 
provides your engineers and technicians with the skills and confidence to optimize your 
investment. Energy and Transportation Solutions offers a variety of ways for your personnel 
to acquire essential system expertise. Our full-time professional instructors can conduct 
classroom training at several of our corporate offices, at your site, or even at your regional 
Emerson office. You can also receive the same quality training via our live, interactive 
Emerson Virtual Classroom and save on travel costs. For our complete schedule and further 
information, contact the Energy and Transportation Solutions Training Department at 800-
338-8158 or e-mail us at Education@Emerson.com. 
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Chapter 1 – Introduction 
In This Chapter 

1.1 Configuration Updates .............................................................. 1-1 
1.2 Scope of Manual...................................................................... 1-2 
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1.4 Installing Config600.................................................................. 1-5 
1.5 Accessing Conf ig600 ................................................................ 1-8 
1.6 Activating Config600 ................................................................ 1-9 
1.7 Additional Technical Information............................................... 1-11 
 
This manual describes how to use the Config600™ configuration 
software suite of editors (referred to as “Config600”) to configure the 
FloBoss™ S600+ Flow Computer (referred to as “S600+”). The 
software runs on a personal computer (PC) running Microsoft® 
Windows® 7 Professional (32-bit or 64-bit) or Windows® 10 (32-bit or 
64-bit). Refer to the technical specification Config600™ Configuration 
Software (Config600).  
This manual discusses configuring S600+ options, including 
calculations; input/output (I/O); communications; Proportional, 
Integral, and Derivative (PID) loops; stations; streams; displays; 
Modbus maps; LogiCalc programming; and reports.  

Use this manual in conjunction with the FloBoss S600+ Flow Manager 
Instruction Manual (part D301150X412). 

 Caution When implementing control using this product, observe best industry 
practices as suggested by applicable and appropriate environmental, 
health, and safety organizations.  

This chapter details the structure of this manual and provides an 
overview of the Config600 software.  

1.1 Configuration Updates 
The S600+ CPU module has also been enhanced and now contains an 
upgraded version of firmware. You can download existing 
configurations from earlier versions of Config600 without change. 
However, if you use the latest version of Config600 to modify an old 
configuration, the configuration file upgrades and will work only with 
version 8 and above. That means you can no longer use old versions of 
Config600 to edit that configuration.  
When you open an older configuration in the current version of 
Config600, the following dialog box displays:  
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Figure 1-1. Config Upgrade dialog 

If you click OK to upgrade, you cannot then use this configuration on 
an S600+ which has firmware less that version 06.07. If you need to 
use this configuration on older S600+ flow computers, click Close ( ) 
to end this process. We suggest you then re-create this configuration 
using the most current version of Config600 or create a copy of the old 
configuration.  

1.2 Scope of Manual 
This manual contains the following chapters:  
Chapter Description 
Chapter 1 
Introduction 

Defines the scope of the document, provides an 
overview of the Config600 software, and details how to 
install the software.  

Chapter 2 
PCSetup Editor  

Describes the PCSetup Editor interface, the 
configuration generator, how to save configurations, 
and the System Graphic utility.  

Chapter 3 
System Setup 
Configuration  

Describes the System Setup screens (Versions, Units, 
Reports, and Totalisation) in the PCSetup Editor, and 
the configuration wizard.  

Chapter 4 
I/O and Comms 
Configuration  

Describes the Input/Output (I/O) assignment screens, 
the PID loop settings screens, and the communication 
task settings screen in the PCSetup Editor. 

Chapter 5 
Station Configuration  

Describes the Station Settings screens in the PCSetup 
Editor. 

Chapter 6 
Stream Configuration  

Describes the Stream Settings screens in the PCSetup 
Editor. 

Chapter 7 
Advanced Setup 
Configuration  

Describes the Advanced Setup screens (Conversions, 
Totals Descriptors, Alarms, Security, and 
Displays/Webserver) in the PCSetup Editor and the 
Calc Explorer utility. 

Chapter 8 
System Editor  

Describes the advanced configuration editor, the 
System Editor (which includes Station Mapping).  
Note: This utility is available only with Config600 Pro. 

Chapter 9  
Config Transfer  

Describes the configuration transfer utility. Use this 
utility to send new or modified files to the S600+ over 
either a dedicated serial port or a TCP/IP connection. 
Config Transfer also enables you to retrieve 
configuration files from the host PC to the S600+. 

PRO 
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Chapter Description 
Chapter 10 
Remote Front Panel 
 

Describes how to set up the Remote Front Panel to 
configure your S600+ and perform certain functions 
f rom your PC.  
Note: The Remote Front Panel requires part 

S600+EXT (the licence key for Remote Front 
Panel)  

Chapter 11 
Remote Archive 
Uploader 

Describes how to automatically upload all reports and 
alarms in the historical archive in the S600+ flow 
computer.  

Chapter 12 
Report Editor  Describes the report format editor.  

Chapter 13 
Display Editor  

Describes the editor you use to customize the front 
panel and webserver displays of the S600+.  

Chapter 14 
Modbus Editor  Describes the Modbus map editor.  

Chapter 15 
LogiCalc Editor  

Describes the editing tool for the LogiCalc programming 
language.  
Note: This tool is available only with Config600 Pro.  

Appendix A: Glossary Provides definitions of acronyms and terms. 
Appendix B: Proving Provides a description of the three proving methods 

Confi600 supports: bi-directional (and uni-directional), 
compact, and master meter.  

Appendix C: Batching Describes the type of batch method you can use for 
non-permanent flows or “start-stop” batching.  

Appendix D: Field 
Calibration 

Describes hardware calibration you perform after 
production to determine the relationship between 
analogue converter counts and current.  

Appendix E: S600+ 
Database Objects and 
Fields  

Provides an alphabetic listing of the database objects 
you can access through the Connect Wizard (which is 
part of the Report Editor, Modbus Editor, LogiCalc 
Editor, Display Editor, and System Editor).   

Appendix F: Peer-to-
Peer Communications 

Describes the bi-directional communications link 
between the A and B computers allowing the duty 
S600+ to update the standby S600+ with any operator 
changes made locally at the duty S600+ keypad or 
through the supervisory system.  

Appendix G: Firewall  Provides information detailing the S600+ firewall to 
keep out unwanted incoming network connections.  

Appendix H: CFX Provides information on creating Common File 
eXchange (CFX) reports.  

Appendix I: Network 
Printing 

Provides information on network printing options for the 
S600+. 

Index Provides an alphabetic listing of items and topics 
contained in this manual.  

1.3 Software Basics 
Config600 software is a Microsoft Windows-based suite of tools that 
enables you to configure and communicate with the S600+ using a host 
PC.  The software has three versions:  
 Config600 Lite, which provides a basic set of tools designed to 

help you modify existing configurations.   
 Config600 Lite Plus, which adds a tool to create configurations to 

Config600 Lite.  

PRO 
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 Config600 Pro, which provides a more powerful set of tools to 
help you create and manage configurations.   

Note: If you are new to the S600+, review Chapter 2, PCSetup 
Editor. This section describes the basic steps involved in 
configuring your S600+ for your application. You can then use 
the PCSetup Editor (available in Config600 Pro) to edit 
existing configurations.  

Table 1-1 compares the tools available in each version.  

Table 1-1. Config600 Tools  
Tool Config600 Lite Config600 Lite Plus Config600 Pro 
PCSetup  X X X 
Config Transfer  X X X 
Report Editor X X X 
Modbus Editor X X X 
Display Editor X X X 
LogiCalc Editor    X 
System Editor   X 
Config Generator  X X 
Remote Archive Uploader1 X X X 
Remote Front Panel1 X X X 
Version History X X X 

 
1Remote Archive Uploader and Remote Front Panel are extended functions of Config600 which you must 
license separately to use. Contact your sales representative for further information.  

 
Using the PCSetup Editor in Config600, you define the initial S600+ 
configuration settings for gas, liquid, or prover applications.  These 
initial configurations include system setup, Input/Output (I/O) setup, 
stations, and streams. You save these configurations to a configuration 
folder on the host PC. Using the Config Transfer utility, you send 
(“download”) the configuration to the S600+ through a serial or 
Ethernet communications port. The download also stores the sent 
configuration permanently in the S600+’s memory.  

With Config600 Pro software, you can:  
 Use the Config Generator Wizard to create new configurations.  
 Use the Config Transfer utility to send or receive the 

configuration to the S600+ through a serial or Ethernet 
communications port. The exchange also stores the send 
configuration permanently in the S600+’s memory.  

 Use the Display Editor to configure front panel/webserver 
displays.  

 Use the LogiCalc Editor to configure LogiCalc applications.  
 Use the Modbus Editor to configure Modbus communications.  
 Use the PCSetup Editor to define the initial S600+ configuration 

settings for gas, liquid, or prover applications. These initial 
configurations include system setup, Input/Output setup, stations, 
and streams. You save these configurations to a configuration 
directory on the host PC.  
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 Use the Remote Archive Uploader to automatically upload all 
reports in the historical archive in the S600+ and manually upload 
other types of files.  

 Use the Remote Front Panel to configure the S600+ to run from 
the PC.  

 Use the Report Editor to generate system reports.  
 Use the System Editor to configure the S600+ database.  
 Use the Version History text file to view a change history 

document that explains changes and updates to the Config600 and 
S600+.  

Note: To get help on a specific screen, press F1 or click Help. You 
can also modify the size of the Config600 editor window by 
clicking and dragging the lower right corner of the window. 
When configuration panes have scroll bars, modify the window 
size to make sure you can view all the configuration settings.  

1.4 Installing Config600  
Remote Automation Solutions distributes Config600 software either on 
a CD-ROM or as a downloadable zipped file. You can install 
Config600 software on a PC running Microsoft® Windows® 7 
Professional (32-bit or 64-bit) or Windows® 10 (32-bit or 64-bit). 

Note: Refer to the product data sheets S600+ and Config600 
(available https://www.emerson.com/en-us/catalog/emerson-
floboss-s600) for complete product requirements and 
specifications.   

To install Config600:   

1. Place the Config600 installation CD-ROM in your PC’s CD or 
DVD drive. The installation should begin automatically.  

2. If the CD-ROM does not run automatically, click Start > Run. 
When the Run dialog box opens, click Browse, navigate to the CD-
ROM drive, and select setup.exe. Click Open. The system 
completes the file location. Click OK in the Run dialog box.   

Note: If you are using a zipped executable file, download the file 
to a temporary location (the installation program installs the 
file in (C:\Users\<<USERNAME>>\Config600 3.4). Unzip 
the file and click setup.exe.   

The Installation Wizard screen displays, and determines whether 
you have previously installed Config600.  

3. If this is a new installation, the Config600 Welcome screen 
displays, followed by a License Agreement screen.  
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Figure 1-2. License Agreement 

4. Review the license agreement and click I Agree to continue. A 
Choose Components screen displays. 

 

Figure 1-3. Choose Components 

Note: Config600 Pro activation codes/licences are issued only to 
those who successfully complete the RA901 Advanced 
Config600 training course. 

5. Select to install the version of Config600 you have purchased and 
click Next. The installation wizard identifies the default destination 
folder (C:\Users\<<USERNAME>>\Config600 3.4).   
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Note: Attendance at the Config600 Pro training class is required 
to use Config600 Pro.   

 

Figure 1-4. Install Location 

6. Click Browse to select an alternative installation folder.  

7. Click Install. As the installation proceeds, the installation wizard 
displays a screen showing the progress of the installation.   

 

Figure 1-5. Installation Progress 

8. When the installation completes, the wizard displays a completion 
screen.   
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Figure 1-6. Installation Complete 

9. Click Close to end the installation. 

Note: You may need to restart your PC to complete the 
installation.  

1.5 Accessing Config600  

 

After you successfully install the Config600 software, you can access 
the application suite either of two ways.  

 
 Create application–specific shortcut icons your desktop. 
 Select Start > All Programs > Config600 3.4 and select an 

application from the menu.  

Note: If you have installed the Lite or Lite Plus version, that 
option appears in the selection menu.  
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Figure 1-7. Config600 Menu 

Which method you choose depends on personal preference. Proceed to 
Chapter 2, PCSetup Editor, for further information on the PCSetup 
utility.   

1.6 Activating Config600  
After you successfully install the software, you must next activate it.  

The activation screen (see Figure 1-8) displays when you attempt to 
open any of the Config600 component tools: 

Note:  

 Remote Archive Uploader can be used for a 30-day trial period 
after which an activation license must be obtained.  

 There is no trial period available for Lite / Lite+ / Pro – an 
activation license must be obtained before use. 
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Figure 1-8. Config600 Activation Screen 

Click Email Codes to send a request to 
CST.ETSEurope@Emerson.com for an activation code. The email 
automatically captures your Site Code and Machine ID.  

Note: Each installation of Config600 is unique. Each copy of 
Config600 you install requires its own activation code.   

Once you obtain an activation code, select Unlock application, enter 
the code in the Activation Code field, and click Continue. The 
Config600 utility you select opens.   

Note: Config600 Pro activation codes/licences are issued only to 
those who successfully complete the RA901 Advanced 
Config600 training course. 

Re-installing 
 Config600 

If you need to move your copy of Config600 to a new PC, un-install 
the software using PCSetup. The process generates a code you send to 
CST.ETSEurope@Emerson.com. You still need to provide the unique 
site code and machine ID.  
Use the authorization code you receive in return to re-activate 
Config600.  
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Changing the  
PC Clock 

If you manually reset the clock on your PC, it is possible that 
Config600 may stop working and require you to re-authorize the 
software. This is not a problem if you allow the PC software to 
automatically accommodate changes for daylight saving time.  

1.7 Additional Technical Information  
Refer to the following technical documentation (available at 
www.Emerson.com/EnergyandTransportation) for additional and 
most-current information.   

Table 1-2. Additional Technical Information  
 

Document Name Form Number Part Number 
FloBoss™ S600+ Flow Computer Instruction Manual  A6115 D301150X412 
FloBoss™ S600+ Flow Computer Product Data Sheet  S600+ D301151X012 
Conf ig600™ Configuration Software Product Data Sheet  Conf ig600 D301164X012 
FloBoss™ S600+ Field Upgrade Guide  A6299 D301668X412 
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Chapter 2 – PCSetup Editor 
In This Chapter 
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When you start Config600 Pro, the Welcome to Config600 screen 
displays (see Figure 2-1). Using this screen, you can create a new 
S600+ configuration, open an existing configuration, transfer data 
between a PC and the S600+, access on-line help, or control whether 
the Welcome screen displays when you start the software.  

 

Figure 2-1. Config600 Welcome 

2.1 Create a New Configuration 
The Configuration Wizard provides several ways for you to create a 
new configuration:  
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 Click the New icon on the PCSetup Editor’s toolbar.  
 Click Start > All Programs > Config600 3.3 > Config 

Generator. 
 Click the icon next to the Create a new configuration option 

from the PCSetup Editor’s Welcome to Config600 Screen (View > 
Startup Screen).  

Note: You can also start the Configuration Generator by selecting 
File > New from the PCSetup screen. The Configuration 
Generator is included in both the Config600 Pro and Config600 
Lite Plus software suites.  

The Configuration Generator is a wizard-based software assistant that 
asks a series of questions to simplify the six-step process of creating a 
new S600+ configuration file. The wizard also validates your 
selections to prevent errors. Once you finish, the wizard saves the 
configuration settings to a file. You can modify the configuration and 
then send the configuration to the S600+.  

2.1.1 Name the Configuration (Step 1 of 6) 

Note: All screens in this section are examples intended to show all 
possible options and do not represent actual configurations.   

Use the first screen in the wizard (Figure 2-2) to provide a name and 
brief description for the configuration file.  

 

Figure 2-2. Configuration Generator, Step 1 

1. Enter a name for the configuration. Keep the name short (up to 20 
alphanumeric characters) for easy identification.  
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Note: This step is mandatory.  

2. Enter a description for the configuration. 

Note: The Configuration Generator displays the name you give 
the file on the running configuration. This optional 
description is for your information only.  

3. Click Next.  

2.1.2 Select Measurement Units (Step 2 of 6) 
Use the second screen in the wizard (Figure 2-3) to set the units of 
measurement for the configuration.    

 

Figure 2-3. Configuration Generator, Step 2 

1. Select the units of measurement the S600+ uses. Valid values are 
Metric or Imperial. The default is Metric. Click  to display 
more values.  

 

 Caution This choice affects how Config600 handles a number of options, 
including the default ADC and PRT modes, maintenance mode 
interlock, alarm latch mode, and others. 

 

Note: You can modify this initial setting after you complete the 
wizard.  

2. Click Next.  
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2.1.3 Specify Modules (Step 3 of 6) 
Use the third screen in the wizard (Figure 2-4) to indicate the number 
of I/O, optional HART, and optional prover modules installed in the 
S600+ for this configuration.    

 

Figure 2-4. Configuration Generator, Step 3 

1. Click  and  to indicate the number and kinds of modules 
physically installed in the S600+. The S600+ chassis can house up 
to three modules:  
Module Description 
I/O Module (P144) Each I/O module can handle up to two streams 

and include both analog and digital I/O. 
Note: You must include at least one I/O 

module in each configuration.  
HART Module (P188) This module enables the S600+ to 

communicate with HART® devices using the 
HART protocol. Each HART module has 12 
channels, and each channel can accept up to 
eight devices. However, you cannot have more 
than 50 devices attached to any one HART 
module. 

Prover Module 
(P154) 

The Prover module provides the functions 
required for liquid prover applications. It is 
mandatory if you select a prover as part of this 
configuration.  
Note: You can include only one Prover module 

in any configuration. 
 
2. Click Next.  
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2.1.4 Specify Stations (Step 4 of 6) 
Use the fourth screen in the wizard (Figure 2-5) to indicate the number 
(up to two) and type (gas or liquid) of stations in the configuration. The 
wizard defaults to one gas station.   

You can define a maximum of two provers (ball, compact, or master 
meter), one for each station.   

 

Figure 2-5. Configuration Generator, Step 4 

1. Indicate the number of stations (to a maximum of two) for this 
configuration. Click  or  to add or delete stations.  

2. Indicate whether the station handles Gas or Liquid. Click  to 
display additional values. The default value is Gas.   

3. Click Options to display a list of default values for each type of 
station. The station options for gas and liquid differ.  

Note: As you modify these options, Config600 displays a 
summary of the options you select.   
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Figure 2-6. Gas Station Options Summary 

 For a Gas station, select the appropriate options. Config600 
initially highlights default values.  
Option  Description 
Densitometer/ 
No Densitometer 

Performs calculations using densitometer input at 
the station. 

Single Chromat/ 
Dual Chromat/ 
No Chromat 

Performs calculations using chromatograph 
input(s) at the station. 

MM Prover/ 
No Prover 

Uses a Master Meter Prover. 
Note:   
 This option requires an associated metering 

stream. 
 Only MM volume v Stream volume is 

supported. 
Batching/ 
No Batching 

Performs station batch handling. Enable batch 
reports and totals. 

Flow Switching/ 
No Flow Switching 

Balances the station flow by opening and closing 
streams. 

Sampling/ 
No Sampling 

Performs single or twin can sampling. 

 
Note: As you select options, the Additional Options Selected 

frame (at bottom of the Options screen) summarizes your 
selections (see Figure 2-7).   

Summary of 
selected options 
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Figure 2-7. Gas Station Options Summarized 

 For a Liquid station, select the appropriate options. Config600 
initially highlights default values.   

  

 
Figure 2-8. Liquid Station Options Summary screens 

 

Summary 
of selected 
options 
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Option  Description 
Option1 Performs no liquid volume calculations at the 

station. Station standard density is available as a 
keypad input. 

Option2 Measures header density but performs no liquid 
volume calculations at the station.  

Option3 Calculates station standard density using header 
density with header temperature and pressure at 
all station inputs. 

Ball Prover Uses a bi-directional or uni-directional prover.  
Note:  Ball provers are also known as “pipe 

provers.”   
Compact Prover  Uses a Daniels®  Compact Prover™   
MM Prover Uses a master meter prover.  

Note: 
 This option requires an associated metering 

stream.  
 The following combinations are supported: 

MM volume v Stream volume, MM volume v 
Stream Mass and MM Mass v Stream Mass. 

No Prover Indicates this station does not perform prover 
runs.  

Batching  
No Batching 

Indicates if the station performs batch handling. 
Enable batch reports and totals. 

Flow Switching  
No Flow Switching  

Indicates if the station balances station flow by 
opening and closing streams. 

Sampling  
No Sampling 

Indicates if the station performs no sampling or 
twin can sampling. 

Product Table 
No Product Table 

Permits multiple product selection for pipeline 
batching applications. Select No Product Table 
to use a single product for continuous flow 
metering.  

 
Note: As you select options, the graphic in the screen changes and 

the Additional Options Selected frame (at the bottom of the 
Options screen) summarizes your selections.   

4. Click Additionals to include any optional calculations in the 
configuration. Config600 opens a text box you use to record the 
additional calculations.   

5. Click OK when you finish adding optional calculations.   

6. Click Next.  

2.1.5 Define Streams (Step 5 of 6) 
Use the fifth screen in the wizard (Figure 2-9) to associate streams 
and stations. You indicate the number of streams, the type of 
stream (gas, liquid, or RTU), link the stream to a station, and select 
stream options.    
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Notes: 
 For station summation of stream flowrates to work correctly, all 

stations must have at least one stream configured. 
 Although you can define up to 10 streams, a standard S600+ 

chassis can hold only three I/O modules. Each I/O module only 
has two dual-pulse inputs (2 turbines), so a standard S600+ can 
support only six dual-pulse turbine streams. However, it could 
support up to 10 single-pulse or 10 single-cell gas DPs.  

Config600 uses the options you selected up to this point to 
determine operational values, including stream flow rate, density, 
flow weighted averages, and other specific values, for each type of 
stream (gas, liquid, or RTU).  

Note: The Graphic Preview button that appears on this screen 
provides a graphic representation of your configuration.   

 

Figure 2-9. Configuration Generator, Step 5 

1. Click  or  to add and delete streams (up to six dual-pulse or ten 
single-pulse). The screen initially displays only one stream.  

Note: If you are configuring a bi-directional or compact prover 
application and require remote streams, then set the number 
of streams to 0. If you are configuring a master meter 
prover application and require remote streams, then you 
must configure at least one stream. Select Next. You will 
then be prompted to select the number of remote streams 
you require (up to 10).  

2. Click  to select a type (gas, liquid, or RTU) for each stream. 
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Note: So that S600+ flow computers can share information, you 
must group similar types of streams together (that is, gas 
with gas and liquid with liquid) and assign streams to 
stations. Config600 displays a warning message at the 
bottom of the screen and disables Next and Graphic 
Preview. Until you resolve these errors you cannot 
complete the configuration.  

3. Click  to select a meter to associate with each stream type.  
Stream Type  Options 
Gas Coriolis, DP, Turbine, Ultrasonic  
Liquid Coriolis, Turbine, Ultrasonic  
RTU Standard (only option)  

 
4. Click  to select a station for each stream-and-meter combination.   

Notes:   
 The RTU stream type essentially collects data for additional 

I/O handling and has no metering function. Consequently, you 
cannot associate an RTU stream with a specific metering 
station. No Station is the appropriate selection.  

 If you defined two stations on screen 4, the wizard reflects 
those definitions in the choices at this step on screen 5.  

5. Click Options to select the processing options for the first stream 
(in this example, gas). Config600 displays an Options summary 
screen with default values.   

Note: The Options summary screens are different for gas, liquid, 
and RTU streams.   

 

Figure 2-10. Gas Stream Options Summary 
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 For a Gas stream, select the appropriate options:  

Note: The Options summary screens are different for each gas 
combination. This is a general list of all options; some 
options may not be available for your selected 
configuration.   

Option  Description 
Option 1 GOST Determines GOST DP using SGERG 

calculations. 
Option 2 GOST Determines GOST DP using VNIC calculations.  
Option 3 PUREGAS  Determines DP using standard PUREGAS 

calculations.  
Station 
Densitometer 

Measures density at station and transfers density 
to dependent stream. You must configure a 
station.  

Stream 
Densitometer 

Measures density at stream. 

No Densitometer  Does not measure density at stream or station. 
This is a default. 

Moles from Station 
Chromat  

Uses selectively distributed (from station) 
analysis data telemetered from the 
chromatograph to streams with matching cycle 
number. Uses individual keypad sets.  

Moles from Station 
Only  

Uses station’s in-use moles directly (that is, the 
station’s common set). Does not use local 
stream moles.  

Moles at Individual 
Stream  

Uses stream moles directly (independently of 
local). This is the default.  

Flowrate AGA3 
Volume 

Determines volume flowrate using AGA3 
calculations. 

Flowrate AGA3 
Mass 

Determines mass flowrate using AGA3 
calculations.  

Flowrate ISO5167 Determines flowrate using ISO5167 calculations. 
This is a default.  

Flowrate ISO5167 
Wet Gas 

Determines flowrate using ISO5167 calculations 
for wet gas.  

Flowrate Annubar Determines flowrate using Annubar calculations. 
Flowrate VCone Determines flowrate using McCrometer V-Cone® 

calculations.   
Flowrate VCone Wet 
Gas 

Determines flowrate using McCrometer V-Cone 
calculations for wet gas.  

Flowrate Daniel Receives flowrate from a Daniel Junior or Senior 
sonic meter (4 path).  

Flowrate 
Rosemount 8 path 

Receives flowrate from a Rosemount 8 path 
ultrasonic meter. 

Flowrate QSonic Receives flowrate from a QSonic meter.  
Flowrate SICK Receives flowrate from a SICK meter.  
Flowrate SICK 8 
path 

Receives flowrate from an 8 path SICK meter 
(FlowSic600-XT).  

CV AGA5 Performs the AGA5 calorific calculation.  
CV GOST Performs the GOST calorific calculation.  
CV ISO6976 Performs the ISO6976 calorific calculation. This 

is the default.  
CV GPA2172-ASTM 
D3588 

Performs the GPA2172-ASTM D3588 calorific 
calculation.  
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Option  Description 
Z AGA8 Performs the AGA8 compressibility calculation 

using DETAIL, GROSS 0, GROSS 1, GROSS 2, 
or VNIC methods. This is the default. 

Z NX19 Performs the NX19 compressibility calculation. 
Z SGERG Performs the SGERG compressibility calculation. 
Z PUREGAS Performs the pure gas compressibility 

calculation.  
Z Ethylene Performs ethylene and propylene compressibility 

calculation.  
Z Steam Performs compressibility calculation using steam 

tables.  
JT ISOTR9464 Calculates the Joule-Thompson coefficient 

according to ISO/PDTR 9464 2005 section 
5.1.5.4.4.  

Valves 
No Valves 

Indicates whether the stream monitors and 
optionally drives valves. No Valves is the 
default.  

Batching  
No Batching 

Indicates whether the stream performs batch 
monitoring and control. You need to configure 
batch reporting to include batch totals objects. 
No Batching is the default.  

Sampling  
No Sampling 

Indicates whether the stream performs twin can 
sampling. No Sampling is the default.  

TFWA x 4 Indicates whether the stream calculates four 
time- and flow-weighted averages. This is the 
default.  

TFWA x 8 Indicates whether the stream calculates eight 
time- and flow-weighted averages.  

TFWA x 12 Indicates whether the stream calculates twelve 
time- and flow-weighted averages.  

PID with Overrides Indicates a single or dual PID control loop with 
override.  

 
Note: As you select options, the Additional Options Selected 

frame (at the bottom of the Options screen) summarises 
your selections (this screen shows a variety of options). 
You may need to scroll down the summary to view all the 
summarised values.   
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Figure 2-11. Gas Stream Options Summarized 
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Figure 2-12. Liquid Stream Options Summary  

 For a Liquid stream, select the appropriate options:  
Option  Description 
Option1 Calculates standard density using header density 

(f rom station input) with header temperature and 
pressure (from stream inputs). Calculates meter 
density using standard density with meter 
temperature and pressure. 

Option2 Calculates meter density using station standard 
density and meter temperature and pressure. 

Option3 Calculates standard density using header density 
(f rom stream inputs) with header temperature 
and pressure (from stream inputs). Calculates 
meter density using standard density with meter 
temperature and pressure. 

Option4 Calculates standard using meter density (from 
stream inputs) with meter temperature and 
pressure. 

Option5 Calculates meter density using stream standard 
density with meter temperature and pressure 
inputs. This is the default.  

Valves 
No Valves   

Indicates whether the stream monitors and 
optionally drives valves. Valves is the default.  

Batching 
No Batching 

Indicates whether the stream performs batch 
monitoring and control and configures batch 
reporting to include batch totals objects. No 
Batching is the default.  

Sampling 
No Sampling 

Indicates whether the stream performs twin can 
sampling. No Sampling is the default.  

Product Table with 
History 

Selects meter factor history and multiple 
products for batching applications with product-
specific meter factor and K-factor curves for each 
product.  
Note: You must select Product Table with 

History in order to use the Prover MF 
Deviation Check stage. 

Product Table 
Advanced 

Selects multiple products (manual only) for 
pipeline batching applications with product-
specific meter factor and K-factor curves for each 
product. 

Product Table Basic Selects multiple products (manual only) for 
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Option  Description 
pipeline batching applications with non-product-
specific meter factor and K-factor curves. 

No Product Table Selects a single product for continuous flow 
metering applications. This is the default. 

TFWA x 4 Indicates whether the stream calculates four 
time- and flow-weighted averages. This is the 
default.  

TFWA x 8 Indicates whether the stream calculates eight 
time- and flow-weighted averages.   

TFWA x 12 Indicates whether the stream calculates twelve 
time- and flow-weighted averages.  

PID with Override Indicates a single or dual PID control loop with 
override.  

 
Note: As you select options, the graphic in the centre of the page 

changes (as shown in Figure 2-12), and the Additional 
Options Selected frame (at the bottom of the Options 
screen) summarises your selections. You may need to scroll 
down the summary to view all the summarised values (see 
Figure 2-13). 

 

Figure 2-13. Liquid Stream Options Summarized 

 For an RTU stream, the only valid station/stream combination 
is Standard and No Station. 

6. Click Next.   

Note: As you select options, Config600 checks to make sure your 
selections are valid and displays appropriate messages at 
the bottom of the screen (see Figure 2-9). If an error 
message displays, Config600 also greys out the Next button 
to prevent you from finalising an invalid configuration. You 
must resolve the configuration error before you can finalise 
your configuration in Step 6.   
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2.1.6 Select Communications (Step 6 of 6) 
Use the sixth screen in the wizard (Figure 2-14) to indicate the external 
communications for the S600+. The selections depend on the defined 
stream and station types.   

 

Figure 2-14. Configuration Generator, Step 6 

1. Select the check boxes to include an optional Modbus slave link 
and Peer to Peer link in the configuration.  

Note: The wizard displays only those options relevant to the 
configuration you have defined in the previous five screens. 
Valid port options (based on the configuration) include 
Modbus Slave, Peer to Peer, Chromatograph, Ultrasonic, 
Coriolis, and Prover.   

2. Indicate the addresses for up to 10 prover remote streams.  

Notes:   
 This option appears if you define a single liquid station with a 

prover option (in Step 4) and no streams (in Step 5). 
Alternately, if you define a master meter (MM) prover in Step 
4, that selection requires you to define one stream for data (Step 
5).   

 If you define stream 1 and stream 2 in the same S600+, enter 
the same Modbus address for each stream. If the streams are in 
separate S600+s, enter unique addresses. 

 Prover remote streams enable you to define Modbus links to 
other S600+s. You can then use the station prover defined in 
this configuration to prove up to 10 other S600+s.  
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3. Click Finish to complete the configuration process. (This may take 
several seconds to complete.) As the wizard creates the 
configuration and saves it to the Configs folder, a dialog box 
displays indicating progress:  

 

Figure 2-15. Generating Config dialog box 

Note: The configuration generator can only create a new 
configuration where all of the metering streams are in the same 
unit as the prover or where all the metering streams are in 
different S600+ flow computers than the prover application. If 
you need to create a configuration where some metering 
streams are in a different S600+ and some streams are in the 
S600+ that houses the prover application, contact technical 
support.   

4. When the process completes, the S600 PCSetup screen redisplays, 
showing a graphic representation of your configuration. (Figure 2-
16 is an example graphic):   

 

Figure 2-16. Example System Graphic 

2.2 Analyse a Configuration (System Graphic) 
System Graphic is the top-most option in the hierarchy menu located 
on the left side of the S600 PCSetup screen. This is also the default 
view whenever you open a configuration (see Section 2.3, Open an 
Existing Configuration).  
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The System Graphic provides a graphically based analysis of the 
configuration file you’ve created or selected. Using the graphic, you 
can quickly review station or stream settings or correct any errors in 
the configuration.  

Note: For further information on selecting and assigning input 
options, refer to Chapter 5, Station Configuration or Chapter 6, 
Stream Configuration.   

 

Figure 2-17. System Graphic (Stations and Streams) 

In the figure above, note the black rectangles labeled Station1 
Calculations and Stream1 Calculations. When you move the cursor 
over one of these blocks, Config600 expands that block to show all the 
values defined for that stream or station: 

 

 

Figure 2-18. Stream Values (expanded) 
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If necessary, you can click on a value in the expanded block (such as 
Gas Properties) to display the Config600 screen that defines those 
values:   

 

Figure 2-19. Value selection (expanded) 

Red circles in the System Graphic alert you to unassigned inputs. 
When you click on a red circle, Config600 displays a screen within the 
system hierarchy you can use to assign those inputs.  
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Figure 2-20. Input Values (expanded) 

Once you assign inputs, you can reselect System Graphic. Config600 
removes the red alerting circles (as in the case of the analogue meters):   
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Figure 2-21. Input Values (assigned) 

In addition to alerting you to inputs you may need to assign, the 
System Graphic also provides other icons you can select. When you 
move the cursor over a selectable icon, the cursor changes to the image 
of a hand. For example, double-clicking the communication icon 
accesses the Communications screen: 
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Figure 2-22. Selectable icons 

Once you are familiar with system components, you can use the 
System Graphic to review and modify the components of your 
configuration file.  
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2.3 Open an Existing Configuration (PCSetup Editor) 
Using the Configuration wizard you can quickly create a basic 
configuration file. You can then use the PCSetup Editor to edit and 
customize the basic settings in an existing configuration file to meet an 
application’s specific requirements.  

Note: While you cannot edit a configuration file that resides and is 
active (online) on the S600+, it is possible to change the 
configuration using the Front Panel or Webserver.   

Editing a configuration includes changing the default values and 
setting alternative I/O configurations, screen definitions, report 
formats, and external communications links. You can: 
 Change measurement units.  
 Configure reports.  
 Assign and re-assign I/O.  
 Configure communications links.  
 Enable/disable alarms.  
 Change cold start values (such as densitometer constants).  
 Change descriptors.  
 Configure existing calculations.  
 Change passwords.  

Note: You cannot add new calculations to a configuration using the 
PCSetup Editor.  

To edit an existing configuration file:  

1. Open a configuration file in one of several ways:  

 Click the Open icon on the PCSetup Editor’s toolbar.  
 Click File > Open in the PCSetup Editor.  

 Click the icon next to the Open an existing configuration 
option on the Welcome to Config600 screen (Figure 2-1) to 
open a previously created configuration file.  

The Select Config screen displays:  

 

Figure 2-23. Select Config…  
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2. Click the name of a configuration file in the left-hand pane. Note 
that the OK and Delete buttons in the right-hand pane become 
active, and the software completes the following fields:  
Field  Description 
Description Displays the description you assigned to this 

configuration in Step 1 of the configuration 
wizard.  

Config Version Indicates the number of times the configuration 
f ile has been edited and saved since its creation. 
The system increments this number only when 
you save a configuration.  

Last Edited Indicates the date the configuration was last 
saved.  

Config Format  Identifies the template version number used to 
generate the configuration file.  

Min Firmware Identifies the minimum version of firmware that 
supports the configuration file.  

OK Click to open the selected configuration file.  
Cancel Click to cancel the action and close this window.  
Delete Click to delete this configuration from the Config 

folder. 
 
3. Click OK. The system opens a configuration-specific S600 

PCSetup screen (note the change in the heading for the screen), 
displaying a graphic representation of that configuration:  

Note: If the existing configuration folder contains an exback file 
(generated when the backup command is utilised on the 
FloBoss S600+ and the configuration uploaded to a PC), then a 
popup window appears asking if the data from the exback file 
should be synchronised with the data in PCSetup. For more 
details refer to Appendix L – Backup Functionality. 
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Figure 2-24. Configuration-specific System Graphic 

Refer to Section 2.2 for further information on using the System 
Graphic. 

Note: By default, PCSetup logs you in at Security Level 1(as shown 
in the lower right-hand corner of the screen). Level 1 has the 
greatest access to software features and functions; level 9 has 
the most restrictions. Refer to Security in Chapter 7, Advanced 
Setup Configuration, for further information on defining 
security levels.  

2.3.1 Navigating the PCSetup Editor  
The PCSetup Editor window consists of two panes: a hierarchy menu 
in the left-hand pane and various configuration screens that appear in 
the right-hand pane. Figure 2-25 shows a sample screen.   
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Figure 2-25. PCSetup Editor 

Located on the left-hand side of the screen, the hierarchy menu 
displays the major configuration components: System Graphic, System 
Setup, I/O Setup, Station(s), Stream(s), and Advanced Setup. Clicking 
on an item in the hierarchy menu displays a sub-menu. Each submenu 
has an associated configuration screen.  
Refer to the following for information on each configuration 
component:  
 System Graphic: Section 2.2 of Chapter 2 
 System Setup Configuration: Chapter 3.  
 I/O and Communications: Chapter 4. 
 Stations: Chapter 5.  
 Streams: Chapter 6.  
 Advanced Setup: Chapter 7.  
The configuration screens on the right-hand side of the screen contain 
parameter fields, check boxes, and buttons. Fields allow you to type 
characters and numbers or to select from drop-down lists. Check boxes 
enable you to select specific options. Buttons link to dialog boxes that 
allow you to configure a data point or parameter.  

Located at the top of the PCSetup Editor screen, the menu bar and icon 
bar have the customary Windows-based software options, plus 
additional menu selections and icons specific to Config600.  

Menu bar 
Icon bar 

Configuration Screen 

Hierarchy Menu 
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2.3.2 The Icon Bar 
The icon bar, located immediately below the menu bar at the top of the 
screen, provides icons for the following actions or shortcuts:  

Table 2-1. Config600 Icon Bar 

Icon Meaning 

 
New Configuration. Click this icon to open the Config600 
Configuration Generation screen sequence. 
Note:  This applies only to the Config600 Pro software.  

 
Open Configuration. Click this icon to open the Select Config 
dialog box. 

 
Save Configuration. Click this icon to save the current 
configuration with the current configuration file name. 

 

Cut, Copy and Paste. These clipboard icons are available if not 
greyed out. Click Cut to remove the selection from the clipboard. 
Click Copy to store the selection to the clipboard. Click Paste to 
insert the contents of the clipboard at the cursor’s location.  

 
Login. Click this icon to open the Login dialog box. 
Note:  This applies only if Level 1 security has been enabled. 

 Edit Security. Click this icon to open the Edit Security dialog box. 

 
Assignment. Click this icon to open the Edit Assignments dialog 
box for the selected data point. 

 
Settings. Click this icon to open the Edit Settings dialog box for 
the selected data point. 

 
Calc Explorer. Click this icon to open the Calc Explorer utility, 
and examine calculation relationships between system 
components.  

 
Config Organiser. Click this icon to display a Config Organiser 
and add, clone, delete, rename, or reorder components of a 
configuration.  

 
Displays. Click this icon to open the Display Editor (see Chapter 
13, Display Editor).  

 
Config Transfer. Click this icon to open the Config Transfer utility. 
(see Chapter 9).  

 
Print. Click this icon to open the Print dialog box. Use this icon to 
print the relevant pane selection to a host printer.  

 
About Config600. Click this icon to open the About Config600 
dialog box that displays copyright and version information.  

 

2.4 The Menu Bar 
The menu bar, located immediately above the icon bar at the top of the 
screen, provides the following actions or shortcuts:   

Table 2-2. Config600 Menu Bar 

Menu Meaning 
File Menu Use these menu options to print, open, close, and save configuration files. 

 New Creates a new conf iguration file. 
 Open Opens an existing configuration file. 
 Close Closes an open configuration file. 
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Menu Meaning 
 Save Saves the selected configuration file. 
 Save As Saves the selected configuration file with a different name. 
 Login Login to the PCSetup Editor.   
 Print Prints the screen currently shown in Config600. 
 Print Preview Opens the selected configuration file in the print preview window. 
 Print Setup Opens the Windows Print Setup window to configure your default 

printer. 
 Recent File Opens or view recently edited configuration files. 
 Regenerate Regenerates the selected configuration file to overwrites all 

modifications to displays and Modbus maps with the standard 
displays and Modbus maps as generated at the build time of the 
conf iguration. 
Note:  To regenerate a report, delete the report and add the 

report using PCSetup Editor > System Setup > 
Reports.  

 Exit Closes the PCSetup Editor. 
Edit Menu Use these menu options to open the Config Organiser, Assignment, and Settings 

screens. 
 Undo, Cut, Copy, 

& Paste 
These functions are disabled in the PCSetup Editor. 

 Config Organiser Launches the Config Organiser to arrange the priority of 
conf igurations so a certain I/O is read before another, rename or 
clone I/O modules, streams or stations, and delete I/O modules. 

 Security Restricts access to authorised system users and determines 
which data items system users can enter or modify. 

 Assignment Opens the Edit Assignments dialog box for the selected data 
point. 

 Settings Opens the Edit Settings dialog box for the selected data point. 
View Menu Use these menu options to view the Tool bar, Status bar, change the frame sizes, and 

open the Startup Screen. 
 Tool Bar Views or hides the Tool Bar. 
 Status Bar Views or hides the Status Bar. 
 Split Changes the f rame sizes. 
 Startup Screen Launches the initial Startup Screen. 

Tools Menu Use this menu to open the Display Editor or the Config Transfer utility. 
 Edit Displays Opens the Display Editor. 
 Transfer Opens the Config Transfer utility. 

Windows Menu Use these menu options to configure how your screens display, clone a configuration, 
arrange icons, and view or select open configurations. 

 New Window Opens a second instance of the configuration file in a new 
window to view a different screen. 

 Cascade Displays all open configuration windows in a Cascade view. 
 Tile Displays all open configuration windows in a Tile view. 
 Arrange Icons Arranges icons according to a grid pattern. 
 Open 

Configurations 
Opens active configurations. 

Help Menu Use these menu options to access the online help system and view the About PCSetup 
information screen.  
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Menu Meaning 
 Contents Accesses the online help system.  
 About PCSetup Displays the About PCSetup dialog box, which contains 

information about the software (including the version number).  

2.5 Managing Configurations 
This section discusses how to save and regenerate a configuration.  

2.5.1 Save a Configuration  
To avoid losing any work as you develop your configuration, it is a 
good practice to save the configuration file after you make any 
changes.   

Config600 creates a separate folder in your computer’s Config600 
folder for each unique configuration. At your request, Config600 saves 
the configuration files in your computer’s Configs folder using the file 
extension “.cfg” for the master configuration file. Other components 
have individual sub-folders:  
 Reports: Contains the report format files. 
 Modbus: Contains the Modbus configuration files. 
 Logicalcs: Contains the custom written files that allow user-

defined functions.  
 Extras: Stores user-defined look-up tables and configuration 

backup files.  
 Logs: Stores a copy of the backup synchronization file and the 

auto-generated log file created when the wizard selections are 
made. 

To save the configuration file, select File > Save or File > Save As 
while in any screen in the PCSetup Editor. To save the configuration 
file with a new name, select File > Save As and then select “<new>” 
from the list of file names. 

2.5.2 Regenerate a Configuration 
In the PCSetup Editor, you can edit displays, reports, or Modbus maps 
using the Display, Report, or Modbus editors. Use the PCSetup Editor 
to edit assignments, values, and modes of data points. Config600 saves 
any file modifications in the Config folder and overwrites any previous 
modifications.  

Note: To regenerate reports, delete the report and add the report using 
PCSetup Editor > System Setup > Reports.   

The File > Regenerate command overwrites all modifications to 
displays and Modbus maps with the standard displays and Modbus 
maps as generated at the build time of the configuration. Modifications 
to the settings and assignments in the configuration file (extension 
.cfg) are reflected in the regenerated files. 
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Use the Regenerate command to force configuration setting 
modifications to the displays and Modbus maps.  
 

Caution 
Regenerating a configuration file results in the loss of any custom 
displays or Modbus maps.  
 

2.6 Display Editor   
Click the Edit Displays icon on the PCSetup tool bar to open the 
Display Editor. Use it to customize the appearance of displays on the 
front panel of the S600+. Refer to Chapter 13, Display Editor, for 
complete instructions on using this utility.  

Note: You can also access this utility either by selecting Tools > 
Display Editor from the PCSetup menu bar or by selecting 
Start > Config600 3.3 > Display Editor.   

2.7 Config Transfer Utility  
Click the Config Transfer icon on the PCSetup tool bar to open the 
Config Transfer utility. Use it to send new or modified configuration 
files to the S600+ using either a dedicated serial port or a TCP/IP 
connection. Config Transfer also enables you to retrieve configuration 
files from the host PC to the S600+. Refer to Chapter 9, Config 
Transfer, for complete instructions on using this utility. 

Note: You can also access this utility either by selecting Tools > 
Transfer from the PCSetup menu bar or by selecting Start > 
Config600 3.3 > Config Transfer.   

2.8 Config Organiser Utility  
Use the Config Organiser to arrange the priority of configurations so a 
certain I/O is read before another, rename or clone I/O modules, 
streams or stations, and delete I/O modules.  
 

Caution 
ALWAYS create a backup of your configuration file before using the 
Config Organiser. The Config Organiser does not automatically update 
any LogiCalcs, displays, reports, or Modbus maps.  
 

1. To open the Config Organiser, either:  
 Click the Config Organiser icon on the PCSetup Editor’s tool 

bar. 
 Select Edit > Config Organiser from the PCSetup Editor’s 

menu bar.  

The Config Organiser screen displays:  
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Figure 2-26. Config Organiser  

2. Click a button to manage the displayed configuration files  
Button Description 

Move Up Selects an I/O module and moves it to a 
higher priority in the configuration so a 
certain I/O is read before another. 

Move Down Selects an I/O module and moves it to a 
lower priority in the configuration so a 
certain I/O is read before another. 

Clone Duplicates an I/O module, stream, or station 
f ile within the configuration. 

Rename Renames an I/O module, stream, or station 
to rename that f ile within the configuration. 

Delete Deletes an I/O module from the 
conf iguration. 

OK  Applies the indicated changes to the 
configuration file.   
Note:  Config600 displays a verification dialog 

box. You must answer Yes to finalise 
your changes.   

Cancel Cancels the action and closes this window. 
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System Setup is the second option in the hierarchy pane on the S600 
PCSetup screen. System settings include company details, units of 
measurement, required reports, and totals. While you define these 
during the initial configuration process, you can use the System Setup 
option to edit these values when necessary.  

 

Figure 3-1. System Setup screen 

When you double-click System Setup, the hierarchy opens to display 
the sub-options: Versions, Units, Reports, Totalisations, and Time. 

Hierarchy 
Menu 

System 
Setup 

 

Hierarchy 
Pane 
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3.1 Versions 
Versions include details of your company and the flow computer being 
used. Config600 uses this information in webserver access windows.  

Config Format 8 As shown in Figure 3-2, Version 3.3 of Config600 uses Config 
Format 8 for its configuration files. Config Format 8 is designed to 
work with Release 5.0 of the CPU module (P152).  

Note: Older configuration files (for release 4.0 or earlier of the CPU 
module) use Config Format 7. We cannot guarantee that 
configurations you create using Config Format 8 will work 
with older releases (4.0 or earlier) of the CPU module. 

 

Figure 3-2. Versions screen  

When you click Versions, Config600 displays a configuration screen 
in the right-hand pane. Unless otherwise indicated, you can edit the 
following fields: 
Field  Description 
Machine Name Provides a tag number or stream name, up to four 

characters in length. Config600 uses this tag (such as 
“S600”) on all printed alarms and events.   

Company Name Provides a short description (up to ten alphanumeric 
characters) for the company.  

Address 1 through 
Address 5 

Provides up to five 30-alphanumeric character fields 
you use to enter your company’s address.   

 
Telephone Provides up to 30 alphanumeric characters for your 

company’s telephone number.  
Fax Provides up to 30 alphanumeric characters for your 

company’s fax number.  
Config Version This read-only field shows the number of times this 

configuration has been saved since it was created.  
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Field  Description 
Config Created This read-only field shows the date and time the 

configuration was originally created.  
Config Last Edited  This read-only field displays the date and time the 

configuration was last saved.  
Config Format This read-only field shows the version number of the 

template used to create the configuration.   
Note: Configuration templates are based on the CPU 

version. Earlier versions (4 or prior) of the CPU 
module use configuration templates version 7 or 
earlier; the version 5 CPU module uses the 
version 8 configuration template. Configurations 
based on earlier templates function with the new 
CPU module. However, configurations 
developed for the new CPU do not work with 
older CPUs. 

 

Note: If you change any values on this screen and try to exit, 
Config600 displays a dialog box asking to save those changes 
to your configuration file. 

 
Click Yes to apply the changes to your configuration file. 

3.2 Units 
Using the Units options, you define the default standard units of 
measurement used throughout the configuration. Config600 performs 
all calculations using units, which conform to the appropriate 
international standards. However, should the requirements of your 
application vary, you can change the displayed units of measurement. 
When you change unit values, the PCSetup Editor automatically 
performs unit conversions.   

You can also override a number of units (such as K-factor) at the 
stream level.  

Note: Click Conversions/Constants to switch between the Units 
screen and the Conversions/Constants option in Advanced 
Setup.  
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Figure 3-3. Units screen 

Each process quantity has a predefined list of selectable units. Click  
to select the units preferred for your application. Config600 removes 
any units not used in this configuration.  

Note: If you change any values on this screen and try to exit, 
Config600 displays a dialog box asking to save those changes 
to your configuration file. 

 
Click Yes to apply the changes to your configuration file.  

3.2.1 Supported Units 
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Table 3-1 lists the standard units of measurement Config600 supports.  

Table 3-1. Standard Measurement Units  
Unit Category Supported Units 
Mass  kg, lbs, M.lbs, MM.lbs, tonne, UK.ton, US.ton 
Mass Flow Rate kg/d, kg/h, kg/m, kg/s, lbs/d, lbs/h, M.lbs/d, 

M.lbs/h, MM.lbs/d, MM.lbs/h, t/d, t/h, UK.t/d, 
UK.t/h, US.t/d, US.t/h 

Uncorrected Vol bbl, CF, kL, km3, L, m3, MCF, MMCF, US 
gal 

Uncorrected Vol Flow Rate bbl/d, bbl/h, CF/d, CF/h, kL/d, kL/h, km3/d, 
km3/h, L/d, L/h, L/m, m3/d, m3/h, MCF/d, 
MCF/h, MMCF/d, MMCF/h, US.gal/d, 
US.gal/h 

Corrected Vol MMSCF, MSCF, Sbbl, SCF, SkL, Skm3, SL, 
Sm3, US.Sgal 

Corrected Vol Flow Rate  MMSCF/d, MMSCF/h, MSCF/d, MSCF/h, 
Sbbl/d, Sbbl/h, SCF/d, SCF/h, SkL/d, SkL/h, 
Skm3/d, Skm3/h, SL/d, SL/h, SL/m, Sm3/d, 
Sm3/h, US.Sgal/d, US.Sgal/hr 

Energy  Btu, Gcal, GJ, Kkcal, KJ, kW.h, mcal, MJ, 
MMBtu, MMMBtu, TJ 

Energy Flow Rate Btu/h, Gcal/d, Gcal/h, GJ/d, GJ/h, Kcal/d, 
Kcal/h, KJ/d, KJ/h, kW.h/d, kW.h/h, MBTu/d, 
Mcal/d, Mcal/h, MJ/d, MJ/h, MMBtu/d, 
MMBtu/h, MMMBtu/d, MMMBtu/h, TJ/d, TJ/h 

Liquid Alternative Vol MMSCF, MSCF, Sbbl, SCF, SkL, Skm3, SL, 
Sm3, US.Sgal 
Notes: 
 Only used in batching configurations. 
 The conversion between units also 

compensates for the difference in metric 
and imperial ‘standard’ conditions (i.e. 
m3 @ 15’C / 0 barg is converted to bbl 
@ 60F / 0 psig) as per the Aramco 
standard.  

Liquid Alternative Mass kg, lbs, M.lbs, MM.lbs, tonne, UK.ton, US.ton 
Note: Only used in batching configurations. 

TEMP UNITS  
(Temperature) 

Deg.C, Deg.F, K 

PRESS UNITS  
(Pressure) 

bara, barg, kgf/cm2a, kgf/cm2g, kPa.a, 
kPa.g, mmH2O, mmHg, Mpaa, MPag, psia, 
psig 

DP UNITS  
(Differential Pressure) 

bar, inH2O, Kg/cm2, kPa, mbar, Mpa, psi 

DENS UNITS 
(Density) 

API, gm/cc, kg/L, kg.m3, kg/Sm3, lbs/bbl, 
lbs/CF, SG 

ROC TEMP UNITS  
(Rate of Change, 
Temperature) 

Deg.C/s, Deg.F/s, Deg.K/s 

ROC PRESSURE UNITS 
(Rate of Change, Pressure) 

bar/s, kPa/s, psi/s 

CV VOL Units 
(Calorific Value) 

BTU/lb, BTU/SCF, GJ/kg, GJ/Sm3, kcal/m3, 
kW.h/m3, MJ/kg, MJ/Sm3 

DYN VISC UNITS 
(Dynamic Viscosity) 

cP, lbm/ft.s, mPa.s, Pa.s, uPa.s 
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Unit Category Supported Units 
DIAM UNITS 
(Diameter) 

cm, ft, in, m, mm, yd 

LENGTH UNITS cm, ft, in, m, mm, yd 
VEL UNITS 
(Velocity) 

f t/s , m/s 

K factor pls/bbl, pls/CF, pls/kg, pls/L, pls/lbs, 
pls/M.lbs, pls/MM.lbs, pls/m3, pls/tonne, 
pls/US.gal, pls/US.ton 

 

3.3 Reports 
Click the Reports option to display a screen identifying the reports 
currently associated with your configuration (Figure 3-4). Config600 
provides two report categories, General and Base Time.  

 

Figure 3-4. Reports screen 

Field  Description 
General Reports Displays the general reports available for selection.  
 Add Click to add a new report.  
 Configure Click to configure the selected report.   
 Edit Click to edit the selected report using the 

Report Editor.   
 Delete Click to delete the selected report.   
Maintenance Mode 
Interlock 

Enables the system to access turbine mode, DP mode, 
and densitometer information regardless of the 
Maintenance Mode status. By default, Config600 
selects this option for imperial-based configurations but 
does not select this option for metric configurations.  

Time Editor Click to display the System Setup > Time screen you 
use to configure time and data parameters for the 
selected report.  

Totals 
Descriptions 

Click to display the the Advanced Setup > Total 
Descriptions screen you use to configure descriptions 
for the selected report.  
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Field  Description 
Base Time Click ▲ or ▼ to select the base time for which you 

want to add a report.  
Note: Although you can define three sets of base time 

reports, Config600 reserves the Hourly and 
Daily reports in base time 2 for Electronic Flow 
Management (EFM) reports (if an EFM Modbus 
module link is included in the software). You can 
overwrite these values, but it may eliminate your 
abiltity to generate EFM reports.  

Hours after 
midnight 

Sets the beginning hour for the specified base time. 6 
is the default hour.  

Multi-day periods Selects how many days a report should cover. Click ▼ 
to display valid values. 1 is the default.  
Note: Once you set this value, the system uses this 

as a fixed period across all three Base Times. 
For example, you cannot then change a period 
of  10 days to a period of 5 days for Base Time 
2. 

Part hour period Indicates how many minutes apart you want reports to 
generate. Click ▼ to display valid values. 1 is the 
default.  
Note: Once you set this value, the system uses this 

as a fixed period across all three Base Times. 
For examle, you cannot then change a period 
of  10 minutes to a period of 5 minutes for Base 
Time 2.  

Report Periods Displays the current report periods associated with the 
report you select in the General Reports pane.  

 Add Click to add a new report period.    
 Configure Click to configure the selected report 

period.    
Note: This button does not display until 

you select a report period.  
 Edit Click to edit the report period you 

selected in the Reports Editor.  
Note: This button does not display until 

you select a report period.   
 Delete Click to configure the selected report.   

Note: This button does not display until 
you select a report period. 

Start of Indicates when the report period starts.  
 Week Indicates the weekday on which the 

report period starts. Click ▼ to display 
valid values. The default is Sunday.  

 Month Indicates the day of the month on which 
the report period starts. Valid values are 
Last Day and First Day. The default is 
First Day.  

 

3.3.1 General Reports 
General reports, which generate as a result of some exception event, 
include: 
Report Name Definition 
Batch Shows totals at the start and end of the batch.  
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Current Shows the current flow rate and cumulative totals.  
Note:  You can request this report from the S600+ front 

panel or webserver.  
Maint Shows totals as you enter and exit maintenance mode.  
STN01 Prv Vol 
and STN02 Prv 
Vol  

Reserved for prover configurations; summarises trial 
runs and final volume data for a prove run.  

STN01 Prv Mass 
and STN02 Prv 
Mass 

Reserved for prover configurations; summarises trial 
runs and final mass data for a prove run.  

CHR D/Load Generates when the chromatograph download data 
changes or when a timeout or mode change occurs.  

CHR Telemetry Generates on the receipt of a new analysis from the 
chromatograph. 

Batch Ticket Shows totals and batch details at the start and end of 
the batch. It also generates if a batch recalculation 
occurs.  
Note: This report replaces the Batch report.  

Basetime  x Tab 
Daily 

Provides the daily data (from the basetime x hourly 
reports) in a tabular format. Available for basetimes 1, 2, 
and 3. 

Basetime x Tab 
Monthly 

Provides the monthly data (from the basetime x daily 
reports) in a tabular format. Available for basetimes 1, 2, 
and 3. 

User-defined 9 reports with content you define. 
 

Note: If you import older configuration files into Config600, the 
Compact Hourly report option may appear on this listing. This 
report, a system-generated base time Hourly report, is available 
but no longer supported.  

3.3.2 Base Time Reports 
Base time reports provide system data as of a particular hour (base 
time) you define.  Base time reports include: 
Time Definition 
Hourly  Shows throughput for the previous hour.  
2 Hourly  Shows throughput for the previous two hours.  
3 Hourly  Shows throughput for the previous three hours.  
4 Hourly  Shows throughput for the previous four hours.  
6 Hourly  Shows throughput for the previous six hours.  
8 Hourly  Shows throughput for the previous eight hours.  
12 Hourly  Shows throughput for the previous twelve hours.  
Daily  Shows throughput for the previous day.  
Weekly  Shows throughput for the previous week.  
Monthly  Shows throughput for the previous month.  
Batch Hourly  Shows, for each hour during a batch, the batch hourly 

total and the batch total.  
Note:  Config600 generates this report only during 

batches. If a batch finishes midway through an 
hour, Config600 does not generate the batch 
hourly value for that hour but does generate the 
end-of-batch value that contains totals for that 
batch.  

Multi Day Shows throughput for the previous multi-day period, as 
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Time Definition 
defined in the Multi-day period field.  
Note: Once you set this value, the system uses this 

as a fixed period across all three Base Times. 
For example, you cannot then change a period 
of  10 days to a period of 5 days for Base Time 
2. 

Part Hour Shows throughput for previous part-hour period, as 
defined in the Part hour period field.  
Note: Once you set this value, the system uses this 

as a fixed period across all three Base Times. 
For examle, you cannot then change a period 
of  10 minutes to a period of 5 minutes for Base 
Time 2. 

 

Note: Although Config600 provides up to three base time categories 
for reports, Config600 reserves base time 2 for Electronic Flow 
Measurement (EFM) reports, which typically do not print. 
Refer to Chapter 14, Modbus Editor, for further information.  

3.3.3 Default Reports 
Config600 provides five default reports: 

 General Reports: Current (set to print and store five instances).  
 Base Time 1 Reports:  

• Hourly (set to print and store 24 instances of this report).  
• Daily (set to print and store 35 instances of this report).  

 Base Time 2 Reports (reserved for EFM reports):  
• Hourly (set to store 840 instances of this report).  
• Daily (set to store 35 instances of this report).  

3.3.4 Report History  
The S600+ saves all periodic reports in circular buffers. For example, 
you decide to save five instances of that report. After saving those five 
reports and generating reports 6 and 7, the S600+ then overwrites the 
data for reports 1 and 2. How many reports you can save is a function 
of the available memory on the S600+. Refer to Section 3.3.5, Adding 
a General Report to a Configuration for information on the total 
number of reports you can save. 

Note: If necessary, you can use the Report Editor to change the report 
format. Any data existing in Config600 is available for 
inclusion on a report, and you can change a report’s format at 
any time.  

3.3.5 Adding a General Report to a Configuration 

Note: Refer to Appendix H, CFX Reporting, for more information on 
CFX reports.   
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Use this procedure to add a General report to your configuration file.  

1. Click Add in the General Reports pane. The Archive Configuration 
dialog box displays:  

 

Figure 3-5. Archive Configuration dialog box 

2. Complete the following values:  
Field  Description 
Archive 
Period  

Indicates the General reports available for selection. Click 
 to display the reports for selection.  
Note: When you select a report from this list and add it to 

the configuration file, Config600 removes that report 
name from this listing.  

Number of 
reports to 
save 

Indicates the number of instances of this report to save. 
Click  or  to increase or decrease the displayed value. 
Note: The total number of reports you can save is a 

function of the available storage on the S600+ after 
you create a configuration file and cold start it. 
Config600 also uses a “report buffer” to store 
reports. If you select 5, Config600 overwrites the first 
iteration of the generated report with the sixth.  

Print when 
Generated  

Indicates whether Config600 prints the report after 
generating it.  

Web history  Indicates whether the selected report appears as an option 
in the Reports display on the S600+ Webserver.  

Report 
Export 

Exports the report formatted as either a text file or a CSV 
f ile to a location you specify.  

Web 
summary 

Indicates whether Config600 includes report data “live” as 
part of the webserver menu bar.  

Preformatted 
HTML  

Indicates whether Config600 uses its native HTML 
formatting when displaying webserver-based reports or 
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Field  Description 
uses your HTML formatting. Select this option to use your 
HTML formatting for reports.  
Note: This is an advanced option. Contact Techical 

Support for further information.  
 
3. Click OK when you are finished. The Archive Configuration 

dialog box closes. Config600 adds your report to the General 
Reports listing.  

3.3.6 User Reports  
S600+ also provides 9 user-defined reports (USER31 through 
USER39) in the General Reports category. Use these reports when you 
have developed special programs (such as a LogiCalc) to trigger report 
conditions or desire to use them on the webserver. You can also use 
these reports to add your own displays on the Webserver menu bar. 

Note: The disable form feed function is not available with user 
reports. 

3.3.7 Adding a Base Time Report to a Configuration 
Use this procedure to add a base time report to your configuration file.  

1. Click  or  in the Base Time Reports pane of the Report screen 
to select the base time for which you want to add a report. 

Note: Although you can define three sets of base time reports, 
Config600 reserves the Hourly and Daily reports in base 
time 2 for Electronic Flow Management (EFM) reports (if 
an EFM Modbus module link is included in the software). 
You can overwrite these values, but it may eliminate your 
ability to generate EFM reports.  

2. Complete the hours after midnight field to indicate the beginning 
hour for the selected base time.  
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3. Click Add in the General Reports pane. The Archive Configuration 
dialog box displays:  

 

Figure 3-6. Archive Configuration  

4. Complete the following values:  
Field  Description 
Archive 
Period  

Displays the base time reports available for selection. Click 
 to display the reports you can select.  
Note: When you select a report from this list and add it to 

the configuration file, Config600 removes that report 
name from this listing.  

Number of 
reports to 
save  

Indicates the number of instances of this report to save.  
Note: The total number of reports you can save is a 

function of the available storage on the S600. 
Config600 also uses a “report buffer” to store 
reports. For example, if you select 5, Config600 
overwrites the first iteration of the generated report 
with the sixth.  

Print when 
Generated  

Indicates whether Config600 prints the report after 
generating it.  

Web history  Indicates whether the selected report appears as an option 
in the Reports display on the Config600 webserver.  

Report 
Export 

Exports the report formatted as either a text file or a CSV 
f ile to a location you specify.  

Web 
summary 

Indicates whether Config600 includes report data “live” as 
part of the webserver menu bar.  

Preformatted 
HTML  

Indicates whether Config600 uses its native HTML 
formatting when displaying webserver-based reports or 
your HTML formatting. Select this box to use your HTML 
formatting for reports.  
Note: This is an advanced option. Contact Techical 

Support for further information.  
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Field  Description 
CFX Stream 
X 

Indicates whether Config600 generates a CFX report for 
this stream. For more information on CFX reports, refer to 
Appendix H, CFX Reporting.  

 
5. Click OK when you finish. The Archive Configuration dialog box 

closes. Config600 adds your report to the Base Time Reports 
listing.  

6. Complete the following fields if you added these reports:  
Report  Field 
Daily Indicates the beginning day of the week. Click  or  to 

select a day. The default is Sunday. 
Monthly Indicates whether the month “starts” on the last day of the 

current month (Last Day or March 31) or the first day of the 
next month (First Day or April 1). Click  or  to select a 
value. The default is First Day. 

3.3.8 Managing Configuration Reports  
At any time you can manage—edit, delete, or reconfigure—the reports 
you have added to your configuration file. Click on a report and 
Config600 displays three additional buttons.  
 Click Configure to display the Archive Configuration dialog box.  
 Click Edit to access the Report Editor (Chapter 10).  
 Click Delete to remove the defined report from the configuration 

file. 

 

Figure 3-7. Managing Configurations  

Note: If you change any values on this screen and try to exit, 
Config600 displays a dialog box asking to save those changes 
to your configuration file. 
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Click Yes to apply the changes to your configuration file. 

3.4 Totalisations 
Click the Totalisation option on the hierarchy to display the 
Totalisation screen (Figure 3-8). Use this screen to manage how the 
system displays totals.  

The Totalisation screen has three components: a Totals Resolutions 
pane, a Total Rollover Digit field, and an Increment Cumulatives in 
Maintenance Mode check box. Edit the Totals Resolution values using 
a dialog (Figure 3-9). For example, if you set the Rollover value to 7 
and the Decimal Place value to 3, rollover occurs at 9,999,999.999. 
Similarly, if you set Rollover to 4 and Decimal Place to 2, rollover 
occurs at 9,999.99. 

Notes:  
 The main calculation routines always use full double-precision 

accuracy for all totalisers and maintain accuracy internally, even if 
you select a restricted number of decimal places for display and 
reporting. 

 Base Sediment and Water volumes use Standard Volume Units. 
This is true even when they are computed as gross volumes.   

 

Figure 3-8. Totalisation  
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To edit totals:  

1. Double-click a Station/Stream line in the Totals Resolution pane. 
The Totals Detail dialog displays:  

 

Figure 3-9. Totals Detail dialog  

2. Complete the following values: 
Field  Description 
Largest Total This read-only field shows the total’s current format. The 

system changes this display as you modify the Rollover 
and Decimal Places values.  
Note:  No total can have more than 15 digits.  

Rollover Indicates the maximum number of digits in the total before 
it rolls over to zero. Valid values are 3 to 15. The default is 
12. Click  or  to increase or decrease the total number 
of  digits.  
Note: Set this value to ensure that when a stream flows at 

its maximum possible flow rate, this limit would not 
cause the total to roll over to zero within a 24-hour 
period. Typically, leave the value at its default of 12 
digits.  

Decimal 
Places 

Indicates the number of decimal places in the total. Valid 
values are 0 to 5. The default is 2. Click  or  to increase 
or decrease the total number of decimal places. 

 

3. Complete the Total Rollover digit field (see Figure 3-8) to 
indicate the value at which rollover occurs. For example, if you 
either leave this field at 0 (default) or set it to 9, rollover occurs at 
9,999. If you set this field to 3, rollover occurs at 3,999, and so on.  

4. Select the Increment Cumulatives in Maintenance Mode check 
box (see Figure 3-8. Totalisation) to enable the S600+ to increment 
all totals in maintenance mode. Otherwise the S600+ increments 
only Maintenance Mode totals when in maintenance mode.   

Note: If you change any values on this screen and try to exit, 
Config600 displays a dialog asking to save those changes to 
your configuration file. 
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Click Yes to apply the changes to your configuration file. 

3.5 Time 
Click the Time option on the hierarchy to display the Date/Time 
Parameters screen (Figure 3-10) and to manage how the system 
formats dates and displays time. The FloBoss S600+ provides two 
methods for time synchronisation: via NTP (refer to section 4.10 
Communications Port) and via a supervisory system. 

 

Figure 3-10. Date/Time Parameters  

1. Review the Date Format, which S600+ uses when displaying 
dates throughout the system. Click  to display available format 
options. The default format is DD MM YYYY.  

2. Review the Time Accept value, which S600+ uses to perform time 
synchronisation procedures for a supervisory system. Valid values 
are: 
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 Disabled 

No time synchronisation is performed via the supervisory 
computer. The default is Disabled. 

 Automatic 

Time synchronisation is automatically performed whenever 
there is a change in the time or date downloaded from the 
supervisory computer. This requires the configuration of the 
SYSTEM KPINTARR TIME AND DATE (DLOAD fields) in 
the supervisory Modbus Map. When a change is seen in any of 
these fields (DLOAD YEAR, DLOAD MONTH, DLOAD 
DAY, DLOAD HOUR, DLOAD MINUTE, DLOAD 
SECOND), the FloBoss S600+ immediately sets its internal 
clock to these values.  

It is also possible to configure the FloBoss S600+ to 
synchronize the time when requested to do so by the 
supervisory computer. This method allows the supervisory 
computer to download the new time / date before it is needed 
(at least 30 seconds in advance) and the synchronization is then 
triggered when required. This triggering is done by using the 
SYSTEM KPINT DLOAD TIME ACCEPT parameter. When 
this field is set to 1 the FloBoss S600+ immediately sets its 
internal clock to the values previously defined in the DLOAD 
YEAR, DLOAD MONTH, DLOAD DAY, DLOAD HOUR, 
DLOAD MINUTE, DLOAD SECOND fields.   

To compensate for any delays in the communications link, a 
DLOAD OFFSET value is provided (in seconds). If this is non-
zero then the value is added to the required time (For example 
if the DLOAD SECOND is set to 30 and the DLOAD OFFSET 
is set to 10, then the FloBoss S600+ will set its seconds value 
to 40).    

More information on time synchronisation via Modbus can be 
located in document ‟How To 61” (which can be obtained by 
contacting Technical Support). 

 
3. Select the Event Time Change option to raise an event whenever 

you change the system time using Modbus.   

4. Enter the Zone Hours and Zone Minutes in the Time Zone Offset 
pane to set the local time. Local time in each time zone is GMT 
plus the curent time zone offset (hours/minutes) for the location.  
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Note: If time synchronization is being performed by a public NTP 
server, then the Zone Hours / Zone Minutes fields need to 
be updated to reflect the time difference from UTC. This 
ensures the flow computer time is correct for its location. 
(Public NTP servers send their time as UTC and the 
configured Zone Hours / Zone Minutes are added or 
subtracted). 

5. Click  in the DST Mode field to select the type of Daylight 
Savings Time to use. Valid values are:  

 Disabled 
Uses Daylight Savings Time as set on your computer. 

 Europe 
Calcuates DST as outlined in COM(2000)302 final, 
2000/0140(COD), “Directive of the European Parliament and 
of the Council on Summer Time Arrangements.” 

• For the purposes of this Directive “summer time period” 
shall mean the period of the year during which clocks are 
put forward by 60 minutes compared with the rest of the 
year. 

• From 2002 onwards, the summer time period shall begin, in 
every Member State, at 1:00 a.m., Greenwich Mean Time, 
on the last Sunday in March.  

• From 2002 onwards, the summer time period shall end, in 
every Member State, at 1:00 a.m., Greenwich Mean Time, 
on the last Sunday in October.  

6. It is possible to provide a Daylight Saving Time status flag which 
indicates Winter Time (value = 0) or Summer Time (value = 1). 
This is only possible by use of the System Editor. Please contact 
Technical support for a ‘How To’ document if this feature is 
required.  

Note: System Editor is available only with the Config600 Pro 
software. 

7. Click Yes to apply the changes to your configuration file.  
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The configuration process assigns default I/O channels to all input and 
output data items—including analog input and digital (discrete) input 
signals, turbine inputs, Highway Addressable Remote Transducer 
(HART®) transmitters, and communication tasks—the S600+ uses. 
Using the I/O Setup option in PCSetup Editor, you can change an 
assigned channel, unassign channels, and modify settings for your 
configured channels. You can also modify the communication tasks, 
including allocating communications links and defining serial port 
settings. Refer to Figure 4-1 for a sample screen. Note that some items 
have already been assigned values.  
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Figure 4-1. Typical I/O Setup Screen (Discrete Inputs Shown)  

4.1 Discrete (Digital) Inputs (DI)  
You can assign each of the data items to a specific digital 
input channel on an available I/O module. You can also configure 
additional user-defined inputs for extra signals, if required.  

Each I/O module (P144 I/O) you install provides up to 16 digital input 
channels. Each Prover module (P154 PRV) you install provides up to 
32 digital input channels. The CPU module (CPU I/O) provides one 
digital input channel. 

4.1.1 Assigning Discrete (Digital) Inputs 
To assign or reassign digital input data items:  

 

1. Select Digital Inputs from the hierarchy menu.  
2. Double-click the digital input you desire to edit. The Digital Input 

Selection dialog box displays.  

Note: You can also click the Assignment icon  on the toolbar 
to display the dialog box.  
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3. Select the I/O Board to assign the digital input or select 
Unassigned to deselect the input. Config600 completes the I/O 
Channel field with available channels:  

 

Figure 4-2. Digital Input Selection dialog box  

4. Select an I/O Channel.  

5. Select the Sense for the digital input bit. The default is Normal. 
Invert reverses the signal’s state.  

6. Click OK to apply the new assignment. The PCSetup screen 
displays showing your new assignment.  

Note: The PCSetup Editor displays a warning message if you 
assign the I/O channel to more than one digital input. Use 
caution: the PCSetup Editor displays a message but does 
not prevent you from assigning the input more than once.  

4.1.2 Editing Discrete (Digital) Inputs 
To edit the description for a digital input data item:  

 

1. Right-click the data item. The system displays a shortcut menu.  

 

Note: You can also click the Settings icon  on the toolbar after 
highlighting the data item to display the menu. However, if 
this option is not available for this item, the system greys 
out this icon.  

2. Select Settings on the menu. The Edit Descriptions dialog box 
displays:  
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Figure 4-3. Edit Description dialog box  

3. Edit the current description or enter a new description.  

Note: The S600+ does not pass this value to the Config600 
configuration or display. Use this process only to customize 
or clarify the value on this screen.  

4. Click OK to confirm the change. The PCSetup screen displays 
showing the edited label.  

4.1.3 Adding Discrete (Digital) Inputs 
To add an additional data item:  

 

Note: When you add a digital I/O point, the point is an object that is 
capable of using 16 digital inputs to derive its value. This 
means that a single object can have a value between 0 and 
65535 as its decimal equivalent. This value shows as 16 bits in 
the Digital Inputs list.  

1. Right-click in the right pane. A shortcut menu displays.  

 
2. Select New I/O Point from the shortcut menu. The Digital Input 

Selection dialog box displays:  

 

Figure 4-4. Digital Input Selection (New I/O Point)  
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Note: The Description field on this screen contains USER, 
indicating that this I/O point is user-defined.  

3. Select the I/O Board to assign the digital input (or select 
Unassigned to deselect the input).  

4. Select an I/O Channel.  

5. Select the Sense for the digital input bit. The default is Normal. 
Invert reverses the signal’s state.  

6. Click OK to apply the new assignment. The PCSetup screen 
displays showing your new assignment. 

4.2 Discrete (Digital) Outputs (DO) 
You can assign each digital output channel to an individual data item. 
Additionally, the S600+ allows you to assign data items to more than 
one output, making a repeat signal available, if necessary.  

Up to 12 digital output channels are available on each installed I/O 
(P144) module, and up to 12 digital output channels are available on 
each installed Prover (P154) module.  

4.2.1 Assigning Discrete (Digital) Outputs 
To assign or reassign a digital output data item:  

 

1. Select Digital Outputs from the hierarchy menu.  
2. Double-click on a digital output item to edit. The Digital Output 

Selection dialog box displays.  
3. Select the Item to assign the digital output or select Unassigned to 

deselect the output. Config600 completes the Output field with 
applicable values (such as Output or Open):  

 

Figure 4-5. Digital Output Selection dialog box   

4. Select an Output channel.  
5. Select the Sense for the digital output. Valid values are Normal, 

Invert, Pulse On, or Pulse Off. The default is Normal.  
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Note: If you select either Pulse On or Pulse Off, you must also 
provide a pulse width (a minimum of 1 second) in the 
Pulse Width field.   

6. Click OK to confirm the reassignment. The PCSetup screen 
displays showing the reassigned values.  

4.3 Analog Inputs (AI)  
You can assign each displayed data item to a specific Analog or PRT 
(Platinum Resistance Thermometer)/RTD (Resistance Temperature 
Detector) input channel on the I/O module (P144) or the HART 
module (P188).   

Each installed I/O module provides up to 12 analog input channels and 
three PRT/RTD input channels. The Prover module (P154) does not 
have any available analog or PRT/RTD input channels. The HART 
module supports up to 50 transmitters. 

Note: If the densitometer also acts as the temperature element for the 
meter, you assign both the Meter Temperature and 
Densitometer Temperature to the same analog input. If the 
prover has only one temperature element, you assign both inlet 
and outlet temperature to the same analog input. This also 
applies to the pressure transmitter.  

4.3.1 Assigning Analog Inputs (AI)  
To assign or reassign an Analog Input data item: 

 

1. Select Analog Inputs from the hierarchy menu.  
2. Double-click an Analog Input to edit. The Analog Input 

Assignment dialog box displays.  

Note: You can also click the Assignment icon  on the toolbar 
to display the dialog box.  

 

Figure 4-6. Analog Input Assignment dialog box  



Config600 Configuration Software User Manual 

Revised January 2023 I/O and Comms Configuration 4-7 

3. Select an input Type. Valid values are Analog Inputs, PRT/RTD 
Inputs, or Unassigned. The default is Unassigned.  

4. Select an I/O Channel to assign the Analog Input.  

Note: This field lists only compatible channels which have either 
not yet been assigned to a particular unit type or that have 
already been assigned to inputs of the same unit type. For 
example, to reassign a pressure input, you can only reassign 
it to an input that is either currently unassigned or already 
assigned to a pressure input. The HART transmitter and the 
S600+ must use matching measurement units.  

5. Click OK to apply the new assignment. The PCSetup screen 
displays showing the new assignment.  

4.3.2 Editing Analog Inputs (AI)  
To edit operational settings for an analog input, a PRT/RTD, or a 
HART input data item: 

 

1. Right-click the desired data item. The system displays a shortcut 
menu.  

2. Select Settings on the menu. An input-specific dialog box displays:  

Note: You can also click the Settings icon  on the toolbar after 
highlighting the data item to display the menu.  
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Figure 4-7. Analog Input, PRT/RTD, and HART dialog boxes  

3. Select an Initial Mode of operation. Valid values are:  
Field  Description 
Measured Use the derived calculated value from the incoming 

signal.  
Keypad Use the keypad value in place of the calculated value.  

Note: This is the default value.  
Last Good Use the last valid value received from the incoming 

signal.  
Average Use the rolling average of the last two “good” readings 

f rom the incoming signal.  
Note: Analog inputs are considered valid if the 

measured current is within Centigrade HI and 
LO fail limits. PRT/RTD inputs are considered 
valid while no integrity fail alarms are present. 
HART inputs are considered valid when no 
errors are present in the good comms and 
second status byte indicates the device is 
healthy. 

Weighted Use the rolling time/flow weight average of the signal. 
Note: This mode is valid only if you configure this 

input in a time/flow weighted average 
calculation table. Refer to Chapter 6, Section 
6.2.8, Time & Flow Weighted Averaging.  
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4. Select a Behaviour value. Valid values are:  

Field  Description 
Disabled  If  the input has failed, continue to use this value.  
Keypad Fail 
with Recovery  

If  the input has failed, change the value to use the 
Keypad value. When the input has recovered, the 
system reverts to its previous mode. This mode 
displays as KEYPAD-F on failure.  

Average Fail 
with Recovery  

If  the input has failed, change the value to use the 
average value. When the input has recovered, the 
system reverts to its previous mode. This mode 
displays as AVERAGE-F on failure.  

Last Good Fail 
with Recovery  

If  the input has failed, change the value to use the last 
valid value. When the input has recovered, the system 
reverts to its previous mode. This mode displays as 
LASTGOOD-F on failure.  

Keypad Fail no 
Recovery  

If  the input has failed, change the value to use the 
Keypad value. When the input has recovered, the 
system remains in Keypad mode until manually 
changed. This mode displays as KEYPAD-F on failure.  

Average Fail no 
Recovery  

If  the input has failed, change the value to use the 
Average value. When the input has recovered, the 
system remains in Average mode until manually 
changed. This mode displays as AVERAGE-F on 
failure.  

Last Good Fail 
no Recovery  

If  the input has failed, change the value to use the 
Lastgood value. When the input has recovered, the 
system remains in Lastgood mode until manually 
changed. This mode displays as LASTGOOD-F on 
failure.  

Weighted Fail 
no Recovery 

If  the input has failed, change the value to use the 
Time / Flow weighted value. When the input has 
recovered, the system remains in Average mode until 
manually changed. This mode displays as 
WEIGHTED-F on failure 

Weighted Fail 
with Recovery 

If  the input has failed, change the value to use the 
Time / Flow weighted value. When the input has 
recovered, the system reverts to its previous mode 
until manually changed. This mode displays as 
WEIGHTED-F on failure. 

 
5. Enter a Keypad value. The system uses this value either if the 

Initial Mode is set to Keypad or the input has failed and the 
Behaviour value is set to Keypad Fail (with or without recovery). 

6. Enter an item Tag of up to 12 alphanumeric characters. The system 
uses this on the front panel of the S600+. 

7. Enter an item Description  of up to 20 alphanumeric characters. 
The system uses this description on reports, alarm printouts, and 
displays.   

8. Enter a Rate of Change (ROC) value. If, in one second, the input 
variable changes by an amount greater than this value and you 
have enabled alarms (Advanced Setup > Alarms), Config600 
alarms the operator.  

9. Enter values for Setpoint and Deviation. Config600 uses these 
values if the operator is required to know when the input variable 
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has changed. The Setpoint field provides a check value, and the 
Deviation field indicates the allowed variance.  

Note: Config600 can raise an alarm only if you have previously 
enabled Alarms in Advanced Setup.  

10. Define Alarm Limits. If you enable an alarm, set a threshold value 
for that alarm.  

On the High and High High alarms, Config600 raises the alarm if 
the in-use value rises above the entered threshold value. On the 
Low and Low Low alarms, Config600 raises an alarm if the in-use 
value falls below the entered threshold value.  

11. Select a Conversion value: 
 If analog, click  to select a valid Conversion value:   
Value  Description 
0–20mA  Use if you apply a current input directly to the I/O board. 
4–20mA  Use if you apply a current input directly to the I/O board. 
0–5V  Use if you apply a voltage signal directly to the I/O 

board or if you place a current loop across a 250-ohm 
resistor and apply the derived voltage to the I/O board.  

1–5V  Use if you apply a voltage signal directly to the I/O 
board or if you place a current loop across a 250-ohm 
resistor and apply the derived voltage to the I/O board.  

0–20mA 2 
point eng 
units 

Use if  you apply a current input directly to the I/O 
board with on-line calibration when the transmitter 
has a straight-line response but an offset is 
required. 
Note: This option enables you to enter Low Scale, 

High Scale, and Offset values on the S600+ 
f ront panel. 

4–20mA 2 
point eng 
units 

Use if  you apply a current input directly to the I/O 
board with on-line calibration when the transmitter 
has a straight-line response but an offset is 
required. 
Note: This option enables you to enter Low Scale, 

High Scale, and Offset values on the S600+ 
f ront panel. 

0–5V 2 point 
eng units   

Use if you apply a voltage signal directly to the I/O 
board or when you place a current loop across a 250-
ohm resistor and apply the derived voltage to the I/O 
board with on-line calibration when the transmitter has a 
straight-line response but an offset is required.  
Note: This option enables you to enter Low Scale, 

High Scale, and Offset values on the S600+ 
f ront panel.  

1–5V 2 point 
eng units   

Use if you apply a voltage signal directly to the I/O 
board or when you place a current loop across a 250-
ohm resistor and apply the derived voltage to the I/O 
board with on-line calibration when the transmitter has a 
straight-line response but an offset is required.  
Note: This option enables you to enter Low Scale, 

High Scale, and Offset values on the S600+ 
f ront panel.  
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Value  Description 
0–20mA 3 
point eng 
units  

Use if you apply a current input directly to the I/O board 
with on-line calibration when the transmitter does not 
have a straight-line response.  
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.  

4–20mA 3 
point eng 
units   

Use if you apply a current input directly to the I/O board 
with on-line calibration when the transmitter does not 
have a straight-line response.  
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.  

0–5V 3 point 
eng units 

Use if you apply a voltage signal directly to the I/O 
board or if you place a current loop across a 250-ohm 
resistor and apply the derived voltage to the I/O board 
with on-lline calibration when the transmitter does not 
have a straight-line response.  
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.  

1–5V 3 point 
eng units 

Use if you apply a voltage signal directly to the I/O 
board or if you place a current loop across a 250-ohm 
resistor and apply the derived voltage to the I/O board 
with on-lline calibration when the transmitter does not 
have a straight-line response.  
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.  

0–20mA 2 
point mA   

Use if you apply a current input directly to the I/O board 
with on-line calibration when the transmitter has a 
straight-line response but an offset is required.   
Note: This option enables you to enter Low mA, High 

mA, and Offset values on the S600+ front panel.  
4–20mA 2 
point mA   

Use if you apply a current input directly to the I/O board 
with on-line calibration when the transmitter has a 
straight-line response but an offset is required.   
Note: This option enables you to enter Low mA, High 

mA, and Offset values on the S600+ front panel.  
0–5V 2 point 
mA  

Use if you apply a voltage signal directly to the I/O 
board or when you place a current loop across a 250-
ohm resistor and apply the derived voltage to the I/O 
board with on-lline calibration when the transmitter has 
a straight-line response but an offset is required.   
Note: This option enables you to enter Low mA, High 

mA, and Offset values on the S600+ front panel.   
1–5V 2 point 
mA  

Use if you apply a voltage signal directly to the I/O 
board or when you place a current loop across a 250-
ohm resistor and apply the derived voltage to the I/O 
board with on-lline calibration when the transmitter has 
a straight-line response but an offset is required.   
Note: This option enables you to enter Low mA, High 

mA, and Offset values on the S600+ front panel.   
0–20mA 3 
point mA  

Use if you apply a current input directly to the I/O board 
with on-lline calibration when the transmitter does not 
have a straight-line response.   
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.    
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Value  Description 
4–20mA 3 
point mA  

Use if you apply a current input directly to the I/O board 
with on-lline calibration when the transmitter does not 
have a straight-line response.   
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.    

0–5V 3 point 
mA  

Use if you apply a voltage signal directly to the I/O 
board or if you place a current loop across a 250-ohm 
resistor and apply the derived voltage to the I/O board 
with on-line calibration when the transmitter does not 
have a straight-line response.   
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.    

1–5V 3 point 
mA  

Use if you apply a voltage signal directly to the I/O 
board or if you place a current loop across a 250-ohm 
resistor and apply the derived voltage to the I/O board 
with on-line calibration when the transmitter does not 
have a straight-line response.   
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.    

 

Note: Refer to Appendix D, Field Calibration for additional 
information.  

 If PRT/RTD, click  to select a valid Conversion value:   
Value  Description 
DIN  Converts the incoming resistance reading into 

temperature using the standard DIN 43760 (using the 
385 curve). 

American  Converts the incoming reading into temperature using 
the standard IPTS-68 (using the 392 curve).  

DIN Offset  Converts the incoming resistance reading into 
temperature using the standard DIN 43760 (using the 
385 curve). Used for on-line calibration where the offset 
is added to the measured temperature.  
Note: This option enables you to enter an offset value 

on the S600+ front panel or webserver.  
American 
Offset  

Converts the incoming reading into temperature using 
the standard IPTS-68 (using the 392 curve). Used for 
on-line calibration where the offset is added to the 
measured temperature.  
Note: This option enables you to enter an offset value 

on the S600+ front panel or webserver. 
Linear Cal  Converts the incoming resistance reading to 

temperature using the American two-point calibration 
constants.  
Note: This option enables you to perform a two-point 

f ield calibration on the S600+ front panel or 
webserver.  

Non Linear 
Cal  

Converts the incoming resistance reading to 
temperature using the American three-point calibration 
constants.  
Note: This option enables you to perform a three-point 

f ield calibration on the S600+ front panel or 
webserver.  
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Value  Description 
Calendar Van 
Dusen  

Converts incoming resistance to temperature using the 
Calendar Van Dusen A, B, C, and R0 constants. Use 
this option to select other tables (such as IEC) by 
entering the A, B, C, or R0 constants.  
Note: Select the Calendar Van Dusen option to 

support other temperature curves (such as DIN 
43760 1980 or IEC 60751 2008) when using 
constants from those standards. 

 
12. Complete any conversion-specific fields for the analog conversion 

value you selected:   

Note: Conversion settings in this section may require that you 
change jumper (bit link) settings on the appropriate I/O 
board. Refer to the FloBoss S600+ Flow Computer 
Instruction Manual (Form A6115) for further details.  

Value  Description 
High Scale  Indicates, in mA or V (depending on the selected 

conversion option), the high-range scaling value (5 V 
or 20 mA).  
Note: This field does not display for on-line 

calibration.  
Mid Scale Indicates, in mA or V (depending on the selected 

conversion option), the middle-range scaling value (5 
V or 20 mA).  
Note: This field does not display for on-line 

calibration.  
Low Scale  Indicates, in mA or V (depending on the selected 

conversion option), the low-range scaling value (0 V, 
1 V, 0 mA, or 4 mA).  
Note: This field does not display for on-line 

calibration.  
High Fail  In current modes, indicates the direct reading of the 

Analog Input at which the transmitter has failed.  
In voltage modes, indicates (in mA) the current 
required to pass through a 250-ohm conditioning 
resistor to achieve the required fail voltage.  

Low Fail Indicates, in mA or V (depending on the selected 
conversion option), the mid-range scaling value (5 V 
or 20 mA).  

 
13. Complete any required calibration-specific fields for the 

conversion factor you selected.  

 If Analog:   
Value  Description 
Low Scale  Indicates, in mA or V (depending on the selected 

conversion option), the low-range scaling value (0 V, 
1 V, 0 mA, or 4 mA).  
Note:  This field does not display for on-line 

calibration.  
Mid Scale Indicates, in mA or V (depending on the selected 

conversion option), the mid-range scaling value (5 V 
or 20 mA).  
Note: This field does not display for on-line 

calibration. 
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Value  Description 
High Scale  Indicates, in mA or V (depending on the selected 

conversion option), the high-range scaling value (5 V 
or 20 mA).  
Note: This field does not display for on-line 

calibration.  
 

 If PRT/RTD:   
Value  Description 
Low Scale Indicates, in degrees Centigrade, the low value for 

calibration. 
Note: This field displays only if you select the 

Linear Cal or Non Linear Cal conversion 
options.  

Mid Scale Indicates, in degrees Centigrade, the mid value for 
calibration.  
Note: This field displays only if you selected the 

Non Linear Cal conversion option. 
High Scale Indicates, in degrees Centigrade, the high value for 

calibration. 
Note: This field displays only if you selected the 

Linear Cal or Non Linear Cal conversion 
options.  

A Provides the A constant value for the Calendar Van 
Dusen conversion.  
Note: This field displays only if you selected the 

Calendar Van Dusen conversion option.  
B Provides the B constant value for the Calendar Van 

Dusen conversion.  
Note: This field displays only if you selected the 

Calendar Van Dusen conversion option.  
C Provides the C constant value for the Calendar Van 

Dusen conversion.  
Note: This field displays only if you selected the 

Calendar Van Dusen conversion option.  
R0 Provides the R0 constant value for the Calendar Van 

Dusen conversion.  
Note: This field displays only if you selected the 

Calendar Van Dusen conversion option.  
 

14. Complete any Alarm Limit values:  

Value  Description 
High High Select the checkbox and enter a value to which the 

input value must rise to generate a High High alarm.  
High Select the checkbox and enter a value to which the 

input value must rise to generate a High alarm.  
Low  Select the checkbox and enter a value to which the 

input value must lower to generate a Low alarm.  
Low Low Select the checkbox and enter a value to which the 

input value must lower to generate a Low Low 
alarm.  

 
15. Click OK to apply the edits. The PCSetup screen displays.  
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4.3.3 Adding a New I/O Point  
To add either a new analog input or a new PRT/RTD I/O point: 

 

1. Right-click in the right-hand pane of the PCSetup screen. The 
system displays a shortcut menu.  

2. Select New I/O Point on the shortcut menu. The system displays 
the Analog Input Assignment dialog box.  

 

Figure 4-8. Analog Input Assignment dialog box  

3. Complete the Type, I/O Board, I/O Channel, and Units fields as 
described in Editing Analog Inputs.  

Note: Config600 highlights the default values for each field. You 
can accept or change those defaults as necessary.  

4. Select the type of Units.  

5. Click OK to apply the new I/O point to your configuration. The 
system redisplays the PCSetup screen with your new I/O point.  

4.4 Analog Outputs (AO)  
You can assign each analog output channel to an individual data item. 
You can also assign individual data items to more than one output, 
which allows you to create a repeat signal.  

Each installed I/O module (P144) provides up to four analog output 
channels. Neither the Prover module (P154) nor the HART module 
(P188) provide any analog output channels.  

4.4.1 Editing Analog Outputs  
To edit an analog output data item:  

 

1. Select Analog Outputs from the hierarchy menu. The system 
displays all currently defined analog outputs in the right-hand pane.  
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2. Double-click an analog output to edit. The Analog Output 
Assignment dialog box displays.  

3. Select the Item Type to assign the Analog Output (or select 
Unassigned to deselect the output). Config600 completes the Item 
field with available data items:  

 

Figure 4-9. Analog Output Items  

4. Select an item in the Item field to assign to the item type.  

5. Define the output scales by entering values in the Low scale and 
High scale fields. S600+ uses these values when converting the 
raw value into a scaled analog output value. The default value for 
the Low scale is 0; the default value for the High scale is 
10000000. To invert the output, set the High scale lower than the 
Low scale.  

Note: Config600 changes the units associated with these fields 
(kg/m3, t/h, m3/h, pls/m3, and such) based on the data item 
you select.  

6. Select a Conversion factor for the Low scale and High scale 
values. Valid options are 0 to 20mA or 4 to 20mA. The default is 4 
to 20mA. For example, if you select the 4 to 20mA option, 
Config600 equates the Low scale value to 4 mA and the High scale 
value to 20mA.  

7. Click OK to apply your selections. The system redisplays the 
PCSetup screen with your new assignments.  

Note: Refer to Appendix D, Field Calibration, for additional 
information.   
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4.5 Density Inputs  
Config600 supports either single or twin densitometers, which you 
assign to each station or stream as you develop a configuration. You 
can assign each densitometer frequency to a specific density input 
channel on the I/O module.  

Each installed I/O module (P144) provides three available density 
input channels. Each installed Prover module (P154) provides two 
channels.  

Notes:  

 If the densitometer also acts as the temperature element for the 
meter, assign the meter temperature, densitometer temperature, and 
pressure transmitter to the same analog input.  

 Using the Streams option in the PCSetup Editor, you can switch a 
frequency input to an analog signal. See Chapter 6, Stream 
Configuration.  

4.5.1 Assigning Density Input  
To assign or reassign a density input data item: 

 

1. Select Density Inputs from the hierarchy menu. The system 
displays all currently defined density inputs in the right-hand pane.  

2. Double-click a Density Input to edit. The Assign Input dialog box 
displays.  

Note: You can also click the Assignment icon  on the toolbar 
to display the dialog box.  

3. Select the I/O Board to assign the density input (or select 
Unassigned to deselect the input). Config600 lists available 
channels in the I/O Channel field:  

 

Figure 4-10. I/O Channels for Density Input   
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4. Select the I/O Channel for the density input. 

5. Click OK to apply the assignment. The system redisplays the 
PCSetup screen with your new I/O assignment.  

Notes: 

 Before displaying the PCSetup screen, Config600 may display 
a reminder for you to enable the alarms for the new assignment.  

 When you assign a densitometer input, the station or stream 
density configuration page displays. 

 

Figure 4-11. Alarm Reminder  

4.5.2 Editing Density Inputs  
To edit the description for a density data item:  

  

1. Select Density Inputs from the hierarchy menu. The system 
displays all currently defined density inputs in the right-hand pane. 

2. Right-click a data item to edit. The system displays a shortcut 
menu.  

3. Select Settings on the shortcut menu. The system displays the Edit 
Description dialog box:  

 

Figure 4-12. Edit Description dialog box  

4. Edit the current item description, using no more than 20 
alphanumeric characters.  

5. Click OK to apply the new item description. The system redisplays 
the PCSetup screen with your new item description.  
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4.6 Turbine Inputs 
A turbine or positive displacement meter provides inputs to the system 
in the form of single-pulse or dual-pulse data. You assign the turbine 
pulse inputs to an I/O channel on the I/O board.  
Each installed I/O module (P144) or Prover module (P154) provides up 
to four pulse input channels. You can define these channels as: 
 Four single-pulse inputs. 
 Two dual-pulse inputs. 
 Two single-pulse and one dual-pulse inputs. 
 

Caution 
The S600+ cannot count pulses unless the I/O module (P144) or Prover 
module (P154) is fitted with a dual-pulse P148 mezzanine board. 
 

4.6.1 Assigning Turbine Inputs  
To assign or reassign turbine input data items: 

 

1. Select Turbine Inputs from the hierarchy menu. The system 
displays all currently defined turbine inputs in the right-hand pane. 

2.  Double-click a turbine input to edit. The Pulse Input Assignment 
dialog box displays. 

Note: You can also click the Assignment icon  on the toolbar 
to display the dialog box.  

 

Figure 4-13. Pulse Input Assignment dialog box  

3. Select a pulse mode:   
Field  Description 
Unassigned  Select to un-assign a pulse input.  
Single  Select if only one pulse train is available from the 

meter.  
Dual Level A  Select if the meter provides dual pulses at the same 

f requency but out of phase.  
Note: This option conforms to Level A interpolation in 

accordance with ISO 6551 (IP252/76). 
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Field  Description 
Dual Level B  Select if the meter provides dual pulses at the same 

f requency but out of phase.  
Note: This option conforms to Level B interpolation in 

accordance with ISO 6551 (IP252/76). 
 
4. Select the I/O board for the pulse turbine input.  

5. Select an I/O channel to use.  
 For dual-pulse input on the I/O (P144) module, select channels 

1 & 2 or 3 & 4.  
 For dual-pulse input on the Prover (P154) module, select 

channels 2 & 3 or 4 & 5 (Config600 reserves channel 1 for the 
raw input value from an internal or exteral raw pulse output).  

 Four channels (1, 2, 3, and 4 for I/O modules or 2, 3, 4, and 5 
for Prover modules) are available for single-pulse inputs.  

6. Complete the Low Frequency Cutoff field using a Hertz value. If 
the S600+ receives pulse frequencies below this value, it sets the 
flow rate and input frequency to zero.  

Note: Totalisation still occurs in Liquid Turbine applications, but 
does not occur in Gas Turbine applications when the 
frequency is below the Low Frequency Cutoff value. 

7. Complete the fields in the Thresholds pane (which displays only if 
you selected Dual Level A or B as a pulse mode).  
Field  Description 
Reset Determines the number of consecutive valid pulses the 

system must receive after the occurrence of the bad 
pulse alarm before it clears the bad pulse alarm. The 
default value is 200000. 
Note: Config600 ignores all bad pulses that occur 

below the value you enter in the Error Check 
Frequency field. 

Bad Pulse Indicates the number of bad pulses that need to 
accumulate in the bad pulse buffer before the system 
raises the bad pulse alarm. The default is 50.  

 
8. Complete the fields in the Bad Pulse Configuration pane (which 

displays only if you selected Dual Level A or B as a pulse mode).  
Field  Description 
Bad Pulse 
Reset Mode  

Defines how the system manages the bad pulse 
buffer. Valid values are Clear (clear the buffer when 
the input frequency is below the error check frequency) 
or Set (do not clear the buffer). The default value is 
Clear.  

Error Check 
Frequency 

Sets a threshold input frequency value. While 
Config600 detects and records pulses below this 
value, it does not include them in bad pulse checking.  

 
9. Click OK to apply the assignments. The PCSetup screen displays 

showing your new values.  
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4.6.2 Editing Turbine Inputs  
To edit the description for a pulse input data item: 

 

1. Select Turbine Inputs from the hierarchy menu. The system 
displays all defined turbine Inputs.  

2. Right-click a data item to edit. The system displays a shortcut 
menu.  

3. Select Settings on the shortcut menu. The system displays the Edit 
Description dialog box:  

Note: You can also click the Settings icon  on the toolbar after 
highlighting the data item to display the menu.  

 

Figure 4-14. Edit Description dialog box  

4. Edit the current item Description, using no more than 25 
alphanumeric characters. 

5. Click OK to apply the new item Description. The system 
redisplays the PCSetup screen with your new item Description.  

4.7 Pulse Outputs 
Use pulse outputs to derive cumulative totals for display on a counter, 
a totaliser, or DCS system. You can assign each pulse output to a 
specific pulse output channel on the I/O board.  

Each installed I/O (P144) module provides five pulse output channels, 
and each installed Prover (P154) module provides four channels.  

 

Figure 4-15. Pulse Output Items  
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4.7.1 Assigning Pulse Outputs  
To assign or reassign Pulse Output data items: 

  

1. Select Pulse Outputs from the hierarchy menu. The system 
displays all defined pulse output data items.  

2. Double-click a pulse output to edit. The Pulse Output Assignment 
dialog box displays.  

 

Figure 4-16. Pulse Output Items  

3. Select Cumulative Totals in the Item Type pane. Config600 
completes the Item field with available items.  

4. Select an Item in the Item pane to associate with the Pulse Output.  

5. Edit the Description associated with the item and item type. 
Config600 uses this value only on screen displays and reports.  

6. Complete the Frequency field using a Hertz value to indicate the 
output’s pulse width. For example, a frequency of 5 Hz equates to a 
200 millisecond pulse width with a 50/50 duty cycle. The default 
value is 5.  

7. Complete the Grab Size field to indicate the number of units per 
pulse (the type of unit being dependent on the application) 
Config600 accumulates before sending a pulse. For example, use a 
Grab Size value of 10m3 to measure increments in the Cumulative 
Volume Totals for each outputted pulse. The default is 10.  

8. Click OK to apply the new assignment. The PCSetup screen 
displays showing the new assignment.  

4.8 HART Modules 
Each Highway Addressable Remote Transducer (HART) module 
supports 12 channels with up to 8 transmitters per channel. However, 
the S600+ has an overall restriction of 50 transmitters.  
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Note: You cannot add a HART module definition to an existing 
configuration file. If you add a HART module to your S600+, 
you must create an entirely new configuration file. Be sure to 
assign the I/O module (P144) to address 1 and the HART 
module (P188) to address 2.  

The S600+ supports 12 channels, with up to 8 sensors multidropped 
from each channel. Since each sensor takes approximately 0.5 second 
of scan time, the more sensors you add to each channel, the slower the 
I/O update time becomes for that channel. Also, the HART module 
reads only the HART digital signal, not the channel’s analogue value. 
If you require both, you must physically wire the HART signal to an 
ADC and HART channel.   

By default, the S600+ acts as the primary HART master. Ensure there 
is no other primary master connected to the channel. For dual master 
support or instructions on how to set the S600+ to secondary master, 
contact Technical Support.   

4.8.1 Editing HART Settings  
To edit or reassign settings for the HART data items:  

 
 

1. Select HART Boards from the hierarchy menu. The system 
displays the HART Board configuration screen:  

 

Figure 4-17. HART Module Configuration screen  

2. Complete the screen based on the number of sensors associated 
with each channel on the S600+. Click ▼ to display valid values.  

4.9 PID Loop Settings  
The PID control task provides primary control with secondary override 
control (that is, two control loops, each with its own parameters). You 
can either select the output according to criteria you can enter or allow 
a status input to the task to select the output.  

You can configure an individual PID task for each station and stream, 
subject to the I/O providing sufficient analog outputs. 



Config600 Configuration Software User Manual 

4-24 I/O and Comms Configuration Revised January 2023 

Typically, a liquid application has flowrate primary control which 
changes to pressure control if the pressure falls too low. A gas 
application has a primary pressure control which is overridden by flow 
control if the flowrate becomes too high.  

4.9.1 Assigning PID Loops  
To assign or reassign PID data items:  

 
 

1. Select PID Loops from the hierarchy menu. The system hides the 
setup fields until you assign an analog output to the PID loop (see 
Figure 4-18).  

 

Figure 4-18. PID Loop Enabled screen  

2. Select Unassigned (or select the Analog Outputs from the 
hierarchy menu) to identify the Analog Output values you desire to 
associate with each PID control loop.  

 

Figure 4-19. Analog Output Assignment screen  
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3. Select PID Loops from the hierarchy menu. The system expands 
the hierarchy to display the control loops defined for each I/O 
module.  

4. Select a control loop. Config600 displays the common data items 
for this loop.   

 
Figure 4-20. PID Loop Output Assigned screen  

5. Assign the Primary Controlled Process Variable to enable the 
primary controller.  

6. Click PV Channel Settings. A Select Object dialog box displays. 
Use it to assign the Analog Output value associated with this PID 
control loop.  

 

Figure 4-21. PID Loop Output Assigned screen  

7. Assign – if required – the Override Controller process variable. 
Config600 expands the screen content.  
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Figure 4-22. PID Loop PV Assigned screen  

8. Select the Control Method for the PID loop. Click ▼ to display all 
valid process variable values.  
Field  Description 
Disable The PID algorithm does not execute and the output 

does not update 
Dual Auto Selects Primary control with Secondary override 

according to the settings defined in Switch Over Logic 
f ield.  

Primary Only Uses the primary control settings with no switching to 
secondary control. 

Secondary 
Only 

Uses the second control settings; does not switch to 
primary control. 

User Logic Uses a KPINT status input to select either primary or 
secondary control. The status can be set by an 
operator, a digital input, user logic in a LogiCalc, or 
downloaded from a supervisory computer. 

 
9. Complete the Auto/Manual field. Valid values are Manual (the 

system forces the output to the Manual Position value) or Auto (the 
system uses the calculated value from the PID algorithm to drive 
the analog output). The default value is Manual.  

10. Indicate an MV Max Rate Of Change as a percentage of the 
output per second. This value controls the Manipulated Variable 
output’s maximum rate of change (ROC). The default is 60 (60% 
of output). For example, entering 20 in this field limits a full range 
(0 to 100) change to a minimum of 5 seconds.  

Note: Enter 0 in the MV Max Rate of Change field to override the 
field.   

11. Indicate an MV Clamping High Limit as a percentage of the 
output. This value limits the Manipulated Variable output’s 
maximum value. The default is 100.  
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12.  Indicate an MV Clamping Low Limit as a percentage of the 
output. This value limits the Manipulated Variable output’s 
minimum value. The default is 0.  

13. PV Channel shows the measured input selected for the PID loop.  

Note: The system grays out the Override Controller PV Channel 
Settings button until you assign the Primary Controller PV 
Channel.  

14. Complete the Control Action field on the PID Loop screen. The 
system uses this value to determine whether to increase or decrease 
the output when the process variable exceeds the SP (Setpoint) 
value. Valid values are Reverse (reduce the output when the 
process variable is greater than the Setpoint value) or Forward 
(increase the output when the process variable is greater than the 
Setpoint value). The default is Reverse.  

15.  Define a Set Point value, which the system—when in Auto 
mode—attempts to achieve by controlling the output. This is an 
initial value that you can change through the S600+ front panel. It 
must be in the same units as the Process Variable.  

16.  Complete the SP Rate Of Change field. The default is 0.  

Config600 uses this value to control the rate of change (ROC) of 
the setpoint. The value defines the maximum rate of change, 
causing the setpoint to change as a percentage of the setpoint range 
incrementally to the new entered Set Point value. Use this value as 
a component of flow profiling, for example, at the start of a batch.  

Note: Enter 0 to override the SP Rate of Change field.  
 

 Warning If you override this parameter, then the rate of change at the output 
occurs as fast as the unit can react to a new setpoint value being 
entered. This results in a step change of the output value rather than 
a smooth transition from one point to another.  

 

17. Select the SP Tracking checkbox to enable setpoint tracking. This 
field works in conjunction with the value you enter in the 
Auto/Manual field:  

 With SP Tracking enabled and in Auto mode, the system sets 
the value in the Manual Position field equal to the current 
output value. 

 With SP Tracking enabled and in Manual mode, the system 
sets the value in the SP (Setpoint) field equal to the process 
variable. 

 With SP Tracking disabled and in Auto mode, the value in the 
Manual Position field remains unchanged. 

 With SP Tracking disabled and in Manual mode, the SP value 
remains unchanged and the system sets the integral action field 
to the value required to maintain the current position. 
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18. Complete the Manual Position field. This value represents the 
output value when the Auto/Manual mode is set to Manual.  

19.  Complete the PV Range field to identify the range for the process 
variable measuring instrument. The value must be in the same units 
as the Process Variable.  

20.  Complete the Prop Band (Proportional Bandwidth) field. This 
value is a tuning parameter expressed as a percentage of the PV 
Range. It makes a change to the output proportional to the current 
error.  

21. Complete the Integral Time field. This value, expressed in 
seconds, is a tuning parameter. It makes a change to the output 
based on the sum of previous errors.   

Note: If the Integral Time is 0, the system sets the integral action 
to zero.   

22. Complete the Derivative Time field. This value, expressed in 
seconds, is a tuning parameter. It makes a change to the output 
based on the rate of change of the error.  

Note: If the Derivative Action Time is 0, the system sets the 
derivative action to zero.   

23. The Dual Auto Control Method uses Switch Over Logic criteria to 
decide whether to use the output produced by the primary control 
loop or the output produced by the secondary override control 
loop. The test compares the override process variable with an 
entered limit, and can test for either lower (such as too low 
pressure) or higher (such as too high flowrate).   
 Switch to override when override PV is less than the entered 

value (to the right of this selection on the screen), and switch 
back when PV reaches the entered value (to the right of this 
selection on the screen). 

 Switch to override when override PV is greater than the 
entered value (to the right of this selection on the screen), and 
switch back when PV reaches the entered value (to the right 
of this selection on the screen). 

Note: The Switch Over Logic option displays only if you select 
Dual Action in the Control Method field.   

24. Click the hierarchy menu when finished. Config600 displays an 
Apply Changes dialog box.  

25. Click Yes to apply the changes to the configuration file. The 
PCSetup screen redisplays.   

4.9.2 Proportional Plus Integral and Derivative Action 
The method for PID control is to calculate an error that is the 
difference between the current measured value of the process variable 
(usually flowrate or pressure) and a setpoint value required for the 
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variable, and to convert the error to a correction which can be applied 
to the output to reduce the error to zero.  
Forward/Reverse action describes the direction in which correction is 
applied to decrease the error. For flowrate control using a flow control 
valve, when the process variable is greater than the setpoint, the output 
needs to be reduced to close the valve slightly, and this is defined as 
Reverse action. For pressure control in the same situation, the output 
would need to be increased and this is defined as Forward acting. 
The three components each provide a different type of correction to the 
output and adjustment of the terms effectively changes the amount of 
damping applied; the proportional component applies to the current 
error, the integral component applies to the sum of previous errors over 
a period and the derivative component applies to the rate of change of 
the error. 

PID Controller The PID controller output is calculated from the sum of the 
proportional, integral, and derivative actions: 

Output = P + I + D 

Each term depends on the Error and Gain:  

 If the control action is Forward: 

Error = Process Variable – Setpoint  

 If the control action is Reverse:  

Error = Setpoint – Process Variable 

 If the proportional gain is applied to all three terms:   

Gain = 1 / PV Range x 100 / Proportional Band x 100  

 If the algorithm is processes at regular intervals:  

Delta Time = Current Time – Previous Time  

Proportional 
Action (P) 

The degree of proportional action (P) is directly proportional to the 
error and is calculated from the formula: 

P = Error x Gain 

A high proportional action produces a large change in the output for a 
given change in the error, a low proportional action produces a small 
change in the output, that is the action is less sensitive. If the 
proportional gain is too high the system becomes unstable. 
A suitable initial value for flowrate control is 200%. 

Integral 
Action (I) The degree of integral action (I) is calculated from the formula:  

 

I (new) = I (previous) + (Error x Gain x Delta Time) / Integral Action Time 
Integral action provides a cumulative offset that eliminates the residual 
error. 
A suitable initial value for flowrate control is 3.0 seconds. 
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Derivative 
Action (D) The degree of derivative action (D) is calculated from the formula:  

 

D = (Error – (2 x Old Error) + Very Old Error) x Gain x Derivative Action Time / Delta Time 

Derivative action responds to rate of change in successive errors. The 
action is sensitive and anything greater than a small value of the 
derivative action time can make the system unstable. 
A suitable initial value for flowrate control is 0.01 seconds. 

4.10 Communications Port 
During the creation of a configuration, you specify the 
communications ports. Once the configuration has been created, you 
must configure the “tasks” for the communications port(s).  
A communication “task” defines the communications links to any 
devices connected to the S600+. The task defines the communications 
or network port and communication parameters for the port. You can 
define up to 20 communications tasks for the S600+ and assign each 
task a specific function (such as Modbus Master, Modbus Slave, or 
Printer). Each task must be allocated to a dedicated communications 
port. If you configure a serial port, the task allows you to configure the 
settings for the COM ports to the external devices.  

The S600+ supports Modbus, Modbus Enron (Modbus with EFM 
Extensions), Modbus encapsulated in TCP/IP, Modbus/TCP, and 
Printing over Ethernet.  

Notes: 

 EFM is Electronic Flow Metering or Measurement. 

 For Modbus encapsulated in TCP/IP and Modbus/TCP, the 
maximum number of RTU’s that can be connected to a single Port 
(501, 502, etc.) is 2.  

S600+ supports: 
 Slave and master peer-to-peer 
 Q.Sonic 
 Slave and master functionality in Modbus 
 Slave and master functionality in Modbus Enron (EFM) 
 Slave and master functionality in Modbus encapsulated in TCP/IP 
 Slave functionality in Modbus/TCP 
 Master TCP/IP communication 
 Printer 
 Network Time Protocol (NTP) 

4.10.1 Editing a Communications Task  
To edit a communication task: 
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1. Select Comms from the hierarchy menu. The system displays the 
Communication Task configuration screen:  

  

  

Figure 4-23. Example Communication Task Configurations  

2. Select a value in the Comms Links field. Config600 displays the 
values associated with that Comm Link type in the right-hand side 
of the screen. The title of that values pane also changes to reflect 
the selected Comm Link type.  

3. Complete the values for the selected Comms Link: 

Note: Not all fields display for each Comm Link option.  

Field  Description 
Function Indicates all valid communication port functions. 

Click  to display all valid functions.  
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Field  Description 
Protocol Select a protocol, if appropriate. Click  to display all 

valid protocols, which include Serial (ASCII), Serial 
(RTU), Ethernet (ASCII), Ethernet (RTU), 
Modbus/TCP, Printer Serial, and Printer Ethernet.   
Note:  
 RTU (Remote Transmission Unit) is the 

preferred protocol for increased performance. 
 Before you change the Protocol field from 

Serial [Serial (ASCII), Serial (RTU), or Printer 
Serial] to Ethernet [Ethernet (ASCII), Ethernet 
(RTU), Modbus/TCP, or Printer Ethernet], set 
the Port field to NONE to ensure the serial port 
is available for future use. 

Port Sets the primary port for the communication task. If 
available, click  to display all valid ports.   Click 
Setup (if present) to display a Port Setup dialog that 
you use to define communication options (baud rate, 
data bits, stop bits, and parity values) for the port you 
select. The port depends on the type of Comms link 
you select.  
Notes: 
 When set to 0, the NTP uses any available port 

when communicating with a public NTP server. 
 For Modbus encapsulated in TCP/IP and 

Modbus/TCP, the maximum number of RTU’s 
that can be connected to a single Port (501, 502, 
etc.) is 2. 

Setup Click to display a Port Setup dialog box that you use 
to define communication options for the selected port 
type.  
Note: The Comm Link type dictates which fields 

selectively appear on this dialog box.  
 Baud Rate Indicates the serial transfer rate. 

Click  to display all valid values. 
The default value is 38400. 

 Data Bits Indicates the number of data bits 
the port uses. Click  to display all 
valid values. The default value is 8. 

 Stop Bits Indicates the number of stop bits 
the port uses. Click  to display all 
valid values. The default value is 1. 

 Parity Indicates the type of parity used to 
detect data corruption during 
transmission. Click  to display all 
valid values. The default value is 
None. 

 Hardware 
Handshake 

Sets RTS/CTS Handshaking. 
When you select this checkbox, the 
ready to send (RTS) line fluctuates 
between on and off. 
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Field  Description 
  RTS On 

Delay 
Sets, in milliseconds, the amount 
of  time Config600 waits after 
turning on the ready to send 
(RTS) signal before beginning 
transmission. The default is 0. 
You can change this value to 
optimise communications.  
The default value should be 
sufficient for dial-up modems and 
EIA-232 (RS-232) connections. 
For older radios, you may need 
to set this value to 0.2 seconds. 
For newer radios, 0.02 seconds 
should be sufficient. 

  RTS Off 
Delay 

Sets, in milliseconds, the amount 
of  time Config600 waits after 
transmitting a message before 
turning off the ready to send 
(RTS) signal. The default is 0. 
You can change this value to 
optimise communications.  
The default value should be 
sufficient for dial-up modems and 
EIA-232 (RS-232) connections. 
For radios, a value of 0.01 may 
be appropriate. 
Note: These variables may 

change per your 
situation. These are 
general values that you 
need to assess for each 
circumstance. 

Address Map Identifies the Modbus file Config600 uses to map 
data.  
Click Edit (if present) to open the Modbus Editor and 
edit the file (see Chapter 14, Modbus Editor for more 
information).  

IP Address If  you select the Modbus (Master) function and the 
Ethernet or Modbus protocols, enter a Slave IP 
Address in addition to identifying the port. 

Server Address Indicates the TC/IP address of the NTP server used 
for time synchronisation.  
Note: This option displays only when you select 

NTP. 
Slave Address If  you select the Modbus (Slave) function, you must 

also complete the Slave Address field. This is a 
switch, not an IP address. Enter either a valid 
Modbus address between 1 and 247 or enter 0. If 
you enter 0, then the Modbus task uses the value 
entered on the S600+ (refer to Chapter 7, Startup, in 
the FloBoss S600+ Flow Manager Instruction 
Manual, Form A6115). This is useful when multiple 
streams with identical configurations require unique 
slave addresses. 
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Field  Description 
Update Interval Indicates how frequently the S600+ connects with 

the NTP server and checks for time drift. Valid 
values are Disabled (the default), Daily, or Weekly. 
Click  to display all values. This update occurs 
between 10 and 50 seconds past the minute.  
Note: This option displays only if you select NTP. 

Max Time Drift Defines (in milliseconds) the threshold at which the 
the S600+ resets its internal clock. This threshold is 
the maximum point of difference between the NTP 
server and the S600+. For example, if the difference 
between the NTP server and the S600+ check 
exceeds this value, the S600+ clock adjusts. Any 
resynchronisations appear in the event log. The time 
difference is in module (+/- Max time drift). 
Note: This option displays only when you select 

NTP.  
Alarm Accept on 
TX 

Allows the S600+ to automatically acknowledge and 
accept alarms locally when they are transmitted on 
the Modbus link. With this option enabled, the S600+ 
accepts all alarms when polled for any data.  

Read Only Prevents the Modbus link from writing data to the 
S600+.  

Secondary Link If  you select the Modbus (Slave) function and the 
Ethernet (RTU) or Modbus/TCP protocol, select 
Secondary Link in Dual Ethernet Systems to indicate 
that the slave unit is on the secondary Ethernet port.  
Note: Modbus (Master) is not supported on the 

second network card. 
Setup Peer to 
Peer Options 

Click to display the Peer Params Setup dialog, which 
you use to select options for peer-to-peer 
networking.  
Note: This option displays only when you select 

the Peer Master Link or Peer Slave Link. 
Link to Stream 
Assignment  

Assign streams in an ascending order to Comm 
Links in an ascending order. For example, Streams 
1 and 2 to Link 1; Streams 3 and 4 to Link 2; and 
Streams 5, 6, and 7 to Link 3. 
Note: This option displays only when you select 

the GDUS Link 1 or Coriolis Link 1. 
 Stream Select the stream to which to link 

the stream. 
 Address Enter the address to which to link 

the stream. 
 
Notes:  

 If you select the Modbus (Master) function and the Ethernet or 
Modbus protocols, you must provide a slave IP address in addition 
to identifying the port.  

 If you select the Modbus (Slave) function and the Ethernet or 
Modbus protocol, a Secondary Link check box appears at the 
bottom of the screen below the Address Map field. Select this 
option to indicate that the slave unit is on the secondary Ethernet 
port.  
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 If you select the Printer function for multiple tasks, all the tasks can 
have the Printer function.  

 
4. Once you are done configuring communications, click on the 

hierarchy menu. Config600 displays an Apply Changes dialog box.   

5. Click Yes to apply the changes to the configuration file. The 
PCSetup screen redisplays.  

4.10.2 Setting Up Peer-to-peer Options  
To set up peer-to-peer communication options, refer to Appendix F, 
Peer-to-peer Link Communications.  
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Use Stations to provide functions, such as station totals, batching, flow 
switching, and proving. They may also provide a common point for 
chromatograph information, sampler output, header density 
measurement and the corresponding liquid volume correction 
calculations.  
Streams can work stand alone, but you may also assign a stream to a 
station together with other streams. For example, stations can provide 
proving functions to streams you configure in other S600+ computers. 

If you assigned streams to stations during the initial configuration 
process, then up to two stations appear as choices in the hierarchy 
menu in the left pane. The stations can be gas or liquid or one of each. 

Notes: 
 For station summation of stream flowrates to work correctly, all 

stations must have at least one stream configured. 

 Some station settings affect stream settings.   

 

Figure 5-1. Stations on the Hierarchy Menu  

Stations 
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Station settings for the S600+ allow the configuration to be organised 
according to the application’s operational requirements. The initial 
configuration process assigns default values to the station settings. 
Using the PCSetup Editor, you can define alarm limits for a maximum 
of two stations in each configuration file. 

To edit the station settings, select the required station from the left 
pane (hierarchy menu) in the PCSetup Editor. 

Note: You can also access and edit station settings through the 
System Editor and the System Graphic.  

Station settings include:  
Common Station Settings  Flow Rate Limits  

 Station Averaging 
 Secondary Units Station Setup 

Gas Station Settings  Flow Switching (Station)  
 Batching (Refer to Batching) 
 Density Measurement (Refer to Stream 

Configuration) 
 Chromatograph Data 

Liquid Station Settings  Product Table (Refer to Batching) 
 Batching (Refer to Batching) 
 Proving (Refer to Proving) 
 Flow Switching (Station)  
 Density Measurement (Refer to Stream 

Configuration) 
 Sampling 
 Liquid Volume Correction 
 Flow Balance Setup  

5.1 Station Flowrate Limits  
Flowrate settings define the alarm setpoints for each type of flowrate. 
You can enable up to four types of alarms for each flowrate. The 
settings enable or disable the alarms, and are system-activated when 
the calculated result for the relevant flowrate is not within the limits 
you specify.   

Editing Flowrate 
Alarms 

To edit or activate flowrate alarm settings:  

1. Select the Flowrate component from the hierarchy menu. The 
system displays the associated settings in the right-hand pane.  
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Figure 5-2. Flowrate Options  

2. Double-click the required flowrate object. The system displays a 
Calculation Result dialog box.  

 

Figure 5-3. Calculation Result dialog box  

3. Select one or more alarms to enable. The system adds limit fields 
and default values to the dialog box.  
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Figure 5-4. Calculation Result (with limits)  

4. Review and modify the limits for any alarms you have enabled.  
5. Click OK to apply the changes to the configuration file. The 

PCSetup screen displays your changes.  

 

Figure 5-5. Flowrate Alarms with Limits  

5.2 Station Averaging Temperature & Pressure 
Use the Station Averaging settings to set the alarm limits of the 
average temperature and pressure and define how the S600+ performs 
averaging.  

1. Select the Average Temp & Pres component from the hierarchy 
menu. The system displays the associated settings in the right-hand 
pane.  
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Figure 5-6. Average Temp & Pressure 

2. Select an averaging mode. Click  to display all valid options:  
Value  Description 
All Average the pressure and temperature of all streams, 

regardless of status.  
All Online Average the pressure and temperature of only those 

streams currently on-line.  
1st Online Use the pressure and temperature of the first stream 

on-line as the average station pressure and 
temperature.  

 
3. Click STN TEMP or STN PRESS to display a Calculation Result 

dialog box.  

  

Figure 5-7. Calculation Result dialog box for Temp & Pressure  

4. Select the appropriate alarms to enable and indicate the specific 
values (temperatures and pressure in pre-defined units) for each 
alarm.  

5. Click OK to apply the changes. The PCSetup screen displays.  
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5.3 Station Secondary Units Setup 
The station secondary units setup allows for the configuration of 
selected flow rates and totals in different units as selected in the unit’s 
section.  
1. Select the Secondary Units STN Setup component from the 

hierarchy menu. The system displays the associated settings in the 
right-hand pane.  

 

Figure 5-8. Secondary Units STN Setup 

2. Select the Gas STN Setup or Liquid STN Setup button to display 
the Dual Units Setup dialog. 

Note: The dialog box consists of two screens (Cumulative Totals and 
Periodic Totals). You can switch between each screen by 
selecting the To Periodic Totals/To Cumulative Totals 
button. 
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Figure 5-9. Dual Units Setup – Cumulative Totals dialog box  

3. The Cumulative Totals screen consists of the following: 

 The first 4 slots are pre-defined and indicate the available flow 
rates.  

 You can configure the next 8 slots as station cumulative totals.  

 The last slot is pre-defined and indicates which station is linked 
to the selected Dual Units Setup instance. 

To add a cumulative total, click on the Add button, and the first 
available cumulative total appears. Use the  button to change the 
cumulative total for each slot.  

Note:  You should only configure Station Cumulative Totals. 
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Figure 5-10. Dual Units Setup  – Periodic Totals dialog box  

4. Click the the To Periodic Totals button to view the Periodic Totals 
screen. The Periodic Totals screen consists of the following: 
 Pre-defined Slot 1 is read-only and indicates the converted 

flow rates and cumulative totals.  
 Pre-defined Slot 2 is read-only and indicates the converted 

periodic totals. 
 You can configure the next 12 slots as periodic totals. 

To add a periodic total, click on the Add button. Use the  button 
to select the required periodic total.  

Note:  You should only configure Periodic Totals belonging to the 
selected station. 

5. Click OK to apply the changes. The PCSetup screen displays. 

5.4 Station Flow Switching  
Flow Switching settings define the method and parameters that 
determine which streams should open and close. You can set up flow 
switching for a station and then disable it until you need this option.  

1. Select Flow Switching from the hierarchy menu. The Flow 
Switching screen displays. 
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Figure 5-11. Flow Switching screen 

2. Complete the following fields.   
Field  Description 
Enabled Disables flow switching for the station. The default is 

checked (flow switching is enabled). 
Algorithm Sets the algorithm to open and close streams. The 

default is 1. 
Note: Refer to Appendix C, Batching, for algorithm 

descriptions. 
Flowrate 
Setpoint 

Sets, if applicable, the required station flowrate. 

Loading Units Identifies whether the measured flowrate is Mass (=1) 
or Volume (=0) units. The default is Volume. 

Auto Close 
First 

Identifies whether to close highest priority stream first 
(checked) or to close lowest priority stream first. 
Note: This does not apply to Algorithm 1. 

Manually Open 
First 

Select to open the first stream manually. 

Manually Close 
Last 

Select to close the last stream manually.  

Deviation Time Sets the minimum time the flowrate must be above or 
below the limit before automatically opening or closing 
a stream. 

Post Move 
Time 

Sets a delay time after opening or closing a valve 
before moving to the monitor flow stage. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
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4. Click Yes to apply your changes. The PCSetup screen displays.  

5.5 Station Gas Composition 
Station Gas Composition settings define the processing and port 
telemetry parameters for stations receiving data from the gas 
chromatograph controller. The chromatograph controller measures the 
individual component concentrations found in the line gas. The 
chromatograph controller settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the 
chromatograph data are not within specified limits.  

1. Select Gas Composition from the hierarchy menu. The Gas 
Composition screen displays.   

 

Figure 5-12. Station Gas Composition screen  

2. Complete the following fields.  
Field  Description 
Type Indicates the chromatograph configuration. Click  to 

display all valid values.   
 KP ONLY Not controller-connected; uses 

information entered via keypad. This 
is the default. 
Note: If  you select KP ONLY, the 

system hides a number of 
f ields on this screen. 

 CHROMAT A Controller connected; uses data 
f rom Chromatograph A. If a fault is 
detected on Chromatograph A, then 
the system uses data from 
Chromatograph B (if healthy) or 
keypad data / last good data as 
fallback. 
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Field  Description 
 CHROMAT B Controller connected; uses data 

f rom Chromatograph B. If a fault is 
detected on Chromatograph B, then 
the system uses data from 
Chromatograph A (if healthy) or 
keypad data / last good data as 
fallback. 

 CHROMAT 
AUTO 

Controller connected; uses data 
f rom both Chromatographs based 
on the new analysis flag (GC A → 
GC B → GC A → GC B). If a fault is 
detected on one of the 
Chromatographs, then the data from 
the other is used. If a fault is 
detected on both Chromatographs, 
then the keypad data / last good 
data is used as fallback. 

Initial Mode Indicates the operational mode for the in-use 
composition data. Click  to display all valid values.  

 KEYPAD Use data entered via keypad. This is 
the default.  

 CHROMAT Use live data from the 
chromatograph controller.  

 DOWNLOAD Download gas composition data 
directly to each stream. Used only if 
connected to a remote supervisory 
computer.  

 USER Use customised program for gas 
composition in S600+.  

 KEYPAD_F Start by using keypad-entered data 
then switch to chromatograph data 
when a good analysis is received.  

Acceptance 
Type 

Indicates how the S600+ manages in-use data. Click 
 to display all valid values.  

 ACC/COPY Copy and normalise keypad data to 
in-use data only after it is accepted. 
This is the default.  

 ACC/NORM Copy normalised keypad data to in-
use data after it is accepted.  

 AUTO/NORM Automatically copy normalised 
keypad data to in-use data.  

Station Number Sets the station associated with this stream. The 
default is 1. 

Apply Splits Indicates the type of analyser connected to the S600+. 
For a C6+ analyser, use the C6Plus option. Click  to 
display all valid values. The default is NO SPLITS.  
If  you select any value other than NO SPLITS, the 
system displays the MOLE SPLITS button. Use it to 
define the specific percentage splits for the gases.  
Note:  This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type.  

Revert to Last 
Good after 
Failure  

Continues using the last good composition in the event 
of  failure. Otherwise, the system reverts to keypad 
data.  
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Field  Description 
Check Critical 
Alarms  

Marks the received composition as failed if any critical 
alarm is set (such as the pre-amp fail on the Danalyzer 
for a Daniel 2551 Controller).  
Note:  This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

Check Non 
Critical Alarms  

Marks the received composition as failed if any non-
critical alarm is set (such as the pre-amp fail on the 
Danalyzer for a Daniel 2551 Controller).  
Note: This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

CHROMAT 
COMMS 

Click to display the Comm screen in I/O Setup.  

Initial Mode Identifies the chromatograph and any fallback 
controllers. Currently, the only valid value is PAY, 
which indicates one chromatograph and no fallback 
controller.   
Note: This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type.  

Type Indicates the type of chromatograph controller. Click  
to display all valid values.    
Note:  This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

 2551 EURO S600+ is connected to a Daniel 
2551 (European) controller. This is 
the default.  

 2350 EURO S600+ is connected to a Daniel 
2350 (European) controller set in 
SIM_2251 mode.  

 2350 USA S600+ is connected to a Daniel 
2350 (USA) controller set in 
SIM_2251 mode.  

 2251 USA S600+ is connected to a Daniel 
2251 controller.  

 Generic S600+ is connected to another type 
of  controller. 

 Siemens S600+ is connected to a Siemens 
Advance Maxum via a Siemens 
Network Access Unit (NAU).  
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Field  Description 
MOLE ORDER Click this button to display a dialog box on which you 

indicate the order in which the gas composition 
information comes into the S600+ via telemetry. 0 
indicates any component which is not included in the 
Modbus map.  
Note: 
 The Modbus map you create must be compatible 

with the controller to which the S600+ is connected. 
Refer to Chapter 14, Modbus Editor, for further 
information. 

 This field displays only if you selected CHROMAT 
A, CHROMAT B, or CHROMAT AUTO as the 
chromatograph configuration type. 

 This is applicable only if you select Siemens or 
Generic in the Type field. 

Address  Configures multi-drop chromatograph support. Do not 
change unless advised to do so.   
Note:  This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

Stream  Sets the chromat analysis stream assigned to this 
metering stream. The default is 0.  
Note:  This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. If you need to support more than one 
stream, contact Technical Support.  

Analysis 
Timeout  

Sets the maximum number of seconds the S600+ 
waits to receive a new composition from the 
chromatograph controller before raising an alarm. The 
default is 900.  
Note: This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

Download 
Timeout  

Sets the maximum number of minutes the S600+ waits 
to receive a new composition from the supervisory 
computer before raising a DL Timeout Alarm. The 
default is 15.  
Note:  
 A value of 0 disables the timeout. 
 This field displays only if you select KP ONLY in 

the Type field. 
KEYPAD 
MOLES 

Click to display a dialog box you use to define mole 
percentage values for each gas component.   
Note:  The system assumes the keypad composition 

adds to 100% (normalised) when the 
Acceptance Type is ACC/COPY. If you select 
ACC/NORM or AUTO/NORM, the system 
automatically normalises the keypad 
composition.   
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Field  Description 
MOLE 
ADDITIONAL 

Click to display a dialog box you use to define mole 
percentage values for gas components not analysed 
by the Danalyzer. The system assumes any additional 
components to be normalised values, so the analyser 
components are re-normalised to (100 – sum of 
additional components).  
Note:  This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

USER MOLES Click to display a dialog box you use to define mole 
percentage values for each gas component. The 
system assumes user moles to be normalised.   
Note: The S600+ uses these values only if you set 

the Initial Mode to USER. A Modbus 
download from another computer may 
overwrite these values on a running 
configuration.  

Check Limits Enables limit checking on each gas component. When 
you select this check box, the MOLE LO LIMITS and 
MOLE HI LIMITS buttons display.  

MOLE LO 
LIMITS 

Click to display a dialog box you use to define low 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:  
 The system uses the values you enter through 

these buttons only if you select the Check Limits 
check box. The system applies this test to the 
keypad, downloaded, user, additionals, and new 
analysis components. When enabled, the system 
applies the limit check against the high and low 
limits. Limits are considered valid if the limit is 
greater than zero (0). The system also applies the 
check to the Total field. If you disable the limit 
check, the keypad, downloaded, and user Total 
f ield must lie within 0.1% and 150%. A sum of the 
new analysis must be within 99.5% and 100.5%.  

 This field displays only if you place a check mark 
in the Check Limits field. 

MOLE HI 
LIMITS 

Click to display a dialog box you use to define high 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component. 
Note: See note in description of Mole Lo Limits field.  

Check 
Deviations 

Enables checking on the deviation from the last good 
analysis for each component. When you select this 
check box, the MOLE DEVN LIMITS button displays.  
Note: This field displays only if you selected 

CHROMAT A, CHROMAT B, or CHROMAT 
AUTO as the chromatograph configuration 
type. 

MOLE DEVN 
LIMITS 

Displays a dialog box you use to define the maximum 
deviation allowed for each gas component. Enter 0 in 
any field to prevent the test for the selected 
component.  
Note: This field displays only if you place a check 

mark in the Check Deviations field. 



Config600 Configuration Software User Manual 

Revised January 2023 Station Conf iguration 5-15 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

5.6 Sampling  
Sampling defines the method and interval period for sampling product 
from a flowing pipeline. By default, Config600 supports one sampler 
per stream. Config600 uses the following stages during the sampling 
process:  

Stage  Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl  
4 Post Pulse  
5 Stopped Manually  
6 Stopped Can Full  
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch  
12 Stopped Initialise  
13 Can Switch Over 

 

1. Select Sampling from the hierarchy menu. The system displays the 
associated settings in the right-hand pane.  

Note: Batch auto-resets the sampler at the start of the batch. 
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Figure 5-13. Station Sampling  

2. Complete the following fields:  
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 

stream or station must have a unique sampler ID. This 
value, which must be greater than 0, is for identification 
purposes only and is not used in any calculation.  

Method Identifies a sampling method. Click  to display valid 
values.  

 Time Prop Divides the value in the Can Fill 
Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Grab Volume 
values) to determine a time interval 
per pulse. This is the default. 

 Flow Prop1 Divides the value in the Expected 
Volume/Mass field by the number of 
grabs needed to fill the can (derived 
f rom the Can Volume and Grab 
Volume values) to determine a 
volume throughput per pulse. 

 Flow Prop2 Uses the value in the Expected 
Volume/Mass field as the volume 
throughput per pulse. 

 Flow Prop3 Uses the value in the Expected 
Volume/Mass field as the volume 
throughput per pulse, but supports 
low pressure digital input and pump 
prime output. 

Mode Indicates the sampling mode. Valid values are Single 
(acquire sample in one can) or Dual (acquire sample 
in two cans).The default value is Single. 
Note: If  you select Dual, the sampler switches to a 

second can when the current can is full 
(according to the twin can changeover mode).  
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Field  Description 
Can Fill 
Indicator 

Determines when the sampling can is full. Click  to 
display valid values.  

 Grab Count Uses the number of pulses output to 
the sample to determine when the 
can is full. This is the default. 

 Dig I/P  Uses a digital input to determine 
when the can is full.  

 Analog I/P Uses an analog input to determine 
when the can is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select one of the check 
boxes to identify the event.  

 On Can Full Disables the sampling process 
when the can is full. 

 On Flowrate 
Limit 

Disables the sampling process 
when the flowrate is less than the 
value of the Flowrate Low Limit. 

 On Flow 
Status 

Disables the sampling process 
when the flow status value is not on-
line. 

Auto Restart  Automatically restarts the sampling process following 
an automatic disabling.  

Expected 
Volume / Mass  

Indicates, in cubic meters, the flow volume or mass 
during which the samples are to be taken. This is the 
value the Flow Prop1 and Flow Prop2 sampling 
methods use for their calculations. The default is 1000. 

Can Fill Period  Indicates, in hours, the amount of time required to fill 
the sampling can. This is the value the Time Prop 
sampling method uses for its calculations. The default 
is 24. 
Note: This field is required for the TIME PROP 

sampling method. 
Flowrate Low 
Limit  

Indicates, in cubic meters, the flowrate limit for the Auto 
Disable on Flowrate option. The default is 0. 
Note: This field is required if you select the On 

Flowrate Limit check box for Auto Disable. 
Minimum 
Interval  

Indicates, in seconds, the minimum amount of time 
between grabs. This is the value the Time Prop 
sampling method uses for its calculations. The default 
is 30. 
Note: If  the sample exceeds this limit, the system sets 

the overspeed alarm and increments the 
overspeed counter. 

Can Volume Indicates, in cubic meters, the volume of the sampling 
can. The default is 0.5. 

Grab Volume Indicates, in cubic meters, the volume of the sampling 
grab. The default is 0.001. 

Can Low Limit  Indicates the low alarm value as a percentage of the 
can volume. The default is 5. 

Can High Limit  Indicates the high alarm value as a percentage of the 
can volume. The default is 90. 

Can High High 
Limit  

Indicates the high high alarm value as a percentage of 
the can volume. The default is 95. 

Twin can 
changeover 
mode  

Indicates whether the system automatically changes to 
a second sampling can. Click ▼ to display valid 
values.  
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3. Click the hierarchy menu when finished. A confirmation dialog 
box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

5.7 Prover Configuration Screens 
This section provides an overview of the four S600+-supported 
proving methods—bi-directional, uni-directional, compact, and master 
meter—and their specifications and applications.  

Note: Refer to Appendix B, Proving, for additional information. 

The uni-directional prover differs from the bi-directional prover only 
in the run control sequence described in Prover Run Control Stages. 

Station Based With release 3.0 of Config600 software, proving is a station-based 
function. Each S600+ can support two stations, and you can assign up 
to 10 streams (depending on the complexity of the configured 
streams) to each station. The provers do not need to be the same type. 
However, the S600+ supports only one Prover (P154) module, which 
means that you can perform only one prove sequence at a time. 

You can configure the streams to be proved either internally (within 
the same S600+) or externally in other S600+ flow computers (using a 
Modbus communication link to transfer process data to the prover). 
The S600+ does not provide an option supporting both internal and 
external streams in one configuration. 
You select the prover type when building the configuration with the 
PCSetup Wizard. 

Local or Remote The software also allows you to prove streams that are “local” (that is, 
part of the same configuration) or prove streams that are “remote” (in 
a separate configuration or separate S600+) to the prover. 

However, you cannot mix the two (for example, have a prover config 
with three metering streams and prove a remote, separate stream). If 
you require this feature, contact technical support. 

5.7.1 Flow Balance Setup 
Use flow balancing in conjunction with proving to regulate the flow 
through the meters to maintain a set flowrate through the prover.  

The objective is to distribute the flow evenly across available streams. 
If the overall flowrate through the skid increases, flow balancing can 
open another meter run, or if the flow reduces the flow balancing, it 
can close a meter run to maintain an optimum flowrate through each 
meter. 
You can open and close meter runs by configuring the streams to open 
and close valves. 
1. Select Flow Balance Setup from the hierarchy menu. The system 

displays Flow Balance settings in the right-hand pane.  
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Figure 5-14. Flow Balance Setup screen 

2. Complete the following fields:  
Field  Description 
Flow Rate Select the source of the proof flowrate. Valid values 

are Preset (sets the proof flowrate to the Preset data 
f ield value plus the Offset data field value) or 
Snapshot (sets the proof flowrate to a snapshot of the 
stream under prove flowrate plus the Offset data field 
value). The default is Preset. 

Preset Sets the proof flowrate. 
O/P 
Initialisation 

Sets the initial manual mode output position for the 
prover flow control valve. The default value is 50. 

Tolerance 
Band 

Sets the tolerance for the deviation of the prover 
f lowrate and its setpoint during the prove. The prove 
aborts if this value is exceeded. The default value is 
60. 

Offset Sets a flowrate to be added to the proof flowrate to 
offset the change in flowrate between the prover and 
the stream under prove. The default value is 0. 

Wait Time Sets, in seconds, how long the S600+ waits for the 
proof flowrate to achieve before moving to the hold 
stability stage. The default value is 300. 

Hold Time Sets, in seconds, how long the S600+ holds the proof 
f lowrate before starting prover runs. The default value 
is 60. 
Note:   S600+ aborts the prover sequence if stability is 

lost during the stability Hold Time. 
Adj. Interval Sets a time interval between making successive 

adjustments to the non-proving streams flowrate. 
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Field  Description 
PID Loop Sets the PID loop you use to control the flowrate at the 

prover. Click ▼ to display valid options. The default is 
None. 
Notes: 
 This field displays only if you have configured a PID 

Control calctable or used the PRV01 CNTRL 1 and 
PRV01 CNTRL 2 by changing type to PID Control. 

 You define flowrate band settings for each stream 
on the Flowrate screen. 

5.7.2 Prover – Ball (Bi-Directional) (Liquid Only) 
Two components enable you to control the prove:  

 Prove sequence – Station-based function which sets up the prove 
environment. 

 Run control – Prover-based function that drives the 4-way valve, 
counts pulses, and performs the K-factor calculations. 

Following a successful prove, the system verifies the stream normal 
flow rate value:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount 
of time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations. 

 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved but does not use the data until it is accepted either locally at 
the S600+ or via a supervisory computer. 

When the prove runs complete, you can either re-run the prove or 
terminate, at which point (if so configured) the sequence restores the 
valves to their pre-prove state. 

Notes: 

 The prove sequence downloads both a K-factor and a meter factor. 
Applications typically use the original K-factor from the meter 
calibration report and update the meter factor, which may be either 
a fixed value or derived from a linearisation process. Alternatively, 
the meter factor can remain unchanged, and the K-factor (fixed or 
linearised) updated.  

 The meter factor deviation tests and the historical meter factor 
database are only supported for "local" streams (part of the same 
configuration with the prover) if you configure the stream normal 
flow rate to a value greater than zero. 

 You define a ticket as Official or Unofficial when you configure a 
prove. This selection applies to both the Aramco-style and non-
Aramco-style linearisation. 
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Following an Official prove, the prove sequence is determined by 
the Aramco / non-Aramco style linearisation selection. 
Following the Unofficial prove, the prove sequence does not 
download the prove results to the stream being proved. This is 
typically used to determine an approximate K-Factor / Meter 
Factor before an official prove takes place or when maintenance 
activities are being performed on the site.  

 The Official/Unofficial selection displays in the report header. 

 
Run Data Run Data settings allow you to define the prover stability check 

variables, the number of prove runs from which the system can 
calculate a K-factor/meter factor, and the tolerances allowed on the K-
factor/meter factor.  Once the S600+ completes a prove and calculates 
these values, you can select a new K-factor or meter factor to replace 
the current K-factor or meter factor.  

To edit the prover run data settings:  

1. Select Run Data from the hierarchy menu. The Run Data screen 
displays.  

 

Figure 5-15. Run Data screen (Ball Prover) 
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2. Complete the following fields.  
Field  Description 
Override Disables temperature and pressure stability checking. 

The default is unchecked (stability checking is 
enabled).   
Note: If  you do not enable this option, you must 

complete the Wait Time and Hold Time fields.  
Wait Time Sets, in seconds, how long the S600+ waits for stability 

before moving to the hold stability prover stage. The 
default is 60.  

Hold Time Sets, in seconds, how long the S600+ holds stability 
before starting prover runs. The default is 10.  
Note:  The S600+ aborts the prover run if stability is 

lost during the stability hold time.  
Required Sets the required number of consecutive runs which 

must be within the defined tolerance limits (typically, 5). 
The default is 5.  
Note:  It is possible that the number of required runs 

cannot be achieved before the maximum 
number of runs reached. In this situation, the 
user can either wait for the prove to abort 
(once the maximum number of runs has been 
reached) or perform a manual abort. 

Maximum Sets the maximum number of runs to perform before 
aborting the sequence (up to 12 for the S600+). The 
default is 12.  

Average 
Method 

Indicates the value to determine the repeatability and 
to indicate whether the final K-factor and meter factor 
are taken as the average of the run values, or are re-
calculated. Click ▼ to display valid values. 

 METER 
FACTOR 

Use the run Meter Factors for 
repeatability and the average 
Meter Factor as the final value. 
The default is METER FACTOR. 

 K-FACTOR Use the run K-factors for 
repeatability and the average K-
factor as the final value. 

 PULSES Use the run pulse counts for 
repeatability. This option also 
signifies to recalculate the final 
K-factor and Meter Factor using 
the average pulse count and 
other average values. See API 
Ch.12 Section 2 part 3. 

Time Sets, in seconds, the amount of time either between 
forward and reverse prover runs or between full prover 
runs. The default is 5.  

Tolerance Sets, as a percentage, the maximum deviation allowed 
before a run is unacceptable. The default is 1. 

Algorithm Indicates the algorithm the system uses to calculate 
the K-factor tolerance. Click  to display valid values.  

 API I API method: max deviation from 
(Average – Run) / Average. This is 
the default. 

 MX-MN/AVG (Max – Min) / Average 
 MX-

MN/MX+MN2 
(Max – Min) / ((Max + Min) / 2) 

 MX-MN/MN (Max – Min) / MIn 
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Field  Description 
 MX-

MN/MX*MN 
(Max – Min) / (Max * Min) 

 MX-AV/AV (Max – Average) / Average 
 AV-MN/AV (Average – Min) / Average 
 STATISTICAL Calculates the statistical k-factor 

deviation using a Student-t table 
distribution.  

Conf. Level Sets the confidence level for a two-sided Student-t 
table used in statistical proving. Click  to display valid 
values. For more information, see Appendix B, 
Proving.  
Note: This field displays only if you select 

STATISTICAL in the Algorithm field.  
Prover mode Indicates the prover mode. Click  to display valid 

values.  
 BIDI 4-WAY Bi-directional prover mode. This is 

the default.  
 UNI ROTORK Uni-directional prover using a 

ROTORK valve. 
 UNI TYPE 2 Uni-directional prover with no valve 

driving and assumes an external 
valve controller. 

Enable User 
Stages 

Enables Logicalc user stages. The default is 
unchecked (user stages are disabled).  

User Student-t 
Table 

Indicates the Student-t table values for degrees of 
f reedom 1-40. For more information, see Appendix B, 
Proving. 
Note: These fields display only if you select 

STATISTICAL in the Algorithm field and USER 
in the Confidence Level field.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
Constants The Constants screen has two major areas. One area (consisting of the 

Stability R.O.C, Stability Bands, and Base Volume panes) defines 
stability checking parameters. The other area (consisting of the 
Reference, Setup, and Misc panes) provides set-up information for the 
prover, including reference conditions and physical properties.  

1. Select Constants from the hierarchy menu. The Constants screen 
displays.   



Config600 Configuration Software User Manual 

5-24 Station Conf iguration Revised January 2023 

 

Figure 5-16. Constants screen (Ball Prover)  

2. Complete the following fields. 
Field  Description 
Temperature 
(Stability 
R.O.C.) 

Sets, in seconds, the Rate of Change (ROC) threshold 
limit for temperature, which the S600+ uses to check 
the ROC between the inlet, the outlet, and the meter. 
The default is 0.1. 

Pressure 
(Stability 
R.O.C.) 

Sets, in seconds, the Rate of Change (ROC) threshold 
limit for pressure, which the S600+ uses to check the 
ROC between the inlet, the outlet, and the meter. The 
default is 0.5. 

UVOL Sets, in seconds, the Rate of Change (ROC) threshold 
limit for the stream uncorrected volume (UVOL) 
f lowrate. The default is 10. 

Temperature 
(Stability 
Bands) 

Sets the maximum temperature difference between the 
inlet, the outlet, and the meter. The default is 10. 

Pressure 
(Stability 
Bands) 

Sets the maximum pressure difference between the 
inlet, the outlet, and the meter. The default is 10. 

Base Volume  
1 through 4 

Sets the calibration volume (base volume) between the 
relevant sphere switches.  
Note:  
 Click Initial to identify the required base volume. 

These values are critical to the calculations. 
 The base volume should be entered as twice the 

calibrated volume (i.e., the round-trip volume). 
Valid values are:  
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Field  Description 
 1 Defines the calibration volume between sphere 

switches 1 and 3. The default is 1. 
 2 Defines the calibration volume between sphere 

switches 2 and 4. 
 3 Defines the calibration volume between sphere 

switches 1 and 4.  
 4 Defines the calibration volume between sphere 

switches 2 and 3. 
Pre Switch 
(Forward) 

Sets the forward pre-run volume (that is, the volume 
before switch 1). The default is 0. 
Note: Set this field to zero (0) to disable timeouts. 

Pre Switch 
(Reverse) 

Sets the reverse pre-run volume (that is, the volume 
before switch 1). The default is 0. 
Note: Set this field to zero (0) to disable timeouts.  

Cal 
Temperature  

Sets the reference temperature value for calculations 
(typically 15°C in Europe). The default is 15. 

Cal Pressure  Sets the reference pressure value for calculations 
(typically 0 barg in Europe). The default is 0. 

CTL 
Temperature 

Sets the reference temperature for the correction of the 
temperature of the liquid factor. The default is 15. 

Density Units Indicates the density units Config600 uses for the 
density correction calculations. Click  to display all 
valid values.  

 DEG.API  Use degrees API.  
 KG/M3  Use kilograms per cubic meter. This 

is the default.  
 S.G. Use specific gravity.  
 CH. 11 2004/7 

CUST 
Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 NORSOK  
I-105 

Use Norsok I-105 Appendix D density 
corrections. 

Product Type Indicates the type of petroleum product involved in the 
calculation. Click  to display all valid values.  

 TABLE 
LOOKUP 

S600+ reads values from a file in the 
Config600 3.0/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The default files 
hold values for the ASTM-IP 
Petroleum Measurement Tables 1952 
Tables 5 and 6. 
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Field  Description 
 A CRUDE If  Density Table Units = KG/M3 and 

reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1980 
Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59A and 60A.  
If  Density Table Units = SG, 
Petroleum Measurement Tables 1980 
Tables 23A and 24A. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5A and 6A. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 
This is the default.  

 B REFINED If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1980 
Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59B and 60B.  
If  Density Table Units = SG, 
Petroleum Measurement Tables 1980 
Tables 23B and 24B. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5B and 6B. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 
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Field  Description 
 C SPECIAL If  Density Table Units = KG/M3, 

Petroleum Measurement Tables 1980 
Table 54C. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 1980 
Tables 23C and 24C. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5C and 6C. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 
Note: Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1982 
Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59D and 60D. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 1982 
Tables 23D and 24D. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1982 
Tables 5D and 6D. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 
54. 
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Field  Description 
 USER K0K1 If  Density Table = KG/M3, Petroleum 

Measurement Tables 1980 Tables 
53A and 54A with user entered 
values for K0 and K1. 
If  Density Table = SG, Petroleum 
Measurement Tables 1980 Tables 
23A and 24A with user entered 
values for K0 and K1. 
If  Density Table = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5A and 6A with user entered 
values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 AROMATICS 
D1555-95 

ASTM D1555-95 Table Lookup. 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 

CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses 
to calculate the liquid pressure correction factor. Click 
▼ to display all valid values.  
Note: This field does not display if you select Density 

Table Units CH.11 2004 CUST or CH.11 2004 
METRIC or a Gazprom Product Type because 
these standards also specify the CPL 
calculation. 

 OFF No CPL calculation. CPL value is set 
to 1.0.  

 API1121 API MPMS Ch.11.2.1 1984. 
 API1121M API MPMS Ch.11.2.1M 1984. The 

default is API1121M. 
 API1122 API MPMS Ch.11.2.2 1986. 
 API1122M API MPMS Ch.11.2.2M 1986. This is 

the default. 
 CONSTANT Use a value you enter. 
 DOWNER Paper entitled Generation of New 

Compressibility Tables for 
International Use presented by L. 
Downer 1979. 

Rounding Enables or disables calculation rounding. Click  to 
display valid values.  

 OFF Rounding is disabled. The default is 
OFF. 
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Field  Description 
 NATIVE Rounding to the rules specified in the 

selected calculation standard. 
 API Ch.12.2 

Part 2 
Rounding to API MPMS Ch.12.2 Part 
2 – Measurement Tickets 1995. 

 API Ch.12.2 
Part 3 

Rounding to API MPMS Ch.12.2 Part 
3 – Proving Reports 1998. 

 Flocheck Rounding to Emerson Flocheck 
verification software package. 

 ASTM 
D1250-04 
Ch. 11 

API MPMS Ch.11.1 2004 (ASTM 
D1250-04) method to round to the 
Petroleum Measurement Tables 1980 
Tables. 

Pipe Diam Sets the internal pipe diameter of the prover loop. The 
default is 500. 

Elasticity Sets the value for Young’s modulus of elasticity 
(expansion coefficient of tube steel), typically 2100000. 
The default is 10000. 

Wall Thick Sets the wall thickness of the prover loop. The default 
is 5. 

Tube Coeff Sets the tube temperature expansion coefficient, 
typically 0.000033. The default is 0.01. 

Density Factor Used in conjunction with METER (DF) to correct meter 
density to prover density. The default is 1. 

Location Used by volume v mass proving to select the location 
of  the prover density used to convert prover volume to 
mass. Click ▼ to display valid values. 

 AT PROVER Read density at the prover. This is the 
default value. 

 METER (C2) Use Meter Density * CTLp * CPLp / 
(CTLm * CPLm), defined for proving a 
Micro Motion Coriolis meter. 

 METER (DF) Use Meter Density * Density Factor 
 KNOWN 

PRODUCT 
Enter a value. 

Meter Factor 
Deviation 1 
Limit 

Sets the maximum allowed deviation from the initial 
base meter factor. The default value is 0.25%. The 
system uses this value while performing the proved 
meter factor deviation checks. Refer to Appendix B, 
Proving for further information. 
Note: This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

Meter Factor 
Deviation 2 
Limit 

Sets the maximum allowed deviation from the initial 
base meter factor. The default value is 0.1%. The 
system uses this value while performing the proved 
meter factor deviation checks. Refer to Appendix B, 
Proving for further information. 
Note: This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 
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Field  Description 
Meter Factor 
Reject Timeout  

Following a successful prove, this value specifies 
the time period before the current prove results are 
automatically accepted and totals are adjusted 
based on the current prove results. During this time 
period, the current prove results can be manually 
ACCEPTED (totals will be adjusted) or 
ACCEPTED NO ADJUST (no totals adjustment). 
The default is 40 seconds. Refer to Appendix B, 
Proving for further information. 
Note: This stage is performed only if you configure 

the meter normal flow to a value greater 
than zero (Aramco-style linearisation). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  

 
Hardware Hardware settings relate to the Prover (P154) module. You use these 

settings to define how the S600+ processes the raw pulse inputs to the 
prover. Typically, when the pulse count is low (less than 10,000 
pulses per round trip), the S600+ uses either “Phase Locked Loop”  or 
“Dual Chronometry”  processing. This effectively divides each pulse 
into smaller parts to maintain accuracy.  
1. Select Hardware from the hierarchy menu. The Hardware screen 

displays.  

 

Figure 5-17. Hardware screen (Ball Prover)   
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2. Complete the following fields.  
Field  Description 
Dual 
Chronometry 

Enables dual chronometry. Dual chronometry 
determines meter pulses by counting a series of whole 
meter pulses and then multiplying that value by the 
ratio of the time between the detector switches and the 
time required to accumulate the pulses. The default is 
unchecked (disabled).  

Phase Locked 
Loop 

Enables the phase locked loop. A phased locked loop 
multiplies the number of actual turbine pulses by a 
value (the Interpolation Factor) for greater accuracy. 
The default is unchecked (disabled). 
Note:  
 If  you select this check box, you must also provide 

an Interpolation Factor value.  
 If  you select this check box, and are not using a 

physical PIM module, the raw pulses need to be 
wired into the PIMLOOP input on the P154 prover 
board (inputs 8 and 20). 
Dual Chronometry and PLL can be used 
independently or together. 

Interpolation 
Factor 

Sets the interpolation factor value for the phase locked 
loops option, typically associated with the Pulse 
Interpolation Module (PIM). The default is 1. 
If  using a physical PIM module, the scaling factors 
should be set to 1 as the multiplication of the pulses is 
done in the PIM.  
Note:  
 This field displays only if you select the Phase 

Locked Loop option.  
 If  no physical PIM is used, the interpolation factor 

should be set between 0 and 1 where 1 indicates 
no interpolation (this value is used as a divider). 
For example, a value of 0.1 will cause the actual 
pulse count to be divided by 0.1 (in effect 
multiplying the value by 10). 

Number of 
Switches 

Indicates the number of switches in the prover. Click  
to display valid values. Valid values are 1, 2, and 4; the 
default is 2.  
Note: The base volume you use is determined by the 

number of switches you select.  
 If  you select 1, use Base Volume 1.  
 If  you select 2, use Base Volume 1. 
 If  you select 4, the base volume will 

determine which switches to use. 
For more information, refer to Appendix 
B.1.4.1, Number of Switches and Base 
Volume. 

3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.   

 
Alarm Limits The Alarm Limits screen sets the prover alarms. For a description of 

the alarms, refer to Alarm Descriptions in Chapter 7, Advanced Setup 
Configuration.  
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1. Select Alarm Limits from the hierarchy menu. The Alarm Limits 
screen displays.   

 

Figure 5-18. Alarm Limits screen (Ball Prover)   

2. Click any of the following buttons to set alarm limits.   
Button  Description 
RTRIP PULSES Click to display a Calculation Result dialog box you 

use to define the specific alarm limits for round trip 
(RTRIP) pulses.   
Note: In a bi-directional (BIDI) prover, this value 

ref lects the sum of forward and reverse pulses.  
RTRIP  
K-FACTOR 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for round trip K-
factors.  
Note: In a uni-directional prover, this value reflects the 

forward pulses.  
RTRIP 
M.FACTOR 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for round trip 
Meter Factors.   
Note: In a uni-directional prover, this value reflects the 

forward pulses. 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

5.7.3 Prover – Compact (Liquid Only) 
Two components enable you to control the prove:   

 Prove sequence – Station-based function which sets up the prove 
environment. 

 Run control – Prover-based function that drives the prover 
hardware, counts pulses, and performs the K-factor calculations. 
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Following a successful prove, the system verifies the stream normal 
flow rate value:  
 If the normal flow rate is set to a value greater than zero (Aramco-

style linearisation), the run control waits for a predefined amount 
of time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations. 

 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved but does not use the data until it is accepted either locally at 
the S600+ or via a supervisory computer. 

When the prove runs complete, you can either re-run the prove or 
terminate, at which point (if so configured) the sequence restores the 
valves to their pre-prove state.  
The compact prover has a small volume chamber so a proof run 
consists of repeated proof passes (a default of 5, a maximum of 39). 
The S600+ does not create a proof report, although you can add this 
option through a user stage. Contact Technical Support. 

Notes: 

 The prove sequence downloads both a K-factor and a meter factor. 
Applications typically use the original K-factor from the meter 
calibration report and update the meter factor, which may be either 
a fixed value or derived from a linearisation process. Alternatively, 
the meter factor can remain unchanged and the K-factor (fixed or 
linearised) updated.  

 The meter factor deviation tests and the historical meter factor 
database are only supported for "local" streams (part of the same 
configuration with the prover), if you configure the stream normal 
flow rate to a value greater than zero. 

 You define a ticket as Official or Unofficial when you configure a 
prove. This selection applies to both the Aramco-style and non-
Aramco-style linearisation. 

Following an Official prove, the prove sequence is determined by 
the Aramco / non-Aramco style linearisation selection. 

Following the Unofficial prove, the prove sequence does not 
download the prove results to the stream being proved. This is 
typically used to determine an approximate K-Factor / Meter 
Factor before an official prove takes place or when maintenance 
activities are being performed on the site.  

 The Official/Unofficial selection displays in the report header. 

Run Data Run Data settings allow you to define the prover stability check 
variables, the number of prove runs from which the system can 
calculate a K-factor/meter factor, and the tolerances allowed on a K-
factor/meter factor. Once the S600+ completes a prove and calculates 
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these values, you can select a new K-factor or meter factor to replace 
the current K-factor or meter factor.  
To edit the prover run data settings:  

1. Select Run Data from the hierarchy menu. The Run Data screen 
displays. 

 

Figure 5-19. Run Data screen (Compact Prover)   
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2. Complete the following fields.  
Field  Description 
Override  Disables temperature and pressure stability checking. 

The default is unchecked (stability checking is 
enabled).  
Note: If  you do not select this option, you must 

complete the Wait Time and Hold Time fields.  
Wait Time  Sets, in seconds, how long the S600+ waits for stability 

before moving to the hold stability prover stage. The 
default is 300.  

Hold Time Sets, in seconds, how long the S600+ holds stability 
before starting prover runs. The default is 10.  

Runs Reqd  Sets the required number of consecutive runs which 
must be within the defined tolerance limits (typically, 5). 
The default is 5.  
Note:  It is possible that the number of required runs 

cannot be achieved before the maximum 
number of runs reached. In this situation, the 
user can either wait for the prove to abort (once 
the maximum number of runs has been 
reached) or perform a manual abort. 

Passes Reqd  Sets the number of passes per prover run, to a 
maximum of 5. The default is 5.  

Runs Max  Sets the maximum number of runs to perform before 
aborting the sequence (up to 12 for the S600+). The 
default is 12.  

Average 
Method 

Indicates the value to determine the repeatability and 
to indicate whether the final K-factor and meter factor 
are taken as the average of the run values, or are re-
calculated. Click ▼ to display valid values. 

 METER 
FACTOR 

Use the run Meter Factors for 
repeatability and the average meter 
factor as the final value. This is the 
default. 

 K-FACTOR Use the run K-factors for 
repeatability and the average K-
factor as the final value. 

 PULSES Use the run pulse counts for 
repeatability. This option also 
signifies to recalculate the final K-
factor and Meter Factor using the 
average pulse count and other 
average values. API Ch.12 Section 
2 part 3. 

Switch Delay  Sets, in microseconds, the amount of time the S600+ 
waits before checking for switch 2. The default is 2.  
Note: This parameter helps eliminate bounce on 

single-switch prover applications.  
Averages Reqd  Sets the required number of pre-run average samples. 

The default is 0.  
Tolerance  Sets, as a percentage, the maximum deviation allowed 

before a run is unacceptable. The default is 1. 
Algorithm  Indicates the algorithm the system uses to calculate 

the K-factor tolerance. Click  to display valid values.  
 API 1 API method: max deviation from 

(Average – Run) / Average. This is 
the default. 

 MX-MN/AVG (Max – Min) / Average 
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Field  Description 
 MX-

MN/MX+MN2 
(Max – Min) / ((Max + Min) / 2) 

 MX-MN/MN (Max – Min) / MIn 
 MX-

MN/MX*MN 
(Max – Min) / (Max * Min) 

 MX-AV/AV (Max – Average) / Average 
 AV-MN/AV (Average – Min) / Average 
 STATISTICAL Calculates the statistical K-factor 

deviation using a Student-t table 
distribution.  

Conf. Level Sets the confidence level for a two-sided Student-t 
table used in statistical proving. Click  to display valid 
values. For more information, see Appendix B, 
Proving. 
Note: This field displays only if you select  

STATISTICAL  in the Algorithm field.  
Ready  Sets, in seconds, the maximum time the S600+ waits 

for the ready signal. The default is 300.  
Plenum  Sets, in seconds, the maximum time the S600+ allows 

for plenum control. The default is 0.  
Note: To disable plenum control, set this value to 

zero (0). 
Launch  Sets, in seconds, the maximum time the S600+ waits 

for switch 1 after the launch command. The default is 
300.  

Flight  Sets, in seconds, the maximum time the S600+ waits 
for switches 1 and 2 after the launch command. The 
default is 300.  

Retrieve  Sets, in seconds, the maximum time the S600+ waits 
for an upstream signal. The default is 300.  

Enable User 
Stages  

Enables Logicalc user stages. The default is 
unchecked (user stages are disabled). 

User Student-t 
Table 

Indicates the Student-t table values for degrees of 
f reedom 1-40. For more information, see Appendix B, 
Proving.  
Note: These fields display only if you select 

STATISTICAL in the Algorithm field and USER 
in the Confidence Level field.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  

 
Constants The Constants screen has two major areas. One area (consisting of the 

Stability R.O.C, Stability Bands, and Base Volume panes) defines 
stability checking parameters. The other area (consisting of the 
Reference, Setup, Plenum, and Misc panes) provides set-up 
information for the prover, including reference conditions and 
physical properties.  
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1. Select Constants from the hierarchy menu. The Constants screen 
displays.  

 

Figure 5-20. Constants screen (Compact Prover)  

2. Complete the following fields. 
Field  Description 
Temperature 
(Stability 
R.O.C.) 

Sets the Rate of Change (ROC) threshold limit for 
temperature, which the S600+ uses to check the ROC 
between the inlet, the outlet, and the meter. The default 
is 0.1.  

Pressure 
(Stability 
R.O.C.) 

Sets the Rate of Change (ROC) threshold limit for 
pressure, which the S600+ uses to check the ROC 
between the inlet, the outlet, and the meter. The default 
is 0.05.  

UVOL (Stability 
R.O.C.) 

Sets the Rate of Change (ROC) threshold limit for the 
stream uncorrected volume (UVOL) flowrate. The 
default is 10.  

Temperature  
(Stability 
Bands) 

Sets the maximum temperature difference between the 
inlet, the outlet, and the meter. The default is 10.  

Pressure  
(Stability 
Bands) 

Sets the maximum pressure difference between the 
inlet, the outlet, and the meter. The default is 10.   

CAL 
Temperature 

Sets the prover calibration temperature used by the 
base volume correction calculation (CTSp). The default 
is 15. 

CAL Pressure  Sets the prover calibration pressure used by the base 
volume correction calculation (CPSp). The default is 
15. 
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Field  Description 
Ambient Temp Sets the ambient temperature used by the CTSp 

correction factor calculation. The default is 15. 
Pipe Diam Sets the internal pipe diameter of the prover loop. The 

default is 500.  
Elasticity Sets the value for Young’s modulus of elasticity 

(expansion coefficient of tube steel), typically 2100000. 
The default is 10000.  

Wall Thick Sets the wall thickness of the prover loop. The default 
is 5.  

Tube Coeff  Sets the tube temperature expansion coefficient. The 
default is 1.5e-005.   

Rod Coeff  Sets the coefficient of linear expansion for the invar 
rod. The default is 1e-005.  

Base Volume 
1, 2, 3, 4 

Sets the calibrated cylinder volume between detector 
switch activation (base volume). The default is 1. 

Density Units Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display valid 
values.  

 DEG.API  Use degrees API.  
 KG/M3  Use kilograms per cubic meter. The 

default is KG/M3. 
 S.G. Use specific gravity.  
 CH. 11 

2004/7 CUST 
Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 
2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 NORSOK  
I-105 

Use Norsok I-105 Appendix D density 
corrections. 

Product Type Indicates the type of petroleum product involved in the 
calculation. Click  to display valid values. The default 
is A CRUDE.   

 TABLE 
LOOKUP 

S600+ reads values from a file in the 
Config600 3.0/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The default files 
hold values for the ASTM-IP 
Petroleum Measurement Tables 1952 
Tables 5 and 6. 
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Field  Description 
 A CRUDE If  Density Table Units = KG/M3 and 

reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1980 
Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59A and 60A. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 1980 
Tables 23A and 24A. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5A and 6A. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 

 B REFINED If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1980 
Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59B and 60B. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 1980 
Tables 23B and 24B. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5B and 6B. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 
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Field  Description 
 C SPECIAL If  Density Table Units = KG/M3, 

Petroleum Measurement Tables 1980 
Table 54C. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 1980 
Tables 23C and 24C. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5C and 6C. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 
Note: Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1982 
Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59D and 60D. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 1982 
Tables 23D and 24D. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1982 
Tables 5D and 6D. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 11 
2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 11 
2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 
54. 
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Field  Description 
 USER K0K1 If  Density Table = KG/M3, Petroleum 

Measurement Tables 1980 Tables 
53A and 54A with user entered 
values for K0 and K1. 
If  Density Table = SG, Petroleum 
Measurement Tables 1980 Tables 
23A and 24A with user entered 
values for K0 and K1. 
If  Density Table = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5A and 6A with user entered 
values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 AROMATICS 
D1555-95 

ASTM D1555-95 Table Lookup. 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 

CPL 
Calculation 

Indicates the specific correction for the pressure of the 
liquid (CPL) value the S600+ Uses. Click  to display 
valid values. The default is API1121M. 

 OFF No CPL calculation. CPL value is set 
to 1.0.  

 API1121 API MPMS Ch.11.2.1 1984. 
 API1121M API MPMS Ch.11.2.1M 1984.  
 API1122 API MPMS Ch.11.2.2 1986. 
 API1122M API MPMS Ch.11.2.2M 1986. 
 CONSTANT Use a value you enter. 
 DOWNER Paper entitled Generation of New 

Compressibility Tables for 
International Use presented by L. 
Downer 1979. 

Rounding Enables or disables calculation rounding. Click  to 
display valid values. The default is OFF. 

 OFF Rounding is disabled.  
 NATIVE Rounding to the rules specified in the 

selected calculation standard. 
 API Ch.12.2 

Part 2 
Rounding to API MPMS Ch.12.2 Part 
2 – Measurement Tickets 1995. 

 API Ch.12.2 
Part 3 

Rounding to API MPMS Ch.12.2 Part 
3 – Proving Reports 1998. 

 Flocheck Rounding to Emerson Flocheck 
verification software package. 
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Field  Description 
 ASTM 

D1250-04 
Ch. 11 

API MPMS Ch.11.1 2004 (ASTM 
D1250-04) method to round to the 
Petroleum Measurement Tables 1980 
Table. 

Density Factor Used in conjunction with METER (DF) to correct meter 
density to prover density. The default is 1. 

Location Used by volume v mass proving to select the location 
of  the prover density used to convert prover volume to 
mass. Click ▼ to display valid values. The default 
value is AT PROVER. 

 AT PROVER Read density at the prover.  
 METER (C2) Use Meter Density * CTLp * CPLp / 

(CTLm * CPLm), defined for proving a 
Micro Motion Coriolis meter. 

 METER (DF) Use Meter Density * Density Factor 
 KNOWN 

PRODUCT 
Enter a value. 

R Sets the R constant value used in the plenum control 
algorithm. The default is 3.5.  

N2K Sets the N2K constant value used in the plenum 
control algorithm. The default is 5.  

Pos Limit Sets the positive plenum pressure tolerance. The 
default is 0.5.  

Neg Limit Sets the negative plenum pressure tolerance. The 
default is 0.5.  

Meter Factor 
Deviation 1 
Limit 

Sets the maximum allowed deviation from the initial 
base meter factor. The default value is 0.25%. The 
system uses this value while performing the proved 
meter factor deviation checks. Refer to Appendix B, 
Proving for further information. 
Note: This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

Meter Factor 
Deviation 2 
Limit 

Sets the maximum allowed deviation from the initial 
base meter factor. The default value is 0.1%. The 
system uses this value while performing the proved 
meter factor deviation checks. Refer to Appendix B, 
Proving for further information. 
Note: This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

Meter Factor 
Reject Timeout  

Following a successful prove, this value specifies the 
time period before the current prove results are 
automatically accepted and totals are adjusted based 
on the current prove results. During this time period, 
the current prove results can be manually ACCEPTED 
(totals will be adjusted) or ACCEPTED NO ADJUST 
(no totals adjustment). The default is 40 seconds. 
Refer to Appendix B, Proving for further information. 
Note: This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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Hardware Hardware settings relate to the Prover (P154) module.  You use these 
settings to define how the S600+ processes the raw pulse inputs to the 
prover. Typically, when the pulse count is low (less than 10,000 
pulses per round trip), the S600+ uses either “Phase Locked Loop”  or 
“Dual Chronometry”  processing. This effectively divides each pulse 
into smaller parts to ensure accuracy is maintained.  
1. Select Hardware from the hierarchy menu. The Hardware screen 

displays.  

 

Figure 5-21. Hardware screen (Compact Prover)  

2. Complete the following fields.  
Field  Description 
Dual 
Chronometry 

Enables dual chronometry. Dual chronometry 
determines meter pulses by counting a series of whole 
meter pulses and then multiplying that value by the 
ratio of the time between the detector switches and the 
time required to accumulate the pulses. The default is 
unchecked (disabled).  

Phase Locked 
Loop 

Enables phase locked loops. A phased locked loop 
multiplies the number of actual turbine pulses by a 
value (the Interpolation Factor) for greater accuracy. 
The default is unchecked (disabled).  
Note:  
 If  you select this check box, you must also 

provide an Interpolation Factor value.  
 If  you select this check box and are not 

using a physical PIM module, the raw 
pulses need to be wired into the PIMLOOP 
input on the P154 prover board (inputs 8 
and 20). 
Dual Chronometry and PLL can be used 
independently or together. 
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Field  Description 
Interpolation 
Factor 

Sets the interpolation factor value for the phase locked 
loops option, typically associated with the Pulse 
Interpolation Module (PIM). The default is 1.  
If using a physical PIM module, the scaling factors should 
be set to 1 as the multiplication of the pulses is done 
in the PIM. 
Note:  
 This field displays only if you select the 

Phase Locked Loop option.  
 If  no physical PIM is used, the interpolation 

factor should be set between 0 and 1 where 
1 indicates no interpolation (this value is 
used as a divider). For example, a value of 
0.1 will cause the actual pulse count to be 
divided by 0.1 (in effect multiplying the value 
by 10). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.   

Alarm Limits The Alarm Limits screen sets the prover alarms. For a description of 
the alarms, refer to “Alarm Descriptions” in Chapter 7, Advanced 
Setup Configuration.  

1. Select Alarm Limits from the hierarchy menu. The Alarm Limits 
screen displays.   

 

Figure 5-22. Alarm Limits screen (Compact Prover)   
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2. Click any of the following buttons to set alarm limits:   
Button  Description 
PULSES Click to display a Calculation Result dialog box you 

use to define the specific alarm limits for pulses.   
Note: This value reflects the cumulative pulses over a 

run, which consists of multiple passes. You set 
the number of passes in the Run Data screen.   

K FACTOR Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for K-factors.   

MTR FACTOR Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for Meter 
Factors.   

 
3. Click in the hierarchy menu when you finish defining alarm limits. 

A confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

5.7.4 Prover – Master Meter (Gas and Liquid) 
The primary function of the Master Meter is to provide an accurate 
“meter factor” value for the proving stream. The S600+ then uses this 
value to calibrate all other meters.  
The proving stream receives pulses from its meter and generates a 
pulse train output, which represents the number of pulses received. The 
Master Meter counts these pulses during a proof run and also counts 
the pulses from its own meter (the master). When the proof run 
completes, the S600+ calculates a meter factor for the stream, based on 
the Master Meter’s meter factor and the ratio of the correct stream 
output pulse count to the Master Meter’s turbine pulse count. 
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings. 
 

Two components enable you to control the prove: 
 Prove sequence – Station-based function which sets up the prove 

environment. 
 Run control – Prover-based function that drives the prover 

hardware, counts pulses, and performs the K-factor calculations. 

Following a successful prove, the system verifies the stream normal 
flow rate value:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount 
of time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations. 
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 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved but does not use the data until it is accepted either locally at 
the S600+ or via a supervisory computer. 

When the prove runs complete, you can either re-run the prove or 
terminate, at which point (if so configured) the sequence restores the 
valves to their pre-prove state.  

Notes: 

 Aramco-style linearisation is only applicable to Liquid Master 
Meter proving. Gas Master Meter proving always uses the non-
Aramco style linearisation. 

 The prove sequence downloads both a K-factor and a meter factor. 
Applications typically use the original K-factor from the meter 
calibration report and update the meter factor, which may be either 
a fixed value or derived from a linearisation process. Alternatively 
the meter factor can remain unchanged and the K-factor (fixed or 
linearised) updated.  

 The meter factor deviation tests and the historical meter factor 
database are only applicable to Liquid Master Meter proving. 

 The meter factor deviation tests and the historical meter factor 
database are only supported for "local" streams (part of the same 
configuration with the prover) if you configure the stream normal 
flow rate to a value greater than zero and have selected “Product 
Table with History” in PC Setup. 

 You define a ticket as Official or Unofficial when you configure a 
prove. This selection applies to both the Aramco-style and non-
Aramco-style linearisation. 

Following an Official prove, the prove sequence is determined by 
the Aramco / non-Aramco style linearisation selection. 

Following the Unofficial prove, the prove sequence does not 
download the prove results to the stream being proved. This is 
typically used to determine an approximate K-Factor / Meter 
Factor before an official prove takes place or when maintenance 
activities are being performed on the site.  

The Official/Unofficial selection displays in the report header. 

 For a list of supported Master Meter/Stream combinations, refer to 
Appendix B.3.1 Master Meter/Stream Combinations. 

 
Run Data Run Data settings allow you to define the prover stability check 

variables, the number of prove runs from which the system can 
calculate a K-factor/meter factor, and the tolerances allowed on a K-
factor/meter factor. Once the S600+ completes a prove and calculates 
these values, you can select a new K-factor or meter factor to replace 
the current K-factor or meter factor.  
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To edit the prover run data settings:  

1. Select Run Data from the hierarchy menu. The Run Data screen 
displays.  

 

Figure 5-23. Run Data (MMeter Prover)   
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2. Complete the following fields.  
Field  Description 
Override  Disables temperature and pressure stability checking. 

The default is unchecked (stability checking is 
enabled).  
Note: If  you do not select this option, you must 

complete the Wait Time and Hold Time fields.  
Wait Time  Sets, in seconds, how long the S600+ waits for stability 

before moving to the hold stability prover stage. The 
default is 60.  

Hold Time Sets, in seconds, how long the S600+ holds stability 
before starting prover runs. The default is 10.  
Note: The S600+ aborts the prover run if stability is 

lost during the stability hold time.  
Required Sets the required number of consecutive runs which 

must be within the defined tolerance limits (typically, 5). 
The default is 5.  
Note:  It is possible that the number of required runs 

cannot be achieved before the maximum 
number of runs reached. In this situation, the 
user can either wait for the prove to abort (once 
the maximum number of runs has been 
reached) or perform a manual abort. 

Maximum Sets the maximum number of runs to perform before 
aborting the sequence (up to 12 for the S600+). The 
default is 12.  

Method Indicates the method used to define a run. Click  to 
display valid values.  

 PULSE Run completes when the pulse count 
equals the value defined in the Pulses 
f ield. This is the default.  

 VOLUME Run completes when the flowed 
volume equals the value defined in the 
Volume field.  

 TIME Run completes when the time elapsed 
equals the value defined in the Timeout 
f ield.  

 MASS Run completes when the flowed mass 
equals the value defined in the mass 
f ield.  

Average 
Method 

Indicates the value to determine the repeatability and 
to indicate whether the final K-factor and meter factor 
are taken as the average of the run values, or are re-
calculated. Click ▼ to display valid values. 

 METER 
FACTOR 

Use the run Meter Factors for 
repeatability and the average 
meter factor as the final value. This 
is the default. 

 K-
FACTOR 

Use the run K-factors for 
repeatability and the average K-
factor as the final value. 

 PULSES Use the run pulse counts for 
repeatability. This option also 
signifies to recalculate the final K-
factor and meter factor using the 
average pulse count and other 
average values. API Ch.12 Section 
2 part 3. 
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Field  Description 
Tolerance  Identifies, as a percentage, the maximum deviation 

allowed before a run is unacceptable. The default is 1.  
Algorithm Indicates the algorithm the system uses to calculate 

the K factor tolerance. Click  to display valid values. 
 API 1 API method: max deviation from 

(Average – Run) / Average. This is 
the default.  

 MX-MN/AVG (Max – Min) / Average 
 MX-

MN/MX+MN2 
(Max – Min) / ((Max + Min) / 2) 

 MX-MN/MN (Max – Min) / MIn 
 MX-

MN/MX*MN 
(Max – Min) / (Max * Min) 

 MX-AV/AV (Max – Average) / Average 
 AV-MN/AV (Average – Min) / Average 
 STATISTICAL Calculates the statistical K-factor 

deviation using a Student-t table 
distribution.  

Conf. Level Sets the confidence level for a two-sided Student-t 
table used in statistical proving. Click ▼ to display valid 
values. For more information, see Appendix B, 
Proving. 
Note: This field displays only if you select 

STATISTICAL in the Algorithm field.   
Pulses Defines the number of pulses required for one run. The 

default is 10000. 
Note: This field displays only if you select PULSE as 

a Run Method.  
Volume Defines the required volume for one run. The default is 

50.  
Note: This field displays only if you select VOLUME 

as a Run Method.  
Timeout Sets, in seconds, the maximum time for any prover 

run. The default is 300.   
Note: If  you select TIME as a Run Method, this field 

indicates the maximum duration for a run.  
Nominated 
Master Meter 
Stream 

Sets the stream number to use as the master meter. 

Enable User 
Stages 

Enables Logicalc user stages. The default is 
unchecked (user stages are disabled). 

User Student-t 
Table 

Indicates the Student-t table values for degrees of 
f reedom 1-40. For more information, see Appendix B, 
Proving.  
Note: These fields display only if you select 

STATISTICAL in the Algorithm field and USER 
in the Confidence Level field.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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Constants The Constants screen is split into two areas. One area (consisting of 
the Stability R.O.C and Stability Bands panes) defines stability 
checking parameters. The other area (consisting of the Reference, 
Master Meter, and Setup panes) provides set-up information for the 
prover, including reference conditions and physical properties.  

1. Select Constants from the hierarchy menu. The Constants screen 
displays.  

 

Figure 5-24. Constants screen (MMeter Prover)   

2. Complete the following fields. 
Field  Description 
Temperature 
(Stability 
R.O.C) 

Sets the Rate of Change (ROC) threshold limit for 
temperature, which the S600+ uses to check the ROC 
between the inlet, the outlet, and the meter. The default 
is 0.1.   

Pressure 
(Stability 
R.O.C.) 

Sets the Rate of Change (ROC) threshold limit for 
pressure, which the S600+ uses to check the ROC 
between the inlet, the outlet, and the meter. The default 
is 0.05.   

UVOL 
(Stability 
R.O.C.)  

Sets the Rate of Change (ROC) threshold limit for the 
stream uncorrected volume (UVOL) flowrate. The 
default is 10.  

Temperature 
(Stability 
Bands) 

Sets the maximum temperature difference between the 
inlet, the outlet, and the meter. The default is 10.  

Pressure 
(Stability 
Bands) 

Sets the maximum pressure difference between the 
inlet, the outlet, and the meter. The default is 10.   

Temperature 
(Reference) 

Sets the reference temperature value for calculations 
(typically 15°C in Europe). The default is 15.   

Pressure 
(Reference) 

Sets the reference pressure value for calculations 
(typically 0 barg in Europe). The default is 0.  
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Field  Description 
Base K Factor Sets the base K-factor value for Master Meter 

calculations.  
Note: This may be a read-only field in some 

applications.  
Density Units Indicates the density units the S600+ uses for the 

density correction calculations. Click  to display all 
valid values.  
Note: This selection is applicable only to Liquid Master 

Meter proving. 
 DEG.API  Use degrees API.  
 KG/M3  Use kilograms per cubic meter. This 

is the default.  
 S.G. Use specific gravity.  
 CH. 11 2004/7 

CUST 
Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 NORSOK  
I-105 

Use Norsok I-105 Appendix D 
density corrections. 

Product Type Indicates the type of petroleum product involved in the 
calculation. Click  to display all valid values. The 
default is A CRUDE.  
Note: This selection is applicable only to Liquid Master 

Meter proving. 
 TABLE 

LOOKUP 
S600+ reads values from a file in 
the Config600 3.0/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The default files 
hold values for the ASTM-IP 
Petroleum Measurement Tables 
1952 Tables 5 and 6. 

 A CRUDE If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 
1980 Tables 23A and 24A. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 
1980 Tables 5A and 6A. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 
11 2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 
11 2004. 
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Field  Description 
 B REFINED If  Density Table Units = KG/M3 and 

reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59B and 60B. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 
1980 Tables 23B and 24B. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 
1980 Tables 5B and 6B. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 
11 2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 
11 2004. 

 C SPECIAL If  Density Table Units = KG/M3, 
Petroleum Measurement Tables 
1980 Table 54C. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 
1980 Tables 23C and 24C. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 
1980 Tables 5C and 6C. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 
11 2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 
11 2004. 
Note:  Table 53C is not 

implemented as the 
assumption is made that the 
base density is already 
known. This is because 
Table 53C allows for a 
keypad entry of Alpha, and if 
this is known then the base 
density would be known. 
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Field  Description 
 D LUBE OILS If  Density Table Units = KG/M3 and 

reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D. 
If  Density Table Units = SG, 
Petroleum Measurement Tables 
1982 Tables 23D and 24D. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 
1982 Tables 5D and 6D. 
If  Density Table Units = CH.11 
2004/7, Cust API MPMS Chapter 
11 2004. 
If  Density Table Units = CH.11 
2004/7, Metric API MPMS Chapter 
11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 
53 and 54. 

 ASTM IP 1952 ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 
54. 

 USER K0K1 If  Density Table = KG/M3, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A with user 
entered values for K0 and K1. 
If  Density Table = SG, Petroleum 
Measurement Tables 1980 Tables 
23A and 24A with user entered 
values for K0 and K1. 
If  Density Table = DEG API, 
Petroleum Measurement Tables 
1980 Tables 5A and 6A with user 
entered values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 AROMATICS 
D1555-95 

ASTM D1555-95 Table Lookup. 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 B1 
UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 B2 
SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 
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Field  Description 
 STO5.9 08 B3 

WFLH 
Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 

CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses 
to calculate the liquid pressure correction factor. Click 
▼ to display all valid values.  
Note: This selection is applicable only to Liquid Master 

Meter proving. 
 OFF No CPL calculation. CPL value is 

set to 1.0. 
 API1121 API MPMS Ch.11.2.1 1984. 
 API1121M API MPMS Ch.11.2.1M 1984. This 

is the default.  
 API1122 API MPMS Ch.11.2.2 1986. 
 API1122M API MPMS Ch.11.2.2M 1986. 
 CONSTANT Use a value you enter. 
 DOWNER Paper entitled Generation of New 

Compressibility Tables for 
International Use presented by L. 
Downer 1979. 

Rounding Enables or disables calculation rounding. Click  to 
display valid values.  

 OFF Rounding is disabled. This is the 
default.  

 NATIVE Rounding to the rules specified in 
the selected calculation standard. 

 API Ch.12.2 
Part 2 

Rounding to API MPMS Ch.12.2 
Part 2 – Measurement Tickets 
1995. 

 API Ch.12.2 
Part 3 

Rounding to API MPMS Ch.12.2 
Part 3 – Proving Reports 1998. 

 Flocheck Rounding to Emerson Flocheck 
verification software package. 

 ASTM D1250-
04 Ch. 11 

API MPMS Ch.11.1 2004 (ASTM 
D1250-04) method to round to the 
Petroleum Measurement Tables 
1980 Tables. 

Density Factor Used in conjunction with METER (DF) to correct meter 
density to prover density. The default is 1. 
Note: This selection is applicable only to Liquid Master 

Meter proving. 
Location Used by volume v mass proving to select the location of 

the prover density used to convert prover volume to 
mass. Click ▼ to display valid values.  
Note: This selection is applicable only to Liquid Master 

Meter proving. 
 AT PROVER Read density at the prover. This is 

the default.  
 METER (C2) Use Meter Density * CTLp * CPLp/ 

(CTLm * CPLm), defined for proving 
a Micro Motion Coriolis meter. 

 METER (DF) Use Meter Density * Density Factor 
 KNOWN 

PRODUCT 
Enter a value. 
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Field  Description 
VCF 
Calculations 

Sets if the system performs volume correction factor 
calculations. If enabled, the resulting outputs are then 
displayed on the prover report. Click ▼ to display valid 
values. 
Note: This selection is applicable only to Liquid Master 

Meter proving. 
 DISABLE The system does not perform 

volume correction factor 
calculations. This is the default.  

 ENABLE The system performs volume 
correction factor calculations and 
displays the resulting outputs on the 
prover report. 

Meter Factor 
Deviation 1 
Limit 

Sets the maximum allowed deviation from the initial 
base meter factor. The default value is 0.25%. The 
system uses this value while performing the proved 
meter factor deviation checks. Refer to Appendix B, 
Proving for further information. 
Notes:  
 This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

 This selection is applicable only to Liquid Master 
Meter proving. 

Meter Factor 
Deviation 2 
Limit 

Sets the maximum allowed deviation from the initial 
base meter factor. The default value is 0.1%. The 
system uses this value while performing the proved 
meter factor deviation checks. Refer to Appendix B, 
Proving for further information. 
Notes:  
 This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

 This selection is applicable only to Liquid Master 
Meter proving. 

Meter Factor 
Reject Timeout 

Following a successful prove, this value specifies the 
time period before the current prove results are 
automatically accepted and totals are adjusted based 
on the current prove results. During this time period, the 
current prove results can be manually ACCEPTED 
(totals will be adjusted) or ACCEPTED NO ADJUST 
(no totals adjustment). The default is 40 seconds. 
Refer to Appendix B, Proving for further information. 
Notes:  
 This stage is performed only if you configure the 

meter normal flow to a value greater than zero 
(Aramco-style linearisation). 

 This selection is applicable only to Liquid Master 
Meter proving. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

 
Hardware Hardware settings relate to the Prover I/O module. You use these 

settings to define how the S600+ processes the pulse inputs to the 
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prover. Typically, when the pulse count is low (less than 10,000 
pulses per round trip), the S600+ uses "Phase Locked Loop" 
processing. This effectively divides each pulse into smaller parts to 
ensure accuracy is maintained.  

1. Select Hardware from the hierarchy menu. The Hardware screen 
displays.   

 

Figure 5-25. Hardware screen (MMeter Prover)  

2. Complete the following fields.  
Field  Description 
Phase Locked 
Loop 

Enables phase locked loops. A phased locked loop 
multiplies the number of actual turbine pulses by a 
value for greater accuracy. The default is unchecked 
(disabled).  

Master Meter 
Channel 

Indicates the I/O channel to which the S600+ sends 
pulse I/O information for the Master Meter.   

Proving Meter 
Channel 

Indicates the I/O channel to which the S600+ sends 
pulse I/O information for the proving meter.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.   

4. Click Yes to apply your changes. The PCSetup screen displays.   

Alarm Limits The Alarm Limits screen sets the prover alarms. For a description of 
the alarms, refer to Alarm Descriptions in Chapter 7, Advanced Setup 
Configuration.   

1. Select Alarm Limits from the hierarchy menu. The Alarm Limits 
screen displays.   
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Figure 5-26. Alarm Limits screen (MMeter Prover)  

2. Click any of the following buttons to set alarm limits:   
Button  Description 
PRV PULSES Click to display a Calculation Result dialog box you 

use to define the specific alarm limits for prover pulses.  
MTR PULSES Click to display a Calculation Result dialog box you 

use to define the specific alarm limits for meter pulses.   
PROVED KF  Click to display a Calculation Result dialog box you 

use to define the specific alarm limits for the proved K-
factor.  

PROVED MF Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the proved 
Meter Factor. 

 
3. Click in the hierarchy menu when you finish defining alarm limits. 

A confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.   
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6.10.1 Density Failure Modes .............................................6-242 

 
Stream settings define the calculation inputs and limits plus alarm 
setpoints for the stream input data from gas, liquid, and prover 
applications. Using these settings, the S600+ calculates operational 
values—including flowrates, density, calorific values and flow-
weighted averages—which conform to AGA and ISO calculation 
standards.  
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings. 
 

6.1 Initial Configurations  
The Configuration Generator assigns default settings to the streams in 
your configuration file. To edit these settings, select the required 
stream number from the left pane in the PCSetup Editor. Some stream 
settings are common to all stream types and some are application-
specific.   
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Figure 6-1. Stream Hierarchy screen   

Stream settings include:  
Common Stream Settings 
(applicable to gas and liquid) 

 General  
 Flowrate  
 Sampling  
 Coriolis 
 Flow Switching  
 Block Valves 
 Time/Flow Weighted Averaging 

Gas-Specific Stream 
Settings  

 Downstream/Upstream Correction 
 Pipe Correction  
 Flowrate (for ISO5167, AGA3, Annubar, V-

Cone®, or AGA3 US Application)  
 Compressibility (for AGA8, NX-19, PTZ, and 

SGERG)  
 Gas CV Calorific Value (ISO6976/GPA)  
 Calorific Value (AGA5)  
 GC FWA 
 Gas Composition (Gas Chromatograph)  
 DP Cell Input Conditioning   
 Gas Turbine (AGA7)  
 Linearisation  
 QSonic Interface 
 Ultrasonic Control  
 Ultrasonic Flowrate Setup  
 Z Ethylene 
 Z Stream 

Liquid-Specific Stream 
Settings  

 Meter Correction  
 Liquid Volume Correction  
 Linearisation  
 Local Units 
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6.2 Common Stream Settings 
Use the Stream settings to configure the Stream Type, Meter Location, 
Manufacturer, Model, Serial No., Tag Number, Meter Size, Alarms, 
Flow rate data, Batching options, Block Values, and Time & Flow 
Weighted Averaging Techniques.  

6.2.1 General Settings 
Use the General settings screen to define the Meter Location name and 
Stream Type, indicate various meter-specific values, manage alarms, 
and configure the initial Maintenance mode setting.. 
1. Select General from the hierarchy menu. Config600 displays the 

Stream Details settings in the right-hand pane.  

 

Figure 6-2. General Settings   

2. Provide Stream Type and Meter Location descriptions, defining up 
to 30 alphanumeric characters for each.   

3. Provide the Manufacturer, Module, Serial No., Tag Number, Meter 
Size  

Note: All the values on this screen appear on reports, although you 
can define Manufacturer, Model, Serial No., Tag Number, and 
Meter Size only for liquid type streams.   

4. Select Maintenance Mode to force the stream to start up in 
maintenance mode, in which current maintenance totals do 
increment but normal totals do not.   

Note: This is only the initial mode of operation. You can change the 
mode on an operating S600+. You can also override this mode 
by selecting the Increment Cumulatives in Maintenance Mode 
check box in the Totalisation section of the PCSetup Editor. To 
fully enable maintenance mode, you must first define a 
maintenance mode report.   
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5. Click Suppress alarms in Maintenance to suppress alarms in 
maintenance mode. An Alarm Suppression dialog box displays.  

 

Figure 6-3. Alarm Suppression dialog box   

6. For each of the objects, select the alarms to suppress. Click Add or 
Remove to select or de-select objects from the listing.  

7. Click OK when you finish identifying alarms to suppress. The 
PCSetup screen displays.  

8. Click the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays. 

9. Click Yes to apply your changes. The PCSetup screen displays. 

6.2.2 Flowrate  
Flowrate settings define the alarm setpoints for each type of flowrate. 
You can define up to four types of alarms for each flowrate, and then 
enable or disable each alarm. The system activates these alarms when 
the calculated result for the relevant flowrate is not within the specified 
limits.  

1. Select Flowrate from the hierarchy menu. The Flowrate Settings 
screen displays.  
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Figure 6-4. Flowrate Settings   

2. Double-click a flowrate object in the Alarm Limits pane. A 
Calculation Result dialog box displays.  

 

Figure 6-5. Calculation Result dialog box  

3. Select the alarms you want to enable and then verify or edit the 
flowrate associated with that alarm.  

4. Click OK to apply your changes. The Flowrate Settings screen 
displays.   

5. Complete the Low Flow Cutoff field to set a cutoff rate.  

6. Click Alarms to Supress on Cutoff if you want to suppress alarms 
while the flowrate is below the Low Flow Cutoff value. An Alarm 
Suppression dialog box displays.  
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Figure 6-6. Alarm Suppression dialog box   

7. Select an object for alarm suppression, and then select the 
appropriate check boxes. You can define up to 20 objects.  

8. Click OK when you finish. The Flowrate Settings screen displays.  
9. If you are editing a liquid stream, indicate values for the High 

Band and Low Band fields. For flow switching, these values set 
the stream’s allowable limits. For flow balancing, these values set 
the highest and lowest flowrates within which flow balancing 
functions.   

10. Complete the PID Loop field to indicate the loop configured to 
control the flowrate through the selected stream. Click  to display 
all valid values.   

Note: Be sure to configure the PID.  

11. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays. 

12. Click Yes to apply your changes. The PCSetup screen displays.  

6.2.3 Stream Secondary Units Setup 
The stream secondary units setup allows for the configuration of 
selected flow rates and totals in different units as selected in the unit’s 
section.  

1. Select the Secondary Units STR Setup component from the 
hierarchy menu. The system displays the associated settings in the 
right-hand pane.  



Config600 Configuration Software User Manual 

6-8 Stream Configuration Revised January 2023 

 

Figure 6-7. Secondary Units STR Setup 

2. Select the Gas STR Setup or Liquid STR Setup button to display 
the Dual Units Setup dialog. 

Note: The dialog box consists of two screens (Cumulative Totals and 
Periodic Totals). You can switch between each screen by 
selecting the To Periodic Totals/To Cumulative Totals 
button. 
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Figure 6-8. Dual Units Setup – Cumulative Totals dialog box  

3. The Cumulative Totals screen consists of the following: 

 The first 4 slots are pre-defined and indicate the available flow 
rates.  

 You can configure the next 8 slots as stream cumulative totals.  

 The last slot is pre-defined and indicates which stream is linked 
to the selected Dual Units Setup instance. 

To add a cumulative total, click on the Add button, and the first 
available cumulative total appears. Use the  button to change the 
cumulative total for each slot.  

Note:  You should only configure Stream Cumulative Totals. 
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Figure 6-9. Dual Units Setup – Periodic Totals dialog box  

4. Click the To Periodic Totals button to view the Periodic Totals 
screen. The Periodic Totals screen consists of the following: 
 Pre-defined Slot 1 is read-only and indicates the converted 

flow rates and cumulative totals.  
 Pre-defined Slot 2 is read-only and indicates the converted 

periodic totals. 
 You can configure the next 12 slots as periodic totals. 

To add a periodic total, click on the Add button. Use the  button 
to select the required periodic total.  

Note:  You should only configure Periodic Totals belonging to the 
selected stream. 

5. Click OK to apply the changes. The PCSetup screen displays. 

6.2.4 Stream Flow Switching Setup 
Flow switching settings define the priorities and number of valves 
present, as well as control loop specifics. You can set up flow 
switching for a stream and then disable it until you need this option.  
1. Select Flow Switching from the hierarchy menu. The Flow 

Switching screen displays.   
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Figure 6-10. Flow Switching screen   

2. Complete the following fields.   
Field  Description 
Priority Sets the priority of the stream. The higher the number, 

the higher the stream’s priority. For example, 2 has 
priority over 1, and 3 has priority over 2. The default is 
1.   

Number of 
Values 

Sets the number of values controlled on the selected 
stream. The default is 2.   

Disabled  Disables flow switching for the selected stream. The 
default is unchecked (flow switching is disabled).  

Setpoint Sets, if applicable, the ideal flowrate required on the 
selected stream.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays. 

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.2.5 Gas Component Flow Weighted Averaging (GC FWA) 
Gas Component Flow Weighted Averaging (GC FWA) defines how 
the system averages gas components for a given period. For this option 
you define two groups of settings, one group for forward flow and one 
for reverse flow. Select TFWAx4 or TFWAx8 in the Options for 
Stream screen to configure GC FWA.  

1. Select GC FWA from the hierarchy menu.  

2. Open the option so that you can see both the FWD (forward) and 
REV (reverse) settings.  
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Note: Forward and reverse settings are linked. Changes made to 
settings for either direction are automatically reflected in 
settings for both directions.   

3. Select the FWD option. The Gas Component FWA screen 
displays.  

  

Figure 6-11. Gas Component Flow Weighted Averaging screen   

4. Complete the following fields.   
Field  Description 
Method Indicates the averaging method. Click  to display all 

options.  
 FWA Flow weighted averaging, calculated 

with respect to the total. This is the 
default value.  

 TWA Time weighted averaging, calculated 
with respect to time and totals. The 
system calculates this value only when 
the flowrate is greater than zero. 

 TWA-
XFLOW 

Time weighted averaging, calculated 
with respect only to time. The system 
calculates this value regardless of the 
measured flowrate. 

Period Indicates the period for the averaging. Click  to 
display all options. Select only one period. The default 
is BASE PRD 1.  

 BASE PRD 
1 

Bases averaging on the Base Period 1 
time period. This is the default.   

 BATCH Bases averaging on the batch time 
period.  

 HOURLY Bases averaging on the hourly time 
period.  

 MAINT Based averaging on the time period in 
maintenance mode.  

Mol Flag Indicates how the system averages the component of 
each value. Click  to display all options.  

 GPA8173 
LIQ EQV 

Calculates the liquid equivalent volume 
for each gas component according to 
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Field  Description 
VOL GPA8173-94.  

 MASS % Provides the proportion of each gas 
component with respect to its molecular 
mass. The option you select in the 
Table field provides the component’s 
molecular mass value. This is the 
default.  

 MOL % Average based on the mol percentage 
each component contributes.  

 TOTALS Determine component mass totals 
based on the percentage mass each 
component contributes. .  

Normalisation Indicates whether the system normalises the output of 
the components. Click  to display all options. The 
default is CLEAR (non-normalised).  

Table Indicates the gas table the S600+ uses to provide gas 
component molecular mass and liquid density values 
for calculating the component liquid equivalent 
volumes. Click  to display all options.  

 ISO6976-
1995 

Uses ISO6976 2016 gas component 
molecular mass values.  
Note: ISO6976 does not provide 

liquid density values; they 
default to 0.0. 

 ISO6976-
2016 

Uses ISO6976 gas component 
molecular gas values. This is the 
default.  
Note: ISO6976 does not provide 

liquid density values; they 
default to 0.0. 

 GPA2145-
2009 

Uses GPA2145 2009 gas component 
molecular mass and liquid density 
values. 

 GPA2145-
2003 

Uses GPA2145-2003 gas component 
molecular gas values. 

 GPA2145-
1994 

Uses GPA2145-1994 gas component 
molecular gas values. 

 

5. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

6. Click Yes to apply your changes. The PCSetup screen displays. 

6.2.6 Density Measurement   
Density Measurement settings define the constants and calculation 
limits for densitometer inputs. This screen displays when you 
configure the S600+ to use a densitometer.  
1. Select Density Measurement from the hierarchy menu.  

2. Select Common Data from the hierarchy menu. The Densitometer 
screen displays.  
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Figure 6-12. Density Measurement Calculation Limits screen   

3. Click one of the buttons:  
Button  Description 
OBSERVED 
DENSITY 

Click to display  a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for observed density.  

SPECIFIC 
GRAVITY(RD)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the specific gravity relative density 
value.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes.  
6. Select Density Measurement > DensitometerA or Densitometer 

B from the hierarchy menu. The Density Measurement 
Densitometer screen displays.  
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Figure 6-13. Density Measurement Densitometer screen   

7. Complete the following fields:   
Field  Description 
DENS A TEMP/ 
DENS B TEMP  

Click to display the analog input configuration screen to 
configure the density temperature input and associated 
values.   

DENS A 
PRESS/ 
DENS B PRESS 

Click to display the analog input configuration screen to 
configure the density pressure input and associated 
values.  

Meter Type Indicates the meter associated with each 
densitometer. Click  to display all valid values:  

 MMI 
3096/98 SI 

Micro Motion (formerly Solartron) 
3096/98 metric units version.  

 MMI CDM 
7835 SI 

Micro Motion (formerly Solartron) 
7835/45/46 metric units version. 

 MMI GDM 
7812/28 SI 

Micro Motion (formerly Solartron) 
7812/28 metric units version.  

 Sarasota/ 
Peek SI 

Sarasota/Peek FD/Anton Paar metric 
units version. 

 DENS 
ANIN 

Observed density from analogue input 
(ADC) 

 RD ANIN Observed relative density from an 
analogue input (ADC)  

 MMI 
3096/98 

IMP 

Micro Motion (formerly Solartron) 
3096/98 Imperial units version.  

 MMI CDM 
7835 IMP 

Micro Motion (formerly Solartron) 
7835/45/46 Imperial units version.  

 MMI GDM Micro Motion (formerly Solartron) 
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Field  Description 
7812/28 

IMP 
7812/28 Imperial units version.  

 Sarasota/ 
Peek IMP 

Sarasota/Peek FD/Anton Paar Imperial 
units version. 

 MMI CDM 
7835 DPT 

SI 

Micro Motion (formerly Solartron) 7835 
metric pressure-temperature coupling 
version.   

 MMI GDM 
7835 DPT 

IMP 

Micro Motion (formerly Solartron) 7835 
imperial pressure-temperature coupling 
version.   

Density 
correction 
factor (0.5 to 
1.5) 

Sets the value between 0.5 and 1.5 to scale the 
calculated density at the densitometer. The default 
value is 0.  

Densitometer 
high period fail 

Sets the limits of measured period value above which 
the densitometer must reach before it fails. Default 
value is 2000. Refer to Density Failure Modes.  

Density low 
period fail  

Sets the limits of measured period value below which 
the densitometer must reach before it fails. Default 
value is 100. Refer to Density Failure Modes.  

Specific meter 
constants 

Sets calibration constants for the selected 
densitometer. Each densitometer type has its own 
calibration constants.  
Note: The meter manufacturer provides these 

constants, which are mandatory for the 
correct functioning of the density calculations.  

 
8. Click in the hierarchy menu when you finish defining these 

settings. A confirmation dialog box displays.  
9. Click Yes to apply your changes.  

6.2.7 Block Valves  
Block valve settings define the type of valves used as well as any 
associated settings and alarms. The system activates these alarms when 
the relevant timers expire or when the status is different than expected.  

1. Select Block Values from the hierarchy menu. The Block Valves 
screen displays. 
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Figure 6-14. Block Valves screen   

2. Select a valve setup type.  
Field  Description 
Type Indicates the valve setup type. Click  to display all 

valid values.  
 MOV Motorised valve that uses separate 

opened and closed status inputs as 
well as separate open and close 
commands. This is the default.  

 SOLENOID Valve that uses separate opened 
and closed status inputs and a 
single open command. 

 PRV 4-WAY Four-way prover valve that uses 
separate forward and reverse 
(home) inputs and separate forward 
and reverse commands.  
Note: The PRV 4-WAY is the only 

valid valve choice when the 
configuration type is BiDi 
Prover and for use with the 
four-way valve. 

 
3. Provide a Valve Timings value.  

Field  Description 
Travel Sets, in seconds, the maximum allowed stroke time for 

the valve to move from fully closed to fully open or from 
fully open to fully closed before raising a timeout alarm.  

Settle Sets, in seconds, the settling time allowed from the 
valve reaching its closed limit (or any limit for a 4-way 
valve) before the test seal is applied.  
Note: Contact technical support to configure valve 

seal checking or valve local remote selection.  
Test  Sets, in seconds, the seal test active time which starts 

when the Settle time has elapsed.  
 
4. If seal checking is required, select from the following options. 
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Note: Seal checking, which determines if a seal is leaking, is 
performed only during test time.  

Field  Description 
No Seal No seal checking is performed. 
Dig Seal Uses a digital input to determine if the seal has failed. 
Diaphragm 
Press Seal 

Uses an analog input to measure the diaphragm 
pressure. If this option is selected, then a new window 
opens to allow entry of the Diaphragm Pressure Limit. 
If  the analog input falls below this limit, then a seal fail 
alarm is raised. 

 
 

5. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays. 

6. Click Yes to apply your changes. The PCSetup screen displays.  

6.2.8 Time & Flow Weighted Averaging Methods 
Time and Flow Weighted Averaging settings define the stream inputs 
the system uses to calculate the time-weighted or flow-weighted 
averages for a given reporting period. You can define a maximum of 
four stream inputs.  

Note: Use the System Editor to configure additional change FWA 
calculations.   
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Figure 6-15. Time & Flow Weighted Averaging Example 

Averaging Methods Config600 provides three methods to calculate the weighted average: 
flow-weighted (FWA), time-weighted (TWA), and a combination 
(TWA-XFLOW). 

Notes: 

 Depending on the method you select, Config600 also computes a 
60-minute rolling average for each object. Refer to Chapter 4, I/O 
and Comms Configuration.  

 The system requires sufficient accumulated flow in order to 
calculate a flow-weighted average. If there is not enough 
accumulated flow to calculate a flow-weighted average, the system 
uses a flow-weighted average of 1.0. 

Flow-Weighted Averaging (FWA)  
For each period type, the algorithm multiples the elapsed total for the 
period (that is, flowrate x time) by the present FWA value to give the 
“weight” for the average. The latest measured value, when multiplied 
by the elapsed total since the algorithm ran, provides the new “weight” 
to be incorporated into the whole.   
Delta = cumulative total – last snapshot of cumulative total 
If  Delta > 0.0 then invoke the flow weighted algorithm: 

FWA = ((FWA period total*FWA )+(process var*delta)) / (FWA period total + 
delta) 
FWA period total = FWA period total + delta 
Last snapshot of cumulative total = cumulative total 
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As an example, steady flowrate = 360 m3/hour, initial temperature = 15 deg.C, 
increasing at 0.1 deg.C every second, present FWA = 15.0  
 
At 00:00:00, cumulative total = 0.0, FWA period total = 0.0, t = 15.0, FWA=15.0 

No action (FWA remains at 15.0) 
At 00:00:01, cumulative total=0.1, FWA period total = 0.0, t = 15.1, FWA=15.0  

Delta = 0.1 – 0.0 = 0.1 
FWA = (0.0 * 15.0) + (15.1*0.1) /(0.0 + 0.1) = 15.1 
FWA period total = 0.0 + 0.1 = 0.1 

At 00:00:02, cumulative total= 0.2, FWA period total = 0.1, t = 15.2, FWA=15.1 
Delta = 0.2 – 0.1 = 0.1 
FWA = (0.1 * 15.1) + (15.2*0.1) /(0.1 + 0.1) = 15.15 
FWA period total = 0.1 + 0.1 = 0.2 

At 00:00:03, cumulative total= 0.3, FWA period total = 0.2, t = 15.3, FWA=15.15 
Delta = 0.3 – 0.2 = 0.1 
FWA = (0.2 * 15.15) + (15.3*0.1) /(0.2 + 0.1) = 15.2 
FWA period total = 0.2 + 0.1 = 0.3 

At 00:00:04, cumulative total= 0.4, FWA period total = 0.3, t = 15.4, FWA=15.2 
Delta = 0.4 – 0.3 = 0.1 
FWA = (0.3 * 15.2) + (15.4*0.1) /(0.3 + 0.1) = 15.25 
FWA period total = 0.3 + 0.1 = 0.4  

 
Time-Weighted Averaging (TWA)  

The S600+ calculates TWA only when the flowrate is greater than 
zero. For each period type, the algorithm multiplies the elapsed time 
for the period by the present TWA value to give the “weight” for the 
average. The latest measured value, when multiplied by the elapsed 
time since the algorithm ran, gives the new “weight” to be incorporated 
into the whole.    
Delta = time interval since task last run 
If  f lowrate > 0.0 then 

TWA = ((period time * TWA ) + (process var * delta)) / (period time + 
delta) 
period time = period time + delta 

As an example, steady flowrate = 360 m3/hour, initial temperature = 15 
deg.C, increasing at 0.1 deg.C every second, present TWA = 15.0  
At 00:00:00, TWA period time = 0.0, t = 15.0, TWA=15.0 

No action (TWA remains at 15.0) 
At 00:00:01, TWA period time = 0.0, t = 15.1, TWA=15.0  

Delta = 0.1 – 0.0 = 0.1 
TWA = (0.0 * 15.0) + (15.1*0.1) /(0.0 + 0.1) = 15.1 
TWA period time = 0.0 + 0.1 = 0.1 

At 00:00:02, TWA period time = 0.1, t = 15.2, TWA=15.1 
Delta = 0.2 – 0.1 = 0.1 
TWA = (0.1 * 15.1) + (15.2*0.1) /(0.1 + 0.1) = 15.15 
TWA period time = 0.1 + 0.1 = 0.2 

At 00:00:03, TWA period time = 0.2, t = 15.3, TWA=15.15 
Delta = 0.3 – 0.2 = 0.1 
TWA = (0.2 * 15.15) + (15.3*0.1) /(0.2 + 0.1) = 15.2 
TWA period time = 0.2 + 0.1 = 0.3 
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At 00:00:04, TWA period time = 0.3, t = 15.4, TWA=15.2 
Delta = 0.4 – 0.3 = 0.1 
TWA = (0.3 * 15.2) + (15.4*0.1) /(0.3 + 0.1) = 15.25 
TWA period time = 0.3 + 0.1 = 0.4 

 
Time-Weighted Averaging – XFLOW (TW-XFLOW)  

The S600+ calculates TWA-XFLOW regardless of the measured 
flowrate. The algorithm used is the same as that for TWA, with the 
exception that the system does not check if the flowrate is greater than 
zero. Refer to the TWA description for an example.  

Note: The methods detailed for flow and time weighted averaging 
should yield the same results as those specified for the linear 
averaging as detailed in API (September 1993) Chapter 21, 
Appendix B. The system supports formulas for both flow-
dependent time weighted linear average (B.1.1 a) and flow-
dependent flow weighted linear average (B.1.1.c).  

 
Weighted Averaging 

Screen 
To access this screen: 

1. Select Time/Flow Weighted Averaging from the hierarchy menu.  

2. Select a stream. The Weighted Averaging screen displays.  

  

Figure 6-16. Weighted Averaging screen  

3. Complete the following field:  
Field  Description 
Method Indicates the averaging method. Click  to display all 

valid values.  
 FWA Flow weighted averaging, calculated 

with respect to the total. This is the 
default value.  
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Field  Description 
 TWA Time weighted averaging, calculated 

with respect to time and totals. The 
system calculates this value only when 
the flowrate is greater than zero. 

 TWA-
XFLOW 

Time weighted averaging, calculated 
with respect only to time. The system 
calculates this value regardless of the 
measured flowrate. 

 
4. Click any of the following buttons to define variables: 

Note: Forward and reverse settings are linked. Changes made to 
settings for either direction are automatically reflected in 
settings for both directions.   

 
Button  Description 
METER 
PRESSURE (Pf) 

Click to display a Select Object dialog box you use to 
review or re-associate an object type with an object for 
meter pressure.   
Note: The STR01 label changes based on the 

selected stream.   
METER TEMP 
(Tf) 

Click to display a Select Object dialog box you use to 
review or re-associate an object type with an object for 
meter temperature.  
Note: The STR01 label changes based on the 

selected stream/application type.   
BASE DENS Displays a Select Object dialog box you use to review 

or re-associate an object type with an object for base 
density.  
Note: The STR01 label changes based on the 

selected stream.   
MASS FR Displays a Select Object dialog box you use to review 

or re-associate an object type with an object for mass 
f lowrate.  
Note: The STR01 label changes based on the 

selected stream.   
 
Note: The system automatically applies any changes to TWFA 

assignments to reports. Any unassigned average variables are 
hidden on the live reports and displays. 

 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays. 

6. Click Yes to apply your changes. The PCSetup screen displays.  

6.3 Gas – Coriolis  
These stream settings are specific to gas applications using a Coriolis 
meter. When you initially create a configuration, the calculation 
selections you make determine which calculation screens appear in the 
hierarchy menu.  
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Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, settings are 
demonstrated using a number of example configurations.  
 

6.3.1 AGA8 (Compressibility)  
Compressibility settings define the constants and calculation limits for 
a range of parameters including pressure, temperature, density, and 
compressibility factors. This screen displays when you configure the 
S600+ to use the main AGA8 standard to calculate base 
compressibility, standard compressibility, and flowing compressibility 
for natural gases. 

Note: Standard conditions are assumed as 14.73 psia and 60° F.  

The compressibility settings also allow you to define alarms. The 
system activates these when the calculated results are not within the 
specified limits. 

1. Select AGA8 from the hierarchy menu. The AGA8 screen 
displays.   

  

Figure 6-17. AGA8 (Compressibility) screen  

2. Complete the following fields.  
Field  Description 
Status/Control 
Method 

Indicates the compressibility method. Click  to 
display all valid values.  

 DETAIL Uses 21 component values, temperature 
and pressure in accordance with the 1994 
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Field  Description 
standard. This is the default.  

 GROSS1 Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 1991 standard.  
Note:  Gross1 only supports volumetric 

heating value and does not support 
mass heating value.  

 GROSS2 Uses SG, N2, CO2, temperature and 
pressure in accordance with the 1991 
standard. 

 VNIC Uses 20 component values, temperature 
and pressure in accordance with GOST 
30319 1996.  

 MGERG Uses 19 component values (As indicated 
in GERG Technical Monograph 2 1998) to 
calculate compressibility of natural gas 
mixtures based on a full compositional 
analysis. 

 PT 1 
DETAIL 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard.  

 PT 1 
GROSS1 
2017 

Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 2017 standard. 
Note:  Gross1 only supports volumetric 

heating value and does not support 
mass heating value. 

 PT 1 
GROSS2 
2017 

Uses SG, N2, CO2, temperature and 
pressure in accordance with the 2017 
standard. 

 PT 1 
GROSS0 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 

 PT 2 
GERG 
2008 

Uses 21 component values [as indicated 
in Table 1 AGA8 2017 Part 2 (GERG 
2008)] to calculate compressibility of 
natural gas mixtures based on a full 
compositional analysis. 

Pressure 
(Standard) 

Sets the pressure under standard conditions. The 
default is 0.   

Temperature 
(Standard) 

Sets the temperature under standard conditions. The 
default is 15.   

Limit Check Disables the system’s calculation limit checking. 
The default is On (enabled).  
Note: Compressibilities and densities are less 

accurate and calculations may fail when 
operating outside the calculation limits.   

Pressure 
(Inputs) 

Sets the current pressure used to calculate 
compressibility and density at flowing conditions.   
Note: On some streams this field may be read-only 

as this reflects the pressure in use when the 
f low computer is operational. 

Temp (Inputs) Sets the current temperature used to calculate 
compressibility and density at flowing conditions.   
Note: On some streams this field may be read-only 

as this reflects the pressure in use when the 
f low computer is operational.  
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Field  Description 
REAL RD (SG) Click to display a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the relative density.   

GROSS HV Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the gross heating value (HV).   

 
3. Click any of the following buttons to set calculation limits:   

Button  Description 
METER 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the meter density.   

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream (flowing) compressibility.   

MOLAR MASS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the molar mass.  

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in the 
Status/Control Method field. 

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base density.  

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base compressibility.  

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in the 
Status/Control Method field. 

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the ideal relative density.  

STD COMP(Zs) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the standard compressibility.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.2 Gas CV (ISO6976 or GPA2172/ASTM D3588) 
Calorific Value (CV) settings define the constants and calculation 
limits for the ideal and real calorific values. This screen displays when 
you configure the S600+ to use either the ISO6976 or GPA2172/ 
ASTM D3588 standard (in step 5, Options, of the PCSetup Editor’s 
Configuration Wizard) to calculate the calorific value (heating value) 
of the gas mixture.  



Config600 Configuration Software User Manual 

6-26 Stream Configuration Revised January 2023 

The calorific value settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits. 

1. Select Gas CV from the hierarchy menu. The Calorific Value 
screen displays. 

  

Figure 6-18. Gas CV screen  

2. Complete the following fields.   
Field  Description 
CV Table Indicates the specific type of GPA scenario calculation 

the S600+ uses. Click  to display all valid values.  
Note: Change units and CV table if you want CV in 

mass units.   
 ISO6976/ 

1995 Vol 
Calculates CV based on volume, using 
the 1995 table. This is the default if you 
choose CV ISO6976 as your initial 
stream option.  
Note: This option displays only if you 

initially configure the stream to 
use CV ISO6976.  

 ISO6976/ 
1995 Mass 

Calculates CV based on mass, using the 
1995 table.   
Note: This option displays only if you 

initially configure the stream to 
use CV ISO6976. 

 ISO6976/ 
1983 Vol 

Calculates CV based on volume, using 
the 1983 table.  
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Field  Description 
Note: Support for the 1983 table is 

limited to superior volumetric at 
15/15. This option displays only 
if  you initially configure the 
stream to use CV ISO6976. 

 ISO6976/ 
2016 Vol 

Calculates CV based on volume, using 
the 2016 table. 
Note: This option only displays if you 

initially configure the stream to 
use CV ISO6976. 

 ISO6976/ 
2016 Mass 

Calculates CV based on mass, using the 
2016 table. 
Note: This option only displays if you 

initially configure the stream to 
use CV ISO6976. 

 GPA/2003 
AGA 
(14.73) 

Calculates CV based on a base 
pressure of 14.73 psia. This is the 
default if you choose CV GPA2172-
ASTMD3588 as your initial stream 
option.   
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 

 GPA/2003 
ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 

 GPA/2000 
AGA 
(14.73) 

Calculates CV based on a base 
pressure of 14.73.   
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 

 GPA/2000 
ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.   
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 

   
 GPA/1996 

AGA 
(14.73) 

Calculates CV based on a base 
pressure of 14.73 psia.   
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 

 GPA/1996 
ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.   
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 

 GPA/2016 
Pb (14.65) 

Calculates CV based on a base 
pressure of 14.65 psia.   
Note: This option displays only if you 

initially configure the stream to 
use CV GPA2172-ASTMD3588. 
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Field  Description 
Reference 
Condition 

Indicates the t1/t2 value, where t1 is the calculation 
reference temperature for combustion and t2 is the 
reference condition for metering. Click  to display all 
valid values. The default is 15/15 DEG C.  
Note:  
 For ISO6976 1983 VOL selection, the 60/60F 

and 15/15.55 Deg C selections are not 
supported.  

 For ISO6976 1995 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection is not supported. 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a 
combustion temperature (t1) of 15 Deg C 
and a metering temperature (t2) of 15 Deg 
C. 

 For ISO6976 2016 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection refers to a combustion temperature 
(t 1) of 15.55 Deg C (60 Deg F) and a metering 
temperature (t2) of 15.55 Deg C (60 Deg F). 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a 
combustion temperature (t1) of 15 Deg C 
and a metering temperature (t2) of 15 Deg 
C. 

Method If  you select CV ISO6976 in your initial 
conf iguration and you select the 1995 standard, 
you have the choice of Alternative or Definitive 
methods (using table 4 Mass / table 5 volume) for 
calculating the ideal, superior, and inferior CV 
values. This selection is not applicable to the 1983 
or 2016 standards. 
If  you select CV GPA2172-ASTMD3588 in your 
initial configuration, you have the choice of the 
Simple (using equation 7 f rom the GPA2172-
ASTMD3588-09 standard) or Rigorous (using 
equations 8 & 9 f rom the GPA2172-ASTMD3588-
09 standard) methods for calculating the standard 
compressibility. 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
User Temp T2 Applicable to the ISO6976 2016 VOL and ISO6976 

2016 MASS selections. Also applicable to the 
ISO6976 1995 VOL selection when the Definitive 
method is selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised.  
User Press P2 Applicable to the ISO6976 2016 VOL and ISO6976 

1995 VOL selections when the Definitive method is 
selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
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Field  Description 
Table Revision This replaces the above AGA and ISO selections in 

the CV Table f ield for GPA 2172. You can select 
the GPA2145 table revision from one of the 
following:  
 1996 
 2000 
 2003 
 2009 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
Base Comp(Zb) Click to supply an externally calculated base 

compressibility from another calculation. The entered 
value is used in GPA2172-ASTMD3588 calculations 
instead of using its own internally calculated value 
based on the composition input. 

Composition 
Type 

Def ines the composition input type. Valid options 
are: 
 mass to energy using mole percent  
 mass to energy using mole fraction 
 volume to energy using mole percent 
 volume to energy using mole fraction 
Note: This option is valid only for AGA5 

configurations. 
 
3. Click any of the following buttons to define calculation limits for 

either the ISO6976 or GPA2172-ASTMD3588 standard.   
Button  Description 
STD COMP (Zs) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for standard compressibility (Zs).   

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal relative density.   
Note: This field displays only if you initially configure 

the stream to use CV ISO6976. 
IDEAL DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for ideal density.  
Note: This field displays only if you initially configure 

the stream to use CV IS6976.  
IDEAL CV 
(SUP) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal calorific value.  
Note:  The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either using the CV 
object mode from the Front Panel display.  

Gross HV Displays a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for gross heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-ASTMD3588. 
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Button  Description 
REAL RD Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for real relative density.  
Note: This field displays only if you initially configure 

the stream to use CV ISO6976.  
REAL DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for real density.  
Note: This field displays only if you initially configure 

the stream to use CV ISO6976. 
REAL CV (SUP) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the Front Panel display. This field 
displays only if you initially configure the 
stream to use ISO6976. 

WOBBE INDEX Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The Wobbe Index is calculated using the Real 

Superior CV. 
REAL VOL 
IDEAL HV 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the real volume ideal 
heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-ASTMD3588. 
 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.3 Gas CV (AGA5)  
Calorific Value settings define the constants and calculation limits for 
ideal and real calorific values. This screen displays when you 
configure the S600+ to use the AGA5 (CVAGA5) standard to calculate 
calorific value (heating value) for the gas mixture. )  

The calorific value settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits.  

1. Select Gas CV from the hierarchy menu. The Calorific Value 
screen displays.  
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Figure 6-19. Calorific Value screen  

2. Click either of the buttons to define calorific value parameters.  
Button  Description 
MIXTURE SG Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for specific gravity.  

ENERGY RATIO  Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the actual calorific value.  
Note:  The energy ratio is equivalent to the real 

calorific value or real heating value.   
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.4 Stream Gas Composition  
Stream Gas Composition settings define the processing and port 
telemetry parameters for streams receiving data from the gas 
chromatograph controller. The chromatograph controller measures the 
individual component concentrations found in the line gas. The 
chromatograph controller settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the 
chromatograph data are not within specified limits.  

1. Select Gas Composition from the hierarchy menu. The Gas 
Composition screen displays.   
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Figure 6-20. Gas Composition screen  

2. Complete the following fields.  
Field  Description 
Type Indicates the chromatograph configuration. Click  to 

display all valid values.   
 CHROMAT A Controller-connected; uses keypad 

data as fallback information.  
 KP ONLY Not controller-connected; uses 

information entered via keypad. This 
is the default. 

 Note: If  you select KP ONLY, the system hides a 
number of fields on this screen.  

Initial Mode Indicates the operational mode for the in-use 
composition data. Click  to display all valid values.  

 KEYPAD Use data entered via keypad. This is 
the default.  

 CHROMAT Use live data from the 
chromatograph controller.  

 DOWNLOAD Download gas composition data 
directly to each stream. Used only if 
connected to a remote supervisory 
computer.  

 USER Use customised program for gas 
composition in S600+.  

 KEYPAD-F Start by using keypad-entered data 
then switch to chromatograph data 
when a good analysis is received.  
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Field  Description 
Acceptance 
Type 

Indicates how the S600+ manages in-use data. Click 
 to display all valid values.  

 ACC/COPY Copy and normalise keypad data to 
in-use data only after it is accepted. 
This is the default.  

 ACC/NORM Copy normalised keypad data to in-
use data after it is accepted.  

 AUTO/NORM Automatically copy normalised 
keypad data to in-use data.  

Station Number Sets the station associated with this stream. The 
default is 1. 

Apply Splits Indicates the type of analyser connected to the S600+. 
For a C6+ analyser, use the C6Plus option. Click  to 
display all valid values. The default is NO SPLITS.  
If  you select any value other than NO SPLITS, the 
system displays the MOLE SPLITS button. Use it to 
define the specific percentage splits for the gases.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

MOLE SPLITS Click to display a Gas Composition dialog box you use 
to indicate the mole splits for hexane, heptane, octane, 
nonane, and decane.  
Note:  This button displays only if you select any 

value other than NO SPLITS in the Apply 
Splits field. 

Revert to Last 
Good after 
Failure  

Continues using the last good composition in the event 
of  failure. Otherwise, the system reverts to keypad 
data.  

Check Critical 
Alarms  

Marks the received composition as failed if any critical 
alarm is set (such as the pre-amp fail on the Danalyzer 
for a Daniel 2551 Controller).  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Check Non 
Critical Alarms  

Marks the received composition as failed if any non-
critical alarm is set (such as the pre-amp fail on the 
Danalyzer for a Daniel 2551 Controller).  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

CHROMAT 
COMMS 

Click to display the Comm screen in I/O Setup.  

Initial Mode Identifies the chromatograph and any fallback 
controllers. Currently, the only valid value is PAY, 
which indicates one chromatograph and no fallback 
controller.   
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 
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Field  Description 
Type Indicates the type of chromatograph controller. Click  

to display all valid values. 
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

 2551 EURO S600+ is connected to a Daniel 
2551 (European) controller. This is 
the default.  

 2350 EURO S600+ is connected to a Daniel 
2350 (European) controller set in 
SIM_2251 mode.  

 2350 USA S600+ is connected to a Daniel 
2350 (USA) controller set in 
SIM_2251 mode.  

 2251 USA S600+ is connected to a Daniel 
2251 controller.  

 Generic S600+ is connected to another type 
of  controller.   

 Siemens S600+ is connected to a Siemens 
Advance Maxum via a Siemens 
Network Access Unit (NAU).  

MOLE ORDER Click this button to display a dialog box on which you 
indicate the order in which the gas composition 
information comes into the S600+ via telemetry. 0 
indicates any component which is not included in the 
Modbus map.  
Note:  
 The Modbus map you create must be compatible 

with the controller to which the S600+ is connected. 
Refer to Chapter 14, Modbus Editor, for further 
information. 

 This field displays only if you select CHROMAT A 
as the chromatograph configuration type. 

 This field is applicable only when selecting 
Siemens or Generic in the Type field. 

Address  Configures multi-drop chromatograph support. Do not 
change unless advised to do so.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Stream  Sets the chromat analysis stream assigned to this 
metering stream. The default is 0.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. If you need to support 
more than one stream, contact Technical 
Support.  
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Field  Description 
Analysis 
Timeout  

Sets the maximum number of seconds the S600+ 
waits to receive a new composition from the 
chromatograph controller before raising an alarm. The 
default is 900.  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Download 
Timeout  

Sets the maximum number of minutes the S600+ waits 
to receive a new composition from the supervisory 
computer before raising a DL Timeout Alarm. The 
default is 15.  
Note:  
 A value of 0 disables the timeout. 
 This field displays only if you select KP ONLY in 

the Type field. 
KEYPAD 
MOLES 

Click to display a dialog box you use to define mole 
percentage values for each gas component.   
Note:  The system assumes the keypad composition 

adds to 100% (normalised) when the 
Acceptance Type is ACC/COPY. If you select 
ACC/NORM or AUTO/NORM, the system 
automatically normalises the keypad 
composition.   

MOLE 
ADDITIONAL 

Click to display a dialog box you use to define mole 
percentage values for gas components not analysed 
by the Danalyzer. The system assumes any additional 
components to be normalised values, so the analyser 
components are re-normalised to (100 – sum of 
additional components).  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

USER MOLES Click to display a dialog box you use to define mole 
percentage values for each gas component. The 
system assumes user moles to be normalised.   
Note: The S600+ uses these values only if you set 

the Initial Mode to USER. A Modbus 
download from another computer may 
overwrite these values on a running 
configuration.  

Check Limits Enables limit checking on each gas component. When 
you select this check box, the MOLE LO LIMITS and 
MOLE HI LIMITS buttons display.  
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Field  Description 
MOLE LO 
LIMITS 

Click to display a dialog box you use to define low 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:  
 The system uses the values you enter through 

these buttons only if you select the Check Limits 
check box. The system applies this test to the 
keypad, downloaded, user, additionals, and new 
analysis components. When enabled, the system 
applies the limit check against the high and low 
limits. Limits are considered valid if the limit is 
greater than zero (0). The system also applies the 
check to the Total field. If you disable the limit 
check, the keypad, downloaded, and user Total 
f ield must lie within 0.1% and 150%. A sum of the 
new analysis must be within 99.5% and 100.5%.  

 This field displays only if you place a check mark 
in the Check Limits field. 

MOLE HI 
LIMITS 

Click to display a dialog box you use to define high 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component. 
Note: See note in description of Mole Lo Limits field.  

Check 
Deviations 

Enables checking on the deviation from the last good 
analysis for each component. When you select this 
check box, the MOLE DEVN LIMITS button displays.  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

MOLE DEVN 
LIMITS 

Displays a dialog box you use to define the maximum 
deviation allowed for each gas component. Enter 0 in 
any field to prevent the test for the selected 
component.  
Note: This field displays only if you place a check 

mark in the Check Deviations field. 
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.5 Gas Properties  
Gas Properties settings define methods the system uses to calculate 
viscosity, isentropic exponent (also known as “specific heat ratio” or 
“adiobatic exponent”), and the velocity of sound.   

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits. 
1. Select Gas Properties from the hierarchy menu. The Gas 

Properties screen displays.    
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Figure 6-21. Gas Properties screen  

2. Complete the following fields.   
Field  Description 
Viscosity @ Tn Sets the reference viscosity for the gas. The default is 

0.010861.   
Note: Used only by VDI/VDE.  

Viscosity Tn Sets the reference viscosity temperature for the gas. 
The default is 15.  
Note: Used only by VDI/VDE.   

Sutherland 
Constant 

Sets the Sutherland constant for the gas. The default is 
164 (Methane).   
Note: Used only by VDI/VDE. 

Viscosity Calc 
Type 

Indicates the method for calculating the viscosity of the 
gas. Click  to display all valid values.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default. 

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires base density, 
N2, and CO2 inputs.  

 VDI/VDE 2040 
1987 

Uses calculations from VDI/VDE 
2040 Part 2 1987. Requires 
viscosity @Tn, viscosity Tn, and 
Sutherland Constant inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   
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Field  Description 
Isentropic 
Exponent 

Indicates the method for calculating the isentropic 
exponent of the gas. Click  to display all valid values.   

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.  

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   

Speed of 
Sound 

Indicates the method for calculating the speed of 
sound. Click  to display all valid values.  

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.   

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.   

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.  

 
3. Click any of the following buttons to display a dialog box you use 

to set gas property outputs or variables:   
Button  Description 
VISCOSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for viscosity. 

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent. 

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound (VOS). 
Note: AGA10 refers to VOS as “speed of sound.”   

METER PRESS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the meter pressure.  
Note: This button may be disabled on some 

applications.  
METER TEMP Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the meter temperature.  
Note: This button may be disabled on some 

applications.  
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Button  Description 
BASE DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for base density. 

INUSE 
COMPOSITION 

Click to display a read-only table of gas compositions. 
This corresponds to the table defined through the Gas 
Composition screen’s KEYPAD MOLES button.  

 
4.  Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.6 Ethylene 
This screen displays when you configure the S600+ to use the Ethylene 
standards to calculate base compressibility, base density, flowing 
compressibility and flowing density for ethylene. The S600+ also uses 
it to calculate the flowing compressibility and flowing density for 
Propylene.  

The compressibility settings also allow you to define alarms. The 
system activates these when the calculated results are not within the 
specified limits. 
1. Select Ethylene from the hierarchy menu. The Ethylene screen 

displays.  

  

Figure 6-22. Ethylene screen  

2. Complete the following fields.  
Field  Description 
Calculation 
Type 

Indicates the type of calculation to use. Click  to 
display all valid values.  

 IUPAC 
ETHYLENE 

Uses IUPAC 1988 (Liquid and Gas 
Phase). This is the default.  

 API 
ETHYLENE 

Uses API 11.3.2.1 1985 (Gas 
Phase).  

 NBS 1045 Uses NBS 1045 1981 (Liquid and 
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Field  Description 
ETHYLENE Gas Phase)   

 API 
PROPYLENE 

Uses API 11.3.3.2 1974 (Liquid 
phase).   

Pressure (Base 
Conditions) 

Sets the pressure under base conditions. The default 
is 0.    

Temperature 
(Base 
Conditions) 

Sets the temperature under base conditions. The 
default is 15.   

Pressure 
(Flowing 
Conditions) 

Sets the current flowing pressure to calculate 
compressibility and density.  
Note: On some streams this field may be read-only.    

Temperature 
(Flowing 
Conditions) 

Sets the current flowing temperature to calculate 
compressibility and density.  
Note: On some streams this field may be read-only.   

 
3. Click any of the following buttons to set calculation limits.  

Button  Description 
BASE DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the base density 

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the meter density. 

METER 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base compressibility. 

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream (flowing) compressibility. 

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.   

6.3.7 Linearisation  
Linearisation settings define the constants and calculation limits for the 
meter factor. The S600+ calculates a meter factor corresponding to the 
frequency by interpolating the frequency between fixed points and then 
cross-referencing the result against a lookup table. Linearisation 
settings also allow you to define alarms. The system activates these 
alarms when the calculated results for the Meter Factor are not within 
specified limits.  

Notes:  
 The linearisation curve for Gas Coriolis configurations uses 

frequency as the default input for Meter Factor calculations. The 
ability to change the default is available only with Config600 Pro 
software. 

 Batching systems that employ meter factor linearisation with 
retrospective meter factor adjustments assume that the adjusted 
value has a “keypad” mode. 
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 To prevent the live metering system from applying a double 
correction, use either a calculated meter factor or a calculated K-
factor linearisation (that is, only one factor should have a 
calculated mode). 

1. Select Linearisation from the hierarchy menu. The Linearisation 
screen displays.   

 

Figure 6-23. Linearisation screen 
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2. Complete the following fields.  
Field  Description 
Meter Factors Sets up to 20 flow rate and values for the meter 

correction factors.  
 Flowrate/Freq Sets the flowrate and frequency for 

each of the meter correction factors.  
 Value Sets the corresponding values for 

each of the meter correction factors.  
M-FACTOR Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the respective factor.  

K-FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor. 

Meter Factor 
Method 

Selectable between METER FACTOR (values entered 
as normal) and ERROR PERCENT (Meter Factor 
entered as a percentage). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.8 Sampling 
Sampling defines the method and interval period for sampling product 
from a flowing pipeline. By default, Config600 supports one sampler 
per stream. Config600 uses the following stages during the sampling 
process:   

Stage Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl 
4 Post Pulse  
5 Stopped Manually 
6 Stopped Can Full 
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch 
12 Stopped initialise 
13 Can Switch Over 

Note:  Batch auto-resets the sampler at the start of the batch. 

1. Select Sampling from the hierarchy menu. The Sampling screen 
displays.  
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Figure 6-24. Stream Sampling screen 

2. Complete the following fields.   
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 

stream or station must have a unique sampler ID and 
must be greater than zero.   

Method  Indicates the sampling method. Click  to display all 
valid values.  

 TIME PROP Divides the value in the Can Fill 
Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a time interval 
per pulse. This is the default.  

 FLOW PROP1 Divides the value in the Volume 
f ield by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a volume 
throughput per pulse.  

 FLOW PROP2 Uses the value in the Volume field 
as the volume throughput per 
pulse.  

 FLOW PROP3 Uses the value in the Volume field 
as the volume throughput per 
pulse, but supports low pressure 
digital input and pump prime 
output.  
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Field  Description 
Mode Indicates the sampling mode. Click  to display all 

valid values. The S600+ uses Can 1 or Can 2.  
 SINGLE Acquire sample in one trial. This is 

the default.  
 DUAL Acquire samples in two trials.  

Note: If  you select Dual, the 
sampler switches to a 
second can when the 
current can is full 
(according to the two can 
switchover mode).  

Can Fill 
Indicator 

Indicates when the sampling can is full. Click  to 
display all valid values.   

 GRAB COUNT Uses the number of pulses output 
to the sampler to determine when 
the sample is full. This is the 
default. 

 DIG I/P Uses a digital input to determine 
when the sampler is full.  

 ANALOG I/P Uses an analog input to determine 
when the sampler is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select the appropriate 
check box to identify the specific event.   

 On Can Full Disables the sampling process 
when the can is full. This is the 
default. 

 On Flowrate 
Limit 

Disables the sampling process 
when the flowrate is less than the 
value of the Flowrate Low Limit. 

 On Flow Status Disables the sampling process 
when the flow status value is not 
on-line. 

Auto Restart Automatically restarts (if selected) sampling following 
an automatic disabling.  

Expected 
Volume/Mass 

Indicates, in cubic meters, the expected flow volume or 
mass of the sampling can. This is the value the Flow 
Prop1 and Flow Prop2 sampling methods use for 
calculations. The default is 1000.  

Can Fill Period Sets, in hours, the time required to fill the sampling 
can. The default is 24.  
Note: The Time Prop sampling method uses this 

value for its calculations.   
Flowrate Low 
Limit  

Indicates flowrate low limit used by the Auto Disable 
on Flowrate Limit option. The default is 0.   
Note:  This field is required if you select the On 

Flowrate Limit check box for Auto Disable.  
Minimum 
Interval  

Indicates, in seconds, the minimum amount of time 
between grabs. This is the value the Time Prop 
sampling method uses for its calculations. The default 
is 30.   
Note: If  the sample exceeds this limit, the system 

sets the overspeed alarm and increments the 
overspeed counter.   
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Field  Description 
Volumes 
 Can Volume Indicates, in cubic meters, the 

volume of the sampling can. The 
default is 0.5.   

 Grab Volume Indicates, in cubic meters, the 
volume of the sampling grab. 
The default is 0.001.   

Can Limits 
 Can Low Limit Indicates the low alarm value as 

a percentage of the can volume. 
The default is 5. 

 Can High Limit Indicates the high alarm value as 
a percentage of the can volume. 
The default is 90.   

 Can High High 
Limit 

Indicates the high high alarm 
value as a percentage of the can 
volume. The default is 95.   

Twin Can 
Changeover 
Mode  

Indicates the changeover method for twin can 
sampling. Click  to display all valid values.  
AUTO The sampler automatically 

changes over to the second can 
when the first is full. 

MANUAL The sampler pauses sampling 
when the first can is full and 
requires the operator to change 
the value of Can Selected before 
sampling continues on the 
second can. 
Note: 
 If  sampling is stopped 

because both cans are full, 
the Twin Can Changeover 
Mode is set to MANUAL by 
the system. The user must 
set back to AUTO if required. 

 The display for Twin Can 
Changeover must be 
manually added to the 
displays. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.3.9 Coriolis   
Coriolis settings define the constants and calculation limits for a range 
of parameters, including stream input sources and modes of operation. 
The Coriolis settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within 
specified limits.    

Flow data is received from a Coriolis meter via Modbus serial 
communications or a pulse input, or a combination of both. The S600+ 
generates its own totals incrementally from the comms or pulses. 
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1. Select Coriolis from the hierarchy menu. The Coriolis screen 
displays.  

 

Figure 6-25. Coriolis screen  

2. Complete the following fields.   
Field  Description 
Flow Units  Indicates the primary measurement for flow units. 

Click  to display all valid values. Select MASS 
(configures the Coriolis meter for mass-based pulses) 
or VOLUME (configures the meter for volume-based 
pulses). The default is MASS.  

Flow Data 
Source  

Indicates the source of flow data. Click  to display 
all valid values. Select SERIAL (enables the system 
to take the primary variable from the serial mass or 
volume flowrate) or PULSE I/P (calculates the 
primary variable from the mass or volume pulse 
input). The default is SERIAL.  

Kdpf  Sets a density correction factor value. The default is 
0.  
Note: Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 
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Field  Description 
Density Calib 
Pressure  

Sets a density calibration pressure value. The default 
is 0.  
Note: Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 

Ktpf1  Sets a pulse correction factor value. The default is 0.  
Note: Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 

Flow Calib 
Pressure  

Sets a flow calibration pressure value. The default is 
0.  
Note: Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 

Pressure  Indicates the source of pressure I/O. Click  to 
display all valid values. Select CORIOLIS (use data 
f rom the Coriolis serial link) or I/O (use data either 
f rom the ADC/PRT/Density inputs [if correctly 
configured] or from the Coriolis serial link [if 
incorrectly configured]). The default is CORIOLIS.  
Note: If  you select I/O, remember to configure the 

analogue inputs.   
Temperature  Indicates the source of temperature I/O. Click  to 

display all valid values. Select CORIOLIS (use data 
f rom the Coriolis serial link) or I/O (uses data either 
f rom the ADC/PRT/Density inputs [if correctly 
configured] or from the Coriolis serial link [ff 
incorrectly configured]). The default is CORIOLIS.  
Note: If  you select I/O, remember to configure the 

analogue inputs.  
Density  Indicates the source of density I/O. Click  to display 

all valid values. Select CORIOLIS (use data from the 
Coriolis serial link) or I/O (use data either from the 
ADC/PRT/Density inputs [if correctly configured] or 
f rom the Coriolis serial link [if incorrectly configured]. 
The default is CORIOLIS.  
Note: If  you select I/O, remember to configure the 

densitometer.  
Use 64 bit totals  Indicates whether the S600+ uses the 64-bit totals 

received from the Coriolis meter in its totalisation 
routines.  
NO Use the 32-bit totals received from the 

Coriolis meter. This is the default. 
YES Use the 64-bit totals received from the 

Coriolis meter. 
Use ext 
temp/press 

Indicates which serial temperature and pressure 
values the S600+ uses in calculations. 
Note: This is valid only if the temperature and 

pressure I/O selections are set to 
CORIOLIS. 

NO Use the internally derived temperature and 
pressure values. This is the default. 

YES Use the external temperature and pressure 
input values. 
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Field  Description 
Max Acceptable 
Gap 

Sets, in seconds, the maximum acceptable gap 
between successive polls. The default is 50. The 
system’s incremental validation logic uses this value 
to determine communication failures.  

Flow Integral 
Acceptance 
Factor 

Sets the acceptance tolerance factor for comparing 
f lowrate to elapsed totals. Used by the increment 
validation logic.The default is 20.   

Max Meter Total Sets a maximum allowable increment in the received 
total. Used by the increment validation logic. 

Max Flowrate  Sets a maximum allowable flowrate. Used by the 
increment validation logic.The default is 160.  

 
3. Click any of the following buttons to set meter variable limits:   

Button  Description 
SERIAL PRESS Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for serial pressure.  

SERIAL TEMP Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for serial temperature.   

SERIAL 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for serial density.  

I/O PRESSURE Click to display an Analog Input dialog box you use to 
define various values for the analog input. For further 
information, refer to Chapter 4, Section 4.3, Analog 
Inputs.   

I/O 
TEMPERATURE 

Click to display an Analog Input dialog box you use to 
define various values for the analog input. For further 
information, refer to Chapter 4, Section 4.3, Analog 
Inputs.   

I/O DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for I/O density.  

Coriolis 
Comms 

Click to access the I/O Setup screen in Comms.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 
Coriolis Validation 

Logic 
The system supports logic to check whether the flowrate and totals 
values received across the serial link are in proportion and correspond 
to data received on the previous poll.  
The expressions in upper case are keypad entered values. The default 
values are: 

 MAX POLL GAP = 50 seconds 
 FLOW INTEGRAL FACTOR = 20 
 MAX FLOWRATE = 2000 t/h 
 MAX INCREMENT = 9990000 tonne 

The task runs approximately once per second, so delta_t would 
normally be about 1 second. 

proc validate_inc() 
          valid = FALSE 
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          delta_t = current time – previous time 
          increment = current total – previous total 
          flow_inc   = (current fr + previous fr) / 2 * delta_t 
ifdelta_t < MAX POLL GAP then 
                    if increment <= FLOW INTEGRAL FACTOR * flow_inc then 
                             if increment < MAX FLOWRATE * delta_t then 
if increment < MAX INCREMENT then 
                            valid = TRUE 
                       endif 
                   endif 
              endif 
          endif 
          return (valid) 
endproc 

6.3.10 Local Units 
This option allows you to override the global K-factor unit, since a gas 
application may have more than one type of meter, each using different 
K-factor units.  

1. Select Local Units from the hierarchy menu. The Local Units 
screen displays.  

 

Figure 6-26. Local Units screen  

2. Complete the following field: 
Field  Description 
K-Factor Units Indicates the type of units to use and override the 

system K-factor units of measurement. Click ▼ to 
display all valid values. The default is SYSTEM 
UNITS. 
Note:  If  you select System Units, the stream uses 
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Field  Description 
the global default value.  

3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
 

6.4 Gas – DP  
These stream settings are specific to gas applications using differential 
pressure (DP) meters. When you initially create a configuration, the 
calculation selections you make determine which calculation-specific 
screens appear in the hierarchy menu.  
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings.  
 

6.4.1 Downstream/Upstream Correction  
Downstream and Upstream correction settings define the parameters 
required to either correct upstream measurements to downstream 
measurements or correct downstream measurements to upstream 
measurements.  
For gas, the system obtains pressure and density measurements from 
either downstream or upstream of the orifice plate. DP flow 
calculations require temperature, pressure, and density to be upstream 
values.  

These correction settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within the 
specified limits. 

1. Select Downstream Upstream Correction from the hierarchy 
menu for the desired stream.  

2. Select CORR T/P (to correct temperature and pressure) or CORR 
DENS (to correct density). The system displays the 
Downstream/Upstream Correction screen.  

Note: For the purpose of explanation, we include two figures 
(Figure 6-27 and Figure 6-28) that display all options. 
Depending on your selections in the previous step, 
Config600 displays only portions of these screens.  



Config600 Configuration Software User Manual 

Revised January 2023 Stream Configuration 6-51 

  

Figure 6-27. Temperature/Pressure Correction screen   

  

Figure 6-28. Density Correction screen   
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3. Click the appropriate button or complete the following fields.  
Field  Description 
Correction 
Type 

Indicates the correction methodology the S600+ 
applies to temperature and density corrections. Click  
to display all valid values.  

 SIMPLE Upstream and downstream 
temperatures are the same.  

 EXTENDED Calculates upstream temperature 
f rom measured downstream 
temperature and upstream density 
f rom measured downstream density. 
Calculation uses exponents 
calculated from the isentropic 
exponent. This is the default.  

 JT METHOD Calculates upstream temperature 
f rom measured downstream 
temperature using the Joule-
Thomson coefficient as described in 
ISO5167-2003.  
Note: This selection adds the JT 

Coefficient button to the 
screen.  

METER PRESS Click to display an Analog Input dialog box you use to 
define various values for the analog input.  

Measurement 
Point 
(Pressure) 

Indicates the source of flow data for pressure 
calculations. Click  to display all valid values. The 
default is UPSTREAM.  
Note: This represents the physical measurement 

point on the metering system.  
DOWNSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for downstream density.  
Note: This button displays only if you select the 

CORR DENS component.   
DENS EXP 
CONSTANT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for density expansion.   
Note: This button displays only if you select the 

CORR DENS component. 
DENSITY 
COMP(Zd) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for densitometer compressibility (Zd).  

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream compressibility (Zf) at 
upstream conditions.   

METER TEMP Click to display an Analog Input dialog box you use to 
define various values for the analog input.  

Measurement 
Point 
(Temperature)  

Indicates the source of flow data for temperature 
calculations. Click  to display all valid values. The 
default is DOWNSTREAM.  
Note:  This field, which represents the physical 

measurement point on the metering system, 
displays only if you select EXTENDED as a 
Correction Type.  
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Field  Description 
TEMP EXP 
CONSTANT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for temperature expansion.   
Note:  This button displays only if you select 

EXTENDED as a Correction Type.  
JT 
COEFFICIENT 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for density expansion.   
Note:  This button displays only if you select JT 

COEFFICIENT as a Correction Type.  
 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.2 Pipe Correction  
Pipe Correction settings define the calibrated diameter, temperature, 
and materials of manufacture for the pipe and orifice plate. Use these 
settings to correct the calibrated pipe and orifice diameters to line 
conditions.   
The pipe correction settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits.  

1. Select Pipe Correction from the hierarchy menu. The system 
displays the Pipe Correction screen.   

  

Figure 6-29. Pipe Correction screen  
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2. Complete the following fields.  
Field  Description 
Pipe 
Calib Diameter Sets, in mm, the calibrated diameter of the pipe. The 

default is 300.  
Calib 

Temperature 
Sets, in Deg C., the calibrated temperature of the pipe. 
The default is 20.  

Pipe Material  Identifies the material for the pipe. Click  to display all 
valid values.   

 STAINLESS Uses a value of either 0.00000925 
in/in°F or 0.0000167 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units. This is the default.  

 MONEL Uses a value of either 0.00000795 
in/in°F or 0.0000143 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.  

 CARBON ST Uses a value of either 0.00000620 
in/in°F or 0.0000112 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.  

 USER Uses the coefficient value entered in 
the User Exp Coeff field.   

 GOST 
8563.C1 
COEFFS 

Calculates the expansion coefficient 
f rom additional coefficients in GOST 
8.563.1 (Table C.1).  
Note: The GOST option displays 

only if you select GOST1 or 
GOST2 from PCSetup. 

 304/316 
Stainless 

Uses a value of either 0.000000925 
in/in°F or 0.0000167 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   

 304 Stainless Uses a value of either 0.000000961 
in/in°F or 0.0000173 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   

 316 Stainless Uses a value of either 0.000000889 
in/in°F or 0.0000160 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   

 Monel 400 Uses a value of either 0.000000772 
in/in°F or 0.0000139 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   

User Exp Coeff  Sets a specific expansion coefficient the S600+ uses 
for the pipe correction.  
Note: This field displays only if you select USER for 

Pipe Material.  
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Field  Description 
Coefficient  

a, b, c 
Sets the specific coefficients the S600+ uses for the 
orifice expansion correction.  
Note: These fields display only if you select GOST 

8563.C1 COEFFS for Pipe Material, which 
supplies its own algorithm and coefficients to 
calculate the pipe and orifice material 
expansion coefficients.  

Orifice 
Calib Diameter  Sets, in mm, the calibrated diameter of the orifice. The 

default is 200.  
Calib 

Temperature 
Sets, in Deg C., the calibrated temperature of the 
orifice. The default is 15.  

Orifice Material  Identifies the material for the orifice. Click  to display 
all valid values.   

 STAINLESS Uses a value of either 0.00000925 
in/in°F or 0.0000167 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units. This is the default.  

 MONEL Uses a value of either 0.00000795 
in/in°F or 0.0000143 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.  

 CARBON ST Uses a value of either 0.00000620 
in/in°F or 0.0000112 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.  

 USER Uses the coefficient value entered in 
the User Exp Coeff field.  

 GOST 
8563.C1 
COEFFS 

Calculates the expansion coefficient 
f rom additional coefficients in GOST 
8.563.1 (Table C.1).  
Note: The GOST option displays 

only if you select GOST1 or 
GOST2 from PCSetup.   

 304/316 
Stainless 

Uses a value of either 0.000000925 
in/in°F or 0.0000167 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   

 304 Stainless Uses a value of either 0.000000961 
in/in°F or 0.0000173 mm/m°C. This is 
the standard expansion coefficient for 
a US application using Imperial or 
metric units.   

 316 Stainless Uses a value of either 0.000000889 
in/in°F or 0.0000160 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   

 Monel 400 Uses a value of either 0.000000772 
in/in°F or 0.0000139 mm/mm°C. This 
is the standard expansion coefficient 
for a US application using Imperial or 
metric units.   
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Field  Description 
User Exp Coeff  Sets a specific expansion coefficient the S600+ uses 

for the orifice correction. The default is 1.6e-005.  
Note: This field displays only if you select USER for 

Pipe Material.  
Coefficient  

a, b, c 
Sets the specific coefficients the S600+ uses for the 
orifice expansion correction.  
Note: These fields display only if you select GOST 

8563.C1 COEFFS for Pipe Material, which 
supplies its own algorithm and coefficients to 
calculate the pipe and orifice material 
expansion coefficients.  

 
Note: GOST applications refer to stainless steel as 12X17, to 

monel as 12X18H9T, and to carbon steel as 20. The 
correction constants are taken from GOST 8.563.1.  

3. Click any of the following buttons to set calculation limits.   
Button  Description 
UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream temperature.   

CORRECTED 
PIPE DIAM 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the corrected pipe diameter.   

CORRECTED 
ORIF DIAM 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the corrected orifice diameter.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
5. Click Yes to apply your changes. The PCSetup screen displays.   

6.4.3 AGA8 (Compressibility) 
Compressibility settings define the constants and calculation limits for 
a range of parameters including pressure, temperature, density, and 
compressibility factors. This screen displays when you configure the 
S600+ to use the main AGA8 standard to calculate base 
compressibility, standard compressibility, and flowing compressibility 
for natural gases.    

Note: “Standard conditions” are assumed as 14.73 psia and 60° F.   

The compressibility settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits.  
1. Select AGA8 from the hierarchy menu. The AGA8 screen 

displays.   
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Figure 6-30. AGA8 (Compressibility) screen  

2. Complete the following fields.  
Field  Description 
Method Indicates the compressibility method. Click  to 

display all valid values.   
 DETAIL Uses 21 component values, temperature 

and pressure in accordance with the 1994 
standard. This is the default.  

 GROSS1 Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 1991 standard.  
Note:  Gross1 only supports volumetric 

heating value and does not support 
mass heating value.    

 GROSS2 Uses SG, N2, CO2, temperature and 
pressure in accordance with the 1991 
standard.  

 VNIC Uses 20 component values, temperature 
and pressure in accordance with GOST 
30319 1996. 

 MGERG Uses 19 component values (As indicated 
in GERG Technical Monograph 2 1998) to 
calculate compressibility of natural gas 
mixtures based on a full compositional 
analysis. 

 PT 1 
DETAIL 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 
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Field  Description 
 PT 1 

GROSS1 
2017 

Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 2017 standard. 
Note:  Gross1 only supports volumetric 

heating value and does not support 
mass heating value.    

 PT 1 
GROSS2 
2017 

Uses SG, N2, CO2, temperature and 
pressure in accordance with the 2017 
standard. 

 PT 1 
GROSS0 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 

 PT 2 
GERG 
2008 

Uses 21 component values [as indicated 
in Table 1 AGA8 2017 Part 2 (GERG 
2008)] to calculate compressibility of 
natural gas mixtures based on a full 
compositional analysis. 

Pressure  Sets the pressure at base conditions. The default is 0.  
Temperature  Sets the temperature at base conditions. The default is 

15.  
Limit Check Overrides the system’s calculation limit checking. 

Click  to select Off and disable limit checking. 
The default is On.  
Note:  Compressibilities and densities are less 

accurate and the calculation may fail 
completely when operating outside the 
calculation limits.   

UPSTREAM 
PRESS  

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for upstream pressure.   

UPSTREAM 
TEMP  

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for upstream temperature.   

REAL RD (SG) Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for real relative density.  

GROSS HV Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for gross heating value (HV).   

DENSITY 
PRESS (P2) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for density pressure (P2).   

DENSITY TEMP 
(T3) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for density temperature (T3).   

 
3. Click one or more of the following buttons to define AGA8 

calculation limits. 
Button  Description 
UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream density.  

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream compressibility (Zf).   
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Button  Description 
MOLAR MASS  Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for molar mass.  

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in the 
Status/Control Method field. 

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base density.  

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base compressibility.  

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in the 
Status/Control Method field. 

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal relative density.   

STD COMP(Zs) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for standard compressibility (Zs).  

DENSITY COMP 
(Zd) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the densitometer compressibility. 

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.4 ISO5167 (Mass Flowrate) 
ISO5167 mass settings define the constants and calculation limits for a 
range of parameters including pressure, density, flow coefficient, and 
pressure loss. This screen displays when you configure the S600+ to 
use the ISO5167 standard to calculate gas flow through the orifice 
meter.   

Mass flowrate settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within the 
specified limits.  

1. Select ISO5167 from the hierarchy menu. The ISO5167 screen 
displays.   
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Figure 6-31. ISO5167 (Mass Flowrate) screen  

2. Complete the following fields.  
Field  Description 
Calculation 
Version  

Indicates the specific version of the ISO5167 
calculation. Click  to display all valid versions. The 
default is 1991. 

Expansion 
Factor 

Displays options for calculating the fluid expansion 
factor. Click ▼ to display all valid versions. 
GAS 
ORIFICE 

Use the expansion factor formula as 
defined by calculation you select in the 
Calculation Version field. This is the 
default. 

LIQUID 
ORIFICE 

Use an Expansion Factor = 1.0 (no 
expansion). 

Limit Check Overrides the system’s calculation limit checking. 
Click  to select Off and disable limit checking. 
The default is On.  
Note:  If  you enable limit checking, ISO5167 

validates the calculation inputs and outputs in 
accordance with the following sections:  
 All tap types  
 Corner and D-D/2 taps 
 Flange taps 
 SA 1932 nozzles 
 Long radius nozzles  
 Venturi  
 Pressure taps  
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Field  Description 
Forward 
Premium Flow 
Limit 

In Premium Billing FLOW mode and Flow Direction 
FORWARD, sets a f lowrate limit above which the 
system increments forward premium totals 
whenever the f lowrate exceeds the keypad limit. 
In Premium Billing TOTAL mode and Flow Direction 
FORWARD, sets a total limit above which the system 
increments forward premium totals whenever the 
period total exceeds the keypad limit. The default is 
100 

Reverse 
Premium Flow 
Limit 

In Premium Billing FLOW mode and Flow Direction 
REVERSE, sets a flowrate limit above which the 
system increments reverse premium totals 
whenever the f lowrate exceeds the keypad limit. 
In Premium Billing TOTAL mode and Flow Direction 
REVERSE, sets a total limit above which the system 
increments reverse premium totals whenever the 
period total exceeds the keypad limit. The default is 
100. 

Premium 
Billing Mode  

Indicates the premium total mode, in which the system 
increments premium totals at the end of a period only if 
the period total exceeds the keypad limit. Click ▼ to 
display all valid values. The default is FLOW. 

Tap Type Click ▼ to indicate the position of the differential 
pressure tap on the metering assembly. Possible 
options are FLANGE, CORNER, D-D/2, NOZZ 1932, 
NOZZ LR, VENT TUBE, VENT NOZZ. The default is 
FLANGE. 

VISCOSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for viscosity.   

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent.   

RSMT Dish 
Calib Factor 

Sets the discharge coefficient calibration factor for the 
Rosemount 1595 conditioning orifice plate.  
Note: This field displays only if you select 

RSMT1595 2003 as the Calculation Version.  
UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure.   

UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream density.   

DOWNSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for downstream pressure.   

 
3. Click any of the following buttons to define ISO5167 calculation 

result limits.    
Button  Description 
MASS 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for mass 
f lowrate.   

PRESSURE 
LOSS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for pressure loss.   



Config600 Configuration Software User Manual 

6-62 Stream Configuration Revised January 2023 

Button  Description 
BETA Click to display a Calculation Result dialog box you 

use to define the specific alarm limits for the calculated 
diameter ratio.   

REYNOLDS 
NUMBER 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the Reynolds 
number.   

EXPANSION 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the expansion factor.   

DISCHARGE 
COEFF  

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the discharge 
coefficient.   

FLOW 
COEFFICIENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the flow coefficient.    

VEL OF 
APPROACH 
FAC 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the velocity of 
approach coefficient.   

4. For wet gas, complete the following values.  
Field Description 
Calc Type Click  to set the specific type of wet gas calculation 

the S600+ uses. Possible options are: 
MURDOCK Uses Lockhart-Martinelli parameter. 

This is the default. 
CHISHOLM Uses Lockhart-Martinelli parameter 

+Gas to Liquid Density Ratio. 
DE-LEEUW Uses Lockhart-Martinelli parameter 

+Gas to Liquid Density Ratio + Gas 
Froude Number (de Leeuw 
correlation). 

STEVEN Uses Lockhart-Martinelli parameter 
+Gas to Liquid Density Ratio + Gas 
Froude Number (Steven correlation). 

WET GAS 
INPUTS 

Click to display a dialog box you use to define specific 
input values for wet gases.   

REYNOLDS 
NUMBERS 

Click to display a dialog box you use to define the wet 
gas Reynolds numbers for up to 30 fields.   

DISCHARGE 
COEFFICIENTS 

Click to display a dialog box you use to define the wet 
gas coefficients for up to 30 fields.   

 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

6. Click Yes to apply your changes. The PCSetup screen displays.   

6.4.5 ISOTR9464  
ISOTR9464 settings provide a calculation of the Joule-Thomson 
coefficient used in upstream temperature correction. The settings 
define the upstream temperature and pressure input limits and the 
Joule-Thomson coefficient output limits. This screen displays when 
you configure the S600+ to use a DP method to calculate gas flow.  

1. Select ISOTR9464 from the hierarchy menu. The ISOTR9464 
screen displays.    
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Figure 6-32. ISOTR9464 screen  

2. Complete the following fields.  
Field  Description 
UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream temperature.   

UPSTREAM 
PRESS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure.   

Limit Check Enables limit checking. The default is enabled.  
With limit checking enabled, the system checks that 
the temperature is between 0 °C and 100 °C, that the 
pressure is between 100 and 200 bar, and that 
methane is > than 80%. If any of these parameters are 
out of range, the system sets the coefficient to zero, 
which prevents the calculation of upstream 
temperature correction.  

JT 
COEFFICIENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the Joule-Thomson coefficient.   

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.   
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6.4.6 V-Cone (Mass Flowrate) 
V-Cone® mass flowrate settings define the constants and calculation 
limits for a range of parameters including pressure, density, flow 
coefficient, and pressure loss. This screen displays when you configure 
the S600+ to use the V-Cone standard to calculate gas flow through the 
orifice meter.   

Mass flowrate settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within the 
specified limits.  

1. Select VCone from the hierarchy menu. The VCone screen 
displays.    

  

Figure 6-33. V-Cone (Mass Flowrate) screen  

2. Complete the following fields.  
Field  Description 
VISCOSITY Click to display a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for viscosity.   

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent.   

FLOW 
COEFFICIENT 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the flow coefficient.   

Gas Expansion Identifies the specific gas expansion calculation the 
S600+ uses. Click ▼ to display all valid values. 
VCONE 2.3 The S600+ uses the McCrometer 2.3 

V-Cone Flowmeter / ISO5167 Gas 
Expansion (Y) calculation.  

VCONE 3.0 
2001 

The S600+ uses the McCrometer 3.0 
2001 V-Cone Gas Expansion (Y) 
calculation. This is the default. 

WCONE 3.0 
2001 

The S600+ uses the McCrometer 3.0 
2001 Wafer Cone Gas Expansion (Y) 
calculation. 
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Field  Description 
LIQUID 
2001 

The S600+ uses a value of 1.0 for the 
Gas Expansion Factor. 
 

Thermal 
Expansion 

Identifies the specific type of thermal expansion 
calculation the S600+ uses. Click ▼ to display all valid 
values. 
S500 
LEGACY 

Sets the Thermal Expansion factor to 
1. 
Note: This option appears only if you 

select VCONE 2.3 in the Gas 
Expansion field. 

DIAMETERS The S600+ uses the calibrated 
diameters in the thermal expansion 
calculation. This is the default. 

BETA 
RATIO 

The S600+ uses the beta ratio in the 
thermal expansion calculation. 

MASS 
FLOWRATE 

Click to display a Calculation Result dialog box you use 
to define the specific alarm limits for the mass flowrate.   

PRESSURE 
LOSS 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the pressure loss.   

BETA Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the calculated diameter ratio.   

REYNOLDS 
NUMBER 

Click to display a Calculation Result dialog box you use 
to define the specific alarm limits for the Reynolds 
number.   

EXPANSION 
FACTOR 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the expansion factor.   

UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the upstream pressure.    

UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the upstream density.   

Forward 
Premium Flow 
Limit 

Sets the premium forward flow mode, in which the 
system increments premium totals whenever the 
f lowrate exceeds the keypad limit. The default is 100.  

Reverse 
Premium Flow 
Limit  

Sets the premium reversed flow mode, in which the 
system increments premium totals whenever the 
f lowrate exceeds the keypad limit. The default is 100. 

Premium 
Billing Mode  

Indicates the premium total mode, in which the system 
increments premium totals at the end of the hour only if 
the hourly total exceeds the keypad limit. Click  to 
display all valid values. The default is FLOW. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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6.4.7 Annubar (Mass Flowrate)  
Annubar mass flowrate settings define the constants and calculation 
limits for a range of parameters including pressure, density, flow 
coefficient, and pressure loss. This screen displays when you configure 
the S600+ to use the 1998 Dieterich Standard Annubar Diamond II+ to 
calculate gas flow through the orifice meter.  

Mass flowrate settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within the 
specified limits.  

1. Select Annubar from the hierarchy menu. The Annubar screen 
displays.   

 

Figure 6-34. Annubar (Mass Flowrate) screen  

2. Complete the following fields.  
Field  Description 
Annubar Base 
Temp  

Sets the Annubar calibration temperature. The default 
is 15.  

VISCOSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for viscosity.   

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent.   

FLOW 
COEFFICIENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the flow coefficient.   

Pipe Diameter Sets, in millimeters, the uncorrected internal pipe 
diameter. The default is 300.   

Probe Diameter Sets, in millimeters, the corrected internal probe 
diameter. The default is 200.  
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Field  Description 
Coefficient 
Linear Exp 

Sets the coefficient the S600+ uses for linear 
expansion. The default is 1.59e-005. 

UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream pressure.    

UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream temperature.   

UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream density.   

Calculation 
Version 

This read-only field shows the default calculation 
Config600 uses for the Annubar settings, based on the 
Annubar device in use.  

Forward 
Premium Flow 
Limit 

In Premium Billing FLOW mode and Flow Direction 
FORWARD. sets a f lowrate limit above which the 
system increments forward premium totals 
whenever the f lowrate exceeds the keypad limit. 
In Premium Billing TOTAL mode and Flow Direction 
FORWARD, sets a total limit above which the system 
increments forward premium totals whenever the 
period total exceeds the keypad limit. The default is 
100. 

Reverse 
Premium Flow 
Limit  

In Premium Billing FLOW mode and Flow Direction 
REVERSE, sets a flowrate limit above which the 
system increments reverse premium totals 
whenever the f lowrate exceeds the keypad limit. 
In Premium Billing TOTAL mode and Flow Direction 
REVERSE, sets a total limit above which the system 
increments reverse premium totals whenever the 
period total exceeds the keypad limit. The default is 
100. 

Premium 
Billing Mode  

Indicates the premium total mode, in which the system 
increments premium totals at the end of a period only if 
the period total exceeds the keypad limit. Click ▼ to 
display all valid values.The default is FLOW. 

MASS 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the mass 
f lowrate.   

PRESSURE 
LOSS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the pressure loss.   

THERMAL 
EXPN FCTR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the thermal expansion factor.   

GAS EXPN 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the gas expansion factor.   

REYNOLDS 
NUMBER 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the Reynolds 
number.   

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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6.4.8 Pure Gas Air 
Pure Gas Air mass flowrate settings define the constants and 
calculation limits for a range of parameters including pressure, density, 
flow coefficient, and pressure loss. This screen displays when you 
configure the S600+ to use the Pure Gas and Air standards to calculate 
gas flow through the orifice meter.  flowrate 

Mass flowrate settings also allow you to define alarms. The system 
actives these alarms when the calculated results are not within the 
specified limits.  

The calculations use ISO6976 tables for CV and Molar Mass.  

1. Select Pure Gas/Air from the hierarchy menu. The Pure Gas/Air 
screen displays.    

  

Figure 6-35. Pure Gas/Air screen  

2. Complete the following fields.  
Field/Button  Description 
Calculation 
Type 

Indicates the specific type of Pure Gas or Air 
calculation the S600+ uses. Click  to display all valid 
values. The default is PURE GAS (VIRIAL EQ). 
Pure Gas 
(Virial Eq) 

The S600+ uses a Third Order Virial 
Equation with derived constants to 
calculate the virial coefficients. 

Air (BIPM  
1981/91) 

The S600+ uses the BIPM Equation 
for the Determination of Density of 
Moist Air (1981/91) by R.S Davies. 

Reference 
Conditions  

Indicates the reference conditions the S600+ uses for 
the Pure Gas/Air calculation. Click  to display all valid 
values. The default is 15/15 DEG C. 

GAS 
COMPOSITION 

Click to display a dialog box you use to define the gas 
percentages of the mixture.   
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Field/Button  Description 
Relative 
Humidity 

Sets the relative humidity for air at base conditions. 
The default is 0. 

CO2 Content Sets the percentage of CO2 content at base 
conditions. The default is 0.04. 

Pressure Sets the pressure at base conditions. The default is 0. 
Temperature Sets the temperature at base conditions. The default is 

15. 
UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream pressure.   

UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream temperature.   

Base Viscosity Sets the base viscosity value the S600+ uses for 
viscosity calculations. The default is 0. 

Sutherland 
Constant 

Sets the Sutherland constant the S600+ uses for 
viscosity calculations. The default is 0. 

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base density   

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base compressibility (Zb).   

ISENTROPIC 
EXPONENT 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the Isentropic exponent.   

METER 
DENSITY 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the meter density.   

UPSTR 
COMP(Zf) 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the upstream compressibility (Zf).   

FLOWING 
VISCOSITY 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the flowing viscosity.   

REAL RD Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the real relative density.   

REAL CV Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the real calorific value (CV).   

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.4.9 Gas CV (ISO6976 or GPA2172/ASTM D3588) 
Calorific Value (CV) settings define the constants and calculation 
limits for ideal and real calorific values. This screen displays when you 
configure the S600+ to use either the ISO6976 or GPA2172/ASTM 
D3588 standard (defined in step 5, Options, of the PCSetup Editor’s 
Configuration Wizard) to calculate the calorific value (heating value) 
of the gas mixture.  
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Calorific value settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within the 
specified limits.  

1. Select Gas CV from the hierarchy menu. The Calorific Value 
screen displays.    

  

Figure 6-36. Gas CV (ISO6976 or GPA2172/ASTM D3588) screen  

2. Complete the following fields.  
Field  Description 
CV Table Identifies the specific compressibility value the program 

uses. Click  to display all valid values. The default is 
ISO6976/1995. 

 ISO6976/1995 
Vol 

Calculates CV based on volume, 
using the 1995 table. This is the 
default if  you choose CV ISO6976 
as your initial stream option. 
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/1995 
Mass 

Calculates CV based on mass, 
using the 1995 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/1983 
Vol 

Calculates CV based on volume, 
using the 1983 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 
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Field  Description 
Support for the 1983 table is 
limited to superior volumetric 
at 15/15. 

 ISO6976/2016 
Vol 

Calculates CV based on volume, 
using the 2016 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/2016 
Mass 

Calculates CV based on mass, 
using the 2016 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 GPA/2003 
AGA (14.73) 

Calculates CV based on a base 
press of 14.73 psia. This is the 
default if  you choose CV 
GPA2172-ASTMD3588 as your 
initial stream option. 
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2003 
ISO (14.696) 

Calculates CV based on a base 
press of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV GPA2172-
ASTMD3588. 

 GPA/2000 
AGA (14.73) 

Calculates CV based on a base 
press of 14.73 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV GPA2172-
ASTMD3588. 

 GPA/2000 
ISO (14.696) 

Calculates CV based on a base 
press of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV GPA2172-
ASTMD3588. 

 GPA/1996 
AGA (14.73) 

Calculates CV based on a base 
press of 14.73 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV GPA2172-
ASTMD3588. 

 GPA/1996 
ISO (14.696) 

Calculates CV based on a base 
press of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV GPA2172-
ASTMD3588. 

 GPA/2016 Pb 
(14.65) 

Calculates CV based on a base 
press of 14.65 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV GPA2172-
ASTMD3588. 
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Field  Description 
Reference 
Condition  

Indicates the t1/t2 value, where t1 is the calculation 
reference temperature for combustion and t2 is the 
reference condition for metering. The default is 15/15 
DEG C.  
Note:  
 For ISO6976 1983 VOL selection, the 60/60F 

and 15/15.55 Deg C selections are not 
supported.  

 For ISO6976 1995 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection is not supported. 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a 
combustion temperature (t1) of 15 Deg C 
and a metering temperature (t2) of 15 Deg 
C. 

 For ISO6976 2016 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection refers to a combustion temperature 
(t 1) of 15.55 Deg C (60 Deg F) and a metering 
temperature (t2) of 15.55 Deg C (60 Deg F). 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a 
combustion temperature (t1) of 15 Deg C 
and a metering temperature (t2) of 15 Deg 
C. 

Method If  you select CV ISO6976 in your initial 
conf iguration and you select the 1995 standard, 
you have the choice of Alternative or Definitive 
methods (using table 4 Mass / table 5 volume) for 
calculating the ideal, superior, and inferior CV 
values. This selection is not applicable to the 1983 
or 2016 standards. 
If  you select CV GPA2172-ASTMD3588 in your 
initial configuration, you have the choice of the 
Simple (using equation 7 f rom the GPA2172-
ASTMD3588-09 standard) or Rigorous (using 
equations 8 & 9 f rom the GPA2172-ASTMD3588-
09 standard) methods for calculating the standard 
compressibility. 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
User Temp T2 Applicable to the ISO6976 2016 VOL and ISO6976 

2016 MASS selections. Also applicable to the 
ISO6976 1995 VOL selection when the Definitive 
method is selected.  
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
User Press P2 Applicable to the ISO6976 2016 VOL and ISO6976 

1995 VOL selections when the Definitive method is 
selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
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Field  Description 
Table Revision This replaces the above AGA and ISO selections in 

the CV Table f ield for GPA 2172. You can select 
the GPA2145 table revision from one of the 
following:  
 1996 
 2000 
 2003 
 2009 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
BASE 
COMP(Zb) 

Click to supply an externally calculated base 
compressibility from another calculation. The system 
uses the entered value in GPA2172-ASTMD3588 
calculations instead of using its own internally 
calculated value based on the composition input. 

Composition 
Type 

Def ines the composition input type. Valid options 
are: 
 mass to energy using mole percent 
 mass to energy using mole fraction 
 volume to energy using mole percent 
 volume to energy using mole fraction 
Note: This option is valid only for AGA5 

configurations. 
 
3. Click any of the following buttons to define calculation limits for 

either the ISO6876 or GPA standard.   
Button  Description 
STD COMP(Zs) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for standard compressibility (Zs).   

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal relative density.   

IDEAL DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal density.   

IDEAL CV 
(SUP) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal calorific value.   
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the S600+ front panel. 

Gross HV Click to displays a Calculation Result dialog box 
you use to define the mode, keypad value, and the 
specific alarm limits for gross heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-ASTMD3588. 
REAL RD Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for real relative density.   

REAL DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real density.   
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Button  Description 
REAL CV (SUP) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the S600+ front panel. 

WOBBE INDEX Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The Wobbe Index is calculated using the Real 

Superior CV. 
REAL VOL 
IDEAL HV 

Displays a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the real volume ideal heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-ASTMD3588. 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 

6.4.10 SGERG (Compressibility) 
SGERG settings define the constants and calculation limits for ideal 
and real calorific values. This screen displays when you configure the 
S600+ to use the SGERG standard to calculate the compressibility of 
the gas mixture.  

SGERG settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits.  

1. Select SGERG from the hierarchy menu. The SGERG screen 
displays.    
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Figure 6-37. SGERG (Compressibility) screen 

2. Complete the following fields.  
Field  Description 
Type Indicates the specific type of SGERG calculation the 

S600+ uses. Click  to display all valid values.  
 SGERG 

CV/RD/CO2 
Calculate SGERG from calorific 
value, relative density, and CO2. 
This is the default.  

 SGERG 
CV/RD/CO2/H2 

Calculate SGERG from calorific 
value, relative density, CO2, and 
hydrogen.  

 ISO 
CV/RD/CO2 

Calculate ISO 12213-3 from calorific 
value, relative density, and CO2. 

   
 ISO 

CV/RD/CO2/H2 
Calculate ISO 12213-3 from calorific 
value, relative density, CO2, and 
hydrogen.  

 SGERG 
CV/CO2/N2 

Calculate SGERG from calorific 
value, CO2, and nitrogen.  

 SGERG 
CV/CO2/N2/H2 

Calculate SGERG from calorific 
value, CO2, nitrogen, and hydrogen.  

 GOST 
BD/CO2/N2 

Calculate GOST from base density, 
CO2, and nitrogen.  

 SGERG 
CV/RD/N2 

Calculate SGERG from calorific 
value, relative density, and nitrogen.  

 SGERG 
CV/RD/N2/H2 

Calculate SGERG from calorific 
value, relative density, nitrogen, and 
hydrogen.  

 SGERG 
RD/CO2/N2 

Calculate SGERG from relative 
density, CO2, and nitrogen.  
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Field  Description 
 SGERG 

RD/CO2/N2/H2 
Calculate SGERG from relative 
density, CO2, nitrogen, and 
hydrogen.  

Pressure  Sets the pressure the S600+ uses to calculate 
compressibility at base conditions. The default is 0.   

Temperature  Sets the temperature the S600+ uses to calculate 
compressibility at base conditions. The default is 15. 

Inputs Limit 
Check 

Performs limit checking on the inputs. The default is 
checked (limit checking occurs).  

 
3. Click any of the following buttons to define SGERG miscellaneous 

values and calculation limits.   
Button  Description 
RELATIVE 
DENSITY (SG) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the relative density.   
Note: Relative density is assumed to be at reference 

0°C.  
SUPERIOR CV 
(25/0)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the calculated calorific value.  
Note:  Calorific value is assumed to be 25/0.  

METER PRES Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream meter pressure.   

METER TEMP Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream meter temperature.    

DENSITY 
PRESS (P2) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the density pressure (P2).    

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base compressibility (Zb).   

STD COMP(Zs) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the standard compressibility (Zs).   

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the calculated base density.   

UPSTR 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream density.   

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream compressibility factor.   

DENSITY 
COMP(Zd) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the densitometer compressibility.   

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
5. Click Yes to apply your changes. The PCSetup screen displays.  
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6.4.11 NX19 (Compressibility) 
NX19 settings define the constants and calculation limits for a range of 
parameters including pressure, temperature, density, and 
compressibility factors. This screen displays when you configure the 
S600+ to use the NX19 standard to calculate base compressibility and 
density, standard compressibility, flowing compressibility and density, 
and compressibility at density conditions.   

NX19 settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits.  

1. Select NX19 from the hierarchy menu.  

 

Figure 6-38. NX19 (Compressibility) screen  

2. Complete the following fields.  
Field  Description 
UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream pressure.   

Pseudo Critical  Sets the pseudo-critical limits for pressure. The default 
is 673.   

UPSTREAM 
TEMPERATURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream temperature.   
Note: This button displays only if you select the 

NX19 UPSTR component.  
Pseudo Critical  Sets the pseudo-critical limits for temperature. The 

default is 344.  
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Field  Description 
Calculation 
Type 

Indicates the calculation type the S600+ uses for the 
specific gravity/relative density calculation. Click  to 
display all valid values.  

 1962 Use AGA manual, December 1962 
to determine supercompressibility 
factor for natural gas. Assumes 
reference conditions at 60° F. 

 MODIFIED Use NX-19 (Mod). Assumes 
reference condition at 0° C. This is 
the default.  

 VDI/VDE 2040 Use VDI/VDE 2040. Assumes 
reference condition at 0° C. 

SG/RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the specific gravity/relative density.   

DENSITY 
PRESS (P2) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the density pressure (P2).   

DENSITY TEMP 
(T3) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the density temperature (T3).   

UPSTR COMP 
(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream compressibility factor. 

DENSITY COMP 
(Zd) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the densitometer compressibility. 

UPSTREAM 
DENSITY  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream density.  

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream compressibility.   

STD COMP(Zs) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for standard compressibility.   
Note: This button displays only if you select the 

NX19 STND component. 
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.12 PTZ (Compressibility) 
PTZ settings take the pressure, temperature, and calculated values from 
the NX19 compressibility calculations to calculate an upstream 
density. This screen displays when you configure the S600+ to use the 
PTZ calculation and is supported only by older configurations.    
PTZ settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits.  

1. Select PTZ from the hierarchy menu. The PTZ screen displays.   
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Figure 6-39. PTZ (Compressibility) screen  

2. Complete the following fields.  
Field  Description 
Pressure Sets pressure at base conditions. The default is 0.   
Temperature Sets temperature at base conditions. The default is 15. 
STD COMP(Zs) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the standard compressibility (Zs).   

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base density.   

UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream pressure.   

UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream temperature.   

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream compressibility (Zf).   

UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the upstream density.    

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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6.4.13 AGA3 (Volume or Mass Flowrate) 
AGA3 settings define the constants and calculation limits for a range 
of parameters including pressure, temperature, density, and 
compressibility factors. This screen displays when you configure the 
S600+ to use the AGA3 standard to calculate gas flow through the 
orifice meter.    

AGA3 settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits.  

You select the AGA3 Volume or AGA3 Mass calculations during the 
PCSetup Editor’s Configuration Wizard because the choice affect the 
totalisation configuration.  

1. Select AGA3 from the hierarchy menu. The AGA3 screen 
displays. 

 

Figure 6-40. AGA3 (Volume Flowrate) screen  

2. Complete the following Inputs fields.  
Field  Description 
Calc Type This read-only field shows the basis (volume or mass) 

for the AGA3 calculation.   
DP Cell Type Indicates the position of the differential pressure taps 

on the metering assembly. Click  to display all valid 
values. The default is FLANGE. 

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent.    

VISCOSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for viscosity.   

UPSTR PRESS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure.   

UPSTR 
DENSITY  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream density.   
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Field  Description 
RSMT Dish 
Calib Factor 

Indicates the discharge coefficient calibration factor for 
the Rosemount 1595 conditioning orifice plate.    
Note: This field displays only if you select the AGA3 

RSMT 1595 Calculation Version.  
UPSTR TEMP  Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for upstream temperature.   

RELATIVE 
DENSITY (SG)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the relative density.   

 
3. Enter the base pressure under standard conditions.  

4. Enter the base temperature under standard conditions.   

5. Click any of the following buttons to define AGA3 calculation 
limits.   
Button  Description 
CVOL 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the corrected 
volume flowrate.   

EXP FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the expansion factor.   

VEL OF APP 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the velocity of 
approach factor.  
Note: This is a mathematical expression that 

relates the velocity of flowing fluid in the 
orifice meter house to the velocity in the 
orifice plate bore.   

UVOL 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the 
uncorrected volume flowrate.   

BETA Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the calculated 
diameter ratio.   

DISCHARGE 
COEFF 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the calculated 
orifice plate coefficient of discharge.  

FLOW 
EXTENSION 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the flow extension.    

 
6. Select a calculation option.  

Field  Description 
Calculation 
Version 

Sets the version of calculation. Click ▼ to display all 
valid values. The default is AGA3-1992.   

Expansion 
Factor 

Displays options for calculating the fluid expansion 
factor. Click ▼ to display all valid versions. 
GAS 
ORIFICE 

Use the expansion factor formula as 
defined by calculation you select in the 
Calculation Version field. This is the 
default. 

LIQUID 
ORIFICE 

Use an Expansion Factor = 1.0 (no 
expansion). 
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Field  Description 
Limit Check Enables limit checking associated with the pipe 

diameter values, orifice diameter values, and the beta 
ratio. The default is On; select this field to disable limit 
checking.  

7. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

8. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.14 Stream Gas Composition  
Stream Gas Composition settings define the processing and port 
telemetry parameters for streams receiving data from the gas 
chromatograph controller. The chromatograph controller measures the 
individual component concentrations found in the line gas. The 
chromatograph controller settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the 
chromatograph data are not within specified limits.  

1. Select Gas Composition from the hierarchy menu. The Gas 
Composition screen displays.   

  
Figure 6-41. Gas Composition screen   

2. Complete the following fields.  
Field  Description 
Type Indicates the chromatograph configuration. Click  to 

display all valid values.  
 CHROMAT A Controller-connected; uses keypad 

data as fallback information.  
 KP ONLY Not controller-connected; uses 

information entered via keypad. This 
is the default.  
Note: If  you select KP ONLY, the 

system hides a number of 
f ields on this screen. 
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Field  Description 
Initial Mode Indicates the operational mode for the in-use 

composition data. Click  to display all valid values.  
 KEYPAD Use data entered via keypad. This 

is the default.  
 CHROMAT Use live data from the 

chromatograph controller.  
 DOWNLOAD Download gas composition data 

directly to each stream. Used only if 
connected to a remote supervisory 
computer.  

 USER Use customised program for gas 
composition in S600+.  

 KEYPAD_F Start by using keypad-entered data 
then switch to chromatograph data 
when a good analysis is received. 

Acceptance 
Type 

Indicates how the S600+ manages in-use data. Click 
 to display all valid values.   

 ACC/COPY Copy and normalise keypad data to 
in-use data only after it is accepted. 
This is the default.  

 ACC/NORM Copy normalised keypad data to in-
use data after it is accepted.  

 AUTO/NORM Automatically copy normalised 
keypad data to in-use data.  

Station 
Number 

Sets the station associated with this stream. The 
default is 1. 

Apply Splits Indicates the type of analyser connected to the S600+. 
For a C6+ analyser, use the C6Plus option. Click  to 
display all valid values. The default is NO SPLITS.  
If  you select any value other than NO SPLITS, the 
system displays the MOLE SPLITS button. Use it to 
define the specific percentage splits for the gases.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

MOLE SPLITS Click to display a Gas Composition dialog box you use 
to indicate the mole splits for hexane, heptane, octane, 
nonane, and decane.  
Note: This button displays only if you select any 

value other than NO SPLITS in the Apply 
Splits field.  

Revert to Last 
Good after 
Failure  

Continues using the last good composition in the event 
of  failure. Otherwise the system reverts to keypad 
data.  

Check Critical 
Alarms  

Marks the received composition as failed if any critical 
alarm is set (such as the pre-amp fail on the Danalyzer 
for a Daniel 2551 Controller).  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Check Non 
Critical Alarms  

Marks the received composition as failed if any non-
critical alarm is set (such as the pre-amp fail on the 
Danalyzer for a Daniel 2551 Controller).  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  
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Field  Description 
CHROMAT 
COMMS 

Click to display the Comm screen in I/O Setup (see 
Chapter 4, Section 4.10).   

Initial Mode Identifies the chromatograph and any fallback 
controllers. Currently, the only valid value is PAY, 
which indicates one chromatograph and no fallback 
controller.   
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Type Indicates the type of chromatograph controller. Click  
to display all valid values.   
Note: This field displays only if you select CHROMAT 

A as the chromatograph configuration type. 
 2551 EURO S600+ is connected to a Daniel 

2551 (European) controller. This is 
the default.  

 2350 EURO S600+ is connected to a Daniel 
2350 (European) controller set in 
SIM_2251 mode.  

 2350 USA S600+ is connected to a Daniel 
2350 (USA) controller set in 
SIM_2251 mode.  

 2251 USA S600+ is connected to a Daniel 
2251 controller.  

 Generic S600+ is connected to another type 
of  controller.  

 Siemens S600+ is connected to a Siemens 
Advance Maxum via a Siemens 
Network Access Unit (NAU). 

MOLE ORDER Click this button to display a dialog box on which you 
indicate the order in which the gas composition 
information comes into the S600+ via telemetry. 0 
indicates any component which is not included in the 
Modbus map.  
Note: 
 The Modbus map you create must be compatible 

with the controller to which the S600+ is 
connected. Refer to Chapter 14, Modbus Editor, 
for further information.  

 This field displays only if you select CHROMAT A 
as the chromatograph configuration type. 

 This field is applicable only if you select Siemens 
or Generic in the Type field. 

Address  Configures multi-drop chromatograph support. Do not 
change unless advised to do so.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Stream  Sets the chromat analysis stream assigned to this 
metering stream. The default is 0.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. If you need to support 
more than one stream, contact Technical 
Support.  
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Field  Description 
Analysis 
Timeout  

Sets the maximum number of seconds the S600+ 
waits to receive a new composition from the 
chromatograph controller before raising an alarm. The 
default is 900. 
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Download 
Timeout  

Sets the maximum number of minutes the S600+ waits 
to receive a new composition from the supervisory 
computer before raising a DL Timeout Alarm. The 
default is 15.  
Note:  
 A value of 0 disables the timeout. 
 This field displays only if you select KP ONLY in 

the Common Type field. 
KEYPAD 
MOLES 

Click to display a dialog box you use to define mole 
percentage values for each gas component.  
Note:  The system assumes the keypad composition 

adds to 100% (normalised) when the 
Acceptance Type is ACC/COPY. If you select 
ACC/NORM or AUTO/NORM, the system 
automatically normalises the keypad 
composition.   

MOLE 
ADDITIONAL 

Click to display a dialog box you use to define mole 
percentage values for gas components not analysed 
by the Danalyzer. The system assumes any additional 
components to be normalised values, and the analyser 
components are re-normalized (100 – sum of 
additional components). 
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

USER MOLES Click to display a dialog box you use to define mole 
percentage values for each gas component. The 
system assumes user moles to be normalised.  
Note:  The S600+ uses these values only if you set 

the Initial Mode to USER. A Modbus 
download from another computer may 
overwrite these values on a running 
configuration.  

Check Limits Enables limit checking on each gas component. When 
you select this check box, the MOLE LO LIMITS and 
MOLE HI LIMITS buttons display.  
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Field  Description 
MOLE LO 
LIMITS 

Click to display a dialog box you use to define low 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:   
 The system uses the values you enter through 

these buttons only if you select the Check Limits 
check box. The system applies this test to the 
keypad, downloaded, user, additionals, and new 
analysis components. When enabled, the system 
applies the limit check against the high and low 
limits. Limits are considered valid if the limit is 
greater than zero (0). The system also applies the 
check to the Total field. If you disable the limit 
check, the keypad, downloaded and user Total 
f ield must lie within 0.1% and 150%. A sum of the 
new analysis must be within 99.5% and 100.5%.  

 This field displays only if you place a check mark 
in the Check Limits field. 

MOLE HI 
LIMITS 

Click to display a dialog box you use to define high 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:  See note in description of Mole Lo Limits field.  

Check 
Deviations 

Enables checking on the deviation from the last good 
analysis for each component. When you select this 
check box, the MOLE DEVN LIMITS button displays.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

MOLE DEVN 
LIMITS 

Click to display a dialog box you use to define the 
maximum deviation allowed for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note: This field displays only if you place a check 

mark in the Check Deviations field. 
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.15 Z Steam (Compressibility)  
This screen displays when you configure the S600+ to use the Steam 
standards to calculate flowing density and flowing enthalpy for steam.  

The compressibility settings also allow you to define alarms. The 
system activates these alarms when the device calculates results that 
are not within the limits you configure. 

Note:  The S600+ only supports-mass based CV units 

1. Select Steam from the hierarchy menu. The Z Steam screen 
displays.    
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Figure 6-42. Z Steam (Compressibility) screen   

2. Complete the following fields.  
Field  Description 
Type Indicates the compressibility method. Click  to 

display all valid values. Available calculation methods 
are IFC 1967 and IAPWS-IF97.  

Phase Option Indicates the phase calculation method. Click ▼ to 
display all valid values.  
Note: This option is available only if you select 

IAPWS-IF97 in the Type field. 
AUTO The S600+ automatically selects the 

region to use based on the 
temperature and pressure inputs. This 
is the default.  

STEAM The S600+ uses Region 2 for 
calculations and raises an alarm if this 
is not possible 

WATER The S600+ uses Region 1 for 
calculations and raises an alarm if this 
is not possible  

UPSTREAM 
PRESS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure.   

UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream temperature.   
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Field  Description 
METER 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the meter density.   

ENTHALPY(H) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for enthalpy(H).    

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.4.16 GOST CV 
Calorific Value settings define the composition type, table to be used, 
and calculation limits for a range of parameters including density, 
relative density, and calorific value. This screen displays when you 
configure the S600+ to use the GOST 30319.1-96 Section 7 standards 
to calculate the calorific value (heating value) of the gas mixture.  

The GOST CV settings also allow you to define alarms. The system 
activates these alarms when the calculated results for the 
chromatograph data are not within specified limits. 
1. Select Gost CV from the hierarchy menu. The GOST CV screen 

displays.   

  

Figure 6-43. GOST CV screen  

2. Click any of the following buttons to define GOST CV settings.   
Button  Description 
INUSE COMP Click to display a dialog box you use to define the 

specific percentages for all components of the gas 
mixture.   
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Button  Description 
BASE DENSITY 
(RHOc) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the base density.   

COMBUSION 
HEAT (Hcb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for superior CV.  
Note: This is the Superior Calorific value.   

COMBUSION 
HEAT (Hch) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for inferior CV.    
Note: This is the Inferior Calorific value.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.17 GOST Flow 
GOST flow settings define the constants and calculation limits for a 
range of parameters including pressure, density, flow coefficient, and 
pressure loss. This screen displays when you configure the S600+ to 
use the GOST 8563 standard to calculate gas flow through the orifice 
meter.  

The GOST Flow settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within 
specified limits. 
1. Select Gost Flow from the hierarchy menu. The GOST Flow 

screen displays.   
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Figure 6-44. GOST Flow screen  

2. Complete the following fields.  
Field  Description 
Calculation 
Version 

Indicates the version of the GOST calculation the 
S600+ uses. Click ▼ to display all valid values.  
GOST8586 
05 

The S600+ uses GOST 8.586-05 for 
the flow rate calculation. This is the 
default.  

GOST8563 
97 

The S600+ uses GOST 8.563.2-97 for 
the flow rate calculation 

GOST8586 
RSMT1595 

The S600+ uses GOST 8.586-05 for 
the flow rate calculation with the 
specific discharge coefficient equations 
for the Rosemount 1595 Conditioning 
Orif ice Plate 

Expansion 
Factor 

Displays options for calculating the fluid expansion 
factor. Click ▼ to display all valid versions. 
GAS 
ORIFICE 

Use the expansion factor formula as 
defined by calculation you select in the 
Calculation Version field. This is the 
default. 

LIQUID 
ORIFICE 

Use an Expansion Factor = 1.0 (no 
expansion). 

Limit Check Activates calculation limit checking. Click  to display 
all valid values. The default is ON. 
Note:  If  you activate limit checking, GOST validates 

the calculation inputs and outputs in 
accordance with section GOST 8.563.1 – 97.   
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Field  Description 
Tap Type Click ▼ to indicate the position of the differential 

pressure tap on the metering assembly. Possible 
options are FLANGE, CORNER, D-D/2, NOZZ 1932, 
NOZZ LR, VENT TUBE, VENT NOZZ. The default is 
FLANGE. 

VISCOSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for viscosity.   

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the Isentropic exponent.   

RSMT Dish 
Calib Factor  

Indicates the discharge coefficient calibration factor 
added for the Rosemount 1595 conditioning orifice 
plate.  
Note: This field displays only if you select 

RSMT1595-2003 as the Calculation Version.  
Inlet Edge 
Radius 

Sets the radius of the inlet edge. The default is 0.05. 
Note:  The program uses this value as part of the 

orifice dulling correction calculation.   
Int Pipe 
Roughness 

Sets the pipe roughness factor. The default is 0.01. 
Note:  The program uses this value as part of the 

roughness coefficient factor.   
Inspection 
Period 

Sets, in whole non-fractional years, the inspection 
period (or calibration span) for the inlet edge radius 
used in the calculation of the orifice dulling correction 
coefficient. The default is 1. 
Note:  You must enter a whole number. Fractions 

are not allowed.  
UPSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure.   

UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream density.   

DOWNSTREAM 
PRESSURE 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for downstream pressure.    

 
3. Click any of the following buttons to define GOST flow calculation 

results limits.   
Button  Description 
MASS 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the mass 
f lowrate.   

PRESSURE 
LOSS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for pressure loss.   

BETA Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the calculated 
diameter ratio.   

REYNOLDS 
NUMBER 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the Reynolds 
number.   

EXPANSION 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the expansion factor.   
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Button  Description 
DISCHARGE 
COEFF 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the discharge 
coefficient.   

FLOW 
COEFFICIENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the flow coefficient.   

VEL OF 
APPROACH 
FAC 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the velocity of 
approach factor.   

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
5. Click Yes to apply your changes. The PCSetup screen displays.  

6.4.18 Gas Properties 
Gas properties settings define methods the system uses to calculate 
viscosity, isentropic exponent (also known as “specific heat ratio” or 
“adiobatic exponent”), and the velocity of sound.   

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits. 

1. Select Gas Properties from the hierarchy menu. The Gas 
Properties screen displays.   

  

Figure 6-45. Gas Properties screen  
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2. Complete the following fields.  
Field  Description 
Viscosity @ Tn Sets the reference viscosity for the gas. The default is 

0.010861. 
Note: Used only by VDI/VDE.  

Viscosity Tn Sets the reference viscosity temperature for the gas. 
The default is 15.  
Note Used only by VDI/VDE.  

Sutherland 
Constant 

Sets the Sutherland constant for the gas. The default 
is 164. 
Note Used only by VDI/VDE. 

Viscosity Calc 
Type  

Indicates the method for calculating the viscosity of the 
gas. Click  to display all valid values.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default. 

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires base 
density, N2, and CO2 inputs.  

 VDI/VDE 2040 
1987 

Uses calculations from VDI/VDE 
2040 Part 2 1987. Requires 
viscosity @Tn, viscosity Tn, and 
Sutherland Constant inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   

Isentropic 
Exponent 

Indicates the method for calculating the isentropic 
exponent of the gas. Click  to display all valid values.   

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.  

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   
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Field  Description 
Speed of Sound Indicates the method for calculating the speed of 

sound. Click  to display all valid values.  
 AGA10 2003 Uses calculations from AGA10 

2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.   

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.   

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.  

 
3. Click any of the following buttons to set gas property outputs or 

variables.   
Button  Description 
VISCOSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for viscosity. 

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound (VOS). 

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent. 

UPSTREAM 
PRESS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure. 
Note:  This button may be disabled on some 

applications.  
BASE DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for base density. 

UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream temperature.  
Note: This button may be disabled on some 

applications.  
INUSE 
COMPOSITION 

Click to display a read-only table of gas compositions. 
This corresponds to the table defined using the Gas 
Composition screen’s KEYPAD MOLES button.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  
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6.4.19 DP Cell Input Conditioning  
Differential pressure (or DP) Cell Input Conditioning settings define 
how the S600+ sequences (or “stacks”) input cell information and sets 
calculation limits for differential pressure measurements.    

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits.   

Cell Input 
Stacking 

The Stack Type you select on the DP Cell Input Conditioning screen 
(see Figure 6-68) defines how the S600+ sequences (or “stacks”) 
differential pressure values. DP stack handling enables you to mark 
each input cell as available under either of the following conditions: 
 Not available when the value is under-range, over-range, in 

Keypad mode, or in a Failed mode (for example, Keypad-F). 

 Available when the value is within the low and high fail limits of 
the analog input or in Measured mode.  

The S600+ determines the value to use based on the stack types you 
select, which include:  

 Single  
 Lo-Hi  
 Hi Hi  
 Lo Mid Hi  
 Lo Hi Hi  
 3 Identical  

The switch up / switch down percentages are always calculated based 
on the cell scaling - irrespective of any analogue conversion selection 
that has been configured. 

Additionally, enhanced error checking (an option you also select on the 
DP Cell Input Conditioning screen) provides another stacking criteria.  

Note: If you select Imperial units, enhanced error checking is 
disabled by default. If you select metric units, enhanced error 
checking is enabled by default.   

The stack type, along with enhanced error checking, result in the 
following.   

Single Select Single  when you connect to only a single input cell. This is the 
default input stack value. 
 If you enable enhanced error checking and the input cell is 

available, the S600+ uses its value. If the cell is unavailable, the 
S600+ uses the value you define in the DP Keypad field.   

 If you disable enhanced error checking, the S600+ uses the single 
cell’s In-Use value, regardless of operating mode, low or high fail 
limits, or whether the input cell is available.   
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Lo-Hi Select Lo Hi  when you connect two cells in a tier. 
 If you enable enhanced error checking, the S600+ first checks both 

cells to ensure they are either within the low and high fail limits of 
the analog input or in Measured mode. It then proceeds to perform 
cell selection.   

The cell selector compares the DP values returned from both cells 
and changes range when one of the following occurs: 

o When using the Lo Cell, the DP value returned from the Lo 
Cell is greater than the switch up percentage of the Lo Cell 
range. 

o When using the Hi Cell, the DP value returned from the Hi Cell 
is less than the switch down percentage of the Lo Cell range. 

To avoid too much switching between ranges, define switch-up and 
switch-down percentage values using the Up and Down fields in 
the DP Cell Input Condition screen’s Switching Points pane. The 
S600+ uses the difference between the switch-up and switch-down 
percentage as hysteresis. The normal value used is 5% hysteresis. 

For example, the Lo Cell = 0–250 mbar and the Hi Cell = 0–500 
mbar. If you define a Up value of 95 and a Down value of 90, then 
the difference is 5%. 

If the low range is in use and the differential pressure is rising, the 
S600+ continues to use this range until it reaches point A (237.5 
mbar). At that point, the S600+ switches to the high range, point B 
(see Figure 6-46).  
If the high range is in use and the differential pressure is falling, the 
S600+ continues to use this range until it reaches point C (225.0 
mbar). At that point, the S600+ switches to the low range, point D 
(see Figure 6-46).  

Figure 6-47 provides a flowchart of Lo Hi input cell handling.  
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Figure 6-46. Lo Hi Cell Input Handling  
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Figure 6-47. Lo Hi Cell Input Handling Flowchart  

 If you disable enhanced error checking, the S600+ automatically 
uses the value of the In-Use cell (the one currently selected by the 
switch-up or switch-down criterion). The switch-up and switch-
down points are based on the lower of the two available cells. The 
cells are always available for selection, regardless of their 
operating mode. 

For example, if cell 1 is above its switch-up point, the stack 
switches up to cell 2, regardless of cell 2’s value. 

Hi-Hi Select Hi Hi  when you connect two cells, both of which are ranged to 
the same values and working in Duty-Standby mode. S600+ 
designates the cell currently being used as the “In Use” cell.  
 If you enable enhanced error checking, the S600+ first checks both 

cells to ensure they are within the low and high fail limits of the 
analog input or in Measured mode and that there are no 
discrepancies between the Hi(1) and Hi(2) cells.   

o If the Hi(1) range is in use, the S600+ continues to use the 
Hi(1) range unless it becomes unavailable. At that point, the 
S600+ switches to the Hi(2) cell.  

o If the Hi(2) range is in use, the S600+ continue to use the Hi(2) 
range unless it becomes unavailable. At that point, the 
S600+switches to the Hi(1) cell. 

o If neither cell is available, the S600+ uses the defined DP Stack 
Keypad value and raises an alarm.    
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 If you disable enhanced error checking, the S600+ uses the 
selected cell’s In-Use value, regardless of operating mode or low or 
high fail limits.   

Figure 6-48 shows Hi Hi cell handling.  
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Figure 6-48. Hi Hi Cell Input Handling Flowchart  

Lo-Mid-Hi Cell Select Lo Mid Hi  when you connect three cells in a tier. 
 If you enable enhanced error checking, the S600+ designates the 

cell currently being used as the “In Use” cell. The S600+ also 
checks for sustained discrepancies between:  

o Lo Cell and Mid Cell 

o Lo Cell and Hi Cell 
o Mid Cell and Hi Cell. 

The cell selector compares the DP values returned from all three 
cells and changes range when one of the following occurs: 

 When using the Lo Cell, the DP value returned from the Lo 
Cell is greater than the switch up percentage of the Lo Cell 
range. 

 When using the Mid Cell, the DP value returned from the Mid 
Cell is greater than the switch up percentage of the Mid Cell 
range. 
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 When using the Mid Cell, the DP value returned from the Mid 
Cell is less than the switch down percentage of the Lo Cell 
range. 

 When using the Hi Cell, the DP value returned from the Hi Cell 
is less than the switch down percentage of the Mid Cell range. 

To avoid too much switching between ranges, define switch up and 
switch down percentage values using the Up and Down fields in 
the DP Cell Input Condition screen’s Switching Points pane. The 
S600+ uses the difference between the switch up and switch down 
percentage as hysteresis. The normal value used is 5% hysteresis. 
For example, the Lo Cell = 0–250 mbar and the Hi Cell = 0–500 
mbar. If you define an Up value of 95 and a Down value of 90, 
then the difference is 5%. 

See Figure 6-49 for a graphical presentation of the following usage 
situation.  

If the low range is in use and the differential pressure is rising, the 
S600+ continues to use this range until it reaches point A (237.5 
mbar). At that point, the S600+ switches to the mid range, point B.  

If the mid range is in use and the differential pressure is still 
rising, the S600+ continues to use this range until it reaches point 
E (475.0 mbar). At that point, the S600+ switches to the high 
range, point F. 
If the high range is in use and the differential pressure is falling, 
the S600+ continues to use this range until it reaches point H 
(450.0 mbar). At that point, the S600+ switches to the mid range, 
point G. 

If the mid range is in use and the differential pressure is still 
falling, the S600+ continues to use this range until it reaches point 
C (225.0 mbar). At that point, the S600+ switches to the low range, 
point D. 
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Figure 6-49. Lo Mid Hi Cell Input Handling  



Config600 Configuration Software User Manual 

6-100 Stream Configuration Revised January 2023 

Figure 6-50 through Figure 6-53 provide flowcharts showing how the 
S600+ handles this.  
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Figure 6-50. Lo Mid Hi Cell Input Handling Flowchart (1)  
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Figure 6-51. Lo Mid Hi Cell Input Handling Flowchart (2)  
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Figure 6-52. Lo Mid Hi Cell Input Handling Flowchart (3)  
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Figure 6-53. Lo Mid Hi Cell Input Handling Flowchart (4)  

 If you disable enhanced error checking, the S600+ automatically 
uses the value of the In-Use cell (the one currently selected by the 
switch-up or switch-down criterion). The switch-up and switch-
down points are based on the lowest of the three available cells. 
The cells are always available for selection, regardless of their 
operating mode.  

For example, if cell 2 is above its switch-up point, the stack 
switches up to cell 3, regardless of the value of cell 3.  

Lo-Hi-Hi Select Lo Hi Hi  when you connect three cells, two of which are 
ranged to the same value and work in a tier, but the Hi cells are 
working in Duty-Standby mode. S600+ designates the cell currently 
being used as the “In Use” cell. The S600+ also checks for sustained 
discrepancies between the Lo cell and the Hi(1) cell, the Lo cell and 
the Hi(2) cell, and the Hi(1) cell and the Hi(2) cell. 
 If you enable enhanced error checking, the cells must be within the 

low and high fail limits of the analog input or in Measured mode. 

 If you disable enhanced error checking, the S600+ automatically 
uses the value of the In-Use cell (the cell currently selected by the 
switch-up or switch-down criterion). The switch-up and switch-
down points are based on the lowest of the three available cells. 
The cells are always available for selection, regardless of the low 
and high fail limits and their operating mode.  

The cell selector compares the DP values returned from all three 
cells and changes range when one of the following occurs: 

o When using the Lo Cell, the DP value returned from the Lo 
Cell is greater than the switch-up percentage of the Lo Cell 
range. 
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o When using the Hi(1) Cell, the DP value returned from the 
Hi(1) Cell is less than the switch-down percentage of the Lo 
Cell range. 

o When using the Hi(2) Cell, the DP value returned from the 
Hi(2) Cell is less than the switch-down percentage of the Lo 
Cell range. 

o When using the Lo Cell, the cell becomes unavailable. 

o When using the Hi(1) Cell, the cell becomes unavailable. 
o When using the Hi(2) Cell, the cell becomes unavailable. 

To avoid too much switching between ranges, define switch-up and 
switch-down percentage values using the Up and Down fields in 
the DP Cell Input Conditioning screen’s Switching Points pane. 
The S600+ uses the difference between the switch-up and switch-
down percentage as hysteresis. The normal value used is 5% 
hysteresis. 

For example, the Lo Cell = 0–250 mbar and the Hi Cell = 0–500 
mbar. If you define a Up value of 95 and a Down value of 90, then 
the difference is 5%. 
See Figure 6-54 for a graphical presentation of the following usage 
situation.  
If the low range is in use and the differential pressure is rising, the 
S600+ continues to use this range until it reaches point A (237.5 
mbar). At that point, the S600+ switches to the Hi(1) or Hi(2) 
range, point B.  

If the Hi(1) or Hi(2) range is in use and the differential pressure is 
still falling, the S600+ continues to use this range until it reaches 
point C (225.0 mbar). At that point, the S600+ switches to the low 
range, point D. 
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Figure 6-54. Lo Hi Hi Cell Input Handling  

Figure 6-55 through Figure 6-58 provide flowcharts illustrating how 
the S600+ handles this.  
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Figure 6-55. Lo Hi Hi Cell Input Handling Flowchart (1)  



Config600 Configuration Software User Manual 

Revised January 2023 Stream Configuration 6-105 

Enter

Yes

Is Lo Cell > Switch Up

Return

Yes

 No

 No

1

Use
Lo Cell

Is Hi(1) Cell Available
AND

Is Hi(1) Cell > Switch Down

Is Hi(2) Cell Available
AND

Is Hi(2) Cell > Switch Down
Use

Hi(2) Cell

Use
Hi(1) Cell

Use
Lo Cell

Yes

 No

  

Figure 6-56. Lo Hi Hi Cell Input Handling Flowchart (2)  
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Figure 6-57. Lo Hi Hi Cell Input Handling Flowchart (3)  
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Figure 6-58. Lo Hi Hi Cell Input Handling Flowchart (4)  

3 Identical The 3 Identical  cell arrangement uses a voting scheme to select 
which cells are to be averaged to yield the stack’s DP value. 

Note: The mode is supported only when you enable enhanced error 
checking.   

If all three cells are available, the S600+ uses the instantaneous results 
from discrepancy checking to determine which cells are within 
tolerance of each other (where “ =” means “within discrepancy limits” 
and “≠” means “not within discrepancy limits”):  

 If all are within tolerance, then use the average of the three. 

 If only two cells are outside tolerance (for example, cell1 = cell2, 
cell1 = cell3, cell2 ≠ cell3), then choose the pair with the smallest 
difference and take their average. 

 If only two cells are within tolerance (for example, cell1 = cell2, 
cell1 ≠ cell3, cell2 ≠ cell3), then choose this pair and take their 
average. 

 If all three cells are outside the discrepancy limits, select the 
middle cell. 

 If only two cells are available, then take their average. 

 If only one cell is available, then use it. 

Figure 6-59 through Figure 6-67 provide flowcharts showing how the 
S600+ handles this scheme.  
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Figure 6-59. 3 Identical Cell Input Handling Flowchart (1)  
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Figure 6-60. 3 Identical Cell Input Handling Flowchart (2)  
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Figure 6-61. 3 Identical Cell Input Handling Flowchart (3)  
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Figure 6-62. 3 Identical Cell Input Handling Flowchart (4)  
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Figure 6-63. 3 Identical Cell Input Handling Flowchart (5)  
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Figure 6-64. 3 Identical Cell Input Handling Flowchart (6)  
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Figure 6-65. 3 Identical Cell Input Handling Flowchart (7)  
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Figure 6-66. 3 Identical Cell Input Handling Flowchart (8)  

Enter

'Take the Middle Cell'

Return

8

Note :-
No Two Cells
Are Within the
Discrepancy

Limits  

Figure 6-67. 3 Identical Cell Input Handling Flowchart (9)  
 

Caution 
DP cell stack handling runs continuously. The S600+ immediately 
implements any changes you make.  
 
Configure the MAXIMUM number of input cells you will EVER require. 
This enables you to change Stack Type through a running S600+’s front 
panel without the risk of triggering configuration alarms because of 
insufficient input cells defined in the configuration file.  
 



Config600 Configuration Software User Manual 

6-110 Stream Configuration Revised January 2023 

DP Cell Input Conditioning Screen  
To access this screen:  

1. Select DP Cell Input Conditioning from the hierarchy menu. The 
DP Cell Input Conditioning screen displays.  

  

Figure 6-68. DP Cell Input Conditioning screen  

2. Complete the following fields.  
Field  Description 
Stack Type Indicates how the S600+ determines the DP value. 

Click  to display all valid values. The default is 
Single.  
Note: Refer to Cell Input Stacking for a description of 

each stack type.  
ASSIGNMENT Click to display an Analog Input Assignment dialog box 

you use to assign AI to the selected stack type.  
Once you select a Stack Type, Config600 displays the 
associated input cell(s). If any items are unassigned, 
use this button to assign AI to the cell.  

SETTINGS Click to display an Analog Input Settings dialog box 
you use to edit the input assignments for the input cell 
with assigned AI.   
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Field  Description 
Use enhanced 
error check 

Enables enhanced error checking in the S600+. The 
default is checked (enabled). 
Note: If  you select metric as your measurement 

units, the S600+ automatically enables 
enhanced error checking. If you select 
Imperial as your measurement units, the 
S600+ automatically disables enhanced 
error checking.  

Value  Sets the value below which the S600+ does not 
totalise DP measurements. The default is 10. 
Note: This value is valid only for Normal mode.   

Mode  Indicates the cell input mode of operation. Click  to 
display all valid values.   

 Normal Totalisation does not occur when the 
measured DP is less than the value in the 
Value field. This is the default.  

 Cats (Common Area Transmission System) 
Totalisation does not occur when the 
measured DP is less than the defined 
Low Low Alarm Limit.  

Up Sets the switch-up point between two input cells, 
expressed as a percentage of the range of the lower 
cell. The default is 95. The S600+ uses this value for 
all cell ranges.  

Down Sets the switch-down point between two input cells, 
expressed as a percentage of the range of the lower 
cell. The default is 90. The S600+ uses this value for 
all cell ranges.  

Value Sets the discrepancy allowed between the readings of 
two active input cells in the operating range. The value 
is defined as a percentage of the high scale value from 
the lower of the two cells. The default is 10. 
Note:  The S600+ performs this test continuously.  

Time-out Sets a period of time during which the S600+ ignores 
the discrepancy between the readings of two available 
transducers. The default is 5. When the duration of the 
discrepancy exceeds this time limit, the S600+ raises 
an alarm.  

Startup Mode Indicates the S600+ startup mode. MEASURED is the 
only currently valid value.   

Keypad Sets a keypad value the S600+ uses as a default if it 
cannot select a cell (for example, all are out of range). 
The default is 100. 

High High  Enables and defines a high high alarm limit.  
High  Enables and defines a high alarm limit.  
Low Enables and defines a low alarm limit.  
Low Low Enables and defines a low low alarm limit.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  
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6.5 Gas – Turbine  
These stream settings are specific to gas applications. When you 
initially create a configuration, the calculation selections you make 
determine which calculation-specific screens appear in the hierarchy 
menu.  

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings.  

6.5.1 AGA8 (Compressibility) 
Compressibility settings define the constants and calculation limits for 
a range of parameters including pressure, temperature, density, and 
compressibility factors. This screen displays when you configure the 
S600+ to use the main AGA8 standard to calculate base 
compressibility and density, flowing compressibility and density, and 
standard compressibility for natural gases.   

Note: “Standard conditions” are assumed as 14.73 psia and 60°F. 

The compressibility settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits.  

1. Select AGA8 from the hierarchy menu. The AGA8 screen 
displays.    

  

Figure 6-69. AGA8 screen  
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2. Complete the following fields.  
Field  Description 
Method Indicates the compressibility calculation method. Click 

 to display all valid values.   
 Detail Uses 21 component values, temperature 

and pressure in accordance with the 1994 
standard. This is the default.  

 Gross1 Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 1991 standard.   
Note:  Gross1 only supports volumetric 

heating value and does not support 
mass heating value. 

 Gross2 Uses SG, N2, CO2, temperature and 
pressure in accordance with the 1991 
standard. 

 VNIC Uses 20 component values, temperature 
and pressure in accordance with GOST 
30319 1996. 

 MGERG Uses 19 component values (As indicated 
in GERG Technical Monograph 2 1998) to 
calculate compressibility of natural gas 
mixtures based on a full compositional 
analysis. 

 PT 1 
DETAIL 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 

 PT 1 
GROSS1 
2017 

Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 2017 standard. 
Note:  Gross1 only supports volumetric 

heating value and does not support 
mass heating value. 

 PT 1 
GROSS2 
2017 

Uses SG, N2, CO2, temperature and 
pressure in accordance with the 2017 
standard. 

 PT 1 
GROSS0 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 

 PT 2 
GERG 
2008 

Uses 21 component values [as indicated 
in Table 1 AGA8 2017 Part 2 (GERG 
2008)] to calculate compressibility of 
natural gas mixtures based on a full 
compositional analysis. 

Pressure Sets the pressure at base conditions. The default is 0. 
Temperature Sets the temperature at base conditions. The default is 

15. 
Limit Check Click ▼ to select Off to disable the calculation limit 

checking. The default is On. 
Note: The compressibilities and densities will be less 

accurate and the calculation may fail 
completely when operating outside the 
calculation limits. 

METER 
PRESSURE  

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for meter pressure.   
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Field  Description 
METER TEMP  Click to display a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter temperature.   

REAL RD (SG) Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for real relative density.  

GROSS HV Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for gross heating value (HV).   

 
3. Click any of the following buttons to define AGA8 calculation 

limits.  
Button  Description 
METER 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter density.  

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream (flowing) compressibility (Zf).   

MOLAR MASS  Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for molar mass.  

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in the 
Status/Control Method field. 

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for base density.  

BASE 
(COMP(Zb)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for base compressibility (Zb).   

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent.  
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in the 
Status/Control Method field. 

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal relative density.   

STD COMP(Zs) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for standard compressibility (Zs). 

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  
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6.5.2 Gas CV (ISO6976 or GPA2172/ASTM D3588) 
Calorific Value settings define the composition type, table to be used, 
and calculation limits for a range of parameters including density, 
relative density, and calorific value. This screen displays when you 
configure the S600+ to use the ISO6976 or GPA2172/ASTM D3588 
standard (in step 5, Options, of the PCSetup Editor’s Configuration 
Wizard) to calculate the calorific value (heating value) of the gas 
mixture.   

Calorific value settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within the 
specified limits.  
1. Select Gas CV from the hierarchy menu. The Calorific Value 

screen displays.    

 

Figure 6-70. Gas CV screen  

2. Complete the following fields.  
Field  Description 
CV Table Indicates the particular compressibility value the 

program uses. Click  to display all valid values.  
 ISO6976/1995 

Vol 
Calculates CV based on volume, 
using the 1995 table. This is the 
default if  you choose CV 
ISO6976 as your initial stream 
option. 
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 
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Field  Description 
 ISO6976/1995 

Mass 
Calculates CV based on mass, 
using the 1995 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/1983 Calculates CV based on volume, 
using the 1983 table.  
Note: Support for the 1983 table 

is limited to superior 
volumetric at 15/15. This 
option displays only if you 
initially configure the stream 
to use CV ISO6976. 

 ISO6976/2016 
Vol 

Calculates CV based on volume, 
using the 2016 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/2016 
Mass 

Calculates CV based on mass, 
using the 2016 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 GPA/2003 
AGA (14.73) 

Calculates CV based on a base 
pressure of 14.73 psia. This is the 
default if  you choose CV 
GPA2172-ASTMD3588 as your 
initial stream option. 
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2003 ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2000 
AGA (14.73) 

Calculates CV based on a base 
pressure of 14.73 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2000 ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/1996 
AGA (14.73) 

Calculates CV based on a base 
pressure of 14.73 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 
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Field  Description 
 GPA/1996 ISO 

(14.696) 
Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV  
GPA2172-ASTMD3588. 

 GPA/2016 Pb 
(14.65) 

Calculates CV based on a base 
pressure of 14.65 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV  
GPA2172-ASTMD3588. 

Reference 
Condition  

Indicates the t1/t2 value, where t1 is the calculation 
reference temperature for combustion and t2 is the 
reference condition for metering. The default is 15/15 
DEG C.  
Note:  
 For ISO6976 1983 VOL selection, the 60/60F 

and 15/15.55 Deg C selections are not 
supported.  

 For ISO6976 1995 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection is not supported. 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a combustion 
temperature (t1) of 15 Deg C and a 
metering temperature (t2) of 15 Deg C. 

 For ISO6976 2016 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection refers to a combustion temperature 
(t 1) of 15.55 Deg C (60 Deg F) and a metering 
temperature (t2) of 15.55 Deg C (60 Deg F). 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a combustion 
temperature (t1) of 15 Deg C and a 
metering temperature (t2) of 15 Deg C. 

Method If  you select CV ISO6976 in your initial 
conf iguration and you select the 1995 standard, 
you have the choice of Alternative or Definitive 
methods (using table 4 Mass / table 5 volume) for 
calculating the ideal, superior, and inferior CV 
values. This selection is not applicable to the 1983 
or 2016 standards. 
If  you select CV GPA2172-ASTMD3588 in your 
initial configuration, you have the choice of the 
Simple (using equation 7 f rom the GPA2172-
ASTMD3588-09 standard) or Rigorous (using 
equations 8 & 9 f rom the GPA2172-ASTMD3588-
09 standard) methods for calculating the standard 
compressibility. 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
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Field  Description 
User Temp T2 Applicable to the ISO6976 2016 VOL and ISO6976 

2016 MASS selections. Also applicable to ISO6976 
1995 VOL selection when the Definitive method is 
selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
User Press P2 Applicable to the ISO6976 2016 VOL and ISO6976 

1995 VOL selections when the Definitive method is 
selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
Table Revision Replaces the above AGA and ISO selections in the 

CV Table f ield for GPA 2172. You can select the 
GPA2145 table revision from one of the following:  
 1996 
 2000 
 2003 
 2009 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
BASE 
COMP(Zb) 

Click to supply an externally calculated base 
compressibility from another calculation. The entered 
value is used in GPA2172-ASTMD3588 calculations 
instead of using its own internally calculated value 
based on the composition input. 

Composition 
Type 

Def ines the composition input type. Valid options 
are: 
 mass to energy using mole percent  
 mass to energy using mole fraction  
 volume to energy using mole percent  
 volume to energy using mole fraction 
Note: This option is valid only for AGA5 

configurations. 
 
3. Click any of the following buttons to compressibility calculation 

limits.   
Button  Description 
STD COMP(Zs) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the calculated standard compressibility.   

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the calculated ideal relative density.   

IDEAL DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the calculated ideal density.   
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Button  Description 
IDEAL CV 
(SUP) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal calorific value.   
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the S600+ front panel.  

Gross HV Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for gross heating value. 
Note: This field displays only if you initially 

configure the stream to use CV GPA2172-
ASTMD3588. 

REAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real relative density.   

REAL DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real density.   

REAL CV (SUP) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the S600+ front panel. 

WOBBE INDEX Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The Wobbe Index is calculated using the Real 

Superior CV. 
REAL VOL 
IDEAL HV 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the real volume ideal 
heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-
ASTMD3588. 

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 

6.5.3 AGA7 (Gross Volume Flowrate) 
The AGA7 settings define the constants and calculation limits for a 
range of parameters including meter pressure, temperature, and 
compressibility. This screen displays when you configure the S600+ to 
use the AGA7 standards to calculate the gross volume flowrate from a 
gas turbine.   
The AGA7 settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within 
specified limits.  
1. Select AGA7 from the hierarchy menu. The AGA7 screen 

displays.    
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Figure 6-71. AGA7 screen  

2. Complete the following fields. 
Field  Description 
METER PRESS Click to display an Analog Inputs dialog box you use to 

define the analog input values associated with this 
stream, I/O module, and channel, as well as 
conversion factors and alarm limits.  

METER TEMP Click to display an Analog Inputs dialog box you use to 
define the analog input values associated with this 
stream, I/O module, and channel, as well as 
conversion factors and alarm limits.  

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the upstream compressibility (Zf).  

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the base compressibility (Zb).  

STREAM 
DENSITY 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the stream density.  

BASE 
DENSITY 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the base density  

REAL CV Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the real calorific value.   

Premium Flow 
Limit 

In Premium Billing FLOW mode. sets a flowrate 
limit above which the system increments forward 
premium totals whenever the flowrate exceeds the 
keypad limit. 
In Premium Billing TOTAL mode, sets a total limit 
above which the system increments forward premium 
totals whenever the period total exceeds the keypad 
limit. The default is 100. 

Premium 
Billing Mode 

Indicates the premium total mode, in which the system 
increments premium totals at the end of a period only if 
the period total exceeds the keypad limit. Click ▼ to 
display all valid values. The default is FLOW.   

Pressure Sets pressure at base conditions. The default is 0. 
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Field  Description 
Temperature  Sets temperature at base conditions. The default is 15. 
UVOL Fail 
Mode 

Indicates the fault total option for the uncorrected 
volume. Click  to display all valid values.  
Note:  If  you define fault totals but do not use them, 

the S600+ does not include them in reports 
and displays at run time.  

 FAULT ONLY When fault condition is active, 
only increment fault totals.  

 NORMAL ONLY When fault condition is active, 
only increment normal totals.  

 NORMAL/FAULT When fault condition is active, 
increment both normal and fault 
totals. This is the default.  

CVOL Fail 
Mode 

Indicates the fault total option mode for the corrected 
volume. Click  to display all valid values.  
Note: If  you define fault totals but do not use them, 

the S600+ does not include them in reports 
and displays at run time. 

 FAULT ONLY When fault condition is active, 
only increment fault totals.  

 NORMAL ONLY When fault condition is active, 
only increment normal totals.  

 NORMAL/FAULT When fault condition is active, 
increment both normal and fault 
totals. This is the default.  

Mass Fail 
Mode  

Indicates the fault total option for the mass fail mode. 
Click  to display all valid values.  
Note: If  you define fault totals but do not use them, 

the S600+ does not include them in reports 
and displays at run time. 

 FAULT ONLY When fault condition is active, 
only increment fault totals.  

 NORMAL ONLY When fault condition is active, 
only increment normal totals.  

 NORMAL/FAULT When fault condition is active, 
increment both normal and fault 
totals. This is the default.  

Energy Fail 
Mode  

Indicates the fault total option for the energy fail mode. 
Click  to display all valid values.  
Note: If  you define fault totals but do not use them, 

the S600+ does not include them in reports 
and displays at run time.  

 FAULT ONLY When fault condition is active, 
only increment fault totals.  

 NORMAL ONLY When fault condition is active, 
only increment normal totals.  

 NORMAL/FAULT When fault condition is active, 
increment both normal and fault 
totals. This is the default.  

TURBINE 
INPUT EDITOR 

Click to display the Turbine Inputs screen on the I/O 
Setup option.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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6.5.4 Stream Gas Composition 
Stream Gas Composition settings define the processing and port 
telemetry parameters for streams receiving data from the gas 
chromatograph controller. The chromatograph controller measures the 
individual component concentrations found in the line gas. The 
chromatograph controller settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the 
chromatograph data are not within specified limits.  

1. Select Gas Composition from the hierarchy menu. The Gas 
Composition screen displays. 

 

Figure 6-72. Gas Composition screen  

2. Complete the following fields.  
Field  Description 
Type Indicates the chromatograph configuration. Click  to 

display all valid values.   
 CHROMAT A Controller-connected; uses keypad 

data as fallback information.  
 KP ONLY Not controller-connected; uses 

information entered via keypad. This 
is the default.   

 Note: If  you select KP ONLY, the system hides a 
number of fields on this screen.  
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Field  Description 
Initial Mode Indicates the operational mode for the in-use 

composition data. Click  to display all valid values.   
 KEYPAD Use data entered via keypad. This is 

the default.  
 CHROMAT Use live data from the 

chromatograph controller.  
 DOWNLOAD Download gas composition data 

directly to each stream. Used only if 
connected to a remote supervisory 
computer.  

 USER Use customised program for gas 
composition in S600+.  

 KEYPAD_F Start by using keypad-entered data 
then switch to chromatograph data 
when a good analysis is received. 

Acceptance 
Type 

Indicates how the S600+ manages in-use data. Click 
 to display all valid values.   

 ACC/COPY Copy and normalise keypad data to 
in-use data only after it is accepted. 
This is the default.  

 ACC/NORM Copy normalised keypad data to in-
use data after it is accepted.  

 AUTO/NORM Automatically copy normalised 
keypad data to in-use data.  

Station Number Sets the station associated with this stream. The 
default is 1. 

Apply Splits Indicates the type of analyser connected to the S600+. 
For a C6+ analyser, use the C6Plus option. Click ▼ to 
display all valid values. The default is NO SPLITS.  
If  you select any value other than NO SPLITS, the 
system displays the MOLE SPLITS button. Use this 
button to define the specific percentage splits for the 
gases. 
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Revert to Last 
Good after 
Failure  

Continues using the last good composition in the event 
of  failure. Otherwise the system reverts to keypad 
data.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Check Critical 
Alarms  

Marks the received composition as failed if any critical 
alarm is set (such as the pre-amp fail on the Danalyzer 
for a Daniel 2551 Controller).  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Check Non 
Critical Alarms  

Marks the received composition as failed if any non-
critical alarm is set (such as the pre-amp fail on the 
Danalyzer for a Daniel 2551 Controller).  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

CHROMAT 
COMMS 

Click to display the Comm screen in I/O Setup (see 
Chapter 4, Section 4.10).  
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Field  Description 
Initial Mode Identifies the chromatograph and any fallback 

controllers. Currently, the only valid value is PAY, 
which indicates one chromatograph and no fallback 
controller.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Type Indicates the type of chromatograph controller 
connected to the S600+. Click  to display all valid 
values.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

 2551 EURO S600+ is connected to a Daniel 
2551 (European) controller. This is 
the default.  

 2350 EURO S600+ is connected to a Daniel 
2350 (European) controller set in 
SIM_2251 mode.  

 2350 USA S600+ is connected to a Daniel 
2350 (USA) controller set in 
SIM_2251 mode.  

 2251 USA S600+ is connected to a Daniel 
2251 controller.  

 Generic S600+ is connected to another type 
of  controller.   

 Siemens S600+ is connected to a Siemens 
Advance Maxum via a Siemens 
Network Access Unit (NAU).  

MOLE ORDER Click this button to display a Gas Composition dialog 
box on which you use to indicate the order in which the 
gas composition information comes into the S600+ via 
telemetry. 0 indicates any component which is not 
included in the Modbus map.  
Note: 
 The Modbus map you create must be compatible 

with the controller to which the S600+ is 
connected. Refer to Chapter 14, Modbus Editor, 
for further information.  

 This field displays only if you select CHROMAT A 
as the chromatograph configuration type. 

 This field is applicable only if you select Siemens 
or Generic in the Type field. 

Address  Configures multi-drop chromatograph support. Do not 
change unless advised to do so.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Stream  Sets the chromat analysis stream assigned to this 
metering stream. The default is 0.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. If you need to support 
more than one stream, contact Technical 
Support.  
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Field  Description 
Analysis 
Timeout  

Sets the maximum number of seconds the S600+ 
waits to receive a new composition from the 
chromatograph controller before raising an alarm. The 
default is 900. 
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Download 
Timeout  

Sets the maximum number of minutes the S600+ waits 
to receive a new composition from the supervisory 
computer before raising a DL Timeout Alarm. The 
default is 15.  
Note: 
 A value of 0 disables the timeout. 
 This field displays only if you select KP ONLY in 

the Common Type field. 
KEYPAD 
MOLES 

Click to display a dialog box you use to define mole 
percentage values for each gas component.   
Note:  The system assumes the keypad composition 

adds to 100% (normalised) when the 
Acceptance Type is ACC/COPY. If you select 
ACC/NORM or AUTO/NORM, the system 
automatically normalises the keypad 
composition.  

MOLE 
ADDITIONAL 

Click to display a dialog box you use to define mole 
percentage values for gas components not analysed 
by the Danalyzer. The system assumes any additional 
components to be normalised values, and the analyser 
components are re-normalised (100 – sum of 
additional components). 
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

USER MOLES Click to display a dialog box you use to define mole 
percentage values for each gas component. The 
system assumes user moles to be normalised.  
Note:  The S600+ uses these values only if you set 

the Initial Mode to USER. A Modbus 
download from another computer may 
overwrite these values on a running 
configuration.  

Check Limits Enables limit checking on each gas component. When 
you select this check box, the MOLE LO LIMITS and 
MOLE HI LIMITS buttons display.  
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Field  Description 
MOLE LO 
LIMITS 

Click to display a dialog box you use to define low 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:  
 The system uses the values you enter through 

these buttons only if you select the Check Limits 
check box. The system applies this test to the 
keypad, downloaded, user, additionals, and new 
analysis components. When enabled, the system 
applies the limit check against the high and low 
limits. Limits are considered valid if the limit is 
greater than zero (0). The system also applies the 
check to the Total field. If you disable the limit 
check, the keypad, downloaded and user Total 
f ield must lie within 0.1% and 150%. A sum of the 
new analysis must be within 99.5% and 100.5%. 

 This field displays only if you place a check mark 
in the Check Limits field. 

MOLE HI 
LIMITS 

Click to display a dialog box you use to define high 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:  See note in description of Mole Lo Limits field.  

Check 
Deviations 

Enables checking on the deviation from the last good 
analysis for each component. When you select this 
check box, the MOLE DEVN LIMITS button displays.  
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

MOLE DEVN 
LIMITS 

Click to display a dialog box you use to define the 
maximum deviation allowed for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note: This field displays only if you place a check 

mark in the Check Deviations field. 
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.5.5 Gas Properties 
Gas Properties settings define methods the system uses to calculate 
viscosity, isentropic exponent (also known as “specific heat ratio” or 
“adiabatic exponent), and the velocity of sound.  ”)  

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits.  
1. Select Gas Properties from the hierarchy menu. The Gas 

Properties screen displays.   
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Figure 6-73. Gas Properties screen  

2. Complete the following fields.  
Field  Description 
Viscosity @ Tn Sets the reference viscosity for the gas. The default is 

0.010861.  
Note: Used only by VDI/VDE.  

Viscosity Tn Sets the reference viscosity temperature for the gas. 
The default is 15.  
Note: Used only by VDI/VDE. 

Sutherland 
Constant 

Sets the Sutherland constant for the gas. The default 
is 164.  
Note: Used only by VDI/VDE. 

Viscosity Calc 
Type  

Indicates the method for calculating the viscosity of the 
gas. Click  to display all valid values.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default. 

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires base 
density, N2, and CO2 inputs.  

 VDI/VDE 2040 
1987 

Uses calculations from VDI/VDE 
2040 Part 2 1987. Requires 
viscosity @Tn, viscosity Tn, and 
Sutherland Constant inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   

Isentropic 
Exponent 

Indicates the method for calculating the isentropic 
exponent of the gas. Click  to display all valid values.   

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  
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Field  Description 
 Disabled Value not calculated; defaults to 

keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.  

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   

Speed of Sound Indicates the method for calculating the speed of 
sound. Click  to display all valid values.  

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.   

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.   

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.  

 
3. Click any of the following buttons to set gas property outputs or 

variables.   
Button  Description 
VISCOSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for viscosity. 

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent. 

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound. 
Note:  AGA10 refers to VOS as “speed of sound.” 

UPSTREAM 
PRESS 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream pressure. 

UPSTREAM 
TEMP 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for upstream temperature. 

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for base density. 

INUSE 
COMPOSITION 

Click to display a read-only table of gas compositions. 
This corresponds to the table defined using the Gas 
Composition screen’s KEYPAD MOLES button.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
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5. Click Yes to apply your changes. The PCSetup screen displays. 

6.5.6 Local Units 
This option allows you to override the global K-factor unit, since a gas 
application may have more than one type of meter, each using different 
K-factor units.  

1. Select Local Units from the hierarchy menu. The Local Units 
screen displays.  

 

Figure 6-74. Local Units screen  

2. Complete the following field.  
Field  Description 
K-Factor Units Indicates the type of units to use and override the 

system K-factor units of measurement. Click ▼ to 
display all valid values. The default is SYSTEM 
UNITS. 
Note:  If  you select System Units, the stream uses 

the global default value.  
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  

6.5.7 Linearisation  
Linearisation settings define the constants and calculation limits for the 
meter factor and K-factor. The S600+ calculates a meter factor and K-
factor corresponding to the turbine frequency by interpolating the 
frequency between fixed points and then cross-referencing the result 
against a lookup table.  
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Linearisation settings also allow you to define alarms. The system 
activates these alarms when the calculated results for the meter factor 
and K factor are not within specified limits. 

Flow meters produce pulses proportional to the total flow through the 
meter, and the K-factor represents the number of pulses produced per 
unit volume.  

Notes:  
 The linearisation curve for Gas Turbine configurations uses 

frequency as the default input for both K-factor and Meter Factor 
calculations. The ability to change the defaults is available only 
with Config600 Pro software. 

 Batching systems that employ meter factor or K-factor linearisation 
with retrospective meter factor/K-factor adjustments assume that 
the adjusted value has a “keypad” mode.   

 To prevent the live metering system from applying a double 
correction, use either a calculated meter factor or a calculated K-
factor linearisation (that is, only one factor should have a 
calculated mode). 

1. Select Linearisation from the hierarchy menu. The Linearisation 
screen displays. 
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Figure 6-75. Linearisation screen  

2. Complete the following field.  
Field  Description 
Meter Factors  Sets up to 20 flow rate and values for the meter 

corrector factors.  
 Flowrate/Freq Sets the flowrate and frequency for 

each of the meter correction factors.  
 Value Sets the corresponding values for 

each of the meter correction factors.  
K-Factors  Sets up to 20 flow rate and values for the K-factors.  
 Flowrate/Freq Sets the flowrate and frequency for 

each of the K-factors.  
 Value Sets the corresponding values for 

each of the K-factors.  
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Field  Description 
METER 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor. 

K-FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor. 

K Factor 
Method 

Selectable between K FACTOR (values entered as 
normal) and ERROR PERCENT (K Factor entered 
as a percentage). 

Meter Factor 
Method 

Selectable between METER FACTOR (values 
entered as normal) and ERROR PERCENT (Meter 
Factor entered as a percentage). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.5.8 Sampling 
Sampling defines the method and interval period for sampling product 
from a flowing pipeline. By default, Config600 supports one sampler 
per stream. Config600 uses the following stages during the sampling 
process:   

Stage Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl 
4 Post Pulse  
5 Stopped Manually 
6 Stopped Can Full 
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch 
12 Stopped initialise 
13 Can Switch Over 

Note:  Batch auto-resets the sampler at the start of the batch. 

1. Select Sampling from the hierarchy menu. The Sampling screen 
displays.  
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Figure 6-76. Stream Sampling screen 

2. Complete the following fields.   
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 

stream or station must have a unique sampler ID and 
must be greater than zero.   

Method  Indicates the sampling method. Click  to display all 
valid values.  

 TIME PROP Divides the value in the Can Fill 
Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a time interval 
per pulse. This is the default.  

 FLOW PROP1 Divides the value in the Volume 
f ield by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a volume 
throughput per pulse.  

 FLOW PROP2 Uses the value in the Volume field 
as the volume throughput per 
pulse.  

 FLOW PROP3 Uses the value in the Volume field 
as the volume throughput per 
pulse, but supports low pressure 
digital input and pump prime 
output.  



Config600 Configuration Software User Manual 

6-134 Stream Configuration Revised January 2023 

Field  Description 
Mode Indicates the sampling mode. Click  to display all 

valid values. The S600+ uses Can 1 or Can 2.  
 SINGLE Acquire sample in one trial. This is 

the default.  
 DUAL Acquire samples in two trials.  

Note: If  you select Dual, the 
sampler switches to a 
second can when the 
current can is full 
(according to the two can 
switchover mode).  

Can Fill 
Indicator 

Indicates when the sampling can is full. Click  to 
display all valid values.   

 GRAB COUNT Uses the number of pulses output 
to the sampler to determine when 
the sample is full. This is the 
default. 

 DIG I/P Uses a digital input to determine 
when the sampler is full.  

 ANALOG I/P Uses an analog input to determine 
when the sampler is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select the appropriate 
check box to identify the specific event.   

 On Can Full Disables the sampling process 
when the can is full. This is the 
default. 

 On Flowrate 
Limit 

Disables the sampling process 
when the flowrate is less than the 
value of the Flowrate Low Limit. 

 On Flow Status Disables the sampling process 
when the flow status value is not 
on-line. 

Auto Restart Automatically restarts (if selected) sampling following 
an automatic disabling.  

Expected 
Volume/Mass 

Indicates, in cubic meters, the expected flow volume or 
mass of the sampling can. This is the value the Flow 
Prop1 and Flow Prop2 sampling methods use for 
calculations. The default is 1000.  

Can Fill Period Sets, in hours, the time required to fill the sampling 
can. The default is 24.  
Note: The Time Prop sampling method uses this 

value for its calculations.   
Flowrate Low 
Limit  

Indicates flowrate low limit used by the Auto Disable 
on Flowrate Limit option. The default is 0.   
Note:  This field is required if you select the On 

Flowrate Limit check box for Auto Disable.  
Minimum 
Interval  

Indicates, in seconds, the minimum amount of time 
between grabs. This is the value the Time Prop 
sampling method uses for its calculations. The default 
is 30.   
Note: If  the sample exceeds this limit, the system 

sets the overspeed alarm and increments the 
overspeed counter.   
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Field  Description 
Volumes 
 Can Volume Indicates, in cubic meters, the 

volume of the sampling can. The 
default is 0.5.   

 Grab Volume Indicates, in cubic meters, the 
volume of the sampling grab. 
The default is 0.001.   

Can Limits 
 Can Low Limit Indicates the low alarm value as 

a percentage of the can volume. 
The default is 5. 

 Can High Limit Indicates the high alarm value as 
a percentage of the can volume. 
The default is 90.   

 Can High High 
Limit 

Indicates the high high alarm 
value as a percentage of the can 
volume. The default is 95.   

Twin Can 
Changeover 
Mode  

Indicates whether the system automatically change to 
a second sampling can. Click  to display all valid 
values.  

 AUTO The sampler automatically 
changes over to the second can 
when the first is full. 

 MANUAL The sampler pauses sampling 
when the first can is full, and 
requires the operator to change 
the value of Can Selected before 
sampling continues on the 
second can. 
Note: 
 If  sampling is stopped 

because both cans are full, 
the Twin Can Changeover 
Mode is set to MANUAL by 
the system. The user must 
set back to AUTO if required. 

 The display for Twin Can 
Changeover must be 
manually added to the 
displays. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  

6.6 Gas – Ultrasonic  
These stream settings are specific to gas ultrasonic applications. When 
you initially create a configuration, the calculation selections you make 
determine which calculation-specific screens appear in the hierarchy 
menu.  
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings. 
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6.6.1 AGA8 (Compressibility) 
Compressibility settings define the constants and calculation limits for 
a range of parameters including pressure, temperature, density, and 
compressibility factors. This screen displays when you configure the 
S600+ to use the main AGA8 standard to calculate base 
compressibility and density, flowing compressibility and density, and 
standard compressibility for natural gases.  

Note:  “Standard conditions” are assumed as 14.73 psia and 60 °F. 

The compressibility settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits. 

1. Select AGA8 from the hierarchy menu. The AGA8 screen 
displays.   

 

Figure 6-77. AGA8 screen  

2. Complete the following fields.  
Field  Description 
Method Indicates the compressibility method. Click  to 

display all valid values.  
 DETAIL Uses 21 component values, temperature 

and pressure in accordance with the 1994 
standard. This is the default.  
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Field  Description 
 GROSS1 Uses SG, Heating Value, CO2, 

temperature and pressure in accordance 
with the 1991 standard. 
Note: Gross1 only supports volumetric 

heating value and does not support 
mass heating value. 

 GROSS2 Uses SG, N2, CO2, temperature and 
pressure in accordance with the 1991 
standard. 

 VNIC Uses 20 component values, temperature 
and pressure in accordance with GOST 
30319 1996. 

 MGERG Uses 19 component values (As indicated 
in GERG Technical Monograph 2 1998) to 
calculate compressibility of natural gas 
mixtures based on a full compositional 
analysis. 

 PT 1 
DETAIL 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 

 PT 1 
GROSS1 
2017 

Uses SG, Heating Value, CO2, 
temperature and pressure in accordance 
with the 2017 standard. 
Note: Gross1 only supports volumetric 

heating value and does not support 
mass heating value. 

 PT 1 
GROSS2 
2017 

Uses SG, N2, CO2, temperature and 
pressure in accordance with the 2017 
standard. 

 PT 1 
GROSS0 
2017 

Uses 21 component values, temperature 
and pressure in accordance with the 2017 
standard. 

 PT 2 
GERG 
2008 

Uses 21 component values [as indicated 
in Table 1 AGA8 2017 Part 2 (GERG 
2008)] to calculate compressibility of 
natural gas mixtures based on a full 
compositional analysis. 

Pressure Sets the pressure at base conditions. The default is 0.  
Temperature  Sets the temperature at base conditions. The default is 

15.  
Limit Check Click ▼ to select Off to disable the calculation limit 

checking. The default is On. 
Note:  The compressibilities and densities will be less 

accurate and the calculation may fail 
completely when operating outside the 
calculation limits. 

METER PRESS Click to display an Analog Inputs dialog box you use to 
define the analog input values associated with this 
stream, I/O card, and channel, as well as conversion 
factors and alarm limits.  

METER TEMP Click to display an Analog Inputs dialog box you use to 
define the analog input values associated with this 
stream, I/O card, and channel, as well as conversion 
factors and alarm limits.  
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Field  Description 
REAL RD (SG) Click to display a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the real relative density.   

GROSS HV Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the gross heating value (HV).   

 
3. Click any of the following buttons to set calculation limits:   

Button  Description 
UPSTREAM 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for upstream density.   

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for upstream compressibility.   

MOLAR MASS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for molar mass.  

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the velocity of sound. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in 
the Status/Control Method field. 

BASE DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for base density.  

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for base compressibility.  

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the isentropic exponent. 
Note: This field is visible only if you select either 

PT1 DETAIL 2017 or PT2 GERG 2008 in 
the Status/Control Method field. 

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for ideal relative density.  

STD COMP(Zs) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for standard compressibility.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.6.2 Gas CV (ISO6976 or GPA2172/ASTM D3588) 
Calorific Value settings define the composition type, table to be used, 
and calculation limits for a range of parameters including density, 
relative density, and calorific value. This screen displays when you 
configure the S600+ to use either the ISO6976 or GPA2172/ASTM 
D3588 standards (defined in step 5 of the PCSetup Editor’s 
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Configuration Wizard) to calculate the calorific value (heating value) 
of the gas mixture.   
The calorific value settings also allow you to define alarms. The 
system activates these alarms when the calculated results are not within 
the specified limits.  

1. Select Gas CV from the hierarchy menu. The Calorific Value 
screen displays. 

 

Figure 6-78. Gas CV screen 

2. Complete the following fields.  
Field  Description 
CV Table Identifies the particular compressibility value the 

program uses. Click  to display all valid values.  
 ISO6976/1995 

Vol 
Calculates CV based on volume, 
using the 1995 table. This is the 
default if  you choose CV 
ISO6976 as your initial stream 
option. 
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/1995 
Mass 

Calculates CV based on mass, 
using the 1995 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 
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Field  Description 
 ISO6976/1983 

Vol 
Calculates CV based on mass, 
using the 1983 table.  
Note: Support for the 1983 table 

is limited to superior 
volumetric at 15/15. This 
option displays only if you 
initially configure the stream 
to use CV ISO6976. 

 ISO6976/2016 
Vol 

Calculates CV based on volume, 
using the 2016 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 ISO6976/2016 
Mass 

Calculates CV based on mass, 
using the 2016 table.  
Note: This option displays only if 

you initially configure the 
stream to use CV ISO6976. 

 GPA/2003 
AGA (14.73) 

Calculates CV based on a base 
pressure of 14.73 psia. This is the 
default if  you choose CV 
GPA2172-ASTMD3588 as your 
initial stream option. 
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2003 ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2000 
AGA (14.73) 

Calculates CV based on a base 
pressure of 14.73 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/2000 ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/1996 
AGA (14.73) 

Calculates CV based on a base 
pressure of 14.73 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

 GPA/1996 ISO 
(14.696) 

Calculates CV based on a base 
pressure of 14.696 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 



Config600 Configuration Software User Manual 

Revised January 2023 Stream Configuration 6-141 

Field  Description 
 GPA/2016 Pb 

(14.65) 
Calculates CV based on a base 
pressure of 14.65 psia.  
Note: This option displays only if 

you initially configure the 
stream to use CV 
GPA2172-ASTMD3588. 

Reference 
Condition  

Indicates the t1/t2 value, where t1 is the calculation 
reference temperature for combustion and t2 is the 
reference condition for metering. The default is 15/15 
DEG C.  
Note:  
 For ISO6976 1983 VOL selection, the 60/60F 

and 15/15.55 Deg C selections are not 
supported.  
 

 For ISO6976 1995 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection is not supported. 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a 
combustion temperature (t1) of 15 Deg C 
and a metering temperature (t2) of 15 Deg 
C. 

 For ISO6976 2016 VOL and MASS selections, 
the 60/60F selection refers to a combustion 
temperature (t1) of 60 Deg F and a metering 
temperature (t2) of 15 Deg C. The 15/15.55 Deg 
C selection refers to a combustion temperature 
(t 1) of 15.55 Deg C (60 Deg F) and a metering 
temperature (t2) of 15.55 Deg C (60 Deg F). 
Note:  For Binary.app versions prior to 06.30a, 

the 60/60F selection refers to a 
combustion temperature (t1) of 15 Deg C 
and a metering temperature (t2) of 15 Deg 
C. 

Method If  you select CV ISO6976 in your initial 
conf iguration and you select the 1995 standard, 
you have the choice of Alternative or Definitive 
methods (using table 4 Mass / table 5 volume) for 
calculating the ideal, superior, and inferior CV 
values. This selection is not applicable to the 1983 
or 2016 standards. 
If  you select CV GPA2172-ASTMD3588 in your 
initial configuration, you have the choice of the 
Simple (using equation 7 f rom the GPA2172-
ASTMD3588-09 standard) or Rigorous (using 
equations 8 & 9 f rom the GPA2172-ASTMD3588-
09 standard) methods for calculating the standard 
compressibility. 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
User Temp T2 Applicable to the ISO6976 2016 VOL and ISO6976 

2016 MASS selections. Also applicable to ISO6976 
1995 VOL selection when the Definitive method is 
selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
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Field  Description 
User Press P2 Applicable to the ISO6976 2016 VOL and ISO6976 

1995 VOL selections when the Definitive method is 
selected. 
Note: It may be necessary to add this item to a 

display so that it can be correctly initialised. 
Table Revision This replaces the above AGA and ISO selections in 

the CV Table f ield for GPA 2172. You can select 
the GPA2145 table revision from one of the 
following:  
 1996 
 2000 
 2003 
 2009 
Note: This option is valid only for configurations 

created with Config600 version 3.1 or greater. 
BASE 
COMP(Zb) 

Click to supply an externally calculated base 
compressibility from another calculation. The system 
uses the entered value in GPA2172-ASTMD3588 
calculations instead of using its own internally 
calculated value based on the composition input. 

Composition 
Type 

Def ines the composition input type. Valid options 
are: 
 mass to energy using mole percent 
 mass to energy using mole fraction 
 volume to energy using mole percent 
 volume to energy using mole fraction 
Note: This option is valid only for AGA5 

configurations. 
 
3. Click any of the following buttons to define ISO6976 or GPA2172/ 

ASTM D3588 calculation limits.   
Button  Description 
STD COMP(Zs) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the calculated standard compressibility 
(Zs).   

IDEAL RD Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the calculated ideal relative density.   

IDEAL DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the calculated ideal density.   

IDEAL CV 
(SUP) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for ideal calorific value.   
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the S600+ front panel.  

Gross HV Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for gross heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-ASTMD3588. 
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Button  Description 
REAL RD Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for real relative density.   

REAL DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real density.   

REAL CV (SUP) Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.  
Note: The superior CV is output to calc field 1 of the 

CV object and the inferior CV is output to calc 
f ield 3. You can select either by the CV object 
mode from the S600+ front panel.   

WOBBE INDEX Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for real calorific value.   
Note: The Wobbe Index is calculated using the Real 

Superior CV. 
REAL VOL 
IDEAL HV 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the real volume ideal 
heating value. 
Note: This field displays only if you initially configure 

the stream to use CV GPA2172-ASTMD3588. 
 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 

6.6.3 AGA7 (Gross Volume Flowrate) 
The AGA7 settings define the constants and calculation limits for a 
range of parameters including meter pressure, temperature, and 
compressibility. This screen displays when you configure the S600+ to 
use the AGA7 standards to calculate the gross volume flowrate from a 
gas turbine.   

The AGA7 settings also allow you to define alarms. The system 
activates these alarms when the calculated results are not within 
specified limits.  

1. Select AGA7 from the hierarchy menu. The AGA7 screen 
displays.    
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Figure 6-79. AGA7 screen  

2. Complete the following fields. 
Field  Description 
METER PRESS Click to display an Analog Inputs dialog box you use to 

define the analog input values associated with this 
stream, I/O module, and channel, as well as 
conversion factors and alarm limits.  

METER TEMP Click to display an Analog Inputs dialog box you use to 
define the analog input values associated with this 
stream, I/O module, and channel, as well as 
conversion factors and alarm limits.  

UPSTR 
COMP(Zf) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the upstream compressibility (Zf).  

BASE 
COMP(Zb) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the base compressibility (Zb).  

STREAM 
DENSITY 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the stream density.  

BASE 
DENSITY 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the base density  

REAL CV Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for the real calorific value.   

Premium Flow 
Limit 

In Premium Billing FLOW mode. sets a flowrate 
limit above which the system increments forward 
premium totals whenever the flowrate exceeds the 
keypad limit. 
In Premium Billing TOTAL mode, sets a total limit 
above which the system increments forward premium 
totals whenever the period total exceeds the keypad 
limit. The default is 100. 

Premium 
Billing Mode 

Indicates the premium total mode, in which the system 
increments premium totals at the end of a period only if 
the period total exceeds the keypad limit. Click ▼ to 
display all valid values. The default is FLOW.   

Pressure Sets pressure at base conditions. The default is 0. 
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Field  Description 
Temperature  Sets temperature at base conditions. The default is 15. 
TURBINE 
INPUT EDITOR 

Click to display the Turbine Inputs screen on the I/O 
Setup option.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.6.4 Stream Gas Composition (Gas Ultrasonic) 
Stream Gas Composition settings define the processing and port 
telemetry parameters for streams receiving data from the gas 
chromatograph controller. The chromatograph controller measures the 
individual component concentrations found in the line gas. The 
chromatograph controller settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the 
chromatograph data are not within specified limits.  

1. Select Gas Composition from the hierarchy menu. The Gas 
Composition screen displays. 

 

Figure 6-80. Gas Composition screen  

2. Complete the following fields.  
Field  Description 
Type Indicates the chromatograph configuration. Click  to 

display all valid values. The default is KP ONLY.  
 CHROMAT A Controller-connected; uses keypad 

data as fallback information.  
 KP ONLY Not controller-connected; uses 

information entered via keypad. This 
is the default. 
Note: If  you select KP ONLY, the 

system hides a number of 
f ields on this screen. 
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Field  Description 
Initial Mode Indicates the operational mode for the in-use 

composition data. Click  to display all valid values. 
 KEYPAD Use data entered via keypad. This is 

the default. 
 CHROMAT Use live data from the 

chromatograph controller.  
 DOWNLOAD Download gas composition data 

directly to each stream. Used only if 
connected to a remote supervisory 
computer.  

 USER Use customised program for gas 
composition in S600+. 

 KEYPAD_F Start by using keypad-entered data 
then switch to chromatograph data 
when a good analysis is received.   

Acceptance 
Type 

Indicates how the S600+ manages in-use data. Click 
 to display all valid values.   

 ACC/COPY Copy and normalise keypad data to 
in-use data only after it is accepted. 
This is the default. 

 ACC/NORM Copy normalised keypad data to in-
use data after it is accepted.  

 AUTO/NORM Automatically copy normalised 
keypad data to in-use data.  

Station Number Sets the station associated with this stream. The 
default is 1. 

Apply Splits Indicates the type of analyser connected to the S600+. 
For a C6+ analyser, use the C6Plus option. Click  to 
display all valid values. The default is NO SPLITS.  
If  you select any value other than NO SPLITS, the 
system displays the MOLE SPLITS button. Use it to 
define the specific percentage splits for the gases.  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

MOLE SPLITS Click to display a dialog box you use to define the 
specific percentage splits for the gases.  
Note: This button displays only if you select any 

value other than NO SPLITS.  
Revert to Last 
Good after 
Failure  

Continues using the last good composition in the event 
of  failure. Otherwise the system reverts to keypad 
data.  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Check Critical 
Alarms  

Marks the received composition as failed if any critical 
alarm is set (such as the pre-amp fail on the Danalyzer 
for a Daniel 2551 Controller).  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Check Non 
Critical Alarms  

Marks the received composition as failed if any non-
critical alarm is set (such as the pre-amp fail on the 
Danalyzer for a Daniel 2551 Controller).  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  
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Field  Description 
CHROMAT 
COMMS 

Click to display the Comm screen in I/O Setup (see 
Chapter 4, Section 4.10).   

Initial Mode Identifies the chromatograph and any fallback 
controllers. Currently, the only valid value is PAY, 
which indicates one chromatograph and no fallback 
controller.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type.  

Type Indicates the type of chromatograph controller. Click  
to display all valid values.   
Note:  This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

 2551 EURO S600+ is connected to a Daniel 
2551 (European) controller. This is 
the default.  

 2350 EURO S600+ is connected to a Daniel 
2350 (European) controller set in 
SIM_2251 mode.  

 2350 USA S600+ is connected to a Daniel 
2350 (USA) controller set in 
SIM_2251 mode.  

 2251 USA S600+ is connected to a Daniel 
2251 controller.  

 Generic S600+ is connected to another type 
of  controller.   

 Siemens S600+ is connected to a Siemens 
Advance Maxum via a Siemens 
Network Access Unit (NAU).  

MOLE ORDER Click this button to display a dialog box on which you 
indicate the order in which the gas composition 
information comes into the S600+ via telemetry.  
0 indicates any component which is not included in the 
Modbus map.  
Note:  
 This button displays only if you select Generic as 

a Type. Additionally, The Modbus map you create 
must be compatible with the controlled to which 
the S600+ is connected. Refer to Chapter 14, 
Modbus Editor, for further information. 

 This field displays only if you select CHROMAT A 
as the chromatograph configuration type. 

 This field is applicable only if you select Siemens 
or Generic in the Type field. 

Address  Configures multi-drop chromatograph support. Do not 
change unless advised to do so. 
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Stream  Sets the chromat analysis stream assigned to this 
metering stream. The default is 0.   
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. If you need to support 
more than one stream, contact Technical 
Support.  
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Field  Description 
Analysis 
Timeout  

Sets the maximum number of seconds the S600+ 
waits to receive a new composition from the 
chromatograph controller before raising an alarm. The 
default is 900. 
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

Download 
Timeout  

Sets the maximum number of minutes the S600+ waits 
to receive a new composition from the supervisory 
computer before raising a DL Timeout Alarm. The 
default is 15.  
Note: 
 A value of 0 disables the timeout. 
 This field displays only if you select KP ONLY in 

the Common Type field. 
KEYPAD 
MOLES 

Click to display a dialog box you use to define mole 
percentage values for each gas component.  
Note: The system assumes the keypad composition 

adds to 100% (normalised) when the 
Acceptance Type is ACC/COPY. If you select 
ACC/NORM or AUTO/NORM, the system 
automatically normalises the keypad 
composition.  

MOLE 
ADDITIONAL 

Click to display a dialog box you use to define mole 
percentage values for gas components not analysed 
by the Danalyzer. The system assumes any additional 
components to be normalised values, and the analyser 
components are re-normalized (100 – sum of 
additional components). 
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

USER MOLES Click to display a dialog box you use to define mole 
percentage values for each gas component. The 
system assumes user moles to be normalised.  
Note: The S600+ uses these values only if you set 

the Initial Mode to USER. A Modbus 
download from another computer may 
overwrite these values on a running 
configuration.  

Check Limits Enables limit checking on each gas component. When 
you select this check box, the MOLE LO LIMITS and 
MOLE HI LIMITS buttons display.  
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Field  Description 
MOLE LO 
LIMITS 

Click to display a dialog box you use to define low 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note:  
 The system uses the values you enter through 

these buttons only if you select the Check Limits 
check box. The system applies this test to the 
keypad, downloaded, user, additionals, and new 
analysis components. When enabled, the system 
applies the limit check against the high and low 
limits. Limits are considered valid if the limit is 
greater than zero (0). The system also applies the 
check to the Total field. If you disable the limit 
check, the keypad, downloaded and user Total 
f ield must lie within 0.1% and 150%. A sum of the 
new analysis must be within 99.5% and 100.5%.  

 This field displays only if you place a check mark 
in the Check Limits field.  

MOLE HI 
LIMITS 

Click to display a dialog box you use to define high 
mole percentage limit values for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note: See note in the description of the Mole Lo 

Limits field.  
Check 
Deviations 

Enables checking on the deviation from the last good 
analysis for each component. When you select this 
check box, the MOLE DEVN LIMITS button displays.  
Note: This field displays only if you select 

CHROMAT A as the chromatograph 
configuration type. 

MOLE DEVN 
LIMITS 

Click to display a dialog box you use to define the 
maximum deviation allowed for each gas component. 
Enter 0 in any field to prevent the test for the selected 
component.  
Note: This field displays only if you place a check 

mark in the Check Deviations field. 

3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.6.5 Gas Properties (Gas Ultrasonic) 
Gas Properties settings define methods the system uses to calculate 
viscosity, isentropic exponent (also known as “specific heat ratio” or 
“adiabatic exponent”), and the velocity of sound.    
These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within the specified 
limits. 
1. Select Gas Properties from the hierarchy menu. The Gas 

Properties screen displays.   



Config600 Configuration Software User Manual 

6-150 Stream Configuration Revised January 2023 

 

Figure 6-81. Gas Properties screen  

2. Complete the following fields.  
Field  Description 
Viscosity @ Tn Sets the reference viscosity for the gas. The default is 

0.010861. 
Note: Used only by VDI/VDE.  

Viscosity Tn Sets the reference viscosity temperature for the gas. 
The default is 15. 
Note: Used only by VDI/VDE. 

Sutherland 
Constant 

Sets the Sutherland constant for the gas. The default 
is 164. 
Note: Used only by VDI/VDE. 

Viscosity Calc 
Type  

Indicates the method for calculating the viscosity of the 
gas. Click  to display all valid values.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default. 

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires base 
density, N2, and CO2 inputs.  

 VDI/VDE 2040 
1987 

Uses calculations from VDI/VDE 
2040 Part 2 1987. Requires 
viscosity @Tn, viscosity Tn, and 
Sutherland Constant inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   
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Field  Description 
Isentropic 
Exponent 

Indicates the method for calculating the isentropic 
exponent of the gas. Click  to display all valid values.   

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.  

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.  

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.   

Speed of Sound Indicates the method for calculating the speed of 
sound. Click  to display all valid values.  

 AGA10 2003 Uses calculations from AGA10 
2003. Requires full gas composition 
input.  

 Disabled Value not calculated; defaults to 
keypad-entered value. This is the 
default.  

 GRI 1991 Uses calculations from GRI 1991. 
Requires full gas composition input.   

 SGERG GOST 
30139-2015 

Uses calculations from GOST 
30139-2015. Requires Base 
Density, N2 and CO2 inputs.   

 VNIC GOST 
30319-2015 

Uses calculations from GOST 
30319-2015. Requires full gas 
composition input.  

 
3. Click any of the following buttons to define gas property outputs or 

variables.   
Button  Description 
VISCOSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for viscosity. 

ISENTROPIC 
EXPONENT 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the isentropic exponent. 

VOS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound (VOS).  
Note:  AGA10 refers to VOS as “speed of sound.”  

LINE PRESS Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for line pressure.  
Note:  This button may be disabled on some 

applications.  
LINE TEMP Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for line temperature. 
Note: This button may be disabled on some 

applications.  
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Button  Description 
BASE DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for base density. 

INUSE 
COMPOSITION 

Click to display a read-only table of gas compositions. 
This corresponds to the table defined using the Gas 
Composition screen’s KEYPAD MOLES button.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 

6.6.6 Local Units 
This option allows you to override the global K-factor unit, since a gas 
application may have more than one type of meter, each using different 
K-factor units.  

1. Select Local Units from the hierarchy menu. The Local Units 
screen displays.  

 

Figure 6-82. Local Units screen  

2. Complete the following field.  
Field  Description 
K-Factor Units Indicates the type of units to use and override the 

system K-factor units of measurement. Click ▼ to 
display all valid values. The default is SYSTEM 
UNITS. 
Note:  If  you select System Units, the stream uses 

the global default value.  
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3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.6.7 Linearisation  
Linearisation settings define the constants and calculation limits for the 
meter factor and K factor. The S600+ calculates a meter factor 
corresponding to the frequency by interpolating the frequency between 
fixed points and then cross-referencing the result against a lookup 
table. Linearisation settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the meter 
factor are not within specified limits. 

Notes:  
 The linearisation curve for Gas Ultrasonic configurations uses 

frequency as the default input for Meter Factor calculations. The 
ability to change the default is available only with Config600 Pro 
software. 

 Batching systems that employ meter factor with retrospective meter 
factor assume that the adjusted value has a “keypad” mode. 

 To prevent the live metering system from applying a double 
correction, use either a calculated meter factor or a calculated K-
factor linearisation (that is, only one factor should have a 
calculated mode). 

1. Select Linearisation from the hierarchy menu. The Linearisation 
screen displays. 
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Figure 6-83. Linearisation screen  
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2. Complete the following field.  
Field  Description 
Meter Factors  Sets up to 10 flow rate and values for the meter 

corrector factors.  
 Flowrate/Freq Sets the flowrate and frequency for 

each of the meter correction factors.  
 Value Sets the corresponding values for 

each of the meter correction factors.  
M-FACTOR Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the respective factor. 

K-FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor. 

Meter Factor 
Method 

Selectable between METER FACTOR (values 
entered as normal) and ERROR PERCENT (Meter 
Factor entered as a percentage). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.6.8 Sampling 
Sampling defines the method and interval period for sampling product 
from a flowing pipeline. By default, Config600 supports one sampler 
per stream. Config600 uses the following stages during the sampling 
process:   

Stage Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl 
4 Post Pulse  
5 Stopped Manually 
6 Stopped Can Full 
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch 
12 Stopped initialise 
13 Can Switch Over 

Note:  Batch auto-resets the sampler at the start of the batch. 

5. Select Sampling from the hierarchy menu. The Sampling screen 
displays.  
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Figure 6-84. Stream Sampling screen 

6. Complete the following fields.   
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 

stream or station must have a unique sampler ID and 
must be greater than zero.   

Method  Indicates the sampling method. Click  to display all 
valid values.  

 TIME PROP Divides the value in the Can Fill 
Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a time interval 
per pulse. This is the default.  

 FLOW PROP1 Divides the value in the Volume 
f ield by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a volume 
throughput per pulse.  

 FLOW PROP2 Uses the value in the Volume field 
as the volume throughput per 
pulse.  

 FLOW PROP3 Uses the value in the Volume field 
as the volume throughput per 
pulse, but supports low pressure 
digital input and pump prime 
output.  
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Field  Description 
Mode Indicates the sampling mode. Click  to display all 

valid values. The S600+ uses Can 1 or Can 2.  
 SINGLE Acquire sample in one trial. This is 

the default.  
 DUAL Acquire samples in two trials.  

Note: If  you select Dual, the 
sampler switches to a 
second can when the 
current can is full 
(according to the two can 
switchover mode).  

Can Fill 
Indicator 

Indicates when the sampling can is full. Click  to 
display all valid values.   

 GRAB COUNT Uses the number of pulses output 
to the sampler to determine when 
the sample is full. This is the 
default. 

 DIG I/P Uses a digital input to determine 
when the sampler is full.  

 ANALOG I/P Uses an analog input to determine 
when the sampler is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select the appropriate 
check box to identify the specific event.   

 On Can Full Disables the sampling process 
when the can is full. This is the 
default. 

 On Flowrate 
Limit 

Disables the sampling process 
when the flowrate is less than the 
value of the Flowrate Low Limit. 

 On Flow Status Disables the sampling process 
when the flow status value is not 
on-line. 

Auto Restart Automatically restarts (if selected) sampling following 
an automatic disabling.  

Expected 
Volume/Mass 

Indicates, in cubic meters, the expected flow volume or 
mass of the sampling can. This is the value the Flow 
Prop1 and Flow Prop2 sampling methods use for 
calculations. The default is 1000.  

Can Fill Period Sets, in hours, the time required to fill the sampling 
can. The default is 24.  
Note: The Time Prop sampling method uses this 

value for its calculations.   
Flowrate Low 
Limit  

Indicates flowrate low limit used by the Auto Disable 
on Flowrate Limit option. The default is 0.   
Note:  This field is required if you select the On 

Flowrate Limit check box for Auto Disable.  
Minimum 
Interval  

Indicates, in seconds, the minimum amount of time 
between grabs. This is the value the Time Prop 
sampling method uses for its calculations. The default 
is 30.   
Note: If  the sample exceeds this limit, the system 

sets the overspeed alarm and increments the 
overspeed counter.   
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Field  Description 
Volumes 
 Can Volume Indicates, in cubic meters, the 

volume of the sampling can. The 
default is 0.5.   

 Grab Volume Indicates, in cubic meters, the 
volume of the sampling grab. 
The default is 0.001.   

Can Limits 
 Can Low Limit Indicates the low alarm value as 

a percentage of the can volume. 
The default is 5. 

 Can High Limit Indicates the high alarm value as 
a percentage of the can volume. 
The default is 90.   

 Can High High 
Limit 

Indicates the high high alarm 
value as a percentage of the can 
volume. The default is 95.   

Twin Can 
Changeover 
Mode  

Indicates whether the system automatically change to 
a second sampling can. Click  to display all valid 
values.  

 AUTO The sampler automatically 
changes over to the second can 
when the first is full. 

 MANUAL The sampler pauses sampling 
when the first can is full, and 
requires the operator to change 
the value of Can Selected before 
sampling continues on the 
second can. 
Note: 
 If  sampling is stopped 

because both cans are full, 
the Twin Can Changeover 
Mode is set to MANUAL by 
the system. The user must 
set back to AUTO if required. 

 The display for Twin Can 
Changeover must be 
manually added to the 
displays. 

 
7. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
8. Click Yes to apply your changes. The PCSetup screen displays.  

6.6.9 Ultrasonic Flow Setup  
The Ultrasonic flow meter settings define the primary inputs, 
calculation limits, and spool values for flowrate data received from a 
Daniel or an Instromet Q.Sonic ultrasonic meter.   

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results for the flowrates are not 
within specified limits.  
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1. Select Ultrasonic Flow Setup from the hierarchy menu. The 
Ultrasonic Flow Setup screen displays. 

 

Figure 6-85. Ultrasonic Flow Setup screen  

2. Click any of the following buttons to define primary inputs and 
calculation limits for the ultrasonic flow.   
Button  Description 
GAS VELOCITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for gas velocity. 

METER 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter density.  

METER TEMP Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter temperature.  

METER PRESS  Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter pressure.  

UVOL 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for uncorrected 
volume flowrate.  

REYNOLDS 
NUMBER 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the Reynolds 
Number.   
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Button  Description 
CTSM FOR 
SPOOL 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the correction factor for the effects of 
temperature on the spool.  

CPSM FOR 
SPOOL 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the correction factor for the effects of 
pressure on the spool.  

VEL CORRN 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for the velocity 
correction factor. 
Note: This value is used only for JuniorSonic 

meters.   
INUSE M-
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the in-use meter factor.   

 
3. Complete the following fields.  

Field  Description 
Velocity Indicates a velocity correction factor. Click  to display 

all valid values. The default is SET.   
Note: This velocity correction factor applies only to 

the JuniorSonic meters.  
Meter Factor Indicates a meter correction factor. Click  to display 

all valid values. The default is CLEAR.  
Note:  This velocity correction factor applies only to 

the JuniorSonic meters.  
Flow Rate 
Points 
(Forward MF) 

Sets up to 10 flow rate points for forward meter factor 
linearisation.   

Meter Factors 
(Forward MF) 

Sets up to 10 meter factor values for forward meter 
factor linearisation.  
Note: If  the Meter Factor Method is ERROR 

PERCENT, enter the meter factors as a 
percentage.   

VISCOSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for viscosity of the metered product.    

Youngs 
Modulus 

Sets the value for the Youngs Modulus of the meter 
spool. Default value is 220000000000.  

Spool Wall 
Roughness 

Sets the value for the roughness of the spool wall. 
Default is 1.6e-005.  

Flow Rate 
Points 
(Reverse MF) 

Sets up to 10 flow rate points for reverse meter factor 
linearisation.   

Meter Factors 
(Reverse MF) 

Sets up to 10 meter factor values for reverse meter 
factor linearisation.  
Note: If  the Meter Factor Method is ERROR 

PERCENT, enter the meter factors as a 
percentage.   
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Field  Description 
Forward 
Premium Limit 

In Premium Billing FLOW mode and Flow Direction 
FORWARD. sets a f lowrate limit above which the 
system increments forward premium totals 
whenever the f lowrate exceeds the keypad limit.  
In Premium Billing TOTAL mode and Flow Direction 
FORWARD, sets a total limit above which the system 
increments forward premium totals whenever the 
period total exceeds the keypad limit. The default is 
100.  

Reverse 
Premium Limit  

In Premium Billing FLOW mode and Flow Direction 
REVERSE, sets a flowrate limit above which the 
system increments reverse premium totals 
whenever the f lowrate exceeds the keypad limit. 
 
In Premium Billing TOTAL mode and Flow Direction 
REVERSE, sets a total limit above which the system 
increments reverse premium totals whenever the 
period total exceeds the keypad limit. The default is 
100. 

Premium 
Billing Mode 

Indicates the premium total mode, in which the system 
increments premium totals at the end of the hour only if 
the hourly total exceeds the keypad limit. Click ▼ to 
display all valid values. 

 FLOW In Premium Billing Flow  mode, the 
system increments premium totals 
whenever the flowrate exceeds the 
keypad limit. This is the default. 

 TOTAL In Premium Billing Total mode, the 
system increments premium totals 
whenever the period total exceeds 
the keypad limit. 

Meter Factor 
Method  

Indicates the method used to linearise the meter factor. 
Click  to display all valid values.  

 ERROR 
PERCENT 

Interpolate between the two 
nearest percentage error values in 
the linearisation table.   

 METER 
FACTOR 

Interpolate between the two 
nearest Meter Factors in the 
linearisation table. This is the 
default.  

FlowSource Indicates the source for generating flowtotals. Possible 
options are: 

 SERIAL Use the serial communication link. 
This is the default. 

 PULSE I/P Use the pulse input. 
SERIAL + 
PULSE I/P 

Use the serial communications link 
as default and switch to the pulse 
input if a fault is detected. 
Note: This option requires both a 

serial interface and pulse 
input to be configured. 

Auto Switch to 
Serial 

If  selected, the S600+ will revert to using serial 
communications once available. 
Note: This option is available only if you select 

SERIAL + PULSE I/P in the Flow Source. 
Internal Sets the internal diameter of the spool for calibration 

calculations. The default is 300. 
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Field  Description 
External Sets the external diameter of the spool for calibration 

calculations. The default is 310. 
Pressure 
(Spool 
Calibration) 

Sets the spool pressure for calibration calculations. 
The default is 15. 

Temperature 
(Spool 
Calibration) 

Sets the spool temperature for calibration calculations. 
The default is 20. 

Pressure 
(Spool 
Exponent)  

Sets the exponent coefficients for pressure 
calculations. The default is 5e-005. 
Note: This field is not used in Daniel calculations.  

Temperature 
(Spool 
Exponent)  

Sets the temperature coefficients for pressure 
calculations. The default is 6e-005. 

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 

6.6.10 Ultrasonic Control  
The Ultrasonic Control settings define the input parameters and 
calculation limits for interfacing to the Daniel Gas ultrasonic meter.  
These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within specified limits.  
1. Select Ultrasonic Control from the hierarchy menu. The 

Ultrasonic Control screen displays.  

 

Figure 6-86. Ultrasonic Control screen  

2. Complete the following fields.  
Field  Description 
Modbus Sets, in seconds, the amount of time the system waits 
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Field  Description 
Timeout before triggering a Modbus timeout. The default is 30.    

Note: If  a timeout occurs, the system sets the gas 
velocity to zero (0) and raises a timeout alarm.   

 
3. Click any of the following buttons to define input parameters and 

calculation limits for the ultrasonic flow.   
Button  Description 
Ultrasonic 
Comms 

Click to display the Comms screen in the I/O Setup 
screen, and focuses on the Daniel USonic link comm 
settings. 

GAS 
VELOCITY 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for gas velocity.  

Calc Type Sets which calculations the system uses with ultrasonic 
meters. Click to display all valid calculations. 

 Daniel 
Equations 

Use Daniel equations for ultrasonic 
meter calculations. 

 ISO17089 
Equations 

Use ISO 17089-1 Annex E (correction 
of  meter geometry for ultrasonic meter 
calculations). 

Transducer 
Separation 

Enter the distance, in millimeters, between the first and 
second transducer. 
Note: 
 This field displays only in you select ISO17089 

Equations in the Calc Type field. 
 Enter the average of the transducer separations. 

Number of 
Bounces 

Enter the number of reflections in the path between 
transducers. 
Set to 0 (For Daniel USM) 
Note: This field displays only in you select ISO17089 

Equations in the Calc Type field. 
Distance 
Between the 
Flanges 

Enter the distance, in millimeters, between the inlet and 
outlet flanges of the meter body. 
Note: This field displays only in you select ISO17089 

Equations in the Calc Type field. 
Poisson Ratio Sets the Poisson’s Ratio value of the pipe. The default 

is 0.3. 
Note: This field displays only in you select ISO17089 

Equations in the Calc Type field. 
VELOCITY OF 
SOUND 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for the velocity of sound. 

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays.  

6.6.11 QSonic Interface 
The QSonic Interface control settings define the input parameters and 
calculation limits for the interface to the QSonic ultrasonic meter.   
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These settings allow you to define alarms. The system activates these 
alarms when the calculated results for the gas velocity are not within 
specified limits.  

1. Select QSonic Interface from the hierarchy menu. The QSonic 
Interface screen displays. 

 

Figure 6-87. Qsonic Flow Setup screen  

2. Complete the following fields to set up QSonic values.   
Button  Description 
Comms port Indicates the communication port to receive the 

QSonic information. Click  to display all valid values. 
The default is PORT 5.  

QSonic Comms Displays the Comms Link screen, which you use to 
define the QSonic Link (see Chapter 4, Section 4.10).   

3. Click any of the following buttons to define QSonic alarm limits.   
Field  Description 
VELOCITY OF 
SOUND 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and specific alarm 
limits for the velocity of sound.   

GAS VELOCITY Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and specific alarm 
limits for the gas velocity.   

PRESS Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and specific alarm 
limits for pressure.  

TEMP Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and specific alarm 
limits for temperature.   

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
5. Click Yes to apply your changes. The PCSetup screen displays. 

6.6.12 SICK Control  
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The SICK Control settings define the primary inputs, calculations 
limits, and spool values for flowrate data received from the SICK 
ultrasonic meter.  

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results are not within specified limits.  

1. Select Sick Control from the hierarchy menu. The Sick Control 
screen displays.   

 

Figure 6-88. SICK Control screen  

2. Click any of the following buttons to define alarm limits for the 
ultrasonic flow.  
Button  Description 
GAS VELOCITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for gas velocity.   

VELOCITY OF 
SOUND 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the velocity of sound.   

UVOL 
FLOWRATE 

Click to display a Calculation Result dialog box you 
use to define the specific alarm limits for uncorrected 
volume flowrate. 

INUSE 
MFACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the in-use Meter factor. 

 
3. Complete the following fields.   

Field  Description 
Modbus 
Timeout 

Sets, in seconds, the amount of time the S600+ 
waits before triggering a Modbus timeout. The 
default is 30. 

SICK COMMS Click to display the Comm screen in I/O Setup.  
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Field  Description 
Forward MF 

Flow Rate 
Points 

Sets up to 10 flow rate points for forward meter 
factor linearisation 

Meter Factors Sets up to 10 meter factor values for forward 
Meter Factor linearisation. 
Note:  If  the Meter Factor Method is ERROR 

PERCENT, enter the meter factors as 
percentages. 

Reverse MF 
Flow Rate 

Points 
Sets up to 10 flow rate points for reverse meter 
factor linearisation. 

Meter Factors Sets up to 10 meter factor values for reverse 
meter factor linearisation. 
Note:  If  the Meter Factor Method is ERROR 

PERCENT, enter the meter factors as 
percentages. 

Forward 
Premium Limit 

In Premium Billing FLOW mode and Flow 
Direction FORWARD. sets a f lowrate limit 
above which the system increments forward 
premium totals whenever the flowrate exceeds 
the keypad limit. 
In Premium Billing TOTAL mode and Flow 
Direction FORWARD, sets a total limit above 
which the system increments forward premium 
totals whenever the period total exceeds the 
keypad limit. The default is 100. 

Reverse 
Premium Limit 

In Premium Billing FLOW mode and Flow 
Direction REVERSE, sets a f lowrate limit 
above which the system increments reverse 
premium totals whenever the flowrate exceeds 
the keypad limit.  
In Premium Billing TOTAL mode and Flow 
Direction REVERSE, sets a total limit above 
which the system increments reverse premium 
totals whenever the period total exceeds the 
keypad limit. The default is 100. 

Premium Billing 
Mode 

Indicates the premium total mode, in which the 
system increments premium totals at the end of 
the hour only if the hourly total exceeds the 
keypad limit. Click ▼ to display all valid values. 

 FLOW In Premium Billing Flow  
mode, the system increments 
premium totals whenever the 
f lowrate exceeds the keypad 
limit. This is the default. 

 TOTAL In Premium Billing Total mode, 
the system increments 
premium totals whenever the 
period total exceeds the 
keypad limit. 

Meter Factor 
Method 

Indicates the method used to calculate meter 
factor. Click ▼ to display all valid values. 

 METER 
FACTOR 

Interpolate between the two 
nearest meter factors in the 
linearisation table. This is the 
default.  

 ERROR 
PERCENT 

Interpolate between the two 
nearest percentage error 
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Field  Description 
values in the linearisation table 

Limit Flow Cut 
Off Limit 

Sets a low flow value at which point the meter 
sets the output flowrate to zero. 

Flow Source Indicates the source for generating flow totals. 
 SERIAL Use the serial 

communications link. This is 
the default. 

 PULSE I/P Use the pulse input. 
SERIAL + 
PULSE I/P 

Use the serial 
communications link as 
default and switch to the pulse 
input if  a fault is detected. 
Note: This option requires 

both a serial interface 
and pulse input to be 
conf igured. 

Auto Switch to 
Serial 

If  selected, the S600+ will revert to using serial 
communications once available. 
Note: This option is available only if you select 

SERIAL + PULSE I/P in the Flow 
Source. 

4. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

5. Click Yes to apply your changes. The PCSetup screen displays. 

6.7 Liquid – Coriolis  
These stream settings are specific to liquid applications using a 
Coriolis meter. When you initially create a configuration, the 
calculation selections you make determine which calculation-specific 
screens appear in the hierarchy menu.  
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings. 
 

6.7.1 Local Units 
This option allows you to override the global K-factor unit, since a 
liquid application may have more than one type of meter, each using 
different K-factor units.  
1. Select Local Units from the hierarchy menu. The Local Units 

screen displays.  
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Figure 6-89. Local Units screen  

2. Complete the following field.  
Field  Description 
K-Factor Units Indicates the type of units to use and override the 

system K-factor units of measurement. Click ▼ to 
display all valid values. The default is SYSTEM 
UNITS. 
Note:  If  you select System Units, the stream uses 

the global default value.  
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.7.2 Linearisation  
Linearisation settings define the constants and calculation limits for the 
meter factor and K factor. The S600+ calculates a meter factor 
corresponding to the frequency by interpolating the frequency between 
fixed points and then cross-referencing the result against a lookup 
table. Linearisation settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the Meter 
Factor is not within specified limits.  

Notes:  
 The linearisation curve for Liquid Coriolis configurations uses 

Mass Flow Rate as the default input for Meter Factor calculations. 
The ability to change the default is available only with Config600 
Pro software. 
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 Batching systems that employ meter factor linearisation with 
retrospective meter factor adjustments assume that the adjusted 
value has a “keypad” mode. 

 To prevent the live metering system from applying a double 
correction, use either a calculated meter factor or a calculated K-
factor linearisation (that is, only one factor should have a 
calculated mode). 

1. Select Linearisation from the hierarchy menu. The Linearisation 
screen displays. 

 

Figure 6-90. Linearisation screen  
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2. Complete the following fields.  
Field  Description 
Meter Factors  Sets up to 20 flow rate and values for the meter 

correction factors. 
 Flowrate/Freq Set the flowrate and frequency for 

each of the meter correction factors. 
 Value Set the corresponding values for 

each of the meter factors. 
METER 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor.   

K- FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor.   

Product Table It allows the selection of the “default” Product Table 
(the in-use functionality) and the 16 other Product 
Tables in order to set up to 10 flow rates and values 
for the meter correction factors and K-factors for each 
product type. When you select a specific product, the 
meter factors and K-factors update accordingly. 
Note:   This field displays only if you enable the 

Product Table when you create the 
configuration. 

Aramco Aramco-style linearisation is identical to normal 
linearisation, but is only used to generate the first 
meter factor – subsequent meter factors are 
generated from proving. 
Notes:      
 Ignore the fields in the Aramco frame unless 

directed by technical support. 
 You must select Product Table with History when 

you create your configuration in order to use the 
Prover MF Deviation Check stage. 

 Normal Flow 
Rate 

Set to zero for standard 
linearisation. Set to non-zero only 
for Aramco-style linearisation. 
Note:  For Aramco-style 

linearisation only, the Initial 
Meter Factor is calculated 
f rom the linearisation curve 
and the Normal Flow Rate. 
This Initial Meter Factor is 
then used in the subsequent 
proving functionality. 

 Date of Initial 
Base Meter 
Factor 

Set the time stamp of the initial base 
meter factor. 
Note:  This field displays only if you 

enable the Product Table 
with History when you 
create the configuration. 

Meter Factor 
Method 

Selectable between METER FACTOR (values entered 
as normal) and ERROR PERCENT (Meter Factor 
entered as a percentage). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 
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6.7.3 Sampling  
Sampling settings define the method and interval period for sampling 
product from a flowing pipeline. By default, the S600+ supports one 
sampler per stream. If you require more than one sampler per stream, 
contact Technical Support personnel.   Config600 uses the following 
stages during the sampling process:  

Stage Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl 
4 Post Pulse  
5 Stopped Manually 
6 Stopped Can Full 
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch 
12 Stopped initialise 
13 Can Switch Over 

 
Note:  Batch auto-resets the sampler at the start of the batch. 

1. Select Sampling from the hierarchy menu. The Sampling screen 
displays.  

 

Figure 6-91. Sampling screen  

2. Complete the following fields.   
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 
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Field  Description 
stream or station must have a unique sampler ID.  

Method  Indicates the sampling method. Click  to display all 
valid values.   

 TIME PROP Divides the value in the Can Fill 
Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a time interval 
per pulse. This is the default.  

 FLOW PROP1 Divides the value in the Volume 
f ield by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a volume 
throughput per pulse.  

 FLOW PROP2 Uses the value in the Volume field 
as the volume throughput per 
pulse.  

 FLOW PROP3 Uses the value in the Volume field 
as the volume throughput per 
pulse, but supports low pressure 
digital input and pump prime 
output.   

Mode Indicates the sampling mode. Click  to display all 
valid values. The default is SINGLE.  

Can Fill 
Indicator 

Indicates how the S600+ determines when the 
sampling can is full. Click  to display all valid values. 
The default is GRAB COUNT.  

 GRAB COUNT Uses the number of pulses output 
during the sample to determine 
when the can is full.  

 DIG I/P Uses a digital input to determine 
when the can is full.  

 ANALOG I/P Uses an analog input to determine 
when the can is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select the appropriate 
check box to identify the specific event.  

Auto Restart Indicates whether the system automatically restarts 
sampling after automatically disabling sampling.  

Expected 
Volume/Mass 

Sets the volume or mass of the sampling can. The 
default is 1000. 

Can Fill Period Sets, in hours, the time required to fill the sampling 
can. The default is 24. 
Note:  This field is required for the TIME PROP 

sampling method.  
Flowrate Low 
Limit  

Sets the volume at which automatic disabling occurs. 
The default is 0. 
Note:  This field is required if you select the On 

Flowrate Limit check box for Auto Disable.  
Minimum 
Interval  

Sets the minimum interval, in seconds, for sampling. 
The default is 30. 
Note:  If  the sample exceeds this limit, the system 

sets the overspeed alarm and increments the 
overspeed counter.  

Can Volume  Sets the volume of the sampling can. The default is 
0.5. 
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Field  Description 
Grab Volume  Sets the volume of each sampling grab. The default is 

0.001. 
Can Low Limit  Sets the low limit alarm as a percentage of the Can 

Volume. The default is 5. 
Cam High Limit  Sets the high limit alarm as a percentage of the Can 

Volume. The default is 90. 
Can High High 
Limit  

Sets the high high alarm as a percentage of the Can 
Volume. The default is 95. 

Twin Can 
Changeover 
Mode  

Indicates the changeover method for twin can 
sampling. Click  to display all valid values.  
AUTO The sampler automatically 

changes over to the second can 
when the first is full. 

MANUAL The sampler pauses sampling 
when the first can is full and 
requires the operator to change 
the value of Can Selected before 
sampling continues on the 
second can. 
Note: 
 If  sampling is stopped 

because both cans are full, 
the Twin Can Changeover 
Mode is set to MANUAL by 
the system. The user must 
set back to AUTO if required. 

 The display for Twin Can 
Changeover must be 
manually added to the 
displays. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
4. Click Yes to apply your changes. The PCSetup screen displays.  

6.7.4 Observed Density Correction  
This option enables you to determine base density from measured 
density. You can include density measurement from a densitometer or 
from the Coriolis meter, as your needs demand.  

You configure the Observed Density Correction according to the 
densitometer location options you select at the station and stream when 
you initially build the configuration. If you select the Use Standard 
Density stream option then the observed density screen does not 
display.  

A Coriolis meter can measure density and so you may read density 
from the Coriolis or density from a densitometer. SEL TO BASE is 
only available for Coriolis applications. 

The system uses base density, coordinated with the standard density 
correction, to calculate correction values for the temperature of the 
liquid at the meter (CTLm) and the pressure of the liquid at the meter 
(CPLm). The system then uses the CTLm and CPLm values to correct 
the metered volume to reference conditions.   
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Note: Depending on the configuration, you may need to define both 
densitometer values (DT TO BASE) and selected meter 
densities (SEL TO BASE) options. Although the following 
screen examples do not show these options, descriptions of 
these options (which occur in the Calculation Results and Live 
Inputs buttons) are included in the field descriptions.  

1. Select Observed Density Correction from the hierarchy menu. 

2. Select the appropriate component of Observed Density Correction 
(DT TO BASE or SEL TO BASE) from the hierarchy menu, if 
necessary. The Observed Density Correction screen displays.  

 

 

Figure 6-92. Observed Density Correction screens  
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3. Complete the following fields.   
Field  Description 
Density Table 
Units 

Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display all 
valid values.  

 CH. 11 
2004/7 CUST 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 
2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 DEG API Use degrees API.  
 KG/M3 Use kilograms per cubic meter. This is 

the default.  
 S.G. Use specific gravity.  
 KG/M3 Use kilograms per cubic meter. This is 

the default.  
 NORSOK 

I-105 
Use Norsok I-105 Appendix D density 
correction.   

Iteration Type Indicates the iteration type for the density correction 
calculations. Valid values are ASTM (use the iterative 
temperature and pressure correction as defined by 
ASTM/API, Chapter 12) or IP2 (use the iterative 
temperature and pressure correction as defined in IP 2 
[ISO 91-1]). The default is ASTM.  

Hydrometer 
Correction  

Indicates whether the S600+ applies hydrometer 
correction values to the calculation. Valid values are 
YES and NO; the default is NO.  

Product Type Indicates the type of petroleum product involved in the 
calculation. Click  to display all valid values. The 
default is A CRUDE.  

 A CRUDE  Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5A and 6A. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 B REFINED Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
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Field  Description 
1988 Tables 59B and 60B. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23B and 24B. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5B and 6B. 
If  CH.11 2004/7 = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 C SPECIAL Selection is based on the value in 
the Density Table Units field:  
If  KG/M3 =, Petroleum 
Measurement Tables 1980 Table 
54C. 
If   SG =,Petroleum Measurement 
Tables 1980 Tables 23C and 24C. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5C and 6C. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
Note:  Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D. 
If  SG = Petroleum Measurement 
Tables 1982 Tables 23D and 24D. 
If  DEG API = Petroleum 
Measurement Tables 1982 Tables 
5D and 6D. 
If  CH.11 2004/7, Cust API = MPMS 
Chapter 11 2004. 
If  CH.11 2004/7 = API MPMS Chapter 
11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM-IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 
54. 
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Field  Description 
Note:   The output is based on the 

relevant formula or look up 
tables dependent on the 
density input. 

 TABLE 
LOOKUP 

S600+ reads values from a file in the 
Config600 3.0/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The default files hold 
values for the ASTM-IP Petroleum 
Measurement Tables 1952 Tables 5 
and 6. 

 USER K0K1 Selection is based on the value in 
the Density Table Units field:  
If  KG/ = Petroleum Measurement 
Tables 1980 Tables 53A and 54A 
with user entered values for K0 and 
K1. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A 
with user entered values for K0 and 
K1. 
If  DEG API = Petroleum Measurement 
Tables 1980 Tables 5A and 6A with 
user entered values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-95 

ASTM D1555-95 Table lookup. 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555M-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555M-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 

CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses. 
Click  to display all valid values.  
Note:  This field does not display if you select CH.11 

2004 CUST or CH.11 2004 METRIC as the 
Density Table Units or one of the Gazprom 
options as Product Type because these 
standards also specify the CPL calculation.  

 OFF No CPL calculation.  
 API121 Use API MPMS Ch.11.2.1 1984. 
 API1121M Use API MPMS Ch. 11.2.1M 1984. 

This is the default.  
 API122 Use API MPMS Ch.11.2.2 1986 
 API122M Use API MPMS Ch.11.2.2M 1986 
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Field  Description 
 CONSTANT Use a value you enter.  
 DOWNER Use calculations specified in L. 

Downer’s 1979 paper  Generation of 
New Compressibility Tables for 
International Use  

Rounding Indicates whether the S600+ rounds the calculation 
results. Click  to display all valid values. 

 OFF No rounding occurs. This is the 
default.  

 NATIVE Round to the rules specified in the 
selected calculation standard.  

 API Ch.12.2 
Part 2 

Round in accordance with API MPMS 
Ch.12.2 Part 2 – Measurement 
Tickets 1995 

 API Ch.12.2 
Part 3 

Round in accordance with API MPMS 
Ch.12.2 Part 3 – Proving Reports 
1998 

 Flocheck Round in accordance with Emerson 
Flowcheck verification software 
package  

 ASTM 
D1250-04 
Ch.11 

Round in accordance with API MPMS 
Ch.11.1 2004 (ASTM D1250-04) 
method to round to the Petroleum 
Measurement Table 1980 Tables 

 DECC 1980 DTI/DECC requirements for 
Petroleum Measurement Tables 1980 
Tables. No rounding occurs and an 
iteration tolerance of 0.0001. 

Reference 
Temp 

Indicates, in degrees Centigrade, the reference 
temperature for the correction calculations. The default 
is 15 degrees C.  

Alpha Sets the coefficient of thermal expansion. The default is 
0.  

FFactor Sets the compressibility factor for the liquid (also 
known as the beta factor). The default is 0. 

PE Calculation Sets the option to calculate the fluid’s Equilibrium 
Vapour Pressure. While this is normally assumed to be 
0, you can use it for natural gas liquids (NGL) and 
similar applications. Click  to display all valid values. 

 OFF Do not calculate PE value. This 
is the default.  

 GPA TP-15 1988 
Equation 2 

Use the GPA TP-15 1988 
Equation 2 

 GPA TP-15 2003 
Equation 2 

Use the GPA TP-15 2003 
Equation 2 

 GPA TP-15 1988 
Equation 3 

Use the GPA TP-15 1988 
Equation 3 

 GPA TP-15 2003 
Equation 3 

Use the GPA TP-15 2003 
Equation 3 

Aromatics 
Type 

Sets the type of aromatics product.  Click  to display 
all valid values. The default is Benzene.  

Aromatics CCF Sets the method for calculating a combined corrector 
factory (CCF) for aromatics products. Valid values are 
Density (calculate using a density you enter) or Table 
1 (calculate use a density from an embedded table).  
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Table 6-1. Observed Density Correction Product Selection 

 Product Type 
Density 
Units 

ASTM-IP  
1952 

A  
Crude 

B  
Refined 

C  
Special 

D 
Lube Oils 

Light 
1986 

Light 
TP25 

Light 
TP27 

Table 
Lookup 

User  
K0 K1 

DEG API ASTM 
D1250 
(1952) 
Table 5 

ASTM 
D1250-80 
Table 5A 

ASTM  
D1250-80 
Table 5B 

n/a ASTM 
D1250-80 
Table 5D 

n/a n/a n/a User 
lookup 
table 

ASTM 
D1250-80 
Table 5A/ 

User 
K0,K1 

S.G. ASTM 
D1250 
(1952) 

Table 23 

ASTM 
D1250-80 
Table 23A 

ASTM  
D1250-80 
Table 23B 

n/a ASTM 
D1250-80 
Table 23D 

n/a GPA TP-
25/ 1988 

Table 23E 

GPA TP-
27 Table 

23E 

User 
lookup 
table 

ASTM 
D1250-80 

Table 
23A/ User 

K0,K1 
KG/M3 ASTM 

D1250 
(1952) 

Table 53 

ASTM 
D1250-80 
Table 53A 
IP Paper 3 

(1988) 
Table 59A 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 53B 
IP Paper 3 

(1988) 
Table 59B 

(20’C 
Reference 

Temp) 

n/a ASTM 
D1250-80 
Table 53D 
IP Paper 3 

(1988) 
Table 59D 

(20’C 
Reference 

Temp) 

ASTM–IP-
API 

Petroleum 
Measurement 

tables for 
light 

hydrocarbon 
liquids 1986 

n/a GPA TP-
27 Table 

53E 
GPA TP-
27 Table 

59E (20’C 
Reference 

Temp) 

User 
lookup 
table 

ASTM 
D1250-80 

Table 
53A/ User 

K0,K1 

CH. 11 
2004/7 
CUST 

n/a ASTM 
D1250-04 

ASTM  
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

CH. 11 
2004/7 
METRIC 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

NORSOK 
I-105 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-

04 

ASTM 
D1250-04 

4. Click any of the following buttons to define calculation results for 
the observed density correction calculations.   
Button  Description 
BASE DEN 
FROM MTR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for base density. 
Note:  The label on this button changes depending 

on the configuration.  
BASE DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for base density. 
Note:  The label on this button changes depending 

on the configuration.  
BASE DENS 
(DT) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for base density. 
Note:  This button displays only if you select the 

densitometer (DT TO BASE) stream 
component.   

BASE DENS 
(SEL) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for base density. 
Note:  This button displays only if you select th meter 

(SEL TO BASE) stream component.  
METER CTL Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of the 
liquid at the meter (CTLm).  
Note:  The label on this button changes depending 

on the configuration.   
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Button  Description 
METER CTL 
(SEL)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of the 
liquid at the meter (CTLm).  
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component.   
METER CCF Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the combined correction factor at the 
meter (CCFm).  
Note:  The label on this button changes depending 

on the configuration   
METER CCF 
(SEL) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the combined correction factor at the 
meter (CCFm).  
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component. 
METER CPL Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for the correction of the pressure of the 
liquid at the meter (CPLm).  
Note:  The label on this button changes depending 

on the configuration. 
METER CPL 
(SEL)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the correction of the pressure of the 
liquid at the meter (CPLm).  
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component. 
 
5. Click any of the following buttons to define live inputs for the 

observed density correction calculations: 
Button  Description 
MTR DENSITY Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for meter density.  
Note:  The label on this button changes depending 

on the configuration.  
OBS DENS (DT) Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for observed density.  
Note:  This button displays only if you select the 

densitometer (DT TO BASE) stream 
component. 

MTR DENS 
(SEL)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter density.  
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component.  
MTR TEMP   Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for meter temperature.  
Note:  The label on this button changes depending 

on the configuration. 



Config600 Configuration Software User Manual 

Revised January 2023 Stream Configuration 6-181 

Button  Description 
OBS TEMP (DT)  Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for observed temperature.  
Note:  This button displays only if you select the 

densitometer (DT TO BASE) stream 
component. 

MTR TEMP 
(SEL)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter temperature.   
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component. 
MTR PRESS  Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for meter pressure.   
Note:  The label on this button changes depending 

on the configuration. 
OBS PRESS 
(DT)  

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for observed pressure.  
Note:  This button displays only if you select the 

densitometer (DT TO BASE) stream 
component. 

MTR PRESS 
(SEL) 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for meter pressure.   
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component. 
MTR Pe   Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for equilibrium vapour pressure (Pe).   
Note:  The label on this button changes depending 

on the configuration. 
Pe Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for observed equilibrium vapour pressure 
(Pe).   
Note:  The label on this button changes depending 

on the configuration. 
Pe (DT)  Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for observed equilibrium vapour pressure 
(Pe).  
Note:  This button displays only if you select the 

densitometer (DT TO BASE) stream 
component. 

 
6. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

7. Click Yes to apply your changes. The PCSetup screen displays.  
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6.7.5 Standard Density Correction  
This calculation enables you to use base density to determine the 
factors for the correction for temperature of the liquid at the meter 
(CTLm) and the correction for the pressure of the liquid at the meter 
(CPLm). The system then uses the CTLm and CPLm values to correct 
the metered volume to reference conditions.  

1. Select Standard Density Correction from the hierarchy menu. 
The Standard Density Correction screen displays.  

 

 

Figure 6-93. Standard Density Correction screens  

2. Complete the following fields.   
Field  Description 
Density Table 
Units 

Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display all 
valid values.  

 CH. 11 2004/7 
CUST 

Use API MPMS Ch. 11.1 2004, 
Addendum 1, 2007 Imperial units.  
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Field  Description 
 CH. 11 2004/7 

METRIC 
Use API MPMS Ch. 11.1 2004, 
Addendum 1, 2007 Metric Units 

 DEG.API  Use degrees API.  
 KG/M3  Use kilograms per cubic meter. This 

is the default.  
 S.G. Use specific gravity.  
 NORSOK 

I-105 
Use Norsok I-105 Appendix D 
density correction.  

 Note: See Table 6-2 for product selection.  
Product Type Indicates the type of petroleum product involved in the 

calculation. Click  to display all valid values. The 
default is A CRUDE. 

 A CRUDE  Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5A and 6A. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 B REFINED Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59B and 60B. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23B and 24B. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5B and 6B. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
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Field  Description 
 C SPECIAL Selection is based on the value in 

the Density Table Units field:  
If  KG/M3 = Petroleum 
Measurement Tables 1980 Table 
54C. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23C and 24C. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5C and 6C. 
If  CH.11 2004/7 Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/, Metric = API MPMS 
Chapter 11 2004. 
Note:  Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D.  
If  SG = Petroleum Measurement 
Tables 1982 Tables 23D and 24D. 
If  DEG API = Petroleum 
Measurement Tables 1982 Tables 
5D and 6D. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM-IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 
54. 
Note:   The output is based on the 

relevant formula or look up 
tables dependent on the 
density input. 
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Field  Description 
 TABLE 

LOOKUP 
S600+ reads values from a file in the 
Config600 3.0/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The default files hold 
values for the ASTM-IP Petroleum 
Measurement Tables 1952 Tables 5 
and 6. 

 USER K0K1 Selection is based on the value in 
the Density Table Units field:  
If  KG/M3 = Petroleum 
Measurement Tables 1980 Tables 
53A and 54A with user entered 
values for K0 and K1. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A 
with user entered values for K0 and 
K1. 
If  DEG API = Petroleum Measurement 
Tables 1980 Tables 5A and 6A with 
user entered values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATIC
S D1555M-
95 

ASTM D1555-95 Table lookup. 

 AROMATIC
S D1555M-
00 

ASTM D1555M-00 Table Lookup. 

 AROMATIC
S D1555M-
04A 

ASTM D1555-04a Calculation. 

 AROMATIC
S D1555M-
08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 

CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses. 
Click  to display all valid values.  
Note: This field does not display if you select CH.11 

2004 CUST or CH.11 2004 METRIC as the 
Density Table Units or one of the Gazprom 
options as Product Type because these 
standards also specify the CPL calculation. 

 OFF No CPL calculation.  
 API121 Use API MPMS Ch.11.2.1 1984. 
 API1121M Use API MPMS Ch. 11.2.1M 1984. 

This is the default.  
 API122 Use API MPMS Ch.11.2.2 1986 
 API122M Use API MPMS Ch.11.2.2M 1986 
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Field  Description 
 CONSTANT Use a value you enter.  
 DOWNER Use calculations specified in L. 

Downer’s 1979 paper  Generation of 
New Compressibility Tables for 
International Use  

Rounding Indicates whether the S600+ rounds the calculation 
results. Click  to display all valid values.  

 OFF No rounding occurs. This is the 
default.  

 NATIVE Round to the rules specified in the 
selected calculation standard.  

 API Ch.12.2 
Part 2 

Round in accordance with API MPMS 
Ch.12.2 Part 2 – Measurement 
Tickets 1995 

 API Ch.12.2 
Part 3 

Round in accordance with API MPMS 
Ch.12.2 Part 3 – Proving Reports 
1998 

 Flocheckl Round in accordance with Emerson 
Flocheck verification software 
package  

 ASTM 
D1250-04 
Ch.11 

Round in accordance with API MPMS 
Ch.11.1 2004 (ASTM D1250-04) 
method to round to the Petroleum 
Measurement Table 1980 Tables 

 DECC 1980 DTI/DECC requirements for 
Petroleum Measurement Tables 1980 
Tables. No rounding occurs and an 
iteration tolerance of 0.0001. 

Reference 
Temp 

Sets, in degrees Centigrade, the reference 
temperature for the correction calculations. The default 
is 15 degrees C.  

Alpha Sets the coefficient of thermal expansion. The default 
is 0. 

FFactor Sets the compressibility factor for the liquid (also 
known as the beta factor). The default is 0. 

PE Calculation Sets the option to calculate the fluid’s Equilibrium 
Vapour Pressure. While this is normally assumed to be 
0, you can use it for natural gas liquids (NGL) and 
similar applications. Click  to display all valid values. 

 OFF Do not calculate PE value. This 
is the default.  

 GPA TP-15 1988 
Equation 2 

Use the GPA TP-15 1988 
Equation 2 

 GPA TP-15 2003 
Equation 2 

Use the GPA TP-15 2003 
Equation 2 

 GPA TP-15 1988 
Equation 3 

Use the GPA TP-15 1988 
Equation 3 

 GPA TP-15 2003 
Equation 3 

Use the GPA TP-15 2003 
Equation 3 

BASE DENSITY Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for base density.  
Note: The label on this button changes depending 

on the configuration.  
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Field  Description 
BASE DENS 
(DT) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for base density.  
Note: This button displays only if you select the 

density to stream option.  

Table 6-2. Standard Density Correction Product Selection 
 Product Type 
Density 
Units 

ASTM-IP  
1952 

A  
Crude 

B  
Refined 

C  
Special 

D 
Lube Oils 

Light 
1986 

Light 
TP25 

Light 
TP27 

Table 
Lookup 

User  
K0 K1 

DEG API ASTM 
D1250 
(1952) 
Table 6 

ASTM 
D1250-80 
Table 6A 

ASTM  
D1250-80 
Table 6B 

ASTM  
D1250-80 
Table 6C 

ASTM 
D1250-80 
Table 6D 

n/a n/a n/a User 
lookup 
table 

ASTM 
D1250-80 
Table 6A/ 

User 
K0,K1 

S.G. ASTM 
D1250 
(1952) 

Table 24 

ASTM 
D1250-80 
Table 24A 

ASTM  
D1250-80 
Table 24B 

ASTM  
D1250-80 
Table 24C 

ASTM 
D1250-80 
Table 24D 

n/a GPA TP-
25/ 1988 

Table 24E 

GPA TP-
27 Table 

24E 

User 
lookup 
table 

ASTM 
D1250-80 
Table 24A/ 

User 
K0,K1 

KG/M3 ASTM 
D1250 
(1952) 

Table 54 

ASTM 
D1250-80 
Table 54A 
IP Paper 3 

(1988) 
Table 60A 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 54B 
IP Paper 3 

(1988) 
Table 60B 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 54C 

ASTM 
D1250-80 
Table 54D 
IP Paper 3 

(1988) 
Table 60D 

(20’C 
Reference 

Temp) 

ASTM–IP-
API 

Petroleum 
Measure 

ment 
tables for 

light 
hydrocarb
on liquids 

1986 

n/a GPA TP-
27 Table 

54E 
GPA TP-
27 Table 

60E (20’C 
Reference 

Temp) 

User 
lookup 
table 

ASTM 
D1250-80 
Table 54A/ 

User 
K0,K1 

CH. 11 
2004/7 
CUST 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

CH. 11 
2004/7 
Metric 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

NORSOK 
I-105 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

3. Click any of the following buttons to define live inputs for the 
density correction calculation:   
Button  Description 
MTR TEMP  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of 
the liquid at the meter (CTLm). 
Note:  The label on this button changes depending 

on the configuration.  
SEL TEMP Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of 
the liquid at the meter (CTLm). 
Note:  The label on this button changes depending 

on the configuration.  
MTR PRESS Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the pressure of the 
liquid at the meter (CPLm). 
Note:  The label on this button changes depending 

on the configuration. 
SEL PRESS Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for the correction of the pressure of the liquid at 
the meter (CPLm).   
Note:  The label on this button changes depending 

on the configuration.     
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Button  Description 
MTR Pe Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for the equilibrium vapour pressure (Pe).   
Note: The label on this button change depending on 

the configuration.  
Pe Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for observed equilibrium vapour pressure (Pe).  
Note:  The label on this button changes depending 

on the configuration.    
 
4. Click any of the following buttons to define calculation results for 

the density correction calculation:   
Button  Description 
METER 
DENSITY 

Displays a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for meter density. 
Note:  The label on this button changes depending 

on the configuration. 
MTR DENS (DT) Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed density. 
Note:  The label on this button changes depending 

on the configuration. 
 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
6. Click Yes to apply your changes. The PCSetup screen displays.  

6.7.6 Base Sediment and Water (BSW) 
This option provides base sediment and water (BSW) settings for the 
calculation of the net volume totals.  

1. Select BSW from the hierarchy menu. The BSW screen displays.  
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Figure 6-94. BSW screen  

2. Complete the following fields. 
Field  Description 
Calc Select Indicates the standard the S600+ uses for the 

BSW calculations. Click  to display all valid 
values. 

IP VII/2 4.12 Use IP VII/2 4.12 standard. This is the default. 
REF METER 
DENS 

Use the meter density; mass = meter dry volume * 
meter density. 

REF STD DENS Use the standard density; mass = std dry volume * 
std density. 

US METHOD 1 Use the meter density; mass = meter wet volume * 
meter density. 

NORSOK I-105 Use Norsok I-105 Appendix D method of 
computing totals. This must be used in conjunction 
with Norsok I-105 Density Table Units option. 

6.7.7 Coriolis  
Coriolis settings define the constants and calculation limits for a range 
of parameters, including stream input sources and modes of operation.   

These settings also allow you to define alarms. The system activates 
these alarms when the calculated results for the flowrates are not 
within specified limits.  

1. Select Coriolis from the hierarchy menu. The Coriolis screen 
displays.   
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Figure 6-95. Coriolis screen  

2. Complete the following fields.   
Field  Description 
Flow Units Indicates the primary flow units measurements. Valid 

values are MASS (configure the Coriolis meter for 
mass-based input) or VOLUME (configure the meter 
for volume-based inputs). The default is MASS. 

Flow Data 
Source 

Indicates the source of flow data. Valid values are  
SERIAL (enable the system to take the primary 
variable from the serial mass or volume flowrate) or  
PULSE I/P (calculate the primary variable from the 
mass or volume pulse input.). The default is SERIAL. 

Kdpf  Sets a density correction factor value. The default is 0. 
Note:  Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 

Density Calib 
Pressure 

Sets a density calibration pressure value. The default 
is 0. 
Note:  Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 
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Field  Description 
Ktpf1  Sets a pulse correction factor value. The default is 0. 

Note:  Please contact your Coriolis supplier or 
reference the supplied calibration sheet for 
more information regarding this field and 
value. 

Flow Calib 
Pressure  

Sets a flow calibration pressure value. The default is 0. 
Note:  Please contact your Coriolis supplier or 

reference the supplied calibration sheet for 
more information regarding this field and 
value. 

Pressure  Indicates the source of pressure I/O. Valid values are  
CORIOLIS (use data from the Coriolis serial link) or I/O 
(use data either from ADC/PRT/Density inputs [if 
correctly configured] or from the Coriolis serial link [if 
incorrectly configured]). The default is CORIOLIS.  
Note:  If  you select I/O, remember to configure the 

analog inputs.  
Temperature  Indicates the source of temperature I/O. Valid values 

are CORIOLIS (use data from the Coriolis serial link) 
or I/O (use data either from the ADC/PRT/Density 
inputs [if correctly configured] or from the Coriolis serial 
link [if incorrectly configured]). The default is 
CORIOLIS.  
Note:  If  you select I/O, remember to configure the 

analog inputs. 
Density  Indicates the source of density I/O. Valid values aret 

CORIOLIS (se data from the Coriolis serial link) or I/O 
(use data either from the ADC/PRT/Density inputs [if 
correctly configured] or from the Coriolis serial link [if 
incorrectly configured]). The default is CORIOLIS.  
Note:  If  you select I/O, remember to configure the 

densitometer. 
Density Calc 
Sel 

Indicates whether the S600+ uses the density from the 
Coriolis meter or from a station densitometer (if 
configured). Valid values are BASE TO METER for a 
station densitometer or METER TO BASE for the 
Coriolis value. BASE TO METER is the default. 

Use 64 bit totals  Indicates whether the S600+ uses the 64-bit totals 
received from the Coriolis meter in totalisation 
routines.  
NO Use the 32-bit totals received from the 

Coriolis meter. This is the default. 
YES Use the 64-bit totals received from the 

Coriolis meter. 
Use ext 
temp/press 

Indicates which serial temperature and pressure 
values the S600+ uses in calculations. 
Note: This is valid only if the temperature and 

pressure I/O selections are set to CORIOLIS. 
NO Use the internally derived temperature and 

pressure values. This is the default. 
YES Use the external temperature and pressure 

input values. 
Max 
Acceptable 
Gap Between 
Successive 
Polls 

Sets, in seconds, the maximum acceptable gap 
between successive polls. The default is 50. The 
system uses this value to determine communication 
failures.  
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Field  Description 
Flow Integral 
Acceptance 
Factor 

Sets the acceptable tolerance factor for comparing 
f lowrate to elapsed totals. The default is 20.  

Max Meter 
Total 

Sets a maximum allowable increment in the received 
total. Used by the increment validation logic. 

Max Flowrate Sets a maximum allowable flowrate. The default is 
500. 

 
3. Click any of the following buttons to set meter variable limits.   

Button  Description 
SERIAL PRESS Click to display a Calculation Result dialog box you 

use to define the mode, keypad value, and the specific 
alarm limits for serial pressure.  

SERIAL TEMP Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for serial temperature.   

SERIAL 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for serial density.  

I/O PRESSURE Click to display an Analog Input dialog box you use to 
define various values for the analog input.  

I/O 
TEMPERATURE 

Click to display an Analog Input dialog box you use to 
define various values for the analog input.   

I/O DENSITY Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for I/O density.  

Coriolis 
Comms 

Click to display the I/O Setup screen in Comms.  

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
5. Click Yes to apply your changes. The PCSetup screen displays.  

6.8 Liquid – Turbine  
These stream settings are specific to liquid applications using turbine 
meters. When you initially create a configuration, the calculation 
selections you make determine which calculation-specific screens 
appear in the hierarchy menu.  
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings. 
 

6.8.1 Local Units 
This option allows you to override the global K-factor unit as a liquid 
application may have more than one type of meter, each using different 
K-factor units.  

1. Select Local Units from the hierarchy menu. The Local Units 
screen displays.  
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Figure 6-96. Local Units screen  

2. Complete the following field.  
Field  Description 
K-factor Units Indicates the type of units you desire to use and 

override the system K-factor units of measurement. 
Click ▼ to display all valid values. The default is 
SYSTEM UNITS. 
Note:  If  you select System Units, the stream uses 

the global default value.  
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.8.2 Linearisation  
Linearisation settings define the constants and calculation limits for the 
meter factor and the K-factor typically taken from a Meter Calibration 
Certificate. The system calculates a meter factor and K-factor 
corresponding to the turbine frequency by interpolating the frequency 
between fixed points and then cross-referencing this value to a look-up 
table.  and the K-factor.  

Flow meters produce pulses proportional to the total flow through the 
meter. The K-factor represents the number of pulses produced per unit 
volume.  
Linearisation settings also allow you to define alarms. The system 
activates these alarms when the calculated results for the meter factor 
and K-factor are not within the specified limits. 
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Notes: 
 The linearisation curve for Liquid Turbine configurations uses 

IVOL Flow Rate as the default input for both K-factor and Meter 
Factor calculations. The ability to change the defaults is available 
only with Config600 Pro software. 

 Batching systems that employ meter factor or K-factor linearisation 
with retrospective meter factor/K-factor adjustments assume that 
the adjusted value has a "keypad" mode. 

 To prevent the live metering system from applying a double 
correction, use either a calculated meter factor or a calculated K-
factor linearisation (that is, only one factor should have a 
calculated mode).  

1. Select Linearisation from the hierarchy menu. The Linearisation 
screen displays. 



Config600 Configuration Software User Manual 

Revised January 2023 Stream Configuration 6-195 

 

Figure 6-97. Linearisation screen  

2. Complete the following fields.  
Field  Description 
Meter Factors  Sets up to 12 flow rate and values for the meter 

correction factors. 
 Flowrate/Freq Set the flowrate and frequency for 

each of the meter correction factors. 
 Value Set the corresponding values for 

each of the meter factors. 
K Factors  Sets up to 10 flow rate and values for the K-factors. 
 Flowrate/Freq Set the flowrate and frequency for 

each of the K-factors. 
 Value Set the corresponding values for 

each of the K-factors. 
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Field  Description 
METER 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the respective factor.   

K-FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the respective factor.   

Product Table It allows the selection of the “default” Product Table 
(the in-use functionality) and the 16 other Product 
Tables in order to set up to 10 flow rates and values 
for the meter correction factors and K-factors for each 
product type. When you select a specific product, the 
meter factors and K-factors update accordingly. 
Note:   This field displays only if you enable the 

Product Table when you create the 
configuration. 

Aramco Aramco-style linearisation is identical to normal 
linearisation, but is only used to generate the first 
meter factor – subsequent meter factors are 
generated from proving. 
Notes:      
 Ignore the fields in the Aramco frame unless 

directed by technical support. 
 You must select Product Table with History when 

you create your configuration in order to use the 
Prover MF Deviation Check stage. 

 Normal Flow 
Rate 

Set to zero for standard 
linearisation. Set to non-zero only 
for Aramco-style linearisation. 
Note:  For Aramco-style 

linearisation only, the Initial 
Meter Factor is calculated 
f rom the linearisation curve 
and the Normal Flow Rate. 
This Initial Meter Factor is 
then used in the subsequent 
proving functionality. 

 Date of Initial 
Base Meter 
Factor 

Set the time stamp of the initial base 
meter factor. 
Note:  This field displays only if you 

enable the Product Table 
with History when you 
create the configuration. 

K Factor 
Method 

Selectable between K FACTOR (values entered as 
normal) and ERROR PERCENT (K Factor entered as 
a percentage). 

Meter Factor 
Method 

Selectable between METER FACTOR (values 
entered as normal) and ERROR PERCENT (Meter 
Factor entered as a percentage). 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays. 

6.8.3 Sampling  
Sampling settings define the method and interval period for sampling 
product from a flowing pipeline. By default, the S600+ supports one 



Config600 Configuration Software User Manual 

Revised January 2023 Stream Configuration 6-197 

sampler per stream. If you require more than one sampler per stream, 
contact Technical Support personnel.   Config600 uses the following 
stages during the sampling process:  

Stage Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl 
4 Post Pulse  
5 Stopped Manually 
6 Stopped Can Full 
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch 
12 Stopped initialise 
13 Can Switch Over 

 
Note:  Batch auto-resets the sampler at the start of the batch. 

1. Select Sampling from the hierarchy menu. The Sampling screen 
displays.  

 

Figure 6-98. Sampling screen  

2. Complete the following fields.   
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 

stream or station must have a unique sampler ID.  
Method  Indicates the sampling method. Click  to display all 

valid values.   
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Field  Description 
 TIME PROP Divides the value in the Can Fill 

Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a time interval 
per pulse. This is the default.  

 FLOW PROP1 Divides the value in the Volume 
f ield by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a volume 
throughput per pulse.  

 FLOW PROP2 Uses the value in the Volume field 
as the volume throughput per 
pulse.  

 FLOW PROP3 Uses the value in the Volume field 
as the volume throughput per 
pulse, but supports low pressure 
digital input and pump prime 
output.   

Mode Indicates the sampling mode. Click  to display all 
valid values. The default is SINGLE.  

Can Fill 
Indicator 

Indicates how the S600+ determines when the 
sampling can is full. Click  to display all valid values. 
The default is GRAB COUNT.  

 GRAB COUNT Uses the number of pulses output 
during the sample to determine 
when the can is full.  

 DIG I/P Uses a digital input to determine 
when the can is full.  

 ANALOG I/P Uses an analog input to determine 
when the can is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select the appropriate 
check box to identify the specific event.  

Auto Restart Indicates whether the system automatically restarts 
sampling after automatically disabling sampling.  

Expected 
Volume/Mass 

Sets the volume or mass of the sampling can. The 
default is 1000. 

Can Fill Period Sets, in hours, the time required to fill the sampling 
can. The default is 24. 
Note:  This field is required for the TIME PROP 

sampling method.  
Flowrate Low 
Limit  

Sets the volume at which automatic disabling occurs. 
The default is 0. 
Note:  This field is required if you select the On 

Flowrate Limit check box for Auto Disable.  
Minimum 
Interval  

Sets the minimum interval, in seconds, for sampling. 
The default is 30. 
Note:  If  the sample exceeds this limit, the system 

sets the overspeed alarm and increments the 
overspeed counter.  

Can Volume  Sets the volume of the sampling can. The default is 
0.5. 

Grab Volume  Sets the volume of each sampling grab. The default is 
0.001. 

Can Low Limit  Sets the low limit alarm as a percentage of the Can 
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Field  Description 
Volume. The default is 5. 

Cam High Limit  Sets the high limit alarm as a percentage of the Can 
Volume. The default is 90. 

Can High High 
Limit  

Sets the high high alarm as a percentage of the Can 
Volume. The default is 95. 

Twin Can 
Changeover 
Mode  

Indicates the changeover method for twin can 
sampling. Click  to display all valid values.  
AUTO The sampler automatically 

changes over to the second can 
when the first is full. 

MANUAL The sampler pauses sampling 
when the first can is full and 
requires the operator to change 
the value of Can Selected before 
sampling continues on the 
second can. 
Note: 
 If  sampling is stopped 

because both cans are full, 
the Twin Can Changeover 
Mode is set to MANUAL by 
the system. The user must 
set back to AUTO if required. 

 The display for Twin Can 
Changeover must be 
manually added to the 
displays. 

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  

6.8.4 Observed Density Correction  
This option enables you to determine base density from measured 
density. The system uses base density, coordinated with the standard 
density correction, to calculate correction values for the temperature of 
the liquid at the meter (CTLm) and the pressure of the liquid at the 
meter (CPLm). The system then uses the CTLm and CPLm values to 
correct the metered volume to reference conditions.  

You can measure density at the header, which is associated with the 
station because it is a common density available to all streams (OBS 
TEMP and OBS PRESS), or you can measure it at the meter, which is 
associated with a specific stream (MTR TEMP and MTR PRESS). If 
you do not measure density, this screen does not display and you enter 
a density at standard conditions. 

Note: Options selected when the configuration was created determine 
whether the screen for standard density or observed density 
displays. This example configuration only shows observed 
density correction. For standard density settings, see either the 
example for Coriolis stream or Liquid Ultrasonic stream.  

1. Select Observed Density Correction from the hierarchy menu. 
The Observed Density Correction screen displays. 
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Figure 6-99. Observed Density Correction screens  

2. Complete the following fields.   
Field  Description 
Density Table 
Units 

Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display all 
valid values.  

 CH. 11 
2004/7 CUST 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 
2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 DEG API Use degrees API.  
 KG/M3 Use kilograms per cubic meter. This is 

the default.  
 S.G. Use specific gravity.  
 NORSOK 

I-105 
Use Norsok I-105 Appendix D density 
correction.   
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Field  Description 
Iteration Type Indicates the iteration type for the density correction 

calculations. Valid values are ASTM (use the iterative 
temperature and pressure correction as defined by 
ASTM/API, Chapter 12) or IP2 (use the iterative 
temperature and pressure correction as defined in IP 2 
[ISO 91-1]). The default is ASTM.  

Hydrometer 
Correction  

Indicates whether the S600+ applies hydrometer 
correction values to the calculation. Valid values are 
YES and NO; the default is NO.  

Product Type Indicates the type of petroleum product involved in the 
calculation. Click  to display all valid values. The 
default is A CRUDE.  

 A CRUDE  Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5A and 6A. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 B REFINED Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59B and 60B. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23B and 24B. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5B and 6B. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
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Field  Description 
 C SPECIAL Selection is based on the value in 

the Density Table Units field:  
If  KG/M3 = Petroleum 
Measurement Tables 1980 Tables 
54C. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23C and 24C. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5C and 6C. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
Note:  Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D. 
If  SG = Petroleum Measurement 
Tables 1982 Tables 23D and 24D. 
If  DEG API = Petroleum 
Measurement Tables 1982 Tables 
5D and 6D. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM-IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 54 
(Algorithm). 
Note:   The output is based on the 

relevant formula or look up 
tables dependent on the 
density input. 
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Field  Description 
 TABLE 

LOOKUP 
S600+ reads values from a file in the 
Config600 3.x/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The specific file 
selected is based on the value in the 
Density Table Units field:  
If  SG, values are read from the ASTM-
IP Petroleum Measurement Tables 
1952 Tables 23 file.  
If  DEG API, values are read from the 
ASTM-IP Petroleum Measurement 
Tables 1952 Tables 5 file.  
For KG/M3, please consult technical 
support.  

 USER K0 K1 Selection is based on the value in 
the Density Table Units field:  
If  KG/M3 = Petroleum 
Measurement Tables 1980 Tables 
53A and 54A with user entered 
values for K0 and K1. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A 
with user entered values for K0 and 
K1. 
If  DEG API = Petroleum Measurement 
Tables 1980 Tables 5A and 6A with 
user entered values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-95 

ASTM D1555-95 Table lookup. 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555M-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555M-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 
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Field  Description 
CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses. 
Click  to display all valid values.  
Note:  This field does not display if you select CH.11 

2004 CUST or CH.11 2004 METRIC as the 
Density Table Units or one of the Gazprom 
options as Product Type because these 
standards also specify the CPL calculation.  

 OFF No CPL calculation.  
 API121 Use API MPMS Ch.11.2.1 1984. 
 API1121M Use API MPMS Ch. 11.2.1M 1984. 

This is the default.  
 API122 Use API MPMS Ch.11.2.2 1986 
 API122M Use API MPMS Ch.11.2.2M 1986 
 CONSTANT Use a value you enter.  
 DOWNER Use calculations specified in L. 

Downer’s 1979 paper  Generation of 
New Compressibility Tables for 
International Use  

Rounding Indicates whether the S600+ rounds the calculation 
results. Click  to display all valid values. 

 OFF No rounding occurs. This is the 
default.  

 NATIVE Round to the rules specified in the 
selected calculation standard.  

 API Ch.12.2 
Part 2 

Round in accordance with API MPMS 
Ch.12.2 Part 2 – Measurement 
Tickets 1995 

 API Ch.12.2 
Part 3 

Round in accordance with API MPMS 
Ch.12.2 Part 3 – Proving Reports 
1998 

 Flocheck Round in accordance with Emerson 
Flowcheck verification software 
package  

 ASTM 
D1250-04 
Ch.11 

Round in accordance with API MPMS 
Ch.11.1 2004 (ASTM D1250-04) 
method to round to the Petroleum 
Measurement Table 1980 Tables 

 DECC 1980 DTI/DECC requirements for 
Petroleum Measurement Tables 1980 
Tables. No rounding occurs and an 
iteration tolerance of 0.0001. 

Reference 
Temp 

Indicates, in degrees Centigrade, the reference 
temperature for the correction calculations. The default 
is 15 degrees C.  

Alpha Sets the coefficient of thermal expansion. The default is 
0.  

FFactor Sets the compressibility factor for the liquid (also 
known as the beta factor). The default is 0. 
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Field  Description 
PE Calculation Sets the option to calculate the fluid’s Equilibrium 

Vapour Pressure. While this is normally assumed to be 
0, you can use it for natural gas liquids (NGL) and 
similar applications. Click  to display all valid values. 

 OFF Do not calculate PE value. This 
is the default.  

 GPA TP-15 1988 
Equation 2 

Use the GPA TP-15 1988 
Equation 2 

 GPA TP-15 2003 
Equation 2 

Use the GPA TP-15 2003 
Equation 2 

 GPA TP-15 1988 
Equation 3 

Use the GPA TP-15 1988 
Equation 3 

 GPA TP-15 2003 
Equation 3 

Use the GPA TP-15 2003 
Equation 3 

Aromatics 
Type 

Sets the type of aromatics product.  Click  to display 
all valid values. The default is Benzene.  

Aromatics CCF Sets the method for calculating a combined corrector 
factory (CCF) for aromatics products. Valid values are 
Density (calculate using a density you enter) or Table 
1 (calculate use a density from an embedded table).  

Table 6-3. Observed Density Correction Product Selection 
  Product Type 
Density 
Units 

ASTM-IP  
1952 

A  
Crude 

B  
Refined 

C  
Special 

D 
Lube Oils 

Light 
1986 

Light 
TP25 

Light 
TP27 

Table 
Lookup 

User  
K0 K1 

DEG API n/a ASTM 
D1250-80 
Table 5A 

ASTM  
D1250-80 
Table 5B 

n/a ASTM 
D1250-80 
Table 5D 

n/a n/a n/a ASTM-IP 
Petroleum 
Measure- 

ment 
Tables 
1952 

Tables 5 
lookup 
table 

ASTM 
D1250-80 
Table 5A/ 

User 
K0,K1 

S.G. ASTM 
D1250 
(1952) 

Table 23 
Algorithm 

ASTM 
D1250-80 
Table 23A 

ASTM  
D1250-80 
Table 23B 

n/a ASTM 
D1250-80 
Table 23D 

n/a GPA TP-
25/ 1988 

Table 23E 

GPA TP-
27 Table 

23E 

ASTM-IP 
Petroleum 
Measure- 

ment 
Tables 
1952 

Tables 23 
lookup 
table 

ASTM 
D1250-80 
Table 23A/ 

User 
K0,K1 

KG/M3 ASTM 
D1250 
(1952) 

Table 53 
Algorithm 

ASTM 
D1250-80 
Table 53A 
IP Paper 3 

(1988) 
Table 59A 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 53B 
IP Paper 3 

(1988) 
Table 59B 

(20’C 
Reference 

Temp) 

n/a ASTM 
D1250-80 
Table 53D 
IP Paper 3 

(1988) 
Table 59D 

(20’C 
Reference 

Temp) 

ASTM–IP-
API 

Petroleum 
Measure 

ment 
tables for 

light 
hydrocarb
on liquids 

1986 

n/a GPA TP-
27 Table 

53E 
GPA TP-
27 Table 

59E (20’C 
Reference 

Temp) 

Consult 
technical 
support 

ASTM 
D1250-80 
Table 53A/ 

User 
K0,K1 

CH. 11 
2004/7 
CUST 

n/a ASTM 
D1250-04 

ASTM  
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

CH. 11 
2004/7 
METRIC 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

NORSOK 
I-105 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

3. Click any of the following buttons to define calculation results for 
the observed density correction calculations.  
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Button  Description 
BASE DENSITY Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for base density. 
Note:  The label on this button changes depending 

on the configuration. 
METER CTL Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of 
the liquid at the meter (CTLm). 
Note:  The label on this button changes depending 

on the configuration. 
METER CCF Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the combined correction factor at 
the meter (CCFm). 
Note:  The label on this button changes depending 

on the configuration. 
METER CPL Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the pressure of the 
liquid at the meter (CPLm). 
Note:  The label on this button changes depending 

on the configuration. 
 
4. Click any of the following buttons to define live inputs for the 

observed density correction calculations.  
Button  Description 
METER 
DENSITY 

Displays a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for meter density. 
Note:  The label on this button changes depending 

on the configuration. 
OBS DENS  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed density. 
Note:  The label on this button changes depending 

on the configuration. 
MTR TEMP  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter temperature. 
Note:  The label on this button changes depending 

on the configuration. 
OBS TEMP  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed temperature. 
Note:  The label on this button changes depending 

on the configuration. 
MTR PRESS  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter pressure. 
Note:  The label on this button changes depending 

on the configuration. 
OBS PRESS Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed pressure. 
Note:  The label on this button changes depending 

on the configuration. 
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Button  Description 
Pe Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed equilibrium vapour 
pressure (Pe). 
Note:  The label on this button changes depending 

on the configuration. 
 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
6. Click Yes to apply your changes. The PCSetup screen displays.  

6.8.5 Standard Density Correction  
This calculation enables you to use base density to determine the 
factors for the correction for temperature of the liquid at the meter 
(CTLm) and the correction for the pressure of the liquid at the meter 
(CPLm). The system then uses the CTLm and CPLm values to correct 
the metered volume to reference conditions.  

1. Select Standard Density Correction from the hierarchy menu. 
The Standard Density Correction screen displays.  

 
Figure 6-100. Standard Density Correction screen  
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2. Complete the following fields.   
Field  Description 
Density Table 
Units 

Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display all 
valid values.  

 CH. 11 2004/7 
CUST 

Use API MPMS Ch. 11.1 2004, 
Addendum 1, 2007 Imperial units.  

 CH. 11 2004/7 
METRIC 

Use API MPMS Ch. 11.1 2004, 
Addendum 1, 2007 Metric Units 

 DEG.API  Use degrees API.  
 KG/M3  Use kilograms per cubic meter. This 

is the default.  
 S.G. Use specific gravity.  
 NORSOK 

I-105 
Use Norsok I-105 Appendix D 
density correction.   

 Note: See Table 6-2 for product selection.  
Product Type Indicates the type of petroleum product involved in the 

calculation. Click  to display all valid values. The 
default is A CRUDE.   

 A CRUDE  Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A. 
If  DEG API =  Petroleum 
Measurement Tables 1980 Tables 
5A and 6A. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 B REFINED Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59B and 60B. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23B and 24B. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5B and 6B. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric =  API MPMS 
Chapter 11 2004. 
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Field  Description 
 C SPECIAL Selection is based on the value in 

the Density Table Units field:  
If  KG/M3 = Petroleum 
Measurement Tables 1980 Table 
54C. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23C and 24C. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5C and 6C. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
Note:  Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

Selection is based on the value in 
the Density Table Units field:  
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D. 
If  SG =,Petroleum Measurement 
Tables 1982 Tables 23D and 24D. 
If  DEG API = Petroleum 
Measurement Tables 1982 Tables 
5D and 6D. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM-IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 54 
(Algorithm). 
Note:   The output is based on the 

relevant formula or look up 
tables dependent on the 
density input. 
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Field  Description 
 TABLE 

LOOKUP 
S600+ reads values from a file in the 
Config600 3.x/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The specific file 
selected is based on the value in the 
Density Table Units field:  
If  SG, values are read from the ASTM-
IP Petroleum Measurement Tables 
1952 Tables 23 file.  
If  DEG API, values are read from the 
ASTM-IP Petroleum Measurement 
Tables 1952 Tables 5 file.  
For KG/M3, please consult technical 
support.  

 USER K0 K1 Selection is based on the value in 
the Density Table Units field:  
If  KG/M3 = Petroleum 
Measurement Tables 1980 Tables 
53A and 54A with user entered 
values for K0 and K1. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A 
with user entered values for K0 and 
K1. 
If  DEG API = Petroleum Measurement 
Tables 1980 Tables 5A and 6A with 
user entered values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-95 

ASTM D1555-95 Table lookup. 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555M-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555M-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 
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Field  Description 
CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses. 
Click  to display all valid values.  
Note: This field does not display if you select CH.11 

2004 CUST or CH.11 2004 METRIC as the 
Density Table Units or one of the Gazprom 
options as Product Type because these 
standards also specify the CPL calculation. 

 OFF No CPL calculation.  
 API121 Use API MPMS Ch.11.2.1 1984. 
 API1121M Use API MPMS Ch. 11.2.1M 1984. 

This is the default.  
 API122 Use API MPMS Ch.11.2.2 1986 
 API122M Use API MPMS Ch.11.2.2M 1986 
 CONSTANT Use a value you enter.  
 DOWNER Use calculations specified in L. 

Downer’s 1979 paper Generation of 
New Compressibility Tables for 
International Use  

Rounding Indicates whether the S600+ rounds the calculation 
results. Click  to display all valid values.  

 OFF No rounding occurs. This is the 
default.  

 NATIVE Round to the rules specified in the 
selected calculation standard.  

 API Ch.12.2 
Part 2 

Round in accordance with API MPMS 
Ch.12.2 Part 2 – Measurement 
Tickets 1995 

 API Ch.12.2 
Part 3 

Round in accordance with API MPMS 
Ch.12.2 Part 3 – Proving Reports 
1998 

   
 Flocheck Round in accordance with Emerson 

Flowcheck verification software 
package  

 ASTM 
D1250-04 
Ch.11 

Round in accordance with API MPMS 
Ch.11.1 2004 (ASTM D1250-04) 
method to round to the Petroleum 
Measurement Table 1980 Tables 

 DECC 1980 DTI/DECC requirements for 
Petroleum Measurement Tables 1980 
Tables. No rounding occurs and an 
iteration tolerance of 0.0001. 

Reference 
Temp 

Sets, in degrees Centigrade, the reference 
temperature for the correction calculations. The default 
is 15 degrees C.  

Alpha Sets the coefficient of thermal expansion. The default is 
0. 

FFactor Sets the compressibility factor for the liquid (also 
known as the beta factor). The default is 0. 
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Field  Description 
PE Calculation Sets the option to calculate the fluid’s Equilibrium 

Vapour Pressure. While this is normally assumed to be 
0, you can use it for natural gas liquids (NGL) and 
similar applications. Click  to display all valid values. 

 OFF Do not calculate PE value. This 
is the default.  

 GPA TP-15 1988 
Equation 2 

Use the GPA TP-15 1988 
Equation 2 

 GPA TP-15 2003 
Equation 2 

Use the GPA TP-15 2003 
Equation 2 

 GPA TP-15 1988 
Equation 3 

Use the GPA TP-15 1988 
Equation 3 

 GPA TP-15 2003 
Equation 3 

Use the GPA TP-15 2003 
Equation 3 

BASE DENSITY Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for base density.  
Note: The label on this button changes depending 

on the configuration.  
BASE DENS 
(DT) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for base density.  
Note: This button displays only if you select the 

density to stream option.  
Aromatics 
Type 

Sets the type of aromatics product. Click  to display 
all valid values. The default is Benzene.  

Table 6-4. Standard Density Correction Product Selection 
  Product Type 
Density 
Units 

ASTM-IP  
1952 

A  
Crude 

B  
Refined 

C  
Special 

D 
Lube Oils 

Light 
1986 

Light 
TP25 

Light 
TP27 

Table 
Lookup 

User  
K0 K1 

DEG API ASTM 
D1250 
(1952) 
Table 6 

ASTM 
D1250-80 
Table 6A 

ASTM  
D1250-80 
Table 6B 

ASTM  
D1250-80 
Table 6C 

ASTM 
D1250-80 
Table 6D 

n/a n/a n/a User 
lookup 
table 

ASTM 
D1250-80 
Table 6A/ 

User 
K0,K1 

S.G. ASTM 
D1250 
(1952) 

Table 24 

ASTM 
D1250-80 
Table 24A 

ASTM  
D1250-80 
Table 24B 

ASTM  
D1250-80 
Table 24C 

ASTM 
D1250-80 
Table 24D 

n/a GPA TP-
25/ 1988 

Table 24E 

GPA TP-
27 Table 

24E 

User 
lookup 
table 

ASTM 
D1250-80 
Table 24A/ 

User 
K0,K1 

KG/M3 ASTM 
D1250 
(1952) 

Table 54 

ASTM 
D1250-80 
Table 54A 
IP Paper 3 

(1988) 
Table 60A 

(20’C 
Reference 

Temp)  

ASTM  
D1250-80 
Table 54B 
IP Paper 3 

(1988) 
Table 60B 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 54C 

ASTM 
D1250-80 
Table 54D 
IP Paper 3 

(1988) 
Table 60D 

(20’C 
Reference 

Temp) 

ASTM–IP-
API 

Petroleum 
Measure 

ment 
tables for 

light 
hydrocarb
on liquids 

1986 

n/a GPA TP-
27 Table 

54E 
GPA TP-
27 Table 

60E (20’C 
Reference 

Temp) 

User 
lookup 
table 

ASTM 
D1250-80 
Table 54A/ 

User 
K0,K1 

CH. 11 
2004/7 
CUST 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

CH. 11 
2004/7 
Metric 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

NORSOK 
I-105 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

 
3. Click any of the following buttons to define live inputs for the 

calculations. 
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Button  Description 
MTR TEMP Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for meter temperature.   
Note:  The label on this button changes depending 

on the configuration.  
MTR PRESS Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for meter pressure.    
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component.  
Pe Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for equilibrium vapour pressure (Pe).   
Note:  The label on this button changes depending 

on the configuration.   
 
4. Click any of the following buttons to define calculation results for 

the correction calculations.  
Button  Description 
METER 
DENSITY 

Displays a Calculation Result dialog box you use to 
define the mode, keypad value, and the specific alarm 
limits for meter density.   
Note: The label on this button changes depending 

on the configuration.  
METER CCF Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for the combined correction factor at the meter 
(CCFm).  
Note: The label on this button changes depending 

on the configuration.    
METER CTL Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for the correction of the temperature of the liquid 
at the meter (CTLm).  
Note: The label on this button changes depending 

on the configuration.   
METER CPL Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for the correction of the pressure of the liquid at 
the meter (CPLm)   
Note: The label on this button changes depending 

on the configuration. 
 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
6. Click Yes to apply your changes. The PCSetup screen displays.  

6.8.6 Base Sediment and Water (BSW)  
This option provides base sediment and water (BSW) settings for the 
calculation of the net volume totals.   

7. Select BSW from the hierarchy menu. The BSW screen displays.  
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Figure 6-101. BSW screen   

8. Complete the following field.   
Field  Description 
Calc Select Indicates the standard the S600+ uses for the BSW 

calculations. Click  to display all valid values.  
 IP VII/2 4.12 Use IP VII/2 4.12 standard. This is 

the default.  
 REF METER 

DENS 
Use the meter density; mass = 
meter dry volume * meter density 

 REF STD 
DENS 

Use the standard density; mass = 
std dry volume * std density. 

 US METHOD 1 Use the meter density; mass = 
meter wet volume * meter density. 

 NORSOK  
I-105 

Use Norsok I-105 Appendix D 
method of computing totals. This 
must be used in conjunction with 
Norsok I-105 Density Table Units 
option.  

 
9. Click any of the following buttons to define BSW parameters.  

Button  Description 
BASE DENSITY Click to display a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for base density. 

BSW PERCENT Click to display an Analog Input dialog box you use to 
define various values for the analogue input.   

Analogue 
Inputs 

Click to display the I/O Setup screen’s settings related 
to the BSW analog input for the selected stream.   

10. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

11. Click Yes to apply your changes. The PCSetup screen displays.  
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6.9 Liquid - Ultrasonic  
These stream settings are specific to liquid ultrasonic applications 
using turbine meters. When you initially create a configuration, the 
calculation selections you make determine which calculation-specific 
screens appear in the hierarchy menu.  
 

Caution 
It is extremely unlikely that any one S600+ configuration would contain 
all the settings discussed in this section. For that reason, several 
sample configurations demonstrate the settings. 
 

6.9.1 Local Units 
This option allows you to override the global K-factor unit as a liquid 
application may have more than one type of meter, each using different 
K-factor units.  

1. Select Local Units from the hierarchy menu. The Local Units 
screen displays.   

 

Figure 6-102. Local Units screen   
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2. Complete the following field.   
Field  Description 
K-factor Units Indicates the type of units you desire to use and 

override the system K-factor units of measurement. 
Click ▼ to display all valid values. The default is 
SYSTEM UNITS. 
Note:  If  you select System Units, the stream uses 

the global default value.  
 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.   

6.9.2 Sampling  
Sampling settings define the method and interval period for sampling 
product from a flowing pipeline. By default, the S600+ supports one 
sampler per stream. If you require more than one sampler per stream, 
contact Technical Support personnel.   Config600 uses the following 
stages during the sampling process:  

Stage Description 
0 Idle 
1 Monitor 
2 Digout n 
3 Min Intvl 
4 Post Pulse  
5 Stopped Manually 
6 Stopped Can Full 
7 Stopped Low Flow  
8 Initial Time 
9 Check Flow Switch  

10 Stopped Flow Switch  
11 Stopped Press Switch 
12 Stopped initialise 
13 Can Switch Over 

 

Note:  Batch auto-resets the sampler at the start of the batch. 

5. Select Sampling from the hierarchy menu. The Sampling screen 
displays.  
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Figure 6-103. Sampling screen  

6. Complete the following fields.   
Field  Description 
Sampler ID Provides an identifying label for the sampler. Each 

stream or station must have a unique sampler ID.  
Method  Indicates the sampling method. Click  to display all 

valid values.   
 TIME PROP Divides the value in the Can Fill 

Period field by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a time interval 
per pulse. This is the default.  

 FLOW PROP1 Divides the value in the Volume 
f ield by the number of grabs 
needed to fill the can (derived from 
the Can Volume and Fill Volume 
values) to determine a volume 
throughput per pulse.  

 FLOW PROP2 Uses the value in the Volume field 
as the volume throughput per 
pulse.  

 FLOW PROP3 Uses the value in the Volume field 
as the volume throughput per 
pulse, but supports low pressure 
digital input and pump prime 
output.   
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Field  Description 
Mode Indicates the sampling mode. Click  to display all 

valid values. The default is SINGLE.  
Can Fill 
Indicator 

Indicates how the S600+ determines when the 
sampling can is full. Click  to display all valid values. 
The default is GRAB COUNT.  

 GRAB COUNT Uses the number of pulses output 
during the sample to determine 
when the can is full.  

 DIG I/P Uses a digital input to determine 
when the can is full.  

 ANALOG I/P Uses an analog input to determine 
when the can is full.  

Auto Disable Indicates the event at which the system automatically 
disables the sampling process. Select the appropriate 
check box to identify the specific event.  

Auto Restart Indicates whether the system automatically restarts 
sampling after automatically disabling sampling.  

Expected 
Volume/Mass 

Sets the volume or mass of the sampling can. The 
default is 1000. 

Can Fill Period Sets, in hours, the time required to fill the sampling 
can. The default is 24. 
Note:  This field is required for the TIME PROP 

sampling method.  
Flowrate Low 
Limit  

Sets the volume at which automatic disabling occurs. 
The default is 0. 
Note:  This field is required if you select the On 

Flowrate Limit check box for Auto Disable.  
Minimum 
Interval  

Sets the minimum interval, in seconds, for sampling. 
The default is 30. 
Note:  If  the sample exceeds this limit, the system 

sets the overspeed alarm and increments the 
overspeed counter.  

Can Volume  Sets the volume of the sampling can. The default is 
0.5. 

Grab Volume  Sets the volume of each sampling grab. The default is 
0.001. 

Can Low Limit  Sets the low limit alarm as a percentage of the Can 
Volume. The default is 5. 

Cam High Limit  Sets the high limit alarm as a percentage of the Can 
Volume. The default is 90. 

Can High High 
Limit  

Sets the high high alarm as a percentage of the Can 
Volume. The default is 95. 

Twin Can 
Changeover 
M d   

Indicates the changeover method for twin can 
sampling. Click  to display all valid values.  
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Field  Description 
AUTO The sampler automatically 

changes over to the second can 
when the first is full. 

MANUAL The sampler pauses sampling 
when the first can is full and 
requires the operator to change 
the value of Can Selected before 
sampling continues on the 
second can. 
Note: 
 If  sampling is stopped 

because both cans are full, 
the Twin Can Changeover 
Mode is set to MANUAL by 
the system. The user must 
set back to AUTO if required. 

 The display for Twin Can 
Changeover must be 
manually added to the 
displays. 

 
7. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

8. Click Yes to apply your changes. The PCSetup screen displays.  

6.9.3 Linearisation  
Linearisation settings define the constants and calculation limits for the 
meter factor and K-factor. The S600+ calculates a meter factor 
corresponding to the frequency by interpolating the frequency between 
fixed points and then cross-referencing the result against a lookup 
table. Linearisation settings also allow you to define alarms. The 
system activates these alarms when the calculated results for the Meter 
Factor are not within specified limits.  

Notes: 
 The linearisation curve for Liquid Ultrasonic configurations uses 

IVOL Flow Rate as the default input for Meter Factor calculations. 
The ability to change the default is available only with Config600 
Pro software. 

 Batching systems that employ meter factor linearisation with 
retrospective meter factor adjustments assume that the adjusted 
value has a "keypad" mode. 

 To prevent the live metering system from applying a double 
correction, use either a calculated meter factor or a calculated K-
factor linearisation (that is, only one factor should have a 
calculated mode). 

1. Select Linearisation from the hierarchy menu. The Linearisation 
screen displays.   
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Figure 6-104. Linearisation screen   
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2. Complete the following fields.  
Field  Description 
Meter Factors  Sets up to 20 flow rate and values for the meter 

correction factors. 
 Flowrate/Freq Set the flowrate and frequency for 

each of the meter correction 
factors. 

 Value Set the corresponding values for 
each of the meter factors. 

METER 
FACTOR 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor.   

K-FACTOR Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the specific 
alarm limits for the respective factor.   

Product Table It allows the selection of the “default” Product Table 
(the in-use functionality) and the 16 other Product 
Tables in order to set up to 10 flow rates and values 
for the meter correction factors and K-factors for each 
product type. When you select a specific product, the 
meter factors and K-factors update accordingly. 
Note:   This field displays only if you enable the 

Product Table when you create the 
configuration. 

Aramco Aramco-style linearisation is identical to normal 
linearisation, but is only used to generate the first 
meter factor – subsequent meter factors are 
generated from proving. 
Notes:      
 Ignore the fields in the Aramco frame unless 

directed by technical support. 
 You must select Product Table with History when 

you create your configuration in order to use the 
Prover MF Deviation Check stage. 

 Normal Flow 
Rate 

Set to zero for standard 
linearisation. Set to non-zero only 
for Aramco-style linearisation. 
Note:  For Aramco-style 

linearisation only, the Initial 
Meter Factor is calculated 
f rom the linearisation curve 
and the Normal Flow Rate. 
This Initial Meter Factor is 
then used in the subsequent 
proving functionality. 

 Date of Initial 
Base Meter 
Factor 

Set the time stamp of the initial base 
meter factor. 
Note:  This field displays only if you 

enable the Product Table 
with History when you 
create the configuration. 

Meter Factor 
Method 

Selectable between METER FACTOR (values 
entered as normal) and ERROR PERCENT (Meter 
Factor entered as a percentage). 

3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  
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4. Click Yes to apply your changes. The PCSetup screen displays. 

6.9.4 Observed Density Correction  
This option enables you to determine base density from measured 
density. The system uses base density, coordinated with the standard 
density correction, to calculate correction values for the temperature of 
the liquid at the meter (CTLm) and the pressure of the liquid at the 
meter (CPLm). The system then uses the CTLm and CPLm values to 
correct the metered volume to reference conditions.  

You can measure density at the header, which is associated with the 
station because it is a common density available to all streams (OBS 
TEMP and OBS PRESS), or you can measure it at the meter, which is 
associated with a specific stream (MTR TEMP and MTR PRESS). If 
you do not measure density, this screen does not display and you enter 
a density at standard conditions. 

1. Select Observed Density Correction from the hierarchy menu. 
The Observed Density Correction screen displays.  
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Figure 6-105. Observed Density Correction screen   
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2. Complete the following fields.  
Field  Description 
Density Table 
Units 

Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display all 
valid values.  

 CH. 11 
2004/7 CUST 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 
2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 DEG API Use degrees API.  
 KG/M3 Use kilograms per cubic meter. This is 

the default.  
 S.G. Use specific gravity.  
 NORSOK 

I-105 
Use Norsok I-105 Appendix D density 
correction.   

Iteration Type Indicates the iteration type for the density correction 
calculations. Valid values are ASTM (use the iterative 
temperature and pressure correction as defined by 
ASTM/API, Chapter 12) or IP2 (use the iterative 
temperature and pressure correction as defined in IP 2 
[ISO 91-1]). The default is ASTM.  

Hydrometer 
Correction  

Indicates whether the S600+ applies hydrometer 
correction values to the calculation. Valid values are 
YES and NO; the default is NO.  

Product Type Indicates the type of petroleum product involved in the 
calculation. Click  to display all valid values. The 
default is A CRUDE.  

 A CRUDE  Selection is based on the value in 
the Density Table Units field: 
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  SG =,Petroleum Measurement 
Tables 1980 Tables 23A and 24A. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5A and 6A. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
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Field  Description 
 B REFINED Selection is based on the value in 

the Density Table Units field: 
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59B and 60B. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23B and 24B. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5B and 6B. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 C SPECIAL Selection is based on the value in 
the Density Table Units field: 
If  KG/M3 = Petroleum Measurement 
Tables 1980 Table 54C. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23C and 24C. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5C and 6C. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
Note:  Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry of 
Alpha, and if this is known then 
the base density would be 
known. 
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Field  Description 
 D LUBE 

OILS 
Selection is based on the value in 
the Density Table Units field: 
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D. 
If  SG = Petroleum Measurement 
Tables 1982 Tables 23D and 24D. 
If  DEG API = Petroleum 
Measurement Tables 1982 Tables 
5D and 6D. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM-IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 54 
(Algorithm). 
Note:   The output is based on the 

relevant formula or look up 
tables dependent on the 
density input. 

 TABLE 
LOOKUP 

S600+ reads values from a file in the 
Config600 3.x/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The specific file 
selected is based on the value in the 
Density Table Units field:  
If  SG, values are read from the ASTM-
IP Petroleum Measurement Tables 
1952 Tables 23 file.  
If  DEG API, values are read from the 
ASTM-IP Petroleum Measurement 
Tables 1952 Tables 5 file.  
For KG/M3, please consult technical 
support.  

 USER K0 K1 Selection is based on the value in 
the Density Table Units field: 
If  KG/M3 = Petroleum Measurement 
Tables 1980 Tables 53A and 54A 
with user entered values for K0 and 
K1. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A 
with user entered values for K0 and 
K1. 
If  DEG API = Petroleum Measurement 
Tables 1980 Tables 5A and 6A with 
user entered values for K0 and K1. 
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Field  Description 
 LIGHT TP25 GPA TP-25 1998 (API Tables 23E and 

24E). 
 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 

24E, 53E, 54E, 59E and 60E). 
 AROMATICS 

D1555M-95 
ASTM D1555-95 Table lookup. 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table Lookup. 

 AROMATICS 
D1555M-04A 

ASTM D1555-04a Calculation. 

 AROMATICS 
D1555M-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid Hydrocarbon. 

CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses. 
Click  to display all valid values.  
Note:  This field does not display if you select CH.11 

2004 CUST or CH.11 2004 METRIC as the 
Density Table Units or one of the Gazprom 
options as Product Type because these 
standards also specify the CPL calculation.  

 OFF No CPL calculation.  
 API121 Use API MPMS Ch.11.2.1 1984. 
 API1121M Use API MPMS Ch. 11.2.1M 1984. 

This is the default.  
 API122 Use API MPMS Ch.11.2.2 1986. 
 API122M Use API MPMS Ch.11.2.2M 1986. 
 CONSTANT Use a value you enter.  
 DOWNER Use calculations specified in L. 

Downer’s 1979 paper  Generation of 
New Compressibility Tables for 
International Use  

Rounding Indicates whether the S600+ rounds the calculation 
results. Click  to display all valid values. 

 OFF No rounding occurs. This is the 
default.  

 NATIVE Round to the rules specified in the 
selected calculation standard.  

 API Ch.12.2 
Part 2 

Round in accordance with API MPMS 
Ch.12.2 Part 2 – Measurement Tickets 
1995 

 API Ch.12.2 
Part 3 

Round in accordance with API MPMS 
Ch.12.2 Part 3 – Proving Reports 1998 

 Flocheck Round in accordance with Emerson 
Flowcheck verification software 
package  

 ASTM 
D1250-04 
Ch.11 

Round in accordance with API MPMS 
Ch.11.1 2004 (ASTM D1250-04) 
method to round to the Petroleum 
Measurement Table 1980 Tables 
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Field  Description 
 DECC 1980 DTI/DECC requirements for Petroleum 

Measurement Tables 1980 Tables. No 
rounding occurs and an iteration 
tolerance of 0.0001. 

Reference 
Temp 

Indicates, in degrees Centigrade, the reference 
temperature for the correction calculations. The default 
is 15 degrees C.  

Alpha Sets the coefficient of thermal expansion. The default is 
0.  

FFactor Sets the compressibility factor for the liquid (also known 
as the beta factor). The default is 0. 

PE Calculation Sets the option to calculate the fluid’s Equilibrium 
Vapour Pressure. While this is normally assumed to be 
0, you can use it for natural gas liquids (NGL) and 
similar applications. Click  to display all valid values. 

 OFF Do not calculate PE value. This is 
the default.  

 GPA TP-15 1988 
Equation 2 

Use the GPA TP-15 1988 
Equation 2 

 GPA TP-15 2003 
Equation 2 

Use the GPA TP-15 2003 
Equation 2 

 GPA TP-15 1988 
Equation 3 

Use the GPA TP-15 1988 
Equation 3 

 GPA TP-15 2003 
Equation 3 

Use the GPA TP-15 2003 
Equation 3 

Aromatics 
Type 

Sets the type of aromatics product.  Click  to display 
all valid values. The default is Benzene.  

Aromatics CCF Sets the method for calculating a combined corrector 
factory (CCF) for aromatics products. Valid values are 
Density (calculate using a density you enter) or Table 1 
(calculate use a density from an embedded table).  

Table 6-5. Observed Density Correction Product Selection 

 Product Type 
Density 
Units 

ASTM-IP  
1952 

A  
Crude 

B  
Refined 

C  
Special 

D 
Lube Oils 

Light 
1986 

Light 
TP25 

Light 
TP27 

Table 
Lookup 

User  
K0 K1 

DEG API ASTM 
D1250 
(1952) 
Table 5 

Algorithm 

ASTM 
D1250-80 
Table 5A 

ASTM  
D1250-80 
Table 5B 

n/a ASTM 
D1250-80 
Table 5D 

n/a n/a n/a User 
lookup 
table 

ASTM 
D1250-80 
Table 5A/ 

User 
K0,K1 

S.G. ASTM 
D1250 
(1952) 

Table 23 
Algorithm 

ASTM 
D1250-80 
Table 23A 

ASTM  
D1250-80 
Table 23B 

n/a ASTM 
D1250-80 
Table 23D 

n/a GPA TP-
25/ 1988 

Table 23E 

GPA TP-
27  

Table 23E 

User 
lookup 
table 

ASTM 
D1250-80 
Table 23A/ 

User 
K0,K1 

KG/M3 ASTM 
D1250 
(1952) 

Table 53 
Algorithm 

ASTM 
D1250-80 
Table 53A 
IP Paper 3 

(1988) 
Table 59A 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 53B 
IP Paper 3 

(1988) 
Table 59B 

(20’C 
Reference 

Temp) 

n/a ASTM 
D1250-80 
Table 53D 
IP Paper 3 

(1988) 
Table 59D 

(20’C 
Reference 

Temp) 

ASTM–IP-
API 

Petroleum 
Measure 

ment 
tables for 

light 
hydrocarb
on liquids 

1986 

n/a GPA TP-
27 Table 

53E 
GPA TP-
27 Table 

59E (20’C 
Reference 

Temp) 

User 
lookup 
table 

ASTM 
D1250-80 
Table 53A/ 

User 
K0,K1 

CH. 11 
2004/7 
CUST 

n/a ASTM 
D1250-04 

ASTM  
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

CH. 11 
2004/7 
METRIC 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

NORSOK  
I-105 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 
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3. Click any of the following buttons to define calculation results for 
the observed density correction calculations.  
Button  Description 
BASE DENSITY Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for base density. 
Note:  The label on this button changes depending 

on the configuration. 
METER CTL Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of 
the liquid at the meter (CTLm). 
Note:  The label on this button changes depending 

on the configuration. 
METER CCF Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the combined correction factor at 
the meter (CCFm). 
Note:  The label on this button changes depending 

on the configuration. 
METER CPL Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the pressure of the 
liquid at the meter (CPLm). 
Note:  The label on this button changes depending 

on the configuration. 
 
4. Click any of the following buttons to define live inputs for the 

observed density correction calculations. 
Button  Description 
METER 
DENSITY 

Displays a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for meter density. 
Note:  The label on this button changes depending 

on the configuration. 
OBS DENS  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed density. 
Note:  The label on this button changes depending 

on the configuration. 
MTR TEMP  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter temperature. 
Note:  The label on this button changes depending 

on the configuration. 
OBS TEMP  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed temperature. 
Note:  The label on this button changes depending 

on the configuration. 
MTR PRESS  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter pressure. 
Note:  The label on this button changes depending 

on the configuration. 
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Button  Description 
OBS PRESS Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed pressure. 
Note:  The label on this button changes depending 

on the configuration. 
Pe Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for observed equilibrium vapour 
pressure (Pe). 
Note:  The label on this button changes depending 

on the configuration. 
 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  

6. Click Yes to apply your changes. The PCSetup screen displays.    

6.9.5 Standard Density Correction  
This calculation enables you to use base density to determine the 
factors for the correction for temperature of the liquid at the meter 
(CTLm) and the correction for the pressure of the liquid at the meter 
(CPLm). The system then uses the CTLm and CPLm values to correct 
the metered volume to reference conditions.  

1. Select Standard Density Correction from the hierarchy menu. 
The Standard Density Correction screen displays.  

 

Figure 6-106. Standard Density Correction screen   

2. Complete the following fields.  
Field  Description 
Density Table 
Units 

Indicates the density units the S600+ uses for the 
density correction calculations. Click  to display all 
valid values.  

 CH. 11 2004/7 
CUST 

Use API MPMS Ch. 11.1 2004, 
Addendum 1, 2007 Imperial units.  

 CH. 11 2004/7 Use API MPMS Ch. 11.1 2004, 
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Field  Description 
METRIC Addendum 1, 2007 Metric Units 

 DEG.API  Use degrees API.  
 KG/M3  Use kilograms per cubic meter. This 

is the default.  
 S.G. Use specific gravity.  
 NORSOK 

I-105 
Use Norsok I-105 Appendix D 
density correction.   

 Note: See Table 6-2 for product selection.  
Product Type Indicates the type of petroleum product involved in the 

calculation. Click  to display all valid values. The 
default is A Crude.   

 A CRUDE  Selection is based on the value in 
the Density Table Units field: 
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59A and 60A. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5A and 6A. 
If  CH.11 2004/7, Cust Density Table 
Units = API MPMS Chapter 11 
2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 B REFINED Selection is based on the value in 
the Density Table Units field: 
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1980 Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59B and 60B.  
If  SG = Petroleum Measurement 
Tables 1980 Tables 23B and 24B. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5B and 6B. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
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Field  Description 
 C SPECIAL Selection is based on the value in 

the Density Table Units field: 
If  KG/M3 = Petroleum 
Measurement Tables 1980 Table 
54C. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23C and 24C. 
If  DEG API = Petroleum 
Measurement Tables 1980 Tables 
5C and 6C. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 
Note:  Table 53C is not implemented 

as the assumption is made that 
the base density is already 
known. This is because Table 
53C allows for a keypad entry 
of  Alpha, and if this is known 
then the base density would be 
known. 

 D LUBE 
OILS 

Selection is based on the value in 
the Density Table Units field: 
If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 
1982 Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 
1988 Tables 59D and 60D. 
If  SG = Petroleum Measurement 
Tables 1982 Tables 23D and 24D. 
If  DEG API = Petroleum 
Measurement Tables 1982 Tables 
5D and 6D. 
If  CH.11 2004/7, Cust = API MPMS 
Chapter 11 2004. 
If  CH.11 2004/7, Metric = API MPMS 
Chapter 11 2004. 

 LIGHT 1986 ASTM-IP-API Petroleum 
Measurement Tables for Light 
Hydrocarbon Liquids 1986 Tables 53 
and 54. 

 ASTM-IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 54 
(Algorithm). 
Note:   The output is based on the 

relevant formula or look up 
tables dependent on the 
density input. 
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Field  Description 
 TABLE 

LOOKUP 
S600+ reads values from a file in the 
Config600 3.x/Config/Project 
Name/extras directory and transfers 
that data into the S600+ with the 
configuration file. The specific file 
selected is based on the value in the 
Density Table Units field:  
If  SG, values are read from the ASTM-
IP Petroleum Measurement Tables 
1952 Tables 23 file.  
If  DEG API, values are read from the 
ASTM-IP Petroleum Measurement 
Tables 1952 Tables 5 file.  
For KG/M3, please consult technical 
support.  

 USER K0 K1 Selection is based on the value in 
the Density Table Units field: 
If  KG/M3 = Petroleum 
Measurement Tables 1980 Tables 
53A and 54A with user entered 
values for K0 and K1. 
If  SG = Petroleum Measurement 
Tables 1980 Tables 23A and 24A 
with user entered values for K0 and 
K1. 
If  DEG API = Petroleum Measurement 
Tables 1980 Tables 5A and 6A with 
user entered values for K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E 
and 24E). 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATIC
S D1555M-
95 

ASTM D1555-95 Table lookup. 

 AROMATIC
S D1555M-
00 

ASTM D1555M-00 Table Lookup. 

 AROMATIC
S D1555M-
04A 

ASTM D1555-04a Calculation. 

 AROMATIC
S D1555M-
08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 
B1 UGC 

Gazprom STO-5.9 2008 Addendum 
B.1 Unstable Gas Condensate. 

 STO5.9 08 
B2 SLH 

Gazprom STO-5.9 2008 Addendum 
B.2 Stable Liquid Hydrocarbon. 

 STO5.9 08 
B3 WFLH 

Gazprom STO-5.9 2008 Addendum 
B.3 Wide Fraction Liquid 
Hydrocarbon. 
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Field  Description 
CPL 
Calculation 

Indicates the specific CPL calculation the S600+ uses. 
Click  to display all valid values.  
Note: This field does not display if you select CH.11 

2004 CUST or CH.11 2004 METRIC as the 
Density Table Units or one of the Gazprom 
options as Product Type because these 
standards also specify the CPL calculation. 

 OFF No CPL calculation.  
 API121 Use API MPMS Ch.11.2.1 1984. 
 API1121M Use API MPMS Ch. 11.2.1M 1984. 

This is the default.  
 API122 Use API MPMS Ch.11.2.2 1986. 
 API122M Use API MPMS Ch.11.2.2M 1986. 
 CONSTANT Use a value you enter.  
 DOWNER Use calculations specified in L. 

Downer’s 1979 paper Generation of 
New Compressibility Tables for 
International Use  

Rounding Indicates whether the S600+ rounds the calculation 
results. Click  to display all valid values.  

 OFF No rounding occurs. This is the 
default.  

 NATIVE Round to the rules specified in the 
selected calculation standard.  

 API Ch.12.2 
Part 2 

Round in accordance with API MPMS 
Ch.12.2 Part 2 – Measurement 
Tickets 1995. 

 API Ch.12.2 
Part 3 

Round in accordance with API MPMS 
Ch.12.2 Part 3 – Proving Reports 
1998. 

 Flocheckl Round in accordance with Emerson 
Flocheck verification software 
package . 

 ASTM 
D1250-04 
Ch.11 

Round in accordance with API MPMS 
Ch.11.1 2004 (ASTM D1250-04) 
method to round to the Petroleum 
Measurement Table 1980 Tables. 

 DECC 1980 DTI/DECC requirements for 
Petroleum Measurement Tables 1980 
Tables. No rounding occurs and an 
iteration tolerance of 0.0001. 

Reference 
Temp 

Sets, in degrees Centigrade, the reference 
temperature for the correction calculations. The default 
is 15 degrees C.  

Alpha Sets the coefficient of thermal expansion. The default 
is 0. 

FFactor Sets the compressibility factor for the liquid (also 
known as the beta factor). The default is 0. 

PE Calculation Sets the option to calculate the fluid’s Equilibrium 
Vapour Pressure. While this is normally assumed to be 
0, you can use it for natural gas liquids (NGL) and 
similar applications. Click  to display all valid values. 

 OFF Do not calculate PE value. This 
is the default.  

 GPA TP-15 1988 
Equation 2 

Use the GPA TP-15 1988 
Equation 2. 
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Field  Description 
 GPA TP-15 2003 

Equation 2 
Use the GPA TP-15 2003 
Equation 2. 

 GPA TP-15 1988 
Equation 3 

Use the GPA TP-15 1988 
Equation 3. 

 GPA TP-15 2003 
Equation 3 

Use the GPA TP-15 2003 
Equation 3. 

BASE DENSITY Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for base density.  
Note: The label on this button changes depending 

on the configuration.  
BASE DENS 
(DT) 

Click to display a Calculation Result dialog box you use 
to define the mode, keypad value, and the specific 
alarm limits for base density.  
Note: This button displays only if you select the 

density to stream option.  
Aromatics 
Type 

Sets the type of aromatics product.  Click  to display 
all valid values. The default is Benzene.  

Aromatics CCF Sets the method for calculating a combined corrector 
factory (CCF) for aromatics products. Valid values are 
Density (calculate using a density you enter) or Table 
1 (calculate use a density from an embedded table).  

Table 6-6. Standard Density Correction Product Selection 
  Product Type 
Density 
Units 

ASTM-IP  
1952 

A  
Crude 

B  
Refined 

C  
Special 

D 
Lube Oils 

Light 
1986 

Light 
TP25 

Light 
TP27 

Table 
Lookup 

User  
K0 K1 

DEG API ASTM 
D1250 
(1952) 
Table 6 

ASTM 
D1250-80 
Table 6A 

ASTM  
D1250-80 
Table 6B 

ASTM  
D1250-80 
Table 6C 

ASTM 
D1250-80 
Table 6D 

n/a n/a n/a User 
lookup 
table 

ASTM 
D1250-80 
Table 6A/ 

User 
K0,K1 

S.G. ASTM 
D1250 
(1952) 

Table 24 

ASTM 
D1250-80 
Table 24A 

ASTM  
D1250-80 
Table 24B 

ASTM  
D1250-80 
Table 24C 

ASTM 
D1250-80 
Table 24D 

n/a GPA TP-
25/ 1988 

Table 24E 

GPA TP-
27 Table 

24E 

User 
lookup 
table 

ASTM 
D1250-80 
Table 24A/ 

User 
K0,K1 

KG/M3 ASTM 
D1250 
(1952) 

Table 54 

ASTM 
D1250-80 
Table 54A 
IP Paper 3 

(1988) 
Table 60A 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 54B 
IP Paper 3 

(1988) 
Table 60B 

(20’C 
Reference 

Temp) 

ASTM  
D1250-80 
Table 54C 

ASTM 
D1250-80 
Table 54D 
IP Paper 3 

(1988) 
Table 60D 

(20’C 
Reference 

Temp) 

ASTM–IP-
API 

Petroleum 
Measurem
ent tables 
for light 

hydrocarb
on liquids 

1986 

n/a GPA TP-
27 Table 

54E 
GPA TP-
27 Table 

60E (20’C 
Reference 

Temp) 

User 
lookup 
table 

ASTM 
D1250-80 
Table 54A/ 

User 
K0,K1 

CH. 11 
2004/7 
CUST 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

CH. 11 
2004/7 
Metric 

n/a ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

n/a n/a n/a n/a n/a 

NORSOK 
I-105 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM  
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

ASTM 
D1250-04 

3. Click any of the following buttons to define live inputs for the 
standard density correction calculations.  
Button  Description 
MTR TEMP  Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter temperature.   
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component.   
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Button  Description 
MTR PRESS Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for meter pressure.  
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component.  
Pe Displays a Calculation Result dialog box you use to 

define the mode, keypad value, and the specific alarm 
limits for observed equilibrium vapour pressure (Pe).  
Note:  This button displays only if you select the 

meter (SEL TO BASE) stream component.   
 
4. Click any of the following buttons to define calculation results for 

the standard density correction calculations.  
Button  Description 
METER 
DENSITY 

Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for meter density. 
Note:  The label on this button changes depending 

on whether you select the DT TO BASE or 
SEL TO BASE stream component.  

METER CCF Click to display a Calculation Result dialog box you 
use to define the mode, keypad value, and the 
specific alarm limits for the combined correction 
factor at the meter (CCFm). 
Note:  This button displays only if you select the 

SEL TO BASE stream component. 
METER CTL Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the temperature of 
the liquid at the meter (CTLm). 
Note:  This button displays only if you select the 

SEL TO BASE stream component. 
METER CPL Displays a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for the correction of the pressure of the 
liquid at the meter (CPLm). 
Note:  This button displays only if you select the SEL 

TO BASE stream component. 
 
5. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
6. Click Yes to apply your changes. The PCSetup screen displays.   

6.9.6 Base Sediment and Water (BSW)  
This option provides base sediment and water (BSW) settings for the 
calculation of the net volume totals.  

1. Select BSW from the hierarchy menu. The BSW screen displays.  
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Figure 6-107. BSW screen   

2. Complete the following fields   
Field  Description 
Calc Select Indicates the standard the S600+ uses for the BSW 

calculations. Click  to display all valid values.  
 IP VII/2 4.12 Use IP VII/2 4.12 standard. This is 

the default.  
 REF METER 

DENS 
Use the meter density; mass = 
meter dry volume * meter density 

 REF STD 
DENS 

Use the standard density; mass = 
std dry volume * std density. 

 US METHOD 1 Use the meter density; mass = 
meter wet volume * meter density. 

 NORSOK 
I-105 

Use Norsok I-105 Appendix D 
method of computing totals. This 
must be used in conjunction with 
the Norsok I-105 Density Table 
Units option.  

 
3. Click any of the following buttons to define BSW parameters.  

Button  Description 
BASE DENSITY Click to display a Calculation Result dialog box you use 

to define the mode, keypad value, and the specific 
alarm limits for base density. 

BSW PERCENT Click to display an Analogue Input dialog box you use 
to define various values for the analogue input.   

Analogue 
Inputs 

Click to display the I/O Setup screen’s settings related 
to the BSW analogue input for the selected stream.   

 
4. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog box displays.  
5. Click Yes to apply your changes. The PCSetup screen displays.   
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6.9.7 Daniel Liquid Ultrasonic  
This option provides an interface between the Modbus comms and the 
generic ultrasonic increments handling.  

The S600+ can generate a totals increment from: 

 Forward or reverse totals from the ultrasonic meter (USM), 
corrected for spool housing effects by the ultrasonic meter using 
temperature and pressure input to the ultrasonic meter. 

 Forward or reverse raw totals not corrected for the spool housing at 
the USM, but corrected in this task using temperature and pressure 
measurements input directly to the S600+. 

 Flowrate calculated by this task from the fluid velocity using the 
selected temperature and pressure. 

 Pulses input from the USM. If there is a good comms link, this task 
produces CTS and CPS values you can use to correct the flow the 
pulse input generates. 

The flowrate read from the USM corresponds to the totals, corrected at 
the USM or corrected at the S600+, and can be positive or negative. 
The flowrate output from this task is always positive and a separate 
object indicates direction. Flow direction for the velocity option is read 
from the USM flow direction object. 

1. Select Daniel Liquid Ultrasonic from the hierarchy menu. The 
Daniel Liquid Ultrasonic screen displays.  

 

Figure 6-108. Daniel Liquid Ultrasonic screen   
2. Complete the following fields.  

Field  Description 
Source Indicates whether the temperature and pressure 

inputs are wired to the USM or to the S600+ I/O. Click 
▼ to display all valid values.  

 USONIC Use USM as the source for the pressure 
and temperature. This is the default.  
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Field  Description 
 I/O Use S600+ inputs as the source for the 

pressure and temperature.  
 Note: If  you do not connect temperature and 

pressure to the USM, disable the pressure 
and temperature expansion correction 
(CTSm/CPSm) at the USM. 

 The system assumes that if pressure and 
temperature are f rom the USM, the task polls for 
the corrected f lowrate and totals, and if pressure 
and temperature are from the S600+ the task polls 
for uncorrected flowrate and totals and applies its 
own CTS and CPS correction. 
If  you acquire the pressure and temperature from 

the S600+ and you do not assign the 
analogues, then the system uses the 
corrected totals from the USM, such as it 
assumes that if you do not assign S600+ I/O 
they must connect to the USM and are read 
f rom USM. 

If  you configure only temperature or pressure (not 
both), the system assumes that the non-
conf igured value is read from the USM and 
the correction is done by the S600+ based on 
the combination of S600+ and serial data. 

Serial Flow 
Type 

Sets the method for generating S600+ totals if you 
select Serial as the Flow Selection option.  . 

 TOTALS Calculate S600+ totals from the 
USM totals. This is the default.  
Note:  The totals format is from Daniel 

Series 3800 Liquid Ultrasonic 
Flow Meter Appendix B.8 Oct 
2006. 

 VELOCITY Calculate S600+ flow rate and totals 
f rom the USM velocity 

Flow Source Indicates the source for generating flow totals.  
 SERIAL  Use the serial comms link. This is the 

default.  
 PULSE I/P Use the pulse input.  

SERIAL + 
PULSE I/P 

Use the serial communications link 
as default and switch to the pulse 
input if  a fault is detected. 
Note: This option requires both a 

serial interface and pulse 
input to be configured. 

Auto switch to 
Serial 

If  selected, the S600+ will revert to using serial 
communications once available. 
Note: This option is available only if you select 

SERIAL + PULSE I/P in the Flow Source. 
Calc Type Sets which calculations the system uses with 

ultrasonic meters. Click to display all valid 
calculations. 

 Daniel 
Equations 

Use Daniel equations for 
ultrasonic meter calculations. 

 ISO17089 
Equations 

Use ISO 17089-1 Annex E 
(Daniel ultrasonic meters, 
correction of meter geometry) for 
ultrasonic meter calculations. 
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Field  Description 
Transducer 
Separation 

Enter the distance, in millimeters, between the first and 
second transducer. 
Note:  
 This field displays only in you select ISO17089 

Equations in the Calc Type field. 
 Enter the average of the transducer separations. 

Distance 
Between the 
Flanges 

Enter the distance, in millimeters, between the inlet 
and outlet flanges of the meter body. 
Note: This field displays only in you select ISO17089 
Equations in the Calc Type field. 

Number of 
Bounces 

Enter the number of reflections in the path between 
transducers. 
Set to 0 (For Daniel USM) 
Note: This field displays only in you select ISO17089 
Equations in the Calc Type field. 

Temperature 
Coef 

Sets the temperature coefficient of the pipe. The 
default is 6e-005. 

Calib 
Temperature 

Indicates the calibrated temperature of the pipe. The 
default is 20. 

Calib Pressure Indicates the calibrated pressure of the pipe. The 
default is 1. 

Pipe Inside 
Diameter 

Indicates the inside diameter of the pipe. The default is 
300. 

Pipe Outside 
Diameter  

Indicates the outside diameter of the pipe. The default 
is 350. 

Young’s 
Modulus 

Indicates the Young's Modulus value of the pipe. The 
default is 2070000. 

Poisson’s Ratio Indicates the Poisson's Ratio value of the pipe. The 
default is 0.3. 

Comms 
Settings 

Click to display the I/O comms screen.  

I/O PRESS Click to display an Analog Input dialog box you use to 
define various values for the analog input. 

I/O TEMP Click to display an Analog Input dialog box you use to 
define various values for the analog input. 

3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog box displays.  

4. Click Yes to apply your changes. The PCSetup screen displays.  
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6.10 Modes of Operation  
Following are the modes of operation for the S600+:  
Mode Description 
Average Uses the value obtained from the average of the last two 

readings. Used on the Analog and PRT/RTD inputs.  
Average 
(Density)  

Uses the value obtained from the average of densitometer 
A and densitometer B. Use when you select the Twin 
Density densitometer option during generation of the 
configuration.  
Note: This option is not valid if there is only a single 

densitometer connected to the flow computer. 
Calculated Uses the calculated value obtained from the relevant 

calculation for the selected item. This option is often used 
when there is a simple choice between one calculated 
result and a fallback keypad value.  

Check Uses a check value to allow a flow computer to be more 
easily checked. This option is normally used for density and 
turbine inputs when a check period or frequency can be 
entered. This option is normally only valid if the flow 
computer is in maintenance mode.  

Chromat Uses the “live” values obtained from the chromatograph 
controller for the selected item.  

Compress Uses the value obtained from compressibility calculations 
for the selected item. This mode uses the calculation you 
select during the generation of the configuration and is 
calculated by the same calculation used t produce the 
compressibility at meter conditions, such as AGA8, 
ISO6976, and GPA2172-ASTMD3588.  

Corrected Uses the value that has been corrected from one condition 
to another. As an example, the pipe diameter will be a 
calibrated diameter at a known temperature. If the current 
temperature is different to the calibrated temperature, the 
corrected pipe diameter will be the diameter corrected to 
current temperature conditions.  

CV Uses the calorific value and uses the compressibility value 
at base conditions calculated by ISO6976 or GPA2172-
ASTMD3588. This mode uses the calculation you select 
during the generation of the configuration.  

Dens A Uses the value obtained from Densitometer A. Used on the 
Density inputs.  

Dens B Uses the value obtained from Densitometer B. Used on the 
Density inputs.  
Note:  This option is not valid if there is only a single 

densitometer configured. 
Keypad Uses a value entered on the keypad or web access server 

interface or fallback value for the selected item.  
Lastgood Uses the last good value obtained from the input. Used on 

analog and PRT/RTD inputs.  
Measured Uses the measured value from a transmitter for the selected 

item. The measured value is converted from the raw input 
prior to use. As an example a pressure input would be first 
seen by the flow computer as raw current (mA) value but 
will be displayed as the calculated pressure value according 
to the scaling of the input.  
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6.10.1 Density Failure Modes  
Following are the failure modes of operation for the S600+:  

KF and MF 
Linearisation 

You may enter a 16-point curve for both K-factors and meter factors. 

The curves consist of pairs of turbine frequency versus K-factor and 
turbine frequency versus meter factor points and linear interpolation 
based on turbine frequency is performed between these points. 

The polynomial curve fit (US requirement) is not yet implemented. 

The in-use K-factor and meter factor may be selected from the 
linearised (calculated) values or from an operator entered keypad 
value. Any combination of linearised/keypad K-factor and meter factor 
is selectable. 

On completion of a successful prove, the prover micro is able to 
download a new K-factor or meter factor and associated turbine 
frequency to the stream. These values are placed in the K-factor or 
meter factor curves by overwriting the entries nearest to them in the 
existing curves. 

Density The system supports single or twin densitometer. 
A densitometer fail frequency is included in the system and if a 
densitometer falls below this frequency it is deemed to have failed and 
the corresponding density value is set to zero. This prevents negative 
densities arising from very low frequency inputs. 

Currently there is no densitometer fail upper limit. Any frequency is 
considered OK. In practice the hardware will be the limiting factor. 

On detection of a densitometer failure an alarm occurs: 

 FAIL A – Dens A has failed 
 FAIL B – Dens B has failed 

These alarms are suppressed in maintenance mode and below low flow 
cut off. You can enter a densitometer check period for test purposes. 
This is only possible only in maintenance mode. 

Densitometer failure handling:  

 If KEYPAD is selected, density stays in KEYPAD mode. 
 If DENS A is selected: 
 If transducer A is OK, DENS A remains selected. 
 If transducer A fails, DENS B automatically selected. 
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Chapter 7 – Advanced Setup Configuration 
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You initially define the Advanced settings—which include conversion 
factors, totals descriptors, alarm mappings, Passwords and stream-to-
station mappings—when you create an S600+ configuration file. To 
edit these settings, select Advanced Setup in the PCSetup Editor.  

7.1 Conversions/Constants 
S600+ acquires the default conversion factors from the API 
Publication 2564, Chapter 15. However, you can edit these settings. If 
the units/conversions have been changed elsewhere, change the values 
in Conversions including Density of Water.  

Note: The S600+ does not perform unit conversions on 
coefficients. For that reason, always ensure that the coefficients 
are related to the selected units. For example, if the Gas Orifice 
Stream units are in degrees Celsius and millimeters, make sure 
the expansion coefficients for the Orifice and Pipe diameters 
are values corresponding to m3/mm°C. 

7.1.1 Editing Conversions/Constants 
To edit the conversion factors:  

1. Select Conversions/Constants from the hierarchy menu. The 
Conversions/Constants screen displays.  
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Figure 7-1. Conversion/Constants screen  

2. Review and modify the conversion factor values for Mass, 
Volume, Temperature, Energy, Length, Misc, and Density.  

3. Complete the values in the Pressure pane in psia or bara. The local 
pressure displays in the engineering units you select. 

Notes:  
 Click Units Editor to switch between the 

Conversions/Constants screen and the Units option in System 
Setup. 

 The AtmP@Live (bara/psia) can be updated to reflect the 
actual atmospheric pressure value based on the pressure units 
selected. 

4. When you are through defining the settings, click in the hierarchy 
menu. A confirmation dialog box displays.  

5. Click Yes to apply the changes. The PCSetup screen displays. 

7.2 Totals Descriptions 
Config600 applies any changes you make on the Totals Descriptions 
screen elsewhere in the configuration and uses these descriptions for 
totals calculations. 

Note: The system displays abbreviated short descriptions on the front 
panel, remote front panel and reports. The system creates these 
short descriptions based on the standard descriptions. For 
example, “STR01 UVOL” becomes “UVOL” and “PRV01 
MASS.” These short descriptions are only created for the 
standard descriptions. If you change a description, the system 
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does not create a short description and instead displays the new 
full description in the short description field. 

7.2.1 Editing Totals Descriptors  
To edit the descriptor for any of the listed totals:  
1. Select the Totals Descriptors component from the hierarchy 

menu. The Totals Descriptors screen displays.   

  

Figure 7-2. Totals Descriptor screen  

2. Double-click a Description. The system displays an Edit 
Description dialog box. 

 

Figure 7-3. Edit Description dialog box  

3. Edit the Description as necessary. 

4. Click OK to apply your edits. The Totals Descriptor screen 
redisplays showing your new description.  

7.3 Alarms 
Config600 allows you to individually enable or disable S600+ alarms. 
You can also establish up to 16 alarm groupings (for ease of polling) or 
poll alarms individually. Normally you do not need to change the 
default alarm groups for each alarm.  
Config600 defines three default alarm groups.  
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 Computer (Group 1). This group generally includes failures of the 
computer or the program internally.  

Note: This alarm is permanently routed to the watchdog alarm 
relay on the CPU module’s processor board. You cannot 
remove this routing, since it is implicit in the S600+ code 
(see Chapter 3, CPU Module, in the FloBoss S600+ Flow 
Computer Instruction Manual (part D301150X412).   

 Process (Group 2). This group generally includes limits, such as a 
high or low Analog Input. 

 System (Group 3). This group generally includes I/O failures, such 
as an under-range alarm on an Analog Input. 

You can define up to 13 more report groupings.  

The Available Alarms dialog box lists all of the system modules, 
which have associated alarms. Config600 displays the associated 
alarms as you select the module. A check indicates the enabled alarms.   

7.3.1 Editing Alarms   
To edit the alarm configuration: :  

1. Select the Alarms component from the hierarchy menu. The 
Alarms screen displays.   

 

Figure 7-4. Alarms screen  
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2. Select Alarm System Operation parameters:  
Field  Description 
Alarm Mode Indicates whether the system reports or time-

stamps an alarm as cleared once it has been 
acknowledged. Valid values are:  

 Latched Prevents system from reporting or 
time-stamping an alarm as 
cleared until it has been 
acknowledged; the value 
automatically sets when entering 
an alarm value and clears when 
leaving the alarm value.  
Note: The default value is 

Latched. 
 Unlatched System reports and time-stamps 

an alarm as cleared as soon as 
the error conditions have been 
resolved; value automatically sets 
when entering an alarm value and 
automatically clears when leaving 
the alarm value. 
Note: Selecting Unlatched may 

result in the alarm log 
f illing up more quickly 
when f leeting alarms 
occur. 

Print 
Alarms/Events 

Select this check box to send alarm reports to the 
printer as they are raised, cleared, and 
acknowledged.  

Archive 
Alarms/Events 

Select this check box to save alarm reports to an 
alarm history file. You can still query on these 
values.  

Printer Comms Click to access the Printer definition on the Comms 
Links screen in I/O Setup.  

 

3. Define Alarm Archive Size parameters:  
Field  Description 
Automatic Select this check box to automatically save alarms to 

the Alarm Archive file.  
Note: If  you select this option, you cannot use the 

Alarms field to indicate a specific number of 
archived alarms. Instead, the S600+ archives 
alarms based on memory resources, as well as 
the settings in the Event Archive Size fields.  

Alarms Indicates the total number of alarms you want to save 
in the Alarm Archive file.  
Note: If  you complete this field, you cannot use the 

Automatic function. You may also find that your 
configuration will not cold start if you do not 
have enough memory. To resolve this, you 
may need to reduce the number of alarms 
saved in the archive file.  
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4. Define Event Archive Size parameters:  
Field  Description 
Automatic Select this check box to automatically save events to 

the Event Archive file. If you complete this field, you 
cannot use the Automatic function. 
Note: If  you select this option, you cannot use the 

Events field to indicate a specific number of 
archived events. Instead, the S600+ archives 
events based on memory resources, as well as 
the settings in the Alarm Archive Size fields. 

Events Indicates the total number of events you want to save 
in the Event Archive file.  
Note: If  you complete this field, you cannot use the 

Automatic function. You may also find that your 
configuration will not cold start if you do not 
have enough memory. To resolve this, you 
may need to reduce the number of events 
saved in the archive file. 

 

5. Select an alarm from the list of available alarms. For example, 
click on SYS HOST.  

6. Enable—or disable—an alarm by selecting each check box.  

7. Assign the alarm to a Group, if necessary. Click  to display 
available alarm groupings.  

8. If you enable an object's alarm limit, the Limits field displays the 
value of that limit. 

9. When you are through defining alarms, click in the hierarchy 
menu. A confirmation dialog box displays:  

10. Click Yes to apply the changes. The PCSetup screen displays.  

7.3.2 Alarm and Event Descriptions 
The following alphabetic list describes alarm and event codes. 

Note: The majority of events are self-explanatory. Events that require 
explanation are listed below.

Code  Description 
A-FAIL Occurs when turbine channel A is either open or has a 

short circuit.  
ABT 1 Occurs when the prover has aborted. The prover 

displays an error code to assist with diagnosing the 
cause of the abort.  

ADDNLS Occurs if the additionals (ADDitioNaLS) do not add up 
to 100% or if you have also defined an additional 
component in the “Splits.”  

B-FAIL Occurs when turbine channel B is either open or has a 
short circuit.  

BAD PULSE Occurs when the number of bad pulses exceeds the 
alarm threshold.  

BATT FAIL Occurs when the battery voltage has fallen below 2.8 
volts and should be replaced as soon as possible.  

BLOCKED Occurs when the flow computer detected that the filter 
is blocked.  
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Code  Description 
CALC FAIL Occurs when a general calculation failure has occurred 

in this task.  
CAN FULL Occurs when the Sampler can is 100% full.  
CAN HIGH Occurs when the Sampler can contents exceed the 

high alarm limit.  
CHROM TELEM 
CONFIG 

Occurs when a new analysis is available from the GC, 
but a fault associated with the MOLE SELECT SPLITS 
or ADDNLS alarms is present. 

CHROM TELEM 
CRITICAL 

Occurs when the GC is indicating a Critical alarm. See 
Section K.4.7, Critical Alarms. 

CHROM TELEM 
MOLE DV 

Occurs when a component, or the total, of the new 
composition set from the GC is deviates from the 
previously received value by more than the limit. See 
Section K.4.3, Deviation. 

CHROM TELEM 
MOLE HI 

Occurs when a component, or the total, of the new 
composition set from the GC is higher than the high 
limit. See Section K.4.2, High/Low Limits. 

CHROM TELEM 
MOLE LO 

Occurs when a component, or the total, of the new 
composition set from the GC is lower than the low limit. 
See Section K.4.2, High/Low Limits. 

CHROM TELEM 
NCRITICAL 

Occurs when the GC is indicating a Non Critical alarm. 
See Section K.4.8, Non-Critical Alarms. 

CHROM TELEM 
REP TOUT 

Occurs when the GC has not indicated that a new 
composition set is available within the timeout period 
specified. See Section K.4.9, Timeouts. 

CHROM TELEM RX 
FAIL 

Occurs when the timeout period for the GC to respond 
has expired. See Section K.3, Chromat Telemetry. 

COLD ST Occurs when the S600+ has performed a Cold Start, 
all settings have been re-initialized.  

COMMON Occurs when any of the alarms in displayed group 
occur. This is a common alarm if you use only a 
minimum alarm set. You then need to determine the 
cause of the problem.  

COMPLETE Occurs when the batch total is greater than the 
required total (that is, the batch has completed).  

CONF CSUM Occurs when parameters in the configuration 
(CONFiguration CheckSUM) have changed. The 
S600+ calculates a configuration checksum as part of 
its background tasks and compares it against the 
previous checksum on a rolling basis.  

CONF ERR Occurs when there is an error in the configuration 
(CONFig ERRor). Remove the S600+ from service if 
this alarm occurs and immediately contact either the 
person who configured your application or technical 
support personnel.   
Note: This alarm can also occur from the IO Section. 

If  an I/O board CONF ERR occurs, remove the 
S600+ from service and exchange the faulty 
I/O board with a replacement before returning 
the S600+ to service.  

CONFIG Occurs when either the Additionals or Splits 
(CONFIGuration error) are in error. This alarm is only 
raised on receipt of a good composition.  

CONFIG CHG Occurs when the configuration held in the Coriolis 
transmitter has changed.  

CRC FAIL Occurs when the S600+ receives a bad checksum.  
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Code  Description 
CRITICAL Occurs when S600+ receives either a Critical or Non-

Critical alarm from an attached 2251, 2551 or 2350 
chromatograph controller.  
The following alarms have been classified as Critical 
and Non-Critical on a 2551 EURO or 2350 EURO 
European chromatograph controller:  

 CRITICAL Peak Overflow, Unknown Error, Peak 
Analysis, Peak Analysis Start, I/O 
Start Failure, Stack Overflow, Buffer 
Overflow, Input Out of Range, 
Preamp Fail, Autostart Fail, Analysis 
Fail, Autostart Alarm. 

 NON-
CRITICAL 

ADC 1 Fail, ADC 2 Fail, ADC 3 Fail, 
Preamp Adjust, Calibration Fail, 24 
Hour Average. 

 The following alarms have been classified as Critical 
and Non-Critical on a 2251 USA or 2350 USA 
chromatograph controller:  

 CRITICAL Preamp Fail, Analysis Fail. 
 NON-

CRITICAL 
ADC 1 Lo or Failed, ADC 2 Lo or 
Failed. 

DATA TOUT Occurs when the Ultrasonic Meter has failed to 
communicate within the time-out period. This forces 
the flowrate to zero.  

DENIED Occurs when the selection algorithm has determined 
that a range change is required but no suitable cell is 
available.  

DENS LIMIT Occurs when the density of the Coriolis transmitter is 
out of limits.  

DEV ERR Occurs when any of the alarms (DEVice ERRor) in 
displayed group occur. This is a common alarm if you 
use only a minimum alarm set. You then need to 
determine the cause of the problem.  

DEV OPEN Occurs when the I/O module has failed to 
communicate correctly with the identified device 
(DEVice OPEN). A system fault.  

DISCREP Occurs when operating within range and a 
discrepancy in the engineering values returns from two 
or more cells.  

DL COMP Occurs when that the downloaded set has been 
rejected. This can be because one of the components 
is outside the limits for that component or because the 
sum of the downloaded components is less than 98% 
or greater than 102%.  
Note: No normalisation of a download set occurs - 

the downloaded composition is expected to 
already be normalised to 100%. 

DL T/OUT Occurs when the S600+ has not received an updated 
composition from the supervisory system within the 
configured Download Timeout period. 

DP INCREMENT I/P 
ERR 

Occurs when differential pressure is not greater than or 
equal to 0.0. 

DRV GAIN Occurs when the Drive Gain of the Coriolis transmitter 
has gone over range.  
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Code  Description 
DSCRP Occurs when the identified variable exceeds the 

discrepancy limit (DiSCRePancy) from the check value 
for longer than the time-out period. This alarm is used 
where two transducers are checked against each other 
or where the process variable is checked against 
previous values.  

EEPROM FAIL Occurs when a Checksum failure has been detected in 
the Coriolis transmitter.  

ERROR Occurs when the Coriolis transmitter has reported an 
error.  

EVENT 1 Occurs when the Coriolis transmitter has reported that 
Event 1 is ON.  

EVENT 2 Occurs when the Coriolis transmitter has reported that 
Event 2 is ON.  

EXCEPTION Occurs when a Modbus Exception reply has been 
received from the other computer.  

FAIL A Occurs when the densitometer frequency is below 
1Hz, or the measured period is outside the period 
limits, or the calculated density is negative.  

FAIL B Occurs when the densitometer frequency is below 
1Hz, or the measured period is outside the period 
limits or the calculated density is negative.  

FAIL CH_A For Daniel Gas Ultrasonic meters, occurs when bit 14 
of  the CHORD A status byte is set. 

FAIL CH_B For Daniel Gas Ultrasonic meters, occurs when bit 14 
of  the CHORD B status byte is set. 

FAIL CH_C For Daniel Gas Ultrasonic meters, occurs when bit 14 
of  the CHORD C status byte is set. 

FAIL CH_D For Daniel Gas Ultrasonic meters, occurs when bit 14 
of  the CHORD D status byte is set. 

FAIL IO'x' (1-7) Occurs when I/O module 'x' has failed to communicate.  
FAIL WARN Occurs when any of the alarms in displayed group has 

been raised. This is a common alarm if you use only a 
minimum alarm set. You then need to determine the 
cause of the problem.  

FATAL CRD For Daniel Gas Ultrasonic meters, occurs when bit 8 of 
the SYSTEM STATUS byte is set. 

FIXED VEL Occurs when a keypad-entered flow velocity is in use.  
FRQ O-RNGE Occurs when the Coriolis reports the frequency is over 

range.  
H Occurs when the In-Use value for the identified 

variable exceeds the Hi alarm limit.  
HH Occurs when the In-Use value for the identified 

variable exceeds the Hi Hi alarm limit.  
HIGH PRD Occurs when the Measured period exceeds (HIGH 

PeRioD) the high period alarm limit.  
H/W FAIL For Daniel Gas Ultrasonic meters, occurs when bits 1, 

2, 3, 4, 5, 6 and 7 of the SYSTEM STATUS byte is set. 
ILLEGAL Occurs when the valve status inputs indicate that the 

valve is not in a valid position (that is, not Open, 
Closed, or Moving).  

INTEG-FAIL Occurs when the S600+ detects the constant current 
for the PRT/RTD circuitry to be outside the range  
0.8 mA to 1.5 mA (INTEGrity FAIL).  

INVALID INC Occurs when the S600+ receives an invalid increment 
f rom the Coriolis transmitter.  
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Code  Description 
I/P ERR Occurs when an input to the calculation is outside the 

valid range.  
IP O-RNGE Occurs when the Coriolis transmitter reports an input is 

over range.  
K_COMP Occurs when the keypad entered composition is 

outside the limits set on the Gas Composition page on 
PCSetup. This check applies to the total and the 
individual components.  

L Occurs when the In-Use value for the identified 
variable falls below the Low alarm limit.  

LL Occurs when the In-Use value for the identified 
variable falls below the Low Low alarm limit.  

LINK 'x' (1-10) Occurs when slave address 'x' is in fault condition.  
LOW FLOW Occurs when the flow rate falls below the low flow rate 

alarm limit set on the sampler page of PCSetup.  
LOW PRD Occurs when the Measured period falls below the low 

period (LOW PeRioD) alarm limit  
MA IP ERR Occurs when the Coriolis transmitter reports a failure of 

its analog input.  
MA OP FXD Occurs when the analog outputs of the Coriolis 

transmitter have been fixed.  
MA OP SAT Occurs when the analog outputs on the Coriolis 

transmitter are saturated.  
MOLE DV Occurs when any component (MOLE DeViation) 

exceeds the deviation limit percentage set up in 
PCSetup on the Gas Composition page. This alarm is 
raised for the complete composition; diagnose the 
component that is in error.  

MOLE HI Occurs when any component exceeds the highest 
acceptable percentage set up in PCSetup on the Gas 
Composition page. This alarm is raised for the 
complete composition; diagnose the component that is 
in error.  

MOLE LO Occurs when any component falls below the lowest 
acceptable percentage set up in PCSetup on the Gas 
Composition page. This alarm is raised for the 
complete composition; diagnose the component that is 
in error.  

MOLE SELECT 
ADDNLS 

Occurs when an additionals component is outside of 
the low or high limit, an additionals component is also 
present in the composition set from the GC, or an 
additionals component is also defined in the Mole 
Splits set. See Section K.4.5, Additionals. 

MOLE SELECT DL 
COMP 

Occurs when a component, or the total, of the 
Download composition set is outside of the low or high 
limit. See Section K.4.2, High/Low Limits. 

MOLE SELECT 
K_COMP 

Occurs when a component, or the total, of the keypad 
entered composition set is outside of the low or high 
limit. See Section K.4.2, High/Low Limits. 

MOLE SELECT 
SPLITS 

Occurs when the entered Mole splits do not add up to 
100%. See Section K.4.6, Splits. 

MOLE SELECT 
USER COMP 

Occurs when a component, or the total, of the User 
composition set is outside of the low or high limit. See 
Section K.4.2, High/Low Limits. 
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Code  Description 
MONITOR Occurs when the software watchdog time has timed-

out for this task.  
Note:   If  this alarm is raised on a Modbus Master TCP 

task, it indicates that the communications link 
has been broken (i.e. the S600+ master cannot 
open a connection to the slave) and has 
therefore caused the software watchdog to time 
out.  

MOVE FAIL Occurs when the valve has not reached the required 
position within the allowable time-out period.   

MOVE UNCM Occurs when the valve has moved position without 
any command being issued (MOVE UNCoMmanded).   

NCRITICAL Refer to CRITICAL. 
NEG FLOW Not used. 
NO PERMIT Occurs when an item in the configuration is locked or 

write protected by the flow computer.  
O-FLOW Occurs when the high frequency limit has been 

exceeded. Some pulses may be unaccounted for.  
O-RANGE Occurs when the raw input exceeds acceptable 

values. For Analog Inputs this value can be entered 
but defaults to 20.5 mA. For PRT/RTD inputs the limit 
is 216 ohms. For the case of the Analog Outputs, the 
value to be output is higher than the high scale value.  

O/P ERR Occurs when an output to the calculation is outside the 
valid range.  

OVERFLOW Occurs when the Pulse Output cannot match the 
required pulse rate or when the number of pulses to be 
output exceeds the pulse reservoir.  

PATH 1 ERROR For SICK Ultrasonic meters occurs when bit 5 of the 
SYSTEM STATUS byte is set. 

PATH 2 ERROR For SICK Ultrasonic meters occurs when bit 6 of the 
SYSTEM STATUS byte is set. 

PATH 3 ERROR For SICK Ultrasonic meters occurs when bit 7 of the 
SYSTEM STATUS byte is set. 

PATH 4 ERROR For SICK Ultrasonic meters occurs when bit 8 of the 
SYSTEM STATUS byte is set. 

PERIOD END 
MISSED EVENT 

The I/O comms cycle checks for the end of every 
minute in the S600+. If the end of the minute is missed 
because the IO task is busy, then this event is raised.  
Note: 
 If  the event is raised and it is not a configured 

period end (i.e. no reports are required), then it is 
logged for informational purposes.  

 If  the event is raised and it is a configured period 
end, then it is logged for informational purposes 
and the report will be re-generated to ensure no 
reports are missed. 

PIC FAIL Occurs when the S600+ detects a hardware failure of 
the indicated I/O board (I/O Board Hardware Failure). If 
this alarm occurs, remove the S600+ from service and 
replace the faulty I/O board before returning the S600+ 
to service.  

PR OP FXD Occurs when the primary Analog Output of the Coriolis 
transmitter is in fixed mode.  

PR OP SAT Occurs when the primary Analog Output of the Coriolis 
transmitter is saturated.  
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Code  Description 
PRE WARN Occurs when a batch is at 'n'% where 'n' is set on the 

Batching page in PCSetup.  
PRINTING ERR Occurs when the internal printer queue is filled. This 

may clear if the printer is made available but some 
data may have been lost.  
Note: When requesting report printouts, a five second 

delay should be observed between print 
requests to allow the report to be generated. 

PWR RESET Occurs when a power reset occurs on the Coriolis 
transmitter.  

RESET Not used. 
RAM FAIL Occurs if the S600+ detects a discrepancy between 

the data written to and from RAM. The S600+ 
continually writes data to RAM and reads it back for 
comparison. If this alarm occurs, remove the S600+ 
f rom service.   
Note: This alarm is also used to check the I/O board 

RAM; the alarm indicates the area of failure. 
REP MISSED Occurs if a periodic report has not been generated due 

to CPU Overloading. 
ROM FAIL Occurs if the S600+ detects a discrepancy between 

the S600+-calculated checksum and a preset 
checksum. If this alarm occurs, remove the S600+ 
f rom service.  
Note: This alarm is also used to check the I/O board 

ROM; the alarm indicates the area of failure.  
ROC Occurs when the ROC (Rate Of Change) exceeds the 

alarm limit for the identified variable.  
RT INT Occurs when the Coriolis transmitter has had a Real 

Time interrupt failure.  
RX FAIL Occurs when the reply from the slave computer has 

not been received within the time-out period.  
SAMPLER Occurs when the sampler has been commanded to 

reset by the batching, but has not reset.  
SCALING Occurs when the scaling values for the identified 

variable are either the same or the high scale value is 
lower than the low scale value.  

SEAL FAIL Occurs when the valve reports that it has not sealed 
during the test period.  

SEC BREACH Occurs when a security breach has been detected in 
the Coriolis meter. 

SEC OP SAT Occurs when the secondary Analog Output of the 
Coriolis transmitter is saturated.  

SEC OP FXD Occurs when the secondary Analog Output of the 
Coriolis transmitter is in fixed mode.  
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Code  Description 
SEL TO BASE I/P 
ERR 

Occurs when a density input is out of range. Possible 
inputs include: 
 Density Units 
 Product Type 
 CPL Calc Type 
 Rounding Enable 
 REF Temperature 
 Alpha 
 FFactor 
 Iteration Type 
 HYC Enable 
 OBS Density 
 OBS Temp 
 OBS Press 
 Pe 
 Aromatic Product 
 Aromatic Density 
 PE100 
 PE Calc Type 
 
The limits to these inputs are user-defined based on 
the data type. 

SELECT Occurs when all cells have failed (a fatal cell selection 
error) or are in Keypad mode.  

SELF CALIB Occurs when the Coriolis transmitter performs a self-
calibration.  

SENS FAIL Occurs when a Sensor failure is detected at the 
Coriolis transmitter.  

SLUG FLOW Occurs when the Coriolis transmitter reports slug flow.  
SPEED Occurs when the Pulse Output for the sampler cannot 

match the required pulse rate. The number of pulses to 
be output has exceeded the pulse reservoir.  

SPLITS Occurs if the total of the splits does not equal 100%.  
STOPPED Occurs when the sampler has stopped.  
TASK ERR Occurs when a task within the I/O module detects an 

error.  
TASK FAIL Occurs when a task within the I/O board fails.  
TEMP FAIL Occurs when the Coriolis temperature sensor fails.  
TOT CORR Occurs when all three totals tri-registers disagree 

(TOTals CORRupt). Totalization is inhibited. Take the 
S600+ out of service and perform a Totals Reset.  

TOT PART Occurs when only two of the three totals tri-registers 
agree (TOTals PARTially corrupt). The S600+ corrects 
the third register automatically and clears the alarm.  

TOT RES Occurs when the totals have been reset to zero 
(TOTals RESet).   

TOT ROLL OVR Occurs when at least one of the totals within the 
S600+ reaches its maximum value and rolls over to 
zero (TOTals ROLL OVeR).  

TOT ROLL UDR Occurs when at least one of the totals within the 
S600+ rolls under zero (TOTals ROLL UnDeR).   
Note: This should occur only if using reverse totals. 
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Code  Description 
TPU FAIL Occurs when the S600+ detects a hardware failure of 

the indicated I/O module (I/O module hardware failure 
system fault).   
Note: If  this alarm occurs, remove the S600+ from 

service and replace the I/O module before 
returning the S600+ to service.  

TSK ERR Occurs when any of the alarms in displayed group 
occur (TaSK ERRor). This is a common alarm if you 
use only a minimum alarm set. You then need to 
determine the cause of the problem.  

TSK OFLOW Occurs when the S600+ traps an attempt to write an 
inf inite number.  

TX CONFIG Occurs when the Coriolis transmitter reports that it is 
not configured.  

TX ELEC Occurs when the Coriolis transmitter reports an 
electronics failure.  

TX FAIL Occurs when the S600+ is unable to place the 
information to the flow computer hardware (system 
fault).   

U-RANGE Occurs when the raw input falls below acceptable 
values. For Analog Inputs this value can be entered 
but defaults to 3.5 mA. For PRT/RTD inputs the limit is 
60 ohms. For the case of the Analog Outputs, the 
value to be output is lower than the low scale value.  

UNAVAIL Occurs when the signal for Local or Remote control 
f rom the valve indicates the valve is in local control 
(UNAVAILable).  

UNDEFINED Occurs when the Coriolis transmitter reports an 
undefined error.  

VCONE I/P Occurs when a V-Cone input is out of range. Possible 
cause include: 
 Differential pressure is not greater than or equal to 

0.0 
 Gas density is not greater than or equal to 0.0 
 (pipe diameter ration) ̂ 4 is not greater than or equal 

to 1.0 
WARM ST Occurs when the S600+ performs a Warm Start, 

possibly due to a power dip or software failure. 
Settings have been retained. In the I/O alarms section 
this alarm indicates if an I/O board has restarted.  

WARN CH_A For Daniel Gas Ultrasonic meters, occurs when bit 13 
of  the CHORD A status byte is set. 

WARN CH_B For Daniel Gas Ultrasonic meters, occurs when bit 13 
of  the CHORD B status byte is set. 

WARN CH_C For Daniel Gas Ultrasonic meters, occurs when bit 13 
of  the CHORD C status byte is set. 

WARN CH_D For Daniel Gas Ultrasonic meters, occurs when bit 13 
of  the CHORD D status byte is set. 

WARNING Occurs when at least one cell has failed or is in 
Keypad mode.  

ZERO DIV Occurs when the S600+ traps an attempt to divide by 
zero.  

ZERO LOW Occurs when the zero value of the Coriolis transmitter 
is too low.  

ZERO HIGH Occurs when the zero value of the Coriolis transmitter 
is too high.  
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Code  Description 
ZERO NOISE Occurs when the signal into the Coriolis transmitter is 

too noisy.  
ZERO OP Occurs when the Coriolis transmitter has failed in its 

zeroing operations.  
ZERO PROG Occurs when the Coriolis transmitter is currently 

zeroing.   

7.4 Security 
The Config600 suite of programs is protected by a multi-level security 
system that both restricts access to authorised system users and 
determines which data items system users can enter or modify. Each 
system user is assigned a security access Level (between 1 and 9) and 
a password. Security access Level 1 provides the largest number of 
privileges; Level 9 provides the fewest number of privileges. Access to 
any one level provides access to all the other less-privileged levels 
(that is, Level 3 access has the privileges of Levels 4 through 9 but is 
denied privileges of Levels 2 and 1).  
When you send the configuration to the S600+, the security settings 
(including the user access levels) become the login Passwords for 
access via the front panel and webserver. 

You can define a maximum of 50 users on each configuration file. You 
cannot repeat the username or S600+ password for any user, since the 
S600+ uses this value to determine who logged in when changes are 
made through the S600+ front panel or PCSetup.  

Note: By default, PCSetup opens with the user logged on a Level 1 
security. To activate the security on PCSetup, you must enter a 
username and a PCSetup password for Level 1 security (see 
Figure 7-5). The PCSetup program does not allow you to delete 
Level 1 logins.  

If you do not enable Level 1 security at PCSetup, this allows anyone to 
modify the configuration at PCSetup. The default S600+ front panel 
password is configured so that only authorized personnel can change 
data at the S600+ front panel.  

Note: With Security Level 1, any items you change using the S600+ 
front panel create checksum alarms. Any objects at Security 
Level 1 change the NMI checksum. Security Level 1 is 
activated when jumper P3 is OFF (see Chapter 3, CPU Module, 
in the FloBoss S600+ Flow Computer Instruction Manual, part 
D301150X412).   

7.4.1 Editing Security  
To edit security settings:   

1. Select the Security hierarchy menu. The Security screen displays.  
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Figure 7-5. Security screen  

2. Using the Security for Data Editing pane, complete the Required 
Level field to assign an access security level (1 through 9) to each 
of the PCSetup data item groups. Remember that 1 is the most 
comprehensive level of access and 9 is the most restrictive level of 
access. 

Note: Click Displays/Webserver to switch between this screen 
and the Displays/Webserver screen. This helps you 
determine which functions should have webserver access.  

3. Click Add in the Passwords pane to add a Password for an 
additional user. The Passwords dialog box displays.  

 

Figure 7-6. Passwords dialog box  

4. Complete the following fields:  
Field  Description 
Username Enter a name the user types to access the relevant 

program. The S600+ also prints this Username on 
event logs to show which user logged in to change 
parameters.  
Note:  
 This value is case-sensitive.  
 Valid special characters are: - . / : = @ [ ] ̂  _ 
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Field  Description 
PC Password Enter an alphanumeric value up to 15 characters in 

length to log on to the Config600 software applications. 
For security, a password should be a random 
combination of numbers and upper- and lower-case 
letters. 
Note:  
 This value is case-sensitive.  
 Valid special characters are: - . / : = @ [ ] ̂  _ 

S600 Password Enter a number (click  or  to increase or decrease 
the values) the user must provide to change 
parameters using the S600+ front panel.  

Security Level Enter a number (between 9 and 1) to indicate the 
Security Level associated with this user ID.  

 
5. Click OK to apply the changes. The Security screen displays, 

showing the user ID you have just defined.  

Note: The following message appears if you enter invalid special 
characters in the Username or PC Password fields. Valid 
special characters are: - . / : = @ [ ] ^ _ 

 

 

7.4.2 Editing/Deleting Passwords  
As administrator, you may need to edit, reset, or remove system 
Passwords:  

1. Click a username in the Passwords pane. Config600 adds two 
buttons (Edit and Delete) to the pane.  
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Figure 7-7. Security screen, Password Edits 

2. Click Edit to display the Passwords dialog box for that username.  

Note: You can also double-click the username to immediately 
display the Passwords dialog box.  

 

Figure 7-8. Passwords dialog box  

Note: To delete a password, click Delete. Config600 removes the 
password from the Passwords pane. 

3. Modify the content as necessary.  

4. Click OK to apply your changes. The Security screen displays.  

7.4.3 Data Item Security 
You can also assign security levels to individual data items on the 
hierarchy menu. This provides an additional level of system security.  

Note: Because of the variation in the nature of data items, this process 
varies slightly from data item to data item. This section is 
presented as an example to familiarize you with the general 
concept of applying security to data items.  

1. Select a component from the hierarchy menu (in this example, 
select Units from the System Setup hierarchy).  
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Figure 7-9. Data Item Security  

2. Select Edit > Security (using the menu bar at the top of the 
screen). The Security dialog box (in this case, security for units) 
displays.  
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Figure 7-10. Units Security dialog box  

3. Review the current Security Levels. If appropriate, select a data 
point from the menu. Config600 completes the Security Level field 
with that item’s current security level.  

 

Figure 7-11. Units Security Level  

4. Change the value in the Security Level field, if necessary.  

5. Click Apply to apply the change.  

6. Once the new value displays in the Security Level column, click 
Done to close the dialog box and redisplay the data item screen.  

7.4.4 PCSetup Editor Login 
If you enable Level 1 security, Config600 restricts access to the 
PCSetup Editor by a login procedure. You cannot make any changes 
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or perform any functions in PCSetup Editor until you complete 
login. Each system user has an assigned security Level that determines 
the type of data that user can enter or modify. 

Login To log in to PCSetup:  
 

1. Select File > Login from the PCSetup menu bar. The Login dialog 
box displays. 

Note: You can also click the Login icon  to open the Login 
dialog box. You see this same dialog box when you open a 
configuration file using the PCSetup Editor.  

 

Figure 7-12. Login dialog box  

2. Enter your username.  

3. Enter your case-sensitive password. Config600 uses asterisks (***) 
to mask the actual characters you type.  

4. Click OK. If Config600 recognizes your username and password, 
the PCSetup screen displays.  

Checksum Before sending a configuration file to the S600+, Config600 checks 
the configuration to make sure it has not been manually modified. 

Config600 accomplishes this by calculating a checksum on the file. If 
the calculated and recorded checksums do not match, Config600 
displays a warning message. To repair the configuration checksum, 
you must login to PCSetup with the Level 1 username and password. 
Once Config600 recognizes and accepts that username and password, 
it saves the file with the correct checksum. Click Cancel to stop 
Config600 from correcting the checksum.  

Note: You cannot transfer a configuration from the host PC to the 
S600+ with an incorrect checksum.  

7.5 Displays/Webserver 
Use the Displays/Webserver  option to determine what information 
each security level (1-9) may access using the webserver.  
 

Caution 
Once you have assigned users to an access level, verify (and modify, if 
necessary) the amount of information available to them. 
 

Note: Click Security to switch between this screen and the Security 
screen. This helps you determine which functions should have 
webserver access.  
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7.5.1 Editing Displays/Webserver  
To edit displays and webserver access: 

1. Select the Displays/Webserver component from the hierarchy 
menu. The Displays/Webserver screen displays.  

  

Figure 7-13. Displays/Webserver screen  

2. Indicate webserver access options by selecting the appropriate 
check box.  
Option  Description 
Displays Permit access to the S600+ display layouts.  
Reports View history reports and request instantaneous 

reports.  
Alarm Accept  Permit alarm accepting.  
Ident  Change data as though logged in through the S600+ 

f ront panel (according to your login security Level).  
Diagnostics  View diagnostics on S600+ calculations.  
Remote Access  Perform system diagnostics. 

Note: This option is reserved only for use by technical 
support personnel. Leave all settings at the 
default values.  

Print  Adds a “Print” button (and printing capability) to 
webserver-displayed pages. 
Note: When requesting report printouts, a five second 

delay should be observed between print 
requests to allow the report to be generated.  

Language 
Support 

Select the default language. 

Auto hide 
unused 
displays 

Select to hide the screens that do not have data. 
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Option  Description 
Security Click to display the PCSetup > Advanced Setup > 

Security screen. 
 
3. Click in the hierarchy menu when you are through editing this 

screen. A confirmation dialog box displays.  

4. Click Yes to apply the changes. The Displays/Webserver screen 
displays.  

7.6 Calc Explorer 
Use the Calc Explorer option to access a graphical tool that enables 
you to analyze how system components link together.  

Note: Although the option is discussed as part of the Advanced Setup 
options, you can also access this feature at any time by clicking 
the Calc Explorer icon on the PCSetup screen’s menu bar.  

1. You can start Calc Explorer in several ways: 

 Click the Calc Explorer icon  on the PCSetup Editor’s 
toolbar. 

 Select the Calc Explorer component from the hierarchy menu. 

The Calc Explorer screen displays. 

 

Figure 7-14. Calc Explorer (blank)  

2. Right-click in the right-hand panel to display a menu of Calc 
Explorer options.  



Config600 Configuration Software User Manual 

7-24 Advanced Setup Configuration Revised January 2023 

 

Figure 7-15. Calc Explorer menu  

7.6.1 Calc Explorer Options  
Once you add an item and right-click on it, the system displays a menu 
of Calc Explorer options. The following table describes the all options 
on that menu.  

  

Figure 7-16. Calc Explorer Menu Options 

Note: This menu modifies its content to reflect the available 
inputs or outputs of any item you select.   

Option  Description 
Add Input Displays a list of all defined inputs for the selected item. 

You can add inputs individually.   
Note: This menu option displays only if the selected 

item has defined inputs.   
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Option  Description 
Add Output Displays a list of all defined outputs for the selected 

item. You can add outputs individually.  
Note: This menu option displays only if the selected 

item has defined outputs.   
New Item Displays a Connect Wizard dialog box you use to add 

system components (“items”) to the Calc Explorer 
graphic.   

Delete Item(s) Removes the selected item from the Calc Explorer 
graphic.  
Note: To select more than one item, place the cursor 

in a blank area of the screen. Click and hold 
down the left mouse button while dragging the 
cursor. This creates a box. Drag the box over 
one or more items. Note that their border 
becomes a dashed line, indicating you have 
selected them. Release the right mouse button 
and left-click any selected item to display the 
menu.  

Add All Inputs Adds all inputs related to the selected item to the Calc 
Explorer graphic.  
Note: This option is grayed out if the selected item 

does not have defined inputs.  
Add All 
Outputs 

Adds all outputs related to the selected item to the 
Calc Explorer graphic.  
Note: This option is grayed out if the selected item 

does not have defined outputs.  
Auto Unit 
Explore --> 

Locates and displays calculations where an input to a 
calculation matches the inputs of the selected item.   
Note: This menu option displays only if the selected 

item has units.  
Auto Unit 
Explore <--  

Locates and displays outputs of calculations that 
match the units of the selected item.  
Note: This menu option displays only if the selected 

item has units.  
Clear All Removes all items from the Calc Explorer graphic.  
Zoom In Reduces the Calc Explorer graphic to its default 

display size.  
Zoom Out Magnifies the Calc Explorer graphic.   
Save As 
Bitmap 

Saves the displayed Calc Explorer graphic as a bitmap 
(CalcExplorer.bmp) in the folder housing the 
Config600 software.  
Note: Config600 uses the same name for each 

bitmap. To save bitmaps of several 
configurations, you must uniquely rename each 
bitmap.   

7.6.2 Adding an Item  
Use this procedure to add a new item to the Calc Explorer screen.  

1. Click New Item on the menu. The Connect Wizard displays.  
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Figure 7-17. Connect Wizard  

2. Select an option from each of the three columns and click OK. 
Calc Explorer adds the defined item to the screen.  

  

Figure 7-18. Newly Added Item  

Notes:  
 When you first add an item, Calc Explorer gives it a dashed (not 

solid) outline (see Figure 7-18). This indicates that the item is 
currently selected. When you right-click a selected item, the Calc 
Explorer menu displays for that item. When you add a second item, 
that item receives the dashed outline. The previous item now has a 
solid outline, indicating it is no longer selected.  

 You can move any item on the graphic to any location. Place the 
cursor over the item, hold down the left-click button, and drag the 
item to its new location. This enables you to organize the items you 
place on the Calc Explorer screen.   
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7.6.3 Adding All Inputs  
Use this option to add all defined inputs for the selected item to the 
Calc Explorer screen.  

1. Right-click an item to display the Calc Explorer menu.  

 

Figure 7-19. Adding Inputs  

2. Click Add All Inputs. The Calc Explorer displays all inputs for the 
selected item.   

 

Figure 7-20. Added Inputs  
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Notes:  
 Use the Add Input menu option to add individual inputs to the 

screen.  

 Shaded (or gray) items indicate calculation tables. Unshaded (or 
white) items indicate inputs or outputs.  

 A thick line connecting items indicates that the item has many 
values (such as arrays).   

7.6.4 Adding All Outputs  
Use this option to add all defined outputs for the selected item to the 
Calc Explorer graphic.  

1. Right-click an item to display the Calc Explorer menu.   

 

Figure 7-21. Adding Outputs  

2. Click Add All Outputs. The Calc Explorer displays all outputs for 
the selected item.  



Config600 Configuration Software User Manual 

Revised January 2023 Advanced Setup Configuration 7-29 

 

Figure 7-22. Added Outputs  

Note: Use the Add Output menu option to add individual outputs to 
the screen.  

7.6.5 Deleting Items  
Use this option to remove one or more selected items from the Calc 
Explorer screen. 

Note: Calc Explorer does not have an “undo” feature. Once you 
delete an item, you can only re-add it.   

1. Right-click an item to select it and display the menu.  

2. Click Delete Item(s). The menu closes and the item disappears 
from the screen.   

To delete more than one item: 

1. Move the cursor in a blank area of the screen near the items you 
intend to delete.  

2. Click and hold down the left mouse button while dragging the 
cursor. This creates a box.  

3. Drag the box over one or more items. Note that as the box touches 
any item, the border of that item becomes a dashed line, indicating 
you have selected that item.  

4. Release the right mouse button and left-click any of the selected 
items to display the menu.  

5. Click Delete Item(s) to delete all of the selected items.  

Note: Use the Clear All menu option to remove all items from the 
Calc Explorer screen.   
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7.6.6 Saving as Bitmaps  
Use this option to save the current contents of the Calc Explorer screen 
as a bitmap (.BMP) graphic on your PC’s hard drive.  

Config600 saves the bitmap (as the file CalcExplorer.bmp) in the 
directory in which you have installed the Config600 software. If you 
intend to create bitmaps of several images, rename the 
CalcExplorer.bmp file immediately after you capture the image. 
Otherwise Config600 reuses the CalcExplorer.bmp filename and 
overwrites the most recent file.   

1. Right-click in the screen to display the Calc Explorer menu. 

 

Figure 7-23. Saving a Bitmap  

Note: Depending on the complexity and size of your Calc 
Explorer image, you may want to maximize the screen size.  

2. Click Save As Bitmap. The Calc Explorer menu closes and the 
saves the bitmap image on your PC’s hard drive.  
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Chapter 8 – System Editor 
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Note: This editor is available only with the Config600 Pro software.  

The System Editor enables you to configure the S600+ database. Just 
as the PCSetup Editor provides a guided interface for editing data 
points in a configuration, the System Editor enables the advanced user 
to create and modify data points. Using the System Editor, you can 
create, remove, or change database objects and tables.  
 

Caution 
This chapter is intended for use in conjunction with materials from the 
RA901 Advanced Config600 training course. That training is critical to 
understanding the concepts in this chapter. Unless you have completed 
that training, do not attempt to use the material in this chapter as a sole 
means of learning about the System Editor. 
 

The System Editor does not have a Configuration Generator. Instead, 
use the System Editor to edit existing configurations. Through the 
System Editor, you can:  
 Change units. 
 Change report information. 
 Change I/O. 
 Change communications tasks and links. 
 Enable and disable alarms. 
 Configure alarms object by object. 
 Change cold start values (for example, densitometer constants). 
 Change descriptors. 
 Configure existing calculations. 
 Create and delete calculations.  
 Change passwords. 
 Create and delete database objects.  
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8.1 Accessing the System Editor  
Use this process to open and select a configuration file to edit. 

1. Select Start > Programs > Config600 3.3 > System Editor. A 
blank System Editor screen displays.  

 

Figure 8-1. System Editor screen (blank)  

Note:  You can also define a shortcut for your desktop to easily access 
this application.  

2. Select a specific configuration file. From the menu bar, select File 
> Open. The Open dialog box displays.  

 

Figure 8-2. Open dialog box  

3. Open the Configs folder (in which Config600 stores all 
configuration files) and click Open.  

4. Select the name of a configuration file to edit and click Open. 
Config600 opens another dialog box that shows the contents of that 
folder.  
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Figure 8-3. Open Dialog box (with .cfg file)  

5. Double-click the S600conf.cfg file.  

Note: You must provide a username and password if the 
configuration file has password protection. 

6. Once you select a configuration (.CFG) file, the System Editor 
opens:  

 

Figure 8-4. System Editor screen (loaded)  

8.2 The S600+ Database  
The S600+ database is divided into sections. Each section contains a 
selection of available data types. Within the sections, the database item 
locations are numbered:  
 System.  
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 I/O Boards 1 to 7.  
 Stations 1 and 2.  
 Streams 1 to 10.  
 

Caution 
If you add any new objects to the database, the System Editor 
automatically re-indexes the Modbus map, displays, and reports. 
However, the System Editor does not re-index any LogiCalc programs, 
which may cause LogiCalc programs to stop functioning. 
 

Note:  For further information about the structure of the database, 
refer to Chapter 12, Report Editor.   

8.2.1 Objects 
The S600+ database contains objects and tables. The following list 
identifies the objects in the S600+database. Your configuration may or 
may not contain all these objects, depending on your application.  

 Cumulative Totals.  
 Period Totals.  
 Analog Inputs.  
 PRT/RTD Inputs.  
 Pulse Inputs.  
 Frequency Inputs.  
 Digital I/Os.  
 Analog Outputs.  
 Pulse Outputs.  
 Keypad Integers.  
 Keypad Integer Arrays. 
 Keypad Reals.  
 Keypad Real Arrays. 

 Keypad Strings.  
 Calculation Results.  
 Configuration Items.  
 System Objects. 
 DP Stacks.  
 PID Control Loops.  
 Alarm Items.  
 Multi-States.  
 Prove Controls.  
 Array Texts.  
 HART Devices.  
 Event History.  
 Alarm History. 

Some objects can be associated with tables. For example, the 
‘VALUE’ of a keypad integer can be linked to a text string. See the 
example below for the Calculation Alarm object. The Mod_Tab_id 
object is associated with Mode Table #3 (Calculated or Keypad).  
 

  TRUTH TABLE #21    
CALCALM #30  1 MJ/kg    
DESC  2 GJ/kg    
Tab_units_id   …   MODE TABLE #3 
Mod_tab_id     1 CALCULATED 
Obj_almitem_id  ALARM ITEM #141  5 KEYPAD 
INUSE and such.   1 STATUS    
  2 UNACC    
  3 INHIBIT    

Figure 8-5. Object/Table Relationship  
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8.2.2 Tables 
Tables map an integer to a text string. For example, when describing 
AGA8 calculations, you can link the options Detail, Gross 1 and Gross 
2 by a Truth table to the integers 0, 1, and 2, respectively. The database 
can then use the integer value and refer back to the Truth table for its 
meaning.  

The following list presents some of the tables in the S600+database. 
Your configuration may or may not contain all these tables, depending 
on your application. 
 Turbine Meter Setup. 
 Digital Input.  
 Totalisation.  
 Task Control.  
 Digital Output.  
 Internal Index. 
 Mode Text. 

 Truth Tables. 
 Alarm Text. 
 Calculation.  
 Prover Setup.  
 Password.  
 I/O Assignment.  
 HART. 

8.3 Navigating the System Editor  
The System Editor splits the S600+ database into four categories:  
 System. 
 I/O Boards. 
 Stations. 
 Streams.  

Depending on the system configuration, you may have multiple I/Os, 
Stations, and Streams.  

You access these four database categories through the hierarchy menu, 
presented in the window’s left-hand pane. As with the PCSetup Editor, 
the System Editor window consists of two panes. Clicking on an item 
in the hierarchy menu in the left-hand pane displays a screen in the 
right-hand pane. 

 

Figure 8-6. System Editor screen  
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Unique to the System Editor is its “spreadsheet-style” presentation of 
the right-hand pane. Each object and table has its own spreadsheet 
screen with headings appropriate to that object or table. Right-clicking 
on a line in the right-hand pane displays a shortcut menu with the 
options Edit, Special Edit (for calculation tables only), Insert (insert 
above), Append (insert below), and Delete. Use these menu functions 
to manage the object or table information.  

Each line in the right-hand pane presents one object or table entry. The 
spreadsheet headings indicate the number (ID), the descriptor (DESC), 
and several parameters for that specific object or table entry.  

8.3.1 Finding Objects 
Finding objects in the System Editor requires that you think about 
what the object is.  
For example, if you are looking for Analog Channel 3, first determine 
on which I/O board the channel is located (in this example, I/O Board 
1). Expand the I/O Board 1 option in the hierarchy menu and highlight 
ADC. Alternately, if you are looking for the Pipe Material data item, 
realize that it is a Keypad Integer value. Determine the stream (Stream 
1 in this example). When you expand the Stream 1 option, highlight 
KPINT (for this example) to find it as item ID #262. 

8.3.2 The System Editor Icon Bar 
The System Editor’s icon bar provides icons for the following actions 
and shortcuts:  

Icon Meaning 

 Open Configuration. Click to open the Select Config dialog box. 

 
Save Configuration. Click to save the current configuration with 
the current configuration file name.  

 
Cut, Copy and Paste. These clipboard icons are available if not 
greyed out. Click Cut to remove the selection from the clipboard. 
Click Copy to store the selection to the clipboard. Click Paste to 
insert the contents of the clipboard to the cursor’s location.  

 
Relative IDs. Click to change the way the System Editor 
displays identification numbers. With Rel IDs off, the numbering 
shows the object’s absolute reference (that is, the absolute 
number of the object in a global list referenced from 0). With Rel 
IDs on, the list numbering becomes relative to the section you 
are currently displaying.  
For example, the KPINTs start in the IO Board section as ID 66 
(the 67th entry in the list of KPINTs). Clicking the Rel ID button 
changes this number to 0, since it now becomes the first entry in 
this section.  
This icon is particularly useful in the LogiCalc Editor. LogiCalc 
referencing is relatively-based, so KPINT 66 displays as I/O 
Board 1, Rel ID 0.  

 
Calc Explorer. Click to open the Calc Explorer utility, and 
graphically examine calculation relationships between system 
components.  

 
Print. Click to open the Print dialog box. Use this icon to print an 
entire configuration to a host printer.  
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Icon Meaning 

 
About. Click to open the About Config600 dialog box that lists 
the software version and copyright information.  

8.3.3 Special Edit 
The Special Edit dialog box for calculation tables allows you to edit an 
existing calculation or build a new calculation. You can configure the 
calculation’s description, sources (Inputs), type, and destinations 
(Outputs).  

To access this dialog box, double-click the Calculation table or right-
click the Special Edit option on the shortcut menu (Figure 8-6). The 
Calc Editor dialog box displays (see Figure 8-7).  

To switch from inputs settings to outputs settings, click the  button 
(located below the word “Inputs” or the word “Outputs” on the Calc 
Editor screen, Figure 8-7). For each source or destination in the 
calculation, you can edit the Description, select the Type, assign it to 
an Object, enter a Field, and enter a Bit No. These all correspond to the 
Spreadsheet style headings for the calculation table screen.  

You can also add and delete sources and destinations.  
 

Caution 
The Calc Editor does not have an Undo feature. If you mistakenly delete 
a source or destination, you must manually re-create it. 
 

 

Figure 8-7. Calc Editor dialog box  

To add a new input/output calculation: 
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1. Click Add (on the right-hand side of the dialog box). The Calc 
Editor screen adds a new numbered line under Inputs or Outputs.  

Note: To edit an existing calculation, skip step 1 and click the 
number of the line.   

2. Click the number for the new line. The Connect Wizard displays.  

 

Figure 8-8. Connect Wizard  

Note: Although you can individually select calculation 
components on the Calc Editor dialog box, using the 
Connect Wizard is the safest—and most accurate—way of 
selecting calculation components.  

3. Select, from left to right, the calculations components.  

4. Click OK when you are done. The Calc Editor dialog box 
redisplays, showing the newly defined calculation line.  

8.3.4 Edit Dialog 
When you select Edit from the shortcut menu, the Edit dialog box 
appears. Use it to edit or create a new row in the spreadsheet-style 
screen or to configure the data point, text string, or value in each 
column of the spreadsheet-style screen.  

The Columns field lists the headings for this object/table’s screen. 
Clicking on a heading from this list displays the Data fields for that 
object or table. The Data (ID:,Col:) field in the upper right corner 
provides the location in the spreadsheet for this data point. The Data 
field shows the current assignment for the heading highlighted in the 
Columns field.  
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Figure 8-9. Edit Dialog (System Editor)  

8.3.5 Asterisks/No Asterisks 
If the heading displayed in the Columns listing is appropriate for 
entering integer values or text strings, then the heading in the Columns 
list does not have a trailing asterisk, and a field appears in the Data 
area for data entry of the integer value or text. 

If the heading has options from a pre-defined list, then the heading in 
the Columns list has a trailing asterisk. Additionally, a list displays 
under the Data field. You can select a value from the list either by 
clicking with a mouse or by entering the item’s number that appears in 
the Data field. 

  
No Trailing Asterisk  Trailing Asterisk  

Figure 8-10. Edit dialog box  
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8.4 General Guidelines 
Observe the following guidelines with the System Editor:  
 The File > Save and File > Save As options have the same 

function in this editor. You can use them interchangeably.  
 Assign the Measured and Calculated (R/O) data points a security 

level of 0 so that only the input source, the PC, or the S600+ 
processor can write to them. 

 Exercise great caution when inserting or deleting information. The 
System Editor does not have an Undo function. You cannot restore 
deletions.  

 Save your work every few minutes. If you inadvertently delete or 
modify a configuration file, you can restore by closing without 
saving. Re-open with the last save, thereby losing only a few 
modifications. 

 S600+ displays the description for each data point on the S600+ 
front panel display and web server access. Whenever possible, type 
descriptions for each data point in upper case letters (CAPS). 
Upper-case text (CAPS) is easier to read on the front panel display.  
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Chapter 9 – Config Transfer  

In This Chapter 
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9.4 Send Configuration................................................................... 9-6 
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9.6.1 Logging a Transfer ........................................................ 9-9 
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9.7.2 Removing a License .....................................................9-12 

 
Use the Configuration Transfer (Config Transfer) utility to send new or 
modified configuration files to the S600+ over either a dedicated serial 
port or a TCP/IP connection. Config Transfer also enables you to 
retrieve configuration files from the host PC to the S600+.  

WARNING: 
Performing configuration changes while equipment is operating may 
result in unexpected behavior. Take appropriate action to prevent 
impact to field devices. 

Config600 saves configuration files in the Configs directory on the 
host PC, and automatically creates a separate sub-directory for each 
new configuration. Config600 also places the following additional 
components in separate sub-directories: 

Note: You can also access this utility either by selecting Tools > 
Transfer from the PCSetup menu bar or by selecting Start > 
Config600 3.3 > Config Transfer. 

 Reports (report format files) 
 Modbus (Modbus configuration files) 
 Override (custom files, such as customized versions of the 

displays, reports, and Modbus files) 

Note: Config600 uses this folder only for older existing 
configurations. Config600 does not use the Override folder 
for new configurations.  

 LogiCalcs (custom-written files that permit the creation of user-
defined functions) 

 Extras (user-defined look-up tables and configuration backup 
files) 
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 Logs (copies of logs created during wizard generation / backup 
synchronisation) 

Config Transfer also provides a utility that enables you to license 
Config600  

9.1 Connecting to the S600+  
You can connect to the S600+ using either a serial cable or a TCP/IP 
connection.  

9.1.1 Connecting via Serial Cable  
The S600+ comes with a serial cable you can use to connect your PC 
to the S600+. One end of the cable has a DB-9 female connector, 
which you attach to your PC’s serial port. The other end of the cable 
has two connectors, a male DB-15 (for serial connection) and an RJ-12 
(EIA-232/RS-232D).  Alternately, you can insert the RJ-12 connector 
into the port on the bottom of the S600+ flow computer’s front panel. 

9.1.2 Connecting via TCP/IP 
You can connect to the S600+ using an Ethernet cable. In this case, 
you must first define an IP, subnet, and gateway addresses for your 
S600+. Refer to the FloBoss™ S600+ Flow Computer Instruction 
Manual Form Number A6115. 

9.1.3 Enabling the PC Setup Link 
Regardless of the connection method you use, the S600+ (by default) 
does not allow you to download or upload configurations or license 
applications until you either access the Startup menu (refer to the 
FloBoss™ S600+ Flow Computer Instruction Manual Form Number 
A6115) or enable the PC Setup link from the S600+. If you proceed 
without enabling the PC Setup link, Config600 displays a warning 
dialog: 

 

Figure 9-1. PCSetup Error Message  

To enable the PC Setup link: 

1. From the S600+ front panel’s main menu, select 
TECH/ENGINEER > SECURITY.  

2. Press  to access the PC Setup Link screen, which indicates that 
the PC Setup Link is currently DISABLED.  
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3. Press CHNG and enter the security code defined for your ID.  

4. Select ENABLE and select ENABLE again. The PC Setup Link 
screen displays, indicating that the PC Setup Link is now 
ENABLED.  

9.1.4 Checksum Security  
When you send a configuration to the S600+, it checks the 
configuration to ensure that it has not been modified manually. 
Config600 calculates and applies a checksum value on the file. If the 
checksum value the S600+ detects does not match the Config600-
applied checksum value, the S600+ displays a warning message. 

If the error persists after repeating the configuration download, it may 
be possible to resolve the warning and repair the configuration 
checksum. Use a registered copy of Config600 and login with the 
Level 1 Username and Password. Once you have correctly entered the 
Username and Password, Config600 saves the configuration file with 
the correct checksum. 

9.2 Accessing Config Transfer  
You can start Config Transfer using any one of three methods: 

 Click the Transfer icon  on the PCSetup Editor’s toolbar.  
 Select Tools > Transfer from the PCSetup Editor’s menu bar. 
 Click Start > All Programs > Config600 3.3 > Config Transfer.  

The Config Transfer screen displays.  

 
Figure 9-2. Config Transfer screen  

This screen uses a tab design to present the major components—
Transfer, Send, Receive, and Logging—of the transfer process, as well 
as to include software licensing (Licensing).  

Tab  Description 
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Tab  Description 
Transfer Sets the communication parameters between the 

S600+ and the PC.  
Send Identifies the configuration file you want to send from 

the PC to the S600+. 
Receive Identifies the configuration file you want to retrieve from 

the S600+. 
Logging Activates logging for the transfer process and selects 

the select of detail included in the log.  
Licensing Enables you to transfer a license from a secure USB 

drive (“dongle”) to Config600. 

9.3 Communications Settings for Transfer 
The host PC uses a dedicated serial or Ethernet port to connect to the 
S600+, and transfers data  in accordance with the communication 
settings defined for that communications port.  

Notes: 
 Both the host PC and the S600+ must use the same 

communications settings for data to transfer successfully. 

 If you are downloading a configuration via Ethernet, disable any 
communication links from a device that is communicating with the 
S600+ before attempting to download the configuration as this 
may disrupt the confirmation upload/download. 

9.3.1 Setting Communication Parameters  
The Transfer screen displays when you first open the utility.  

Note: Both the S600+ and the host PC must have the same 
communications settings to communicate successfully.   

1. Start the Config Transfer utility.  
2. Select the Transfer tab.  

3. Enter the Modbus address for the S600+ in the S600 ID field.  

This value is available from the S600+ front panel (select 
Tech/Engineer > Communications > Assignment > Modbus 
Address) or from the Network option on the Cold Start menu.  
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Figure 9-3. Config Transfer screen   

4. Indicate the specific serial or network (Ethernet) COM port in the 
S600 Connections field.   

Note: To verify the serial connection, click Scan to display the 
current serial port connected to the S600+.  

5. If you are using a serial port, review the following fields. Change 
the default values only if you have a good reason for doing so.  
Field  Description 
S600 ID Identifies the S600+; the default value is 1.  

You can verify the S600+ ID from the front panel of the 
S600+ by selecting Tech/Engineer > 
Communications > Assignment > Modbus 
Address.  

S600 
Connections 

Lists all available communication connections. 

Scan Click to validate the currently available IP or serial 
connections. If  you have a valid network 
connection, the system detects it and automatically 
completes the Hostname field with an IP address. 
If  you have a valid serial connection, the system 
detects it and automatically completes the serial 
port settings. 

Hostname Indicates the IP address of the host PC. 
Note: This f ield is available only if you selected a 

network connection. 
16 Bit Mode Provides compatibility with legacy Modbus 

conf igurations.  
Note: The 16 Bit Mode checkbox represents an 

advanced Modbus option. It permits a 16-bit 
byte count on Modbus communications, 
allowing longer messages. Refer to Chapter 
14, Modbus Editor, for further information. 
For most systems, this option should be 
unchecked.  

Baud Rate Indicates the serial transfer rate. Click  to display all 
valid values. The default value is 38400. 
Note: You can modify this field only if you select a 

serial port.   
Data Bits Indicates the number of data bits the port uses. Click 

 to display all valid values. The default value is 8.  
Note: You can modify this field only if you select a 

serial port.   
Stop Bits Indicates the period length. Click  to display all valid 

values. The default value is 1.  
Note: You can modify this field only if you select a 

serial port.    
Parity Indicates the type of parity used to detect data 

corruption during transmission. Click  to display all 
valid values. The default value is None.  
Note: You can modify this field only if you select a 

serial port.   
 
6. If you are using a network (Ethernet) port, complete the Hostname 

field.  
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9.4 Send Configuration  
You can send up to 20 user configurations files to the S600+ from the 
host PC.  

Note: Although you cannot clear a configuration from a slot; you can 
overwrite it. 

Each configuration may be comprised of 55 files of the following:  

 Config – The main configuration file for the S600+ including all 
the initialization values.  

 Displays – Configuration file for the display menus and data pages.  
 Reports – Report format configuration files.  
 Modbus Maps – Modbus configuration files, including slave 

register maps and master polling sequences.  
 LogiCalcs – Custom-written files that allow creation of user-

defined functions. 
 Extras – User-defined look-up tables, configuration backup files, 

and prover sequence files. 

 Logs – Copies of logs created during wizard generation / backup 
synchronisation. 

You can use Config Transfer to download the following files (image 
files): 

 Binary Package – Embedded software for the FloBoss S600+; a 
basic version is installed in the S600+ prior to delivery. To transfer 
this package, copy the binary.app file into Binary folder from 
Config S600+ directory. 

 Firmware – Software firmware and embedded software for the 
FloBoss S600+. This is for internal Emerson use only. 

Caution 
Updating the binary or firmware file could affect the entire metering 
accuracy and stability of your S600+. It is strongly recommended that 
you update this file only under the specific instruction of technical 
support personnel. 
 

 

9.4.1 Sending a Configuration  
Note: If you are updating the firmware or binary file (only under the 

direction of technical support personnel), you must first 
place the S600+ in Reflash Firmware mode. For further 
instructions, refer to “Reflash Firmware” in Chapter 8, 
Troubleshooting, in the FloBoss S600 Flow Manager 
Instruction Manual (part number D301150X412).   

To send a new or modified configuration file to the S600+ from a host 
PC: 

Note: You must cold-start the S600+ before you can send a 
configuration file.   
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1. Select System Settings > System Status > CHNG > Enter valid 
operator code > Cold Start > Yes to cold-start the S600+ before 
you send a configuration file 

2. Launch Config Transfer.  
3. Select the Send tab on the Config Transfer screen.  

 

Figure 9-4. Config Transfer Send tab  

4. Select a configuration from the Available Configurations listing.  
5. Click Send to initiate the transfer.  

A confirmation message displays when your configuration send is 
successful.  

Note: If you are updating the firmware or binary file (under the 
direction of technical support personnel), you must first place 
the S600+ in Reflash Firmware mode. For further instructions, 
refer to “Reflash Firmware” in Chapter 8, Troubleshooting, in 
the FloBoss S600 Flow Manager Instruction Manual (A6115).  

9.4.2 Manually Adding a Configuration File to be Transferred 
To manually add a configuration file to the Config600 to transfer the 
file to the S600+ from a host PC: 
1. Open the folder where you installed Config600. 

Note: By default, this is in the 
C:\Users\<<USERNAME>>\Config600 3.3\Configs folder. 
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2. Copy the configuration folder into the Configs folder. 

Note: All configuration files are encrypted in an archive folder. 

9.5 Receive Configuration  
You can receive the following files from the S600+ onto the host PC:   
 Config (the main configuration file for the S600+ including all the 

initialization values) 
 Displays (configuration file for the display menus and data pages).  
 Reports (report format configuration files) 
 Modbus Maps (Modbus configuration files, including slave 

register maps and master polling sequences) 
 LogiCalcs (custom-written files that allow creation of user-defined 

functions) 
 Extras (user-defined look-up tables and configuration backup 

files) 

 Logs (copies of logs created during wizard generation / backup 
synchronisation) 

9.5.1 Receiving a Configuration 
To receive a configuration file from the S600+ into a host PC: 
1. Select the Receive tab on the Config Transfer screen.  

 

Figure 9-5. Config Transfer Receive tab  

2. To overwrite an existing configuration, select it from the Available 
Configurations listing. You can also select <new> to create a new 
configuration on the host PC.  

Note: Click Refresh List to update the list with the configuration 
files in S600+. 
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3. Click Receive to initiate the transfer.  
4. If you selected <new>, Config600 now prompts you to name the 

folder to receive the new configuration files.  

 

Figure 9-6. Save As New Config dialog box  

5. Enter up to 30 characters to name the folder.  

A confirmation message displays when your configuration receive is 
successful.  

9.6 Log Transfers  
You can create a log of the activity and events of the transfer 
application. This log can be useful for diagnosing and resolving 
communication problems.   
When you enable the logging function, the S600+ creates a log file 
with the current time stamp in the working configuration folder. The 
log file contains all details of the transfer session until you either 
disable the logging option or close the Config Transfer application.  

9.6.1 Logging a Transfer  
To initiate an activity and event log for the transfer session:  
1. Select the Logging tab on the Config Transfer screen.  

 

Figure 9-7. Config Transfer Logging tab 

2. Select the Enabled check box. This activates the Logging Detail 
field.  
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3. Click  to indicate the logging detail. Valid values are General 
(include only events) and Detailed (include both events and 
activity). The default is General.   

Note: The S600+ maintains the log until you either close the 
application or disable the logging process.   

9.7 CFX Licensing  

Note: This utility requires you to install firmware binary 06.21 or 
later.   

The Licensing utility with Config Transfer enables you to transfer a 
CFX software license from a USB drive (“dongle”) installed on a host 
PC to the S600+. The drive used to transfer Config600 licenses is a 
secure USB drive designed for this purpose. You cannot use a 
standard USB drive with this utility.  

Note: To activate this utility, you must first cold-start the S600+ from 
its front display and leave the S600+ at the Cold Start menu. 
Also, make sure that the secure USB drive containing the 
license is installed on the host PC.   

9.7.1 Transferring a License  
To transfer a license:  
1. Select the Licensing tab on the Config Transfer screen. The 

Licensing screen displays.   

 

Figure 9-8. Config Transfer Licensing tab  

2. Click Connect to Dongle. The utility shows all licenses on the 
license key in the Dongle list on the left side of the screen:  
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Figure 9-9. Licenses on Key 

3. Click Connect to S600+ to establish a connection to the S600+. A 
series of Transferring dialogs may appear while the utility makes 
the connection.  

 

Note: When the connection completes, the utility activates the 
arrow keys in the center of the screen.    

4. Select a license from the Dongle list and click the right-pointing 
arrow () to move the license from the USB drive to the S600+. 
The utility displays a series of Transferring dialogs as the process 
occurs.  
When the process completes, the utility displays a notification 
dialog: 

 
5. Click OK to close the dialog. The License screen now shows the 

license installed on the S600+. Note also that the quantity of 
licenses on the USB has decreased by 1.   
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Figure 9-10. Transferred License 

6. Click Quit to close the License utility.  

9.7.2 Removing a License  
Removing a license from the S600+ and transferring it to the secure 
USB drive is just as simple. After you connect to the USB drive and 
the S600+, select the license in the S600+ column and click the left-
pointing () arrow. The system displays a notification dialog when 
the process completes. When you click OK, the utility displays the 
Licensing screen. Note that the quantity of licenses on the USB drive 
has increased by one.  
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Chapter 10 – Remote Front Panel 
In This Chapter 

10.1 Configuring Your PC without a Native Serial Comm Port .............. 10-1 
10.1.1 Changing the Port on Your USB Communications Port ...... 10-2 

10.2 Configuring Your PC with a Native Serial Comm Port .................. 10-3 
10.3 Configuring the S600+ to Use the Remote Front Panel ................ 10-4 
10.4 Accessing the Remote Front Panel ........................................... 10-7 

10.4.1 Remote Front Panel Startup Menu ................................. 10-7 
10.4.2 Disabling the Remote Front Panel .................................. 10-8 
10.4.3 Restoring the Remote Front Panel ................................. 10-9 

 
Use the Remote Front Panel to configure your S600+ to perform 
certain functions from your PC. Connect your computer to the S600+ 
as directed in the FloBoss S600+ Flow Computer Instruction Manual 
(part D301150X412). The Remote Front Panel requires part number 
S600+EXT (the License Key for Remote Front Panel).  

Note: For more information on the complete functionality of the Front 
Panel, refer to the FloBoss S600+ Flow Computer Instruction 
Manual, part D301150X412. 

10.1 Configuring Your PC without a Native Serial Comm Port 
This section details how to configure your PC to communicate between 
the S600+ and the Remote Front Panel application on your PC if you 
do not have a native serial communications port on your PC. If this is 
the case, you require a USB-to-Serial convertor cable.   

1. Install the convertor software if necessary.  

2. Verify the communications port number.  

 Windows 10: Right -click Start and select Device Manager 
 Windows 7 or Vista: 

Select Start > Control Panel > Hardware and Sound > 
Devices and Printers > Device Manager. 

 Windows XP: 
Select Start > Control Panel > System > Hardware tab> 
Device Manager. 

3. Select Ports (COM & LPT). 

4. Verify that the Communications Port number is 1, 2, 3, or 4. The 
Remote Front Panel only supports communications ports 1 through 
4. 

Note: If the communications port is not 1, 2, 3, or 4, you must 
change it. Refer to Changing the Communications Port.  
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Figure 10-1. Device Manager 

10.1.1 Changing the Port on Your USB Communications Port 
The Remote Front Panel only supports communications ports 1 
through 4. To change your communications port: 

1. Right-click on the Communications Port (COM1) and select 
Properties.  

2. Select the Port Settings tab.  

3. Click Advanced.  

4. Click ▼ in the COM Port Number field to select a 
communications port between 1 and 4. This is the communication 
port through which you communication with the S600+ and the 
Remote Front Panel on the PC.  

5. Click OK in the Advanced Comm Ports Setting screen.  

6. Click OK in the Communications Port (COM1) Properties screen.  

7. Restart your computer.  
8. Configure the S600+. Refer to Configuring the S600+ to Use the 

Remote Front Panel.  
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10.2 Configuring Your PC with a Native Serial Comm Port 
This section details how to configure your PC to communicate between 
the S600+ and the Remote Front Panel application on your PC if you 
have a native serial communications port on your computer. The 
Remote Front Panel only supports communications ports 1 through 4. 
Typically a native serial port uses communication port number 1.  

1. Open Device Manager. 

 Windows 10: Right -click Start and select Device Manager 
 Windows 7 or Vista: 

Select Start > Settings > Control Panel > System > 
Advanced System Settings >Hardware tab > Device 
Manager. 

 Windows XP: 
Select Start > Control Panel > System > Hardware > Device 
Manager. 

2. Select Ports (COM & LPT).  

  
Figure 10-2. Device Manager 

3. Right-mouse click on the Communications Port you desire to 
change and select Properties.  

4. Select the Port Settings tab.  

5. Click Advanced.  
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Figure 10-3. Advanced Settings 

6. Click ▼ on the COM Port Number field to select a 
communication port between 1 and 4. This is the communications 
port through which you communicate with the S600+ and the 
Remote Front Panel on the PC.  

7. Click OK in the Advanced Settings screen.  

8. Click OK in any remaining screen.  

9. Restart your computer.  

10. Configure the S600+. Refer to Configuring the S600+ to Use the 
Remote Front Panel.  

10.3 Configuring the S600+ to Use the Remote Front Panel 
To use the Remote Front Panel, you must launch the Remote Front 
Panel application and configure your S600+.  
1. Select Start > Programs > Config600 3.3 > Remote Front Panel. 

On the S600+ front panel: 

2. If the S600+ is metering, you need to access the Cold Start menu to 
set up the serial port parameters. To do this, select 5 (System 
Settings). 
1* FLOW RATES 
2* TOTALS 
3* OPERATOR 
4* PLANT I/O 
5* SYSTEM SETTINGS 
6* TECH/ENGINEER 
 
8* CALCULATIONS 

3. Select 6 (System Status). 
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1* UNIT SETUP 
2. REPORT SETUP 
3. ALARM SETUP 
4. MAINTENANCE MODE 
5. TOTAL RESET 
6. SYSTEM STATUS 
7. SOFTWARE VERSION 

4. Press CHNG. 
SYSTEM RUN MODE 
NORMAL               * 
  
P145.1 <of 1>      S 

5. Enter your password in the Enter Code field. 
SYSTEM RUN MODE 
  
ENTER CODE: 
 
  
P145.1 <of 1>      S 

6. Select 1 (Cold Start). 
1. COLD ST 
2. WARM ST 
3. GO BACK 

7. Select 1 (Yes). 
CONFIRM 
SET TO: 
COLD ST 
1. YES 
2. NO 

8. Select 8 (Factory Setup). 
1* WARM START 
2* COLD START 
3* NETWORK SETUP 
4. REFLASH FIRMWARE 
5. CONFIG SELECTION 
 
 
8* FACTORY SETUP 

9. Select 3 (Serial Ports). 
1. CLEAR SRAM 
2. FORMAT FLASH 
3* SERIAL PORTS 
4* DISPLAY 
5* FIRMWARE 
6. USB LOCK 
7. DEBUG MODE 
8. GO BACK 

10. Select 1 (PC Setup Port). 

1. PC SETUP PORT 
2. GO BACK 
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11. Press 0 to change the Port from 2 to 0. 
FloBoss S600+ 
 
ENTER SERIAL PORT 
RANGE 2 TO 8 
CURRENT  2 
         0 

12. Press Enter.  
13. Select 2 (Go Back). 

1. PC SETUP PORT 
2. GO BACK 

14. Select 8 (Go Back). 
1. CLEAR SRAM 
2. FORMAT FLASH 
3* SERIAL PORTS 
4* DISPLAY 
5* FIRMWARE 
6. USB LOCK 
7. DEBUG MODE 
8. GO BACK 

15. Select 8 (Factory Setup). 
1* WARM START 
2* COLD START 
3* NETWORK SETUP 
4. REFLASH FIRMWARE 
5. CONFIG SELECTION 
 
 
8* FACTORY SETUP 

16. Select 4 (Display). 
1. CLEAR SRAM 
2. FORMAT FLASH 
3* SERIAL PORTS 
4* DISPLAY 
5* FIRMWARE 
6. USB LOCK 
7. DEBUG MODE 
8. GO BACK 

17. Select 1 (Display Port). 
1. DISPLAY PORT 
2. DISPLAY TYPE 
3. GO BACK 

18. Press 2 to change the Display from 2 to 1. 
FloBoss S600+ 
 
ENTER SERIAL PORT 
RANGE 1 TO 8 
CURRENT  1 
         2 

19. Press Enter.  
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20. Power cycle the S600+. 
After launching the Remote Front Panel and configuring the S600+, 
the S600+ displays "REMOTE FRONT PANEL IN USE" on the Front 
Panel. This places the S600+’s front panel under the control of the 
Remote Front Panel utility.   

10.4 Accessing the Remote Front Panel 
To start the Remote Front Panel, click Start > Programs > Config600 
3.3 > Remote Front Panel. The Remote Front Panel displays.  

  
Figure 10-4. Remote Front Panel  

The Remote Front Panel utility functions exactly like the actual S600+ 
front panel. Refer to the FloBoss S600+ Flow Manager Instruction 
Manual (part D301150X412). 

10.4.1 Remote Front Panel Startup Menu 
After you launch the Remote Front Panel and configure the S600+, the 
S600+ displays "REMOTE FRONT PANEL IN USE" on the Front 
Panel. This places the S600+ front panel under the control of the 
Remote Front Panel utility.  

The Remote Front Panel displays the Startup Menu:  



Config600 Configuration Software User Manual 

10-8 Remote Front Panel Revised January 2023 

1* WARM START 
2* COLD START 
3* NETWORK SETUP 
4. REFLASH FIRMWARE 
5. CONFIG SELECTION 
 
 
8* FACTORY SETUP 

Figure 10-5. Remote Front Panel Startup Menu  

Note:  An asterisk (*) after an option number indicates a sub-menu. A 
period indicates a subsequent data screen.  

Field Description 
1* Warm Start Restarts a S600+ from the point prior to where the 

S600+ lost power. 
2* Cold Start Builds a new metering database on the S600+ 

f rom the files in Flash memory. 
3* Network 
Setup 

Conf igures the TCP/IP, Gateway, and Modbus 
addresses. 

4. Reflash 
Firmware 

Reprograms the S600+ operating system firmware 
f rom Flash memory. 

5. Config 
Selection 

Displays the configuration files currently 
downloaded to the S600+. 

8* Factory Setup Clears the SRAM and formats Flash memory and 
changes additional settings. 
Note: Use this option only at the direction of a 

factory representative. 
 

10.4.2 Disabling the Remote Front Panel 
To disable the Remote Front Panel, you must perform the following in 
the Remote Front Panel application:  
From the Remote Front Panel: 

1. Return to the main Remote Front Panel menu.  
1* WARM START 
2* COLD START 
3* NETWORK SETUP 
4. REFLASH FIRMWARE 
5. CONFIG SELECTION 
 
 
8* FACTORY SETUP 

2. Select 8 (Factory Setup). 
1. CLEAR SRAM 
2. FORMAT FLASH 
3* SERIAL PORTS 
4* DISPLAY 
5* FIRMWARE 
6. USB LOCK 
7. DEBUG MODE 
8. GO BACK 
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3. Select 4 (Display). 
1. DISPLAY PORT 
2. DISPLAY TYPE 
3. GO BACK 
 

4. Select 1 (Display Port). 
Floboss S600+ 
 
  ENTER SERIAL PORT 
 
    RANGE 1 to 8 
     CURRENT  2 
              1 

5. Press 1 to change the display port from 2 to 1. 

6. Press Enter.  
7. Press 3 (Go Back). 

1. DISPLAY PORT 
2. DISPLAY TYPE 
3. GO BACK 
 

8. Press 3 (Go Back). 
9. Select Factory Setup. 

10. Select Serial Ports. 
1. PC SETUP PORT 
2. GO BACK 
 

11. Select 1 (PC Setup Port). 
FloBoss S600+ 
 
  ENTER SERIAL PORT 
 
    RANGE 2 to  8 
     CURRENT  0 
              2 

12. Press 2 to change the port from 0 to 2. 
13. Press Enter.  

Note:  Disregard any undesirable characters that may occur in the 
display.  

14. Power cycle the S600+. 

10.4.3 Restoring the Remote Front Panel 
In the event of a remote front panel communications failure, you may 
need to restore the serial communications to the normal front panel. 
This is possible by pressing the S600+ Front Panel keys in the 
following order when powering up the S600+: 

To restore the Remote Front Panel if remote communications fail:  
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1. Remove power and then re-apply power to the S600+. 
2. When the “REMOTE FRONT PANEL ENABLED” message 

displays, press 123 456 789 -0. from left to right (the last three 
keys in the sequence are the dash, the zero, and the period).   

Note: You must complete the key sequence within 5 seconds after 
the message displays. If you are unsuccessful the first time, 
repeat the process.  

3. The Cold Start menu displays when the process is successful.  
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Chapter 11 – Remote Archive Uploader 
In This Chapter 
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The Remote Archive Uploader allows you to automatically upload all 
reports and alarms in the historical archive in the S600+ flow 
computer, and manually upload the following:  

 Constant Log  
 Display Dump  
 List of all available alarms  
 List of current alarms  
 Current report  
 Alarm / Event History File  

Note: Support for the Alarm / Event History feature was 
withdrawn for firmware version 5.0 and later.  

 All reports in the Historical Archive  

Note: The Remote Archive Uploader requires part number 
S600+EXT (the license key for Archive Uploader). 

The Remote Archive Uploader logs all significant events to a log file, 
which is also held in the archive folder. Logged events include: 

 Manual Upload of Constant Log  
 Manual Upload of Display Dump  
 Manual Upload of All Alarms  
 Manual Upload of Current Alarms  
 Manual Upload of Current Report  
 Manual Upload of Alarm/Event History  
 Failed to Open Communications Port  
 Link Failed  
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 Manual Load of Report Files  
 Automatic Load of Report Files  
All events are date- and time-stamped. 

11.1 Accessing the Remote Archive Uploader 
To launch the Remote Archive Uploader, from your PC select Start > 
All Programs > Config600 3.3 > Remote Archive Uploader. The 
Remote Archive Uploader screen displays. 

 

Figure 11-1. Remote Archive Uploader screen  

11.2 Automatic Archive Polling 
The Remote Archive Uploader allows you to automatically poll all 
reports and alarms in the historical archive of the S600+ flow 
computer. You configure the archive type, frequency, and the 
communications link the Config600 software uses on the Flow 
Computer Poll Sequence screen.  

11.2.1 Configure Automatic Polling 
You must configure the archive type, frequency, and the 
communications link the Config600 software uses to poll for data.  
1. Select Tools > Flow Computer List. The Flow Computer Poll 

Sequence screen displays showing any previously configured 
reports. 
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Notes: 

 Each column on the Flow Computer Poll Sequence screen 
represents a single configured archive poll. 

 The Flow Computer poll sequence list is reset whenever you 
change the directory settings (Tools > Directory settings). For more 
information, refer to Section 11.5, Saving. 

 

Figure 11-2. Display Editor with shortcut menu   

2. Review the values displayed for each configured archive poll: 
Option  Description 
Name Shows a description of the archive poll. This is used by 

Config600 to create file or folder names when storing 
archives on your PC. 
Note: You enter this description in the Comment field 

on the Edit FC List screen. 
Period Shows the frequency that Config600 polls the flow 

computer for the archive. Valid values are Hourly, 
Daily, Weekly, or Monthly. 

Date Shows the date of the month Config600 polls the flow 
computer for the archive. Valid values are 1–31. 
Note: Data is displayed only for Monthly archive 

uploads. 
Day Shows the day of the week Config600 polls the flow 

computer for the archive. 
Note: Data is displayed only for Weekly archive 

uploads. 
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Option  Description 
Time Shows the time of day to Config600 polls the flow 

computer for the archive.   
Note: Data displays only for Daily, Weekly, or Monthly 

archive uploads. 
Action Shows the archive poll type of the selected poll. Valid 

values are Auto Upload All (uploads ALL of the 
archived reports from the S600+) or Auto Upload New 
(uploads only new archived reports from the S600+). 

Comm Type Shows the communication type the Config600 
software uses to poll the flow computer for the archive 
data. Valid values are Serial, Ethernet, or Modem. 

MB Address Shows the Modbus address of the remote flow 
computer.  

Port Shows the PC port Config600 uses when polling the 
S600+ for archive data. 

Baud Shows the baud rate Config600 uses when polling the 
S600+ for archive data. 

Data Shows the number of data bits in use for serial 
communications Config600 uses when polling the 
S600+ for archive data. 

Stop Shows the number of stop bits in use for serial 
communications used by Config600 when polling the 
S600+ for the archive data. 

Parity Shows the parity in use for serial communications 
Config600 uses when polling the S600+ for archive 
data. 

TCP/IP Addr Shows the TCP/IP address of the flow computer. 
TCP/IP Port Enter the dedicated TCP port at the S600+ with which 

you desire to communicate. Valid ports are 6001, 
6002. Ensure no other device is communicating with 
the S600+ on this port. 
Note: Port 6002 is recommended over 6001.  

MODEM Port PC port in use for MODEM communications. 
Phone Phone number in use for MODEM communications. 
Delete Select a flow computer and click Delete to remove it 

f rom the Flow computer poll sequence screen. 
New Click New to add a new flow computer to poll. 
Copy Select a flow computer and click Copy to duplicate an 

existing configuration. 
 

11.2.2 Add or Edit an Automatic Poll  
To add a new or edit an existing flow computer:  
1. Click New or double-click the name of an existing archive poll 

configuration to edit. The Edit FC List Item screen displays. 
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Figure 11-3. Edit FC List Item screen   

2. Complete (or update) the values for the selected flow computer: 
Option  Description 
Period Selects the frequency that Config600 software polls 

the S600+ for the archive. Click  to display all valid 
options. Valid options are Hourly, Daily, Weekly, or 
Monthly. 

Date Sets the date of the month to perform the poll. 
Note: This field is active only if you select Monthly in 

the Period field. 
Day Sets the day of the week to perform the poll. 

Note: This field is active only if you select Weekly in 
the Period field. 

Time Sets the time of day to perform the poll. 
Note: This field is active only if you select Daily, 

Weekly, or Monthly in the Period field. 
Action Selects the archive data to upload. Click  to display 

all valid options. Valid options include Auto Upload All 
or Auto Upload New.  

 Auto Upload 
All 

Uploads all of the archived reports 
f rom the S600+ and saves them into 
the folder on the PC using the Tools 
> Manual Comms Settings.  

 Auto Upload 
New 

Uploads only new archived reports 
f rom the S600+ and saves them into 
the folder on the PC using the Tools 
> Manual Comms Settings.  

Comment Indicates a name to identify the archive poll. Config600 
software uses this name to create file or folder names 
for the reports uploaded from the selected flow 
computer.  
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Option  Description 
Comms… Click Comms… to configure communication settings 

the Config600 software uses to retrieve data from the 
selected flow computer. Refer to Section 11.3.1, 
Configuring Config600 Communications. 

 

11.2.3 Enable Automatic Polling 
If you enable automatic polling, Config600 performs any archive polls 
you configure in the Flow Computer Poll Sequence screen (Section 
11.3). To enable the automatic polling:  

Select Tools > Enable Automatic Operation. Config600 
automatically retrieves any reports that you defined on the Flow 
Computer Poll Sequence screen. 

 

Figure 11-4. Tools Menu - Automatic Operation Enabled 

Config600 software automatically polls the S600+ at the specified 
times and saves the uploaded archives in the Archive folder.  

Note: The format is exactly the same as for the Manual upload 
command except that the folder names are based on the row in 
the flow computer list. 

11.3 Manual Archive Polling 
You can manually upload reports on an as-needed basis. You can 
manually upload the following data types:  

 Constant Log  
 Display Dump  
 List of all available alarms  
 List of current alarms  
 Current report  
 Alarm / Event History File  
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Note: Support for the Alarm / Event History feature was 
withdrawn for firmware version 5.0 and above.  

 All reports in the Historical Archive  
To perform a manual archive poll, you must configure the 
communication settings Config600 uses to perform the manual poll. 
Config600 then waits for you to issue the Reload Tree, Upload All, or 
Upload New command from the File menu to poll the S600+. 

11.3.1 Configuring Config600 Communications 
You must configure the communication settings Config600 uses to 
retrieve data from selected flow computers. An editor is available from 
the Tools menu, which allows you to set up the port, TCP/IP address, 
or telephone details to use in connecting to the flow computer.  

1. Select Tools > Manual Comm Settings to display the Comms 
Properties screen.  

 

Figure 11-5. Typical Display Page (Stream 2 Flow Limits shown)  

2. Complete the values for the communications port Config600 uses:  
Field  Description 
Comm Type Selects the communication type Config600 uses to 

perform a manual poll. Click  to display all valid 
types. Valid values are Serial (the default), 
Ethernet, or Modem.  

Slave Address Sets a valid Modbus slave address for the flow 
computer. 
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Field  Description 
Retry Count Sets the number of times the Remote Archive 

Uploader should attempt to communicate with the 
S600+ before it times out. 

TCP/IP Address Sets IP address for the S600+ with which you desire 
to communicate.  
Note: This field is active only if you select Ethernet 

in the Comms Type field. 
TCP/IP Port Sets the dedicated TCP port at the S600+ with 

which you desire to communicate. Valid ports are 
6001 and 6002; port 6002 is recommended. Ensure 
no other device is communicating with the S600+ on 
this port. 
Note:  This field is active only if you select Ethernet 

in the Comms Type field. 
Baud Rate Sets the serial transfer rate. Click  to display all 

valid values. The default value is 38400.  
Note: This field is active only if you select Serial or 

Modem in the Comms Type field. 
Data Bits Sets the number of data bits the port uses. Click  

to display all valid values. The default value is 8. 
Note: This field is active only if you select Serial or 

Modem in the Comms Type field. 
Stop Bits Sets the period length. Click  to display all valid 

values. The default value is 1. 
Note: This field is active only if you select Serial or 

Modem in the Comms Type field. 
Parity Sets the type of parity used to detect data corruption 

during transmission. Click  to display all valid 
values. The default value is None. 
Note: This field is active only if you select Serial or 

Modem in the Comms Type field. 
Port Sets the communication port to using during serial 

transmissions. Click  to display all valid values. 
The default value is COM1. 
Note: This field is active only if you select Serial in 

the Comms Type field. 
Modem Sets the type of modem you will use in 

communications. Click  to display all valid values.  
Note: This field is active only if you select Modem 

in the Comms Type field. 
Phone No. Sets the phone number of the modem you will use in 

communications. 
Note: This field is active only if you select Modem 

in the Comms Type field. 
Properties Click the Properties button to configure additional 

parameters for the modem. 
Note: This button is active only if you select 

Modem in the Comms Type field. 

3. Click OK to save any changes. The Remote Archive Uploader 
screen redisplays. 

11.3.2 Reload Tree 
This command enables you to manually generate, view, print, and save 
the following:   
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 Constant Log  
 Display dump  
 List of all available alarms  
 List of current alarms  
 Current report  
 Alarm / Event History File  

Note: Support for the Alarm / Event History file feature was 
withdrawn for firmware 05.xx and above. Please contact 
technical support for assistance. 

Select the File > Reload Tree. Config600 software reads the report 
index file from the S600+ (using the parameters you configure on the 
Manual Communication Settings screen) and displays the contents. 

Note: If you set the manual communication type to Modem, you 
must manually connect the modem before you can select the 
Reload Tree command. 

 
Figure 11-6. Remote Archive Uploader Tree  

The tree shows a list of the files available in the S600+ archive. To 
upload a file, click the file in the tree. The package extracts that file 
from the S600+ and displays it on the right side of the screen. 
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Notes: 
 The system does not automatically store data generated using this 

method on the PC. You must manually save these reports using the 
File > Save As command. 

 The Current Report generated using this method is not archived in 
the S600+, as its generation bypasses the S600+ print and archiving 
mechanism. If a generated Current Report is required, it should be 
generated manually. If a Current Report has been generated at the 
S600+, it appears along with all other archived reports in the tree 
on the left side of the screen. 

Progress Bar A progress bar display at the bottom of the window and provides 
details of the action underway and its percentage completion. A small 
modem graphic has also been added to display the modem connection 
status. 

 

Figure 11-7. Progress Bar 

11.3.3 Upload All Reports / Upload New Reports 
The Upload All Reports and Upload New Reports commands enable 
manual polling of the S600+ using the communication parameters you 
entered on the Tools > Manual Comms Settings page. The system 
automatically saves files generated by this method in the user-defined 
file directory on your PC.  

To perform an manual poll using the Upload All Reports or Upload 
New Reports command:  

1. Select File > Upload All Reports (to upload all archived reports 
from the S600+ and save them into the folder on the PC) ) or select 
File > Upload New Reports (to upload only new archived reports 
from the S600+ and save them into the folder on the PC). The Flow 
Computer Selection screen displays. 
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Figure 11-8. Manual Upload Options 

2. Complete the values for the desired flow computer: 
Field  Description 
Flow computer 
list 

Click  to display all valid flow computers you defined 
on the Flow Computer List screen. 
Notes: 
 These options then become either the folder name 

(extended folder structure) or part of the file name 
(compact folder structure). 

 The f low computer list option uses the 
communications details you enter into the list 
(Tools > Flow Computer List). 

New Flow 
computer 

Sets the name of the new flow computer with which 
you desire to communicate. 
Notes: 
 These options then become either the folder name 

(extended folder structure) or part of the file name 
(compact folder structure). 

 New Flow Computer option uses the default 
communications settings as per the Reload Tree 
command although the modem now connects and 
disconnects automatically. 

3. Click OK to perform the manual poll. 

11.4 Viewing Reports 
You can view reports stored on the S600+. 

Note: The system retrieves reports from the S600+ using the 
communication settings you configured on the Manual Comms 
Settings screen. 

11.4.1 Report Archive 
You can view reports stored in the S600+ archives. To view reports:  
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1. Select File > Reload Tree to display all reports loaded in the 
S600+ archive. 

2. Double-click Report Archive. 

3.  Double-click the report you desire to view. 

 

Figure 11-9. Report Archive 

11.5 Saving  
By default, the system saves automatically retrieved archives on your 
PC’s Config600 Archive folder. You can change the default location 
using the Directory Settings command or manually save a report using 
the Save As command. 

11.5.1 Directory Settings (File Locations) 
Archives retrieved automatically are saved on your PC in the 
Config600 Archive folder. You can configure Config600 to save 
archive uploads to a different folder using the Directory Settings 
command. To configure a different folder: 
1. Select Tools > Directory Settings. The Select Folder screen 

displays. 
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Figure 11-10. Select Folder 

2. Navigate to the folder on your PC where you want Config600 to 
save your uploaded archives. 

3. Click Open to select the new location. 

11.5.2 File Settings 
You can configure the file format when saving archive uploads. You 
can choose from two formats: .txt file format or .PDF file format. To 
configure the file format:  
1. Select Tools > File Settings. The Save File Settings screen 

displays.  

 

Figure 11-11. Select Folder 
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2. Click  to display all valid file format options. If you select Text 
File (*.txt) format type, the archive uploads are saved as .txt files. 
If you select PDF Documents (*.pdf) format type, the archive 
uploads are saved as .pdf files.   
Field  Description 
File Format Click  to choose a f ile format for report uploads. 

Valid options are Text File (*.txt) (the system 
saves archive uploads as .txt files) or PDF 
Documents (*.pdf) (the system saves archive 
uploads as .pdf files). The default is PDF 
Documents (*.pdf). 

User Password Indicates the password for the user of the 
document. The user_password is allowed to be 
set to NULL or zero length string.The max length 
of  user pass is 32 characters. If  the password is 
set, the min length is 8 characters. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Enable Printing Enables, if selected, the Print option in the PDF 

f ile. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Enable Copy Enables, if selected, the Copy option in the PDF 

f ile. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Add “created 
by” 

Includes, if selected, the Windows login name of 
the person who created the document and the 
date/time the document was created at the 
bottom of every page. This information is 
provided in the following format:  
Document created by operator: <xxxxxxx> at 
<Date / Time> 
Where xxxxxx is the windows login name 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Title Sets a name to be saved in the Document 

Properties of the PDF file. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Author Sets an author name to be saved in the 

Document Properties of the PDF file. The default 
is the user computer name. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Subject Sets a subject to be saved in the Document 

Properties of the PDF file. The default value is 
S600 Archive. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
Keywords Provides the keywords to be saved in the 

Document Properties of the PDF file. 
Note: The option is valid only if you select PDF 

Documents (*.pdf) as the file format type. 
 
3. Click OK to save your changes.  
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11.5.3 Save As 
To manually save a report:  

1. When viewing a report, select File > Save As. The Save As screen 
displays. 

 
Figure 11-12. Save As 

2. Type a file name in the File Name field. 

3. Navigate to the location where you desire to store the report. 

4. Click Save to save the report. 

11.5.4 Folder Formats 
You can configure what folders on your PC are created when saving 
archive uploads. You can choose from two folder formats: compact 
folder format or extended folder format. 
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Compact Folder 
Formats 

Select Tools > Compact Folder Format to enable files uploaded 
through either manual or automatic operation, to be automatically 
stored in the same folder (called FCD Data). 

 
Figure 11-13. Compact Folder Format 

Note: Since the entry in New Flow Computer manual option uses the 
default communications settings and forms part of the file 
name, take great care in using this option: you can accidentally 
overwrite files from other computers.  
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Extended Folder 
Formats 

Select Tools > Extended Folder Format to enable files uploaded 
through either manual or automatic operation, to be automatically 
stored in individual folders as named by the manual load options or 
the Flow Computer List.  

 

Figure 11-14. Extended Folder Format 

Note: Config600 creates the Basetime 1 period 1 and 2 folders and 
places archived reports as text files in these folders.  

11.5.5 Data Integrity 
The package carries out checks to ensure integrity of data transfers as 
follows.  

Field  Description 
File Size All files are checked to ensure they have a non-zero 

size. Any Zero sized files are deleted. This will appear 
in the error log. Due to differences in file sizes, only the 
Zero size is checked. 

Comm Fail Any f ile in transit if a COMMS FAIL alarm is 
detected is deleted irrespective of its file size. This 
appears in the error log. Failures include: 
 Slave fails to respond. 
 Slave sends exception reply. 
 CRC fail. 
 PC cannot connect to port or socket. 
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Field  Description 
File Names Any files that do not match those you configure in the 

Flow Computer List display in the error log. 

11.6 Printing the Report 
This section details how to print reports.  

11.6.1 Print 
To print the report select File > Print. The Windows Print screen 
displays 

 

Figure 11-15. Print dialog 

11.6.2 Print Preview 
To display a preview of the report before you print it: 

1. Select File > Print Preview. The Print Preview screen displays. 
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Figure 11-16. Print Preview 

2. Review the values for in the following fields: 
Field  Description 
Print Click to print the report. 
Next Page Click to see the next page in the report. 
Previous Page Click to see the previous page in the report. 
Two Page Click to see the report in a two page layout side-by-

side. 
Zoom In Click to zoom in on the report to make it larger. 
Zoom Out Click to zoom out on the report to make it smaller. 

11.6.3 Print Setup 
To display and configure the Print dialog, select File > Print Setup. 
The Print Setup screen displays: 
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Figure 11-17. Print Setup 

Review (or change as necessary) the fields on this screen and then 
click OK to accept the changes. 

11.7 Abort Transfer 
Select Tools > Abort Transfer to stop data from being transferred 
between the Remote Archive Uploader and the S600+.  

 

Figure 11-18. Abort Transfer 
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Chapter 12 – Report Editor 
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The Report Editor is a Windows-based tool that is a part of the 
Config600 software suite. The Report Editor enables you to modify the 
reports that you have defined in the S600+ configuration. The Report 
Editor allows you to add both background text and data points, 
therefore enabling the generation of completely customized reports.  
Reports have a maximum of 80 characters per line. The system 
automatically numbers each report using a “docket number” system 
that maintains up to 65,536 unique reports. The docket number starts at 
0 and increments to 65535. When the numbering reaches 65535, the 
numbering system restarts at 0 and replaces the report with the original 
docket number 0.   
You can use the Report Editor to modify the format of current, period, 
and batch reports, which either print upon trigger events you define or 
appear on the webserver. However, you cannot use the Report Editor 
to change the format of constant logs, display dumps, security dumps, 
alarm dumps, config reports, Modbus maps, or help text. 

The procedures in this chapter describe how to change the fields and 
text in the body of reports. You configure basetime and other report 
parameters on the System Setup > Reports screen.  

Note: Because the reports do not affect the metering accuracy of the 
S600+, changing the report layout does not increase the Config 
Version of the selected configuration.  

The PCSetup Editor has been modified to integrate with the Report 
Editor. PCSetup generates only new reports that have been added and 
deletes any that have been removed. This allows the Report Editor to 
edit the reports directly in the main reports folder without the 
intervention of PCSetup.  

Period total indexes are fixed for any particular stream, period, and 
index to ensure the integrity of the database. Config600 uses a formula 
to generate an index from these variables, and adding or removing 
reports does not change any other indexes. The period total indexes can 
be referenced in the reports.  
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12.1 Accessing the Report Editor  
You access the Report Editor either as a selection from the PCSetup 
Editor or as its own application.   

12.1.1 Via PCSetup  
While you are using the PCSetup Editor, this method enables you to 
select a specific report you have already defined and stored in the 
current configuration. 

1. From the PCSetup Editor hierarchy, select System Setup > 
Reports. The Reports screen displays. 

 

Figure 12-1. PCSetup Reports screen   

Note: If you have more than one version of Config600 on your 
machine, select the version appropriate to the configuration 
file.  

2. Select a report from either the General Reports or the Base Time 
Reports pane. Config600 adds Configure, Edit, and Delete buttons 
next to the report listing.   
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Figure 12-2. PCSetup Reports screen with Edit button   

3. Click Edit. The Report Editor opens, displaying the selected report.  

 

Figure 12-3. Report Editor  

12.1.2 Via Report Editor  
Use this method to open the Report Editor application independently of 
the PCSetup Editor.   

 

1. Click Start > All Programs > Config600 3.3 > Report Editor. A 
Select Config dialog displays.  
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Figure 12-4. Select Config dialog  

2. Select a configuration. Note that Config600 completes the 
information fields for the selected configuration.  

 

Figure 12-5. Select Config dialog  

3. Click OK. Config600 loads all of the reports defined within that 
configuration file and displays the first report on the Report Editor 
screen. Note that the screen’s title bar now displays the report name 
(rep8.txt, in this case). 
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Figure 12-6. Report Editor screen (populated)   

Note: By default, Report Editor displays the rep8.txt report first. 
To display a list of all currently defined reports within this 
configuration file, click the Window option on the menu 
bar.  

12.1.3 Report Names 
Config600 uses the following naming convention for the report files. 
You cannot change these report file names, which are listed so you can 
locate them in the Reports directory, if necessary.  
 

Report File Name Description 
rep00.txt Fixed Hourly Report 
rep01.txt Batch Report 
rep02.txt Maintenance Report 
rep03.txt Base Time 1 – Period 1 Report 
rep04.txt Base Time 1 – Period 2 Report 
rep05.txt Base Time 1 – Period 3 Report 
rep06.txt Base Time 1 – Period 4 Report 
rep07.txt Base Time 2 – Period 1 Report 
rep08.txt Base Time 2 – Period 2 Report 
rep09.txt Base Time 2 – Period 3 Report 
rep10.txt Base Time 2 – Period 4 Report 
rep11.txt Base Time 3 – Period 1 Report 
rep12.txt Base Time 3 – Period 2 Report 
rep13.txt Base Time 3 – Period 3 Report 
rep14.txt Base Time 3 – Period 4 Report 
rep15.txt Current Report 



Config600 Configuration Software User Manual 

12-6 Report Editor Revised January 2023 

Report File Name Description 
rep16.txt Stream Prover Volume Report 

Note: Previous versions of the Config600 
sof tware grouped the Prover Volume 
report and the Prover Mass report in one 
report, rep16.txt.  

rep17.txt Stream Prover Mass Report 
rep18.txt Station 1 Prover Volume Report 
rep19.txt Station 1 Prover Mass Report 
rep20.txt Station 2 Prover Volume Report 
rep21.txt Station 2 Prover Mass Report 
rep22.txt CHR D/LOAD 
rfep23.txt CHR TELEMETRY 
rep24.txt BATCH TICKET 

rep25 – rep39.txt User def ined reports 
 

12.2 Using the Report Editor  
Regardless of the access method, once you open the Report Editor you 
can begin using it to modify the format and content of your reports.  

You select editing functions from a pop-up menu, which displays when 
you right-click any part of the Report Editor screen:  

 

Figure 12-7. Report Editor menu   

Note: You can also access this menu by selecting Edit from the menu 
bar.  
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The menu provides these options:  
Option  Description 
Cut  Removes the selected element from the report and 

places it on the Clipboard.  
Copy  Copies the selected element from the report and 

places it on the Clipboard.  
Paste  Places content from the Clipboard to the cursor’s 

location.  
New Placement Accesses the Placement Editor, which you use to 

define a new data point (see Section 12.2.1, Adding a 
Data Point).  

Edit Placement Accesses the Placement Editor, which you use to edit 
a current data point.  

Delete Removes the selected element from the report without 
placing it on the Clipboard.  

Insert Line Adds a line to the report at the cursor’s current 
position.  

Delete Line Removes the selected line from the report.  
 
Note: The Report Editor does not provide an “undo” function. Once 

you have deleted a report element or a line, you cannot restore 
it. You must recreate it.   

12.2.1 Adding a Data Point 
Use this procedure to add a data point field to the selected report.  

1. Place the cursor where you want to insert the new data point.  
2. Right-click and select New Placement from the shortcut menu. 

The Placement Editor dialog box displays.   

Note: You can also select Edit > New Placement from the menu 
bar.  

 

Figure 12-8. Placement Editor   

3. Click System Run Mode / Desc to select a data point. The 
Connect Wizard displays.  
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Figure 12-9. Connect Wizard   

4. Define the new data point by highlighting values in each of the four 
columns. Select from left to right. You can click  or  to display 
more values. Refer to Appendix E, S600+ Database Objects and 
Fields for additional information.   

5. Click OK once you have defined the new data point. The 
Placement Editor dialog box re-displays. Note that the label on the 
button now reflects the choices you made using the Connect 
Wizard. 

 

Figure 12-10. Placement Editor with revised label   

6. Complete the following fields on the Placement Editor dialog box:  
Field  Description 
Minimum Field 
Width 

Indicates the number of characters reserved for the 
data item, counted to the right of where you placed the 
data item. If the number or text exceeds the minimum 
f ield width, the data item automatically expands to the 
right.  

Alignment Indicates whether the data point aligns to the left or 
right of the placed position.  

 
7. Click OK to apply your new data point definition to the report file. 

The report file displays, showing your new data point.  
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12.2.2 Editing a Data Point  
Use this procedure to edit an existing data point field on the selected 
report.  

1. Select an existing data point and right-click. The edit pop-up menu 
displays.   

2. Select Edit Placement. The Placement Editor dialog box displays.   

 

Figure 12-11. Placement Editor dialog box  

3. Click the button at the top of the dialog box. The Connect Wizard 
displays.  

Note: The label on this button changes depending on the data 
point you select.   

 

Figure 12-12. Connect Wizard  

4. Modify the selections on the Connect Wizard as necessary.  
5. Click OK when you finish. The Placement Editor dialog box 

displays.  
6. Click OK to apply your changes to the data point. The report file 

displays.  

12.2.3 Adding Report Lines 
Use this procedure to insert a new line on the report.    

1. Place the cursor where you desire to insert the new line.  
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2. Right-click and select Insert Line from the shortcut menu. 
Config600 adds a blank line to the report above the cursor position.  

12.2.4 Deleting Report Lines 
Use this procedure to delete a line from the report.   
1. Place the cursor on the desired line.  

2. Right-click and select Delete Line from the shortcut menu. 
Config600 removes the line from the report.  

 

Caution 
This editor does not provide an “undo” facility. Once you delete a 
report line, you cannot restore it. You must rebuild it. 
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Chapter 13 – Display Editor 
In This Chapter 

13.1 Accessing the Display Editor .................................................. 13-1 
13.2 Navigating the Display Editor ................................................. 13-2 
13.3 Editing ................................................................................ 13-3 

13.3.1 Insert Menu............................................................. 13-5 
13.3.2 Insert/Append Page.................................................. 13-5 
13.3.3 Edit Line ................................................................. 13-5 
13.3.4 Translate ................................................................ 13-7 
13.3.5 Save ...................................................................... 13-8 
13.3.6 Menu/Page Clipboard ............................................... 13-8 

13.4 Regenerating Displays .......................................................... 13-8 

The S600+ Display Editor allows you to customize the visual display 
on your S600+’s front panel. The Display Editor provides a graphical 
"what-you-see-is-what-you-get" (WYSIWYG) feel for the final 
appearance of the front panel and the navigation of your configuration 
in the S600+. The Display Editor presents your configuration, allowing 
you to view the actual data point initialization values for your specific 
application.  

Note: The Display Editor front panel does not display live data from 
the S600+. 

 

13.1 Accessing the Display Editor 
You can start the Display Editor in any of three ways:  

 Click the Edit Displays icon  on the PCSetup Editor’s tool bar. 
The Display Editor menu displays.  

 Select Tools > Edit Displays from the PCSetup Editor’s Menu bar. 
 Click Start > All Programs > Config600 3.3 > Display Editor. 

You select a configuration from the Select Config dialog box. The 
Display Editor menu displays.  

 

Caution 
Because of the way S600+ creates and saves displays, you should edit 
displays only after you have finished creating the configuration file. 
This ensures the inclusion of any changes to the configuration. 
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Figure 13-1. Display Editor main menu screen  

13.2 Navigating the Display Editor 
To navigate through the Display Editor, click menu options 1 through 
6 and 8. To move back up through the menus, click the menu button or 
the 4-direction arrow key. These keys behave just as they do on the 
S600+ front panel itself. Refer to Chapter 5 in the FloBoss S600+ 
Flow Computer Instruction Manual (part D301150X412) for more 
details on front panel navigation.  
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Figure 13-2. Typical Display Page (Stream 2 Flow Limits shown)  

13.3 Editing the Display Editor  
To edit the displays:  

1. Right-click on a menu line to display a shortcut menu. 
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Figure 13-3. Display Editor with shortcut menu   

This menu provides the following options: 
Option  Description 
Insert Menu Creates a submenu.  
Insert Page When you select Insert Page from a menu, the Display 

Editor creates and inserts a page link at the position of 
the cursor.  
When you select Insert Page from a page, the Display 
Editor creates and inserts a page before the selected 
page.  

Append Page Creates and inserts a page after the selected page.  
Edit Line  Edits the selected line.  
Translate Re-indexes the placements on the displays to use an 

alternative stream or station selection, such as to 
change stream objects from their current stream 
selection to the equivalent selection in another stream. 

Save Saves any modifications you have made to the 
configuration file.  

Menu/Page Cut, copy, delete or paste the menu item or page link. 
Help Accesses the online help for the Display Editor.  

 

Config600 grays out any options that do not apply to the selected 
item.  
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13.3.1 Insert Menu 
To create a new menu, right-click on any empty menu slot and select 
Insert Menu. 

The S600+ can display more than eight options in a menu. However, 
unless the menu already has eight or more options, you cannot 
currently add more options.  

Note: If you create empty menus while editing, the S600+ does not 
display them because the Display Editor automatically removes 
them on startup.  

13.3.2 Insert/Append Page 
To create a new page, right-click on any empty menu slot. You can add 
a new page to an existing menu option by navigating to a page on that 
row, right-clicking, and selecting either Insert Page (to create a page 
before the current one) or Append Page (to create a page after the 
current one).  

The S600+ can display more than eight options in a menu. However, 
due to technical limitations with the Display Editor, you cannot add 
more options. Contact technical support personnel if you need to add 
more options. 

13.3.3 Edit Line 
To edit an existing line in the display menu:  

1. Right-click on the required line and select Edit Line. The Edit 
dialog box displays.  

 

Figure 13-4. Edit dialog box   
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2. If the line contains only text, use the Text field to change the 
displayed description.  

Note:  The description cannot contain any commas (,).   

3. Click OK when you are finished. The menu displays, showing your 
edit.  

4. If the line contains a data point or you want to place a data point on 
a blank line, select the Data Point checkbox. Config600 activates 
the rest of the Edit dialog box.  

 

Figure 13-5. Edit dialog box   

5. Click the Data Point button at the top of the Data Point pane to 
define a data point. The Connect Wizard displays.  

 

Figure 13-6. Connect Wizard   
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6. Define the new data point by highlighting values in each of the 
four columns (object source, object type, object, object field). 
Select from left to right. Click  or  to display more values. 

Note:  Refer to Appendix E, S600+ Database Objects and Fields. 

7. Click OK when you have finished. The Edit dialog box displays.  

8. Complete, as necessary, the remaining fields on the Edit dialog 
box.  
Field  Description 
Security  Indicates a security Level (0 to 9) for the field.  

Note: The default is 0 (cannot be changed).  
Exponential 
Format  

Select to indicate the representation of numbers in an 
exponential format.  
Note: If  you select this checkbox, S600+ greys out 

the Decimal Places and Leading Zeroes fields.  
Decimal Places  Indicates the number of decimal places required for the 

selected field.  
Leading Zeroes  Select to indicate whether leading zeroes are required 

for this field.  
High Limit  Indicates the high (maximum) limit for the value in this 

f ield.  
Low Limit  Indicates the low (minimum) limit for the value in this 

f ield.  
 
9. Click OK when you have finished defining the field. The Display 

Editor displays, showing the new value you have defined.  

13.3.4 Translate 
This shortcut menu option allows you to translate or copy a menu 
structure for one stream or station into that for another stream or 
station. To translate a menu structure: 

Note: The Translate function only translates stream or station data.   

1. Build the display structure you require for one stream or station. 
(This is the “model” structure.) 

2. Right-click on another line and select Translate. The Translate 
dialog box displays.  

 

Figure 13-7. Translate dialog box   
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3. Select a model stream or station from the left-hand column and a 
target stream or station in the right-hand column. Config600 
activates the OK button when you identify a target stream or 
station.  

4. Click OK to apply the model structure to the target stream or 
station.  

13.3.5 Save 
If you have changed any display content, Config600 gives you the 
option of saving your changes through the Save option on the shortcut 
menu. Establishing the habit of saving your work frequently is a highly 
recommended practice.  

13.3.6 Menu/Page Clipboard 
The Display Editor has a built-in clipboard that can store any number 
of menus and/or pages. This enables you to copy or move menus and 
pages by right-clicking and using the shortcut menu. 

 To copy a page to the clipboard, navigate to that page and select 
Menu/Page > Copy from the shortcut menu.  

 To copy a whole row of pages to the clipboard, navigate to the 
menu above the row of pages, right-click on the title of the row of 
pages, and select Menu/Page > Copy.  

 To copy a menu structure complete with all submenus and pages, 
navigate to the menu above the menu structure you wish to copy, 
right-click on the menu title required, and select Menu/Page > 
Copy. 

Deleting and cutting menus and pages is the same as copying but you 
select Menu/Page > Delete or Menu/Page > Cut. A Cut is similar to a 
Delete, except that the action places the deleted items on the clipboard. 
Once you have a page or a row of pages on the clipboard, you can 
paste them either to an empty menu slot or into an already existing row 
of pages.  

To paste the page(s) to an empty slot, right-click on an empty menu 
slot and select Menu/Page > Paste.  

To paste the page(s) into an already existing row of pages, navigate to 
an already existing page and select Menu/Page > Paste. Config600 
pastes a copy of the page or pages on the clipboard after the current 
display in the page row. 

When you have a menu structure in the clipboard, you can paste it into 
any empty menu slot by right-clicking on it and selecting Menu/Page 
> Paste. You cannot paste menu structures into pages or page rows. 

13.4 Regenerating Displays 
Using an option in PCSetup, you can restore S600+ displays to the 
appearance and values as defined in the selected configuration. 
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Caution 
This option overwrites any edits or customisations you may have made 
to the displays in the selected configuration.  
 

1. Select File > Regenerate from the PCSetup menu bar. The Display 
and Modbus Regeneration dialog box displays.   

 

Figure 13-8. Display Regeneration   

2. Select the Displays check box and click OK. Config600 restores 
all S600+ displays to the default values defined in the selected 
configuration.  
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Chapter 14 – Modbus Editor 
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The Modbus protocol is the standard communications interface to the 
S600+. The protocol is based on Gould/Modicon Modbus. The S600+ 
supports Modbus, Modbus Enron (also referred to as Modbus with 
EFM Extensions), and Modbus encapsulated in TCP/IP. The FloBoss 
S600+ supports both slave and master functionality in Modbus and 
Modbus Enron, and slave functionality in Modbus encapsulated in 
TCP/IP. 

Modbus is the Config600 software interface to the S600+. This 
communications link uses Function Code 65, with specially designed 
sub-functions to provide file transfer, system edit commands, and other 
specialized functionality. The S600+ is the slave on this link.  
 

14.1 Supported Function Codes  
The Config600 Modbus supports the following function codes.   

Function Code Description 
1 Read Output Status  
2 Read Input Status  
3 Read Output Registers  
4 Read Input Registers  
5 Read Single Coil  
6 Read Single Register  
8 Loopback  

15 Write Multiple Coils  
16 Write Multiple Registers  
65 Read Floats (PCSetup only)  
66 Write Floats (PCSetup only) 
67 Read Doubles (PCSetup only) 
68 Write Doubles (PCSetup only) 

 

Modbus fully supports RTU (Remote Terminal Unit) Modbus and 
ASCII (American Standard Code for Information Interchange) 
Modbus. In RTU mode, you must configure the link for 8 data bits. No 
message header or trailer is included. The checksum is the 16-bit CRC 
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specified in the Gould Modbus specification. No inter-character gaps 
are required on received RTU Modbus messages. 
In ASCII mode, you can set the link to 7 or 8 data bits. The message 
starts with the ASCII Modbus start character “:” (colon). The 
checksum is the 8-bit LRC defined in the Gould Modbus specification. 
The message terminates with the ASCII Modbus trailer characters 
“CR” then “LF”. 

The communications configuration is split into two parts: link 
configuration for the ten tasks (links) and map configuration. The 
Modbus map configuration is the assignment of database points and 
fields to Modbus coils, inputs, and registers. This is accomplished 
through a text file you build using the Modbus Editor.  

14.2 Accessing the Modbus Editor  
You can start the Modbus Editor in either of two ways:  
 From the PCSetup Editor’s hierarchy menu, select I/O Setup > 

Comms. Select a Modbus task that includes an Address Map and 
click Edit. The Modbus Editor displays.  

 From Windows, click Start > All Programs > Config600 3.3 > 
Modbus Editor. Select File > Open and select a configuration file 
from the Select Config dialog box. The Modbus Editor displays. 

Note: If you have more than one version of Config600 on your 
machine, select the version appropriate to the configuration 
file. Starting with Config600 3.1, the system derives the 
Slave Modbus map from the in-use display file.  

14.3 Using the Modbus Editor  
The Config600 Modbus Editor enables you to configure the Modbus 
maps the Config600 sends to the S600+ to allow communications.  

Using the Modbus Editor, you create Modbus maps as text files. All 
Modbus maps must use the naming convention “mbxxxxxx.txt”: file 
names begin with mb followed by six characters of your choosing. The 
S600+ only recognizes map files that start with mb.  

Note: As you edit maps, make sure to save (using either the Save icon 
or File > Save) all modifications to the files.  

The interface shows the coils, inputs, and registers in spreadsheet-style 
tables. The editor consists of two panes: a hierarchy menu in the left 
pane and the tables in the right pane. 
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Note: Addresses that display and that you enter at the S600+ are the 
actual address transmitted and received within the Modbus 
messages, they are not pre-processed. Functions are entered 
separately and are not associated with a specific address range. 
Each function can access any address.  

 

Figure 14-1. Modbus Editor main screen  

Note: Using the PCSetup Editor’s Comms screen (I/O Setup > 
Comms), you can define an entire Modbus map as read-only. 
This prevents the host PC—or any other computer—from 
editing or overwriting the map.  

14.4 Map Properties 
Use the Modbus map Properties dialog box to set parameters for the 
map’s .txt file.  

1. Select Register in the left pane. 

2. Select File > Properties from the Modbus Editor’s menu bar. The 
Properties dialog box displays.  
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Figure 14-2. Properties dialog box  

Note: If you selected a slave map to edit, Config600 greys out the 
Master Settings.  

3. Complete the following fields:  
Field  Description 
TX Buffer Size Sets, in bytes, the size of the message transmit buffer. 

Valid values are 256 to 65535. For normal Modbus 
operation, set this to 256, since this is the maximum 
message size Modbus supports.  

RX Buffer Size Sets, in bytes, the size of the message receive buffer. 
Valid values are 256 to 65535. For normal Modbus 
operation, set this to 256, since this is the maximum 
message size Modbus supports.  

Message 
Length Mode 

Indicates how the system handles the message length 
section of the Modbus message. Click  to display 
valid values, which include Byte 8, Byte 16, Item 8, and 
Item 16.  
The basic Modbus specification defines this field as a 
single byte, which defines the number of bytes of data 
in the message. Many implementations have changed 
this field to be an item count, indicating the number of 
data items in the message.  
To increase the amount of data you can transfer, the 
S600+ supports a 16-bit value for this field. This 16-bit 
value is not compatible with standard Modbus.  
Note:   If  you use either of the 16-bit formats, 

messages may be longer than 256 bytes. 
Adjust the values in the TX Buffer Size and RX 
Buffer Size fields accordingly.  

Poll Delay Sets, in sixtieths of a second, the delay between 
system polls.  

Loop Delay Sets, in sixtieths of a second, the delay at the end of a 
poll loop.  

Retry Limit Sets the number of retries the master polls for a single 
message before classing it as failed.  
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Field  Description 
Timeout Sets, in seconds, the amount of time the master waits 

for a response from the slave.  
Slave Status 
Object 

The slave status KPINTARR gives the communication 
link status of an individual slave on a Modbus master 
link. Each field of the KPINTARR represents the status 
of  a specific slave. For example, a Modbus master link 
with three slaves would use FIELD01, FIELD02 and 
FIELD03 as they appear listed in the Modbus map 
editor tree view. Note the field number bears no 
relation to the Modbus slave address. The individual 
f ields can have a value of 0 (healthy), 1 (disabled) or 2 
(communication error). 

Slave Control 
Object 

The slave control KPINTARR uses to enable or 
disable an individual slave on a Modbus master link. 
Each field of the KPINTARR represents the status of a 
specific slave. For example, FIELD01 enables or 
disables the first slave as listed in the Modbus map 
editor tree view. Note the field number bears no 
relation to the Modbus slave address. 

Slave Address 
Object  

The slave address KPINTARR uses to define the 
Modbus address of an individual slave on a Modbus 
master link. Each field of the KPINTARR represents 
the address of a specific slave. For example, FIELD01 
contains the address of the first slave as listed in the 
Modbus map editor tree view. 

 
4. Click OK when you have finished. The Modbus Editor screen 

displays.  

14.4.1 Insert a Data Point 
The Modbus Editor provides three ways to add a data point to the 
Modbus map:  

 Quick Insert (base new data point entirely on selected data point).  
 Insert Special (define new data point by using the Enter Details 

and Choose dialog boxes).  
 Insert (do not base new data point on selected data point; use the 

Enter Details dialog box and Connect Wizard to define data point 
components).  

Note: Regardless of the method you select, be sure to save the 
Modbus map after you add each new point.  

These methods correspond to the options on the Edit shortcut menu, 
which are also available through the Edit menu on the Modbus Editor 
menu bar.  
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Figure 14-3. Insert shortcut menu  

14.4.2 Quick Insert  
To base a new data point on a selected data point:  
1. Select the data type in the hierarchy menu. The associated list 

displays in the right pane.  
2. Select a data point in the right pane. Right-click the data point to 

display the shortcut menu  
3. Select Quick Insert. Using the next available starting address, the 

Modbus Editor adds the new data point to the data point listing.  

Note: To further define this data point, refer to the procedures 
described in Section 14.4.6, Edit Modbus Format.  

14.4.3 Insert Special  
To add a data point field to the report:  

1. Select the data type in the hierarchy menu. The associated list 
displays in the right pane.  

2. Select a data point in the right pane. Right-click the data point to 
display the shortcut menu.  

3. Select Insert Special. The Modbus Editor displays the Enter 
Details dialog box.  

 

Figure 14-4. Enter Details dialog box  
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4. Indicate a starting address for the new data point. As a default, the 
Modbus Editor uses the next available address based on the data 
point you selected in step 2.  

5. Click OK. The Choose dialog box displays.  

 

Figure 14-5. Choose dialog box  

6. Select a data item type and click OK. The Modbus Editor adds the 
new data point to the data point listing.  

Note: To further define this data point, refer to the procedures 
described in Section 14.4.6, Edit Modbus Format.  

14.4.4 Insert Special  
To create the next available address using the same parameters as the 
selected data item:  
1. Select the data type in the hierarchy menu. The associated list 

displays in the right pane.  
2. Select a data point in the right pane. Right-click the data point to 

display the shortcut menu.  
3. Select Insert. The Modbus Editor displays the Enter Details dialog 

box.  

 

Figure 14-6. Enter Details dialog box  

4. Indicate a starting address for the new data point. As a default, the 
Modbus Editor uses the next available address based on the data 
point you selected in step 2.  

5. Click OK. The Connect Wizard displays.  
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Figure 14-7. Connect Wizard  

6. Define the new data point by highlighting values in each of the four 
columns (source, type, item, field). Select from left to right. Click 
 or  to display more values.  

7. Click OK. The Modbus Editor displays, showing the newly added 
data point.  

14.4.5 Delete a Data Point 
 

Caution 
The Modbus Editor does not have an “undo” function. Once you delete 
a data point, you cannot restore it. You must re-create it. 
 

To delete a data point:   

1. Right-click a data point. A shortcut menu displays.  

2. Select Delete from the shortcut menu. The Modbus Editor screen 
displays without the selected data point.  

14.4.6 Edit Modbus Format  
To edit the format of a Modbus register:  
1. Select a register from the hierarchy menu. Config600 highlights 

the register in the left-hand pane.  
2. Right-click a data item. Config600 displays a shortcut menu.  

Note:  The options on the shortcut menu are also available on the 
Edit menu on the Modbus Editor’s menu bar.  

3. Select Edit Format from the shortcut menu. The Edit Format 
dialog box displays.  
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Figure 14-8. Edit Format dialog box  

4. Select an address format. Click  to display additional formats.  
Field  Description 
Scale n nnnn  Reads holding registers as integers, scaled between 

the values n and nnnn. In master mode, the S600+ 
displays the value returned in terms of the selected 
scaling. For example, 500 would represent 50% on the 
scaling 0 999 or 5% on the scaling 0 9999. You can 
configure data at every address (such as 0 to 65535).  

Float  Reads holding registers as IEEE-format single-
precision floating point numbers, Most Significant Byte 
(MSB) first. For each point required, one address is 
requested in the Modbus message and 4 bytes are 
returned. You can configure data at every address 
(such as 0 to 65535). 

Double  Reads holding registers as IEEE-format double-
precision floating point numbers. For each point 
required, one address is requested in the Modbus 
message and 8 bytes are returned. You can configure 
data at every address (such as 0 to 65535). 

Enron 16 Bit  Reads holding registers as signed integers, in the 
range –32767 (Hex 8001) to 32767 (Hex 7FFF). You 
can configure data at every address (such as 0 to 
65535). 

Enron 32 Bit Reads holding registers as unsigned long integers. 
Negative numbers are not allowed. You can configure 
data at every address (such as 0 to 65535). 

Enron Float Reads holding registers as IEEE-format single-
precision floating point numbers, MSB first. For each 
point required, one address is requested in the 
Modbus message and 4 bytes are returned. You can 
configure data at every address (such as 0 to 65535). 

Rosemount Reads holding registers as IEEE-format single-
precision floating point numbers, Least Significant Byte 
(LSB) first used on Rosemount DCS systems. For 
each point required, two addresses are requested in 
the Modbus message and 4 bytes are returned. You 
can configure data at every other address (such as 0, 
2, 4 to 65534). 

Phillips Float Reads holding registers as IEEE-format single-
precision numbers, MSB first. For each point required, 
two addresses are requested in the Modbus message 
and 4 bytes are returned. You can configure data at 
alternate addresses (such as 0, 2, 4 to 65534). 
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Field  Description 
Phillips Double Reads holding registers as IEEE-format double-

precision numbers, MSB first. For each point required, 
four addresses are requested in the Modbus message 
and 8 bytes are returned. You can configure data at 
every fourth address (such as 0, 2, 4 to 65534). 

RFT 64 Bit Reads totals from a Micro Motion RFT transmitter 
using a proprietary data format. 

MVD Total Reads totals from a Micro Motion MVD transmitter 
using a proprietary data format. 

 
5. Complete the Addr/Item field to indicate the number of addresses 

Config600 must poll for each variable.  

6. Select the Eventing type if required. Click ▼ to display additional 
options. 
Field  Description 
Disabled The eventing for this data point is disabled (default). 
Changes When the value written to the data point is different to 

the current value an event is logged. 
All Every time a write to the data point is performed an 

event is logged. 
 
7. If necessary, select the Security Level. Click ▼ to display 

additional options.  
Option  Description 
0 Maximum possible security level. Marks the Modbus 

address as read-only. 
9 Minimum possible security level. Marks the Modbus 

address as read/write. 
 
8. Click OK to apply the edits. Config600 displays the Modbus 

Editor.  

14.4.7 Insert a Message 
Use this option to insert a message request into a Master Modbus map 
file. This message requests defined slave devices or all slaves for 
specific information.  

Note: Slave Modbus map files do not allow the message option.  

To insert a new message: 
1. Select Slave > Add New Message from the Modbus Editor menu 

bar. The Message Details dialog box displays.  
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Figure 14-9. Message Details dialog box  

2. Select a Message Function. Click  to display additional options.  
3. Define a Start Address and a Message Length in the dialog box.  

4. Click the Trigger button to define a trigger value for the message. 
The Connect Wizard displays.  

 

Figure 14-10. Connect Wizard  

Note: Select a KPINT or KPINTARR value from the Connect 
Wizard if the message uses an object as a trigger 
mechanism. When the object value is set to 1, the system 
polls the message and, once the polls complete, sets the 
object’s value back to zero.  

5. Highlight values in each of the four columns (source, type, item, 
field). Select from left to right. Click  or  to display more 
values. 

6. Click OK to apply this definition. The Message Details dialog box 
displays showing the Trigger event you selected.  
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Figure 14-11. Message Details dialog box (with trigger)  

7. Click OK to apply this message. Config600 displays a Select 
Slaves dialog box.  

 

Figure 14-12. Select Slaves dialog box  

8. Select a displayed Slave Address and click OK to apply the 
selection. Config600 displays the Modbus Editor.  

14.4.8 Insert a Slave 
You can add slaves into a Master Modbus map file at any time. When 
initially added, the new slave address has blank tables. You can either 
complete these blank tables one data point at a time or cut-and-paste 
data points from another slave.  

To create a new slave: 
1. Click in the hierarchy menu in the left pane. 

2. Select Slave > Add New Slave from the menu bar. A Choose 
dialog box displays.  
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Figure 14-13. Choose dialog box  

3. Select the Slave Address from the list of available addresses on the 
left-hand side of the screen.  

4. Click OK. The Modbus Editor screen redisplays, showing your 
new slave in the hierarchy menu.  

Note: You can also request a new start address at this time.   

14.5 Regenerating Maps 
Using an option in PCSetup, you can restore Modbus maps to the 
default values defined in the selected configuration.  
 

Caution 
This option overwrites any edits or customisations you may have made 
to the maps in the selected configuration.  
 

1. Select File > Regenerate from the PCSetup menu bar. The Display 
and Modbus Regeneration dialog box displays.   

 

Figure 14-14. Modbus Map Regeneration  

2. Select the Modbus Maps check box. The Modbus Map Options 
panel displays, showing the default Modbus options:  
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Figure 14-15. Modbus Map Options  

3. Select the options you want to enable and click OK. Config600 
restores all Modbus maps to the default values defined in the 
selected configuration.  
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Chapter 15 – LogiCalc Editor 
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Note: This editor is available only with the Config600 Pro software.  

The S600+ can run LogiCalc programs written in LogiCalc, a Basic-
like language proprietary to Emerson Process Management. You can 
add LogiCalc programs to an existing S600+ configuration without 
rebuilding the base software. This allows you to customise and extend 
the functionality of the S600+. LogiCalc programs can read, write, and 
perform calculations on values in the S600+ database.  

Caution 
This chapter is intended for use in conjunction with materials from the 
RA901 Advanced Config600 training course. That training is critical to 
understanding the concepts in this section. Unless you have completed 
that training, do not attempt to use the material in this section as a sole 
means of learning about the LogiCalc Editor. 

The LogiCalc Editor enables you to write, test, and debug programs. 
You can test LogiCalc programs on the PC against an actual S600+ 
config file or test them in-place, running on the S600+. You can also 
monitor LogiCalc programs running in the S600+ from the Webserver 
under Diags > LogiCalc. 



Config600 Configuration Software User Manual 

15-2 LogiCalc Editor Revised January 2023 

Notes:  

 In-place testing with Version 1.2 or earlier of Config600 requires a 
serial connection between your PC and the S600+. Version 1.3 or 
higher allows an Ethernet connection.  

 The S600+ can execute several LogiCalcs in parallel, they run at a 
low task priority so in a large configuration they may run slowly. 
Hence they are not suitable for use where timing is critical. 

Example 
LogiCalcs 

The Config600 3.3 directory contains a LCLIB folder. In this folder 
are sample LogiCalc programs, provided solely as models to help you 
create your own LogiCalc programs. No warranty, expressed or 
implied, accompanies these programs. Additionally, no support is 
available for these programs.  
 

15.1 Accessing the LogiCalc Editor  
To access the LogiCalc Editor:   
1. Select Start > All Programs > Config600 3.3 > LogiCalc Editor. 

The Config600 LogiCalc screen displays.  

Note: If you have more than one version of Config600 on your 
machine, select the version appropriate to the configuration 
file.   

 

Figure 15-1. LogiCalc screen 

2. Click the Load Config icon  located in the upper left-hand 
corner of the toolbar. The Select Config dialog displays.  
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Figure 15-2. Select Config dialog box 

Note: You can also display this dialog by selecting File > Load 
Local Config from the LogiCalc screen’s menu bar.   

3. Select a configuration file and click OK. The LogiCalc screen 
redisplays, loaded with the LogiCalc in the selected configuration.  

   

Figure 15-3. LogiCalc screen (loaded)  

The LogiCalc Editor screen consists of four panes: Alarm, Program (or 
Code), Variable, and Status. You can dock, hide, or move each pane to 
suit your needs.  

The LogiCalc Editor is designed for ease of use. The Program pane 
prompts you for the next step in writing the program by intelligently 
moving the cursor to the next task, either a necessary statement or 
portion of a statement. You can place statements in the program by 
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typing them in, by using keyboard shortcuts, or through the Statements 
menu. The LogiCalc Editor also uses the Connect Wizard to permit 
you easy access to items in the database.  

For quick reference, the Editor always displays the cursor’s position at 
the bottom of the window, below the Status pane, such as “Ln 2, Col 
17” = line 2, column 17.   

The Editor provides a “Goto Line” facility. It helps you navigate in 
longer LogiCalcs, enabling you to move the cursor to a specific line in 
the file. To access this facility, select Edit > Goto Line from the menu 
bar at the top of the screen.  
The Alarms pane is useful when setting, accepting, and clearing alarms 
using the LogiCalc Editor. During debugging of the program, the test 
appears in the Alarms pane.  

15.1.1 LogiCalc Tips  
Review the following tips before you begin work on a LogiCalc 
program. 

 Structurally, a LogiCalc is a list of one or more functions laid out 
sequentially in a text file. Functions start with the “function” 
keyword and end with the “end” keyword. Place the actual code to 
be executed (in statements) between these two keywords.  

 End all functions and statements with a semicolon (;).  
 Indent code within functions to improve readability.  
 Some programming languages require you to specify what type of 

data (such as textural or numeric) a variable holds. LogiCalc 
automatically converts between the various data types, depending 
on the context.  

 LogiCalc evaluates mathematical expressions using precedence 
rules and not from left to right. Use brackets and parentheses as a 
guide accordingly.  

 The LogiCalc Editor supports both Undo (Edit > Undo Typing or 
Ctrl + Z) and Redo (Edit > Redo Typing or Ctrl + Y) functions.  

 Limit the length of LogiCalc filenames to eight characters. The file 
extension is “.lc”.  

 LogiCalc always starts to execute a LogiCalc at the beginning of 
the last function in the file.  

 Type constant names in uppercase letters with underscores. 
Variable names should not be all uppercase. 

 The LogiCalc Editor colour-codes statements in blue and 
comments in green to differentiate them from the code. 

 Use the “#” character at the start of a line to identify comments 
(short lines of explanatory text) you add to the code for 
documentation. You can place comments on their own line or on 
the end of a line. 
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15.1.2 Starting a LogiCalc  
Writing LogiCalcs generally requires an existing S600+ configuration. 
If you do not have on your PC a copy of the configuration file with 
which the LogiCalc will eventually run, you can generate a file using 
the PCSetup Editor.   

Note: If you generate a fresh configuration, make sure that it matches 
the destination configuration in all pertinent settings. Pay 
specific attention to database connections.    

To start a LogiCalc, either create a new empty LogiCalc by clicking 
the New icon on the toobar ( ) or modify an existing LogiCalc using 
the File > Import option. 

When you create a new LogiCalc, the LogiCalc Editor displays a new 
window:  

 

Figure 15-4. LogiCalc screen (loaded)  

15.2 Creating a LogiCalc  
The following example demonstrates how to build a simple LogiCalc 
function.  
Once you start LogiCalc, the LogiCalc Editor positions the cursor 
where you should type the Function name. If you type test, the 
LogiCalc looks like this. 
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function test() 
     
end; 

Note: All code examples in this chapter use this font convention to 
distinguish them from the text.   

Next, you add some instructions to be executed. If you move the cursor 
down from the function tag to the next blank line, you see that the 
LogiCalc Editor has also inserted a tab on the next blank line. This 
provides indentation to help in readibilty.  

15.2.1 Variables 
Variables are boxes that hold data, which can be a number (such as 4) 
or a text string (such as “Hello”). You create variables with names and 
refer to them by these names in the LogiCalc code. To create a variable 
with a name “my_value”, add the following line after the tab:  
    dim my_value; 

The Dimension (dim) statement is used heavily in Basic-type 
languages for creating variables. You may have noticed that the 
LogiCalc Editor has recognised the dim statement and coloured it blue.   

This new variable does not yet have a value. LogiCalc does not require 
you to specify what type of data (text or numeric) a variable holds. For 
this example, the variable should hold a number 1. You initialise the 
variable on the next line by changing the code to:  
    dim my_value; 
    my_value = 1; 

LogiCalc allows you to save space and increase readability by creating 
and initialising the variable in one step, so change the existing 
statement to: 
    dim my_value = 1; 

Add the following statement on the next line: 
    my_value = my_value + 2 * 3; 

This statement sets the value of my_value to the result of the 
expression on the right of the = sign. LogiCalc evaluates expressions 
using precedence rules, so it evaluates the * (multiply) before the +, 
giving the answer of 1 + 6 = 7. That is different from a left-to-right 
evaluation of our expression, which would be 3 * 3 = 9.  

Use brackets to force a left-to-right evaluation of the expression:  
    my_value = (my_value + 2) * 3; 

The program is now complete and should look like this: 
function test() 
    dim my_value = 1; 
    my_value = (my_value + 2) * 3; 
end; 
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15.2.2 LogiCalc Loops 
The example in the previous section executes a couple of statements 
and then stops. To create a LogiCalc that runs continuously, you need a 
loop.   

while/do/wend To insert a while/do/wend loop, position the cursor at the beginning of 
the line “my_value = (my_value + 2) * 3;”.  

Insert a while/do/wend statement from the Statements > 
while/do/wend menu option or Ctrl + W. The LogiCalc Editor inserts 
a while/do/wend statement and positions the cursor in the brackets 
where you need to enter an expression.  

Enter “my_value < 100” as the expression and use Edit > Cut and 
Edit > Paste to rearrange the “my_value = (my_value + 2) * 3;” line 
into the while loop. 

The while/do/wend statement allows nesting like the function/end 
statement, so the semicolon comes after the wend.  

The format of the statement is “while <expression> do <nested 
statements> wend;”  

When executing, the expression is first evaluated and, if it is true, the 
nested statements within the while are then executed. Once this is 
done, execution goes back to the top to evaluate the expression again 
and this continues until the expression is false.  
In our case, the expression is true initially and remains true a couple of 
times through the loop, my_value growing each time the loop is 
executed. Eventually, my_value stops being less than 100 (that is, it 
becomes greater than or equal to 100) and execution “breaks out” of 
the loop and continues down the LogiCalc. 

The program is now complete and should look like this: 
function test() 
    dim my_value = 1; 
 
    while (my_value < 100) do 
        my_value = (my_value + 2) * 3; 
    wend; 
end; 
 

for/next To insert a for/next loop that will run for a number of times specified 
explicitly, position the cursor at the beginning of the “my_value = 
(my_value + 2) * 3;”. Insert a for/next statement by using the 
Statement > for/next menu or Ctrl + R. 
To perform our calculation 10 times, enter the following: 
function test() 
    dim my_value = 1; 
    dim stream_number; 
 
    for stream_number = 1 to 10 
        my_value = (my_value + 2) * 3; 
    next; 
end; 
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This loop requires another variable called stream_number. It has no 
assigned value in the dim statement, as the for/next statement has 
control over its value and it would overwrite any initialised value. 

The for/next statement sets the stream_number variable to 1. Then the 
statement tests the value against 10. If the value is greater than 10 
execution breaks out of the loop and continues on down the LogiCalc. 
If the value is not greater than 10, the nested statements within the loop 
execute. Once the execution completes, it goes back to the top of the 
loop, adds 1 to the loop variable (in this case, stream_number), and 
repeats the test against 10.  

Summary The while/do/wend is functionally identical to the for/next statement. 
But it exists as a separate statement because for/next looping is more 
precise, compact, and readable than the while/do/wend. 

The following example is a for/next loop repeated with a 
while/do/wend loop around it. The while/do/wend statement evaluates 
1 as an expression, which is always true. LogiCalc actually 
understands true and false as non-zero and zero respectively, so the 
while loop never terminates and the code performs the same task 
forever. This loop is useful if some of your variables are real world 
values, like Analog Input readings. 
function test() 
    while (1) do 
        dim my_value = 1; 
        dim stream_number; 
 
        for stream_number = 1 to 10 
            my_value = (my_value + 2) * 3; 
        next; 
    wend; 
end; 
 

15.2.3 LogiCalc Constants 
LogiCalc has the ability to create and define variables that are not 
allowed to change. For instance, the statement:  
        for stream_number = 1 to 10 

Uses two numbers, but the variable name indicates that they are being 
used as stream numbers and that 1 means stream 1 and 10 means 
stream 10. 

However, a statement may not fully show what is being done, such as: 
        pressure_mode = 1; 

Obviously a mode for pressure is being set up, but what is type 1? A 
constant (const) statement can make this sort of code more readable by 
specifying somewhere in the LogiCalc: 
        const ADC_KEYPAD = 1; 

This allows you to change the assignment to: 
        pressure_mode = ADC_KEYPAD; 

which is much more specific. 
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The const statement is similar to the dim statement. However, you 
must assign a value in the const statement, whereas in a dim statement 
it is optional.   

The following example shows the use of the const statement. 
function test() 
    const TRUE = 1; 
 
    while (TRUE) do 
        dim my_value = 1; 
        dim stream_number; 
 
        for stream_number = 1 to 10 
            my_value = (my_value + 2) * 3; 
        next; 
    next; 
end; 

15.2.4 Connecting to Data Items  
LogiCalc provides the connect statement so that data items from the 
S600+ database can be read and written from the program.   

To simplify the process of building connect statements, the Editor uses 
a Connect Wizard that offers a point-and-click method of choosing 
data to use within LogiCalcs. To open the Connect Wizard, select 
Statements > Connect from the menu bar or press Ctrl + T. 

Note: The Connect Wizard displays only if you have already loaded a 
configuration file. If the Connect Wizard does not display, save 
your LogiCalc before you attempt to load a configuration file.   

The Connect (const) statement is similar to a dim statement, since it 
also creates a new variable. But instead of the new variable being 
empty and open to any value, the new variable is implicitly connected 
to a point in the S600+ database. For example, the Analog Input 
scanning task within the S600+ is continually updating a data point 
with new values read from the input. If a LogiCalc program reads that 
data point at any time, it should get the current value of meter pressure.  

Creating a  
Const Statement 

To further explain this example, we can write a LogiCalc to read our 
stream 1 meter pressure into a variable and examine it. Position the 
cursor on the blank line in a new LogiCalc, and bring up the Connect 
Wizard by selecting Statements > Connect or Ctrl + T.  

In the Connect Wizard, navigate to the Stream 1 meter pressure by 
selecting Stream 1 : GAS DP, IOASSIGN, STR01 METER 
PRESSURE, and INUSE. Once you find the desired data point, click 
OK.   

The Connect Wizard adds two lines of code, and the Editor positions 
the cursor just after the connect statement so that you can complete the 
statement by typing a variable name. Type pressure.   
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The LogiCalc should now look like this: 
function test() 
const IOASSIGN_GASDP_METERPRESSURE = 0; 
    connect pressure(stream(1), "IOASSIGN",IOASSIGN_GASDP_METERPRESSURE, 
"INUSE"); 
end; 

Const statements can define a number by use of the constant name. So 
the const statement above with a name defines 0 to mean 
“IOASSIGN_GASDP_METERPRESSURE”. The constant name may 
help you to recognize it later.  
In the Connect statement, stream(1) refers to the database section that 
is reserved for stream 1.   
The S600+ database is divided into sections, each section having 
within it a selection of the available data types. Within the sections, the 
database item locations are numbered:  

 0: System  
 1–7: I/O Modules 1 to 7  
 10–11: Stations 1 and 2  
 15–24: Streams 1 to 10. 

Note: Database item locations 8, 9, and 12 through 14 are reserved 
for system use.   

LogiCalc accesses the S600+ database by calling upon these numbers 
in parentheses after functions and statements. LogiCalc translates the 
section number by adding or subtracting out the number of sections 
before the pertinent one. 

For example, a const statement calls stream(1). This is another built-in 
function, stream(x), which just adds 14 to the stream number so that it 
conforms to the above section table. LogiCalc could refer to it as 15 
instead of stream(1) but, that would be less understandable to the user 
reading the code. 

Using a  
Const Statement 

To further explain this example, you can write a LogiCalc to read the 
stream 1 meter pressure into a variable and examine it. Position the 
cursor on the blank line in a new LogiCalc, and bring up the Connect 
Wizard by selecting Statements > Connect or Ctrl + T.  

To demonstrate performing calculations on a connected data item, 
multiply the meter pressure from the example above by 2 and store the 
value back in the database. To make sure the program knows where to 
store the value back, create a new data item using the System Editor. 
This example uses an unused data point in the database. 

Position the cursor on the next line from the connect statement and 
summon the Connect Wizard. Select System, KPREAL, Spare, and 
Value. Type “spare” as the Constant name.  

This operation loops again and again, so the value tracks the pressure 
in real time. Note how the while/do/wend loop is only around the 
calculation. If it were around the whole program, the code would be 
reconnecting pressure and spare every time, which would increase the 
amount of time necessary to track changes in pressure. 
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Modify the LogiCalc as follows: 
function test() 
const IOASSIGN_GASDP_METERPRESSURE = 0; 
const KPREAL_SYS_SPARE = 13; 
  connect pressure(stream(1), "IOASSIGN", IOASSIGN_GASDP_METERPRESSURE, "INUSE"); 
  connect spare(0, "KPREAL", KPREAL_SYS_SPARE, "INUSE"); 
 
    while (1) do 
        spare = pressure * 2; 
    wend; 
end; 

15.2.5 If/Then/Endif 
The if/then/endif and the if/then/else/endif statements allow LogiCalc 
to make decisions.  
A LogiCalc can make a decision based on some external conditions. 
For example, if the meter pressure is in keypad (R/W) mode, it should 
be multiplied by 3 instead of 2. 

First, connect to the mode of the meter pressure. Open the Connect 
Wizard and select Board 1:P144I/O, ADC, I/O ADC 01, and MODE. 
Select the Define Options checkbox, which creates const statements for 
all the different options of the parameter. In this case, all the modes 
area assigned a const statement with an integer value. 
Type the variable name as pressure_mode and change the const names 
for the modes (that is, from IO1ADC01_MEASURED to 
ADC_MEASURED, and such.). 

Add the if/then statements. The full format for this statement is if 
<expression> then <nested statements> else <nested statements> endif; 
and execution is directed either to the first set of statements or the 
second, depending on the outcome of the expression evaluation. 

The if <expression> then <nested statements> endif; variant only has 
the one set of nested statements and executes them only if the 
expression is true. Otherwise they are skipped. 
The new LogiCalc continually evaluates the pressure_mode and, if it is 
in keypad executes the * 3 statement. Otherwise, it executes the * 2 
statement. 

The complete LogiCalc looks like this:  
function test() 
const IOASSIGN_GASDP_METERPRESSURE = 0; 
const KPREAL_SYS_SPARE = 13; 
const ADC_P144IIO_IO01ADC01 = 0; 
    const ADC_MEASURED = 0; 
    const ADC_KEYPAD = 1; 
    const ADC_AVERAGE = 2; 
    const ADC_LASTGOOD = 3; 
    const ADC_KEYPADF = 4; 
    const ADC_AVERAGEF = 5; 
    const ADC_LASTGOODF = 6; 
 
    connect pressure(stream(1), "IOASSIGN", IOASSIGN_GASDP_METERPRESSURE, 

"INUSE"); 
    connect spare(0, "KPREAL", KPREAL_SYS_SPARE, "INUSE"); 
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    connect pressure_mode(ioboard(1), "ADC", ADC_P144IIO_IO01ADC01, "MODE"); 
 
    while (1) do 
        if (pressure_mode = ADC_KEYPAD) then 
            spare = pressure * 3; 
        else 
            spare = pressure * 2; 
        endif; 
    wend; 
end; 

15.2.6 Special Functions 
LogiCalc can use data from the S600+ which is not an item in the 
database. It can read configuration-specific details, such as the number 
of streams present and what type they are. Use the numstream() 
function to determining the number of streams. Two other functions— 
numstations() and numioboards()—perform the same functions for 
stations and I/O boards.  

For example, the following simple LogiCalc reads the stream 1 meter 
pressure and copies it to a hard coded keypad real object.  

function test() 
const IOASSIGN_GASDP_METERPRESSURE = 0; 
const KPREAL_SYS_SPARE = 13; 
 
  connect pressure(stream(1), "IOASSIGN", IOASSIGN_GASDP_METERPRESSURE, "INUSE"); 
  connect spare(0, "KPREAL", KPREAL_SYS_SPARE, "INUSE"); 
 
  while (1) do 
        spare = pressure * 2; 
  wend; 
end; 

To expand it to sum the results of all stream pressures into this keypad 
real, use the numstreams() function. This is a built-in function that 
returns the number of streams in a configuration. Then, use a for/next 
statement to span the streams. 

function test() 
const IOASSIGN_GASDP_METERPRESSURE = 0; 
const KPREAL_SYS_SPARE = 13; 
 
    connect spare(0, "KPREAL", KPREAL_SYS_SPARE, "INUSE"); 
 
    while (1) do 
        dim stream_number;     # Hold the current stream number 
 
        spare = 0; 
        for stream_number = 1 to numstreams() 
            connect pressure(stream(stream_number), "IOASSIGN", 
IOASSIGN_GASDP_METERPRESSURE, "INUSE"); 
            spare = spare + pressure * 2; 
        next; 
    wend; 
end; 

Note the added variable, stream_number (which is used as the variable 
in the for/next loop), and the comment.   
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The spare variable is cleared down and the for/next loop sets 
stream_number to each stream present before executing the summing 
code. This code connects to the stream pressure for the current stream.   

Note: Stream (stream_number) in the connect pressure statement 
determines the stream to which the pressure variable is 
connected. Once pressure is connected to the correct stream, 
the LogiCalc reads it, multiplies it by 2 and adds it into the 
spare variable.   

You can modify this example. The spare variable is a direct link to the 
data item in the S600+ database, so it would be constantly changing 
back to zero and summing. It could be modified to sum it in another 
variable and then set this variable when the final sum is reached. 

The stream_number variable is created inside the while/do/wend loop 
which means it is created every time around. This is not necessary and 
needs only to be created once. To make the program more efficient, 
move this statement out of the loop.  

The modified LogiCalc now looks like: 
function test() 
const IOASSIGN_GASDP_METERPRESSURE = 0; 
const KPREAL_SYS_SPARE = 13; 
 
    connect spare(0, "KPREAL", KPREAL_SYS_SPARE, "INUSE"); 
    dim stream_number;     # Hold the current stream number 
 
    while (1) do 
        dim sum = 0;       # Hold the sum of two times the meter pressures 
 
        for stream_number = 1 to numstreams() 
            connect pressure(stream(stream_number), "IOASSIGN", 
IOASSIGN_GASDP_METERPRESSURE, "INUSE"); 
            sum = sum + pressure * 2; 
        next; 
 
        spare = sum; 
    wend; 
end; 

15.2.7 Saving and Compiling a LogiCalc 
Before you compile the program, first save it to the configuration 
directory. Until you save the program to the configuration directory, 
the program is only saved in the PC’s memory.   

To save, click Save ( ) on the toolbar and type a name for your new 
LogiCalc. Logica1 is the default program name. The file extension is 
“.lc”.   

Note: Limit all LogiCalc filenames to eight or fewer characters, all in 
lower case letters, such as myapplic.lc. The S600+ operating 
system requires this.   

The Save As dialog box opens the LogiCalc folder in the open 
configuration directory. If for any reason, the Save As command does 
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not open in the LogiCalc folder, navigate to the appropriate 
configuration folder and find a LogiCalc sub-folder. 
Compilation allows the LogiCalc Editor to check your code, ensure 
that it is valid, and to create some internal data structures that allow the 
code to run. If you make changes to a LogiCalc and run it without first 
compiling it, the last compiled version runs instead.  

To compile your LogiCalc, click Compile ( ) on the toolbar. After a 
short pause, the Status pane should show the message Program 
LOGICA1 OK. 

The compiler contains an error checking mechanism. When the 
LogiCalc Editor compiles a program with an error, it displays the 
location and type of error in the Status pane, as shown below:  

Error: test.lc - Line 2 : Expecting variable, constant or bracket 
    dim my_value = ; 
                   ^ 

This message indicates an error on line number 2 of the program. Also, 
the Editor positions the cursor on the offending line at the position 
where the error was encountered to allow you to type a correction.  

Once saved and successfully, compiled, the LogiCalc is ready to run. 

15.2.8 Running a LogiCalc in Simulation Mode 
The LogiCalc Editor allows you to run your LogiCalc in simulation 
mode before you actually download it to the S600+ to test it. The 
LogiCalc Editor can run LogiCalcs either at full speed or line-by-line 
(debug mode).  

To halt execution at any time, click Stop .  
Free Running To run the program at full speed, compile it and click Run ( ). The 

program will finish with the message: program TEST.LC has 
stopped. 

Line by Line To run the LogiCalc in single step mode, ensure the LogiCalc has 
compiled successfully and then click Step ( ). 

The LogiCalc Editor first displays the message Program TEST.LC has 
started. Then it displays a yellow arrow in the Code pane, indicating 
the statement that is about to run. Finally, it also fills in the Variable 
pane with a list of all the variables currently active in the LogiCalc, 
together with their current values.  

Click Step until the Editor has moved through through the entire 
LogiCalc. Click Step again and the program finishes, displaying the 
message: Program TEST.LC has stopped. 

Breakpoint A breakpoint is a line marker which stops a free-running LogiCalc. 

Once the Editor reaches the breakpoint, it continues to run using 
single-stepping.  Breakpoints are useful when running a long LogiCalc.   

To use a breakpoint, position the cursor anywhere on the desired 
breakpoint line, and click Toggle Breakpoint ( ). A red stop sign 
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 displays next to the statement, indicating that a breakpoint is 
active. Clicking Toggle Breakpoint again turns off the breakpoint. 

Click Run ( ) to permit the LogiCalc to free-run at full speed. After 
a short pause, the yellow arrow marker appears on top of the red 
breakpoint icon, indicating that the LogiCalc has executed all the 
statements before the breakpoint and has now stopped at the 
breakpoint. Also, the variable window will now update with current 
values. 
Single-step the program through the remaining steps. The program 
finishes and displays the message: program TEST.LC has stopped. 

Changing Variables While single-stepping through a LogiCalc, you can manually change a 
variable. 

Double-click on the variable text in the Variable pane. The Editor 
displays the Set Variable dialog.  

 

Figure 15-5. Set Variable dialog  

Change the variable value, click OK, and then continue single-
stepping through the LogiCalc.  

The value updates, using the newly supplied value in the calculation 
statement. 

Note: You can change values while the program is free running (not 
single stepping), but the Variables pane will not update until 
the program hits a breakpoint. This is not a recommended 
procedure as you do not know what your LogiCalc is doing 
when you set the value.  

15.3 Installing a LogiCalc on the S600+ 
Once you have compiled and tested a LogiCalc, save it to the 
configuration directory.  

To install the LogiCalc to a S600+, start the Config Transfer utility and 
transfer the configuration (including with any associated LogiCalcs 
files in the configuration) to the LogiCalc folder. For further 
information, refer to Chapter 9, Config Transfer.  
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15.3.1 Remotely Debugging a LogiCalc  
You can test LogiCalc programs on-line in the S600+. To accomplish 
this in-place testing, you need either a serial connection between your 
PC and the S600+ (if you are using Config600 version 1.2 or earlier) or 
an Ethernet connection (if you are using a version higher than 1.2). 
You can also use shell commands to monitor LogiCalc programs 
running in the S600+.  

Ensure that the connection between the S600+ and the PC is working. 
Also ensure that the PCSetup transfer program is not using the 
connection. Start the LogiCalc Editor and click Connect to S600 ( ). 
Select the connection details and click OK. 

After a few seconds, the following message displays in the Status pane:  
Connecting to S600. Please wait... 
Program TEST.LC OK 
Done. 

The running LogiCalc should also appear in the Code pane. If it does 
not appear, check the connection settings and try again. 
To view the currently running LogiCalc without interrupting it, use the 
shell functions. To examine a free-running LogiCalc from the 
LogiCalc Editor, insert a breakpoint and stop the LogiCalc 
temporarily. 

Place the cursor on the desired line and press F9 or click Toggle 
Breakpoint ( ). The breakpoint marker ( ) displays to the left of 
the line. Soon thereafter the program reaches the breakpoint and the 
yellow execution arrow appears on top of this red stop sign. Values of 
all the variables display in the variables pane. 

To see the effect on the variables, step through the program line-by-
line. The information you view is the real data from the S600+, sent 
through the serial or Ethernet link. It is not a LogiCalc Editor 
simulation.  
If the value is in keypad mode, go to the front panel and change it. Do 
another single-step and see the values update to your newly entered 
keypad value. 

To disconnect from the S600+, click Connect ( ). If the LogiCalc is 
sitting at a breakpoint, disconnecting restarts the LogiCalc free-
running. 

15.4 LogiCalc Examples 
The following examples may be useful references in building LogiCalc 
programs for your application. Remember, LogiCalc considers any text 
following a # to be comments and ignores it.  
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Note: The folder LCLIB is included in the directory in which you 
installed the Config600 software. This LCLIB folder contains 
some sample LogiCalc programs. These are only examples for 
illustrative purposes. They are not provided with any express or 
implied guarantee or warranty. Additionally, Remote 
Automation Solutions does not provide support if you choose 
to use these example programs.   

15.4.1 Perform PTZ Calculations 
############################################################################ 
# Perform PTZ for all gas dp & gas turbine streams in the system.          # 
# Version History 
# 
# v0.6 - 17/10/2000 - GW -   conversion routines fixed. There were several  
# errors in the calculations. CalcPtz() function removed to avoid duplication of 
# constants 
# 
# v0.5 - 26/06/2000 - GW -   temp variable removed from main loop. Unnecessary  
# when calling a function if a return value is not required. 
# 
# v0.4 - 23/12/1999 - GW -   const 's' made dim as it hasn't been initialised by  
# a constant expression as required by LogiCalc v0.20 and above.  Support added  
# for gas turbine. 
# 
# v0.3 - 26/11/1999 - GW -   s in ptz() made const. 
# 
# v0.2 - 24/11/1999 - GW -   Ported to v0.15 of LogiCalc. Units conversion added  
# in. Some connects moved inside main loop for efficiency. 
# 
# v0.1 - 22/11/1999 - GW -   's' added as intermediate variable to shrink code  
# down and make it run a bit faster. 
# 
############################################################################## 
# Name:                PressToBarg 
# function:            Convert pressure to barg from the system units. 
# Arguments:           press - The pressure in the system units. 
# return value:        Pressure in barg. 
############################################################################## 
 
function PressToBarg(press) 
 
const KPINT_SYS_PRESSUNITS = 45; 
    const PRESSUNITS_BARG = 0; 
    const PRESSUNITS_BARA = 1; 
    const PRESSUNITS_KPAG = 2; 
    const PRESSUNITS_KPAA = 3; 
    const PRESSUNITS_PSIG = 4; 
    const PRESSUNITS_PSIA = 5; 
const KPREAL_SYS_BARGBARA = 2; 
const KPREAL_SYS_BARKPA = 4; 
const KPREAL_SYS_BARPSI = 5; 
 
    connect sysUnits(0, "KPINT", KPINT_SYS_PRESSUNITS, "VALUE"); 
    if (sysUnits = PRESSUNITS_BARG) then 
        return press; 
    endif; 
     
    if (sysUnits = PRESSUNITS_BARA) then 
        connect bargToAbs(0, "KPREAL", KPREAL_SYS_BARGBARA, "VALUE"); 
        return press - bargToAbs; 



Config600 Configuration Software User Manual 

15-18 LogiCalc Editor Revised January 2023 

    endif; 
 
    if (sysUnits = PRESSUNITS_KPAG) then 
        connect bargToKpa(0, "KPREAL", KPREAL_SYS_BARKPA, "VALUE"); 
        return press / bargToKpa; 
    endif; 
     
    if (sysUnits = PRESSUNITS_KPAA) then 
        connect bargToAbs(0, "KPREAL", KPREAL_SYS_BARGBARA, "VALUE"); 
        connect bargToKpa(0, "KPREAL", KPREAL_SYS_BARKPA, "VALUE"); 
        return press / bargToKpa - bargToAbs; 
    endif; 
     
    if (sysUnits = PRESSUNITS_PSIG) then 
        connect bargToPsi(0, "KPREAL", KPREAL_SYS_BARPSI, "VALUE"); 
        return press / bargToPsi; 
    endif; 
 
    if (sysUnits = PRESSUNITS_PSIA) then 
        connect bargToAbs(0, "KPREAL", KPREAL_SYS_BARGBARA, "VALUE"); 
        connect bargToPsi(0, "KPREAL", KPREAL_SYS_BARPSI, "VALUE"); 
        return press / bargToPsi - bargToAbs; 
    endif; 
end; 

15.4.2 Convert Temperature Units 
############################################################################## 
# Name:                TempToDegc 
# function:            Convert temperature to degc from the system units. 
# Arguments:           temp - The temperature in the system units. 
# return value:        temperature in degc. 
############################################################################## 
 
function TempToDegc(temp) 
 
const KPINT_SYS_TEMPUNITS = 47; 
    const TEMPUNITS_DEGC = 0; 
    const TEMPUNITS_DEGF = 1; 
    const TEMPUNITS_DEGK = 2; 
    const KPREAL_SYS_DEGCK = 7; 
 
    connect sysUnits(0, "KPINT", KPINT_SYS_TEMPUNITS, "VALUE"); 
    if (sysUnits = TEMPUNITS_DEGC) then 
        return temp; 
    endif; 
 
    if (sysUnits = TEMPUNITS_DEGF) then 
        return (temp - 32.0) / 9.0 * 5.0; 
    endif; 
 
    if (sysUnits = TEMPUNITS_DEGK) then 
        connect degcToDegk(0, "KPREAL", KPREAL_SYS_DEGCK, "VALUE"); 
        return temp - degcToDegk; 
    endif; 
end; 

15.4.3 Convert Density Units to Kgm3 
############################################################################## 
# Name:                DensToKgm3 
# function:            Convert density to Kgm3 from the system units. 
# Arguments:           dens - The density in the system units. 
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# return value:        density in kgm3. 
############################################################################## 
 
function DensToKgm3(dens) 
 
const KPINT_SYS_DENSUNITS = 48; 
    const DENSUNITS_KGM3 = 0; 
    const DENSUNITS_KGL = 1; 
    const DENSUNITS_LBSCF = 2; 
    const DENSUNITS_GMCC = 3; 
    const DENSUNITS_KGSM3 = 4; 
const KPREAL_SYS_LBKG = 0; 
const KPREAL_SYS_M3CF = 9; 
 
    connect sysUnits(0, "KPINT", KPINT_SYS_DENSUNITS, "VALUE"); 
 
    if (sysUnits = DENSUNITS_KGM3) then 
        return dens; 
    endif; 
 
    if (sysUnits = DENSUNITS_KGL) then 
        return dens * 1000; 
    endif; 
 
    if (sysUnits = DENSUNITS_LBSCF) then 
        connect lbToKg(0, "KPREAL", KPREAL_SYS_LBKG, "VALUE"); 
        connect m3ToCf(0, "KPREAL", KPREAL_SYS_M3CF, "VALUE"); 
 
        return dens * lbToKg * m3ToCf; 
    endif; 
 
    if (sysUnits = DENSUNITS_GMCC) then 
        return dens * 1000; 
    endif; 
 
    if (sysUnits = DENSUNITS_KGSM3) then 
        return dens; 
    endif; 
end; 

15.4.4 Convert Density Units from Kgm3 
############################################################################## 
# Name:                DensFromKgm3 
# function:            Convert density from Kgm3 to the system units. 
# Arguments:           dens - The density in kgm3. 
# return value:        density in system units. 
############################################################################## 
 
function DensFromKgm3(dens) 
 
const KPINT_SYS_DENSUNITS = 48; 
    const DENSUNITS_KGM3 = 0; 
    const DENSUNITS_KGL = 1; 
    const DENSUNITS_LBSCF = 2; 
    const DENSUNITS_GMCC = 3; 
    const DENSUNITS_KGSM3 = 4; 
const KPREAL_SYS_LBKG = 0; 
const KPREAL_SYS_M3CF = 9; 
 
    connect sysUnits(0, "KPINT", KPINT_SYS_DENSUNITS, "VALUE"); 
 
    if (sysUnits = DENSUNITS_KGM3) then 
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        return dens; 
    endif; 
 
    if (sysUnits = DENSUNITS_KGL) then 
        return dens / 1000; 
    endif; 
 
    if (sysUnits = DENSUNITS_LBSCF) then 
        connect lbToKg(0, "KPREAL", KPREAL_SYS_LBKG, "VALUE"); 
        connect m3ToCf(0, "KPREAL", KPREAL_SYS_M3CF, "VALUE"); 
 
        return dens / (lbToKg * m3ToCf); 
    endif; 
 
    if (sysUnits = DENSUNITS_GMCC) then 
        return dens / 1000; 
    endif; 
 
    if (sysUnits = DENSUNITS_KGSM3) then 
        return dens; 
    endif; 
end; 

15.4.5 Perform PTZ Calculations and Convert Units 
############################################################################## 
# Name:                DoStreamPtz 
# function:            Get the data from the database for the passed stream,  
# calculate the PTZ and place the result back into the database. Do units  
# conversion on all values. 
# Arguments:           s - stream number 
# return value:        1 if we did calc, 0 if we didn't 
############################################################################## 
 
function DoStreamPtz(s) 
    const ATMOSPHERIC_PRESSURE = 1.01325; 
    const ABSOLUTE_ZERO = 273.15; 
const KPINT_STREAMTYPE = 0; 
    const STREAMTYPE_GASDP = 0; 
    const STREAMTYPE_GASTURB = 1; 
    const STREAMTYPE_GASUS = 2; 
    const STREAMTYPE_LIQTURB = 3; 
    const STREAMTYPE_PRVBIDI = 4; 
const KPREAL_GASDP_STDPRESS = 9; 
const KPREAL_GASTURB_STDPRESS = 1; 
const KPREAL_GASDP_STDTEMP = 8; 
const CALCALMITEM_GASDP_UPSTRCOMPRESS = 16; 
const CALCALMITEM_GASDP_STDDENS = 8; 
const CALCALMITEM_GASDP_STDCOMPRESS = 17; 
const CALCALMITEM_GASDP_UPSTRPRESS = 10; 
const CALCALMITEM_GASDP_UPSTRTEMP = 7; 
const CALCALMITEM_GASDP_UPSTRDENS = 4; 
const CALCALMITEM_GASTURB_STRCOMPRESS = 10; 
const IOASSIGN_GASTURB_STREAMTEMP = 5; 
const CALCALMITEM_GASTURB_STDDENS = 5; 
const CALCALMITEM_GASTURB_STDCOMPRESS = 11; 
const KPREAL_GASTURB_STDTEMP = 0; 
const IOASSIGN_GASTURB_METERPRESSURE = 0; 
const CALCALMITEM_GASTURB_STREAMDENS = 4; 
 
    connect strType(s, "KPINT", KPINT_STREAMTYPE, "VALUE"); 
 
    if (strType <> STREAMTYPE_GASDP) AND (strType <> STREAMTYPE_GASTURB) then 
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        return 0; 
    endif;         
 
# Define all the indexes for the various gas stream types 
    dim stdPress; 
    dim upstrCompress; 
    dim upstrTemp; 
 
# connect all the data 
    if (strType = STREAMTYPE_GASDP) then 
        connect dbStdPress(s, "KPREAL", KPREAL_GASDP_STDPRESS, "VALUE"); 
        stdPress = dbStdPress; 
        connect dbUpstrCompress(s, "CALCALMITEM", 
CALCALMITEM_GASDP_UPSTRCOMPRESS, "INUSE"); 
        upstrCompress = dbUpstrCompress; 
        connect dbUpstrTemp(s, "CALCALMITEM", CALCALMITEM_GASDP_UPSTRTEMP, 

"INUSE"); 
        upstrTemp = dbUpstrTemp; 
    endif; 
 
    if (strType = STREAMTYPE_GASTURB) then 
        connect dbStdPress(s, "KPREAL", KPREAL_GASTURB_STDPRESS, "VALUE"); 
        stdPress = dbStdPress; 
        connect dbUpstrCompress(s, "CALCALMITEM", 
CALCALMITEM_GASTURB_STRCOMPRESS, "INUSE"); 
        upstrCompress = dbUpstrCompress; 
        connect dbUpstrTemp(s, "IOASSIGN", IOASSIGN_GASTURB_STREAMTEMP, "INUSE"); 
        upstrTemp = dbUpstrTemp; 
    endif; 
 
# Convert the data 
    dim stdPressBarg; 
    call stdPressBarg = PressToBarg(stdPress); 
 
    dim upstrTempDegc; 
    call upstrTempDegc = TempToDegc(upstrTemp); 
 
    dim denom = (upstrTempDegc + ABSOLUTE_ZERO) * upstrCompress * 
                (stdPressBarg + ATMOSPHERIC_PRESSURE); 
 
    if (denom > 0.0) then 
        dim stdDens; 
        dim stdCompress; 
        dim stdTemp; 
        dim upstrPress; 
 
# connect more data 
        if (strType = STREAMTYPE_GASDP) then 
            connect dbStdDens(s, "CALCALMITEM", CALCALMITEM_GASDP_STDDENS, 

"INUSE"); 
            stdDens = dbStdDens; 
            connect dbStdCompress(s, "CALCALMITEM", 
CALCALMITEM_GASDP_STDCOMPRESS, "INUSE"); 
            stdCompress = dbStdCompress; 
            connect dbStdTemp(s, "KPREAL", KPREAL_GASDP_STDTEMP, "VALUE"); 
            stdTemp = dbStdTemp; 
            connect dbUpstrPress(s, "CALCALMITEM", CALCALMITEM_GASDP_UPSTRPRESS, 

"INUSE"); 
            upstrPress = dbUpstrPress; 
        endif; 
 
        if (strType = STREAMTYPE_GASTURB) then 
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            connect dbStdDens(s, "CALCALMITEM", CALCALMITEM_GASTURB_STDDENS, 
"INUSE"); 

            stdDens = dbStdDens; 
            connect dbStdCompress(s, "CALCALMITEM", 
CALCALMITEM_GASTURB_STDCOMPRESS, "INUSE"); 
            stdCompress = dbStdCompress; 
            connect dbStdTemp(s, "KPREAL", KPREAL_GASTURB_STDTEMP, "VALUE"); 
            stdTemp = dbStdTemp; 
            connect dbUpstrPress(s, "IOASSIGN", IOASSIGN_GASTURB_METERPRESSURE, 

"INUSE"); 
            upstrPress = dbUpstrPress; 
        endif; 
 
# Convert the data 
        dim stdDensKgm3; 
        call stdDensKgm3 = DensToKgm3(stdDens); 
 
        dim stdTempDegc; 
        call stdTempDegc = TempToDegc(stdTemp); 
 
        dim upstrPressBarg; 
        call upstrPressBarg = PressToBarg(upstrPress); 
 
# Do the calculation and convert back 
        dim upstrDensKgm3 = stdDensKgm3 * (stdCompress * (stdTempDegc + 
ABSOLUTE_ZERO) * 
                (upstrPressBarg + ATMOSPHERIC_PRESSURE)) / denom; 
 
        dim ndxUpstrDens; 
        if (strType = STREAMTYPE_GASDP) then 
            ndxUpstrDens = CALCALMITEM_GASDP_UPSTRDENS; 
        endif; 
        if (strType = STREAMTYPE_GASTURB) then 
            ndxUpstrDens = CALCALMITEM_GASTURB_STREAMDENS; 
        endif; 
 
        connect dbUpstrDens(s, "CALCALMITEM", ndxUpstrDens, "CALC3"); 
        call dbUpstrDens = DensFromKgm3(upstrDensKgm3); 
    endif; 
 
    return 1; 
end; 

15.4.6 Perform PTZ Calculations on All Streams 
############################################################################## 
# Name:                ptz 
# function:            Attempt ptz calculation on all streams. 
# Arguments:           - 
# return value:        - 
############################################################################## 
 
function ptz() 
    while (1) do 
        dim str; 
        for str = 1 to numstreams() 
            DoStreamPtz(stream(str)); 
        next; 
    wend; 
end; 
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15.5 LogiCalc Lanuage Specifications  
This section provides specifications on the LogiCalc language.   

Name Definition 
Supported 

Types 
Decimal Integer (e.g. -999) 
Binary Integer (e.g. 11001100b) 
Double Precision Floating Point (e.g. 3.14159265) 
String (e.g. "hello mum") 

Supported 
Operators 

+ - * / 
( ) 
>, <, =, >=, <=, <> 
AND, OR (boolean) 
& (bitwise AND), | (Bitwise OR) 
$ (string concatenation) 
<<, >> (Bit shifting) 

Supported 
Statements 

function/end, dim, const, let, if/then/else/endif, while/do/wend, for/next, call, 
return, connect, setalarm/clearalarm/accalarm 

Built-in 
Functions 

ioboard(x), station(x), stream(x), numioboards(), numstations(), 
numstreams(), 
numobjects(x, "type"), log(x), exp(x), abs(x), int(x), pow(x, y), sin(x), cos(x), 
tan(x), timenow() 
lef tstring("string", len), rightstring("string", len) 
NOT(), NOTB() 

Comments # as f irst character in a line denotes a comment 
Max Program File 

Line Length 
255 chars 

Max 
Variable/Function 

Name Length 

63 chars 

Max Chars for 
String Variable 

127 chars 

Max Number of 
ARGs in a 
Function 

16 

Variable Names a-z, A-Z, 0-9 and _.  
(First char can't be 0-9) 

Max Terms in a 
Single Arithmetic 

Expression 

32 

Max LogiCalc 
Program File 
Name Length 

8.3 characters (S600+ uses FAT) 
For example, "my_progy.lc" is ok; "myprogram.lc" is not. 

15.5.1 LogiCalc Statements 
Use these statements to create custom LogiCalc statements.  

function/end A program consists of one or more user defined functions in a text 
file. These functions should be laid out one after the other. The last 
function found is used as the first one to run. Each function can call 
the other user-defined functions as long as the functions called are 
defined earlier in the file (that is, you can only call “upwards”).  
User defined functions can take any number of arguments. They are 
evaluated at run time and passed by value. A function can return one 
value which must be assigned to a variable using the “call” keyword. 
User functions cannot be used directly in expressions. 
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function <function1_name>(<arg1>, <arg2>, ...) 
    . 
    . 
    . 
end; 
 

dim Defines a variable for use in the current scope.  
 
dim <variable_name>; 
dim <variable_name> = <expression>; 
 

const Defines a constant for use in the current scope. This is the same as a 
variable except a value must be assigned at define time and the value 
cannot be changed (like a #define in C).  
 
const <constant_name> = <expression>; 
 

let Assigns a value to a variable. The let command is optional.  
 
let <variable_name> = <expression>; 
<variable_name> = <expression>; 
 

if/then/else/endif Conditionally changes the path of execution in a program.  
 
if <expression> then 
    . 
    . 
endif; 
 
if <expression> then 
    . 
    . 
else 
    . 
    . 
endif; 
 

while/do/wend Conditionally loops the path of execution in a program.   
 
while <expression> do 
    . 
    . 
wend; 
 

for/next Loops the path of execution in a program a set number of times. The 
variable name on the “next”' is optional.  
 
for <variable_name> = <expression> to <expression> 
    . 
    . 
next <variable_name>; 
 
 
for <variable_name> = <expression> to <expression> 
    . 
    . 
next; 
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call Required to call a user function that returns a value. The returned 
value from a function is assigned to the specified variable. If a return 
value is not required, just specify the function name on its own 
without the call keyword.  
You can call a function in any of the following three shown examples.  

Note: The third variant works on only version 1.2 and above; avoid 
using it to ensure compatibilty.   

 
<function_name>(<expression1>, <expression2>, ...); 
call <variable_name> = <function_name>(<expression1>, <expression2>, ...); 
call <function_name>(<expression1>, <expression2>, ...); 
 

return Returns a value from a function.    
 
return <expression>; 
 

connect Connects a data point from the S600+ database for use in the 
program.   

 
connect <variable_name>(<expression>, <expression>, <expression>, <expression>); 
 

The four valid statement parameters are:  
 Section index: 

Usually 0 (for system) or derived from stream(x), station(x) or 
ioboard(x)  

 Data type: 
A string such as "KPREAL", "KPINT", "KPSTRING", etc.  

 Data index: 
An index into the data of the section specified in the first argument.  

 Field name: 
A string representing the field name (which as "INUSE", 
"VALUE", etc.)  

The connect wizard or system editor will help you out specifying these 
values. 

Note: The variable is only dynamically connected to its data point 
within the scope of the function to which it is connected. If you 
pass the variable as a parameter to another function, the 
function will receive a static snapshot of the value when it was 
passed in, as in the following:    

 
function copydouble(in, out) 
    out = in * 2; 
end; 
 
function main() 
    connect adc1(ioboard(1), "ADC", 0, "MEASURED"); 
    connect dac1(ioboard(1), "DAC", 0, "MEASURED"); 
    while 1 do 
        copydouble(adc1, dac1); 
    wend; 
end; 
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Although this LogiCalc will compile and run, it will not do anything 
useful since the 'in' and 'out' variables are not connections; they are just 
values. The act of passing them into the function 'copydouble' has 
evaluated them from connected variables (adc1, dac1) to normal 
variables with values in them (in, out). 

setalarm/clearalarm/ 
accalarm 

Manipulates S600+ alarms.  

 
setalarm <variable_name>(<expression>, <expression>); 
 
The two statement parameters are:  

 Alarm number (between 0 – 15)  
 An alarm value.  
The alarm value has no significance apart from that it will print as part 
of the alarm event message. This only happens if it is non-0 so just 
pass 0 if no value is required on the printout. You can pass different 
values (such as setalarm, clearalarm, and accalarm) and they all print 
out against the relevant alarm event messages. 

15.5.2 Built-In Functions 
LogiCalc provides a number of built in functions you can include 
directly in expressions to perform common tasks.  

ioboard(x), 
station(x), 
stream(x) 

These section index functions return the base index for the specified 
stream, station, and ioboard section. Typically you would use these 
functions in a call to connect to index data within a stream.  
For example, if you are using a direct index or just a system index, 
pass zero (0) instead of these functions. For example, to update a 
variable of known index in stream 2:  

 
# Relative stream index for a KPREAL 
const INDEX_KPREAL_VISC = 14; 
connect strVisc(stream(2), "KPREAL", INDEX_KPREAL_VISC, "VALUE"); 
strVisc = 0.317; 
 
numioboards(), 
numstations(), 

numstream() 

These resource evaluation functions return the number of streams, 
stations, or I/O modules present in the current running configuration. 
For example, to iterate through the IO modules:  
 
dim io; 
for io = 1 to numioboards() 
 connect xxx(io, xxxx, xxxx, xxxx); 
 ... 
next; 
 

numobjects(x, “type”) This object evaluation function returns the number of objects of the 
specified type present in section (x) of the currently running 
configuration.  
For example, to iterate through all the system keypad ints:  
 
dim numints = numobjects(0, "KPINT"); 
for i = 1 to numints 
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 connect xxx(0, "KPINT", i, "VALUE"); 
 ... 
next; 
 

setalarm(x, v), 
clearalarm(x, v), 

accalarm(x, v) 

These alarm handling functions set, clear, and accept system alarms. 
The parameters are alarm numbers (0→15) and alarm value (which 
gets printed).  
 
connect adc1(ioboard(1), "ADC", 0, "INUSE"); 
if (adc1 > 50) then 
 setalarm adc1(1, adc1); 
else 
 clearalarm adc1(1, adc1); 
endif; 
accalarm adc1(1, 0.0); 
 

timenow() Provides a snapshot of the system time; useful for working out 
relative times.  

 
while (1) do 
    dim t = timenow(); 
    . 
    . 
    . 
    # Have we taken too long??? (i.e. exceeded 1.5 seconds) 
    if (timenow() - t > 1.5) then 
        setalarm timeout(0, t); 
    endif 
wend 
 

log(x) Provides a natural logarithm.  
 

exp(x) Provides an exponential value.  
 

pow(x, y) Provides a power function, taking x to the power y. Arguments can be 
double precision. This function is processor-intensive, so do not use 
this function in a loop unless it is absolutely necessary.    
 

abs(x) Returns the absolute value of x. If x is positive, return x. If x is 
negative, return –x.  
 

int(x) Returns the integer portion of x. Always truncates, so int(1.9) returns 
1. If you want to round up, call int(x + 0.5).  
 

sin(x), cos(x), 
tan(x) 

Provides associated trigonometric functions. X must be in radians.  .  

 
NOT(x), NOTB(x) NOT() is a Boolean not, and returns 1 or 0 depending on the value of 

the passed expression, such as:  
 NOT(1) = 0  
 NOT(0) = 1  
 NOT(25.6) = 0  
NOTB() is a bitwise NOT, and is typically used for masking bits, as in:  
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function ClearBit(value, bitpos) 
    return value & NOTB(1 << bitpos); 
end; 
 

15.5.3 Alarms 
Testing Alarms You can test for alarms being set or clear, accepted or unaccepted by 

connecting to ALARM objects, as in:  
 
connect adcstatus(ioboard(1), "ALARMS", ALARMS_P144IIO_IO01ADC01, "STATUS"); 
connect adcunacc(ioboard(1), "ALARMS", ALARMS_P144IIO_IO01ADC01, "UNACC"); 
 

This object allows access to the alarm status of an ADC. The value 
returned is a 16-bit mask with a 1 in each alarm position representing 
an alarm that is set or unaccepted, respectively. 
To test if alarm 'x' (remember alarms start at 0) is set: 
 
    if adcstatus & (1 << x) then # alarm is set 
        . 
        . 
    endif; 
 
To test if alarm 'x' (remember alarms start at 0) is unaccepted: 

    if adcunacc & (1 << x) then      # alarm is unaccepted 
        . 
        . 
    endif; 
 

Suppressing Alarms Access to the alarm object allows you to suppress and test 
suppression. For example, To suppress alarm “x” (where x = 0 to 15) 
on an ADC, connect to an alarm object's "SUPPRESS" field:  

 
    connect adcsuppress(ioboard(1), "ALARMS", ALARMS_P144IIO_IO01ADC01, 
"SUPPRESS"); 
    adcsuppress = adcsuppress | (1 << x); 
 

The field is a 16-bit mask as are the Status and Unacc fields of the 
alarm object. Suppressed alarms are represented by a set bit in the 
mask. Setting a bit in the mask suppresses the alarm. Bear in mind that 
the above code first reads out the current suppress mask, OR's in a bit 
and writes it back. This happens pretty quickly but may conflict with 
anything else that is updating the value. Ensure the LogiCalc is the 
only task updating the alarm suppression word to avoid missing the 
odd suppression. 
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Appendix A – Glossary 

A  
ADC Analog to Digital Converter. Used to convert analog inputs (AI) to a format the flow 

computer can use. Also known as A/D Converter.  
Address A character or group of characters used to identify a particular item (such as a 

particular area of memory or a particular computer on a communication link with many 
other computers).  

AGA American Gas Association. A professional organisation that oversees the AGA3 
(orif ice), AGA5 (heating value), AGA7 (turbine), AGA8 (compressibility), AGA9 
(Ultrasonic) and AGA11 (Coriolis) gas flow calculation standards. See 
http://www.aga.org.  

AI Analogue input, also known as ANIN.  
Alphanumeric  Consisting of only the letters A through Z and the numbers 0 through 9. 
Analogue A signal with no defined steps, its value being determined by its size.  
Annubar A primary flow element that operates by sensing an impact pressure and a reference 

pressure through multiple sensing ports connected to dual averaging plenums. The 
resultant difference is a differential pressure signal. Sensing ports are located on both 
the up- and downstream sides of the flow element. The number of ports is proportional 
to the pipe diameter.  

ANIN Analogue input, also know as AI.  
ANOUT Analogue output, also known as AO.  
ANSI American National Standards Institute. An organization responsible for approving U.S. 

standards in many areas, including computers and communications. Standards 
approved by this organisation are often called ANSI standards (for example, ANSI C is 
the version of the C language approved by ANSI). ANSI is a member of ISO. See 
http://www.ansi.org.  

ASCII American Standard Code for Information Interchange. Numeric values assigned to 
letters, numbers, and other characters to enable exchange of information between 
devices (for example, “A” = 65, “B”=66, and so on).  

AWG American Wire Gauge, a system of sizing wiring.  

B  
Back up/backup The process of copying or creating a duplicate of computer files (called “a backup file”) 

that can be used to restore the original content in the event of a data loss.  
Baud An indicator of the rate of serial data transfer (for example, a baud rate of 10 indicates 

10 bits per second).  
Basetime The end of  day time when any daily, weekly, or monthly reports print; also known as 

“contract hour.” S600+ supports three basetimes.  
Batch control A system option used to allow a liquid station within the S600+ to control a number of 

streams to dispatch a precise amount of product. If  batch control is required, it should 
be enabled on all relevant streams and on the station settings during the configuration 
generation stage.  

Baud rate An indicator of the rate of serial data transfer (for example, a baud rate of 10 indicates 
10 bits per second, or approximately 1 character per second).  

Binary Numbers in base 2 (that is, only numbers 0 and 1 are used). May be represented as a 
digital signal and referred to as True/False, High/Low, or On/Off.  

Bit A binary digit, either a binary 0 or 1. One byte is the amount of memory needed to 
store each character of information (text or numbers). Eight bits constitute one byte (or 
character).  

Bit Link 
 

A bridge (also known as a jumper) that closes an electrical circuit. Typically a bit link 
consists of a plastic plug that fits over a pair of protruding pins. Placing a bit link over a 
dif ferent set of pins allows you to change a board’s parameters.  
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Bit switch Switches that represent data bits by on or off state.  
Buffer A device inserted between devices to match impedance, equipment speeds, or to 

supply additional drive capability. Also, a storage area for data that compensates for 
the speed difference when transferring data from one device to another; usually refers 
to an area reserved for I/O operations into which data is either read or f rom which data 
is written.  

Bus  One or more conductors used as a path over which information transmits.  
Byte Block of 8 bits, which can define 256 states (0 through 255).  

C  
Calorific value 
(CV) 

Superior calorific value (CV) is the amount of heat which could be released by the 
complete combustion in air of a specified quantity of gas, in such a way that the 
pressure at which the reaction takes place remains constant, and all the products of 
combustion are returned to the same specified temperature as that of the reactants, all 
of  these products being in the gaseous state except for water formed by combustion, 
which is condensed to the liquid state (source ISO6976, 1995).  
CV can also be calculated in accordance with AGA Report No. 5. 
For inferior calorific value, water remains in a gaseous state (vapour).  

CATS Common Area Transmission System. An agreed standard for measurement of gases 
and light hydrocarbons which are to be delivered to and redelivered for the CATS 
Transportation Facilities and Input Facilities (EU only).  

Cold Start A process of starting the FloBoss S600+ that copies the configuration file from Flash 
memory.  

Config600 
software 

PC-based software tool used to configure the S600+.  

Constants Numbers that only infrequently change. Examples would include the conversion value 
between Degrees Celsius and Degrees Fahrenheit or pipe diameter.  

Control bus  Bus connections for control signals (such as read/write).  
CPS Correction for pressure on steel (of meter or prover) 
CPU Central Processing Unit; in the S600+, the CPU module (P152+).   
CTL_CPL Factors for the Correction for the temperature of the liquid and correction for the 

pressure of the liquid. In the Calculations portion of the Config600 Configuration 
Generator, this option is set to include the Liquid Volume Correction Table for a US 
conf iguration (tables 23, 24, 53, or 54).  

CTS Clear to Send. The signal asserted (logic “0”, positive voltage) by the remote device to 
inform the flow computer that transmission may begin. RTS and CTS are commonly 
used as handshaking signals to moderate the flow of data into the remote device.  

CTS Correction for temperature on steel (of meter or prover) 
CUI Daniel USM interface 

D  
DAC Digital to Analog converter, also known as the D/A converter. Used to convert the 

digital signals used within the S600+ to an analog value for use with an analog 
transducer or for an analog readout.  

Databus A group of bi-directional lines capable of transferring data to and from the CPU storage 
and peripheral devices.  

DCS Distributed Control System. A computer system which manages the process of a plant 
or site.  

DCU Data Concentrator Unit. Used to connect one device (such as a printer) to multiple 
S600s. Control of the shared device is determined by the hardware handshaking lines 
of  the RS-232 port.   

Densitometer Transducer used to measure the density of the product at current conditions in the 
pipework where it is mounted.  

DI Digital or discrete input, as known as DIGIN.  
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Digital A signal with only two states, such as on/off, input/output, or 5V/0V.  
DIN Deutsches Institut fur Normung. German Standard.  
Discrepancy Used to check the difference between a measured variable and a preset value. For 

example, if Flow Discrepancy was selected during the generation phase, the S600+ 
would check the current uncorrected volume flow rate against the proved uncorrected 
volume flow rate. If  the discrepancy exceeded the preset limit, the S600+ would raise 
an alarm indicating that a prove was required.  
Note: This example is only applicable to a liquid turbine configuration. 

DO Digital or discrete output, also known as DIGOUT.  
DP Dif ferential Pressure.  
DPR Dual Pulse Receiver or turbine input.  
DRAM Dynamic Random-Access Memory. Volatile storage memory used in the S600+. When 

power is removed from the S600+, the contents of the DRAM memory are lost.  
DVM Digital voltmeter.  

E  
E-Format Mathematical notation where the mantissa is any number greater than –10 and less 

than 10 and the exponent is the multiplier.  
EEPROM Electrically Erasable Programmable Read Only Memory, a non-volatile memory chip 

which may be erased and reprogrammed electronically.  
Ethernet A 10- or 100-megabit-per-second (Mbps) baseband-type network that uses the 

contention-based CMSA/CD media access method. Invented by Robert Metcalf at 
Xerox’s Palo Alto Research Center in the mid-1970s.   

Exponent Base 10 multiplier.  
EU European Union.  
EU Engineering unit 

F, G 
Flash memory Non-volatile storage memory. Although slower to access than SRAM and DRAM, once 

programmed flash memory retains the data and requires no further support. In the 
S600+, configuration files and the operating system are typically stored in flash 
memory. Write protect jumpers are used to prevent accidental programming of flash 
memory.  

Flow Balance Used to balance the flow through a liquid system so a required flow rate can be 
attained through a prover.   

Flow Switching This option allows the station within the S600+ to control the number of streams open 
according to the current flow rates. If flow switching is required it should be enabled on 
all relevant streams and on the station settings during the generation phase.  

FRQ Frequency input.  

H  
HART® Highway Addressable Remote Transducer (or HART) is a communication protocol 

designed for industrial process measurement and control applications. It combines 
both analogue and digital communication and can communicate a single variable using 
a 4-20 mA analogue signal, while also communicating added information on a digital 
signal.  

Hex Hexadecimal, referring to numbers in base 16 (that is, numbers from 0 through 9 and 
letters f rom A through F).  

Heating Value 
(HV) 

See Calorif ic Value (CV).  

Holding 
Register 

Analog Output number value to be read.  

Hz Hertz.  
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I, J, K  
Integer Any positive or negative whole number, including zero.  
Intelligent I/O The Intelligent Input Output module (P144), also known as “IIO”.  
I/O Input and Output.  
IP Institute of Petroleum or Ingress protection standard, referring to British standard 5420 

or International Electro-Technical Commission standard 144.  
IP2 In the calculations section of the generator, this option includes the Liquid Volume 

Correction Tables (53 or 54) for a non-US configuration.  
IS Intrinsic Safety. A technique used to prevent excess electrical energy, or faults, in 

instrumentation from causing explosions in hazardous atmospheres. Often found in the 
process industry. It is the only protection method accepted for use in Zone 0 
hazardous areas.  

ISO International Organisation for Standards. A voluntary, non-treaty organization founded 
in 1946 which is responsible for creating international standards in many areas, 
including computers and communications. Its members are the national standards 
organizations of the 89 member countries, including ANSI for the U.S. See 
http://www.iso.org.  

ISO 5167 Measurement of fluid flow by means of pressure differential devices (such as orifice 
plates, nozzles, or Venturi tubes) inserted in circular cross-section conduits.  

ISO 6976 Natural gas calculation of calorific values, density, relative density and Wobbe index 
f rom composition.  

L 
LED Light-Emitting Diode (an indicator). On the S600+, a light to show the status of the 

S600+ in a visual form. As examples, the Alarm LED shows the status of the machine 
by the color of the LED and communications between the main processor board and 
the IO boards is shown on the rear of the flow computer by use of the transmit and 
receive LEDs.  

M 
Mantissa Numerically significant part of a f loating-point number.  
Meter 
Correction 

An option applicable only to liquid turbine applications and used to correct the flow rate 
due to temperature and pressure effects on the body of the meter.  

Meter 
Linearisation 

An option used to correct the K Factor or Meter Factor of a pulse input according to the 
input f requency. This is used to correct discrepancies caused by the non-linearity of 
the transducer connected to the pulse input.  

Modbus A device communications protocol developed by Gould-Modicon and used on the 
station supervisory computer data link, as well as communicating with Coriolis meters, 
gas chromatographs, ultrasonic meters, and other devices.   

Modem  Modulator Demodulator; a device used to communicate with other equipment using a 
telephone network.  

Modulate Superimposing one signal upon another.  
MOV Motor Operated Valve; a valve that is motorized and requires a signal to drive the 

valve open, a signal to drive the valve closed, and has a two signals returning to the 
S600+ to describe the valve as being open, closed, moving, or illegal.  

Multiplexor Multiple Input Selector.  
MVS Multi-variable sensor 

N 
Noise Random electrical interference.  
Non-volatile 
Memory 

Memory type that retains data when the power supply is disconnected.  

NX-19 An AGA report developed for the calculation of supercompressibility factors.  
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O 
Object Generally, any item that can be individually selected and manipulated. This can 

include shapes and pictures that appear on a display screen as well as less-tangible 
sof tware entities. In object-oriented programming, for example, an object is a self-
contained entity that consists of both data and procedures to manipulate the data.  

Octal Numbers in base 8 (that is, numbers 0 through 8).  
Off-line Accomplished while the target device is not connected (by a communications link). For 

example, “off-line configuration” refers to configuring an electronic file that is later 
loaded onto the S600+.  

On-line Accomplished while connected (by a communications link) to the target device. For 
example, “on-line configuration” refers to configuring an S600+ while connected to it, 
so you can view the current parameter values and immediately load new values.  

Open Collector Digital output that is driven by a transistor and requires external power.   
Opto-Isolator Optical device for connecting signals while maintaining electrical isolation.  
Overrange Over the preset current limit for the A/D Converter.  

P, Q 
PCB Printed circuit board.  
PID Three-term control action that uses Proportional, Integral, and Derivative components 

to modify a control output, with the goal of achieving a measured process variable at a 
set point.  

Peer to Peer 
Link 

Communications mode implemented by giving each communication node both server 
and client capabilities.  

Port Group of inputs or outputs to the computer.  
Program Series of instructions.  
Protocol Precise description of data interchange over a telemetry link.  
Prove 
Sequence 

An order of events set into the S600+ to perform a calibration (or “prove”) of flow 
balancing, stability checking, or valve-routing.  

PRT Platinum resistance thermometer. See also RTD.  
PSU Power supply unit.  
PTZ Calculation of Compressibility, Relative Density and Line Density using the Solartron 

7915 PTZ method.  

R 
RAM Random-access memory. Volatile memory that becomes unreliable when power is 

removed from the computer.  
Relative Density 
(RD) 

Liquid relative density: the ratio of the mass of a given volume of liquid at 15°C (or 
other standard temperature, such as 60°F) to mass of an equal volume of pure water 
at the same temperature. When reporting results, explicitly state the standard 
reference temperature (for example, relative density 15/15°C). [Source API Vocabulary 
1994].  
Gas relative density: As above except that air is used as the reference instead of 
water. 
Ideal and Real gas relative density. See Specific Gravity. 

Note: Water at 15°C is 999.058 kg/m3. 
Water at 60°F is 999.012 kg/m3. [Source API 2540 volume X] 
Air at 15°C is 1.2255 kg/m3. 

ROM Read-only memory (fixed storage). Typically used to store firmware. Flash memory. 
This type of memory cannot be written to by default; however, some modern memory 
allows writing to occur under certain conditions.  

RS-232 Voltage standard for multi-drop serial data transmission. Also EIA-232.  
RS-422 Voltage standard for serial data transmission; used as extender for RS-232.  
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RS-485 Voltage standard for multi-point digital data transmission.  
RTD Resistance thermometer device.  
RTS Request to Send. This signal is asserted (logic '0', positive voltage) to prepare the 

other device for accepting transmitted data from the flow computer. Such preparation 
might include enabling the receive circuits, or setting up the channel direction in half-
duplex applications. When the other device is ready, it acknowledges by asserting 
Clear to Send.  

RTU Remote terminal unit.  
RTV  Room temperature vulcanizing, typically a sealant or caulk such as silicon rubber.  
RX or RXD Received information.   

S 
Sampler Device used to take samples of the product in the pipework where it is mounted. This 

can either be timed according to throughput or number of samples required in a certain 
timeframe.  

Security Code Codes that limit operator access to software parameters; typically stored in micro 
memory.   

Specific Gravity 
(SG) 

Ideal gas relative density (specific gravity), Gi is defined as the ratio of the ideal 
density of the gas to the ideal density of dry air at the same reference conditions of 
pressure and temperature. Since the ideal densities are defined at the same reference 
conditions of pressure and temperature, the ratio reduces to a ratio of molar masses 
(molecular weights). [Source AGA3 1992]  
Real gas relative density (specific gravity), Gr, is defined as the ratio of the real density 
of  the gas to the real density of dry air at the same reference conditions of pressure 
and temperature. To correctly apply the real gas relative density (specific gravity) to the 
f low calculation, the reference conditions for the determination of the real gas relative 
density (specific gravity) must be the same as the base conditions for the flow 
calculation. [Source AGA3 1992] 
See also Relative Density (RD). 

Note: Real relative density differs from ideal relative density in that the ratio of the gas 
compressibilities is also taken into account. 

SRAM Static random-access memory. Stores data as long as power is applied; typically 
backed up by a lithium battery or supercapacitor.  

S600+ FloBoss™ S600+ Flow Computer.   

T  
Task An operating system concept that refers to the combination of a program’s execution 

and the operating system’s bookkeeping information. Whenever a program executes, 
the operating system creates a new task for it.  

TCP/IP Transmission Control Protocol/Internet Protocol.  
Time and Flow 
Averaging 

An option that allows the S600+ to average process variables based on time, flow or 
time and f low.  

Totaliser Area of  RAM for integrating totals.  
Transducer Device that converts energy from one state to another.   
TRI-REG Triple register; an area of RAM where data is stored in triplicate, normally used to 

store totals.  
TX  Transmitted information.  

U  
Underrange Under the preset current limit for the A/C Converter.  

V  
Variables Changeable values.  
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V-Cone® A differential pressure device produced by McCrometer.   
Volatile Memory that is unstable in the absence of power.  
VWI View Interface; now superseded by the Daniel Ultrasonic Interface.  

W  
Warm Start An S600+ startup process in which the configuration remains untouched.  
Watchdog A hardware circuit that monitors correct program operation and restarts the program in 

the event of malfunction.  
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Appendix B – Proving 
In This Chapter 
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B.1.8 Prove/Stream Data .................................................... B-31 
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B.3.3 Communications ....................................................... B-78 
B.3.4 Pulse Measurement ................................................... B-78 
B.3.5 Prove Sequence and Control ...................................... B-79 
B.3.6 Prover Run Control Stages ......................................... B-88 
B.3.7 Prove/Stream Data .................................................... B-94 
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B.3.9 Proving Calculations .................................................. B-97 

 
This appendix provides an overview of the four S600+-supported 
proving methods—bi-directional, uni-directional, compact, and master 
meter—and their specifications and applications.   

Note: Refer to Chapter 5, Station Configuration, for a discussion of 
prover configuration screens.  

The uni-directional prover differs from the bi-directional prover only in 
the run control sequence described in Section B.1.7. 

Station-Based In Config600 software, proving is a station-based function. Each 
S600+ can support two stations, and you can assign up to 10 streams 
(depending on the complexity of the configured streams) to each 
station. The provers do not need to be the same type. However, the 
S600+ supports only one Prover (P154) module, which means that you 
can perform only one prove sequence at a time.  

Local or Remote The software also allows you to prove streams that are “local” (that is, 
part of the same configuration) or prove streams that are “remote” (in a 
separate configuration or separate S600+) to the prover.  
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However, you cannot mix the two (for example, have a prover config 
with three metering streams and prove a remote, separate stream).  

B.1 Bi-Directional (Ball) Prover – Liquid Only 
Two components enable you to control the prove:  

 Prove sequence, a station-based function which sets up the prove 
environment, and  

 Run control, a prover-based function which drives the 4-way 
valve, counts pulses, and performs the K-factor calculations. 

Following a successful prove, the system verifies the stream’s normal 
flow rate value:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount of 
time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations.  

 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved, but does not use the data until it is accepted either locally 
at the S600+ or via a supervisory computer. 

When the prove runs complete, you can either re-run the prove or 
terminate, at which point (if so configured) the sequence restores the 
valves to their pre-prove state. 

Notes: 
 The prove sequence downloads both a K-factor and a meter factor. 

Applications typically use the original K-factor from the meter 
calibration report and update the meter factor, which may be either 
a fixed value or derived from a linearisation process. Alternatively 
the meter factor can remain unchanged and the K-factor (fixed or 
linearised) updated. 

 The meter factor deviation tests and the historical meter factor 
database are only supported for "local" streams (part of the same 
configuration with the prover), if you configure the stream normal 
flow rate to a value greater than zero and you select "Product Table 
with History" when you create your configuration. 
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 You define a ticket as Official or Unofficial when you configure a 
prove. This selection applies to both the Aramco-style and non-
Aramco-style linearisation. 

Following an Official prove, the prove sequence is determined by 
the Aramco / non-Aramco style linearisation selection. 

Following the Unofficial prove, the prove sequence does not 
download the prove results to the stream being proved. This is 
typically used to determine an approximate K-Factor / Meter 
Factor before an official prove takes place or when maintenance 
activities are being performed on the site.  

 The Official/Unofficial selection displays in the report header. 

B.1.1 Inputs/Outputs 
For bi-directional proving the S600+ requires the following hardware:  
 A CPU module (P152+)  

 An I/O module (P144)  

 A Prover module (P154)   
Inputs  A bi-directional prover normally has the following inputs:  

 
Prover Inlet Pressure 4-20mA ADC 
Prover Outlet Pressure 4-20mA ADC 
Prover Inlet Temperature 4-wire PRT 
Prover Outlet Temperature 4-wire PRT 
Stream Raw Pulses Raw Pulse Input  
Prove Enable Status Digital Input 
4-way Valve Forward Status Digital Input 
4-way Valve Reverse Status Digital Input 
4-way Valve Seal Status Digital Input 
4-way Valve Local/Remote Status Digital Input 
Sphere Switches 1 – 4 Switch Inputs 1 – 4 

 

Note: If there is only one pressure and temperature input, assign inlet 
and outlet objects to use the same input. 

Outputs  A bi-directional prover normally has the following outputs:  

 
4-way Valve Forward Command Digital Output 
4-way Valve Reverse Command Digital Output 

B.1.2 Communications 
Using the Modbus protocol, a slave link provides communications with 
any remote stream flow computers.   
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 To set up the link at the prover (which is the master), select 
Tech/Engineer > Communications > Assignment > Prover 
Master Link.  

 To set up the Modbus address, select Tech/Engineer > 
Communications > Assignment > Prover Master Lin.  

Prover/Stream Link Default Setting 
Modbus RTU Master 
Prover/Stream Link 
 

Serial RS485 - Comm 5  
9600 
8 bits 
No Parity  
1 stop bit  
Address = 1 (front panel)  

 
 To set up the link at the stream (which is the slave), select 

Tech/Engineer > Communications > Assignment > Next > 
Prover Slave Lin.   

Note: You can reset the ports, baud rate, number of bits, and parity 
values through the S600+’s front panel.  

B.1.3 Pulse Measurement  
The primary function of the prover is to calculate an accurate K-factor 
or meter factor value for the meter under prove. The bi-directional 
prover does this by counting the number of pulses from the stream 
meter and equating them to the known volume of the prover.   

The stream flow computer receives a known volume or mass from its 
meter and transmits a pulse train output (Raw Pulse Output) which 
represents the number of pulses received, including bad pulse 
correction. The prove sequence commands the selected stream to turn 
on its Raw Pulse Output, which allows the prover computer to monitor 
the pulses from the meter. The prover counts pulses during a proof run, 
and corrects the count for temperature and pressure. 
When the proof run completes, the prover calculates the stream’s K-
factor from the corrected pulse count and the known prover volume. 

Note: The electrical diagram for the Prover module shows a Raw 
Pulse Output, but this is not available. You cannot use this raw 
pulse output to pass pulses input to the Prover module to Raw 
Pulse Input.  

Pulse Gating When a proof run starts, a sphere launches into the flow and passes 
forward through the prover, triggering the two sphere detector 
switches as is goes. The 4-way valve then reverses and the sphere 
again launches into the flow, passing back through the prover and 
again triggering the two sphere detector switches.  

The raw pulses are counted on both the forward and reverse pass, 
during the period between the sphere switch detectors being triggered.  
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Figure B-1. Components of a Bidirectional Prover 

Pulse Interpolation  Pulse interpolation is used when the pulse count is low (typically less 
than 10,000 pulses per round trip).  
The S600+ supports two methods of pulse interpolation: dual 
chronometry (the standard) or an optional Pulse Interpolation module 
(PIM). Either method allows the prover computer to resolve the pulse 
count to better than the API recommendation of 1 part in 10,000.  

Dual chronometry adds accurate timing of the period between 
detectors so in effect partial pulses can be counted. 

If you do not select dual chronometry, you can use a Pulse 
Interpolation module (PIM) to achieve greater resolution. Using the 
S600+ keypad, you enter an interpolation factor corresponding to the 
PIM setting into the S600+ prover.  

B.1.4 Sphere Switch Interface 
You can select four possible calibrated (base) volumes, as shown in 
Figure B-2:   
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LAUNCH /
HOME

CHAMBER

RETURN
CHAMBER

4 WAY
VALVE

SS1

SS2

SS4

SS3

FORWARD
DIRECTION
REVERSE

DIRECTION

 

Figure B-2. Sphere Switch Selections 

The value for each volume entered represents the “round trip” volume 
between a pair of sphere switches (that is, twice the calibrated 
volume). You can enter the calibration conditions through the S600+ 
keypad. All four switches are connected directly to the prover 
computer. Table B-1 through Table B-4 detail the possible sphere 
switch selections:  

Table B-1. Bi-Directional Sphere Switch Selections 
(Prover mode set to BIDI 4-WAY and the number of switches set to 2) 

Sphere Switch (SS) P154 Connections 
1 & 2 SS1 = Sw1 (A17) 

SS2 = Sw3 (A5) 
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Table B-2. Bi-Directional Sphere Switch Selections 
(Prover mode set to BIDI 4-WAY and the number of switches set to 4) 

Base Volume Sphere Switch (SS) P154 Connections 
1 1 & 3 First part of pass: 

SS1 = Sw1 (A17) 
SS3 = Sw3 (A5) 

Return: 
SS3 = Sw3 (A5) 
SS1 = Sw1 (A17) 

2 2 & 4 First part of pass: 
SS2 = Sw2 (A18) 
SS4 = Sw4 (A6) 

Return: 
SS4 = Sw4 (A6) 
SS2 = Sw2 (A18) 

3 1 & 4 First part of pass: 
SS1 = Sw1 (A17) 
SS4 = Sw4 (A6) 

Return: 
SS4 = Sw4 (A6) 
SS1 = Sw1 (A17) 

4 2 & 3 First part of pass: 
SS2 = Sw2 (A18) 
SS3 = Sw3 (A5) 

Return: 
SS3 = Sw3 (A5) 
SS2 = Sw2 (A18) 

 

Table B-3. Type 2 
( Prover mode set to UNI TYPE 2) 

Sphere Switch (SS) P154 Connections 
1 & 2 SS1 = Sw1 (A5) 

SS2 = Sw2 (A17) 
 

Table B-4. Rotork  
(Prover mode set to UNI ROTORK and the number of switches set to 4) 

Base Volume Sphere Switch (SS) P154 Connections 
1 1 & 3 SS1 = Sw1 (A17) 

SS3 = Sw3 (A5) 
2 2 & 4 SS2 = Sw2 (A18) 

SS4 = Sw4 (A6) 
3 1 & 4 SS1 = Sw1 (A17) 

SS4 = Sw4 (A6) 
4 2 & 3 SS2 = Sw2 (A18) 

SS3 = Sw3 (A5) 
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B.1.4.1 Number of Switches and Base Volume 
The number of switches is selectable between 1, 2 and 4. The base 
volume you select on the Constants screen is determined by the 
number of switches you select. For more information, refer to Section 
5.7.2, Prover – Ball(Bi-Directional)  

If you select 1 switch, use Base Volume 1.  
 This prover has 2 sphere detector switches in parallel, and both 

switches are wired into Pin 17. Pulses are counted between the 1st 
hit and 2nd hit of this input. 

 This is a special for a particular uni prover manufacturer. 
If you select 2 switches, use Base Volume 1 

 This prover has 2 sphere detector switches which are named as 
Switch 1 and Switch 2. 

Launch / Home 
Chamber

Return
Chamber

4 Way Valve
Sphere Detector Switch 1 Sphere Detector Switch 2

Forward Run

Reverse Run

 

Figure B-3. Two Sphere Switches 

 They will register on Pin 17 (Switch 1) and Pin 5 (Switch 2). 

 

Figure B-4. Pinout for Two Sphere Switches 
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If you select 4 switches, the base volume will determine which 
switches to use. 
 This prover has 4 sphere detector switches which are named as 

Switch 1, 2, 3 and 4. 
Launch / Home 

Chamber
Return

Chamber

4 Way Valve
Sphere Detector Switch 1
Sphere Detector Switch 2

Sphere Detector Switch 4
Sphere Detector Switch 3

Forward Run

Reverse Run

 

Figure B-5. Four Sphere Switches 

 The Sphere Detector switches will register on the following: 

Pin 17 – Detector Switch 1 

Pin 18 – Detector Switch 2 
Pin 5 – Detector Switch 3 

Pin 6 – Detector Switch 4 

 

Figure B-6. Pinout for Four Sphere Switches 

Note: The Sphere Detector Switch pinouts will alter based on the 2 
switch or 4 switch selection. 
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B.1.5 Valve Interface 
The flow computer interfaces to a motor-operated 4-way valve. This 
section discusses the specifics of that valve.  

Operating 
Mode 

The valve has two available modes, remote and local. The flow 
computer accepts a digital input signal in order to determine the status 
of the valve mode. In remote mode (the valve’s remote status is 
“SET”), the S600+ controls the valve. In local mode (the valve’s 
remote status is “CLEAR”), you control the valve manually at the 
valve.  

Note: If you start a prove when the 4-way valve is in local mode, the 
run control expects the operator to manually move the valve. 
The sequence waits indefinitely for the valve to attain the 
correct position before continuing.  

Valve Position 
Inputs 

The prover computer monitors two digital input signals in order to 
determine the position of the 4-way valve.  
Table B-5 shows the interpretation of the two inputs. 1 indicates a 
contact closure/active signal; 0 indicates an open contact/inactive 
signal. CAS2 is the Valve Closed/Reverse Limit switch and OAS2 is 
the Valve Open/Forward Limit switch. 

For correct operation the Valve Closed Limit switch remains closed 
until the closed stop is reached, and the Open limit switch remains 
closed until the Open stop is reached. This means that both inputs are 
active when the valve is moving and ensures that a valve illegal alarm 
is raised due to a wiring fault. 

Table B-5. Valve Positions 
 
Actual Valve 
Position 

Valve Closed 
Limit Switch 

(CAS2) 

Valve Open 
Limit Switch 

(OAS2) 

 
Flow Computer 

Valve Closed Input 

 
Flow Computer 

Valve Open Input 
OPEN/FWD 1 0 0 1 
MOVING 1 1 1 1 
CLOSED/REV 0 1 1 0 
FAULT 0 0 0 0 

 
To achieve this operation you must wire the Closed Limit Switch 
(CAS2) to the flow computer’s valve open input, and wire the Open 
Limit Switch (OAS2) to the flow computer’s valve closed input. 

Note: If the Limit Switches show the fault state as bits 1/1 not 0/0 
there is a work around by swapping the digital inputs for open 
& closed and inverting the signals.  

Valve Command 
Outputs 

Two digital outputs command the valve to move. The forward/reverse 
output signals can either be held continuously until the valve travel is 
complete or initiate a pulse where the output is activate for an entered 
period (such as two seconds).  

A valve timeout alarm is raised if the valve position inputs do not 
reflect the required position within a configurable timeout period. The 
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timer activates when the flow computer issues the valve move 
command.  

Valve Seal 
Detection 

The S600+ accepts a digital input signal in order to monitor the 
position of the seal of the valve.  
The operator can enter two parameters: a valve “Settle” time 
(initialised to 30 seconds) and a “Test” time (initialised to 120 
seconds), which starts when the settle time expires. 

Note: The prover does not function correctly if the value is not sealed 
correctly (without leaks).   

When the valve attains position, the following events occur: 

1. The valve settle time expires.  

2. At the expiration of the settle time, the program checks the seal 
status and raises a Seal Fail alarm if the seal has not set.  

3. At the expiration of the test time, the test aborts.  

Valve Travel 
Time 

This represents the time, in seconds, for the valve to reach its 
commanded position prior to raising a timeout alarm. 

Valve Simulation 
Mode 

Valve simulation is available, accessible through the security-protected 
display. When the valve simulation mode is enabled, the status line 
changes when a command has been issued. 

Alarms and 
Events 

The following alarms and events are typically raised on this input. 

 
Alarms  Valve illegal  

 Valve seal fail  
 Move fail – if status does not change when command 

issued (when the valve is in remote mode). 
 Move Uncom – if valve status changes when no 

command has been issued (when the valve is in 
remote mode). 

 Valve unavailable (when the valve is in local mode) 
Events Each Mode change (Measured to Keypad) etc. 

Note: If a prove fails (aborts) because of a Seal Fail alarm, you must 
manually command the valve to move when the seal is made 
before the prove sequence “knows” the valve is now sealed.   

B.1.6 Prove Sequence and Control  
Two components enable you to control the prove:  

 Prove sequence, a station-based function which sets up the prove 
environment, and  

 Run control sequence, a prover-based function which drives the 
4-way valve, counts pulses, and performs the K-factor and meter 
factor calculations. 
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Note: In normal operation, the prove sequence automatically 
controls the run control sequence. However, you can 
manually control the run control sequence (for example, to 
diagnose problems).    

The S600+’s front panel display provides the following commands you 
can use to control and monitor the two prove control tasks (Operator 
> Station > Sequence Ctl):  

Display  Description 
SEQ CTL  Operator commands for sequence control (outer loop) 
SEQ STREAM NO.  Enter the designated stream number to be proved  

Note: For local streams, this is the logical stream number. 
For remote streams, this is the slave number in the 
Modbus master map. For example, if the first slave 
has a Modbus address of 22, this is stream 1. If  the 
second slave in the master map has an address of 
33, this is stream 2.  

SEQ STAGE INDEX  Shows current sequence stage as the sequence progresses. 
SEQ STAGE PREV Indicates the sequence stage immediately prior to the current 

stage. If an abort occurs, use this value to help identify the 
source of the abort.  

SEQ ABORT INDEX  In the event of a sequence error, an abort reason index will 
be shown here. 

RUN CTL  Operator commands for proof run (inner loop) 
Run permit Interlock required for starting proof run. 
Run stage index Shows current proof run stage as the sequence progresses. 
Run abort index In the event of a proof run sequence error, displays an abort 

reason index. 
 
Following a successful prove, the system verifies the stream’s normal 
flow rate:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount of 
time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations.  
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 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved, but does not use the data until it is accepted either locally 
at the S600+ or via a supervisory computer. 

You then have two options for accepting the prove results: 

 If you select ACCEPT, the currently running batch is retroactively 
adjusted with the new factor. 

 If you select ACCEPT NO ADJUST, no adjustment is performed 
on the currently running batch. 

B.1.6.1 Default Prove Sequence Stages 
The prover sequence functions in stages. Table B-6 shows the default 
stages for a typical application’s normal, reprove, and abort situations.  
If an abort occurs either automatically or by operator command then 
the prove sequence stage changes to Aborted. No further action is 
taken until the computer receives either a Continue command to 
initiate a re-prove or a Terminate command to finish the sequence.  

Table B-6. Default Prove Sequence Stages 

Stage Display Description 
0 IDLE Halted: idle, await Start command 
1 INITIALISE Initialise 
2 PULSES ON Turn proving stream pulses on 
8 SEAT SPHERE A Ensure sphere is in the launch chamber  
16 PRV FLOW/T/P STAB Hold stable temperature, pressure and flowrate 
18 PROOF RUN Perform proof runs (execute Run Control stages) 
19 KF DOWNLOAD K-factor download 
20 AWAIT REPROVE Halted: prove runs complete, await Continue/Terminate 

command 
26 ABORTED STAGE Halted: sequence aborted, await Continue/Terminate 

command 
Continue (Reprove) 

28 RE-SEAT SPHERE A Seat sphere 
29 RE STAB CHECKS Hold stable temperature, pressure and flowrate 
18 PROOF RUN Perform proof runs (execute Run Control stages) 

Terminate 
21 SEAT SPHERE B Seat sphere (at end of prove) 
25 PS PULSES OFF Turn of f pulses 
30 TERMINATE Terminate (return to idle) 

 
To use stages not included in the sequence you need to create your 
own sequence file (or two files, if you have configured two provers). 
Example sequence files are included in 
C:\Users\<username>\Config600 3.3\pseqlib directory. Copy one of 
these to C:\Users\<username>\Config600 3.3\Configs\Project\extras 
directory so that you can download it to the S600+ with the 
configuration. 
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Note: An explanation of this procedure is provided in How To No.72 
available from SupportNet.  

B.1.6.2 Complete Sequence Stage Descriptions 
Table B-7 shows all the stages of a prove sequence.  

Table B-7. Prove Sequence Stages (Complete) 
Stage Title Description 

0 Idle Wait for a command to start the sequence, then proceed to stage 1 
(Validate and Initialise). 

1 Validate + 
Initialise 

Verify:  
 The proving stream is flowing. 
 The proving stream is not in maintenance mode.  
 Telemetry to the proving stream is OK.  
 The prove permit state (run control status) is OK. 
Initialise:  
 Copy the proving stream meter variables into the proving set.  
 Copy the product stream product data into the proving set. 
 Initialise proof run date (via Initialise command to run control 

task).  
 Determine required proof flowrate from current rate (snapshot) or 

preset f lowrate.  
 Save all FCV settings. 
Proceed to stage 2 (Pulses On). 

2 Pulses On Command all online streams to turn pulses off  
Command proving stream to turn pulses on 
Wait for pulses to be aligned   
Proceed to stage 3 (Prover FCV Initialise)  
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails.  
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 

3 Prover FCV 
initialise 

Set prover FCV manual output to initial output 
Set prover FCV mode to manual 
Set proving stream FCV tracking on 
Set proving stream FCV mode to manual 
Proceed to stage 4 (Open prover outlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
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Stage Title Description 
4 Prover open 

outlet 
Command Prover Outlet Valve to open 
Wait for valve to reach position 
Proceed to stage 5 (Non-proving stream close prover inlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

5 Non-proving 
stream close 
prover inlet 

Command non-proving streams Prover Inlet Valves to close 
Wait for valves to reach position 
Proceed to stage 6 (Proving stream open prover inlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

6 Proving 
stream open 
prover inlet 

Command proving streams Prover Inlet Valve to open 
Wait for valve to reach position 
Proceed to stage 7 (Proving stream close stream outlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

7 Proving 
stream close 
stream outlet 

Command proving streams Outlet Valve to close 
Wait for valve to reach position 
Proceed to stage 8 (Seat sphere A) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
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Stage Title Description 
8 Synchronise 

with Run 
Control (Seat 
sphere A) 

Command 4-way valve to reverse (via Seat Sphere command to run 
control task).  
Wait for valve to reach position 
Proceed to stage 9 (Non-proving stream FCV track) or stage 16 
(Temperature / Pressure Stability) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

9 Non-proving 
stream FCVS 
track 

Set FCV for non-proving streams to tracking 
Proceed to stage 10 (Non-proving stream flow balance) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
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Stage Title Description 
10 Non-proving 

stream flow 
balance 

Enable f low balancing for non-proving streams 
Flow error = proving stream flowrate - (selected proof flowrate + 
of fset). 
If  the error is too low then: 
 If  there are no on-line streams then go to abort stage. 
 Turn down value = abs (error / no. of on line none proving 

streams). 
 For each on line proving stream, new setpoint = current rate - turn 

down.  
If  all new set points (for each stream) are within the low flow range 
then download the new set points and delay for adjustment prior to 
rechecking the flow error. 
If  any new set point is less than the low flow range then go to stage 12 
(operator close) 
If  the error is too high then: 
 If  there are no on-line streams then go to abort stage. 
 Turn up value = error / no. of on line none proving streams. 
 For each on line proving stream, new setpoint = current rate + 

turn up.  
If  all new set points (for each stream) are within the high flow range 
then download the new set points and delay for adjustment prior to 
rechecking the flow error. 
If  any new set point is higher than the low flow range then go to stage 
13 (operator open). 
Proceed to stage 14 if the error is within tolerance (Non-proving 
stream FCV manual). 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 

11 Not used  
12 Close 

suspend 
Flow balancing – wait for operator to close stream 
Return to f low balancing stage 10 if continue command issued 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 
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Stage Title Description 
13 Open 

suspend 
Flow balancing – wait for operator to open stream 
Return to f low balancing stage 10 if continue command issued 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 

14 Non-proving 
stream FCVS 
manual 

Set all non-proving stream FCV tracking on 
Set all non-proving stream FCV mode to manual 
Proceed to stage 15 (Prover flowrate stability) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

15 Prover 
flowrate 
stability 

Set prover FCV to selected prove flow rate + offset 
Set prover FCV mode to auto 
Set prover FCV tracking to on 
Hold proving stream flow rate within tolerance for a user configurable 
time 
Proceed to stage 16 (Temperature / Pressure Stability) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  stability not achieved. 



Config600 Configuration Software User Manual 

Revised January 2023 Proving B-19 

Stage Title Description 
16 Synchronise 

with Run 
Control 
(Temperature 
/ pressure 
stability) 

Hold stability for a user-configurable time 
Proceed to stage 17 (Prover FCV manual)  
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  stability not maintained. 

17 Prover FCV 
manual 

Set prover FCV tracking on 
Set prover FCV mode to manual 
Proceed to stage 18 (Proof runs) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

18 Synchronise 
with Run 
Control 
(Proof runs) 

Start the prove runs (via Start command to run control task).  
On success proceed to stage 19 (KF download)  
Abort:  
 If  a run fails (such as a timeout for a sphere switch). 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

19 K-factor 
Download 

Copy proof K-factor, meter factor, flow rate, and frequency into 
proving stream data points for subsequent telemetry download.  
Notes:  
 The stream metering calculations do not use these until 

commanded separately. 
 If  the historical meter factor option is enabled then the historical 

meter factors and deviations arrays are also copied.  
Proceed to stage 20 (Await reprove) 

20 Await reprove Go to stage 21 (Seat sphere B) if the Terminate or abort command is 
issued.  
Go to stage 28 (Re-seat Sphere) if Continue (Reprove) command is 
issued. 
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Stage Title Description 
21 Synchronise 

with Run 
Control 
(Seat sphere 
B) 

Command 4-way valve to reverse (via Seat Sphere command to run 
control task).  
Wait for valve to reach position 
Proceed to stage 22 (Proving stream open stream outlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

22 Proving 
stream open 
stream outlet 

Command proving stream Outlet Valve to open 
Wait for valve to reach position 
Proceed to stage 23 (Proving stream close prover inlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  valve fails to reach position. 

23 Proving 
stream close 
prover inlet 

Command proving stream Prover Inlet Valve to close 
Wait for valve to reach position 
Proceed to stage 24 (Restore FCV) or stage 25 (Proving stream 
pulses off) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

24 Restore FCVS Reset FCV’s to previous (pre-prove) settings as noted in stage 1 
Proceed to stage 25 (Proving stream pulses off) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 
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Stage Title Description 
25 Proving 

stream 
pulses off 

Command proving stream to turn pulses off.  
Wait for the pulses to be turned off  
Proceed to stage 1 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 

26 Aborted 
stage 

An abort condition has occurred.  
Go to the next relevant stage if the Terminate command is issued.  
Go to stage 28 (Re-seat Sphere) if Continue (Reprove) command is 
issued. 

27 Not used  
28 Synchronise 

with Run 
Control 
(Re seat 
sphere A) 

Command 4-way valve to reverse (via Seat Sphere command to run 
control task).  
Wait for valve to reach position 
Proceed to stage 29 (Stability Checks) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

29 Synchronise 
with Run 
Control 
(Stability 
checks) 

Wait to achieve stability (via Stabilise command to run control task) for 
temperatures, pressure rate of change.  
Upon achieving stability, wait for stability to be held for a user-
conf igurable time. 
Proceed to the stage 18 (Proof runs). 

30 Terminate Ensure the run control sequence terminates.  
Return to stage 1 (Idle). 

31 to 
40 

User Stages Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

41 Not used  
42 User Comms 

Suspend 1 
Suspends the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

43 User Comms 
Normal 1 

Re-enables the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

44 User Comms 
Suspend 2 

Suspends the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

45 User Comms 
Normal 2 

Re-enables the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

B.1.6.3 Prove Sequence Abort Index 
Table B-8 shows the abort values for a prove sequence.  
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Table B-8. Prove Sequence Abort Index 
Value Display Description 

1 OP ABORT Operator Requested Abort 
2 Not Used  
3 PS TELEM FAIL Proving Stream Telemetry Fail 
4 RUN CTL BUSY Run Control Task Busy 
5 METER NO FLOW No Flow at Meter 
6 RUN CTL ABORT Run Control Task Aborted 
7 ILLEGAL PULSES More than one stream has raw pulses enabled  
8 ANY TELEM FAIL Non Proving Stream Telemetry Fail 
9 NPS PRV I-VLV OPEN Non Proving Stream Prover Valve Not Closed 
10 PS PRV I-VLV CLOSED Proving Stream Prover Offtake Valve Not Open 
11 PS STR O-VLV OPEN Proving Stream Outlet Valve Not Closed 
12 PRV I-VLV CLOSED Prover Inlet Valve Not Open 
13 PRV O-VLV CLOSED Prover Outlet Valve Not Open 
14 PS IN MAINT Proving Stream Is In Maintenance Mode 
15 FBAL TIMEOUT Flow Balance Timeout 
16 FBAL NO NPS ON LINE Flow Balance Error - No Non Proving Streams On-line  
17 FBAL NO NPS IN AUTO Flow Balance Error - No Non Proving Streams In Auto 
18 FBAL HOLD FAIL Flow Balance Error - Stability Not Achieved 
19 PS I-ISL-VLV CLOSED Proving Stream Inlet Isolation Valve Not Open 
20 PS O-ISL-VLV CLOSED Proving Stream Header Isolation Valve Not Open 
21 PS P-ISL-VLV CLOSED Proving Stream Prover Isolation Valve Not Open 
22 PEER STATUS STANDBY Unit is in standby mode when peer-to-peer is configured 

B.1.7 Prover Run Control Stages 
The Run Control sequence is specific to the type of prover (such as a 
ball prover, a compact prover, or a master meter). The Run Control 
sequence initiates the prove runs and performs the calculations that 
produce a K-factor and meter factor when the runs complete. 

Normally the sequence runs when commanded by the Prove Sequence 
at stage 18 (Perform Proof Runs). However, you can initiate the 
sequence from the S600+ front panel display or (by using custom 
controls) from elsewhere.  

Table B-9 shows the default stage sequencing for a typical bi-
directional prove. 

Table B-9. Bi-Directional Prover Run Control Stages 

Stage Display Description 
0 IDLE Halted: idle 
1 INITIALISE Initialise run data 
2 AWAIT SEAT CMD Halted: await Seat Sphere command 
3 SEAT SPHERE A Seat sphere (drive 4-way valve to reverse) 
4 POST SEAT SPHERE A Delay to allow sphere to fully seat 
5 AWAIT STAB CMD Halted: await Stabilise command 
6 WAIT STAB Wait until stability is achieved 
8 AWAIT RUN CMD Halted: await start runs command 
9 DRIVE FORWARD Drive 4-way valve to forward 
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Stage Display Description 
10 FORWARD WAIT SW1 Wait switch 1 hit (forward run) 
11 FORWARD WAIT SW2 Wait switch 2 hit (forward run) 
23 BI HALF RUN COMP Bidi half run complete 
12 HALF RUN CALCS Perform half run calculations 
13 TURN RND1 DELAY Delay for turn around 
14 DRIVE REVERSE Drive 4-way valve to reverse 
15 REVERSE WAIT SW2 Wait switch 2 hit (reverse run) 
16 REVERSE WAIT SW1 Wait switch 1 hit (reverse run) 
17 FULL RUN CALCS Perform full run calculations 
18 RUN AVG CALCS Perform run average calculations 
19 STD RPT CHECKS Perform repeatability checks (if success go to stage 25) 
26 CHECK RUNS 

EXCEEDED 
Check runs exceeded (if yes go to stage 21) 

20 TURN RND2 DELAY Delay for turn around (then go to stage 9) 
25 FINAL AVG Perform final average calculations 
27 MF DEVIATION 

CHECKS 
Perform meter factor deviation checks. This stage occurs only 
if  you configure the meter normal flow rate to a value greater 
than zero.  
Note: This stage is performed only if you configure the meter 

normal f low to a value greater than zero (Aramco-
style linearisation) and you select “Product Table 
with History” when you create your configuration. 

28 WAIT REJECT 
COMMAND 

Allow a time-out for rejecting the current prove. If  the time-out 
elapses then print the proof report. This stage occurs only if 
you configure the meter normal flow rate to a value greater 
than zero.  
Note: This stage is performed only if you configure the meter 

normal f low to a value greater than zero (Aramco-
style linearisation). 

21 FINAL Halted: f inal – await Terminate/Reprove command 
 

Uni-directional A configuration option (Prover Mode) on the PCSetup Run Data 
screen enables you to run a uni-directional prover. In a sequence 
similar to the one shown in Table B-9, the uni-directional prover uses 
stage 24 instead of stage 23 and bypasses the return stages 12 through 
16.  

User Stages You can also enable user stages on the PC Setup Run Data screen. 
These invoke a LogiCalc which you can edit to provide user specific 
logic as the prove progresses.   

The folder C:\Users\<username>\Config600 3.3\lclib\prover includes 
example LogiCalcs.   

First, copy one of these to the C:\Users\<username>\Config600 
3.3\Configs\Project\LogiCalc directory so that you can download it to 
the S600+ with the configuration so you can edit it to be compatible 
with your configuration and then download it to the S600+ with the 
configuration. 

Note: You must edit the LogiCalc file to connect to the correct 
objects in your configuration. 
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Note: The displays showing the switch hit only update during a 
prove. You cannot use them independently to test the hardware.  

B.1.7.1 Run Control Stage Description  
Table B-10 shows all the stages of a Run Control sequence in bi- and 
uni-directional provers.  

Table B-10. Prover Run Control Stages 
Run Stage Description 

0 Idle 
Wait for the Initialise command to start the Run Control 
sequence.  
Proceed to next stage only if the prove is permitted (that is, if the 
Run Control stage is Idle or Final and the available signal is zero; 
normally, the available signal is assigned to a digital input which 
may be connected to a valve or a key-switch). 

1 Initialise Run Data 
Zero down all run data and arrays.  
Proceed to next stage. 

2 Halted: Await Seat Sphere Command  
Wait for Seat Sphere command then proceed to next stage. 
Abort: 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 

3 Seat The Sphere (Drive 4-Way Valve To Reverse)  
Issue hardware command to drive 4-way valve to reverse then 
wait for valve to travel to reverse.  
Proceed to next stage upon reaching reverse. 
Abort: 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 

4 Delay To Allow Sphere To Seat 
Delay for a period (estimated from flowrate and the selected 
base volume) to allow sphere to fully seat, then proceed to next 
stage. A flow uncertainty value of 1.5 is also used in the 
calculation of travel time (Travel time = ((Base Volume * 3600) / 
Flow Rate) * Flow Uncertainty). 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 

5 Halted: Await Stabilise Command  
Wait for Stabilise command then proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
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Run Stage Description 
6 Wait Until Stability Is Achieved  

Proceed to next stage if stability override is on. 
Set stability wait timer running. 
Continuously monitor deviations for: 
 prover inlet pressure vs. prover outlet pressure 
 meter pressure vs. prover inlet pressure 
 meter pressure vs. prover outlet pressure 
 prover inlet temperature vs. prover outlet temperature 
 meter temperature vs. prover inlet temperature 
 meter temperature vs. prover outlet temperature 

Continuously monitor (over 5-second periods) rates of change  
for: 
 prover inlet pressure 
 prover outlet pressure 
 prover inlet temperature 
 prover outlet temperature 
 meter f lowrate 

Proceed to next stage when stability is achieved. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued. 
 If  stability wait timer expires. 

7 Hold Stability For Entered Period  
Proceed to next stage if stability override is on. 
Set stability hold timer running. 
Repeat the stability checks from the previous stage to ensure 
stability is maintained for the given period. 
Proceed to next stage when stability hold timer expires. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  any of the stability checks fail. 

8 Halted: Await Start Runs Command  
Wait for Start Runs command then proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 

9 Drive 4-Way Valve To Forward  
Issue command to reset the prover hardware. 
Issue hardware command to drive the 4-way valve to forward 
then wait for the valve to travel to the forward position. 
Proceed to next stage upon reaching forward. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 
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Run Stage Description 
10 Wait Switch 1 Hit (Forward Run)  

Estimate time for switch 1 hit based on stream flowrate and pre 
switch 1 volume. A flow uncertainty value of 1.5 is also used in 
the calculation of travel time (Travel time = ((Pre-Switch 1 
Volume * 3600) / Flow Rate) * Flow Uncertainty). 
Set switch timer running based on this estimate. (Setting this 
switch to 0 disables the timer and enters permanent wait state.)  
Proceed to next stage when switch 1 is hit. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 
 If  pulse lock is lost. 
 If  switch timer expires. 
 If  switch sequence error. 

11 Wait Switch 2 Hit (Forward Run)  
Estimate time for switch 2 hit based on stream flowrate and 
selected base volume. A flow uncertainty value of 1.5 is also 
used in the calculation of travel time (Travel time = ((Base 
Volume * 3600) / Flow Rate) * Flow Uncertainty). 
Set switch timer running based on this estimate. (Setting this 
switch to 0 disables the timer and enters permanent wait state.) 
Average meter and prover data whilst the sphere is between 
detectors. 
Perform stability checks whilst the sphere is between detectors. 
Proceed to next stage when switch 2 is hit. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 
 If  pulse lock is lost. 
 If  stability checks fail. 
 If  switch timer expires. 
 If  switch sequence error. 

12 Perform Half Run Calculations  
No action; proceed to next stage. 

13 Delay For Turn Around  
Set timer running to allow sphere to reach the chamber (having 
passed the sphere switch). 
Proceed to next stage when timer expires.  
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued.  

14 Drive 4-Way Valve To Reverse  
Issue command to reset the prover hardware. 
Issue hardware command to drive the 4-way valve to reverse 
then wait for the valve to travel to the reverse position.  
Proceed to next stage upon reaching reverse. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 
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Run Stage Description 
15 Wait Switch 2 Hit (Reverse Run)  

Estimate time for switch 2 hit based on stream flowrate and pre 
switch 2 volume. A flow uncertainty value of 1.5 is also used in 
the calculation of travel time (Travel time = ((Pre-Switch 2 
Volume * 3600) / Flow Rate) * Flow Uncertainty). 
Set switch timer running based on this estimate. 
Proceed to next stage when switch 2 is hit. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 
 If  pulse lock is lost. 
 If  switch timer expires. 
 If  switch sequence error. 

16 Wait Switch 1 Hit (Reverse Run)  
Estimate time for switch 1 hit based on stream flowrate and 
selected base volume. A flow uncertainty value of 1.5 is also 
used in the calculation of travel time )Travel time = ((Base 
Volume * 3600) / Flow Rate) * Flow Uncertainty). 
Set switch timer running based on this estimate. 
Average meter and prover data whilst the sphere is between 
detectors. 
Perform stability checks whilst the sphere is between detectors. 
Proceed to next stage when switch 1 is hit. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 
 If  the 4-way valve raises Move Fail or Leak alarms. 
 If  pulse lock is lost. 
 If  stability checks fail. 
 If  switch timer expires. 
 If  switch sequence error. 

17 Perform Full Run Calculations  
Based on forward and reverse run pulse counts, flight times and 
data averaged during the forward and reverse run. 
Proceed to next stage if calculations are all valid. 
Abort if there is a calculation failure (such as K-factor out of 
range). 

18 Perform Run Average Calculations  
Average the individual run data over the last n good runs and 
place the data in the 12th slot of the run arrays. 
Proceed to the next stage.  

19 Perform Repeatability Checks  
If  the required number of runs has not been performed then 
proceed to next stage. 
If  the required number of runs has been performed then check 
each of  the last n run’s K-factor against the average. 
If  each K-factor is within tolerance then proceed to stage 21 
(Await Reprove/Terminate). 
If  any K-factors are outside tolerance and the maximum number 
of  runs has been exceeded then proceed to stage 21 (Await 
Reprove/Terminate) otherwise proceed to the next stage. 
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Run Stage Description 
20 Delay For Turn Around (Then Go To Stage 9)  

Set timer running to allow sphere to reach the chamber (having 
passed the sphere switch). 
Proceed to next stage when timer expires. 
Abort if the Terminate command is issued. 

21 Halted: Final - Await Terminate/Reprove Command 
End of prove. If : 
 Run control command is Initialise, proceed to stage 1 

(Initialise Run Data).  
 Run control command is Terminate, proceed to stage o 

(Idle). 
 Run control command is Seat Sphere, proceed to the 

next stage (Seat Sphere) stage. 
22 Seat The Sphere (Drive 4-Way Valve To Reverse)  

Issue hardware command to drive 4-way valve to reverse then 
wait for valve to travel to reverse. 
Proceed to next stage upon reaching reverse, by default the idle 
stage. 
Abort:  
 If  the Terminate command is issued. 
 If  the 4-way valve raises the Move Fail or Leak alarms. 

23 Bi-directional Half Run Complete  
Extract the forward run pulse count and flight time ready for 
calculations. 
Proceed to the next stage. 

24 Uni-Directional Full Run Calculations  
Based on forward run pulse counts, flight times and data 
averaged during the forward run. 
Proceed to next stage if calculations are all valid. 
Abort if there is a calculation failure (such as K-factor out of 
range). 

25 Perform Final Average Calculations  
Calculate the f inal (average) K-factor and meter factor. 
Proceed to the next stage. 

26 Check Runs Exceeded 
Check the number of runs executed against the maximum 
allowed. 
Proceed to the next stage. 
Abort if the maximum runs have been exceeded. 
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Run Stage Description 
27 Perform Meter Factor Deviation Checks 

Perform tolerance tests (calculated meter factor versus initial 
base meter factor: maximum deviation of 0.25% and calculated 
meter factor versus average of saved historical meter factors: 
maximum deviation of 0.1%). 

Only valid meter factors at normal flow rate are incorporated in 
the historical database. When the limit from either test is 
exceeded, the meter fact is not used for measurement and the 
corresponding meter factor at normal meter flow rate is not 
entered in the historical database. Proving reports are annotated 
as “ABORTED” with cause of failure stated.  
Proceed to stage 26 if any of the tolerance test fail.  
Proceed to the next stage.  

Note: This stage is performed only if you configure the meter 
normal f low rate to a value greater than zero (Aramco-
style linearisation) and you select "Product Table with 
History" when you create your configuration.  

28 Await for Current Prove to be Rejected 
You can reject the current prove results within a predefined time-
out. 
Print report when timer expires 
Abort if the prove is rejected. 
Proceed to the next stage.  
Note: This stage is performed only if you configure the meter 

normal f low to a value greater than zero (Aramco-style 
linearisation). 

B.1.7.2 Run Stage Abort Index  
Following an abort the program displays a value in the Run Control 
abort index display.  

Table B-11. Run Stage Abort Index 
Value Display Description 

0 NULL Not used 
1 OPERATOR Operator abort 
2 4WAY FAIL 4-way valve command timeout  
3 SW1 TIMEOUT Switch 1 timeout (the switch was not hit within the predicted 

time).  
To resolve, check wiring; set pre-switch volume to 0; or check 
that raw pulse bus frequency is greater than 0.  

4 SW2 TIMEOUT Switch 2 timeout (the switch was not hit within the predicted 
time).  
To resolve, check wiring; set pre-switch volume to 0; or check 
that raw pulse bus frequency is greater than 0.  
Note: If  the f low computer does not see SW2, check the raw 

pulse bus.  
5 STAB WAIT Temperature/Pressure/Flowrate wait stability timeout 
6 STAB HOLD Temperature/Pressure/Flowrate hold stability timeout 
7 AVG CALC Average calculation error; number of samples exceeds 30,000 
8 HALF CALC Not used 
9 FULL CALC Error occurred when performing full run calculations (for details 

refer to Run Stage Calculation Index).  
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Value Display Description 
10 RUNS EXCEEDED Maximum number of runs exceeded 
11 SS ERROR Sphere switch sequence error 
12 PLS LOCK LOST Pulse interpolator module lock lost 
13 IO FAIL I/O module failed to respond to prove request 
14 NULL Not used 
15 BVOL CHANGED Base volume changed 
16 KF/MF RANGE K-factor or meter factor out of range, even if alarms not 

conf igured. To resolve, check the high and low limits for the 
meter factor, the K-factor, and pulse count objects. 

17 4WAY MOVED 4-way valve moved unexpectedly; pulse count range checked.  
18 UNAVAIL Prover unavailable 
19 NULL Not used 
20 INV CALC Unsupported volume/mass calculations 
21 MF DEV INVALID Failed during meter factor deviation checks.   

B.1.7.3 Run Stage Calculation Index  
If a prover calculation fails, the program displays a value indicating the 
failed calculation in the Run Stage Calc Index display.  

Table B-12. Run Stage Calculation Index 
Value Display Description 

0 IDLE No calculation errors 
1 CTSP The calculation to determine the correction factor for the effect of 

temperature on the steel at the prover (CTSp) failed because the 
CTSp value is less than 0.5 or greater than 1.5.  

2 CPSP The calculation to determine the correction factor for the effect of 
pressure on the steel at the prover (CPSp) failed because the 
modulus of elasticity or wall thickness is 0 and the CPSp value is 
less than 0.5 or greater than 1.5. 

3 N/A Not used 
4 N/A Not used 
5 CPLP The calculation to determine the correction factor for the effect of 

pressure on the liquid at the prover (CPLp) failed because of low 
density.  

6 CPLM The calculation to determine the correction factor for the effect of 
pressure on the liquid at the meter (CPLm) failed because of low 
density 

7 N/A Not used 
8 CTLP The calculation to determine the correction factor of the effect of 

temperature on the liquid at the prover (CTLp) failed because of low 
density.  

9 CTLM The calculation to determine the correction factor of the effect of 
temperature on the liquid at the meter (CTLm) because of low 
density  

10 PRV VOL The calculation to determine the gross standard volume of the prover 
(GSVp) failed because no error checks occurred.  

11 MCF The calculation to determine the meter correction factor (MCF) failed 
because the CTLm or CPLm values are less than or equal to 0.  

12 K-FACTOR K-factor calculation is outside the low/high alarm limits 
13 METER FACTOR Meter factor calculation is outside the low/high alarm limits 
14 PRV MASS Prover mass calculation failed because the prover gross volume or 

density is less than or equal to 0 
15 MTR MASS Mass K- factor calculation failed because the pulses or prover mass 
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Value Display Description 
is less than or equal to 0 

16 IND MTR VOL Calculation to determine the indicated volume at the meter (IVm) 
failed because pulses or base K-factor is less than or equal to 0  

B.1.8 Prove/Stream Data 
The prover computer reads the following data from the stream under 
prove: 

 Stream Temperature (in use) 
 Stream Pressure (in use) 
 Stream Standard Density (in use) 
 Alpha Constant K0 
 Alpha Constant K1 
 Alpha Constant K2 
 Equilibrium Vapour Pressure 
 Meter Factor (in use) 
 K-factor (in use) 
 CTSm (in use) 
 CPSm (in use) 
 Flowrate Minimum 
 Flowrate Maximum 
 FCV Setpoint 
 FCV Output 
 Reference Temperature 
 Meter Density (in use) 
 FCV Auto/Manual Status 
 FCV Tracking Status 
 Volume Correction Rounding Status 
 Volume Correction Units Selection 
 Volume Correction Product Type 
 Volume Correction CPL Option 
 Volume Correction Product Subtype 
 Volume Correction Density Type 
 K-factor Units  
 Normal Meter Flow Rate  
 Initial Base Meter Factor  
 Initial Base Meter Factor Time Stamp  
 Base Meter Factor Linearisation Points 
 Historical Meter Factors 
 Historical Meter Factors Time Stamp  
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If the prove completes successfully, the system transfers the following 
prove data to the stream but does not use it until you accept the data at 
the stream. 

 Proved K-factor 
 Proved Meter Factor 
 Proved Turbine Frequency 
 Proved Flowrate 
 Proved Meter Temperature 
 Proved Meter Pressure  
 Historical Meter Factors  
 Historical Meter Factors Time Stamp 
 Proved Meter Factor Acceptance Flag  

B.1.9 Prove Reports 
The system provides two reports, volume or mass K-factor. Which 
report generates is determined by the K-factor units, pulses/volume, or 
pulses/mass.  

Following are two customized proof reports: 
 
============================================================================================= 
    1                              METER PROOF REPORT                    06/08/2013  09:58:40 
============================================================================================= 
 
STREAM ON PROOF    : 0 
PROVING RATE :  0.000 m3/h 
 
STANDARD DENSITY :  0.000 kg/m3 
BASE VOLUME :  0.000 m3 
STREAM TEMPERATURE :  0.000 Deg.C STREAM PRESSURE : 0.000 barg 
PROVER TEMP :  0.000 Deg.C PROVER PRESS : 0.000 barg 
 
 STREAM PROVER STANDARD METER  
TRIAL 
NO. 

TEMP 
(Deg.C) 

PRESSURE 
(barg) 

TEMP 
(Deg.C) 

PRESSURE 
(barg) 

DENSITY 
(kg/m3) 

PULSES 
(      ) 

FLOWRATE 
(m3/h) 

K-FACTOR 
(pls/m3) 
 

1 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
2 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
3 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
4 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
5 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
6 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
7 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
8 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
9 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
10 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
11 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
12 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
AVE 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
 
 CTLM CPLM CTSP CPSP CTLP CPLP FTIME 
1 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
2 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
3 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
4 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
5 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
6 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
7 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
8 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
9 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
10 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
11 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
12 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
AVE 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
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CURRENT K-FACTOR : 0.00  pls/m3 
NEW K-FACTOR : 0.00  pls/m3 
NEW METER FACTOR :    0.000000 
REPEATABILITY :    0.000000  % 
 
============================================================================================= 
============================================================================================= 
  ============================================================================================= 
 2                              PROVING REPORT                     
                            Emerson Process Management 
============================================================================================= 
  
LOCATION :  AAAAAAA                            DATE/TIME : MM/DD/YYYY HH:MM:SS 
  
METER MANUFACTURER:    AAAAAAA               PROVER MANUFACTURER:  AAAAAAA         
METER MODEL:           AAAAAAA               PROVER SERIAL NUMBER: AAAAAAA      
METER SERIAL NUMBER:   AAAAAAA                
METER SIZE (mm):       0.000            
NOMINAL K-FACTOR:      0.000          
METER TAG NUMBER:      AAAAAAA                
  
PRIMARY FLOW COMPUTER: XX:XX:XX:XX:XX:XX 
LIQUID: A CRUDE          
OBSERVED DENSITY:   0.000  kg/m3  AT 0.00 Deg.C  =  0.000   kg/m3  AT 0.000 Deg.C  
  

TRIAL 
NO. 

PULSES 
TOTAL 

TOTAL 
TIME 
S 

PRESS 
PROVER 
barg 

METER 
barg 

TEMP 
PROVER 
Deg.C 

METER 
Deg.C 

TRIAL 
M.F. MFT 

1 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
2 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
3 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
4 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
5 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
6 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
7 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
8 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
9 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
10 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
AVE 0.0  0.00 0.0  0.0  0.000 0.  0.  
        
        
  
REPEATABILITY FOR LAST   10 TRIALS = 0.000  % 
  
A. TEMP. CORRECTION FACTOR FOR LIQUID IN PROVER   (CTLp)        0.000 
B. PRESS. CORRECTION FACTOR FOR LIQUID IN PROVER  (CPLp)        0.000 
C. COMBINED CORRECTION FACTOR FOR PROVER          (CCFp)        0.000 
D. GROSS STANDARD VOLUME FOR PROVER               (GSVp)        0.000 Sm3    
E. INDICATED METER VOLUME                         (IVm)         0.000 m3     
F. TEMP. CORRECTION FACTOR FOR LIQUID IN METER    (CTLm)        0.000 
G. PRESS. CORRECTION FACTOR FOR LIQUID IN METER   (CPLm)        0.000 
H. COMBINED CORRECTION FACTOR FOR METER           (CCFm)        0.000 
I. GROSS STANDARD VOLUME FOR METER                (GSVm)        0.000 Sm3    
J. AVG. METER FLOW RATE                                         0.000 m3/h   
K. METER FACTOR @ PROVING FLOW RATE                             0.000 
L. METER FACTOR @ NORMAL METER FLOW RATE OF  0.000 m3/h 0.000 
   METER FACTOR TEST RESULTS (%): 1) 0.00   2) 0.00             
M. PROVER MASS                                                  0.000 tonne  
N. METER MASS                                                   0.000 tonne  
  
   HISTORICAL DATA OF METER FACTORS @ NORMAL METER FLOW RATE OF  0.000 m3/h   
   INITIAL BASE METER FACTOR (DATE:  MM/DD/YY) = 0.000    
  
 DATE:          MM/DD/YY    MM/DD/YY     MM/DD/YY     MM/DD/YY      MM/DD/YY 
 FACTOR:        0.000       0.000        0.000        0.000         0.000  
 DEVIATION(±):  0.00%       0.00%        0.00%        0.00%         0.00% 
  
 DATE:          MM/DD/YY    MM/DD/YY     MM/DD/YY     MM/DD/YY      MM/DD/YY 
 FACTOR:        0.000       0.000        0.000        0.000         0.000  
 DEVIATION(±):  0.00%       0.00%        0.00%        0.00%         0.00% 
  
PROVED FOR: ______________________ BY : _____________________ DATE: ____________ 
  
WITNESSED BY : ______________________________________________ DATE: ____________ 
  
============================================================================================= 
========================================================================================== 
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B.1.10 Proving Calculations 
This section provides information on calculations used in the prove 
procedure.  

The calculations are for volume or mass K-factor and the choice is 
determined by the K-factor units, pulses/volume or pulses/mass.   

Average Method The "average method" option directs how the system performs the 
final averaging:  

 The Meter Factor option calculates a meter factor for each run and 
takes the average of these to arrive at the final meter factor. 

 The K-factor option calculates a K-factor for each run and takes the 
average of these to arrive at the final K-factor.  

 The Pulses option takes the average of the pulses, temperature, 
pressure, and other variables and performs a final set of 
calculations using this average data to arrive at the final meter and 
K-factor. 

The Meter Factor and K-factor options are equivalent to the ‘average 
meter factor’ method used for API Ch.12 Section 2 Part 3 Proving 
reports. The Pulses option is equivalent to the ‘average data’ method.  

Standard References The prover volume correction calculations correspond to those used by 
the meter under prove, in which the system transfers the calculation 
steering variables from the stream.  
Name Standard Reference 
Averaging Calcs General mathematic principles 
Stability Calcs General mathematic principles 
Correction Factor (CTLm/CTLp) Corresponds to meter calculations 
Correction Factor (CPLm/CPLp) Corresponds to meter calculations 
Correction Factor (CTSp/CPSp) API Ch 12 
K-factor/Flowrate API Ch 12 
K-factor Deviation API Ch 4  
K-factor Deviatoin Statistical 
Method 

NORSOK I-105 Annex F 

Meter Factor API Ch 12 

B.1.10.1 Formulae: Averaging Calculations  
Run Average Data 

Samples
XinstX ∑ = run  

where: 

Xrun is the average value of the variable for a single run  
Xinst is the instantaneous sample value of the variable being 

averaged 
Samples is the number of samples taken during the run 
 
The sampled variables (Xinst) are: 
 Prover temperature (average of inlet and outlet)  
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 Prover pressure (average of inlet and outlet)  
 Meter temperature  
 Meter pressure  
 Standard density 
 

Run Average Frequency (Hz)  

t
PCFRE
∆

 = Qrun  

where: 

FREQrun  is the average meter frequency for a single run  
PC is the run pulse count 
∆t is the run flight time (secs) 
 

Final Average Data (Over Consecutive Good Runs)  

N
X

X ∑ run
final  =  

where: 
Xfinal the final average value of a relevant variable for the N 

consecutive good runs 
Xrun the value of the variable for a single run 
N  the number of consecutive good runs 
 
The final average variables are: 
 Pulse count  
 Flight time 
 Prover temperature (average of inlet and outlet)  
 Prover pressure (average of inlet and outlet)  
 Meter temperature  
 Meter pressure 
 Vapour pressure  
 Standard density 
 Prover density 
 Meter density 
 Meter frequency 
 Prover flowrate 
 Alpha 
 Prover beta 
 Meter beta 
 CTSm 
 CPSm 
 CTLm 
 CPLm 
 CTSp 
 CPSp 
 CTLp 
 CPLp 
 Prover standard volume 
 Prover mass 
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 Meter mass 
 K-factor 
 Meter factor 

B.1.10.2 Formulae: Stability Calculations 
Stream/Prover Discrepancy Checks  

Xdiff  = XA - XB 
where: 

XA, XB are the variables being compared 
 
The variables compared are: 
 Prover Inlet - Prover Outlet (Temperature and Pressure) 
 Prover Inlet - Meter (Temperature and Pressure) 
 Prover Outlet - Meter (Temperature and Pressure) 

Variable Rate of Change 

Period
 -   XXX oldnew

rate =  

where: 

 
Xrate  the rate of the variable 
Xnew  the new sample value 
Xold the previous sample value 
Period the sampling interval 
 
The variables compared are: 
 Prover Inlet (Temperature and Pressure) 
 Prover Outlet (Temperature and Pressure) 
 Meter Flowrate 

B.1.10.3 Formulae: Correction Factor (CTLm/CTLp) 
Correction Factor for the Effect of Temperature on the Liquid  

These factors are calculated according to the product, using the same 
calculations as the meter under prove. 

B.1.10.4 Formulae: Correction Factor (CPLm/CPLp) 
Correction Factor for the Effect of Pressure on the Liquid  

These factors are calculated according to the product, using the same 
calculations as the meter under prove. 

B.1.10.5 Formulae: Correction Factor (CTSp/CPSp) 
Correction Factor for the Effect of Temperature on the Prover 
Steel 

CTSp = 1 + [(T – Tb) Gc] 

where: 
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Gc Mean coefficient of cubical expansion per degree 
temperature of the material of which the container is made 
between Tb  and T. 

Tb Base temperature. 
T Average liquid temperature in the container. 
 

Correction Factor for the Effect of Pressure on the Prover Steel 
CPSp = 1 + (Pp − Pb) D/Et 

where: 
Pp  Pressure of the liquid at the prover (barg) 
Pb  Base Pressure (barg) 
D Inside diameter of the flow tube (mm) 
E Modulus of elasticity of the flow tube steel (bar) 
t Wall thickness of the prover flow tube (mm) 

Note: The average Tp, Pp over the run is used for calculating the 
correction factors. 

B.1.10.6 Formulae: Volume Prover Calculations 

Prover Gross Standard Volume (Sm3)  

runrunrunrunrun CPSpCTSpCPLpCTLpBV = GSVp ××××  

where: 

BV is the entered volume for the prover at standard conditions 

CTLprun  is the correction factor for the effect of temperature on the 
liquid at the prover, using the average prover run 
temperature 

CPLprun  is the correction factor for the effect of pressure on the 
liquid at the prover, using the average prover run pressure 

CTSprun  is the correction factor for the effect of temperature on the 
steel at the prover, using the average prover run temperature 

CPSprun  is the correction factor for the effect of pressure on the steel 
at the prover, using the average prover run pressure 

Meter Indicated Volume (m3)  

 KFm
PC = IVm

run

run
run  

where: 

PCrun is the run pulse count (pls) 

KFm is the meter K-factor (pls/m3) 
 

Meter Indicated Standard Volume (Sm3)  



Config600 Configuration Software User Manual 

B-38 Proving Revised January 2023 

runrunrunrun CPLmCTLmIVm = ISVm ××  

where: 
IVmrun is the indicated volume for the meter 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

Volume K-factor (pls/m3)  

 
GSVp

CPLmCTLmPC = KFm
run

runrunrun
run

××  

where: 
PCrun is the run pulse count (pls) 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

GSVprun is the prover gross standard volume (m3) 

Meter Factor  

 ISVm
GSVp = MF

run

run  

where: 

GSVprun is the prover gross standard volume (m3) 

ISVmrun is the meter indicated standard volume (m3) 
 

Prover Volume Flowrate (m3/h)  

3600
CPLmCTLmt

GSVp = VFRp
runrun

run
run ×

××∆
 

where: 

GSVp is the prover gross standard volume (m3) 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

∆t is the run flight time (s) 

B.1.10.7 Formulae: Mass Prover Calculations 

Prover Gross Volume (m3)  
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runrunrun CPSpCTSpBV = GVp ××  

where: 
BV is the entered volume for the prover at standard conditions 

CTSprun  is the correction factor for the effect of temperature on the 
steel at the prover, using the average prover run temperature 

CPSprun  is the correction factor for the effect of pressure on the steel 
at the prover, using the average prover run pressure 

Prover Mass (kg)  
DensityGVp = Mp runrun ×  

where: 

GVprun is the prover gross volume (m3) 

Density is the density at prover conditions (kg/m3) 
Meter Mass (kg)  

run

run
run KFm

PC = Mm  

where: 
PCrun is the run pulse count (pls) 

KFmrun is the meter K-factor (pls/kg) 

Meter Factor  

 Mm
Mp = MF

run

run  

where: 

Mprun is the prover mass (kg) 
Mmrun is the meter mass (kg) 
 

Mass K-factor (pls/kg)  

 Mp
PC = KFm

run

run
run  

where: 

PCrun is the run pulse count (pls) 

Mprun is the prover mass (kg) 

Prover Mass Flowrate (kg/h)  

3600
t

Mp = MFRp run
run ×

∆
 

where: 
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Mprun is the mass for the master meter (kg) 

∆t is the run flight time (s) 

B.1.10.8 K-factor Deviation 
When the required number of consecutive good runs has been 
achieved, the program checks each individual run (which make up the 
N consecutive good runs) to see how far it deviates from the average. If 
any run’s K-factor deviates by more than the allowable limit then 
additional runs are performed and the test is repeated.  

When all the required run K-factors fall within the deviation limit, then 
the prove is considered successful and Final average data is calculated. 
At the same time the program stores the single maximum deviation 
value (repeatability) of the good run K-factors as an indication of how 
well the prove fell within the deviation tolerance. 

API Ch.4 Method 1 (default)  
( )

100  
K

K - K
 = K ×

avg

runavg
dev  

MX-MN/AVG  
( ) 100  

K
K - K = K minmax ×

avg
dev  

MX-MN/MX+MN2  
( )

( ) 100  
2K  K

K - K = K
minmax

minmax ×
÷+dev  

MX-MN/MN  
( ) 100  

K
K - K = K

min

minmax ×dev  

MX-MN/MX*MN  
( )
( ) 100  

K  K
K - K = K

minmax

minmax ×
×dev  

MX-AV/AV  
( )

100  
K

K - K
 = K max ×

avg

avg
dev  

AV-MN/AV  
( )

100  
K

K - K
 = K min ×

avg

avg
dev  

where: 
 
Kdev  is the K-factor deviation (%) 

Kavg is the average K-factor of N consecutive good runs (pls/m3) 
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Kmin is the minimum K-factor of N consecutive good runs (pls/m3) 

Kmax is the maximum K-factor of N consecutive good runs (pls/m3) 

Krun is the run K-factor being checked (pls/m3) 

 
Statistical  

N
S

avg

N
dev ×

−

K
 x  x t200 = K 1

1-N  

where: 
 
Kdev  is the K-factor deviation (%) 

Kavg is the average K-factor of N consecutive good runs (pls/m3) 
tN-1 is the uncertainty band confidence level, which is a selectable 

value (95%, 99%, 99.5%, or a user-defined value). NORSOK 
requires this method (using the student-t distribution) at a 
recommended value of 95%. API MPMS Ch.4.8 also 
recommends 95%.  

SN-1 is the standard deviation of K-factor of N consecutive good 
runs (pls/m3) 

B.1.10.9 Meter Factor Deviation Tests  
This section defines the Meter Factor Deviation tests.  

Calculated Meter Factor versus Initial Base Meter Factor)  
 

% Deviation Test 1 =  (MFCPFRN – Initial Base Meter Factor) X 100 (Initial Based Meter Factor) 

where: 
MFCPFRN is the calculated meter factor from current prove at normal 
flow rate. 
Maximum deviation of ± 0.25 %. 

Calculated Meter Factor versus Average of Previous Historical 
Meter Factors)  

 

% Deviation Test 2 =  
(MFCPFRN – Average of Previous Meter 

Factors) X 100 
(Average of Previous Meter Factors) 

where: 
MFCPFRN is the calculated meter factor from current prove at normal 
flow rate. 
Maximum deviation of ± 0.1 %. 
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B.2 Compact Prover – Liquid Only 
Two components enable you to control the prove:  

 Prove sequence, a station-based function which sets up the prove 
environment, and  

 Run control, a prover-based function which drives the prover 
hardware, counts pulses, and performs the K-factor calculations. 

Following a successful prove, the system verifies the stream normal 
flow rate value:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount of 
time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations. 

If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved, but does not use the data until it is accepted either locally 
at the S600+ or via a supervisory computer. 

When the prove runs complete, you can either re-run the prove or 
terminate, at which point (if so configured) the sequence restores the 
valves to their pre-prove state. 

The compact prover has a small volume chamber so a proof run 
consists of repeated proof passes (a default of 5, a maximum of 39). 
The S600+ does not create a proof report, although you can add this 
option through a user stage. Contact Technical Support.  

Notes:  
 The prove sequence downloads both a K-factor and a meter factor. 

Applications typically use the original K-factor from the meter 
calibration report and update the meter factor, which may be a 
fixed value or derived from a linearisation process. Alternatively, 
the meter factor can remain unchanged and the K-factor (fixed or 
linearised) updated. 

 The meter factor deviation tests and the historical meter factor 
database are only supported for "local" streams (part of the same 
configuration with the prover), if you configure the stream normal 
flow rate to a value greater than zero and you select "Product Table 
with History" when you create your configuration. 

 You define a ticket as Official or Unofficial when you configure a 
prove. This selection applies to both the Aramco-style and non-
Aramco-style linearisation. 

Following an Official prove, the prove sequence is determined by 
the Aramco / non-Aramco style linearisation selection. 
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Following the Unofficial prove, the prove sequence does not 
download the prove results to the stream being proved. This is 
typically used to determine an approximate K-Factor / Meter 
Factor before an official prove takes place or when maintenance 
activities are being performed on the site.  

 The Official/Unofficial selection displays in the report header. 

B.2.1 Inputs/Outputs  
For compact proving, the S600+ requires the following hardware:   

 A CPU module (P152+) 

 An I/O module (P144) 

 A Prover module (P154) 
 

Inputs A compact prover normally has the following inputs:  

Prover Inlet Pressure 4-20mA ADC 
Prover Outlet Pressure 4-20mA ADC 
Prover Plenum Pressure 4-20mA ADC 
Prover Inlet Temperature 4-wire PRT 
Prover Outlet Temperature 4-wire PRT 
Stream Raw Pulses Raw Pulse Input  
Prove Enable Status Digital Input 
Prover Ready (Upstream) Status Digital Input 
Piston Detector Switch Switch Input 1 
 

Note: If there is only one pressure and temperature input, assign inlet 
and outlet objects to use the same input. 

 
Outputs A compact prover normally has the following outputs:  

Hydraulics On/Off Digital Output 
Prove Launch (Run) Command Digital Output 
Plenum Charge Digital Output 
Plenum Vent Digital Output 
 
You can regulate plenum pressure to lie within boundary limits by 
means of two digital outputs – a charge and vent system. The control 
logic is described in the Run Control stages. 

B.2.2 Communications 
Using the Modbus protocol, a slave link provides communications with 
any remote stream flow computers.  

 To set up the link at the prover (which is the master), select 
Tech/Engineer > Communications > Assignment > Prover 
Master Lin > Seq Enable.  
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 To set up the Modbus address, select Tech/Engineer > 
Communications > Assignment > Prover Master Lin > Seq 
Addr.  

 
Prover/Stream Link Default Setting 
Modbus RTU Master 
Prover/Stream Link 
 

Serial RS485 - Comm 5  
9600 
8 bits 
No Parity  
1 stop bit  
Address = 1 (front panel)  

 
 To set up the link at the stream (which is the slave), select 

Tech/Engineer > Communications > Assignment > Next > 
Prover Slave Lin.   

Note: You can reset the ports, baud rate, number of bits, and parity 
values through the S600+’s front panel.  

B.2.3 Pulse Measurement  
The primary function of the prover is to calculate an accurate K-factor 
value for the meter under prove. The compact prover does this by 
counting the number of pulses from the stream meter and equating 
them to the known volume of the prover. 
The stream flow computer receives pulses from its meter and transmits 
a pulse train output (‘Raw Pulse Output’) which represents the number 
of pulses received, including bad pulse correction. The prove sequence 
commands the selected stream to turn on its Raw Pulse Output, which 
allows the prover computer to monitor the pulses from the meter. The 
prover counts pulses during a proof run, and corrects the count for 
temperature and pressure. 

When the proof run completes, the prover calculates the stream’s K-
factor from the corrected pulse count and the known prover volume. 

Note: The electrical diagram for the Prover module shows a Raw 
Pulse Output, but this is not available. You cannot use this Raw 
Pulse Output to pass pulses input to the Prover module to the 
Raw Pulse Input.  

Pulse Gating When a proof pass is launched the flow drives a piston forward 
through the chamber, triggering a detector switch twice as it goes.  
Hydraulic pressure is then used to reverse the piston through the 
chamber ready for the next pass to commence.  

For each pass the raw pulses are counted during the period between the 
detector switch triggers as the piston moves forward through the 
chamber.  

Pulse Interpolation  Pulse interpolation is used when the pulse count is low (typically less 
than 10,000 pulses per run).  
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The S600+ support two methods of pulse interpolation: dual 
chronometry (the standard) or a pulse interpolation module (optional). 
Either method allows the prover computer to resolve the pulse count to 
better than the API recommendation of 1 part in 10,000. 

Dual chronometry adds accurate timing of the period between 
detectors so in effect partial pulses can be counted. 

If you do not select dual chronometry, you can use a Pulse 
Interpolation Module (PIM) to achieve greater resolution. You enter an 
interpolation factor corresponding to the PIM setting into the prover 
S600+ using a keypad.  
A pulse lock lost digital input is provided to indicate whether the PIM 
pulses are valid. The input is active when the PIM output is considered 
good. 

B.2.4 Proving Control Signal Timing  
Figure B-7 is a timing diagram showing the sequence of relevant 
signals during the initial pass of a proof run. Table B-13 describes each 
stage of the diagram.  

t1 t3 t4 t5 t6 t7 t8 t9 t10t2

Enable Hydraulics
(S600 O/P)

Launch Command
(Hydraulic Solenoid)
(S600 O/P)

Prove Ready
Detector)
(S600 I/P)

Piston
Detector
(S600 I/P)

t11

 

Figure B-7. Initial Pass of Proof Run Timing 

Table B-13. Proof Run Signals 

Pass Description 
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Pass Description 
t1 At the start of a prove cycle there is no hydraulic pressure (the 

hydraulic pump is switched off) so if there is flow the piston is 
stationary downstream. The Enable Hydraulics signal (an 
S600+ digital output) is switched to start the hydraulic pumps. 
The Hydraulic Solenoid signal (an S600+ digital output) is high, 
closing the associated solenoid valve and returning the piston 
returns upstream due to the increased hydraulic pressure. 

t2 The piston returns upstream and is held there by the hydraulic 
pressure. When the piston is upstream the upstream detector 
triggers, switching the associated Upstream Detector signal (an 
S600+ digital input) to high. 

t3 A user-configurable time after t1 (providing that the Upstream 
Detector signal is switched to high), the piston launches, 
switching the Hydraulic Solenoid signal to low and opening the 
solenoid valve which reduces the hydraulic pressure. The 
Hydraulic Solenoid signal remains low until the Volume 
Detector switch has been triggered a second time. 

t4 As the piston moves down the chamber it is no longer 
upstream and the Upstream Detector signal switches to low. 

t5 The f irst volume piston detector switch triggers and the Volume 
Piston Detector signal (an S600+ digital input) produces a 
pulse, switching from high to low and back to high again. 

t6 The second volume piston detector switch triggers and the 
Volume Piston Detector signal produces a second pulse, 
switching from high to low and back to high again. 

t7 When it detects the second Volume Piston Detector signal 
pulse, the Hydraulic Solenoid signal switches to low to close 
the solenoid valve. This increases the hydraulic pressure and 
returns the piston upstream. 

t8 The returning piston triggers the second volume piston detector 
switch, generating a third pulse on the Volume Piston Detector 
signal.  
Note: The piston moving down the chamber slowly (switching 
the Hydraulic Solenoid signal low on detection of the second 
Volume Piston Detector signal) could result in the piston 
starting to return prior to having fully cleared the second 
volume chamber detector switch. In that case, the two pulses 
which commenced at passes t6 and t8 may form a single pulse 
of  longer duration. 

t9 The f irst Volume Piston Detector switch triggers on the return of 
the piston, generating a fourth pulse on the Volume Piston 
Detector signal. 

t10 The piston returns upstream and is held there by hydraulic 
pressure. When the piston is upstream the upstream detector 
triggers and switches the associated Upstream Detector signal 
to high. 

t11 The piston launches for the second pass, switching the 
Hydraulic Solenoid signal to low, which opens the solenoid 
valve and reduces the hydraulic pressure.  
The prove cycle continues for the required number of passes.  
When the prove cycle completes the Enable Hydraulics 
switches to high to stop the hydraulic pumps. 

B.2.5 Prove Sequence and Control  
Two components enable you to control the prove:   
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 Prove sequence, a station-based function which sets up the prove 
environment, and  

 Run control, a prover-based function which drives the hardware, 
counts pulses, and performs the K-factor calculations. 

The S600+’s front panel display provides the following commands you 
can use to control and monitor the two prove control tasks (Operator 
> Station > Sequence Ctl):  

Display  Description 
SEQ CTL  Operator commands for sequence control (outer loop).  
SEQ STREAM NO.  Enter the designate stream number to be proved.  

Note: For local streams, this is the logical stream number. 
For remote streams, this is the slave number in the 
Modbus master map. For example, if the first slave 
has a Modbus address of 22, this is stream 1. If  the 
second slave in the master map has an address of 
33, this is stream 2.  

SEQ STAGE INDEX  Shows current sequence stage as the sequence progresses. 
SEQ STAGE PREV Indicates the sequence stage immediately prior to the current 

stage. If an abort occurs, use this value to help identify the 
source of the abort.  

SEQ ABORT INDEX  In the event of a sequence error, an abort reason index 
displays here. 

RUN CTL  Operator commands for proof run (inner loop) 
Run permit Interlock required for starting proof run. 
Run stage index Shows current proof run stage as the sequence progresses. 
Run abort index In the event of a proof run sequence error, an abort reason 

index displays here. 
 

Following a successful prove, the system verifies the stream normal 
flow rate value:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount of 
time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations.  

 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved, but does not use the data until it is accepted either locally 
at the S600+ or via a supervisory computer. 

You then have two options for accepting the prove results: 

 If you select ACCEPT, the currently running batch is retroactively 
adjusted with the new factor. 

 If you select ACCEPT NO ADJUST, no adjustment is performed 
on the currently running batch. 
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B.2.5.1 Default Prove Sequence Stages  
The prover sequence functions in stages. Table B-14 shows the default 
stages for a typical application’s normal, reprove, and abort situations.  

If an abort occurs either automatically or by operator command then 
the prove sequence stage changes to Aborted. No further action is 
taken until the computer receives either a Continue command to 
initiate a re-prove or a Terminate command to finish the sequence. 

Table B-14. Default Prove Sequence Stages 

Stage Display Description 
0 IDLE Halted: idle, await Start command 
1 INITIALISE Initialise 
2 PULSES ON Turn proving stream pulses on 
41 ENABLE HYDRAULICS Enable piston hydraulics (execute Run Control stages) 
16 PRV FLOW/T/P STAB Hold stable temperature, pressure and flowrate 
18 PROOF RUN Perform proof runs (execute Run Control stages) 
19 KF DOWNLOAD K-factor and data download 
20 AWAIT REPROVE Halted: prove runs complete, await Continue/Terminate 

command 
26 ABORTED STAGE Halted: sequence aborted, await Continue/Terminate 

command 
   
Continue (Reprove) 

29 RE STAB CHECKS Hold stable temperature, pressure and flowrate 
18 PROOF RUN Perform proof runs (execute Run Control stages) 

   
Terminate 

25 PS PULSES OFF Turn proving stream raw pulses off 
30 TERMINATE Terminate (return to idle) 

B.2.5.2 Complete Sequence Stage Descriptions 
Table B-15 shows all the stages of a prove sequence.  

Table B-15. Complete Prove Sequence Stages 
Stage Title Description 

0 Idle Wait for a command to start the sequence, then proceed to stage 1 
(Validate and Initialise). 
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Stage Title Description 
1 Validate + 

Initialise 
Verify:  
 The proving stream is flowing. 
 The proving stream is not in maintenance mode.  
 Telemetry to the proving stream is OK.  
 The prove permit state (run control status) is OK. 
Initialise:  
 Copy the proving stream meter variables into the proving set.  
 Copy the product stream product data into the proving set. 
 Initialise proof run date (via Initialise command to run control 

task).  
 Determine required proof flowrate from current rate (snapshot) or 

preset f lowrate.  
 Save all FCV settings. 
Proceed to stage 2 (Pulses On). 

2 Pulses On Command all online streams to turn pulses off  
Command proving stream to turn pulses on 
Wait for pulses to be aligned   
Proceed to stage 3 (Prover FCV Initialise)  
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails.  
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 

3 Prover FCV 
initialise 

Set prover FCV manual output to initial output 
Set prover FCV mode to manual 
Set proving stream FCV tracking on 
Set proving stream FCV mode to manual 
Proceed to stage 4 (Open prover outlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 

4 Prover open 
outlet 

Command Prover Outlet Valve to open 
Wait for valve to reach position 
Proceed to stage 5 (Non-proving stream close prover inlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 
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Stage Title Description 
5 Non-proving 

stream close 
prover inlet 

Command non-proving streams Prover Inlet Valves to close 
Wait for valves to reach position 
Proceed to stage 6 (Proving stream open prover inlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

6 Proving 
stream open 
prover inlet 

Command proving streams Prover Inlet Valve to open 
Wait for valve to reach position 
Proceed to stage 7 (Proving stream close stream outlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

7 Proving 
stream close 
stream outlet 

Command proving streams Outlet Valve to close 
Wait for valve to reach position 
Proceed to stage 41 (Enable Hydraulics) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

8 Not used  
9 Non-proving 

stream FCVS 
track 

Set FCV for non-proving streams to tracking 
Proceed to stage 10 (Non-proving stream flow balance) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
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Stage Title Description 
10 Non-proving 

stream flow 
balance 

Enable f low balancing for non-proving streams 
Flow error = proving stream flowrate - (selected proof flowrate + 
of fset). 
If  the error is too low then: 
 If  there are no on-line streams then go to abort stage. 
 Turn down value = abs (error / no. of on line none proving 

streams). 
 For each on line proving stream, new setpoint = current rate - turn 

down.  
If  all new set points (for each stream) are within the low flow range 
then download the new set points and delay for adjustment prior to 
rechecking the flow error. 
If  any new set point is less than the low flow range then go to stage 12 
(operator close) 
If  the error is too high then: 
 If  there are no on-line streams then go to abort stage. 
 Turn up value = error / no. of on line none proving streams. 
 For each on line proving stream, new setpoint = current rate + 

turn up.  
If  all new set points (for each stream) are within the high flow range 
then download the new set points and delay for adjustment prior to 
rechecking the flow error. 
If  any new set point is higher than the low flow range then go to stage 
13 (operator open). 
Proceed to stage 14 if the error is within tolerance (Non-proving 
stream FCV manual). 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 

11 Not used  
12 Close 

suspend 
Flow balancing – wait for operator to close stream 
Return to f low balancing stage 10 if continue command issued 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 
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Stage Title Description 
13 Open 

suspend 
Flow balancing – wait for operator to open stream 
Return to f low balancing stage 10 if continue command issued 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 

14 Non-proving 
stream FCVS 
manual 

Set all non-proving stream FCV tracking on 
Set all non-proving stream FCV mode to manual 
Proceed to stage 15 (Prover flowrate stability) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

15 Prover 
flowrate 
stability 

Set prover FCV to selected prove flow rate + offset 
Set prover FCV mode to auto 
Set prover FCV tracking to on 
Hold proving stream flow rate within tolerance for a user configurable 
time 
Proceed to stage 16 (Temperature / Pressure Stability) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  stability not achieved. 
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Stage Title Description 
16 Synchronise 

with Run 
Control 
(Temperature 
/ pressure 
stability) 

Hold stability for a user-configurable time 
Proceed to stage 17 (Prover FCV manual)  
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  stability not maintained. 

17 Prover FCV 
manual 

Set prover FCV tracking on 
Set prover FCV mode to manual 
Proceed to stage 18 (Proof runs) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

18 Synchronise 
with Run 
Control 
(Proof runs) 

Start the prove runs (via Start command to run control task).  
On success proceed to stage 19 (KF download)  
Abort:  
 If  a run fails (such as a timeout for a sphere switch). 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

19 K-factor 
Download 

Copy proof K-factor, meter factor, flow rate, and frequency into 
proving stream data points for subsequent telemetry download.  
Notes:  
 The stream metering calculations do not use these until 

commanded separately. 
 If  the historical meter factor option is enabled then the historical 

meter factors and deviations arrays are also copied.  
Proceed to stage 20 (Await reprove) 

20 Await reprove Go to stage 22 (Proving stream open stream outlet) if the Terminate 
or abort command is issued. 
Go to stage 29 (Stability Checks) if Continue (Reprove) command is 
issued. 

21 Not used  
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Stage Title Description 
22 Proving 

stream open 
stream outlet 

Command proving stream Outlet Valve to open 
Wait for valve to reach position 
Proceed to stage 23 (Proving stream close prover inlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  valve fails to reach position. 

23 Proving 
stream close 
prover inlet 

Command proving stream Prover Inlet Valve to close 
Wait for valve to reach position 
Proceed to stage 24 (Restore FCV) or stage 25 (Proving stream 
pulses off) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

24 Restore FCVS Reset FCV’s to previous (pre-prove) settings as noted in stage 1 
Proceed to stage 25 (Proving stream pulses off) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 

25 Proving 
stream 
pulses off 

Command proving stream to turn pulses off.  
Wait for the pulses to be turned off  
Proceed to stage 1 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 

26 Aborted 
stage 

An abort condition has occurred.  
Go to the next relevant stage if the Terminate command is issued.  
Go to stage 29 (Stability Checks) if Continue (Reprove) command is 
issued. 

27 Not used  
28 Not used  
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Stage Title Description 
29 Synchronise 

with Run 
Control 
(Stability 
checks) 

Wait to achieve stability (via Stabilise command to run control task) for 
temperatures, pressure rate of change.  
Upon achieving stability, wait for stability to be held for a user-
conf igurable time. 
Proceed to the stage 18 (Proof runs). 

30 Terminate Ensure the run control sequence terminates.  
Return to stage 1 (Idle). 

31 to 
40 

User Stages Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

41 Enable 
Hydraulics 

Command prover to turn on the compact prover piston hydraulics (via 
Enable hydraulics command to run control task) 
Proceed to stage 9 (Non-proving stream FCV track) or stage 16 
(Temperature / Pressure Stability) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 

42 User Comms 
Suspend 1 

Suspends the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

43 User Comms 
Normal 1 

Re-enables the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

44 User Comms 
Suspend 2 

Suspends the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

45 User Comms 
Normal 2 

Re-enables the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

B.2.5.3 Prove Sequence Abort Index 
Table B-16 shows the abort values for a prove sequence.  

Table B-16. Prove Sequence Abort Index 
Value Display Description 

1 OP ABORT Operator Requested Abort 
2 Not Used  
3 PS TELEM FAIL Proving Stream Telemetry Fail 
4 RUN CTL BUSY Run Control Task Busy 
5 METER NO FLOW No Flow at Meter 
6 RUN CTL ABORT Run Control Task Aborted 
7 ILLEGAL PULSES More than one stream has raw pulses enabled.  
8 ANY TELEM FAIL Non Proving Stream Telemetry Fail 
9 NPS PRV I-VLV OPEN Non Proving Stream Prover Valve Not Closed 

10 PS PRV I-VLV CLOSED Proving Stream Prover Offtake Valve Not Open 
11 PS STR O-VLV OPEN Proving Stream Outlet Valve Not Closed 
12 PRV I-VLV CLOSED Prover Inlet Valve Not Open 
13 PRV O-VLV CLOSED Prover Outlet Valve Not Open 
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Value Display Description 
14 PS IN MAINT Proving Stream Is In Maintenance Mode 
15 FBAL TIMEOUT Flow Balance Timeout 
16 FBAL NO NPS ON LINE Flow Balance Error - No Non Proving Streams On-line  
17 FBAL NO NPS IN AUTO Flow Balance Error - No Non Proving Streams In Auto 
18 FBAL HOLD FAIL Flow Balance Error - Stability Not Achieved 
19 PS I-ISL-VLV CLOSED Proving Stream Inlet Isolation Valve Not Open 
20 PS O-ISL-VLV CLOSED Proving Stream Header Isolation Valve Not Open 
21 PS P-ISL-VLV CLOSED Proving Stream Prover Isolation Valve Not Open 
22 PEER STATUS STANDBY Unit is in standby mode when peer-to-peer is configured  

 
B.2.6 Prover Run Control Stages 

The Run Control sequence is specific to the type of prover (such as a 
bi-direction or uni-directional [ball] prover, a compact prover, or a 
master meter). The Run Control sequence initiates the prove runs and 
performs the calculations that produce a K-factor and meter factor 
when the runs complete.  

Normally the sequence runs when commanded by the Prove Sequence 
at stage 18 (Perform Proof Run). However, you can initiate it from the 
S600+ front panel display or (by using custom control) from 
elsewhere.  
The Prover Run sequence below shows the default stage sequencing 
for a typical compact prove. 

Table B-17. Compact Prover Run Control Stages 

Stage Display Description 
0 IDLE Halted: idle 
1 INITIALISE Initialise run data 
2 AWAIT HYD CMD Halted: await Enable Hydraulics command 
3 WAIT READY Wait for the Ready signal (piston upstream) 
4 AWAIT STAB CMD Halted: await Stabilise command 
5 WAIT STAB Wait until stability is achieved 
7 AWAIT RUN CMD Halted: await start runs command 
8 CONTROL PLENUM Balance the plenum pressure 
9 PRE FLIGHT AVG Average tmp/prs etc prior to launch 

10 LAUNCH Issue Run command 
11 WAIT 1ST HIT Wait detector f irst hit 
12 WAIT 2ND HIT Wait detector second hit 
13 PASS CALCS Perform pass calculations 
14 RETRIEVE Return piston to upstream (if another pass go to stage 9) 
15 RUN CALCS Perform run calculations 
16 AVG CALCS Perform run average calculations 
21 STD POST RUN No action 
17 STD RPT CHECKS Perform repeatability checks (if success go to stage 19) 
20 CHECK RUNS 

EXCEEDED 
Check runs exceeded (if yes go to stage 18 else stage 8) 

19 FINAL AVG Perform final average calculations 
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Stage Display Description 
22 MF DEVIATION CHECKS Perform meter factor deviation checks.  

Note: This stage is performed only if you configure the 
meter normal f low to a value greater than zero 
(Aramco-style linearisation) and you select “Product 
Table with History” when you create your 
conf iguration. 

23 WAIT REJECT COMMAND Allow a time-out for rejecting the current prove. If  the time-
out elapses then print the proof report.  
This stage only occurs if you configure the meter normal flow 
rate to value great than zero.  
Note: This stage is performed only if you configure the 

meter normal f low to a value greater than zero 
(Aramco-style linearisation).   

24 REPORT STAGE Generates the proof report. 
18 FINAL Halted: f inal – await Terminate/Reprove command.  

 
You can also enable user stages on the PC Setup Run Data screen. 
These invoke a LogiCalc which you can edit to provide user specific 
logic as the prove progresses. Example LogiCalcs are included in the 
C:\Users\<username>\Config600 3.3\lclib\prover directory. Copy one 
of these to the C:\Users\<username>\Config600 
3.3\Configs\Project\LogiCalc directory so that you can edit it to be 
compatible with your configuration and then download it to the 
S600+ with the configuration.  

Notes: 
 You can enable user stages by editing a configuration using the 

System Editor.   
 The displays showing the detector hit only update during a prove. 

They cannot be used independently for testing the hardware.  

B.2.6.1 Run Control Stage Description 
Table B-18 shows all the stages of a Run Control sequence.  
Table B-18. Compact Run Control Stages 

Run Stage Description 
 

 
Idle 
Wait for the Initialise command to start the run control sequence. 
Proceed to next stage only if the prove is permitted (that is, the 
run control stage is ‘idle’ or ‘final’ and the available signal is 
zero). The available signal is normally assigned to a digital input 
which may be connected to a valve or a key-switch.  

1 
 

Initialise Run Data 
Zero down all run data and arrays.  
Proceed to next stage. 
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Run Stage Description 
2 Wait Prior to Enabling the Hydraulics 

Issue hardware command to enable hydraulics, then proceed to 
the next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 

3 Wait Prover Ready Signal 
Wait for the prover ready (upstream) signal to be set (indicating 
the piston is in the upstream position). 
When set, proceed to the next stage. 
Abort:  
 If  ready wait timer expires. 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 

4 Wait Prior To Stability Checks 
Wait for Stabilise command then proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued. 

5 Wait Stability 
If  stability override is selected, ignore the checks and proceed to 
the next stage. 
Set stability wait timer running. 
Continuously monitor deviations for:  
 prover inlet pressure vs. prover outlet pressure 
 meter pressure vs. prover inlet pressure 
 meter pressure vs. prover outlet pressure 
 prover inlet temperature vs. prover outlet temperature 
 meter temperature vs. prover inlet temperature 
 meter temperature vs. prover outlet temperature 

Continuously monitor (over 5-second periods) rates of change 
for: 
 prover inlet pressure 
 prover outlet pressure 
 prover inlet temperature 
 prover outlet temperature 
 meter f lowrate 

Proceed to next stage when stability is achieved. 
Abort:  
 If  stability wait timer expires, that is stability not achieved. 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued. 

6 Hold Stability 
If  stability override is selected, ignore the checks and proceed to 
the next stage. 
Set stability hold timer running. 
Check that stability is maintained for the timer period by 
repeating stability checks from stage 5. 
Proceed to next stage when stability hold timer expires. 
Abort:  
 If  any of the stability checks fail.  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued.  
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Run Stage Description 
7 Wait Prior to Starting the Runs 

Wait for the Start Runs command. 
Proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued. 

8 Control Plenum Pressure 
Set pass number = 1, increment run number. 
Set plenum timer running. 
Adjust plenum pressure if necessary. The adjustment can be 
ignored by setting the plenum timer to zero. 
 Inputs: prover pressure, plenum pressure (psig) 
 Constants: R (such as 3.5 for 8” prover), N2K (such as 60 

psig), and tolerance (such as 2 psig) 
 Formula: required pressure = prover pressure / R + N2K. 

o if  plenum pressure > (required pressure + tolerance) 
then open the vent solenoid. 

o if  plenum pressure < (required pressure - tolerance) 
then open the charge solenoid (timeout if N2 bottle 
has suspected low pressure). 

o if  plenum pressure < (required pressure + tolerance) 
and plenum pressure > (required pressure – 
tolerance) then proceed to next stage. 

 Outputs: charge solenoid and vent solenoid (digital 
outputs) 

Abort: 
 If  pressure not achieved within timeout period. 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  the Terminate command is issued.  

9 Pre-flight Average  
Average all stream and prover variables which serve as inputs 
into the calculations. 
 
Note: The system would normally sample and average data 

during the period between detector switches. However, if 
this period is very short or if the mechanical arrangement 
of  the hardware (such as a prover-mounted 
densitometer) makes the measured values unreliable, 
they can be sampled at this point instead. Trigger the 
sampling mechanism by specifying the number of 
samples (to a maximum of 3000). If  the number of 
samples is zero then proceed to the next stage. 

 
Check that stability is maintained while averaging unless stability 
override is selected. 
Abort:  
 If  number of samples is greater than 3000. 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued.  
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Run Stage Description 
10 Launch (Run) 

Reset internal prover hardware. 
Set the launch timer running. 
Set the run digital output when the hardware indicates ready. 
When the prover ready (upstream) signal clears proceed to the 
next stage. 
Abort:  
 If  ready signal doesn't clear within launch timeout period. 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued.  

11 Wait Detector 1st Hit 
Set switch timer running – uses flight timer value. 
Proceed to next stage when detects hit 1. 
Abort:  
 If  f light timer expires. 
 If  switch sequence error. 
 If  pulse lock is lost (if PIM) 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued. 

12 Wait Detector 2nd Hit 
Set f light timer running. 
Average all stream and prover variables (which serve as inputs 
into the calculations) to activate set the number of samples 
required to zero (see stage 9). 
Check stability is maintained for this period between detectors by 
repeating the stability checks from stage 5. 
Proceed to next stage when detects hit 2. 
Abort:  
 If  stability checks fail. 
 If  f light timer expires. 
 If  switch sequence error. 
 If  number of samples is greater than 3000. 
 If  pulse lock is lost (if PIM) 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  Terminate command is issued. 

13 Pass Calculations 
Run the calculations for this pass and store the results. 
Abort: 
 If  very few pulses or very short flight time. 
 If  calculations fail. 

14 Retrieve  
Clear the run digital output signal. 
Set retrieve timer running. 
Wait for the prover ready (upstream) signal. 
If  the required number of passes has been performed then go to 
stage 15. 
If  more passes are required then go to stage 9 for the next pass. 
Abort:  
 If  retrieve timer expires. 
 If  the prove is no longer permitted. 
 If  the base volume has changed. 
 If  terminate command is issued. 
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Run Stage Description 
15 Run Calculations 

Perform the end of run calculations.  
Proceed to the next stage if all the calculations are valid. 
Abort if there is a calculation failure (such as the K-factor is out of 
range).   

16 Run Average Calculations 
Average the individual run data either for the runs so far or the 
last n runs (where n is the required number of good runs) and 
store the results. 
Proceed to stage 21 (Post Run Logic). 

17 Repeatability Checks 
If  the required number of runs has not been performed, then 
proceed to stage 20.  
If  the required number of runs (n) has been performed, then 
check each of the last n run’s K-factor against the average. 
If  the K-factors are within tolerance, then proceed to final 
calculations stage 19 (Final Average Calculations). If the K-
factors are not within tolerance, proceed to stage 20 to check 
maximum runs. 

18 Wait Terminate/Reprove Command 
Wait for the operator or supervisory computer to issue the run 
control command to terminate the proof or to start a re-prove. 
If  the command is Initialise then proceed to stage 1 (Initialize Run 
Data) to start a re-prove. 
If  the command is Terminate then disable the hydraulics and 
proceed to stage 0 (Idle).  

19 Final Average Calculations 
Average the run data for the n good runs. 
Calculate the f inal K-factor and meter factor. 
Print the f inal proof report. 
Proceed to stage 22.  

20 Maximum Runs 
If  the maximum number of runs has been exceeded then 
proceed to stage 18. Otherwise, proceed to stage 8 to start the 
next run.  

21 Perform Meter Factor Deviation Checks 
Perform tolerance tests (calculated meter factor versus initial 
base meter factor: maximum deviation of 0.25% and calculated 
meter factor versus average of saved historical meter factors: 
maximum deviation of 0.1%) 
Only valid meter factors at normal flow rate are incorporated in 
the historical database. When the limits from either test exceeds 
the meter factor they are not entered in the historical database. 
Proving reports are annotated as “ABORTED” with cause of 
failure stated. 
Proceed to stage 20 if any of the tolderance tests fila.  
Proceed to next stage.  
Note: This stage is performed only if you configure the meter 

normal f low rate to a value greater than zero (Aramco-
style linearisation) and you select "Product Table with 
History" when you create your configuration.   
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Run Stage Description 
22 Await for Current Prove to be Rejected 

You can reject the current prove results within a predefined time-
out.  
Print report when timer expires.  
Abort if the prove is rejected.  
Proceed to stage 18. 
Note: This stage is performed only if you configure the meter 

normal f low to a value greater than zero (Aramco-style 
linearisation).   

23 Post Run Logic 
No action. 
Proceed to stage 17 (Repeatability Checks).   

B.2.7 Run Stage Abort Index 
Following an abort the program displays a value in the Run Control 
Abort Index display.  

Table B-19. Run Stage Abort Index 
Value Display Description 

0 NULL Not used 
1 OPERATOR Operator abort 
2 READY TIMEOUT Prover ready timeout, piston upstream signal not set 
3 SW1 TIMEOUT Switch 1 timeout (the switch was not hit within the predicted 

time).  
To resolve, check wiring; set pre-switch volume to 0; or check 
that raw pulse bus frequency is greater than 0.  

4 SW2 TIMEOUT Switch 2 timeout (the switch was not hit within the predicted 
time).  
To resolve, check wiring; set pre-switch volume to 0; or check 
that raw pulse bus frequency is greater than 0.  
Note: If  the f low computer does not see SW2, check the raw 
pulse bus.  

5 STAB WAIT Temperature/Pressure/Flowrate wait stability timeout   
6 STAB HOLD Temperature/Pressure/Flowrate hold stability timeout   
7 AVG CALC Average calculation error - number of samples exceeds 3000 
8 PASS CALC Not used 
9 FULL CALC An error occurred when performing a run calculation; see the 

Run Stage Calculation Index   
10 RUNS EXCEEDED Maximum number of runs exceeded 
11 SS ERROR Detector switch sequence error 
12 PLS LOCK LOST Pulse interpolator module lock lost 

13 IO FAIL I/O module failed to respond to prove request 
14 NULL DATA Pass calculation fail, no pulses or flight time very short. This 

can occur when noise/signal bounce affects the switch input. 
Adjust the switch delay.  

15 BVOL CHANGED Base volume changed during prove runs 
16 KF/MF RANGE K-factor or meter factor out of range, even if alarms not 

conf igured. To resolve, check the high and low limits for the 
meter factor, the K-factor, and pulse count objects. 

17 PLENUM CTL Fail to achieve in range plenum pressure timeout 
18 PLENUM CONFIG Plenum pressure config invalid 
19 LAUNCH TIMEOUT Launch timeout 
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Value Display Description 
20 RETRIEVE TIMEOUT Retrieve timeout, ready signal not set 
21 UNAVAIL Prover unavailable 
22 INV CALC Unsupported volume/mass calculations 
23 MF DEV INVALID Failed during meter factor deviation checks 

B.2.8 Run Stage Calculation Index 
The Run Stage Calculation Index shows the current prove run 
calculation. If the calculations cause an abort this value indicates 
which calculation failed.  

Table B-20. Run Stage Calculation Index 
Value Display Description 

0 IDLE No calculation errors  
1 CTSP The calculation to determine the correction factor for the effect 

of  temperature on the steel at the prover (CTSp) failed 
because the CTSP value is less than 0.5 or greater than 1.5 

2 CPSP The calculation to determine the correction factor for the effect 
of  pressure on the steel at the prover (CPSp) failed because 
the modulus of elasticity or wall thickness is 0 and the CPSp 
value is less than 0.5 or greater than 1.5 

3 CPLP The calculation to determine the  correction factor for the effect 
of  pressure on the liquid at the prover (CPLp) failed because of 
low density  

4 CPLM The calculation to determine the correction factor for the effect 
of  pressure on the liquid at the meter (CPLm) failed because of 
low density 

5 CTLP The calculation to determine the correction factor for the effect 
of  temperature on the liquid at the prover (CTLp) failed 
because of low density 

6 CTLM The calculation to determine the correction factor for the effect 
of  temperature on the liquid at the meter (CTLm) failed 
because of low density 

7 PRV SVOL/GVOL The calculation to determine the gross standard volume at the 
prover (GSVp) failed; no error checks occurred. 

8 MTR GVOL/PRV MASS The calculation to determine the indicated volume at the meter 
(IVM) failed. For gross volume, this was due either to no K-
factor or a pulse count less than 1.0. For prover mass, this was 
due to lack of a value for gross volume at the prover or a pulse 
count less than or equal to zero.  

9 MTR SVOL/MTR/MASS The calculation to determine the indicated standard voume at 
the meter (IVSM) failed because no error checks occurred, no 
K-factor was available, or the pulse count was less than 1.0  

10 K-FACTOR The calculation to determine the K-factor failed because the 
value is outside low/high alarm limits 

11 METER FACTOR The calculation to determine the Meter factor failed because 
the value is outside low/high alarm limits 

12 FLOWRATE The calculation to determine the flowrate failed because the 
CTLm or the CPLM is less than or equal to 0 

B.2.9 Prove/Stream Data 
The prover computer reads the following data from the stream under 
prove:  

 Stream Temperature (in use) 
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 Stream Pressure (in use) 
 Stream Standard Density (in use) 
 Alpha Constant K0 
 Alpha Constant K1 
 Alpha Constant K2 
 Equilibrium Vapour Pressure 
 Meter factor (in use) 
 K-factor (in use) 
 CTSm (in use) 
 CPSm (in use) 
 Flowrate Minimum 
 Flowrate Maximum 
 FCV Setpoint 
 FCV Output 
 Reference Temperature 
 Meter Density (in use) 
 FCV Auto/Manual Status 
 FCV Tracking Status 
 Volume Correction Rounding Status 
 Volume Correction Units Selection 
 Volume Correction Product Type 
 Volume Correction CPL Option 
 Volume Correction Product Subtype 
 Volume Correction Density Type 
 K-factor Units 
 Normal Meter Flow Rate  
 Initial Base Meter Factor 
 Initial Base Meter Factor Time Stamp  
 Base Meter Factor Linearisation Points  
 Historical Meter Factors 
 Historical Meter Factors Time Stamps  
 
If the prove completes successfully, the following prove data transfers 
to the stream, but is not used until you accept the data at the stream. 

 Proved K-factor 
 Proved Meter Factor 
 Proved Turbine Frequency 
 Proved Flowrate 
 Proved Meter Temperature 
 Proved Meter Pressure  
 Historical Meter Factors 
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 Historical Meter Factors Time Stamp 
 Proved Meter Factor Acceptance Flag 

B.2.10 Prove Reports 
The system provides two reports, volume or mass K-factor. Which 
report generates depends on the K-factor units, pulses/volume, or 
pulses/mass.  

Following are two customized proof reports: 
 
============================================================================================= 
    1                              METER PROOF REPORT                    06/08/2013  09:58:40 
============================================================================================= 
 
STREAM ON PROOF    : 0 
PROVING RATE :  0.000 m3/h 
 
STANDARD DENSITY :  0.000 kg/m3 
BASE VOLUME :  0.000 m3 
STREAM TEMPERATURE :  0.000 Deg.C STREAM PRESSURE : 0.000 barg 
PROVER TEMP :  0.000 Deg.C PROVER PRESS : 0.000 barg 
 
 STREAM PROVER STANDARD METER  
TRIAL 
NO. 

TEMP 
(Deg.C) 

PRESSURE 
(barg) 

TEMP 
(Deg.C) 

PRESSURE 
(barg) 

DENSITY 
(kg/m3) 

PULSES 
(      ) 

FLOWRATE 
(m3/h) 

K-FACTOR 
(pls/m3) 
 

1 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
2 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
3 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
4 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
5 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
6 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
7 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
8 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
9 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
10 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
11 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
12 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
AVE 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.0 
 
 CTLM CPLM CTSP CPSP CTLP CPLP FTIME 
1 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
2 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
3 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
4 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
5 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
6 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
7 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
8 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
9 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
10 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
11 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
12 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
AVE 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000 
 
CURRENT K-FACTOR : 0.00  pls/m3 
NEW K-FACTOR : 0.00  pls/m3 
NEW METER FACTOR :    0.000000 
REPEATABILITY :    0.000000  % 
 
============================================================================================= 
============================================================================================= 

======================================================================== 
 2                         PROVING REPORT 
                    Emerson Process Management  
                 
                  (0)OFFICIAL   (0)UNOFFICIAL   (0)ABORTED 
  
LOCATION :             AAAAAAA               DATE/TIME : MM/DD/YYYY HH:MM:SS 
  
METER MANUFACTURER:    AAAAAAA               PROVER MANUFACTURER:    AAAAAAA  
METER MODEL:           AAAAAAA               PROVER SERIAL NUMBER:   AAAAAAA 
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METER SERIAL NUMBER:   AAAAAAA   
METER SIZE (mm):       0.000            
NOMINAL K-FACTOR:      0.000          
METER TAG NUMBER:      AAAAAAA   
  
PRIMARY FLOW COMPUTER: XX:XX:XX:XX:XX:XX 
  
LIQUID: A CRUDE          
OBSERVED DENSITY:   0.000  kg/m3  AT 0.00 Deg.C  =  0.000   kg/m3  AT 0.000 Deg.C  
 

TRIAL 
NO. 

PULSES 
TOTAL 

TOTAL TIME 
S 

PRESS 
PROVER 
barg 

METER 
barg 

TEMP 
PROVER 
Deg.C 

METER 
Deg.C 

TRIAL 
M.F. MFt 

1 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
2 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
3 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
4 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
5 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
6 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
7 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
8 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
9 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
10 0.00 0.00 0.00 0.00 0.000 0.0 0.0 
AVE 0.00 0.00 0.00 0.00 0.000 0.0 0.0 

  
REPEATABILITY FOR LAST   10 TRIALS = 0.000  % 
  
A. TEMP. CORRECTION FACTOR FOR LIQUID IN PROVER   (CTLp)        0.000 
B. PRESS. CORRECTION FACTOR FOR LIQUID IN PROVER  (CPLp)        0.000 
C. COMBINED CORRECTION FACTOR FOR PROVER          (CCFp)        0.000 
D. GROSS STANDARD VOLUME FOR PROVER               (GSVp)        0.000 Sm3 
E. INDICATED METER VOLUME                         (IVm)         0.000 m3 
F. TEMP. CORRECTION FACTOR FOR LIQUID IN METER    (CTLm)        0.000 
G. PRESS. CORRECTION FACTOR FOR LIQUID IN METER   (CPLm)        0.000 
H. COMBINED CORRECTION FACTOR FOR METER           (CCFm)        0.000 
I. GROSS STANDARD VOLUME FOR METER                (GSVm)        0.000 Sm3 
J. AVG. METER FLOW RATE                                         0.000 m3/h 
K. METER FACTOR @ PROVING FLOW RATE                             0.000 
L. METER FACTOR @ NORMAL METER FLOW RATE OF  0.000 m3/h 0.000 
   METER FACTOR TEST RESULTS (%):        1) 0.00      2) 0.00             
M. PROVER MASS                                                  0.000 tonne  
N. METER MASS                                                   0.000 tonne  
  
   HISTORICAL DATA OF METER FACTORS @ NORMAL METER FLOW RATE OF  0.000 m3/h   
   INITIAL BASE METER FACTOR (DATE:  MM/DD/YY) = 0.000   
  
 DATE:          MM/DD/YY    MM/DD/YY      MM/DD/YY      MM/DD/YY      MM/DD/YY 
 FACTOR:        0.000       0.000         0.000         0.000         0.000  
 DEVIATION(±):  0.00%       0.00%         0.00%         0.00%         0.00% 
  
 DATE:          MM/DD/YY    MM/DD/YY      MM/DD/YY      MM/DD/YY      MM/DD/YY 
 FACTOR:        0.000       0.000         0.000         0.000         0.000  
 DEVIATION(±):  0.00%       0.00%         0.00%         0.00%         0.00% 
  
PROVED FOR: ______________________ BY : _____________________ DATE: ____________ 
  
WITNESSED BY : ______________________________________________ DATE: ____________ 
 
================================================================================ 

B.2.11 Proving Calculations 
This section provides information on various calculations used in the 
prove procedure.  

The calculations are for volume or mass K-factor and the choice is 
determined by the K-factor units, pulses/volume or pulses/mass.  

Average Method The “average method” option steers how the system performs the final 
averaging:  

 The Meter Factor option calculates a meter factor for each run and 
takes the average of these to arrive at the final meter factor. 
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 The K-factor option calculates a K-factor for each run and takes the 
average of these to arrive at the final K-factor.  

 The Pulses option takes the average of the pulses, temperature, 
pressure, and other variables and performs a final set of 
calculations using this average data to arrive at the final meter and 
K-factor. 

Options 1 and 2 are equivalent to the “average meter factor" method 
used for API Ch.12 Section 2 Part 3 Proving reports. Option 3 is 
equivalent to the ‘average data’ method.  

Standard References The prover volume correction calculations correspond to those used by 
the meter under prove, in which the system transfers the calculation 
steering variables from the stream.  
 
Name Standard Reference 
Averaging Calcs General mathematic principles 
Stability Calcs General mathematic principles 
Correction Factor (CTLm/CTLp) Corresponds to Meter calculations 
Correction Factor (CPLm/CPLp) Corresponds to Meter calculations 
Correction Factor (CTSp/CPSp) API Ch 12 
K-factor/Flowrate API Ch 12 
K-factor Deviation API Ch 4  
K-factor Deviation Statistical 
Method 

NORSOK I-105 Annex F 

Meter Factor API Ch 12 

B.2.11.1 Formulae: General 
At the end of a pass, the system calculates a K-factor, flowrate, and 
frequency based on the uncorrected prover base volume and samples 
the measured inputs either prior to the piston launch or whilst the 
piston is between detector hits (the default).  
The measured values are averaged for the required number of passes 
(default of five passes and a maximum of 39 passes) to provide values 
for the run calculations. (For more than 39 passes, refer to the latest 
calculation table document available – for Config600 Pro users only.) 
The run’s K-factor and flowrate are then re-calculated using the pass 
average meter pulse count (corrected to standard conditions) and the 
prover base volume (corrected to standard conditions). Final K-factor 
and flowrate are averaged run values from the required number of 
good runs (a default of five runs and a maximum of 12 runs). 

B.2.11.2 Formulae: Averaging Calculations 
Pass Average Data (Sampled during each Pass)   

Samples
X

X inst
pass

∑ =  

where: 

Xpass is the average value of the variable for a single pass 
Xinst is the instantaneous sample value of the variable being 

averaged 
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Samples is the number of samples taken during the pass 
 
The sampled variables (Xinst) are: 
 Prover temperature  
 Prover pressure 
 Meter temperature 
 Meter pressure 
 Meter vapour pressure 
 Meter standard density 
 

Pass Average Frequency (Hz)  

t
PCFREQpass ∆

 =  

where: 

FREQpass is the average meter frequency for a single pass 
PC is the pass pulse count 
∆t is the pass flight time (s) 
 

Pass Average Flowrate  

3600 = ×
∆t
BVFRpass  

where: 
FRpass is the average prover flowrate for a single pass 
BV is the prover base volume at standard conditions 
∆t is the pass flight time (s) 
 

Pass K-factor  

BV
PCKFpass  =  

where: 
KFpass is the K-factor for a single pass 
PC is the pass pulse count 
BV is the prover base volume at standard conditions 
 

Run Average Data (Over Number of Passes)  

pass

pass
run N

X
X ∑ =  

where: 

Xrun the average value of the variable for N  passes 
Xpass the value of the variable for a single pass 
Npass  the number of passes 
 
The run average variables are: 
 Pulse count 
 Flight time 
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 Prover temperature 
 Prover pressure 
 Meter temperature 
 Meter pressure 
 Meter vapour pressure 
 Meter standard density 
 Meter frequency 
 

Final Average Data (Over Consecutive Good Runs)  

run

run
final N

X
X ∑ =  

where: 

Xfinal the final average value of the variable for N consecutive 
good runs 

Xrun the value of the variable for a single run 
Nrun  the number of consecutive good runs 
 
The final average variables are: 
 Pulse count  
 Flight time 
 Prover temperature (average of inlet and outlet)  
 Prover pressure (average of inlet and outlet)  
 Meter temperature  
 Meter pressure 
 Vapour pressure  
 Standard density 
 Prover density 
 Meter density 
 Meter frequency 
 Prover flowrate 
 Alpha 
 Prover beta 
 Meter beta 
 CTSm 
 CPSm 
 CTLm 
 CPLm 
 CTSp 
 CPSp 
 CTLp 
 CPLp 
 Prover standard volume 
 Meter gross volume 
 Meter standard volume 
 Prover mass 
 Meter mass 
 K-factor 
 Meter factor 
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B.2.11.3 Formulae: Stability Calculations 
Meter/Prover Discrepancy Checks  

BAdiff XXX −=  

where: 

XA, XB are the variables being compared 
 
The variables compared are: 
 Prover temperature – Meter temperature 
 Prover pressure – Meter pressure 
 

Variable Rate of Change 

Period
XXX oldnew

rate
−

=  

where: 

Xrate  the rate of the variable 
Xnew  the new sample value 
Xold the previous sample value 
Period the sampling interval 
 
The variables compared are: 
 Meter temperature  
 Meter pressure 
 Meter flowrate 

B.2.11.4 Formulae: Correction Factor (CTLm/CTLp) 
Correction Factor for the Effect of Temperature on the Liquid  

These factors are calculated according to the product, using the same 
calculations as the meter under prove.  

B.2.11.5 Formulae: Correction Factor (CPLm/CPLp) 
Correction Factor for the Effect of Pressure on the Liquid  

These factors are calculated according to the product, using the same 
calculations as the meter under prove.  

B.2.11.6 Formulae: Correction Factor (CTSp/CPSp) 
Correction Factor for the Effect of Temperature on the Prover 
Steel 

CTSp = (1+(Tp − Tb)Y1) ×(1+(Tamb − Tb)Y2) 
where:  

Tp Temperature of the liquid at the prover (°C or °F or °K) 
Tb Base Temperature (°C or °F or °K) 
Y1 Area Thermal Coefficient of Cubic expansion of the prover 

tube (/°C or /°F or /°K dependent on temperature units 
selected) 
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Tamb Ambient Temperature (°C or °F or °K) 
Tcal Calibration Temperature of the prover (°C or °F or °K) 
Y2 Linear Thermal Coefficient of Cubic expansion of the prover 

rod (/°C or /°F or /°K dependent on temperature units 
selected) 

Correction Factor for the Effect of Pressure on the Prover Steel 
CPSp = 1 + (Pp − Pb) D/Et 

where: 

Pp  Pressure of the liquid at the prover (barg) 
Pb  Base Pressure (barg) 
D Inside diameter of the flow tube (mm) 
E Modulus of elasticity of the flow tube steel (bar) 
t Wall thickness of the prover flow tube (mm) 

Note: The average Tp, Pp over the run is used for calculating the 
correction factors. 

B.2.11.7 Formulae: Volume Prover Calculations  
Prover Gross Standard Volume (Sm3)  

runrunrunrunrun CPSpCTSpCPLpCTLpBV = GSVp ××××  

where: 

BV is the entered volume for the prover at standard conditions 

CTLprun  is the correction factor for the effect of temperature on the 
liquid at the prover, using the average prover run 
temperature 

CPLprun  is the correction factor for the effect of pressure on the 
liquid at the prover, using the average prover run pressure 

CTSprun  is the correction factor for the effect of temperature on the 
steel at the prover, using the average prover run temperature 

CPSprun  is the correction factor for the effect of pressure on the steel 
at the prover, using the average prover run pressure 

Meter Indicated Volume (m3)  

 KFm
PC = IVm

run

run
run  

where: 
PCrun is the run pulse count (pls) 

KFm is the meter K-factor (pls/m3) 
 

Meter Indicated Standard Volume (Sm3)  

runrunrunrun CPLmCTLmIVm = ISVm ××  

where: 
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IVmrun is the indicated volume for the meter 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

Volume K-factor (pls/m3)  

 
GSVp

CPLmCTLmPC = KFm
run

runrunrun
run

××  

where: 

PCrun is the run pulse count (pls) 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

GSVprun is the prover gross standard volume (m3) 

Meter Factor  

 ISVm
GSVp = MF

run

run  

where: 

GSVprun is the prover gross standard volume (m3) 

ISVmrun is the meter indicated standard volume (m3) 
 

Prover Volume Flowrate (m3/h)  

3600
CPLmCTLmt

GSVp = VFRp
runrun

run
run ×

××∆
 

where: 

GSVprun is the prover gross standard volume (m3) 
CTLmrun  is the correction factor for the effect of temperature on the 

liquid at the meter, using the average meter run temperature 
CPLmrun  is the correction factor for the effect of pressure on the 

liquid at the meter, using the average meter run pressure 

∆t is the average pass flight time (s) 

B.2.11.8 Formulae: Mass Prover Calculations 

Prover Gross Volume (m3)   

runrunrun CPSpCTSpBV = GVp ××  

where: 
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BV is the entered volume for the prover at standard conditions 

CTSprun  is the correction factor for the effect of temperature on the 
steel at the prover, using the average prover run temperature 

CPSprun  is the correction factor for the effect of pressure on the steel 
at the prover, using the average prover run pressure 

Prover Mass (kg)  
DensityGVp = Mp runrun ×  

where: 

GVprun is the prover gross volume (m3) 

Density is the density at prover conditions (kg/m3) 
 

Meter Mass (kg)  

run

run
run KFm

PC = Mm  

where: 
PCrun is the run pulse count (pls) 

KFmrun is the meter K-factor (pls/kg) 
 

Meter Factor  

 Mm
Mp = MF

run

run  

where: 

Mprun is the prover mass (kg) 

Mmrun is the meter mass (kg) 
 

Mass K-factor (pls/kg)  

 Mp
PC = KFm

run

run
run  

where: 
PCrun is the run pulse count (pls) 

Mprun is the prover mass (kg) 

 
Prover Mass Flowrate (kg/h)  

3600
t

Mp = MFRp run
run ×

∆
 

where: 

Mprun is the mass for the master meter (kg) 

∆t is the average pass flight time (s) 
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B.2.11.9 K-factor Deviation 
When the required number of consecutive good runs has been 
achieved, the program checks each individual run’s K-factor (which 
make up the N consecutive good runs) to see how far it deviates from 
the average. If any run’s K-factor deviates by more than the allowable 
limit then additional runs are performed and the test is repeated.  

When all K-factors for the required runs fall within the deviation limit, 
then the prove is considered successful and a final average data is 
calculated. At the same time the program stores the single maximum 
deviation value (repeatability) of the good run K-factors as an 
indication of how well the prove fell within the deviation tolerance. 

API Ch.4 Method 1 (default)  
( )

100  
K

K - K
 = K ×

avg

runavg
dev  

MX-MN/AVG  
( ) 100  

K
K - K = K minmax ×

avg
dev  

MX-MN/MX+MN2  
( )

( ) 100  
2K  K

K - K = K
minmax

minmax ×
÷+dev  

MX-MN/MN  
( ) 100  

K
K - K = K

min

minmax ×dev  

MX-MN/MX*MN  
( )
( ) 100  

K  K
K - K = K

minmax

minmax ×
×dev  

MX-AV/AV  
( )

100  
K

K - K
 = K max ×

avg

avg
dev  

AV-MN/AV  
( )

100  
K

K - K
 = K min ×

avg

avg
dev  

where: 
 
Kdev  is the K-factor deviation (%) 
Kavg is the average K-factor of N consecutive good runs (pls/m3) 
Kmin is the minimum K-factor of N consecutive good runs (pls/m3) 
Kmax is the maximum K-factor of N consecutive good runs (pls/m3) 
Krun is the run K-factor being checked (pls/m3) 



Config600 Configuration Software User Manual 

Revised January 2023 Proving B-75 

 
Statistical  

N
S

avg

N
dev ×

−

K
 x  x t200 = K 1

1-N  

where: 
 
Kdev  is the K-factor deviation (%) 
Kavg is the average K-factor of N consecutive good runs (pls/m3) 
tN-1 is the uncertainty band confidence level, which is a selectable 

value (95%, 99%, 99.5%, or a user-defined value). NORSOK 
requires this method (using the student-t distribution) at a 
recommended value of 95%. API MPMS Ch.4.8 also 
recommends 95%.  

SN-1 is the standard deviation of K-factor of N consecutive good 
runs (pls/m3) 

B.2.11.10 Meter Factor Deviation Tests  
This section defines Meter Factor Deviation tests.  

Calculated Meter Factor versus Initial Base Meter Factor   
 

% Deviation Test 1 =  (MFCPFRN – Initial Base Meter Factor) X 100 (Initial Base Meter Factor) 

where: 

MFCPFRN is the calculated meter factor from current prove at normal 
flow rate. 

Maximum deviation of ± 0.25 %. 

Calculated Meter Factor versus Average of Previous Historical 
Meter Factors   

 

% Deviation Test 2 =  
(MFCPFRN – Average of Previous Meter 

Factors) X 100 
(Average of Previous Meter Factors) 

where: 

MFCPFRN is the calculated meter factor from current prove at normal 
flow rate. 

Maximum deviation of ± 0.1 %. 

B.3 Master Meter Prover – Gas and Liquid 

The primary function of the Master Meter is to provide an accurate 
"meter factor" value for the proving stream. The S600+ then uses this 
value to calibrate all other meters.  
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The proving stream receives pulses from its meter and generates a 
pulse train output, which represents the number of pulses received. The 
Master Meter counts these pulses during a proof run and also counts 
the pulses from its own meter (the master). When the proof run 
completes, the S600+ calculates a Meter Factor for the stream, based 
on the Master Meter’s Meter Factor and the ratio of the correct stream 
output pulse count to the Master Meter’s turbine pulse count. 
  

Caution It is extremely unlikely that any one S600+ configuration would 
contain all the settings discussed in this section. For that reason, 
several sample configurations demonstrate the settings. 
  

Two components enable you to control the prove:  

 Prove sequence, a station-based function which sets up the prove 
environment, and  

 Run control, a prover-based function which drives the prover 
hardware, counts pulses, and performs the K-factor calculations. 

Following a successful prove, the system verifies the stream normal 
flow rate value:  

 If the normal flow rate is set to a value greater than zero (Aramco-
style linearisation), the run control waits for a predefined amount of 
time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations.  

 If the normal flow rate is zero (non-Aramco-style linearisation), 
the prove sequence downloads the prove results to the stream being 
proved, but does not use the data until it is accepted either locally 
at the S600+ or via a supervisory computer. 

When the prove runs complete, the sequence offers you the option of 
re-running the prove or terminating, at which point (if configured) the 
sequence restores the valves to their pre-prove state. 

Notes: 
 Aramco-style linearisation is only applicable to Liquid Master 

Meter proving. Gas Master Meter proving will always use the non-
Aramco style linearisation. 

 The prove sequence downloads both a K-factor and a meter factor. 
Applications typically use the original K-factor from the meter 
calibration report and update the meter factor, which may be a 
fixed value or derived from a linearisation process. Alternately, the 
meter factor can remain unchanged and the K-factor (fixed or 
linearised) updated. 

 The meter factor deviation tests and the historical meter factor 
database are only applicable to Liquid Master Meter proving. 
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 The meter factor deviation tests and the historical meter factor 
database are only supported for "local" streams (part of the same 
configuration with the prover), if you configure the stream normal 
flow rate to a value greater than zero and you select "Product Table 
with History" when you create your configuration. 

 You define a ticket as Official or Unofficial when you configure a 
prove. This selection applies to both the Aramco-style and non-
Aramco-style linearisation. 
Following an Official prove, the prove sequence is determined by 
the Aramco / non-Aramco style linearisation selection. 
Following the Unofficial prove, the prove sequence does not 
download the prove results to the stream being proved. This is 
typically used to determine an approximate K-Factor / Meter 
Factor before an official prove takes place or when maintenance 
activities are being performed on the site.  

The Official/Unofficial selection displays in the report header. 

B.3.1 Master Meter/Stream combinations 
The following tables show the supported liquid and gas Master Meter / 
Stream combinations: 

Table B-21. Master Meter/Stream Combinations – Liquid 

Liquid 
 Stream Meter 

  Turbine (V) USM (V) Coriolis (V) Coriolis (M) 

M
as

te
r M

et
er

 Turbine (V) Yes Yes Yes Yes 

USM (V) Yes Yes Yes Yes 

Coriolis (V) Yes Yes Yes Yes 

Coriolis (M) No No No Yes 

Notes: 
1. (V) represents volume pulse-based meter input 
2. (M) represents mass pulse-based meter input 

Table B-22. Master Meter/Stream Combinations – Gas 

Gas 
  Stream Meter 

M
as

te
r M

et
er

 

  Turbine (V) USM (V) Coriolis (V) Coriolis (M) 

Turbine (V) Yes Yes* Yes* No 

USM (V) Yes* Yes Yes No 

Coriolis (V) Yes* Yes Yes No 

Coriolis (M) No No No No 

Notes: 
1. (V) represents volume pulse-based meter input 
2. (M) represents mass pulse-based meter input 
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3. AGA6 Gas Master Metering is based on Volume comparison 
4. Coriolis Meter must be configured to provide volume not mass flow rate 
*. This combination needs the Master Meter and Stream Meter in separate 

stations. 
B.3.2 Inputs/Outputs  

For master meter proving the S600+ requires the following hardware:   

 A CPU module (P152+)  

 An I/O module (P144)  
 A Prover module (P154)   

Inputs Master meter proving normally has the following inputs:  

Prover Pressure 4-20mA ADC 
Prover Temperature 4-20mA PRT 
Master Meter Pulses Pulse Input 
Stream Raw Pulses Raw Pulse Input  

Note: Pulse input must be on 
Prover module (P154).  

Prove Enable Status Digital Input 

Outputs Master meter proving has no outputs.   

B.3.3 Communications 
Using the Modbus protocol, a slave link provides communications with 
the stream flow computers.  

 To set up the link at the prover (which is the master), select 
Tech/Engineer > Communications > Assignment > Prover 
Master Lin > Seq Enable.  

 To set up the Modbus address, select Tech/Engineer > 
Communications > Assignment > Prover Master Lin > Seq 
Addr. 

Prover/Stream Link Default Setting 
Modbus RTU Master 
Prover/Stream Link 
 

Serial RS485 - Comm 5  
9600 
8 bits 
No Parity  
1 stop bit  
Address = 1 (front panel)  

 
 To set up the link at the stream (which is the slave), select 

Tech/Engineer > Communications > Assignment > Next > 
Prover Slave Lin.  

Note: You can reset the ports, baud rate, number of bits, and parity 
values through the S600+’s front panel.  

B.3.4 Pulse Measurement  
The primary function of the prover is to calculate an accurate K-factor 
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or meter factor value for the meter under prove. The master meter does 
this by comparing pulses from the stream meter with those from the 
master meter.  

The stream flow computer receives pulses from its meter and transmits 
a pulse train output (‘Raw Pulse Output’) which represents the number 
of pulses received, including bad pulse correction. The prove sequence 
commands the selected stream to turn on its ‘Raw Pulse Output’, which 
allows the prover computer to monitor the pulses from the meter. The 
prover counts pulses during a proof run, and corrects the count for 
temperature and pressure. 

During the proof run the prover also counts the pulses received from its 
own master meter and the count is corrected for temperature and 
pressure. 

When the proof run completes, the prover calculates the stream’s K-
factor from the master meter K-factor and the ratio of the corrected 
stream output pulse count and the master meter pulse count. 
For a master meter prove, a run’s duration is determined by counting a 
set number of pulses (typically 10000), by the flow for a set volume or 
mass of liquid, or by the flow of a liquid for a set period of time.  

Note: The electrical diagram for the Prover module shows a Raw 
Pulse Output, but this is not available. You cannot use the Raw 
Pulse Output to pass pulses input to the Prover module to the 
Raw Pulse Input.  

 
Pulse Gating The Prover module independently and synchronously snapshots and 

counts the master meter pulses together with the raw pulse inputs from 
the meter under prove.  

Pulse Interpolation  Use pulse interpolation when the pulse count is low (typically less than 
10,000 pulses per run).  

For master metering proving, you can use a Pulse Interpolation Module 
(PIM) and enter an interpolation factor corresponding to the PIM 
setting into the prover S600+ using a keypad.  

A pulse lock lost digital input is provided to indicate whether the PIM 
pulses are valid. The input is active when the PIM output is considered 
good. 

B.3.5 Prove Sequence and Control  
Two components enable you to control the prove:  
 Prove sequence, a station-based function which sets up the prove 

environment, and  
 Run control sequence, a prover-based function which drives the 

hardware, counts pulses, and performs the K-factor and meter 
factor calculations. 
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The S600+’s front panel display provides the following commands you 
can use to control and monitor the two prove control tasks (Operator 
> Station > Sequence Ctl):  

 
Display  Description 
SEQ CTL  Operator commands for sequence control (outer loop) 
SEQ STREAM NO.  Enter the designated stream number to be proved.  

Note: For local streams, this is the logical stream number. 
For remote streams, this is the slave number in the Modbus 
master map. For example, if the first slave has a Modbus 
address of 22, this is stream 1. If  the second slave in the 
master map has an address of 33, this is stream 2.  

SEQ STAGE INDEX  Shows current sequence stage as the sequence progresses. 
SEQ STAGE PREV Indicates the sequence stage immediately prior to the current 

stage. If an abort occurs, use this value to help identify the 
source of the abort.  

SEQ ABORT INDEX  In the event of a sequence error, an abort reason index 
displays here. 

RUN CTL  Operator commands for proof run (inner loop) 
Run permit Interlock required for starting proof run. 
Run stage index Shows current proof run stage as the sequence progresses. 
Run abort index In the event of a proof run sequence error, an abort reason 

index displays here. 
 
Following a successful prove, the system verifies the stream normal 
flow rate value:  
 If the normal flow rate is set to a value greater than zero (Aramco-

style linearisation), the run control waits for a predefined amount of 
time for you to reject the current prove results. If a prove is 
rejected, the proving report is annotated as "ABORTED". If the 
time-out elapses, the prove sequence downloads the prove results 
to the stream being proved and the data is automatically used in the 
subsequent calculations.  

 If the normal flow rate is zero (non-Aramco-style linearisation), the 
prove sequence downloads the prove results to the stream being 
proved, but does not use the data until it is accepted either locally 
at the S600+ or via a supervisory computer. 

You then have two options for accepting the prove results: 

 If you select ACCEPT, the currently running batch is retroactively 
adjusted with the new factor. 

 If you select ACCEPT NO ADJUST, no adjustment is performed 
on the currently running batch. 

B.3.5.1 Default Prove Sequence Stages  
The prover sequence functions in stages. Table B-23 shows the default 
stages for a typical application’s normal, reprove, and abort situations.  
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If an abort occurs either automatically or by operator command then 
the prove sequence stage changes to Aborted. No further action is 
taken until the computer receives either a Continue command to 
initiate a re-prove or a Terminate command to finish the sequence. 

Table B-23. Default Prove Sequence Stages 

Stage Display Description 
0 IDLE Halted: idle, await Start command 
1 INITIALISE Initialise 
2 PULSES ON Turn proving stream pulses on 
16 PRV FLOW/T/P STAB Hold stable temperature, pressure and flowrate 
18 PROOF RUN Perform proof runs (execute Run Control stages) 
19 KF DOWNLOAD K-factor and data download 
20 AWAIT REPROVE Halted: prove runs complete, await Continue/Terminate 

command 
26 ABORTED STAGE Halted: sequence aborted, await Continue/Terminate 

command 
   
Continue (Reprove) 

29 RE STAB CHECKS Hold stable temperature, pressure and flowrate 
18 PROOF RUN Perform proof runs (execute Run Control stages) 

   
Terminate 

25 PS PULSES OFF Turn proving stream raw pulses off 
30 TERMINATE Terminate (return to idle) 

B.3.5.2 Complete Sequence Stage Descriptions  
Table B-24 shows all the stages of a prove sequence.  

Table B-24. Complete Prove Sequence Stages 
Stage Title Description 

0 Idle Wait for a command to start the sequence, then proceed to stage 1 
(Validate and Initialise). 

1 Validate + 
Initialise 

Verify:  
 The proving stream is flowing. 
 The proving stream is not in maintenance mode.  
 Telemetry to the proving stream is OK.  
 The prove permit state (run control status) is OK. 
Initialise:  
 Copy the proving stream meter variables into the proving set.  
 Copy the product stream product data into the proving set. 
 Initialise proof run date (via Initialise command to run control 

task).  
 Determine required proof flowrate from current rate (snapshot) or 

preset f lowrate.  
 Save all FCV settings. 
Proceed to stage 2 (Pulses On). 
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Stage Title Description 
2 Pulses On Command all online streams to turn pulses off  

Command proving stream to turn pulses on 
Wait for pulses to be aligned   
Proceed to stage 3 (Prover FCV Initialise)  
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails.  
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 

3 Prover FCV 
initialise 

Set prover FCV manual output to initial output 
Set prover FCV mode to manual 
Set proving stream FCV tracking on 
Set proving stream FCV mode to manual 
Proceed to stage 4 (Open prover outlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 

4 Prover open 
outlet 

Command Prover Outlet Valve to open 
Wait for valve to reach position 
Proceed to stage 5 (Non-proving stream close prover inlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

5 Non-proving 
stream close 
prover inlet 

Command non-proving streams Prover Inlet Valves to close 
Wait for valves to reach position 
Proceed to stage 6 (Proving stream open prover inlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
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Stage Title Description 
6 Proving 

stream open 
prover inlet 

Command proving streams Prover Inlet Valve to open 
Wait for valve to reach position 
Proceed to stage 7 (Proving stream close stream outlet) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

7 Proving 
stream close 
stream outlet 

Command proving streams Outlet Valve to close 
Wait for valve to reach position 
Proceed to stage 9 (Non-proving stream FCVS track) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 

8 Not used  
9 Non-proving 

stream FCVS 
track 

Set FCV for non-proving streams to tracking 
Proceed to stage 10 (Non-proving stream flow balance) 
Abort: 
 If  an abort command is issued.  
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
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Stage Title Description 
10 Non-proving 

stream flow 
balance 

Enable f low balancing for non-proving streams 
Flow error = proving stream flowrate - (selected proof flowrate + 
of fset). 
If  the error is too low then: 
 If  there are no on-line streams then go to abort stage. 
 Turn down value = abs (error / no. of on line none proving 

streams). 
 For each on line proving stream, new setpoint = current rate - turn 

down.  
If  all new set points (for each stream) are within the low flow range 
then download the new set points and delay for adjustment prior to 
rechecking the flow error. 
If  any new set point is less than the low flow range then go to stage 12 
(operator close) 
If  the error is too high then: 
 If  there are no on-line streams then go to abort stage. 
 Turn up value = error / no. of on line none proving streams. 
 For each on line proving stream, new setpoint = current rate + 

turn up.  
If  all new set points (for each stream) are within the high flow range 
then download the new set points and delay for adjustment prior to 
rechecking the flow error. 
If  any new set point is higher than the low flow range then go to stage 
13 (operator open). 
Proceed to stage 14 if the error is within tolerance (Non-proving 
stream FCV manual). 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 

11 Not used  
12 Close 

suspend 
Flow balancing – wait for operator to close stream 
Return to f low balancing stage 10 if continue command issued 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream.  
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 
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Stage Title Description 
13 Open 

suspend 
Flow balancing – wait for operator to open stream 
Return to f low balancing stage 10 if continue command issued 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off.   
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  valves are not correctly aligned. 
 If  the valve fails to reach position. 
 If  f low balance is not achieved (timeout / hold fails). 

14 Non-proving 
stream FCVS 
manual 

Set all non-proving stream FCV tracking on 
Set all non-proving stream FCV mode to manual 
Proceed to stage 15 (Prover flowrate stability) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

15 Prover 
flowrate 
stability 

Set prover FCV to selected prove flow rate + offset 
Set prover FCV mode to auto 
Set prover FCV tracking to on 
Hold proving stream flow rate within tolerance for a user configurable 
time 
Proceed to stage 16 (Temperature / Pressure Stability) 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  stability not achieved. 
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Stage Title Description 
16 Synchronise 

with Run 
Control 
(Temperature 
/ pressure 
stability) 

Hold stability for a user-configurable time 
Proceed to stage 18 (Proof runs)  
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 
 If  stability not maintained. 

17 Not used  
18 Synchronise 

with Run 
Control 
(Proof runs) 

Start the prove runs (via Start command to run control task).  
On success proceed to stage 19 (KF download)  
Abort:  
 If  a run fails (such as a timeout for a sphere switch). 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valves are not correctly aligned. 

19 K-factor 
Download 

Copy proof K-factor, meter factor, flow rate, and frequency into 
proving stream data points for subsequent telemetry download.  
Notes:  
 The stream metering calculations do not use these until 

commanded separately. 
 If  the historical meter factor option is enabled then the historical 

meter factors and deviations arrays are also copied.  
Proceed to stage 20 (Await reprove) 

20 Await reprove Go to stage 22 (Proving stream open stream outlet) if the Terminate 
or abort command is issued.   
Go to stage 29 (Stability Checks) if Continue (Reprove) command is 
issued. 

21 Not used  
22 Proving 

stream open 
stream outlet 

Command proving stream Outlet Valve to open 
Wait for valve to reach position 
Proceed to stage 23 (Proving stream close prover inlet) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  valve fails to reach position. 
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Stage Title Description 
23 Proving 

stream close 
prover inlet 

Command proving stream Prover Inlet Valve to close 
Wait for valve to reach position 
Proceed to stage 24 (Restore FCV)  
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty. 
 If  the valve fails to reach position. 

24 Restore FCVS Reset FCV’s to previous (pre-prove) settings as noted in stage 1 
Proceed to stage 25 (Proving stream pulses off) 
Abort: 
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream raw pulse output is not switched on. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 

25 Proving 
stream 
pulses off 

Command proving stream to turn pulses off.  
Wait for the pulses to be turned off  
Proceed to stage 1 
Abort:  
 If  an abort command is issued. 
 If  proving stream telemetry fails. 
 If  prove permit state (run control status) is off. 
 If  no f low at proving stream. 
 If  proving stream is in maintenance mode. 
 If  peer status is not duty 

26 Aborted 
stage 

An abort condition has occurred.  
Go to the next relevant stage if the Terminate command is issued.  
Go to stage 29 (Stability Checks) if Continue (Reprove) command is 
issued. 

27 Not used  
28 Not used  
29 Synchronise 

with Run 
Control 
(Stability 
checks) 

Wait to achieve stability (via Stabilise command to run control task) for 
temperatures, pressure rate of change.  
Upon achieving stability, wait for stability to be held for a user-
conf igurable time. 
Proceed to the stage 18 (Proof runs). 

30 Terminate Ensure the run control sequence terminates.  
Return to stage 1 (Idle). 

31 to 
40 

User Stages Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

41 Not used  
42 User Comms 

Suspend 1 
Suspends the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 
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Stage Title Description 
43 User Comms 

Normal 1 
Re-enables the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

44 User Comms 
Suspend 2 

Suspends the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

45 User Comms 
Normal 2 

Re-enables the prover / stream communications.  
Requires the implementation of the expseq.txt file and a logicalc to 
perform any specific functionality. 

B.3.5.3 Prove Sequence Abort Index 
Table B-25 shows the abort values for a prove sequence.  

Table B-25. Prove Sequence Abort Index 
Value Display Description 

1 OP ABORT Operator Requested Abort 
2 Not Used  
3 PS TELEM FAIL Proving Stream Telemetry Fail 
4 RUN CTL BUSY Run Control Task Busy 
5 METER NO FLOW No Flow at Meter 
6 RUN CTL ABORT Run Control Task Aborted 
7 ILLEGAL PULSES More than one stream has raw pulses enabled.  
8 ANY TELEM FAIL Non Proving Stream Telemetry Fail 
9 NPS PRV I-VLV OPEN Non Proving Stream Prover Valve Not Closed 

10 PS PRV I-VLV CLOSED Proving Stream Prover Offtake Valve Not Open 
11 PS STR O-VLV OPEN Proving Stream Outlet Valve Not Closed 
12 PRV I-VLV CLOSED Prover Inlet Valve Not Open 
13 PRV O-VLV CLOSED Prover Outlet Valve Not Open 
14 PS IN MAINT Proving Stream Is In Maintenance Mode 
15 FBAL TIMEOUT Flow Balance Timeout 
16 FBAL NO NPS ON LINE Flow Balance Error - No Non Proving Streams On-line  
17 FBAL NO NPS IN AUTO Flow Balance Error - No Non Proving Streams In Auto 
18 FBAL HOLD FAIL Flow Balance Error - Stability Not Achieved 
19 PS I-ISL-VLV CLOSED Proving Stream Inlet Isolation Valve Not Open 
20 PS O-ISL-VLV CLOSED Proving Stream Header Isolation Valve Not Open 
21 PS P-ISL-VLV CLOSED Proving Stream Prover Isolation Valve Not Open 
22 PEER STATUS STANDBY Unit is in standby mode when peer-to-peer is configured  

B.3.6 Prover Run Control Stages  
The Run Control sequence is specific to the type of prover (such as a 
ball prover, a compact prover, or a master meter). The Run Control 
sequence initiates the prove runs and performs the calculations that 
produce a K-factor and meter factor when the runs are completed.  

Normally the sequence runs when commanded by the Prove Sequence 
at stage 18 (Perform Proof Runs). However, you can initiate it from the 
S600+ front panel display or (by using custom control) from 
elsewhere.  
The Prover Run sequence below shows the default stage sequences for 
a typical master meter prove. 



Config600 Configuration Software User Manual 

Revised January 2023 Proving B-89 

Table B-26. Prover Run Control Stages 

Stage Display Description 
0 IDLE Halted: idle 
1 INITIALISE Initialise run data 
2 AWAIT STAB CMD Halted: await Stabilise command 
3 WAIT STAB Wait until stability is achieved 
5 AWAIT RUN CMD Halted: await start runs command 
6 START RUN Start the pulse counters 
7 COUNT PULSES Count the pulses 
8 RUN CALCS Perform run calculations 
9 AVG CALCS Perform run average calculations 
12 STD POST RUN No action 
10 STD RPT CHECKS Perform repeatability checks (if success go to stage 14) 
13 CHECK RUNS EXCEEDED Check runs exceeded (if yes go to stage 11 else stage 6) 
14 FINAL AVG Perform final average calculations 
15 MF DEVIATION CHECKS Perform meter factor deviation checks.  

Note:  This stage applicable to Liquid Master Meter 
Proving and is performed only if you configure the 
meter normal f low to a value greater than zero 
(Aramco-style linearisation) and you select 
“Product Table with History” when you create your 
conf iguration. 

16 WAIT REJECT COMMAND Allow a time-out for rejecting the current prove. If  the 
time-out elapses go to the next stage.  
Note:  This stage applicable to Liquid Master Meter 

Proving and is performed only if you configure the 
meter normal f low to a value greater than zero 
(Aramco-style linearisation).     

17 REPORT GENERATION Print the proof report.  
11 FINAL Halted: f inal – await Terminate/Reprove command.  

 
You can also enable user stages on the PC Setup Run Data screen. 
These invoke a LogiCalc which you can edit to provide user-specific 
logic as the prove progresses. Example LogiCalcs are included in the 
C:\Users\<username>\Config600 3.3\lclib\prover directory. Copy one 
of these to the C:\Users\<username>\Config600 
3.3\Configs\Project\LogiCalc directory so you edit it to be compatible 
with your configuration and then download it to the S600+ with the 
configuration.  

Note: You can enable user stages by editing a configuration using the 
System Editor.   

B.3.6.1 Run Control Stage Description 
Table B-27 shows all the stages of a Run Control sequence.  

Table B-27. Master Meter Prover Run Control Stages 
Run Stage Description 
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Run Stage Description 
0 Idle 

Wait for the Initialise command to start the Run Control 
sequence.  
Proceed to next stage only if the prove is permitted (that is, 
if  the Run Control stage is Idle or Final and the available 
signal is zero; normally, the available signal is assigned to a 
digital input which may be connected to a valve or a key-
switch). 

1 Initialise Run Data 
Zero down all run data and arrays.  
Proceed to next stage. 

2 Halted: Await Stabilise Command  
Wait for Stabilise command then proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the master meter number has changed. 
 If  the Terminate command is issued. 

3 Wait Until Stability Is Achieved  
Proceed to next stage if stability override is on. 
Set stability wait timer running. 
Continuously monitor deviations for: 
 meter pressure vs. prover pressure 
 meter temperature vs.prover temperature 

Continuously monitor (over 5-second periods) rates of 
change for: 
 prover pressure 
 prover temperature 
 meter f lowrate 

Proceed to next stage when stability is achieved. 
Abort:  
 If  the prove is no longer permitted. 
 If  the master meter number has changed. 
 If  Terminate command is issued. 
 If  stability wait timer expires. 

4 Hold Stability For Entered Period  
Proceed to next stage if stability override is on. 
Set stability hold timer running. 
Repeat the stability checks from the previous stage to 
ensure stability is maintained for the given period. 
Proceed to next stage when stability hold timer expires. 
Abort:  
 If  the prove is no longer permitted. 
 If  the master meter number has changed. 
 If  the Terminate command is issued. 
 If  any of the stability checks fail. 

5 Halted: Await Start Runs Command  
Wait for Start Runs command then proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the master meter number has changed. 
 If  the Terminate command is issued. 

6 Start Run  
Start the pulse counters. 
Proceed to next stage. 
Abort:  
 If  the prove is no longer permitted. 
 If  the master meter number has changed. 
 If  the Terminate command is issued. 
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Run Stage Description 
7 Count Pulses 

Set f light timer running. 
Count and monitor the pulses. 
Average meter and prover data. 
Check stability is maintained for duration of the prove run 
by repeating the stability checks from the wait stability 
stage. 
Proceed to next stage when the required number of pulses 
has been counted, or the required volume/mass has been 
metered, or the specified run duration has elapsed.  
Abort:  
 If  the prove is no longer permitted. 
 If  the master meter number has changed. 
 If  the Terminate command is issued. 
 If  master meter K-factor equals 0. 
 If  master meter and meter under prove bad pulse 

counts differ. 
 If  pulse lock is lost (if PIM). 
 If  f light timer expires. 

8 Perform Run Calculations  
Based on data averaged during the run. 
Proceed to next stage if calculations are all valid. 
Abort if there is a calculation failure (such as K-factor out of 
range). 

9 Perform Run Average Calculations  
Average the individual run data over the last n good runs 
and store the results. 
Proceed to the next stage.  

10 Perform Repeatability Checks  
If  the required number of runs has not been performed 
then proceed to next stage. 
If  the required number of runs has been performed then 
check each of the last n run’s K-factor against the average. 
If  each K-factor is within tolerance then proceed to the 
Await Reprove/Terminate stage (11). 
If  any K-factors are outside tolerance and the maximum 
number of runs has been exceeded then proceed to the 
Await Reprove/Terminate stage (11), otherwise proceed to 
the next stage. 

11 Halted: Final - Await Terminate/Reprove Command 
End of prove. If : 
 Run control command is Initialise, proceed to 

Initialise stage 1 (Run Data)  
 Run control command is Terminate, proceed to 

stage 0 (Idle)  
 Run control command is Seat Sphere, proceed to 

the next stage (Seat Sphere). 
13 Check Runs Exceeded 

Check the number of runs executed against the maximum 
allowed. 
Proceed to the next stage. 
Abort if the maximum runs have been exceeded. 

14 Perform Final Average Calculations 
Calculate the f inal (average) K-factor and meter factor. 
Proceed to the next stage. 
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Run Stage Description 
15 Perform Meter Factor Deviation Checks  

Perform tolerance tests (calculated meter factor versus 
meter factor: maximum deviation of 0.25% and calculated 
meter factor versus average of saved historical meter 
factors: maximum deviation of 0.1%). 
Only valid meter factors at normal flow rates are 
incorporated in the historical database. When the limits for 
either test exceed the meter factor they are not used for 
measurement and the corresponding meter factor at normal 
meter f low rate is not entered in the historical database. 
Proving reports are annotated as “ABORTED” with cause of 
failure stated.  
Proceed to stage 13 if any of the tolerance test fail.  
Proceed to the next stage.  
Note:  This stage is only applicable to Liquid Master Meter 

Proving and is performed only if you configure the 
meter normal f low rate to a value greater than zero 
(Aramco-style linearisation) and you select 
"Product Table with History" when you create your 
conf iguration. 

16 Await for Current Prove to be Rejected  
You can reject the current prove results within a predefined 
time-out.  

Abort if the prove is rejected.  
Proceed to the next stage.  
Note:  This stage is performed only if you configure the 

meter normal f low to a value greater than zero 
(Aramco-style linearisation).    

17 Print the Proof Report 
Proceed to stage 11.  

B.3.6.2 Run Stage Abort Index 
Following an abort the program displays a value in the Run Control 
abort index display.  

Table B-28. Run Stage Abort Index 
Value Display Description 

0 NULL Not used 
1 OPERATOR Operator abort 
2 PC TIMEOUT Not used 
3 STAB WAIT Temperature/Pressure/Flowrate wait stability timeout 
4 STAB HOLD Temperature/Pressure/Flowrate hold stability timeout 
5 AVG CALC Not used 
6 RUN CALC Error occurred when performing run calculations. For details 

refer to Run Stage Calc Index 
7 RUNS EXCEEDED Maximum number of runs exceeded 
8 PLS LOCK LOST Pulse interpolator module lock lost 
9 IO FAIL I/O module failed to respond to prove request 
10 NULL DATA Not used 
11 KF/MF RANGE K-factor or meter factor out of range, even if alarms not 
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Value Display Description 
conf igured. To resolve, check the high and low limits for the 
meter factor, the K-factor, and pulse count objects.  

12 UNAVAIL Prover unavailable 
13 TIMEOUT Flight timeout 
14 INVALID CONSTANTS Master meter K-factor = 0 or selection option invalid 
15 BAD PULSES Master meter and meter under prove bad pulse counts differ 
16 MM NO CHANGED Master meter number changed during prove runs 
17 INV CALC Unsupported volume/mass calculations 

B.3.6.3 Run Stage Calculation Index 
If a prover calculation fails, the program displays a value indicating the 
failed calculation in the Run Stage Index S600+ front panel display.  

Table B-29. Run Stage Calculation Index 
Value Display Description 

0 IDLE No calculation errors 
11 FREQ Calculation failed because flight time equaled 0 
12 CPLP The calculation to determine the correction factor for the effect of 

pressure on the liquid at the prover (CPLp ) failed because of low 
density – applicable to Liquid only 

13 CPLM The calculation to determine the correction factor for the effect of 
pressure on the liquid at the meter (CPLm) failed because of low 
density – applicable to Liquid only 

14 CTLP The calculation to determine the correction factor for the effect of 
temperature on the liquid at the prover (CTLp) failed because of low 
density – applicable to Liquid only 

15 CTLM The calculation to determine the correction factor for the effect of 
temperature on the liquid at the meter (CTLm) failed because of low 
density – applicable to Liquid only 

16 PRV GVOL The calculation to determine the gross volume at the prover failed 
because the K-factor or the pulse count equaled 0  

17 MTR GVOL The calculation to determine the gross volume at the meter failed 
because the K-factor or the pulse count equaled 0  

18 PRV SVOL The calculation to determine the volume at standard conditions 
(SVOL) at the prover failed because of no error checks  

19 MTR SVOL The calculation to determine the volume at standard conditions 
(SVOL) at the meter failed because of no error checks  

20 K-FACTOR The calculation to determine K-factor failed because the value was 
outside low/high alarm limits 

21 METER FACTOR The calculation to determine meter factor failed because the value 
was outside low/high alarm limits 

22 PRV FLOWRATE The calculation to determine the flowrate at the prover failed 
because the flight time equaled 0 

23 MTR FLOWRATE The calculation to determine the flowrate at the meter failed because 
the f light time equaled  0 

31 PRV PCF The calculation to determine the pressure correction factor (PCF) at 
the prover failed.  

32 PRV MASS The calculation to determine the mass at the prover failed because 
the K-factor, pulse count, or pressure correction factor was 0 

33 MTR MASS The calculation to determine the mass at the meter failed because 
the K-factor, pulse count, or pressure correction factor was 0. 

34 METER FACTOR The calculation to determine meter factor failed because the value 
was outside low/high alarm limits 
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Value Display Description 
35 PRV FLOWRATE The calculation to determine the flowrate at the prover failed 

because the flight time equaled 0 
36 MTR FLOWRATE The calculation to determine the flowrate at the meter failed because 

the f light time equaled 0 
37 K-FACTOR The calculation to determine the K-factor failed because the value 

was outside low/high alarm limits 

B.3.7 Prove/Stream Data 
The prover computer reads the following data from the stream under 
prove:  

 Stream Temperature (in use) 
 Stream Pressure (in use) 
 Stream Standard Density (in use) 
 Alpha Constant K0 – applicable to Liquid only 
 Alpha Constant K1 – applicable to Liquid only 
 Alpha Constant K2 – applicable to Liquid only 
 Equilibrium Vapour Pressure – applicable to Liquid only 
 Zf (Flowing Compressibility) applicable to Gas only 
 Meter Factor (in use) 
 K-factor (in use) 
 CTSm (in use) – applicable to Liquid only 
 CPSm (in use) – applicable to Liquid only 
 Flowrate Minimum 
 Flowrate Maximum 
 FCV Setpoint 
 FCV Output 
 Reference Temperature 
 Meter Density (in use) 
 FCV Auto/Manual Status 
 FCV Tracking Status 
 Volume Correction Rounding Status 
 Volume Correction Units Selection – applicable to Liquid only 
 Volume Correction Product Type – applicable to Liquid only 
 Volume Correction CPL Option – applicable to Liquid only 
 Volume Correction Product Subtype – applicable to Liquid only 
 Volume Correction Density Type – applicable to Liquid only 
 K-factor Units  
 Normal Meter Flow Rate – applicable to Liquid only 
 Initial Base Meter Factor – applicable to Liquid only 
 Initial Base Meter Factor Time Stamp – applicable to Liquid only 
 Base Meter Factor Linearisation Points – applicable to Liquid only 
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 Historical Meter Factors – applicable to Liquid only 
 Historical Meter Factors Time Stamps – applicable to Liquid only 

If the prove completes successfully the system transfers the following 
prove data to the stream, but does not use it until you accept the data at 
the stream. 

 Proved K-factor 
 Proved Meter Factor 
 Proved Turbine Frequency 
 Proved Flowrate 
 Proved Meter Temperature 
 Proved Meter Pressure  
 Historical Meter Factors – applicable to Liquid only 
 Historical Meter Factors Time Stamp – applicable to Liquid only  
 Proved Meter Factor Acceptance Flag – applicable to Liquid only  

B.3.8 Prove Reports 
Two reports are available, for volume or mass K-factor, and the choice 
is determined by the K-factor units, pulses/volume or pulses/mass.  
The following are two sample proof reports for liquid:  

 
============================================================================================= 
    1                              METER PROOF REPORT                    06/08/2006  10:00:00 
============================================================================================= 
 
STREAM ON PROOF    : 0 
PROVING RATE :  0.000 m3/h 
 
STANDARD DENSITY :  0.000 kg/m3 
STREAM TEMPERATURE :  0.000 Deg.C STREAM PRESSURE : 0.000 barg 
PROVER TEMP :  0.000 Deg.C PROVER PRESS : 0.000 barg 
 
 STREAM PROVER STANDARD     PROVER METER FLIGHT 
TRIAL 
No. 

TEMP 
(Deg.C) 

PRESSURE 
(barg) 

TEMP 
(Deg.C) 

PRESSURE 
(barg) 

DENSITY 
(kg/m3) 

PULSES 
         

PULSES 
 

TIME 
(pls/m3) 
 

1 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
2 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
3 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
4 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
5 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
6 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
7 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
8 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
9 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
10 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
11 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
12 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
AVE 0.00 0.00 0.00 0.00 0.000 0.0 0.0 0.000000 
 
     PROVER STREAM  METER 
 
No. 

CTLM 
 

CPLM 
 

CTLP 
 

CPLP 
 

VOLUME 
(Sm3 ) 

VOLUME 
(Sm3 )        

FLOWRATE 
 

FACTOR 
 

1 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
2 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
3 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
4 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
5 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
6 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
7 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
8 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
9 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
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10 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
11 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
12 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
AVE 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 0.000000 
 
CURRENT K-FACTOR : 0.00  pls/m3 
NEW K-FACTOR : 0.00  pls/m3 
NEW METER FACTOR :    0.000000 
REPEATABILITY :    0.000000  % 
 
============================================================================================= 
============================================================================================= 
 
================================================================================ 
 1                                                         PROVING REPORT 
                                                  Emerson Process Management                  
                                         (0)OFFICIAL   (0)UNOFFICIAL   (0)ABORTED 
  
LOCATION :  AAAAAAA                            DATE/TIME : MM/DD/YYYY HH:MM:SS 
  
METER MANUFACTURER:    AAAAAAA               PROVER MANUFACTURER:  AAAAAAA         
METER MODEL:           AAAAAAA               PROVER SERIAL NUMBER: AAAAAAA      
METER SERIAL NUMBER:   AAAAAAA                
METER SIZE (mm):       0.000            
NOMINAL K-FACTOR:      0.000          
METER TAG NUMBER:      AAAAAAA                
  
PRIMARY FLOW COMPUTER: XX:XX:XX:XX:XX:XX 
  
LIQUID: A CRUDE          
OBSERVED DENSITY:   0.000  kg/m3  AT 0.00 Deg.C  =  0.000   kg/m3  AT 0.000 Deg.C  
TRIAL PULSES TOTAL PRESS             TEMP         TRIAL   
  

TRIAL No. PLUSES TOTAL 
TOTAL TIME  

s 
PRESS PROVER 

barg 
METER 
barg 

TEMP PROVER 
Deg.C 

METER 
Deg.C 

TRIAL M.F. MFt 

1 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
2 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
3 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
4 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
5 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
6 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
7 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
8 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
9 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
10 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
11 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
12 0.000000 0.000000 0.000000 0.000000 0.00 0.00 0.0 
AVE 0.000000 0.000000 0.000000 0.00000  0.00 0.00 0.0 
  
REPEATABILITY FOR LAST   10 TRIALS = 0.000  % 
  
A. TEMP. CORRECTION FACTOR FOR LIQUID IN PROVER     (CTLp)        0.000 
B. PRESS. CORRECTION FACTOR FOR LIQUID IN PROVER    (CPLp)        0.000 
C. COMBINED CORRECTION FACTOR FOR PROVER            (CCFp)        0.000 
D. GROSS STANDARD VOLUME FOR PROVER                 (GSVp)        0.000 Sm3    
E. INDICATED METER VOLUME                           (IVm)         0.000 m3     
F. TEMP. CORRECTION FACTOR FOR LIQUID IN METER      (CTLm)        0.000 
G. PRESS. CORRECTION FACTOR FOR LIQUID IN METER     (CPLm)        0.000 
H. COMBINED CORRECTION FACTOR FOR METER             (CCFm)        0.000 
I. GROSS STANDARD VOLUME FOR METER                  (GSVm)        0.000 Sm3    
J. AVG. METER FLOW RATE                                           0.000 m3/h   
K. METER FACTOR @ PROVING FLOW RATE                               0.000 
L. METER FACTOR @ NORMAL METER FLOW RATE OF  0.000 m3/h           0.000 
   METER FACTOR TEST RESULTS (%): 1) 0.00   2) 0.00             
M. PROVER MASS                                                    0.000 tonne  
N. METER MASS                                                     0.000 tonne  
  
   HISTORICAL DATA OF METER FACTORS @ NORMAL METER FLOW RATE OF  0.000 m3/h   
   INITIAL BASE METER FACTOR (DATE:  MM/DD/YY) = 0.000    
  
 DATE:         MM/DD/YY      MM/DD/YY      MM/DD/YY      MM/DD/YY      MM/DD/YY 
 FACTOR:       0.000         0.000         0.000         0.000         0.000  
 DEVIATION(±): 0.00%         0.00%         0.00%         0.00%         0.00% 
  
 DATE:         MM/DD/YY      MM/DD/YY      MM/DD/YY      MM/DD/YY      MM/DD/YY 
 FACTOR:       0.000         0.000         0.000         0.000         0.000  
 DEVIATION(±): 0.00%         0.00%         0.00%         0.00%         0.00% 
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PROVED FOR: ______________________ BY : _____________________ DATE: ____________ 
  
WITNESSED BY : ______________________________________________ DATE: ____________ 
 
================================================================================ 

B.3.9 Proving Calculations 
This section provides information on calculations used in the prove 
procedure.  

The calculations are for volume or mass K-factor and the choice is 
determined by the K-factor units, pulses/volume or pulses/mass.  

Average Method The "average method" option indicates how the system performs final 
averaging:  

 The Meter Factor option calculates a meter factor for each run and 
takes the average of these to arrive at the final meter factor. 

 The K-factor option calculates a K-factor for each run and takes the 
average of these to arrive at the final K-factor.  

 The Pulses option takes the average of the pulses, temperature, and 
pressure and performs a final set of calculations using this average 
data to arrive at the final meter and K-factor. 

Options 1 and 2 are equivalent to the “average meter factor" method 
used for API Ch.12 Section 2 Part 3 Proving reports. Option 3 is 
equivalent to the "average data" method.  

Standard References The prover volume correction calculations correspond to those used by 
the meter under prove, in which the system transfers the calculation 
steering variables from the stream.  
Name Standard Reference 
Averaging Calcs General mathematic principles 
Stability Calcs General mathematic principles 
Correction Factor (CTLm/CTLp) Corresponds to Meter calculations – 

applicable to Liquid only 
Correction Factor (CPLm/CPLp) Corresponds to Meter calculations – 

applicable to Liquid only 
K-factor/Flowrate API Ch 12 
K-factor Deviation API Ch 4  
K-factor Deviation Statistical 
Method 

NORSOK I-105 Annex F 

Meter Factor API Ch 12 

B.3.9.1 Formulae: Averaging Calculations  
Run Average Data   

Samples
XinstX ∑ = run  

where: 

Xrun is the average value of the variable for a single run  
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Xinst is the instantaneous sample value of the variable being 
averaged 

Samples is the number of samples taken during the run 
 
The sampled variables (Xinst) are: 
 Prover temperature 
 Prover pressure 
 Meter temperature  
 Meter pressure  
 Standard density 
 

Run Average Frequency (Hz)  

t
PCFRE
∆

 = Qrun  

where: 

FREQrun  is the average meter frequency for a single run 
PC is the run pulse count 
∆t is the run flight time (secs) 
 

Final Average Data (Over Consecutive Good Runs)  

N
X

X ∑ run
final  =  

where: 

Xfinal the final average value of a relevant variable for the N 
consecutive good runs 

Xrun the value of the variable for a single run 
N  the number of consecutive good runs 
 
The final average variables are: 
 Prover pulse count 
 Meter pulse count  
 Flight time 
 Prover temperature 
 Prover pressure 
 Meter temperature  
 Meter pressure 
 Vapour pressure – applicable to Liquid only 
 Standard density 
 Prover density 
 Meter density 
 Meter frequency 
 Prover flowrate 
 Meter flowrate 
 Alpha – applicable to Liquid only 
 Prover beta – applicable to Liquid only 
 Meter beta – applicable to Liquid only 
 CTLm – applicable to Liquid only 
 CPLm – applicable to Liquid only 
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 CTLp – applicable to Liquid only 
 CPLp – applicable to Liquid only 
 Flowing Compressibility (Zf) – applicable to Gas only  
 Pressure correction factor 
 Prover standard volume 
 Meter standard volume 
 Meter indicated volume 
 Prover mass 
 Meter mass 
 K-factor 
 Meter factor 

B.3.9.2 Formulae: Stability Calculations 
Stream/Prover Discrepancy Checks  

Xdiff  = XA - XB 
where: 

XA, XB are the variables being compared 
 
The variables compared are: 
 Prover - Meter Temperature 
 Prover - Meter Pressure 
 

Variable Rate of Change 

Period
 -   XXX oldnew

rate =  

where: 

 
Xrate  the rate of the variable 
Xnew  the new sample value 
Xold the previous sample value 
Period the sampling interval 
 
The variables compared are: 
 Prover Temperature 
 Prover Pressure 
 Meter Flowrate 

B.3.9.3 Formulae: Correction Factor (CTLm/CTLp) 
Correction Factor for the Effect of Temperature on the Liquid  

These factors are calculated according to the product, using the same 
calculations as the meter under prove – applicable to Liquid only.  

B.3.9.4 Formulae: Correction Factor (CPLm/CPLp) 
Correction Factor for the Effect of Pressure on the Liquid  

These factors are calculated according to the product, using the same 
calculations as the meter under prove – applicable to Liquid only.  
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B.3.9.5 Formulae: Volume Prover Calculations 
Prover Indicated Volume (m3)  

 KFp
PCp = IVp run

run  

where: 

PCprun is the run pulse count for the master meter (pls) 
KFp is the master meter K-factor (pls/m3) 
 

Meter Indicated Volume (m3)  

 KFm
PCm = IVm

run

run
run  

where: 

PCmrun is the run pulse count for the meter (pls) 

KFm is the meter K-factor (pls/m3) 
 

Prover Gross Standard Volume (Sm3) – Liquid  
MFp x CPLp x CTLpx IVp = GSVp runrunrunrun  

where: 
IVprun is the indicated volume for the master meter 

CTLprun  is the correction factor for the effect of temperature on the 
liquid at the prover, using the average prover run 
temperature 

CPLprun  is the correction factor for the effect of pressure on the 
liquid at the prover, using the average prover run pressure 

MFp is the master meter Meter Factor 

 

Meter Indicated Standard Volume (Sm3) – Liquid   

runrunrunrun CPLm x CTLmx IVm = ISVm  

where: 

IVmrun is the indicated volume for the meter 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

Volume K-factor (pls/m3) – Liquid   

KFp x 
CPLp x CTLp x PCp
CPLm x CTLmx PCm = KFm

runrunrun

runrunrun
run  

where: 

PCmrun is the run pulse count for the meter (pls) 
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PCprun is the run pulse count for the master meter (pls) 

CTLprun  is the correction factor for the effect of temperature on the 
liquid at the prover, using the average prover run 
temperature 

CPLprun  is the correction factor for the effect of pressure on the 
liquid at the prover, using the average prover run pressure 

CTLmrun  is the correction factor for the effect of temperature on the 
liquid at the meter, using the average meter run temperature 

CPLmrun  is the correction factor for the effect of pressure on the 
liquid at the meter, using the average meter run pressure 

KFp is the master meter K-factor (pls/m3) 

PTZ Factor - Gas 

 
where: 

PresPrun is the prover pressure (psia) 
PresMrun is the meter pressure (psia) 

TempPrun is the prover temperature (Deg F) 

TempMrun is the meter temperature (Deg F) 

ZfPrun is the prover flowing compressibility 
ZfMrun is the meter flowing compressibility 

Meter Factor – Liquid   

 ISVm
GSVp = MF

run

run  

where: 
GSVprun is the prover gross standard volume (m3) 

ISVmrun is the meter indicated standard volume (m3) 

Meter Factor - Gas 

 
where: 

IVprun is the prover indicated volume (m3) 

PTZ is the PTZ factor 
IVmrun is the meter indicated volume (m3) 

Prover Indicated Volume Flowrate (m3/h)  

3600 x 
t

IVp = IVFRp run
run ∆
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where: 

IVprun is the indicated volume for the master meter (m3) 

∆t is the meter run flight time (secs) 
 

Meter Indicated Volume Flowrate (m3/h)  

3600 x 
t

IVm = IVFRm run
run ∆

 

where: 
IVmrun is the indicated volume for the meter (m3) 

∆t is the meter run flight time (secs) 

B.3.9.6 Formulae: Mass Prover Calculations 
Prover Pressure Correction Factor  

)P - (PKTPF  1 = PCF refrun×+  

where: 

Prun is the master meter pressure (bar) 

Pref  is the master meter PCF reference pressure (bar) 
KTPF is the master meter KTPF 
 

Prover Mass (kg)  

 KFp
PCFPCp = Mp run

run
×  

where: 

PCprun is the run pulse count for the master meter (pls) 

KFp is the master meter K-factor (pls/kg) 

PCF is the master meter pressure correction factor 

Meter Mass (kg)  

 KFm
1.0PCm = Mm

run

run
run

×  

where: 

PCmrun is the run pulse count for the meter (pls) 
KFm is the meter K-factor (pls/kg) 
 

Meter Factor  

 Mm
Mp = MF

run

run  

where: 

Mprun is the master meter mass (kg) 

Mmrun is the meter mass (kg) 
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Mass K-factor (pls/kg)  

 MF
KFp = KFm

run
run  

where: 

MFrun is the run meter factor 

KFp is the master meter K-factor (pls/kg) 
 

Prover Mass Flowrate (kg/h)  

3600 x 
t

Mp = MFRp run
run ∆

 

where: 
Mprun is the mass for the master meter (kg) 

∆t is the meter run flight time (secs) 
 

Meter Mass Flowrate (kg/h)  

3600 x 
t

Mm = MFRm run
run ∆

 

where: 

Mmrun is the mass for the meter (kg) 

∆t is the meter run flight time (secs) 

B.3.9.7 Formulae: K-factor Deviation 
When the required number of consecutive good runs has been 
achieved, the program checks each individual run K-factor (which 
make up the N consecutive good runs) to see how far it deviates from 
the average. If any run’s K-factor deviates by more than the allowable 
limit then additional runs are performed and the test is repeated.  
When all K-factors for the required runs fall within the deviation limit, 
then the prove is considered successful and the system calculated Final 
Average Data. At the same time the program stores the single 
maximum deviation value (repeatability) of the good run K-factors as 
an indication of how well the prove fell within the deviation tolerance. 

API Ch.4 Method 1 (default)  
( )

100  
K

K - K
 = K ×

avg

runavg
dev  

MX-MN/AVG  
( ) 100  

K
K - K = K minmax ×

avg
dev  

MX-MN/MX+MN2  
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( )
( ) 100  

2K  K
K - K = K
minmax

minmax ×
÷+dev  

MX-MN/MN  
( ) 100  

K
K - K = K

min

minmax ×dev  

MX-MN/MX*MN  
( )
( ) 100  

K  K
K - K = K

minmax

minmax ×
×dev  

MX-AV/AV  
( )

100  
K

K - K
 = K max ×

avg

avg
dev  

AV-MN/AV  
( )

100  
K

K - K
 = K min ×

avg

avg
dev  

where: 
 
Kdev  is the K-factor deviation (%) 

Kavg is the average K-factor of N consecutive good runs (pls/m3) 
Kmin is the minimum K-factor of N consecutive good runs (pls/m3) 

Kmax is the maximum K-factor of N consecutive good runs (pls/m3) 

Krun is the run K-factor being checked (pls/m3) 

Statistical  

N
S

avg

N
dev ×

−

K
 x  x t200 = K 1

1-N  

where: 
 
Kdev  is the K-factor deviation (%) 
Kavg is the average K-factor of N consecutive good runs (pls/m3) 
tN-1 is the uncertainty band confidence level, which is a selectable 

value (95%, 99%, 99.5%, or a user-defined value). NORSOK 
requires this method (using the student-t distribution) at a 
recommended value of 95%. API MPMS Ch.4.8 also 
recommends 95%. 

 SN-1 is the standard deviation of K-factor of N consecutive good 
runs (pls/m3) 

B.3.9.8 Meter Factor Deviation Test  
This section defines Meter Factor Deviation tests – applicable to 
Liquid only.  
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Calculated Meter Factor versus Initial Base Meter Factor    

 
% Deviation Test 1 =  (MFCPFRN – Initial Base Meter Factor) X 100 (Initial Base Meter Factor) 

where: 
MFCPFRN is the calculated meter factor from current prove at normal 
flow rate. 

Maximum deviation of ± 0.25 %. 

Calculated Meter Factor versus Average of Previous Historical 
Meter Factors 

 
% Deviation 
Test 2 =  

(MFCPFRN – Average of Previous Meter 
Factors) X 100 

(Average of Previous Meter Factors) 
 

where: 
MFCPFRN is the calculated meter factor from current prove at normal 
flow rate 
Maximum deviation of ± 0.1 %. 
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Appendix C – Batching  
In This Chapter 

C.1 Batching Overview ...................................................................C-2 
C.1.1 Product Table .............................................................C-2 
C.1.2 Station Batch Setup .....................................................C-8 
C.1.3 Product Interface Detection ......................................... C-15 
C.1.4 Slops Handling Examples ........................................... C-18 

C.2 Batch Sequence and Control ................................................... C-19 
C.2.1 Batch Sequence Stages ............................................. C-20 
C.2.2 Retrospective Batch Totals ......................................... C-29 
C.2.3 Batch Alarms ............................................................ C-30 
C.2.4 Batch Ticket ............................................................. C-30 

C.3 Batch Recalculation ................................................................ C-32 
C.3.1 Displays ................................................................... C-32 
C.3.2 Batch Ticket ............................................................. C-36 
C.3.3 Recalculating Batches................................................ C-38 

C.4 Flow Switching....................................................................... C-47 
C.4.1 Station Flow Switching Setup ...................................... C-47 
C.4.2 Stream Flow Switching Setup ...................................... C-49 
C.4.3 Flow Switching Algorithms .......................................... C-50 
C.4.4 Alarms ..................................................................... C-53 

C.5 Batch Stack........................................................................... C-53 
C.5.1 Conf iguring the Batch Stack Through the PCSetup Editor  
 ............................................................................... C-54 
C.5.2 Configuring the Batch Stack with the System Editor ........ C-56 
C.5.3 Conf iguring the Batch Stack through the Front Panel Display 
 ............................................................................... C-58 
C.5.4 Slot Edit Commands (Front Panel Display) .................... C-59 
C.5.5 Configuring the Batch Stack f rom the Webserver............ C-64 
C.5.6 Slot Edit Commands (Webserver) ................................ C-65 

C.6 Basic Batching Setup.............................................................. C-69 
 
 
This appendix primarily covers batching on a liquid system and 
provides an overview of the three batching methods the S600+ 
supports: standalone station, supervised station, and standalone stream.  

Notes: 

 You must select Batching and a Product Table option in your initial 
S600+ configuration in order to perform a batching operation. 

 You must configure at least one Product Table prior to starting a 
batch. For more information, refer to Product Table. 

 If you have two stations, you must configure both stations for 
batching in your initial S600+ configuration. 

 Batching assumes that the densitometer is at the station header 
(Station Option 3 in the wizard). Density inputs at the stream level 
(Stream options 3, 4 and 5 in the wizard) are not supported. 
 An S600+ running firmware version 6.22 or greater cannot use a 

batching configuration created with a Config600 version prior to 
3.2.7.0. In this situation, you must create a new configuration. 

 The Batch Stack, Product Table, and Product Interface Detection 
features are not implemented in gas batching. 



Config600 Configuration Software User Manual 

C-2 Batching Revised January 2023 

C.1 Batching Overview 
Batching provides the control process for loading a defined quantity of 
product. The process is run as a sequence stepping through a series of 
stages.  
During a batch, each stream is assigned a volume or mass total to flow; 
the data passes to the stream that then controls its own batch through 
the various batch stages, which may include opening and closing 
stream valves and regulating the flow using a flow control valve. 

An operator or supervisory computer can set the batch quantity and 
specify a startup flowrate, a nominal flowrate for the main body of the 
batch, and a top off flowrate at the end of batch to provide an accurate 
quantity. The quantity can be measured by volume or mass. 
The batch can be controlled from the station that distributes the flow 
across available streams configured within the same S600+. It does not 
work with streams in separate S600+ flow computers, such as 
requiring a comms link. Each stream then runs its own batch. The 
sequence can be stepped along automatically by the station or it can be 
supervised by a remote host computer. 
Alternatively, each stream can control its own batch sequence in a 
standalone mode 
The station sequence employs flow switching to open and close 
streams according to their availability and the required flowrate. 
The batch sequence also provides a mechanism for retrospective 
adjustment of totals if the K-factor or meter factor changes during the 
batch. The process occurs at the stream and can be done either at most 
stages during the batch once flow starts or at the end of batch (if you 
enable user stages). The adjustment automatically reflects in the station 
totals. However, the adjustment can be made only once though the 
S600+ uses the new K-factor/meter factor in subsequent totalisation. 

Note: This adjustment method is not valid for applications using K-
factor/meter factor linearisation because it is difficult to derive 
an accurate historic K-factor/meter factor. 

C.1.1 Product Table 
The product table allows you to define up to 16 sets of constants for 
the Observed Density Correction / Standard Density Correction 
calculations at run time. This is useful for batching applications where 
the product being metered changes. The product details are sent to the 
stream when a batch starts or if the operator manually changes the 
product number at the station. 
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Notes: 

 If the product table with meter factor curve option was selected, 
then remember to setup the associated product Meter factor / K-
factor curve on the Linearisation form. Please refer to the Stream 
Configuration document. 

 The active product can be changed at run time via the station menu 
PRODUCT TABLE. 

1. Select Product Table from the hierarchy menu. The Product Table 
screen displays in the right-hand pane.  

 

Figure C-1. Product Table Options  

2. Indicate a product in the Product Selection field. Click  to 
display all valid products (product range is 1 through 16).  

3. Enter the Product Details for the selected product.   
Field Description 
Density Unit Indicates the density units the S600+ uses for the 

density correction calculations. Click  to display all 
valid values.  

 DEG.API Use degress API. 
 S.G. Use specific gravity. 
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Field Description 
 KG/M3 Use kilograms per cubic meter. The 

default is KG/M3. 
 CH. 11 

2004/7 
CUST 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Imperial Units. 

 CH. 11 
2004/7 
METRIC 

Use API MPMS Chapter 11.1 2004, 
Addendum 1, 2007 Metric Units. 

 NORSOK I-
105 

Use I-105 Appendix D density 
correction. 

Iteration Type Indicates the iteration type for the density correction 
calculations.  Click  to display all valid values. 

 ASTM Use the iterative temperature and 
pressure correction as defined by 
ASTM/API, Chapter 12. 

 IP2 Use the iterative temperature and 
pressure correction as defined in IP 
Paper 2 (ISO 92-1). The default is IP2. 

   
Hydrometer 
Correction 

Indicates whether the S600+ applies the hydrometer 
correction values to the calculation. 

 NO Do not apply hydrometer correction 
values. The default is NO. 

 YES Do apply hydrometer correction values. 
Product Type Indicates the type of petroleum product involved in the 

calculation. Click  to display all valid values. The 
default is A CRUDE. 

 A CRUDE If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1980 
Tables 53A and 54A.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59A and 60A. 
If  Density Table Units = SG, Petroleum 
Measurement Tables 1980 Tables 23A 
and 24A. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5A and 6A. 
If  Density Table Units = CH.11 2004/7, 
Cust API MPMS Chapter 11 2004. 
If  Density Table Units = CH.11 2004/7, 
Metric API MPMS Chapter 11 2004. 
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Field Description 
 B REFINED If  Density Table Units = KG/M3 and 

reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1980 
Tables 53B and 54B.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59B and 60B. 
If  Density Table Units = SG, Petroleum 
Measurement Tables 1980 Tables 23B 
and 24B. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5B and 6B. 
If  Density Table Units = CH.11 2004/7, 
Cust API MPMS Chapter 11 2004. 
If  Density Table Units = CH.11 2004/7, 
Metric API MPMS Chapter 11 2004. 

 C SPECIAL If  Density Table Units = KG/M3, 
Petroleum Measurement Tables 1980 
Table 54C. 
If  Density Table Units = SG, Petroleum 
Measurement Tables 1980 Tables 23C 
and 24C. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5C and 6C. 
If  Density Table Units = CH.11 2004/7, 
Cust API MPMS Chapter 11 2004. 
If  Density Table Units = CH.11 2004/7, 
Metric API MPMS Chapter 11 2004. 
Note: Table 53C is not implemented as 

the assumption is made that the 
base density is already known. 
This is because Table 53C 
allows for a keypad entry of 
Alpha, and if this is known then 
the base density would be 
known. 

 D LUBE OILS If  Density Table Units = KG/M3 and 
reference temperature = 15 Deg C, 
Petroleum Measurement Tables 1982 
Tables 53D and 54D.  
If  Density Table Units = KG/M3 and 
reference temperature = 20 Deg C, 
Petroleum Measurement Tables 1988 
Tables 59D and 60D. 
If  Density Table Units = SG, Petroleum 
Measurement Tables 1982 Tables 23D 
and 24D. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1982 
Tables 5D and 6D. 
If  Density Table Units = CH.11 2004/7, 
Cust API MPMS Chapter 11 2004. 
If  Density Table Units = CH.11 2004/7, 
Metric API MPMS Chapter 11 2004. 
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Field Description 
 LIGHT 1986 ASTM-IP-API Petroleum Measurement 

Tables for Light Hydrocarbon Liquids 
1986 Tables 53 and 54. 

 ASTM IP 
1952 

ASTM-IP Petroleum Measurement 
Tables 1952 Tables 23, 24, 53 and 54. 

 TABLE 
LOOKUP 

S600+ reads values from a file in the 
Config600 3.0/Config/Project 
Name/extras directory and transfers that 
data into the S600+ with the 
configuration file. The default files hold 
values for for the ASTM-IP Petroleum 
Measurement Tables 1952 Tables 5 
and 6. 

 USER K0K1 If  Density Table Units = KG/M3, 
Petroleum Measurement Tables 1980 
Tables 53A and 54A with user entered 
values K0 and K1. 
If  Density Table Units = SG, Petroleum 
Measurement Tables 1980 Tables 23A 
and 24A with user entered values K0 
and K1. 
If  Density Table Units = DEG API, 
Petroleum Measurement Tables 1980 
Tables 5A and 6A with user entered 
values K0 and K1. 

 LIGHT TP25 GPA TP-25 1998 (API Tables 23E and 
24E). 

 AROMATICS 
D1555-95 

ASTM D1555-95 Table lookup. 

 LIGHT TP27 GPA TP-27 2007 (API Tables 23E, 
24E, 53E, 54E, 59E and 60E). 

 AROMATICS 
D1555M-00 

ASTM D1555M-00 Table lookup. 

 AROMATICS 
D1555M-04A 

ASTM D1555M-04a Calculation. 

 AROMATICS 
D1555M-08 

ASTM D1555M-08 Calculation. 

 STO5.9 08 B1 
UGC 

Gazprom STO-5.9 2008 Addendum B.1 
Unstable Gas Condensate. 

 STO5.9 08 B2 
SLH 

Gazprom STO-5.9 2008 Addendum B.2 
Stable Liquid Hydrocarbon. 

 STO5.9 08 B3 
WFLH 

Gazprom STO-5.9 2008 Addendum B.3 
Wide Fraction Liquid Hydrocarbon. 

CPL 
Calculation 

Indicates the specific CPL calculation the S600+ 
uses to calculate the liquid pressure correction 
factor for the selected product. Click ▼ to display 
all valid values. 
Note:  This f ield does not display if you select 
Density Table Units CH.11 2004 CUST or CH.11 
2004 METRIC or a Gazprom Product Type 
because these standards also specify the CPL 
calculation. 

 OFF No CPL calculation. 
 API1121 API MPMS Ch.11.2.1 1984. 
 API1122 API MPMS Ch.11.2.1 1986. 
 API1121M API MPMS Ch.11.2.1M 1984. The 

default is API1121M. 
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Field Description 
 API1122M API MPMS Ch.11.2.1M 1986. 
 CONSTANT Use a value you enter. 
 DOWNER Paper entitled Generation of New 

Compressibility Tables for 
International Use presented by L. 
Downer 1979. 

Rounding Indicates whether the S600+ rounds the calculation 
results for the selected product. Click ▼ to display 
all valid values. 

 OFF No rounding occurs. The default is 
OFF. 

 NATIVE Rounding to the rules specified in the 
selected calculation standard. 

 API Ch.12.2 
Part 2 

Rounding to API MPMS Ch.12.2 Part 
2 – Measurement Tickets 1995. 

 API Ch.12.2 
Part 3 

Rounding to API MPMS Ch.12.2 Part 
3 – Proving Reports 1998. 

 Flocheck Rounding to Emerson Flocheck 
verif ication software package. 

 ASTM 
D1250-04 
Ch. 11 

API MPMS Ch.11.1 2004 (ASTM 
D1250-04) method to round to the 
Petroleum Measurement Tables 
1980 Tables. 

 DECC 1980 DTI/DECC requirements for 
Petroleum Measurement Tables 
1980 Tables. No rounding occurs and 
an iteration tolerance of 0.0001. 

Reference 
Temp 

Sets the reference temperature for the correction 
calculations. The default is 15 degrees C. 

Alpha Sets the coefficient of thermal expansion. The 
default is 0. 

FFactor Sets the compressibility factor for the liquid (also 
known as the beta factor). The default is 0. 

PE Calculation PE Calculation provides a method to calculate the 
f luid Equilibrium Vapour Pressure for the selected 
product. The PE Calculation is normally assumed to 
be zero, but you may use it for Natural Gas Liquids 
(NGL) and similar applications. 

 OFF S600+ does not use a PE 
Calculation. The default is OFF. 

 GPA TP-15 
1988 EQN 2 

Calculate using the GPA TP-15 1988 
Equation 2. 

 GPA TP-15 
2003 EQN 2 

Calculate using the GPA TP-15 2003 
Equation 2. 

 GPA TP-15 
1988 EQN 3 

Calculate using the GPA TP-15 1988 
Equation 3. 

 GPA TP-15 
2003 EQN 4 

Calculate using the GPA TP-15 2003 
Equation 4. 

Observed 
Density 

Sets the observed density for the selected product. 

Base Density Sets the base density for the selected product. 
Pe Calculation Sets the observed equilibrium vapour pressure (Pe) 

for the selected product. 
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C.1.2 Station Batch Setup 
To configure the Batching application:  

1. Select Batching from the hierarchy menu. The system displays the 
associated settings in the right-hand pane. 

 

Figure C-2. Station Batching 

2. Complete the following fields. 
Field Description 
Batch Type Identif ies the type of batch. Click ▼ to display 

all valid values.  
Note: If  you require a simple daily batch 

volume report, you can request this 
through the Reports screen. Click 
Reports Editor to access the Reports 
option on the hierarchy menu. 
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Field Description 
 VOL LOAD Bases the batch on GUVOL 

f low. This is the default.  
 All stages are followed 

(Def ine, start, nominal, top-
of f, terminate etc). 

 Batch automatically goes to 
COMPLETE once the 
required volume has been 
loaded. 

 Current batch information is 
copied to previous and 
FWA reset on start of new 
batch. 

 MASS 
LOAD 

Bases the batch on mass flow. 
 All stages are followed 

(Def ine, start, nominal, top-
of f, terminate etc). 

 Batch automatically goes to 
COMPLETE once the 
required mass has been 
loaded. 

 Current batch information is 
copied to previous and 
FWA reset on start of new 
batch.  

 DIGIN Triggers batches by the station 
digital input BCH START.  
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept 
TERMINATE command 
(operator) only. 

 Uses a digital input to do a 
RESTART – which will copy 
current batch data to 
previous and reset 
(including FWA). 

 INTERFACE Bases the batch on the 
dif ferences in density (see 
Section C.1.3 Product Interface 
Detection).  
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept 
TERMINATE command 
(operator) only. 

 Uses a density change to 
do a RESTART – which will 
copy current batch data to 
previous and reset 
(including FWA). 
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Field Description 
 BASE TIME 

1 
Bases the batch on the "Base 
Time 1" hour. Each batch lasts 
one day. 
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept 
TERMINATE command 
(operator) only. 

 Uses a day change to do a 
RESTART – which will copy 
current batch data to 
previous and reset 
(including FWA). 

 BASE TIME 
2 

Bases the batch on the "Base 
Time 2" hour. Each batch lasts 
one day. 
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept 
TERMINATE command 
(operator) only. 

 Uses a day change to do a 
RESTART – which will copy 
current batch data to 
previous and reset 
(including FWA). 

 BASE TIME 
3 

Bases the batch on the "Base 
Time 3" hour. Each batch lasts 
one day. 
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept 
TERMINATE command 
(operator) only. 

 Uses a day change to do a 
RESTART – which will copy 
current batch data to 
previous and reset 
(including FWA). 
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Field Description 
 CONT VOL 

LOAD  
Bases the batch on GUVOL 
f low and a new batch is 
automatically triggered when 
the current batch ends. A new 
batch can be triggered 
manually, before the required 
quantity is achieved, by using 
the RESTART command. 
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept RESTART 
command (operator) or 
TERMINATE command 
(operator) only. 

 Uses a USER 
START/STOP object to do 
a RESTART – which will 
copy current batch data to 
previous and reset 
(including FWA). 

Notes:  
 Select this option only if the 

f low is continuous. 
 The current f low weighted 

average values are copied 
to the previous flow 
weighted average values if 
a RESTART is performed 
when there is f low. 
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Field Description 
 CONT 

MASS 
LOAD 

Bases the batch on mass flow 
and a new batch is 
automatically triggered when 
the current batch ends. A new 
batch can be triggered 
manually, before the required 
quantity is achieved, by using 
the RESTART command. 
 Uses DEFINE command 

(operator) and goes straight 
to MONITOR MODE. 

 Will then accept RESTART 
command (operator) or 
TERMINATE command 
(operator) only. 

 Uses a USER 
START/STOP object to do 
a RESTART – which will 
copy current batch data to 
previous and reset 
(including FWA). 

Notes:  
 Select this option only if the 

f low is continuous. 
 The current f low weighted 

average values are copied 
to the previous flow 
weighted average values if 
a RESTART is performed 
when there is f low. 

Supervised Indicates the point from which the batch is 
controlled. Leave this option blank to permit 
the batch to automatically step through each 
phase. Select this option if you intend either to 
manually monitor the process or have a 
supervisory computer monitor the batch 
process. 
Note: If  Supervised is selected at the station, 

only a subset of batch commands are 
accepted and only VOL LOAD and 
MASS LOAD Batch Types are 
supported. 

User Stages User stages provide a halt in the sequence 
waiting for the sequence stage number to be 
changed. This is normally handled by a 
LogiCalc which you can edit to provide user 
specific logic as the prove progresses. If the 
stage number does not change, the sequence 
will not progress past these stages. Click ▼ to 
display all valid values. 

 DISABLED S600+ does not execute user 
stages. The default is 
Disabled. 

 ENABLED S600+ executes user stages 
and requires a LogiCalc. 
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Field Description 
 ARAMCO Enables specific application 

features. If you require this 
feature, contact Technical 
Support. 

Pwr Fail Mode Sets how the system handles the currently 
running batch after a power cycle.  

 CONTINUE 
BATCH 

Continues the batch after 
power is resumed.  

 START 
NEW 
BATCH 

Stops the batch that started 
before the power failure and 
starts a new batch when the 
power resumes.  

 STOP 
BATCH 

Stops the batch that started 
before the power failure after 
the power resumes.  

Max Duration Sets the maximum number of days a batch will 
run. The batch restarts after the max duration 
has been reached. 

Prealarm 
Setting 

Triggers an operator warning based on the 
batch’s percentage of completion. Indicate a 
percentage value (such as 95) to raise a 
warning alarm or set a value of 100 to disable 
this alarm. 

Std. Vol. 
Source 

Indicates if the corrected volume is used for the 
batch quantity. Click ▼ to display all valid 
values.  
NO Use the uncorrected volume as 

the batch quantity. This is the 
default. 

YES Use the corrected volume as the 
batch quantity. 

Reports Editor Click Reports Editor to display a screen 
identifying the reports currently associated with 
your configuration. 

Density 
Change Limit 

Sets the minimum change in density, per m3 or 
second, for which an interface should be 
f lagged. All density variations which are below 
this limit are ignored by the algorithm. If the 
ROC Algorithm option is set to VOLUME, the 
parameter is specified in units of density 
divided by units of volume. If  the ROC 
Algorithm option is set to TIME, the parameter 
is specified in units of density divided by units 
of  time. 

Line Pack Sets the amount of product that is required to 
pass between the moment a valid interface has 
been detected at the station densitometer and 
the moment the interface is actually flagged 
(reported) – when the interface has reached the 
stream meter. The line pack is expressed as a 
volume. If you set the parameter to 0, the 
interface is flagged as soon as the algorithm 
detects it at the station densitometer. Refer to 
f igure Figure C-6. 
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Field Description 
Slops Handling Sets how the system handles transmix 

(“slops”). Valid options are: 
 ADD TO 

NEXT 
The slops (transmix) is 
considered part of the batch 
that just started. The interface 
is considered to be right at the 
boundary between the end of 
the previous product and the 
start of the slops. 

 ADD TO 
CURRENT 

The slops (transmix) is 
considered part of the batch 
that just ended. The interface is 
considered to be right at the 
boundary between the end of 
the slops and the start of the 
next product. 

 SEPARATE The slops (transmix) is 
considered to be a separate 
batch. Its properties are 
considered to be the same as 
the batch that just ended. 

ROC Algorithm Sets how the system computes the density rate 
of  change. Valid values are:  

 TIME Rate of  change is computed as 
the change in density with 
respect to time. 

 VOLUME Rate of  change is computed as 
the change in density with 
respect to volume. 

 

3. Complete the Required, Startup, and Top-off values for both 
Quantities and Flowrates, so that:  

 
Figure C-3. Flowrate Totals  
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Where: 

A Startup flowrate. 
B Nominal f lowrate. 
C Top-off flowrate. 
D Startup volume. 
E Nominal volume. 
F Top-off volume. 

4. Click on the hierarchy menu when finished. A confirmation dialog 
box displays. 

5. Click Yes to apply your changes. The PCSetup screen displays.  

C.1.3 Product Interface Detection 
The Product Interface Detection logic detects and flags the boundary 
between two adjacent products, determining the end of one product 
and the beginning of another.  
To enable Product Interface Detection, you must first enable the 
Batching option at the station level when generating a new 
configuration file. You enable the option only at the station level, 
although you can configure the option for each station independently. 
The option runs in the background once started, monitors density 
changes in a fixed volume of product, and flags any interfaces.  
You define four parameters to configure the Product Interface 
Detection algorithm, which you access either through PCSetup, the 
S600+’s front panel, or Webserver.   

 To access the parameters from PCSetup, select Station (number) > 
Batching. 

 To access the parameters from the front panel or the Webserver, 
select Operator > Station (number) > Batch I/F. 
 

Configuration The options below are available via PCSetup, front panel and 
webserver. For more information, refer to C.1.2 Station Batch 
Setup. 
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Figure C-4. Product Interface Detection Form (in PCSetup)  

Functionality By comparing product densities in the same unit of volume, the 
algorithm notes changes in base density over a fixed amount of 
product. When the algorithm detects a change above a certain 
configurable limit it marks an interface. The algorithm performs 
an average rate of change check to filter out small changes in 
density or sudden density spikes 
The rate of change of density varies depending on the process 
conditions and the relative density of the two products. Generally, two 
products with similar densities mix much more than two products with 
largely different densities. The rate of change in density in the first 
case is lower than the rate of change in the second case. 

Figure C-5. uses three products (A, B, and C) in an idealized example 
of how the algorithm works. The density of Product A (100 [units of 
density]) is much closer to the density of Product C (700 [units of 
density]) than to the density of Product B (900 [units of density]). 
Accordingly, the transition from Product A to Product B is much faster 
(in terms of units of volume) than the transition from Product A to 
Product C. The rates of change can be seen in the following graphic: 
 From Product A to Product B: ROC = 200 [units of density / units 

of volume] 
 From Product A to Product C: ROC = 100 [units of density / units 

of volume] 
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The algorithm computes the average rate of change (ROC) over a fixed 
number of volume or time units. If the computed ROC is greater than 
the operator-entered ROC, the algorithm considers this variation as a 
change in product and flags it. Otherwise, the algorithm ignores the 
change. 

The following graphic shows three different operator-set ROC limits 
(indicated by the dashed lines): 300 [units of density / units of 
volume], 150 [units of density / units of volume], and 75 [units of 
density / units of volume].  

The three operator-set limits depict three different situations. If the 
ROC limit is set too high for the product density changes for that 
particular pipeline, then the algorithm ignores all transitions. If the 
ROC limit is set too low, then the algorithm picks up most transitions 
but it might also pick up unwanted transitions. For the algorithm to 
work properly, you must set the ROC lower than the lowest product 
transitions for that mix. 

 
Figure C-5. Idealised Example of Transitions between Products with Different Densities  
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Figure C-6. Product Interface Detection Algorithm (Line Pack at 300 m3) 

C.1.4 Slops Handling Examples   
The three following examples show how the system handles slops, 
based on the option (respectively, Add to Current, Add to Next, or 
Separate) you select in the Slops Handling field.   

 
Figure C-7. Slops Handling Examples  
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Legend  
PD Point of Detection; the point at which the densitometer 

f irst detects the interface 
PR Point of Report; the point at which the meter reports 

the interface  
Line Pack The dif ference in volume between PD and PR 
T1, T2, T3, etc. Points (or triggers) in the flowing product at which an 

interface is triggered  

C.2 Batch Sequence and Control 
The sequence can be stepped along automatically by the station or it 
can be supervised by a remote host computer. Each stream can control 
its own batch sequence in a standalone mode.  
Before you initiate a batch, ensure that the Delivery/Receipt and 
Official/Unofficial modes are correctly configured on the S600+’s 
front panel displays (BCH CURR INPUTS).  

The S600+ flow computer’s front panel display provides the following 
commands you can use to control the batch sequence (Operator > 
Station > Batch > Batch Command):  
Display Description 
Define Accept the load parameters and reset batch totals. 
Start Open valves and commence startup flow. Available 

only for the VOL LOAD and MASS LOAD batch 
types. 

Nominal Ramp up to the nominal flowrate. Available only for 
the VOL LOAD and MASS LOAD batch types.  
Note:  Command will be rejected if Supervised is 

selected at the station. 
Topoff Ramp down to the top-off flowrate. Available only 

for the VOL LOAD and MASS LOAD batch types.  
Note:  Command will be rejected if Supervised is 

selected at the station. 
Hold Pause the batch. Available only for the VOL LOAD 

and MASS LOAD batch types. 
Note:  Command will be rejected if Supervised is 

selected at the station. 
Terminate End the batch. 
Restart Stops the current batch and starts a new one. 

Available only for the CONT, VOL LOAD and 
CONT, MASS LOAD batch types. 
Notes:  
 Select this option only if the flow is continuous. 
 The current f low weighted average values are 

copied to the previous flow weighted average 
values if  a RESTART is performed when there 
is f low. 

 Command will be rejected is Supervised is 
selected at the station. 
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C.2.1 Batch Sequence Stages 
The batch sequence functions in stages. Table C-1 shows the complete 
list of station stages for a typical application batching scenario.  

Table C-1. Station Batch Sequence Stages 
Stage Display Description 

0 IDLE Halted: idle, await Define command 
1 WAIT SAMPLER Wait for the sampler to reset 
2 BATCH DEFINED Halted: await Start command 
3 WAIT STREAMS 

START 
Wait for streams to start 

4 BEGIN STARTUP Set the startup flowrate, wait for station flowrate > startup flowrate 
5 IN STARTUP Wait for station total > startup volume 
6 BEGIN NOMINAL Set the nominal flowrate, wait for station flowrate > nominal flowrate 
7 IN NOMINAL Wait for station total > (specified – top-off) total 
8 BEGIN TOPOFF Set the top-off flowrate, wait for station flowrate > top-off flowrate 
9 IN TOPOFF Wait for station total > specified total 
10 BEGIN HOLD Suspend flow, wait for station flowrate = 0 
11 IN HOLD Halted: await Start or Terminate command 
12 STREAM BATCH Not implemented 
13 WAIT STREAMS 

CLOSE 
Wait for station flowrate = zero 

14 WAIT STREAMS END Wait for streams to return Idle 
15 BATCH COMPLETE Print report, return to Idle 
16 BATCH MONITOR Halted: await a stage change. 
17 WAIT RECALC CMND Halted: await Recalc or Terminate command 
18 RECALCULATING Wait for streams to return Recalc Complete 
19 TERMINATING Wait for streams to return to Idle 
20 RECALCULATE 

COMPLETE 
Halted: await Terminate command or an external stage change 
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C.2.1.1 Station Sequence Stage Descriptions 
Table C-2 shows all the stages of a default batch sequence.  

Table C-2. Batch Sequence Stages (Complete)  
Sequence 

Stage 
 
Description 

0 Halted: Idle 
Wait for the Define command to start the sequence. 
If  the batch permit state is OK, then: 
 Increment the batch number, max 9999. 
 Record the cumulative totals. 
 Command available streams to initialise (via Define command to each stream batch 

task). 
Streams are available if: 
 Stream berth no = station berth no displays as STATION NO. 
 Stream control type = supervised. 
 Stream f low switching is enabled. 
 Stream batch permit is enabled. 
 Initialise the sampler. 
Proceed to the next stage. 

1 Wait for Sampler to Reset 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Batch Complete stage. 
Check the sampler status. 
If  the sampler is reset or the stage times out, then: 
Proceed to the next stage. 

2 Halted: Batch Defined 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Batch Complete stage. 
Wait for the Start command then proceed to the next stage. 

3 Wait for Streams to Start 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Batch Complete stage. 
Wait for the streams for this berth to indicate they have reset and are ready to start the 
batch (stream status = Batch Monitor). Proceed to the next stage. 
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Sequence 
Stage 

 
Description 

4 Begin Startup 
Set the station flow switching setpoint = batch startup flowrate 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
If  the Hold command is issued, then: 
 Command streams to hold 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Begin Hold stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
If  the required batch total has been achieved (prematurely), then: 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
Wait for the station startup flowrate to be achieved. 
Proceed to the next stage. 

5 In Startup 
Set the station flow switching setpoint = batch startup flowrate 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
If  the Hold command is issued, then: 
 Command streams to hold 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Begin Hold stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
If  the required batch total has been achieved, then: 
Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
Wait for the station startup total to be achieved. 
Proceed to the next stage. 
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Sequence 
Stage 

 
Description 

6 Begin Nominal 
Set the station flow switching setpoint = batch nominal flowrate 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
If  the Hold command is issued, then: 
 Command streams to hold 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Begin Hold stage. 
If  the Top-Off command is issued, then: 
 Go to the Begin Top-off stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
If  the required batch total has been achieved, then: 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
Wait for the station nominal flowrate to be achieved. 
Proceed to the next stage. 

7 In Nominal 
Set the station flow switching setpoint = batch nominal flowrate 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
If  the Hold command is issued, then: 
 Command streams to hold 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Begin Hold stage. 
If  the Top-Off command is issued, then: 
 Go to the Begin Top-off stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
If  the required batch total has been achieved, then: 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
Wait for the station nominal total (= batch – top-off) to be achieved. 
Proceed to the next stage. 
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Sequence 
Stage 

 
Description 

8 Begin Top-Off 
Set the station flow switching setpoint = batch top-off flowrate 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
If  the Hold command is issued, then: 
 Command streams to hold 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Begin Hold stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
If  the required batch total has been achieved, then: 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
Wait for the station top-off flowrate to be achieved. 
Proceed to the next stage. 

9 In Top-Off 
Set the station flow switching setpoint = batch top-off flowrate 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 
If  the Hold command is issued, then: 
 Command streams to hold 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Begin Hold stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
Wait for the required batch total to be achieved, then: 
 Set the station setpoint = 0 
 Command the flow switching to shut down. 
 Go to the Wait Streams Close stage. 

10 Begin Hold 
Set the station flow switching setpoint = 0 
If  the Start command is issued, then: 
 Command the flow switching to start. 
 Go to the Begin Startup stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
Wait for the station flowrate to reduce to zero. 
Proceed to the next stage. 
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Sequence 
Stage 

 
Description 

11 Halted: In Hold 
Set the station flow switching setpoint = 0 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Command the flow switching to shut down. 
 Go to the Wait Streams End stage. 
If  the Start command is issued, then: 
 Command the flow switching to start. 
 Go to the Begin Startup stage. 

12 Stream Batch 
Not currently configured 

13 Wait for Streams Close 
Set the station flow switching setpoint = 0 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Wait Streams End stage. 
Wait for the station flowrate to reduce to zero, then: 
 Command streams to terminate. 
 Command the sampler to stop. 
 Go to the Wait Streams End stage. 

14 Wait for Streams End 
If  the Terminate command is issued, then: 
 Command the sampler to stop. 
 If  User stages are disabled, then: 

Go to the Batch Complete stage. 
else  

Go to the Wait Re-Calc stage. 
If  the User stages are disabled, then: 
 Command the sampler to stop. 
 Wait for the streams to indicate they have individually returned to the Idle stage. 
 Go to the Batch Complete stage. 
else  
 Command the sampler to stop. 
 Wait for the streams to indicate they have individually reached the Wait Re-Calc 

Command stage. 
 Go to the Wait Re-Calc Command stage. 

15 Batch Complete (Station) 
Go to the Idle stage. 

15 Batch Complete (Stream) 
If  the User stages are disabled, then: 
 Handle the totals 
 Go to the Idle stage. 
else 
 Go to the Wait Re-Calc Command stage. 

16 Halted: Batch Monitor 
Used by supervised batching. 
If  the Terminate command is issued, then: 
 Go to the Wait Streams Close stage. 
If  a totals retrospective adjustment is required, then: 
 Carry out the adjustment. 
Wait for the next stage to be determined by the supervisory system.   
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Sequence 
Stage 

 
Description 

17 Halted: Wait Re-Calc Command 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Terminated stage. 
If  the Re-Calc command is issued, then: 
 Command streams to re-calculate. 
 Go to the Re-Calculating stage. 

18 Re-Calculating 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Terminated stage. 
Wait for the streams to indicate they have individually completed their re-calcs. 
Proceed to the Re-Calculate Complete stage. 

19 Terminating 
If  the Terminate command is issued, then: 
 Go to the Idle stage. 
Wait for the streams to indicate they have individually returned to the Idle stage. 
Proceed to the Idle stage. 

20 Halted: Re-Calculate Complete 
If  the Terminate command is issued, then: 
 Command the streams to terminate. 
 Go to the Terminated stage. 
Wait for the stage to be changed externally. 

C.2.1.2 Standalone Station Stages 
Station batching is designed for a station/stream(s) combination within 
the same FloBoss S600+ flow computer. It monitors and controls a 
load using the required batch quantity together with the flow rate 
setpoints for start up, nominal and top off.  

The system supports two modes of batch control:  
 Standalone (the sequence is controlled by the S600+) 
 Supervised, such as by a remote host computer. 

The batch steps through a set of stages where the current stage is 
executed every second. The stage remains the same until an event 
(such as an operator command or the loading of a required volume) 
causes a change.  
Standalone mode enables the FloBoss S600+ station computer to drive 
a batch from start to completion allowing for operator interaction along 
the way. Table C-3 presents the sequence stages for standalone station 
batching. 

Table C-3. Standalone Station Batch Sequence Stages 
Stage Display Description 

0 IDLE Halted: idle, await Define command 
1 WAIT SAMPLER Wait for the sampler to reset 
2 BATCH DEFINED Halted: await Start command 
3 WAIT STREAMS START Wait for streams to start 
4 BEGIN STARTUP Set the startup flowrate, wait for station flowrate > startup flowrate 
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Stage Display Description 
5 IN STARTUP Wait for station total > startup volume 
6 BEGIN NOMINAL Set the nominal flowrate, wait for station flowrate > nominal flowrate 
7 IN NOMINAL Wait for station total > (specified – top-off) total 
8 BEGIN TOPOFF Set the top-off flowrate, wait for station flowrate > top-off flowrate 
9 IN TOPOFF Wait for station total > specified total 

13 WAIT STREAMS CLOSE Wait for station flowrate = zero 
14 WAIT STREAMS END Wait for streams to return Idle – wait for recalculation command if 

user stages are selected 
15 BATCH COMPLETE Print report, return to Idle 

Hold (Suspend Batch)  
10 BEGIN HOLD Suspend flow, wait for station flowrate = 0 
11 IN HOLD Halted: await Start or Terminate command 

Recalc   Note:  Only available if you select User Stages 
17 WAIT RECALC CMND Halted: await Recalc or Terminate command 
18 RECALCULATING Recalculating the totals 
20 RECALC COMPLETE Halted: await Terminate command 

Terminate  
19 TERMINATING Wait streams Idle, go to Station Idle 

 
If user stages are enabled, you can use a LogiCalc to perform specific 
recalculation functions. The folder C:\Users\<username>\Config600 
3.3\lclib\batch includes a sample station batch logicalc. 

C.2.1.3 Supervised Station Stages 
Supervised mode is intended to be controlled from a remote 
supervisory system, but the station still issues individual batch 
commands to the streams. Table C-4 shows the batch sequence stages 
for a supervised station.  

Table C-4. Supervised Station Batch Sequence Stages 
Stage Display Description 
0 IDLE Halted: idle, await Define command 
1 WAIT SAMPLER Wait for the sampler to reset 
2 BATCH DEFINED Halted: await Start command 
3 WAIT STREAMS 

START 
Wait for streams to start 

4 BEGIN STARTUP Remain in Batch Monitor stage 
5 IN STARTUP Remain in Batch Monitor stage 
6 BEGIN NOMINAL Remain in Batch Monitor stage 
7 IN NOMINAL Remain in Batch Monitor stage 
8 BEGIN TOPOFF Remain in Batch Monitor stage 
9 IN TOPOFF Remain in Batch Monitor stage 
16 BATCH MONITOR Halted: await next stage from the supervisory system 
13 WAIT STREAMS 

CLOSE 
Wait for station flowrate = zero 

14 WAIT STREAMS END Wait for streams to return Idle – wait for recalculation command if user 
stages are selected 

15 BATCH COMPLETE Print report, return to Idle 
Hold (Suspend Batch)  

10 BEGIN HOLD Suspend flow, wait for station flowrate = 0 
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Stage Display Description 
11 IN HOLD Halted: await Start or Terminate command 

Recalc   Note:  Only available if you select User Stages. 
17 WAIT RECALC CMND Halted: await Recalc or Terminate command 
18 RECALCULATING Recalculating the totals 
20 RECALC COMPLETE Halted: await Terminate command 

Terminate   
19 TERMINATING Wait streams Idle, go to Station Idle 

 

If user stages are enabled, a LogiCalc can be used to perform specific 
recalculation functions. The folder C:\Users\<username>\Config600 
3.3\lclib\batch includes a sample station batch logicalc.  

C.2.1.4 Standalone Stream Stages 
Standalone mode is intended for a single stream to control a batch with 
no interaction with any other streams or supervisory sequences.  Table 
C-5 shows the batch sequence stages for standalone streams.  

Note: Standalone stream stages require the use of the System Editor 
which is only available with the Config600 Pro software. For 
more information about implementing standalone stream 
stages, refer to How To 83. 

The sequence stage logic is essentially the same as for the station, with 
the addition of:  
 The Startup and Nominal stages can accept Nominal and Top-Off 

commands to move them on to the next stage. 
 The Batch Complete and Re-Calc stages handle enabled user 

stages. 

Table C-5. Standalone Stream Batch Sequence Stages 
Stage Display Description 

0 IDLE Halted: idle, await Define command 
1 WAIT SAMPLER Wait for the sampler to reset 
2 BATCH DEFINED Halted: await Start command 
4 BEGIN STARTUP Set the startup flowrate, wait for station flowrate > startup flowrate 
5 IN STARTUP Wait for station total > startup volume 
6 BEGIN NOMINAL Set the nominal flowrate, wait for station flowrate > nominal flowrate 
7 IN NOMINAL Wait for station total > (specified – top-off) total 
8 BEGIN TOPOFF Set the top-off flowrate, wait for station flowrate > top-off flowrate 
9 IN TOPOFF Wait for station total > specified total 
13 WAIT STREAMS CLOSE Wait for station flowrate = zero 
15 BATCH COMPLETE Print report, return to Idle – wait for recalculation command if user 

stages are selected 
Hold (Suspend Batch)   

10 BEGIN HOLD Suspend flow, wait for station flowrate = 0 
11 IN HOLD Halted: await Start or Terminate command 

Recalc   Note:  Only available if you select User Stages 
17 WAIT RECALC CMND Halted: await Recalc or Terminate command 
18 RECALCULATING Recalculating the totals 
20 RECALC COMPLETE Halted: await Terminate command 
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Stage Display Description 
Terminate   

19 TERMINATING Transfer the batch totals from current to previous, go to Idle 
 

If user stages are enabled, a LogiCalc can be used to perform specific 
recalculation functions. The folder C:\Users\<username>\Config600 
3.3\lclib\batch includes a sample stream batch logicalc. 

C.2.1.5 Supervised Stream Stages 
Supervised mode is controlled either in conjunction with the S600+ 
station batch sequence or from a remote supervisory system.  Table C-
6 shows the batch sequence stages for a supervised stream.  

Table C-6. Supervised Stream Batch Sequence Stages 
Stage Display Description 

0 IDLE Halted: idle, await Define command 
1 WAIT SAMPLER Wait for the sampler to reset 
2 BATCH DEFINED Halted: await Start command 
3 WAIT STREAMS START Wait for streams to start 
4 BEGIN STARTUP Remain in Batch Monitor stage 
5 IN STARTUP Remain in Batch Monitor stage 
6 BEGIN NOMINAL Remain in Batch Monitor stage 
7 IN NOMINAL Remain in Batch Monitor stage 
8 BEGIN TOPOFF Remain in Batch Monitor stage 
9 IN TOPOFF Remain in Batch Monitor stage 

16 BATCH MONITOR Halted: await next stage from the supervisory system 
13 WAIT STREAMS CLOSE Wait for station flowrate = zero 
14 WAIT STREAMS END Wait for streams to return Idle 
15 BATCH COMPLETE Print report, return to Idle 

Hold (Suspend Batch)   
10 BEGIN HOLD Suspend flow, wait for station flowrate = 0 
11 IN HOLD Halted: await Start or Terminate command 

Terminate   
19 TERMINATING Wait streams Idle, go to Station Idle 

  

C.2.2 Retrospective Batch Totals 
The system applies retrospective totals adjustment at the stream.  

Stream batching can run as a standalone (self contained) batch or as 
part of a station (supervised) batch. Both methods support retrospective 
K-factor or meter factor corrections at any stage during the batch after 
flow has started. 

Note: Standalone stream stages require the use of the System Editor 
which is only available with the Config600 Pro software. For 
more information about implementing standalone stream 
stages, refer to How To 83. 

By enabling user stages, you can also apply retrospective totals 
adjustments after a stream batch completes and before it returns to the 
Idle stage. This passes control to the Wait Recalc Command stage 
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rather than the Batch Complete stage (at the station). The sequence 
then halts at this stage until the Recalc command is received. 
For example, if you modify the K-factor or meter factor after a prove, 
the system adjusts each batch total as follows: 
Adjusted total = batch total * ratio 

Where: 

ratio = old K-factor / new K-factor  

or 
ratio = new meter factor / old meter factor 

or 

ratio = GVC1 / GV1 

where:  
GVC1 = corrected gross volume for period 1. 

GV1 = gross volume for period 1. 

Further K-factor / meter factor changes do not invoke this correction 
but the S600+ uses the latest value in subsequent totalisations. 

Retrospective adjustment is not applied to Indicated Volume totals. 

Note: This adjustment method is not valid for applications using K-
factor / meter factor linearisation because it is difficult to derive 
an accurate historic K-factor / meter factor. 

C.2.3 Batch Alarms 
The system generates alarms at the following events:  

 Batching not permitted.  

 Pre-warning of batch approaching completion. 

 Batch complete. 

C.2.4 Batch Ticket 
Following is a sample batch ticket:  

================================================================================  
    1                     BATCH TICKET – STATION 1 

                 PRINT DATE/TIME:  02/04/2021 06:28:48  
              (X)DELIVERY ( )RECEIPT TICKET   264  
                (X)OFFICIAL ( )UNOFFICIAL  
                ( )RECALCULATED ( )ACCEPTED             
 1. BATCH NUMBER                                                        16  
 2. TYPE OF LIQUID                                                 A CRUDE  
 3. METER CLOSING READING (DATE/TIME)                  02/04/2021 06:28:45    
 4. METER OPENING READING (DATE/TIME)                  02/04/2021 06:12:04    
 5. NET DELIVERY/RECEIPT TIME                            0: 16      h : m  
 6. METER CLOSING READING IVOL                            1072502   m3        
 7. METER OPENING READING IVOL                            1068499   m3        
 8. IVOL                                                     4002   m3        
 9. GUVOL                                                4002.320   m3        
10. AVERAGE FLOW RATE                                     14394.0   m3/h      
11. OBS DENSITY                                          750.0000 ! kg/m3     
12. OBS TEMP                                                11.00 ! Deg.C     
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13. BASE DENSITY AT  15.0 Deg.C                             750.0 ! kg/m3       
14. AVERAGE WEIGHTED TEMPERATURE                             1.00   Deg.C     
15. AVERAGE WEIGHTED PRESSURE                                5.00   barg     
16. BS&W                                                   60.000 ! %           
17. BS&W CORRECTION FACTOR                                 60.000           
18. NSVOL        AT       Deg.C                          1604.130   Sm3       
19. NSVOL        AT  15.0 Deg.C                          1604.130   Sm3       
20. NETT MASS   (METRIC)                                  1203.11   tonne     
21. NETT MASS                                             2406.22   tonne 
 
NON-NEGOTIABLE, NON-TRANSFERABLE 
CHECKED FOR ___________________ 
BY: ____________________________________ DATE: ___________        
 
WITNESSED 
BY: ____________________________________ DATE: ___________        
 
 
    1                     BATCH TICKET – STREAM 1 

                 PRINT DATE/TIME:  02/04/2021 06:28:48  
METER MANUFACTURER:    METER MAN             
METER MODEL:           METER MODEL           
METER SERIAL NUMBER:   METER SERIAL NO       
METER TAG NUMBER:      METER TAG             
METER SIZE:            0.00   mm             
NOMINAL K-FACTOR:     100.0   pls/m3         
  
PRIMARY FLOW COMPUTER: 00:A0:D8:F8:00:24  
  
 1. BATCH NUMBER                                                        16  
 2. TYPE OF LIQUID                                                 A CRUDE  
 3. METER CLOSING READING (DATE/TIME)                  02/04/2021 06:28:45  
 4. METER OPENING READING (DATE/TIME)                  02/04/2021 06:12:04  
 5. NET DELIVERY/RECEIPT TIME                            0: 16      h : m  
 6. METER CLOSING READING IVOL                            1072502   m3  
 7. METER OPENING READING IVOL                            1068499   m3  
 8. IVOL                                                     4002   m3  
 9. AVERAGE FLOW RATE                                     14394.0   m3/h  
10. GUVOL                                                4002.320   m3  
11. AVERAGE METER FACTOR                                   1.2536    
12. OBS DENSITY                                          750.0000 ! kg/m3  
13. OBS TEMP                                                11.00 ! Deg.C  
14. BASE DENSITY AT  15.0 Deg.C                             750.0 ! kg/m3  
15. AVERAGE WEIGHTED TEMPERATURE                             1.00   Deg.C  
16. AVERAGE WEIGHTED PRESSURE                                5.00   barg  
17. CTLM                                                   0.9876    
18. CPLM                                                   1.0101    
19. BS&W                                                   60.000 ! %  
20. BS&W CORRECTION FACTOR                                 60.000  
21. CCFM                                                   0.9975  
22. CCFM BSW                                               0.9975  
23. NSVOL        AT       Deg.C                          1604.130   Sm3  
24. NSVOL        AT  15.0 Deg.C                          1604.130   Sm3  
25. NETT MASS   (METRIC)                                  1203.11   tonne  
26. NETT MASS                                             2406.22   tonne  
 
NON-NEGOTIABLE, NON-TRANSFERABLE 
CHECKED FOR ___________________ 
BY: ____________________________________ DATE: ___________        
 
WITNESSED 
BY: ____________________________________ DATE: ___________        
 
================================================================================  
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C.3 Batch Recalculation  
Batch recalculation enables the recalculation of batch totals based on a 
newly modified observed density, observed temperature, observed 
pressure, meter temperature, meter pressure, or modified BS&W (for 
crude oil). It should be noted that the recalculation of totals takes into 
account the units and rounding option configured for the product.  

When triggered by an operator-issued recalculation command, the 
system recalculates the totals for the selected batch ticket according to 
specific settings. You can run recalculation for a specific day for a 
selected batch, for either the current batch or for a chosen historical 
batch ticket. You can enter values for the density, temperature, 
pressure, meter temperature, meter pressure and BS&W manually or 
use the flow weighted average. 

C.3.1 Displays 
The following tables describe the displays associated with the batch 
totals recalculation. Access the displays through the S600+ front panel 
or web browser.  

For station recalculations the menus can be found by navigating to 
Operator>Station n> (where “n” is the station number). For stream 
recalculations navigate to Operator>Station n> (where “n” is the 
stream number).  
The BCH CURR BASE DENS (Station), BCH CURR BS&W 
(Station), BCH CURR RECALC (Station), BCH 
CURR RESULTS (Station and Stream), BCH CURR MTR TEMP 
(Stream) and BCH CURR MTR PRESS (Stream) menu locations 
include the displays which deal with the current batch ticket. 

The RECALL TICKET (Station), RECALL BASE DENS (Station), 
RECALL BS&W (Station), RECALL RECALC (Station), RECALL 
RESULTS (Station and Stream), RECALL MTR TEMP (Stream) and 
RECALL MTR PRESS (Stream) menu locations include the displays 
which deal with a recalled historic batch ticket. 
Some of the displays behave differently although they are the same for 
both current and recalled batch tickets. These differences are described 
below. To distinguish between the CURRENT and the RECALL 
displays, their descriptions were prefixed with C. and R., respectively. 

Table C-7. BATCH CONTROL and RECALL TICKET Displays 
Display Description 
TICKET NUMBER Identif ies the batch ticket the recalculation will be 

performed on. The number must be a valid batch 
ticket. If viewed from the BATCH CONTROL menu 
this location indicates the number of the current/last 
ticket and cannot be changed. If viewed from the 
RECALL TICKET menu you can change the value of 
this location to select the desired batch ticket for 
which the calculations should be performed.  

BATCH NUMBER Sets the operator entered batch number  
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Display Description 
DAY NUMBER Indicates the total number of days in the currently 

selected batch ticket 
OFFICIAL/ 
UNOFFICIAL 

Determines whether this is an official or unofficial 
batch. Valid values are OFFICIAL (the BATCH 
NUMBER increases by one) or UNOFFICIAL (the 
BATCH NUMBER is 0). This must be set before 
starting a batch. Found only a station level in the 
BATCH CONTROL menu.  

DELIVERY/ 
RECEIPT 

Determines whether this is a delivery or a receipt. 
Values: YES, NO. This must be set before starting a 
batch. Found only at station level in the BATCH 
CONTROL menu. 

Table C-8. BCH CURR BASE DENS and RECALL BASE DENS Displays 
Display Description 
BASE DENSITY 
(BATCH) 

Shows the flow weighted average value for the 
selected batch. 
Note: This value is found only at the station level. 

RECALC BASE 
DENSITY 

Sets the base density value that the system uses in 
recalculations. The system uses this value only if 
you set the BASE DENSITY SOURCE field to 
RECALC. 
Note: This value is found only at the station level. 

BASE DENSITY 
SOURCE 

Sets the source for base density that the system 
uses for recalculations. Valid values are ORIGINAL 
(use the f low weighted average as the source for the 
base density) or RECALC (use the value in the 
RECALC BASE DENSITY field as the source for 
base density). The default is ORIGINAL. 
Note: This value is found only at the station level. 

BASE DENSITY 
(DAY NO.) 

Shows, for each day, the base density of the 
selected batch. 
Note: This value is found only at the station level. 

Table C-9. STATION BCH CURR BS&W and RECALL BS&W Displays 
Display Description 
BS&W 
(BATCH) 

Shows the BS&W flow weighted average value for 
the selected batch. 
Note: This value is found only at the station level. 

RECALC BS&W Sets the BS&W value that the system uses in 
recalculations.  
Note: This value is found only at the station level. 

BS&W SOURCE Sets the source for BS&W that the system uses for 
recalculations. Valid values are ORIGINAL (use the 
f low weighted average) or RECALC (use the value in 
the RECALC BS&W field).  
Note: This value is found only at the station level. 

BS&W (DAY NO.) Shows, for each day, the BS&W of the selected 
batch. 
Note: This value is found only at the station level. 

Table C-10. STATION BCH CURR MTR TEMP and RECALL METER TEMP Displays 
Display Description 
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Display Description 
MTR TEMP 
(BATCH) 

Shows the flow weighted average value for the 
selected batch. 
Note: This value is found only at the stream level. 

RECALC MTR 
TEMP 

Sets the observed temperature value that the system 
uses in recalculations.  
Note: This value is found only at the stream level. 

MTR TEMP 
SOURCE 

Sets the source for the meter temperature that the 
system uses for recalculations. Valid values are 
ORIGINAL (use the f low weighted average) or 
MANUAL (use the value set in the RECALC MTR 
TEMP f ield).  
Note: This value is found only at the stream level. 

MTR TEMP 
(DAY NO.) 

Shows, for each day, the meter temperature of the 
selected batch. 
Note: This value is found only at the stream level. 

MTR PRESS 
(BATCH) 

Shows the flow weighted average value for the 
selected batch. 
Note: This value is found only at the stream level. 

RECALC MTR 
PRESS 

Sets the meter pressure value that the system uses 
in recalculations.  
Note: This value is found only at the stream level. 

MTR PRESS 
SOURCE 

Sets the source for the meter pressure that the 
system uses for recalculations. Valid values are 
ORIGINAL (use the f low weighted average) or 
RECALC (use the value set in the RECALC MTR 
PRESS field).  
Note: This value is found only at the stream level. 

MTR PRESS 
(DAY NO.) 

Shows, for each day, the meter pressure of the 
selected batch. 
Note: This value is found only at the stream level. 

Table C-11. BCH CURR RECALC and RECALL RECALC Displays 
Display Description 
RECALC 
COMMAND 

Enables the system to perform recalculation with the 
currently set values. Valid values are YES (enable) 
and NO (disable). 

ACCEPT 
COMMAND 

Marks the current values as accepted for the 
selected batch. Valid values are ACCEPT (prevent 
further recalculations) and IDLE (allow further 
recalculations). 
Note: Also a new Batch Ticket is generated which 

indicates that the recalculated values have 
been accepted. 

RECALC DAY Shows the day of the selected batch for which the 
recalculations will be performed.  
Note: This value is found only at the station level. 

DIAGNOSTIC Shows a diagnostic message for the batching and 
recalculation functionality. 

Table C-12. STATION/STREAM BATCH CURR RESULTS and RECALL RESULTS Displays 
Display Description 
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Display Description 
OBS DENSITY Shows the observed density for each day of the 

selected batch ticket and the flow weighted average 
value for the whole batch. 
Note: This value is found only at the station level. 

OBS TEMP Shows the observed temperature for each day of the 
selected batch ticket and the flow weighted average 
value for the whole batch.  
Note: This value is found only at the station level. 

OBS PRESS Shows the observed pressure for each day of the 
selected batch ticket and the flow weighted average 
value for the whole batch. 
Note: This value is found only at the station level. 

BS&W Shows the recalculated BS&W for each day of the 
selected batch ticket and the recalculated flow 
weighted average for the whole batch.  
Note: This value is found at both the stream and 

station levels. 
BASE DENSITY Shows the recalculated base density for each day of 

the selected batch ticket and the base flow weighted 
average for the whole batch. 
Note: This value is found only at the station level. 

BATCH IVOL/ 
GUVOL/GSVOL/ 
NSVOL/SWVOL 

Shows the recalculated volume totals for the 
currently selected batch ticket. It should be noted 
that the recalculation of totals takes into account the 
units and rounding option configured for the product.   
Note: This value is found at both the stream and 

station levels. 
BATCH MASS/ 
NMASS 

Shows the recalculated mass totals for the currently 
selected batch ticket. It should be noted that the 
recalculation of totals takes into account the units 
and rounding option configured for the product. 
Note: This value is found at both the stream and 

station levels. 
TOTAL HOURS Indicates the duration in hours of the currently 

selected batch.  
Note: This value is found at both the stream and 

station levels. 
TOTAL MINUTES Number of minutes elapsed in addition to the TOTAL 

HOURS location.  
Note: This value is found at both the stream and 

station levels. 
FLOWING HOURS Number of hours during which there was flow for the 

selected batch.  
Note: This value is found at both the stream and 

station levels. 
FLOWING 
MINUTES 

Number of minutes during which there was flow for 
the selected batch in addition to the FLOWING 
HOURS location.  
Note: This value is found at both the stream and 

station levels. 
IDLE HOURS Number of hours during which there was no flow for 

the selected batch.  
Note: This value is found at both the stream and 

station levels. 
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Display Description 
IDLE MINUTES Number of minutes during which there was no flow 

for the selected batch in addition to the IDLE 
HOURS location.  
Note: This value is found at both the stream and 

station levels. 
MTR DENSITY This set of  displays shows the recalculated meter 

density for each day of the selected batch ticket and 
the recalculated flow weighted average for the whole 
batch.  
Note: This value is found only at the stream level. 

MTR TEMP This set of  displays shows the recalculated meter 
temperature for each day of the selected batch ticket 
and the recalculated flow weighted average for the 
whole batch.  
Note: This value is found only at the stream level. 

MTR PRESS This set of  displays shows the recalculated meter 
pressure for each day of the selected batch ticket 
and the recalculated flow weighted average for the 
whole batch.  
Note: This value is found only at the stream level. 

BASE DENSITY This set of  displays shows the recalculated base 
density for each day of the selected batch ticket and 
the recalculated flow weighted average for the whole 
batch.  
Note: This value is found only at the stream level. 

C.3.2 Batch Ticket 
The system generates a batch ticket at the beginning of a batch. The 
system updates a ticket with new data and generates a new instance of 
the ticket under the REPORTS>BATCH TICKET location when a 
batch ends, when a recalculation occurs, or when you issue an Accept 
command on a selected ticket.  

Each ticket has a number you can use for recalling the ticket. This 
number appears on the same row as the ()DELIVERY or ()RECEIPT 
TICKET flags and can be read from a generated batch ticket.  
Use the Recall Ticket option to recall the latest instance of the batch 
ticket.  

Note: Data copied from the meter contains values irrespective of 
whether that meter has been flowing. These include (but are not 
limited to) Average Meter Factor, Average K Factor, Average 
Meter Density, CTLM, CPLM and CCFM. 

Following is an example of a batch ticket.   
================================================================================  
    1                     BATCH TICKET – STATION 1 

                 PRINT DATE/TIME:  02/04/2021 06:28:48  
              (X)DELIVERY ( )RECEIPT TICKET   264  
                (X)OFFICIAL ( )UNOFFICIAL  
                ( )RECALCULATED ( )ACCEPTED             
 1. BATCH NUMBER                                                        16  
 2. TYPE OF LIQUID                                                 A CRUDE  
 3. METER CLOSING READING (DATE/TIME)                  02/04/2021 06:28:45    
 4. METER OPENING READING (DATE/TIME)                  02/04/2021 06:12:04    
 5. NET DELIVERY/RECEIPT TIME                            0: 16      h : m  
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 6. METER CLOSING READING IVOL                            1072502   m3        
 7. METER OPENING READING IVOL                            1068499   m3        
 8. IVOL                                                     4002   m3        
 9. GUVOL                                                4002.320   m3        
10. AVERAGE FLOW RATE                                     14394.0   m3/h      
11. OBS DENSITY                                          750.0000 ! kg/m3     
12. OBS TEMP                                                11.00 ! Deg.C     
13. BASE DENSITY AT  15.0 Deg.C                             750.0 ! kg/m3       
14. AVERAGE WEIGHTED TEMPERATURE                             1.00   Deg.C     
15. AVERAGE WEIGHTED PRESSURE                                5.00   barg     
16. BS&W                                                   60.000 ! %           
17. BS&W CORRECTION FACTOR                                 60.000           
18. NSVOL        AT       Deg.C                          1604.130   Sm3       
19. NSVOL        AT  15.0 Deg.C                          1604.130   Sm3       
20. NETT MASS   (METRIC)                                  1203.11   tonne     
21. NETT MASS                                             2406.22   tonne 
 
NON-NEGOTIABLE, NON-TRANSFERABLE 
CHECKED FOR ___________________ 
BY: ____________________________________ DATE: ___________        
 
WITNESSED 
BY: ____________________________________ DATE: ___________        
 
 
    1                     BATCH TICKET – STREAM 1 

                 PRINT DATE/TIME:  02/04/2021 06:28:48  
METER MANUFACTURER:    METER MAN             
METER MODEL:           METER MODEL           
METER SERIAL NUMBER:   METER SERIAL NO       
METER TAG NUMBER:      METER TAG             
METER SIZE:            0.00   mm             
NOMINAL K-FACTOR:     100.0   pls/m3         
  
PRIMARY FLOW COMPUTER: 00:A0:D8:F8:00:24  
  
 1. BATCH NUMBER                                                        16  
 2. TYPE OF LIQUID                                                 A CRUDE  
 3. METER CLOSING READING (DATE/TIME)                  02/04/2021 06:28:45  
 4. METER OPENING READING (DATE/TIME)                  02/04/2021 06:12:04  
 5. NET DELIVERY/RECEIPT TIME                            0: 16      h : m  
 6. METER CLOSING READING IVOL                            1072502   m3  
 7. METER OPENING READING IVOL                            1068499   m3  
 8. IVOL                                                     4002   m3  
 9. AVERAGE FLOW RATE                                     14394.0   m3/h  
10. GUVOL                                                4002.320   m3  
11. AVERAGE METER FACTOR                                   1.2536    
12. OBS DENSITY                                          750.0000 ! kg/m3  
13. OBS TEMP                                                11.00 ! Deg.C  
14. BASE DENSITY AT  15.0 Deg.C                             750.0 ! kg/m3  
15. AVERAGE WEIGHTED TEMPERATURE                             1.00   Deg.C  
16. AVERAGE WEIGHTED PRESSURE                                5.00   barg  
17. CTLM                                                   0.9876    
18. CPLM                                                   1.0101    
19. BS&W                                                   60.000 ! %  
20. BS&W CORRECTION FACTOR                                 60.000  
21. CCFM                                                   0.9975  
22. CCFM BSW                                               0.9975  
23. NSVOL        AT       Deg.C                          1604.130   Sm3  
24. NSVOL        AT  15.0 Deg.C                          1604.130   Sm3  
25. NETT MASS   (METRIC)                                  1203.11   tonne  
26. NETT MASS                                             2406.22   tonne  
 
NON-NEGOTIABLE, NON-TRANSFERABLE 
CHECKED FOR ___________________ 
BY: ____________________________________ DATE: ___________        
 



Config600 Configuration Software User Manual 

C-38 Batching Revised January 2023 

WITNESSED 
BY: ____________________________________ DATE: ___________        
 
================================================================================  

C.3.3 Recalculating Batches 
The S600+ can store data for up to eight historic batches. When the 
history is full, a new batch overwrites the oldest batch data. You 
cannot recalculate a batch after it’s been overwritten, although you 
may still be able to view its reports depending on your reports settings. 
Each batch can hold up to 20 days of data; you can adjust this using 
PCSetup. You can recall each batch in the history and adjust different 
batch parameters, based either on a certain day or on the whole batch. 
Each time you trigger a recalculation, the system generates a new batch 
report that shows the recalculated data for the whole batch. 

The system saves batch data on a per day basis. A day is considered to 
start at the base time 1 hour and is 24 hours long. To change the base 
time 1 hour, select System Settings on the top menu and then select 
Report Setup on the left-hand side menu. Scroll to the BASETIME 1 
display and change the value. 

This section gives step by step descriptions of the batching and batch 
recalculation procedures for the S600+. The batching procedure 
described here refers to the Volume Load batch type, but most of the 
steps apply to the other batch types, as well.  

Configuring the 
 Next Batch 

To configure the settings for the next batch:  

1. Select Operator from the top menu.  
2. On the left side menu, select Station 1>Bch Stack.   
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Figure C-8. Batch Configuration  

3. Select Batch Slot 1.  

4. Enter the PRODUCT NUMBER. 

5. Enter the BATCH QUANTITY. Once this quantity has flowed 
through the meter, the batch ends.  

Note: Refer to section Batch Stack for further details about editing the 
batch stack. 

Starting a Batch To start a batch:  
1. Select Operator from the top menu.  

2. On the left side menu, select Station 1>Batch Control.  

3. Scroll to the right until you see the BATCH TYPE, and set the 
Status to VOL LOAD. 

Note: You can only change the BATCH TYPE while the batch is 
idle. It cannot be changed while the batch is running. 
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Figure C-9. Volume Load  

4. Under the same menu, navigate to the BATCH COMMAND 
display and set its Status to BATCH DEFINED. 

Note: Setting the status to BATCH DEFINED generates the Batch 
Start report. You can view the report by selecting Reports on 
the top menu and then selecting Batch Ticket on the left side 
menu. This action also triggers a Load Started alarm. You 
can check this by selecting Alarms on the top menu. 

 
Figure C-10. Batch Defined 

5. From the same display, select the START command. The status on 
the STAGE NO display page changes to IN NOMINAL. 

Note: Use of the START command is required only when the batch 
type is either VOL LOAD or MASS LOAD. DIGIN, 
INTERFACE, BASETIME, CONT VOL LOAD, and 
CONT MASS LOAD batch types only need the DEFINE 
command to start and run a batch. 

Stopping a Batch You can stop a VOL LOAD batch type either manually or 
automatically. To stop the batch at any time, use the TERMINATE 
command:   

1. Select Operator from the top menu.  

2. On the left side menu, select Station 1>Batch Control. 
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3. On the BATCH COMMAND display change the status to 
TERMINATE. 

4. For the batch to stop automatically, the REQUIRED QUANTITY 
must be achieved. 

Note: The end of a batch generates a BATCH END ticket. To view 
the ticket, click Reports on the top menu and the click Batch 
Ticket on the left-hand side menu. Additionally, the end of a 
batch triggers a Load Complete alarm. You can check this by 
clicking on Alarms on the top menu. 

Viewing Batch 
Information 

To view information about the running batch, select Operator on the 
top menu. Select Station 1 on the left side menu to view the Batch 
Control, Bch Curr Base Ds, Bch Curr Bs&W, Bch Curr Recalc, 
and Bch Curr Results menus. These menus provide information 
regarding the current running batch or the last stopped batch.  

 

Figure C-11. Batch Information 

To review data about historical batches, use the Recall Ticket, Recall 
Base Dens, Recall Bs&W, Recall Recalc, and Recall Results menus. 
You can find these menus be selecting Operator > Station 1. To see 
data for a batch, click on Recall Ticket. Go to the TICKET 
NUMBER display and change the value to the ticket number you wish 
to review. All the Recall menus update with information about the 
recalled ticket. 
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Figure C-12. Batch Information 

You can find the same menus at stream level as well. 

Notes: 

 To get a ticket number, select Reports on the top menu and access 
the Batch Ticket menu on the left hand side menu. Choose a report 
and on the header of the report you can see the ticket number next 
to the RECEIPT TICKET flag. 

 Both the Btch Curr and the Recall menus have a similar layout. 

 The Bch Control/Recall Ticket menus provide information about 
ticket number, batch number, the number of days elapsed since the 
start of the batch and the ACCEPT command. 

 The Bch Curr Base Dens/Recall Base Dens,  Bch Curr 
Bs&W/Recall Bs&W, Bch Curr Mtr Temp/Recall Mtr Temp, 
Bch Curr Mtr Press/Recall Press menus show information about 
input batch parameters such as BASE DENSITY, BS&W, 
METER TEMPERATURE and METER PRESSURE. The data 
is stored as a weighted average and is displayed on a per day basis. 
You can also change the values of any of these parameters to issue 
a recalculated batch ticket. 

 The Bch Curr Recalc/Recall Recalc menus include the RECALC 
COMMAND, the ACCEPT COMMAND, the RECALC DAY and 
the DIAGNOSTIC display. These are used when performing a 
recalculation on the current or a historic batch ticket. 

 The Bch Curr Results/Recall Results menus show information 
about the batch, such as quantities accumulated during the batch or 
recalculated quantities and the duration of the batch. 

Recalculating a  
Current Batch 

To recalculate a current batch:  

1. Select Operator on the top menu.  
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2. Select Station 1>Batch Control on the left-hand side menu. The 
TICKET NUMBER display shows the ticket number of the 
current running batch or of the previously stopped batch, if no 
batch is running now. 

 

Figure C-13. Ticket Number 

3. Select Bch Curr Recalc on the left side menu and scroll to the 
RECALC DAY display. Select the day you wish to recalculate 
(the example uses Day 2).  

Note: If the current batch is running you cannot recalculate 
either the current day or the whole batch. 

 

Figure C-14. Recalculate Day 

4. To recalculate the batch with a new base density for day 2, go to 
the Operator menu, select Bch Curr Base Dens, and scroll to the 
BASE DENSITY (DAY NO) displays. This shows the original 
value for the base density on a given day or for the whole batch. 

5. Scroll to the BASE DENSITY SOURCE display and change the 
status from ORIGINAL to RECALC. 

6. To change the base density, scroll to the RECALC BASE 
DENSITY display and enter a new value. 
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Figure C-15. Recalculate Base Density 

7. Select Bch Curr Recalc on the left side menu. and scroll to the 
RECALC COMMAND display.  

8. Set the status to YES. This triggers a recalculation on the selected 
batch with the changed parameter. A new batch ticket is triggered, 
reflecting the changes for the whole batch. The displays under the 
Bch Curr menus update with the new data. That is, the density on 
the selected day match the one we’ve entered previously, and the 
volumes for that day are recalculated. The totals for that batch 
update correspondingly. 

 

Figure C-16. Recalculate Command 

Note: Perform steps 1 through 8 for any of the other parameters 
which can be modified. 

Recalculating  
an Historic Batch 

To recalculate an historic batch:  

Note: This procedure assumes that at least one batch is available in 
batch history. 

1. To recalculate a historic batch ticket, you need the batch ticket 
number. To get the batch ticket number, go to Reports on the top 
menu and access Batch Ticket on the left side menu. Choose a 
report. The header of the report displays the ticket number next to 
the RECEIPT TICKET flag. 

2. Go to Operator on the top menu, then Station 1 on the left side 
menu and click on Recall Ticket. On the TICKET NUMBER 
display enter the batch ticket number from the batch ticket. Once 
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you’ve entered the ticket number the Recall displays updates with 
the data particular to that ticket. 

 

Figure C-17. Recall Ticket Number 

3. Go to the Recall Recalc menu and scroll to the RECALC DAY 
display. Select the day to recalculate. This example selects day two 
and recalculates the batch with an new base density for day two.  

Note: If the batch you’ve recalled is running you cannot 
recalculate either the current day or the whole batch. 

 

Figure C-18. Day Selection 

4. To see the original value for the base density on a given day or for 
the whole batch, go to Operator > Station 1 > Recall Base 
Density and scroll to the BASE DENSITY (DAY NO.) displays. 
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Figure C-19. Base Density Display 

5. Scroll to the BASE DENSITY SOURCE display and change the 
status from ORIGINAL to RECALC. 

6. To change the base density, scroll to the RECALC BASE 
DENSITY display and enter a new value. 

 

Figure C-20. Base Density Display 

7. Select Operator > Station 1 > Recall Recalc and set the status on 
the RECALC  COMMAND display to YES. This triggers a 
recalculation on the selected batch with the changed parameter. A 
new batch ticket will be triggered, reflecting the changes for the 
whole batch. The displays under the Recall menus update with the 
new data. That is, the density on the selected day will match the 
one we’ve entered previously and the volumes for that day will be 
recalculated. The totals for that batch update correspondingly. 
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Figure C-21. Base Density Display 

Note: Perform steps 1 through 7 for any of the other parameters 
which can be modified. 

C.4 Flow Switching 
Flow switching is a station-based function that the batching process 
uses. In a standalone mode, flow switching determines how many 
streams are required to flow in order to maintain a required overall 
flowrate, depending on the availability of each stream.  

If a stream fails, the stream can be closed and a new available stream 
given its remaining total.  

Regulating flow is achieved by passing flowrate setpoints to the 
streams to control flowrate using PID control to drive flow control 
valves.  

Note: Station flow switching calculations require that you configure 
stream flow switching calculations.  

C.4.1 Station Flow Switching Setup 
Flow switching settings define the method and parameters to determine 
which streams should open and close. You can set up flow switching 
for a station and then disable it until you need this option.  
1. Select Flow Switching from the hierarchy menu. The Flow 

Switching screen displays. 
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Figure C-22. Station Flow Switching screen  

2. Complete the following fields.  
Field Description 
Enabled  Disables flow switching for the station. The 

default is checked (flow switching is Enabled). 
Algorithm Sets the algorithm to open and close streams. 

The default is 1. 
Flowrate Setpoint Sets, if applicable, the required station 

f lowrate. 
Loading Units Identif ies whether the Measured Flowrate is 

Mass (=1) or Volume (=0) units. The default is 
Volume. 

Auto Close First Identif ies whether to close highest priority 
stream f irst (checked) or to close lowest 
priority stream first. 
Note: This does not apply to Algorithm 1.  

Manually Open 
First 

Opens the f irst stream manually if selected. 

Manually Close 
Last 

Closes the last stream manually if selected. 

Deviation Time Sets the minimum time the flowrate must be 
above or below the limit before automatically 
opening or closing a stream. 

Post Move Time Sets a delay time after opening or closing a 
valve before moving to the monitor flow stage.  

 
3. Click in the hierarchy menu when you finish defining settings. A 

confirmation dialog displays. 

4. Click Yes to apply your changes. The PCSetup screen displays. 
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C.4.2 Stream Flow Switching Setup 
Flow switching settings define the priorities and number of valves 
present, as well as control loop specifics. You can set up flow 
switching for a stream and then disable it until you need this option.  

1. Select Flow Switching from the hierarchy menu. The Flow 
Switching screen displays. 

 

Figure C-23. Stream Flow Switching screen  

2. Complete the following fields.  
Field Description 
Priority Sets the priority of the stream. The higher the 

number, the higher the stream’s priority. For 
example, 2 has priority over 1, and 3 has 
priority over 2. The default is 1. 

Number of Valves Sets the number of valves the stream 
controls. The default is 2. 

Disabled Disables flow switching for the selected 
stream. The default is unchecked (flow 
switching is disabled). 

Setpoint Sets, if applicable, the ideal flowrate required 
on the selected stream. 

PID Loop Identif ies the PID loop used to control the 
f lowrate of the selected stream. Click ▼ to 
display all valid options. The default is I/O 01 
PID CNTRL 1. 
Note:  Def ine flowrate band settings for each 

stream on the Flowrate screen.  
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3. Click in the hierarchy menu when you finish defining settings. A 
confirmation dialog displays. 

4. Click Yes to apply your changes. The PCSetup screen displays. 

C.4.3 Flow Switching Algorithms 
This section details flow switching algorithms, which provide 
alternative rules for deciding which streams to use:  
 Algorithm 1 compares the stream flowrate against its low/high 

limits. 
 Algorithm 2 compares the station flowrate against the summated 

low/high limits. 
 Algorithm 3 compares the station flowrate setpoint against the 

summated low/high limits. 
 Algorithm 4 is the same as algorithm 3 and also distributes a 

setpoint to each open stream to spread the flowrate evenly. 
Algorithm 1 For each open stream, the system compares the observed flow rate 

against the low and high bands. If the lowest priority stream’s flow rate 
is less than its low band for the specified Deviation Time and more 
than one stream is online, the stream closes. If only one stream is 
online, flow switching takes no action.  

If the lowest priority stream’s high band is exceeded for the specified 
Deviation Time and at least one other stream is available for opening, 
the flow switching then opens the available highest priority stream. If 
no stream is available for opening, an alarm occurs but flow switching 
performs no switching actions. 

This algorithm requires you to carefully initialize the stream low and 
high bands to avoid continuously switching between open and close 
stages. 

Sample settings could include: 

 Stream 1: low band = 150 m3/hr, high band = 300 m3/hr 
 Stream 2: low band = 140 m3/hr, high band = 280 m3/hr 
 Stream 3: low band = 150 m3/hr, high band = 300 m3/hr 

These settings then set the ranges:  

 One online stream has the range 150 to 300 m3/hr 
 Two online streams have the range 290 to 580 m3/hr 
 Three online streams have the range 440 to 880 m3/hr 
 

Algorithm 2 This algorithm uses the stream low and high bands but compares the 
station observed flow rate against the current operating range (that is, 
the summated low and high bands of the online streams).  

If the observed station flow is less than the summated low range for the 
specified Deviation Time and two or more streams are open, 
Config600 closes the lowest priority open stream. If only one stream is 
online, Config600 takes no action. 
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If the observed station flow is greater than the summated high range 
for the specified Deviation Time and another stream is available for 
opening, Config600 opens the highest priority available stream. If no 
stream is available for opening, an alarm occurs but Config600 
performs no switching actions.  

Algorithm 3 This algorithm uses the stream low and high bands but compares the 
station flow rate setpoint against the current operating range (that is, 
the summated low and high bands of the online streams).  
If the station flow setpoint is less than the summated low range for the 
specified Deviation Time and two or more streams are open, 
Config600 closes the lowest priority open stream. If only one stream is 
online, Config600 performs no actions. 

If the station flow setpoint is greater than the summated high range for 
the specified Deviation Time and another stream is available for 
opening, then Config600 opens the highest priority available stream. If 
no stream is available for opening, an alarm occurs but Config600 
performs no switching actions. 

Algorithm 4 This algorithm is the same as Algorithm 3, but adds the ability to 
distribute the flow rate setpoint across the online streams.  

Having determined the streams that should be open, Config600 uses 
the following formula for the distribution of the flow setpoint to each 
open (or opening) stream: 

 Station offset is the station setpoint minus (sum of low bands of 
streams to be opened). 

 Station span is the (sum of high bands of streams to be opened) 
minus (sum of low bands of streams to be opened). 

For each open (or opening) stream: 
 Stream span is stream high band minus low band. 
 Stream setpoint is stream low band plus (station offset / station 

span) multiplied by stream span. 
The following example uses the cited parameters, a setpoint of 350 
m3/hr, and streams 1 and 2 are open; 

 For stream 1, low band = 150 m3/hr and high band = 300 m3/hr. 
 For stream 2, low band = 140 m3/hr and high band = 280 m3/hr. 
 Station offset is 350 - (150+140) = 60. 
 Station span is (300+280) - (150+140) = 290. 
 Stream 1 span is 300 – 150 = 150. 
 Stream 1 setpoint is 150 + (60 / 290) * 150 = 181 m3/hr. 
 Stream 2 span is 280 – 140 = 140. 
 Stream 2 setpoint is 140 + (60 / 290) * 140 = 169 m3/hr. 

Based on this, the station downloads a value of 181 m3/hr to the 
setpoint for stream 1 and 169 m3/hr to the setpoint for stream 2. 

Flow Switching Stages You associate a station with a stream using the stream flow switching 
configuration table, which means that the stream shares a number with 
the station (displayed as Station No). This enables you to dynamically 
allocate a single stream to different loads.  
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Prior to performing stage handling, flow switching performs a set of 
calculations to determine: 
 The number of streams open for each station. 
 The number of streams still available for opening. 
 The highest priority stream for opening (algorithm-dependent). 
 The highest priority stream for closing  (algorithm-dependent). 
 The number of open streams. 
 The number of streams still available for opening. 
For each station, the flow switching stage assumes one of the following 
values, remaining in that stage until an event occurs. 

Display Description 
IDLE On issue of the Start-up command: 

If  no streams are open and at least one stream is 
available, proceed to Open First Stream. 
If  at least one stream is on line then proceed to Monitor 
Flow. 

MONITOR 
FLOW 

On issue of the Shutdown command, proceed to 
Shutdown. 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
Invoke the configured switching algorithm (this may 
invoke a change of stage number). 

OPEN 1ST 
STREAM 

If  the manual Open First Stream parameter is not set, 
issue Line Open command to the stream marked for 
opening. 
On issue of the Shutdown command, proceed to 
Shutdown. 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
When the stream has opened, proceed to Post Open 
Delay. 

OPEN 
STREAM 

Issue Line Open command to the stream marked for 
opening. 
On issue of the Shutdown command, proceed to 
Shutdown stage. 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
When the stream has opened, proceed to Post Open 
Delay. 

CLOSE 
STREAM 

Issue Line Close command and zero the flow rate 
setpoint for the stream marked for closing. 
On issue of the Shutdown command, proceed to 
Shutdown. 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
When the stream has closed, proceed to Post Close 
Delay. 
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Display Description 
CLOSE LAST 
STREAM 

If  the manual close last stream parameter is not set 
then issue line close command and zero the flow rate 
setpoint for the stream marked for closing. 
On issue of the shutdown command, proceed to 
Shutdown. 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
When the stream has closed, proceed to Delay after 
Closing. 

POST OPEN 
DELAY 

On issue of the Shutdown command, proceed to 
Shutdown. 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
On expiration of the delay timer, proceed to Monitor 
Flow. 

POST 
CLOSE 
DELAY 

On issue of the shutdown command, proceed to 
Shutdown stage. 
On issue of the ESD command, proceed to Emergency 
Shutdown stage. 
On expiration of the delay timer, if all streams are now 
closed, proceed to Idle else proceed to Monitor Flow. 

SHUTDOWN On issue of the Startup command, proceed to Monitor 
Flow 
On issue of the ESD command, proceed to Emergency 
Shutdown. 
Issue Line Close command and zero the flow rate 
setpoint for the next stream marked for closing. 
When the marked stream closes: 
If  there is only one more stream to close then proceed 
to Close Stream, else 
Repeat this stage until there is only one stream left to 
close. 

EMERGENCY 
SHUTDOWN 

At issue of the Startup command, proceed to Monitor 
Flow. 
Issue Line Close command and zero the flow rate 
setpoint for all the open streams. When all streams are 
closed, proceed to Idle. 

C.4.4 Alarms 
Flow switching does not raise any alarms.  

C.5 Batch Stack 
Batching allows you to configure and edit a stack of 16 products, 
called a “batch stack.” Each batch stack element is called a “batch slot” 
and each batch slot holds the relevant information for batching 
(product number, batch ID, customer number, batch type, meter type, 
quantities, and flowrates). 

A batch slot is considered empty or undefined if the product number is 
not set (that is, the product number is zero).  
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Each time a batch starts, the system copies information from data in 
stack position #1 and uses it in the batching logic. The first batch slot 
is then deleted and the rest of the slots advance one position. This is 
“advancing the stack.” As a result, after the batch starts, the first slot 
element contains the data for the next batch. 

When the system advances the stack, it ignores empty or undefined 
batch slots and uses the first defined slot it encounters.  

If the batch is continuous, when the batch ends the system 
automatically advances the batch stack and copies the next element so 
that the data can be used for the next batch. Advancing a continuous 
volume load or mass load batch is done only if the required quantity 
for the next product is non-zero. If the required quantity for the next 
batch stack slot is zero, the batch stops and an alarm occurs to mark 
that the batch stopped. 
A volume or mass load batch cannot start if there is no required 
quantity, and the system will reject the start command. For a batch 
stack of only one product, regardless of the batching type, advancing is 
not performed. The defined slot is not deleted when starting or 
restarting a batch and the data defined in that slot is used for all 
batches. However, the data is copied every time a start or restart is 
performed. This allows you to edit the slot information.  

If you select batching when creating a configuration file, the objects 
needed for the batch stack are added by default, but they are not 
initialised. Batching will not work until the batch stack slots are 
configured, and all batch commands will be rejected.  

You can configure the batch stack slots four different ways: through 
the Batch Stack screen in the PCSetup Editor, by directly editing the 
configuration file through System Editor, at run-time from the front 
panel of the S600+, and at run-time from the Webserver. 

C.5.1 Configuring the Batch Stack Through the PCSetup Editor 
The Batch Stack screen in the PCSetup Editor allows you to configure 
batch slots. You can edit the parameters of a batch slot, delete a batch 
slot entirely, or copy the parameters of a batch slot to another slot in 
the stack. 

To configure the Batch Stack through the PCSetup Editor: 
1. Select Batch Stack from the hierarchy menu. The Batch Stack 

screen displays. 

Note: The screen below shows available fields for all options in 
the Actions pane. 
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Figure C-24. Batch Stack 

2. Click ▼ to select the batch slot you want to change. The Action 
pane displays. 

3. To delete the selected batch slot, select Delete in the Action pane 
and click Ok to delete the selected batch slot. The system displays 
a confirmation screen. Click Yes to delete the batch slot. 

4. To copy parameters from the selected batch slot to another, select 
Copy to in the Action pane, click ▼ to select the batch slot to 
which the parameters are copied, and click Ok. The system 
displays a confirmation screen. Click Yes to copy the batch slot. 

5. To modify parameters for the selected batch, select Edit. The 
Batch Slot Editor displays. 
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6. Complete the following fields: 
Field Description 
Slot This read-only f ield displays the number of the 

currently selected batch slot. 
Batch id Sets the Batch ID for the selected batch slot. 

Valid values are 0 through 65535. 
Meter type Determines whether this is a delivery or a 

receipt. Possible values are: 
 RECEIPT The batch is a receipt. 

 DELIVERY The batch is a delivery. 
Batch type Determines whether this is an official or 

unof ficial batch. Possible values are: 
 UNOFFICIAL The BATCH NUMBER is 0. 

 OFFICIAL The BATCH NUMBER 
increases by 1. 

Product number Sets the product number used by the selected 
batch slot. Valid values are 1 through 16. 

Customer Sets the customer number for the selected 
batch slot. Valid values are 0 through 65535. 

Batch Sets the total quantity of the batch. 
Start Sets the start quantity of the batch. The 

system uses the flow rate set in the Start flow-
rate f ield at the beginning of the batch until this 
quantity is met. 

Top-off quantity Sets the top-off quantity of the batch. The 
system uses the flow rate set in the Top flow-
rate f ield for the remainder of the batch when 
this quantity is remaining. 

Start flow-rate Sets the f low rate the system uses at the start 
of  the batch until the quantity set in the Start 
f ield is met. 

Nominal Sets the nominal flow rate for the selected 
batch slot. The nominal flow rate is used after 
Start f low rate and before the Top flow-rate. 
Quantities and Flowrates are always positive 
values. 

Top flow-rate Sets the f low rate the system uses at the end 
of  the batch when the quantity set in the Top-
off quantity f ield is remaining. Quantities and 
Flowrates are always positive values. 

Pre-alarm Sets a percentage of the entire batch amount 
that, when reached, raises an alarm. Valid 
values are 0% to 100%. 

 
7. Click Save to apply your changes. 

C.5.2 Configuring the Batch Stack with the System Editor 
When you use the System Editor to configure the batch stack, it is 
recommended that you first define all the data – batch ID, product 
number, customer number, quantities, flowrates, and pre-alarm 
percentage – for each slot.  
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1. Select Start > Programs > Config600 3.3 > System Editor. 

2. Select Station X > KPINTARR. 

3. Double-click STN0X NEXT PRODUCT and edit Fields 1 through 
16 for the corresponding batch stack slots. This array holds the 
product type of each stack slot. Valid values are 0 through 16. 
Values 1 through 16 define correct product types. If using product 
number 0, the slot is considered as undefined. 

4. Select OK to save changes. 
5. Double-click STN0X NEXT CUST and edit Fields 1 through 16 

for the corresponding batch stack slots. This array holds the 
Customer number for each stack slot. Valid values are 0 through 
65535. 

6. Select OK to save changes. 

7. Double click STN0X NEXT BATCH ID and edit Fields 1 through 
16 for the corresponding batch stack slots. This array holds the 
Batch ID for each stack slot. Valid values are 0 through 65535. 

8. Select OK to save changes. 

9. Double-click STN0X MTR TYPE and edit Fields 1 through 16 for 
the corresponding batch stack slots. This array holds the Meter 
Type for each stack slot. Valid values are 0 and 1. 

10. Select OK to save changes. 

11. Double-click STN0X BCH TYPE and edit Fields 1 through 16 for 
the corresponding batch stack slots. This array holds the Batch 
Type for each stack slot. Valid values are 0 and 1. 

12. Select OK to save changes. 

13. Select Station X > KPREALARR. 
14. Edit the fields of arrays STN0X START QTY, STN0X REQD 

QTY, STN0X TOP QTY, STN0X F/R START, STN0X F/R 
NOMINAL, STN0X F/R TOPOFF, and STN0X PRE ALARM 
to edit the properties corresponding to (in order): Start quantity, 
Required quantity, Top-off quantity, Start flowrate, Nominal 
flowrate, Top-off flowrate, Pre-alarm percentage. 

Valid values for STN0X PRE ALARM are between 0.0 and 100.0 
while values for all of the other arrays should be positive. 
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Figure C-25. Config600 System Editor (1)  

 

Figure C-26. Config600 System Editor (2)  

C.5.3 Configuring the Batch Stack through the Front Panel Display 
1. Navigate to OPERATOR > STATION X > BCH STACK.  

2. The display shows all the batch stack slots in numerical order. 
Press the Left and Right keys to navigate through the slots.  

BATCH SLOT 2 
  
BATCH ID 43 
PRODUCT 3 
D LUBE OILS 
  
EXIT                   
* 
  

Figure C-27. Batch Slots 

3. Press CHNG to edit the selected slot. 
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1. MOVE TO TOP 
2. MOVE TO SLOT 
3. MOVE DOWN 
4. INS BCH 
5. INS BCH TO SLOT 
6. COPY TO SLOT 
7. EDIT SLOT 
8. DELETE SLOT 

Figure C-28. Slot Editing Options 

4. Press the number key that corresponds to the action you want to 
perform.   

C.5.4 Slot Edit Commands (Front Panel Display) 
The slot edit commands you can access through the Front Panel 
Displays have the following functions:  
 MOVE TO TOP / MOVE DOWN  

These commands move the stack slot up and down by one slot, 
respectively. If you are editing the first slot, the system disables the 
MOVE TO TOP command; if you are editing the last slot, the 
system disables the MOVE DOWN command.  

 MOVE TO SLOT 
Select MOVE TO SLOT to access a display that enables you to set 
the destination slot. When moving a slot, if the destination slot 
number is smaller than the source slot number, the system moves 
the source up the stack, to the destination slot. All slots from the 
destination slot to the source slot are moved down one position and 
the source slot is copied over the destination slot. Similarly, if the 
destination slot number is greater than source slot number, the 
system moves the source down in the stack, to the destination slot. 
All slots from the source to the destination are moved up one 
position and the source slot is copied over the destination slot. For 
example, if you have a batch stack slot order of 1, 2, 3, 4, 5, 6, and 
you move slot 6 to slot 3, the resulting batch stack slot order would 
be 1, 2, 6, 3, 4, 5. 

 INS BCH / INS BCH TO SLOT 
The system disables these commands if the batch stack is full. 
When you select INS BCH TO SLOT the system displays a screen 
that changes the slot in which the data is inserted:  
ENTER SLOT NUMBER: 
  
VALUE: 
     14 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

Figure C-29. Insert Batch Command 
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Following this screen or selecting INS BCH TO SLOT you are 
taken to a succession of screens where you can change the data 
(batch ID, meter type, batch type, product number, customer 
number, batch quantity, start quantity, top-off quantity, start 
flowrate, nominal flowrate, top-off flowrate, and pre-alarm 
percentage) for the new slot. Press ENTER to move to the next 
screen; press LEFT to return to the previous screen.  

BATCH ID 
  
VALUE: 
     12345        * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 METER TYPE 
  
VALUE: 
RECEIPT           * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 BATCH TYPE 
  
VALUE: 
OFFICIAL          * 
  
  
ENTER - NEXT 
CLEAR – CANCEL 

     
PRODUCT NUMBER 
  
VALUE: 
     1            * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 CUSTOMER NUMBER 
  
VALUE: 
     12345        * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 BATCH QUANTITY 
  
VALUE(m3): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

     
START QUANTITY 
  
VALUE(m3): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 TOP-OFF QUANTITY 
  
VALUE(m3): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 START FLOWRATE 
  
VALUE(m3/h): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

     
NOMINAL FLOWRATE 
  
VALUE(m3/h): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 TOP-OFF FLOWRATE 
  
VALUE(m3/h): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 PRE-ALARM PERCENTAGE 
  
VALUE(%): 
           0.0000 * 
  
  
ENTER - NEXT 
CLEAR - CANCEL 

 

Each of these displays shows the current value of the field. Press 
CHNG to access a screen showing the current value and the range 
limits, and where you can insert a new value using the numerical 
keys. The LEFT key works as backspace, deleting one character at 
a time. 
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Each data field has its own specific entry limits: Batch ID and 
Customer number range is 0 to 65535; Product number and batch 
slot range is 1 to 16; Quantities and Flowrates are always positive 
values, Pre-alarm percentage range is 0 to 100%. If you enter a 
value which is out of the valid range for the respective field, the 
system displays an error message and returns you to the screen 
showing the current value of the field. 

Press ENTER to accepts the new data; press  CLEAR to abort a 
data change. After you press ENTER or CLEAR, the system 
returns you to the screen, showing the field you edited.  
CURRENT VALUE: 
               0.00    
% 
LIMITS OF ENTRY: 
                 
100.000 
                   
0.000 
  
ENTER NEW VALUE: 
54.23 

Figure C-30. Entering Data 

CURRENT VALUE: 
               0.00    
% 
LIMITS OF ENTRY: 
                 
100.000 
                   
0.000 
  
ENTER NEW VALUE: 
ABORTED 

Figure C-31. Pressing CLEAR 

CURRENT VALUE: 
               0.00    
% 
LIMITS OF ENTRY: 
                 
100.000 
                   
0.000 
  
  
OUT OF RANGE 

Figure C-32. Input out of Range 

Press ENTER in the last screen (Pre-alarm percentage) to accept 
the data entered in the previous screens. 
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If you have selected INS BCH, the system accepts data to the next 
free slot in the batch stack. That is, if the next free slot is slot 
number 14, after you complete all the steps to insert a batch slot 
and press ENTER, the system saves data in slot number 14.   

If you select INS BCH TO SLOT and the slot in which you want 
to insert data is not empty, the system moves all the slots following 
that slot towards the first empty slot by one position, filling up the 
first empty slot in the stack, in order to prevent the loss of non-
empty batch stack slots. For example, if the batch stack slots 1 
through 10 are defined and you want to insert a batch slot to slot 
number 5, the system moves slots 5, 6, 7, 8, 9 and 10 down one 
position (to positions 6, 7, 8, 9, 10 and 11) and places the data 
entered in the INS BCH TO SLOT procedure in slot number 5. 

Pressing CLEAR at any time in the screen succession displays a 
confirmation screen, verifying that you want to abort the insert for 
the new batch slot. Aborting takes you back to the batch stack slot 
screens. 

  
ARE YOU SURE YOU 
WISH TO ABORT? 
  
  
  
ENTER - ABORT 
CLEAR - CANCEL 

Figure C-33. Abort Confirmation Screen 

If a batch has started and it advances while you are editing the data 
in the screen sequence, when you press ENTER in the last screen 
the system displays an error message showing that the batch stack 
has advanced. The system then discards all the changes.   

  
BATCH STACK ADVANCE 
WHILE EDITING 
  
CHANGES DISCARDED 
  
PRESS ANY KEY 
TO CONTINUE 

Figure C-34. Changes Discarded Message 

 COPY TO SLOT 
When you select this option, the system displays a screen where 
you can enter the destination slot:  
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COPY SLOT 4 
  
RANGE 1..16 
       5 
  
  
ENTER - ACCEPT 
CLEAR - CANCEL 

Figure C-35. Copy to Slot 

If the destination slot is not empty, the system displays a 
confirmation screen and gives you the option to overwrite the 
destination slot. If you choose not to overwrite the destination slot, 
the system makes no changes.   
COPY TO SLOT 5 
  
SLOT IS NOT EMPTY 
OVERWRITE DATA? 
  
  
ENTER - ACCEPT 
CLEAR - CANCEL 

Figure C-36. Confirmation Screen 

 EDIT SLOT 
When you select this option, the system displays a screen sequence 
that enables you to change the data of the batch slot. The 
succession of displays and functionality is identical to the one for 
the INS BCH command. Please see the section describing the INS 
BCH command for details on functionality. When you press 
ENTER at the last screen of the sequence (Pre-alarm percentage), 
the system stores the new data in the selected batch slot without 
displaying a confirmation screen. 
 
If a batch has started and it advances while you are editing the data 
in the screen sequence, when you press ENTER in the last screen, 
the system displays an error message indicating that the batch stack 
has advanced. The system then discards all the changes.  

  
BATCH STACK ADVANCED 
WHILE EDITING 
  
CHANGES DISCARDED 
  
PRESS ANY KEY 
TO CONTINUE 

Figure C-37. Changes Discarded 

 DELETE SLOT 
When you select this option the system displays a screen prompting 
you to confirm the deletion of the selected slot:  
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DELETE SLOT 5 
  
  
  
  
ENTER - ACCEPT 
CLEAR - CANCEL 

Figure C-38. Delete Confirmation 

When deleting a slot, if there are valid slots in the batch stack after 
the deleted slot, the system advances the remaining valid batch 
slots one position in the batch stack. For example, if the first ten 
slots are configured and you delete slot number 4, the system 
moves slots 5 to 10 up one position so that slot 5 moves to slot 4, 
slot 6 moves to slot 5, and so on.  

If there is a continuous batch running (volume load or mass load) 
and there is only one batch slot defined, the system disables the 
DELETE command. 

C.5.5 Configuring the Batch Stack from the Webserver 
1. Navigate to OPERATOR > STATION X > BCH STACK. 

2. Navigate to the batch slot you wish to edit. 
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Figure C-39. Batch Slots 

3. Select EDIT; the system displays a page showing the edit options 
for the selected slot:  

 

Figure C-40. Slot Editing Options 

4. Press the numeric keys corresponding to the command you wish to 
perform. 

C.5.6 Slot Edit Commands (Webserver) 
The slot edit commands you can access through the Webserver have 
the following functions:  
 MOVE TO TOP / MOVE DOWN / MOVE TO SLOT  

Select any of these options and click OK to move the slot is moved 
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to the top of the batch stack, to move the slot down by one position, 
or to move the slot to a specific location (as defined in the MOVE 
TO SLOT field).  

Whenever you move a slot, the system does not lose o overwrite 
data. If the number of the destination slot is smaller than the 
number of the source slot, the source moves up in the stack, to the 
destination slot. All slots from the destination slot to the source slot 
move down one position and the system copies the source slot over 
the destination slot. If the number of the destination slot is greater 
than the number of the source slot, the system moves the source 
down in the stack, to the destination slot. All slots from the source 
to the destination move up one position and the system copies the 
source slot over the destination slot. For example, you have a batch 
stack slot order of 1, 2, 3, 4, 5, 6, and you move slot 6 to slot 3, the 
resulting batch stack slot order would be 1, 2, 6, 3, 4, 5.  

The system validates the text field which contains the destination 
slot. If the value is not the correct range (1 to 16), the system 
displays an error message below the OK and CANCEL buttons and 
resets the text field to the default value, which is the slot number of 
the selected slot. 

 
If you select the first slot in the batch stack, the system disables the 
MOVE TO TOP command. If you select the last slot in the batch 
stack, the system disables the MOVE DOWN command.  

 INS BCH / INS BCH TO SLOT 
When you select this option, you enter the slot number where the 
new slot will be inserted in the text field next to the command 
name. 
After you click OK, the system displays another pages with all the 
data that needs to be edited for a new slot. All the text fields 
(except the SLOT NUMBER) are pre-loaded with default values. 

The system disables these two commands if the batch stack is full 
(that is, all 16 slots are defined).  
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When you select INS BCH, the system disables the SLOT 
NUMBER text field and sets it to the number of the next free slot 
in the batch stack. 

When you select INS BCH TO SLOT, the system displays the 
value entered on the previous page in the SLOT NUMBER text 
field and enables it for editing.  

The system performs range checks on all data, according to each 
field’s specific entry limits: Batch ID and Customer number range 
is 0 to 65535; Product number and batch slot range is 1 to 16; 
Quantities and Flowrates are always positive values; and Pre-alarm 
percentage range is 0 to 100%.   
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When you press OK, if at least one of the fields is out of range, the 
system displays an error message (“Error – data out of range”) on 
the bottom of the screen. Additionally, the system highlights those 
fields in orange and resets them to 0.0.  
If the batch stack advances while you are inserting a new batch, the 
system displays an error indicating that the batch stack has 
advanced. The system then discards all changes.  

 
 COPY TO SLOT 

When you select this option and click OK, the system copies the 
selected slot to the destination slot entered in the text field next to 
the COPY TO SLOT text. 

If the slot is invalid, the system displays an error message on the 
bottom of the page and resets the value in the text field set to the 
default value, which is the slot number of the selected slot. 
If the destination slot is not an empty slot, the system then prompts 
you to overwrite the data in the destination slot.  
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 EDIT SLOT 

When you select this option and click OK, the system displays a 
page where you can edit all the data for a batch stack slot. Note that 
the SLOT NUMBER of the edited slot is not available for editing 
and is disabled. 
The functionality for this option is identical to the INS BCH 
options; refer to that description for further details of use.   
The system pre-loads all the text fields with the current data of the 
selected batch stack slot so there is no chance of accidentally 
changing important data.  

When you click OK the system saves new data to the selected 
batch stack slot. 

 DELETE SLOT 
When you select this option and click OK, the system deletes the 
selected batch stack slot and moves the rest of the batch stack slots 
below the deleted slots up one position. The system automatically 
inserts a new empty slot in the last position of the batch stack as 
slot number 16. No confirmation screen follows the selection of the 
DELETE command. 

If there is a continuous volume load or mass load batch running 
and only one batch stack slot is defined, the system disables the 
DELETE command. 

C.6 Basic Batching Setup 
If basic batching is required (i.e. single product with the start / stop 
commands being issued manually (i.e. no enterable required batch 
quantity and no recalculation) then the following steps should be 
followed.  
1. Create a batching application containing “station batching with 

product table” and “stream batching with product table basic”. 
2. Configure Product 1 in the station product table with the correct 

information. 
3. Configure the station batching as VOL LOAD or MASS LOAD.  

4. Configure Slot 1 in the batch stack with a large batch quantity 
(9,999,999,999) and product id for Product 1. 

5. Configure the stream batching as supervised. 

6. Update the displays so that only the station batch command, station 
batch stage and batch number are visible.  
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7. Remove all station product displays (if required the data for 
product 1 can remain).  

8. Remove all the station batch current displays (Stack, Interface, 
Control, Base Dens, BSW, Recalc and Results).  

9. Remove all the station batch recall displays (Ticket, Base Dens, 
BSW, Recalc, Results). 

10. Remove all the stream batch current displays (Mtr Temp, Mtr 
Press, Avg KF and Results).  

11. Remove all the stream batch recall displays (Mtr Temp, Mtr Press, 
Avg KF and Results). 

12. To start a batch the operator should use the Batch Define 
command. The batch totals will then start incrementing once flow 
is received (note the batch status will remain at Batch Defined for 
the duration of the batch).   

13. The batch can be stopped at any time by the operator entering the 
Batch Terminate command.  
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Appendix D – Field Calibration 
In This Chapter 
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D.1.1 Calibration Control Requirements ................................ D-2 
D.1.2 Linear Two-point ADC Device Calibration ..................... D-3 
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D.1.4 Non-linear 3-point Curve Calibration Control Mechanism D-7 
D.1.5 Offset PRT Device Calibration .................................... D-8 
D.1.6 Linear 2-point Device PRT Calibration.......................... D-8 
D.1.7 Non-linear 3-point Curve-Fit PRT Device Calibration ...... D-9 

D.2 Analogue Output Calibration...................................................D-10 
D.2.1 Calibration Control Requirements ...............................D-10 
D.2.2 DAC Device Calibration ............................................D-11  

 
This appendix describes the hardware calibration you perform after 
production to determine the relationship between analogue converter 
counts and current.    

D.1 Analogue Input Calibration 
Do not confuse process calibration with the production hardware 
calibration you perform on all IO modules subsequent to 
manufacturing. You perform hardware calibration after production to 
determine the relationship between analogue converter counts and 
current in mA for Analog to Digital Converters (ADCs) or converter 
counts and resistance in the case of Platinum Resistance Thermometers 
(PRTs). Hardware calibration process essentially “fixes” each 
individual input channel the way in which the S600+ measures the 
current or resistance.  

Process calibration does not alter this counts-to-measure relationship.  

In the case of ADCs, there are two methods of calibration available:  

1. The first method defines the relationship between the perceived 
input current (as measured by the analogue converter using the 
hardware calibration data) and plant transducer engineering units. 
Even after a process calibration, the analogue device may not 
produce a current reading corresponding to the true circuit current. 
However, the device should perform a conversion to provide an 
accurate representation of the engineering units associated with the 
transducer applied to the analogue input. 

2. The second method (current calibration) calibrates the input current 
applied at the transducer and the perceived raw current (as 
measured by the analogue converter using the hardware calibration 
data), this uses mA for both. 

In the case of the PRTs, you can use the process calibration to modify 
the conversion or to bypass the temperature lookup tables which the 
S600+ normally employs. 
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D.1.1 Calibration Control Requirements 
The firmware automatically controls the calibration mechanism 
internally to ensure that the system integrity is not impaired during the 
calibration process. The firmware applies the following three 
conditions during a calibration: 
1. The operational status of any PID control loops during calibration. 

Any loop employing a field input device which is under calibration 
should be automatically disabled. Thus if the control loop is in auto 
mode, the control output remains at the last generated state until the 
field device returns to normal operation. This safeguard does not 
extend to locking the output if the control loop is in manual mode 
or switching to manual mode during calibration. Manual mode 
overrides the loop disable.  

2. You cannot perform part of a calibration and effectively impair the 
integrity of field input data. The calibration control task uses a 
configurable timer to monitor all calibration operations. If you 
perform part of a calibration but do not complete the process prior 
to timeout, the control task reverts all calibration data to its initial 
state prior to the start of the calibration operation. The calibration 
terminates and an error displays. The default timeout setting for an 
online calibration is 15 minutes; the default timeout setting for a 
manual calibration is 30 seconds. These times are configurable. 
For more information contact Technical Support.  

3. For an online calibration, you are not required to manually change 
the mode of a field input prior to initiating the calibration sequence. 
The calibration control mechanism ensures that the mode switches 
to a known safe state prior to continuing. For a manual calibration 
the mode is unchanged. The following table presents the online 
calibration mode changes for the ADCs and PRTs.  

Pre-calibration Mode Calibration Mode  
Measured LastGood 
Keypad Keypad 
Average Average 
LastGood LastGood 
Keypad-F Keypad 
Average-F Average 
LastGood-F LastGood 

  

At the end of an online calibration (or if the calibration was aborted), 
the mode of the ADC or PRT automatically reverts back to the pre-
calibration mode. For manual calibrations, the mode remains 
unchanged.  
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Notes: 

 You can change a device’s mode during calibration. The 
calibration package updates calibration specific object data, (such 
as Gradient or Offset) only when a coherent data set is available. 

 The online calibration mode reads values directly from the ADC. 
The manual calibration mode, uses default values for a 4-20 mA 
or 1.5 Vdc ADC (hi-current = 20, mid_current = 12 and lo_current 
= 4) and for a 0-20mA or 0-5 Vdc ADC (hi-current = 20, 
mid_current = 10 and lo_current = 0).    

D.1.2 Linear Two-point ADC Device Calibration 
This method enables you to calibrate an ADC device across a linear 
range by entering high and low range process setpoints as well as an 
offset adjustment factor. You can then define the setpoints and offset 
making the calibration device/process dependent.   

Operator Interface  To calibrate the linear two-point ADC device:  

1. Navigate to an analogue input channel requiring calibration.  

2. Move to the low range calibration display page. This page has an 
entry for the low range setpoint, an indication of the associated 
current reading at this setpoint, and the current measured value 
associated with this device. 

ADC Channel 1 
Meter Temperature 
CALIB (LO/CUR/MEAS) 
xxxx.xx       DegF * 
xxxx.xx       mA 
xxxx.xx       DegF 

P12.3 <of 10> 

 
3. Once you stabilise the plant device to the low range process setting, 

enter a low range setpoint. When you press Return the flow 
computer takes and stores a current reading for the selected 
channel. The display page then indicates the low range setpoint and 
the associated low range current reading. For current calibration, 
the low range setpoint and the associated low range raw current 
value display.  

ADC Channel 1 
Meter Temperature 
CALIB (LO/CUR/MEAS) 
    23.00       DegF * 
    10.87       mA 
    23.54       DegF 

P12.3 <of 10> 
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4. Repeat this process for the high range setpoint.  

ADC Channel 1 
Meter Temperature 
CALIB (HI/CUR/MEAS) 
    89.00       DegF * 
    18.27       mA 
    89.94       DegF 

P12.4 <of 10> 

 
5. Include an additional device offset adjustment if required. You 

define this by setting the plant device to its zero position and then 
navigating to the offset display for the relevant analogue input. The 
system then prompts you to accept a change request which initiates 
the acquisition of an offset current reading. Following are examples 
of the display before and after the acquisition of the offset 
calibration.  

ADC Channel 1 
Meter Temperature 
CALIB (OFF/CUR/MEAS) 
      0.00       DegF 
      4.63       mA 
      1.07       DegF 

P12.5 <of 10> 

 
ADC Channel 1 
Meter Temperature 
CALIB (OFF/CUR/MEAS) 
      1.07       DegF 
      4.63       mA 
      0.00       DegF 

P12.5 <of 10> 

 

Notes:  
 You can perform the low- and high-range calibrations in any order; 

there is no need to perform the low range calibration prior to the 
high range. The only requirement is that you complete both points 
within the calibration timeout period.   

 The calibration is deemed to have initiated when the first setpoint 
is entered. At this point the device mode is handled and any 
associated control loops are disabled. 

Analogue Input  
Object (ADC) 

The calibration process uses the following fields:  

 
ADC Object Field Description Data Type 

LastGood field Holds the last good value read from the analogue input. [double] 
LOrange f ield The lowest value of the inputs total range to use in the calibration. [double] 
LOcurrent f ield The measured current at the LOrange point. [double] 
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ADC Object Field Description Data Type 
HIrange f ield  The highest value of the inputs total range to be used in the 

calibration. 
[double] 

HIcurrent f ield The measured current at the HIrange point. [double] 
Gradient f ield The gradient of the line between the LO and Hi range setpoints. [double] 
Of fset field The actual offset value used by the ADC, updated after a successful 

calibration. 
[double] 

Of fset adjustment 
f ield 

The of fset entered during the calibration.  [double] 

Calibration control 
f ield 

Keeps track of the calibration status. [char] 
  

Where: 

Gradient =  
HIScale – LOScale 

HICurrent – LOCurrent 

Offset = LOScale –  (LOCurrent x Gradient) 

 
The calibration control field is used to perform controlled data readings 
from the analogue input channels at the IO board. 

Then each analogue input current reading to plant value conversion is 
performed using: 

Value = (Current x Gradient) + Offset  – OffsetAdjust 
Two-Point  

Control Mechanism 
The background control task auto-configures regardless of the IO 
configuration of a particular system.  This task monitors each of the 
ADC object’s calibration control fields. The task remains idle until a 
control field is set indicating a calibration request has been made. 
The calibration control field of each of the system’s ADC input objects 
identifies what type of modification has been requested. The displays 
task is responsible for marking the calibration control field when:  

 You change the LOrange field. 
 You change the HIrange field. 
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 You perform an offset adjustment data capture. 

When you modify the calibration control field the control task: 

 Captures and places the current reading into the relevant data field. 
The previous settings are also logged internally. 

 Initiates a calibration timer that monitors the operator. 
 Continues the timer until you set the second of the two points. 

Note: If the timer completes before you set the second point, the 
device reverts to its original (logged) settings and the 
calibration cycle aborts with an error (and associated 
alarm). 

 Updates the relevant gradient, offset, and offset adjustment fields 
each time you perform a complete calibration cycle. The internally 
held previous settings will be discarded at this point. 

When you make changes, an audit trail print initiates to indicate that a 
device calibration change has been performed. This trail indicates:  

 The operator making the change. 
 The change made. 
 The old setting for this field. 
 The new setting for this data field. 
This printout uses a system event generation mechanism and as such 
has the same data attributes as any other system event. Additionally, 
the system stores the event data in the event record buffer (as is the 
case with all events generated by the flow computer). For example:  

27/10/1998 13:48:58 S600+  
USER: super-2 LOGGED IN    LEVEL:  3 

27/10/1998 13:50:03 S600+ 
Meter Temp MODE LASTGOOD 

27/10/1998 13:50:03 S600+ 
Meter Temp CALIB LO SETPT  CHANGED FROM 0.0 TO 23.0 

27/10/1998 13:54:17 S600+ 
Meter Temp CALIB LO CURR  CHANGED FROM 0.0 TO 10.87 

27/10/1998 13:54:17 S600+ 
Meter Temp CALIB HI  SETPT  CHANGED FROM 100.0 TO 89.0 

27/10/1998 13:54:17 S600+ 
Meter Temp CALIB HI  CURR  CHANGED FROM 20.0 TO 18.27 

27/10/1998 13:56:55 S600+ 
Meter Temp OFFSET CHANGED FROM 0.0 TO 1.07 

27/10/1998 13:56:59 S600+ 
Meter Temp CALIB CYCLE COMPLETED 

27/10/1998 13:50:03 S600+ 
Meter Temp MODE MEASURED 

27/10/1998 14:02:00 S600+ 
USER: super-2 LOGGED OUT 

  

D.1.3 Non-linear Three-point Curve-fit ADC Device Calibration 
This method enables you to calibrate an ADC device across a non-
linear range by entering high, mid, and low range process setpoints. 
The selection of these setpoints is user definable and thus 
device/process dependent.  
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Note: The three-point calibration process is not applicable to 
ADC11/12. 

Operator Interface  You perform this calibration in exactly the same manner as the linear 
two-point calibration with the exception that there is one additional 
display to accommodate the mid range calibration setpoint. Again, the 
order in which you define the three setpoints is irrelevant.  

 
Analogue Input  

Object (ADC)  
The calibration process uses the following fields:   

 
ADC Object Field Description Data Type 
LastGood field Holds the last good value read from the analogue input. [double] 
LOrange f ield The lowest value of the inputs total range to use in the calibration. [double] 
LOcurrent f ield The measured current at the LOrange point. [double] 
MIDrange f ield The mid range value of the inputs total range to use in the calibration. [double] 
MIDcurrent f ield The measured current at the MIDrangepoint. [double] 
HIrange f ield  The highest value of the inputs total range to be used in the calibration. [double] 
HIcurrent f ield The measured current at the HIrange point. [double] 
CurveCoeff_1 
f ield 

Calculated coefficient 1 value for use in the curve fit equation. [double] 

CurveCoeff_2 
f ield 

Calculated coefficient 2 value for use in the curve fit equation. [double] 

CurveCoeff_3 
f ield 

Calculated coefficient 3 value for use in the curve fit equation. [double] 

Calibration control 
f ield 

Keeps track of the calibration status. [char] 

Then each analogue input current reading to plant value conversion is 
performed using the second order curve equation: 

Value = (Coef 1 x Current2) + (Coef 2 x Current) + Coef 3 – OffsetAdjust 

D.1.4 Non-linear Three-point Curve Calibration Control Mechanism 
The displays task marks the calibration control field when:  

 You change the LOrange field. 
 You change the MIDrange field. 
 You change the HIrange field. 
 You perform an offset adjustment data capture. 

When you modify the calibration control field of an ADC / PRT input 
the control task: 

 Captures and places the current reading into the relevant data field 
and internally logs the previous settings. 

 Initiates a calibration timer that monitors the operator. 
 Continues the timer until you set the last of the three points.  

Note: If the timer completes before you set the third point, the 
device reverts to its original (logged) settings and the 
calibration cycle aborts with an error (and associated 
alarm). 
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 Recalculates the relevant polynomial coefficients and offset 
adjustment fields each time you perform a complete calibration 
cycle. The system also discards internally held previous settings at 
this point. 

The audit trail functionality is similar to that produced by the linear 
method with the exception that a midpoint change event exists. 

D.1.5 Offset PRT Device Calibration 
The conversion types (OffsetCalDIN and OffsetCalUS) enable you to 
crudely calibrate a PRT device across the linear range defined by the 
respective resistance-to-temperature lookup tables. The calibration 
consists of simply determining an offset from the temperature table 
conversion value.  

Operator Interface  The operator performs the calibration in exactly the same manner as 
required for the ADC calibration offset point defined previously. 

 
PRT Input Object  The calibration process uses the following fields:  

 Offset adjustment field  [double] 
 Calibration control field  [char] 

Conversions are performed at the IO module using the following 
mechanism: 

 Resistance measured by IO board PRT input. 
 Conversion made using selected lookup table. 
 Temp_actual = Temp_conv – Offset_adjust 

Offset PRT Calibration 
Control Mechanism  

The displays task, as with the ADCs, marks the calibration control 
field when:  
 You performsan offset adjustment capture. 

When you modify the calibration control field of a PRT the control 
task: 

 Captures the measured temperature reading into the offset data 
field.  

Note: The previous offset value is discarded. Additionally, there is no 
timer associated with an offset calibration type device. Finally, 
the audit trail functionality is similar to that produced for 
ADCs. 

D.1.6 Linear Two-point Device PRT Calibration 
The two-point calibration of PRTs operates in the same manner as the 
two-point calibration for ADCs. The displays task is responsible for 
marking the calibration control field when: 
 You change the LOrange field. 
 You change the HIrange field. 
 You perform an offset adjustment data capture. 
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When you modify the calibration control field the control task: 

 Captures and places the resistance reading into the relevant data 
field and logs the previous settings.  

 Initiates a calibration timer that monitors the operator. 
 Continues a timer until you set the second of the two points. 

Note: If the timer completes before you set the second point, the 
device reverts to its original (logged) settings and the 
calibration cycle aborts with an error (and associated 
alarm). 

 Updates the relevant gradient, offset and offset adjustment fields 
each time you perform a complete calibration cycle. The system 
also discards internally held previous settings at this point 

The audit trail handling is the same as for ADCs.  
PRT Input Object  The calibration process uses the following fields:  

 
PRT Object Field Description Data Type 

LastGood field Holds the last good value read from the PRT input. [double] 
LOrange f ield The lowest value of the inputs total range to use in the calibration. [double] 
LOresist field The measured resistance at the LOrange point. [double] 
HIrange f ield  The highest value of the inputs total range to use in the calibration. [double] 
HIresist f ield The measured resistance at the HIrange point. [double] 
Gradient f ield The gradient of the line between the LO and Hi range setpoints. [double] 
Of fset field The actual offset value used by the ADC, updated after a successful 

calibration. 
[double] 

Of fset adjustment field The of fset entered during the calibration. [double] 
Calibration control field Keeps track of the calibration status. [char] 

  

Where: 

Gradient =  
HIScale – LOScale 

HIResist  – LOResist 

Offset = LOScale – (LOResist x Gradient) 

Then each analogue input current reading to plant value conversion is 
performed using: 

Temperature = (Resist tance x Gradient) + Offset – OffsetAdjust 

D.1.7 Non-linear Three-point Curve-Fit PRT Device Calibration 
This method enables you to calibrate a PRT device across a non-linear 
range by entering high, mid, and low range temperature setpoints. The 
selection of these setpoints is user definable and thus device 
dependent. 

Operator Interface  Same as the process for a three-point ADC calibration 
PRT Input Object The calibration process uses the following fields:  
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PRT Object Field Description Data Type 
LastGood field Holds the last good value read from the analogue input. [double] 
LOrange f ield The lowest value of the inputs total range to use in the calibration. [double] 
LOresist field The measured resistance at the LOrange point. [double] 
MIDrange f ield The mid range value of the inputs total range to use in the calibration. [double] 
MIDresist field The measured resistance at the MIDrangepoint. [double] 
HIrange f ield  The highest value of the inputs total range to use in the calibration. [double] 
HIresist f ield The measured resistance at the HIrange point. [double] 
CurveCoeff_1 field Calculated coefficient 1 value for use in the curve fit equation. [double] 
CurveCoeff_2 field Calculated coefficient 2 value for use in the curve fit equation. [double] 
CurveCoeff_3 field Calculated coefficient 3 value for use in the curve fit equation. [double] 
Calibration control field Keeps track of the calibration status. [char] 

  

Then each PRT input resistance reading to plant value conversion is 
performed using the second order curve equation: 

Value = (Coef1 x Re sis tance2) + (Coef2 x Re sis tance) + Coef3 – OffsetAdjust 

D.2 Analogue Output Calibration 

Do not confuse process calibration with the production hardware 
calibration you perform on all IO boards subsequent to manufacturing. 
You perform hardware calibration after production to determine the 
relationship between analogue converter counts and current in mA for 
Digital to Analog Converters (DACs). This calibration process 
essentially “fixes” each individual output channel the way in which the 
S600+ outputs the current.  

Process calibration does not alter this counts-to-measure relationship. 

In the case of DACs, calibration defines the adjustment made to the 
transducer engineer units before driving the output current. Thus; after 
process calibration, the analogue device produces a current equal to the 
one that would be produced by an ideal device. 

D.2.1 Calibration Control Requirements 
1. You must disconnect any device connected to the analog output. 

The current driven by the device changes abruptly during 
calibration and this might damage the device.    

2. You cannot perform part of a calibration and effectively impair the 
integrity of field output data. The calibration control task uses a 
configurable time to monitor all calibration operations. Thus, if you 
perform part of a calibration but do not complete the process prior 
to timeout, the control task reverts all calibration data to its initial 
state prior to the start of the calibration operation. The calibration 
terminates and an error displays. The default timeout setting for the 
analog output calibration is 20 minutes. This time value is not 
configurable.  
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D.2.2 DAC Device Calibration 
This is a linear calibration. The purpose is to adjust the current for the 
LOW and the HIGH values of the DAC’s scale.  

Operator Interface  To calibrate the DAC device:  

1. Connect a digital multimeter to read the current (mA) from the 
analog ouput that you will calibrate.   

2. Navigate to an analog output channel requiring calibration.  

3. Move to the calibration display page. Press CHNG to start 
calibration. 

DAC01               
I/O01 DAC 01        
                    
FOR CALIBRATION 
PRESS 
CHANGE       *           
  
P51.3 <of 3> 

 
4. Calibrate the low current. Use the up and down arrows from the 

keypad to adjust the current until the measured current is equal to 
the expected current (the one shown on the display). Once they are 
equal, press Enter to go to the next step.  

DAC01               
I/O01 DAC 01        
                    
        4mA 
UP      - INCREASE 
DOWN    - DECREASE 
ENTER   - NEXT 
CLEAR   - ABORT 

 

Note: In the event the calibration offset limits are reached, the 
system displays a message for the operator on the display.  

5. Calibrate the high current. Use the up and down arrows from the 
keypad to adjust the current until the measured current is equal to 
the expected current (the one shown on the display). Once they are 
equal, press Enter to go to the next step.  

DAC01               
I/O01 DAC 01        
                    
        20mA 
UP      - INCREASE 
DOWN    - DECREASE 
ENTER   - ACCEPT 
CLEAR   - ABORT 
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6. Repeat steps 4 and 5 by pressing keypad 2 until you can see no 
further improvement. When no improvement can be seen, select 1 
(SAVE CHANGES) to save the changes.   

DAC01               
I/O01 DAC 01        
                     
CALIBRATION FINISHED 
  
1. SAVE CHANGES 
2. GO AGAIN 
2. ABORT 

 
7. In order to make the adjustments consistent through a cold start, 

perform a system backup. If you do not do this, you lose the 
changes on a cold start (although they persist on a warm start). 

Notes:  
 The system saves values for a specific board. If you change the 

board, you must redo the calibration.    
 In steps 4 or 5, press CLEAR to abort the process.  

DAC Control 
 Mechanism  

The calibration control task monitors each of the DAC objects 
calibration control fields. The task remains idle until a control field is 
set indicating a calibration request has been made. The calibration 
control field of each of the systems DAC objects identifies what type 
of modification has been requested. The display task is responsible for 
marking the calibration control field when:  

 You change the low calibration offset (calibrate the low current). 
 You change the high calibration offset (calibrate the high current). 

When you modify the calibration control field, the control task: 
 Captures and saves the current calibration offsets. 
 Initiates a calibration time that monitors the operation. 
 Continues the timer until you save the calibration changes. 

Note: If the timer completes before you save the calibration 
changes, the device reverts to its original (logged) settings 
and the calibration cycle aborts with an error (and 
associated alarm). 

 Updates relevant offset adjustment fields each time you perform a 
complete calibration cycle. The system discards internally held 
previous settings at this point. 

When you make changes, an audit trail print indicates that a device 
calibration has been performed and logs:  

 The operator making the change. 
 The change made. 

This printout uses a system event generation mechanism and has the 
same data attributes as any other system event. Additionally, the 
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system stores the event data in the event record buffer (as is the case 
with all events generated by the flow computer). For example:  

11/02/2011 07:25:36 S600 FP  USER: LOGGED IN    LEVEL:  1 

11/02/2011 07:26:45 S600 CALIBRATION STARTED FOR DAC01 

11/02/2011 07:26:45 S600 CALIBRATION ABORTED FOR DAC01 

 

11/02/2011 07:26:55 S600 CALIBRATION STARTED FOR DAC01 

11/02/2011 07:46:55 S600 CALIBRATION TIMED OUT FOR DAC01  

11/02/2011 07:46:55 S600 CALIBRATION ABORTED FOR DAC01   

 

11/02/2011 07:50:45 S600 CALIBRATION STARTED FOR DAC01   

11/02/2011 08:05:52 S600 CALIBRATION POINTS SAVED FOR DAC01   
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This appendix provides a alphabetic listing of the database objects you 
can access through the Connect Wizard, which is part of the Reports 
Editor, Modbus Editor, LogiCalc Editor, Display Editor, and System 
Editor.  

E.1 Database Objects   
This section provides an alphabetic listing of all database objects. 

E.1.1 ADC  
Object Descriptor Type 
DESC Descriptor String 
CONVTYP ADC conversion type (integer) Byte 
TAG Tag name associated with the object String 
MODE Integer mode / field selection for ‘INUSE’ 

f ield.   
Byte 

HEALTH Measurement status. 0 if OK Byte 
INUSE Value copied from MEASURED, 

KEYPAD, AVERAGE , LASTGOOD, or 
WEIGHTED as indexed by the ‘MODE’ 
f ield 

Double 

KEYPAD Value used in KEYPAD / KEYPAD-F 
mode 

Double 

MEASURED Measured value Double 
CURRENT Measured current Double 
LOSCALE Low ADC scale value (4mA or 0mA) Double 
HISCALE High ADC scale value 20mA Double 
LOCALIB Low engineering value * Double 
MIDCALIB Mid engineering value * Double 
HICALIB High engineering value * Double 
LOCURRENT Snapshot low current * Double 
MIDCURRENT Snapshot mid current * Double 
HICURRENT Snapshot high current * Double 
GRADIENT Calculated gradient * Double 
OFFSET Calculated offset * Double 
OFFSETADJ In-use offset adjust * Double 
COEFF1 Calculated low calibration coefficient * Double 
COEFF2 Calculated mid calibration coefficient * Double 
COEFF3 Calculated high calibration coefficient * Double 
ROC The maximum rate at which the ‘INUSE’ 

f ield can change, per second 
Double 

SETPOINT Expected value Double 
DEVIATION Maximum allowed variation from 

‘SETPOINT’ 
Double 

AVERAGE Rolling average of the MEASURED field:  
AVERAGE=(AVERAGE+MEASURED)/2 

Double 

LASTGOOD Last MEASURED value Double 
HIHILIM High – high alarm limit Double 
HILIM High alarm limit Double 
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Object Descriptor Type 
LOLIM Low alarm limit Double 
LOLOLIM Low – low alarm limit Double 
OFFSETENTRY Operator offset adjust field * Double 
LOFAIL Under-range current limit Double 
HIFAIL Over range current limit Double 
WEIGHTED Time/flow weighted average (updated at 

the end of the period) 
Double 

MODETEXT Text string associated with the integer 
‘MODE’ field. See mode table 

String 

CONVTEXT ADC type String 
ID For internal use Double 
UNITTEST Units associated with the object String 
DESCSHORT Short descriptor of the object String 

* These f ields are used for field calibration. 

E.1.2 ALARM  
Object Description Type 
DESC Descriptor String 
STATUS Current alarm status for alarms 1 – 16 Word 
UNACC Current alarm accept status for alarms 1 – 

16 
Word 

INHIBIT Alarm inhibit bit mask for alarms 1 – 16 Word 
SUPPRESS Current alarm suppression bit mask for 

alarms 1 – 16 
Word 

E.1.3 ALARMHIST  
Object Description Type 
PRINTED Printed flag Byte 
STATE Current status for alarms (ALM_SET, 

ALM_CLR, or ALM_ACC)  
Byte 

NUM Alarm number Byte 
ID Alarm audit ID counter  Word 
ENRONID Enron Modbus ID Word 
ENRONBIT Enron bitmask Word 
LIMIT Alarm limit Double 
VALUE Value when the alarm was raised  Double 

E.1.4 ARRTXT  
Object Description Type 
DESC Descriptor String 
0 Array text 0 String 
1 Array text 1 String 
2 Array text 2 String 
3 Array text 3 String 
4 Array text 4 String 
5 Array text 5 String 
6 Array text 6 String 
7 Array text 7 String 
8 Array text 8 String 
9 Array text 9 String 
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Object Description Type 
10 Array text 10 String 
11 Array text 11 String 
12 Array text 12 String 
13 Array text 13 String 
14 Array text 14 String 
15 Array text 15 String 
16 Array text 16 String 
17 Array text 17 String 
18 Array text 18 String 
19 Array text 19 String 
20 Array text 20 String 
21 Array text 21 String 
22 Array text 22 String 
23 Array text 23 String 
24 Array text 24 String 
25 Array text 25 String 
26 Array text 26 String 
27 Array text 27 String 
28 Array text 28 String 
29 Array text 29 String 
30 Array text 30 String 
31 Array text 31 String 
32 Array text 32 String 
33 Array text 33 String 
34 Array text 34 String 
35 Array text 35 String 
36 Array text 36 String 
37 Array text 37 String 
38 Array text 38 String 
39 Array text 39 String 

E.1.5 CALCALMITEM  
Object Description Type 
DESC Descriptor String 
MODE Integer mode / field selection for ‘INUSE’ 

f ield. Refer to CALC/ALM Modes, Density 
Transducer Modes, and CALC/ALM Auto 
Switch Modes.   

Byte 

INUSE Value copied from KEYPAD, CALC1, 
CALC2, CALC3, or CALC4 as indexed by 
the ‘MODE’ field 

Double 

KEYPAD Value used in KEYPAD / KEYPAD-F 
mode 

Double 

CALC1 Calculation result 1 Double 
CALC2 Calculation result 2 Double 
CALC3 Calculation result 3 Double 
CALC4 Calculation result 4 Double 
HIHILIM High – High alarm limit Double 
HILIM High alarm limit Double 
LOLIM Low alarm limit Double 
LOLOLIM Low – low alarm limit Double 
WEIGHTED Rolling time/flow weighted average Double 
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Object Description Type 
MODETEXT Mode text String 
UNITTEXT Units associated with the object String 
DESCSCHORT Short descriptor of the object String 

E.1.6 CALCTAB  
Object Description Type 
DESC Descriptor String 
TYPE Calculation type, i.e., AGA3 = 104 Word 
INPUT01 CONFTAB index for input 1 Word 
INPUT02 CONFTAB index for input 2 Word 
INPUT03 CONFTAB index for input 3 Word 
INPUT04 CONFTAB index for input 4 Word 
INPUT05 CONFTAB index for input 5 Word 
INPUT06 CONFTAB index for input 6 Word 
INPUT07 CONFTAB index for input 7 Word 
INPUT08 CONFTAB index for input 8 Word 
INPUT09 CONFTAB index for input 9 Word 
INPUT10 CONFTAB index for input 10 Word 
INPUT11 CONFTAB index for input 11 Word 
INPUT12 CONFTAB index for input 12 Word 
INPUT13 CONFTAB index for input 13 Word 
INPUT14 CONFTAB index for input 14 Word 
INPUT15 CONFTAB index for input 15 Word 
INPUT16 CONFTAB index for input 16 Word 
INPUT17 CONFTAB index for input 17 Word 
INPUT18 CONFTAB index for input 18 Word 
INPUT19 CONFTAB index for input 19 Word 
INPUT20 CONFTAB index for input 20 Word 
OUTPUT01 CONFTAB index for output 1 Word 
OUTPUT02 CONFTAB index for output 2 Word 
OUTPUT03 CONFTAB index for output 3 Word 
OUTPUT04 CONFTAB index for output 4 Word 
OUTPUT05 CONFTAB index for output 5 Word 
OUTPUT06 CONFTAB index for output 6 Word 
OUTPUT07 CONFTAB index for output 7 Word 
OUTPUT08 CONFTAB index for output 8 Word 
OUTPUT09 CONFTAB index for output 9 Word 
OUTPUT10 CONFTAB index for output 10 Word 
OUTPUT11 CONFTAB index for output 11 Word 
OUTPUT12 CONFTAB index for output 12 Word 
OUTPUT13 CONFTAB index for output 13 Word 
OUTPUT14 CONFTAB index for output 14 Word 
OUTPUT15 CONFTAB index for output 15 Word 
OUTPUT16 CONFTAB index for output 16 Word 
OUTPUT17 CONFTAB index for output 17 Word 
OUTPUT18 CONFTAB index for output 18 Word 
OUTPUT19 CONFTAB index for output 19 Word 
OUTPUT20 CONFTAB index for output 20 Word 
ERRORNUM Calculation error number (for diagnostics) Word 
DESCSHORT Short descriptor of the object String 
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E.1.7 CONFTAB  
Object Description Type 
DESC Descriptor String 
OBJTYPE Object type Word 
OBJINDEX Object index Word 
OBJFIELD Object field Word 
BITNO Bit number Word 
DESCSHORT Short descriptor of the object String 

E.1.8 CUMTOT  
Object Description Type 
DESC Descriptor String 
ROLLOVER The power of 10 at which rollover occurs Byte 
DECPLACE Number of figures after the decimal point 

stored in the ‘TOTAL’ field, all others are 
held in the ‘REMAINDER’ field 

Byte 

SCALE Not used Double 
PREVIOUS Not used Double 
SNAPSHOT Cumulative total at the last period end Double 
TOTAL Current cumulative total (tri-reg) Double 
val_1 For internal use Double 
REMAINDER The remainder not included in TOTAL Double 
rem_1 For internal use Double 
SNAPTIMETEXT The time when SNAPSHOT was updated String 
UNITTEXT Units associated with the object String  
DESCSHORT Short descriptor of the object  String  

E.1.9 DACOUT  
Object Description Type 
DESC Descriptor String 
CONVTYP DAC conversion type (integer) Byte 
TAG Tag name associated with the object String  
RAW DAC output value (engineering units) Double 
LOSCALE Low scale output value (4mA or 0mA) Double 
HISCALE High scale output value (20mA Double 
LOOFFSET Low calibration offset Double 
HIOFFSET High calibration offset Double 
CONVTEXT DAC type String 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

E.1.10 DIGIO  
Object Description Type 
DESC Description String 
TAG Tag name associated with the object String 
HEALTH Measurement status. 0 if OK Byte 
INPUT Digital output status, where bits 0 to 11 

represent digital outputs 1 to 12 
Word 

OUTPUT Digital input status, where bits 0 to n 
represent digital inputs 1 to n 

Word 

RAWIN As INPUT Word 
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Object Description Type 
RAWOUT As OUTPUT Word 
INPUTTEXT Status text String 
OUTPUTTEXT Status text String 

E.1.11 DOSETUP   
Object Description Type 
DESC Descriptor String 
SENSE Channel mode: normal, invert, pulse, or 

pulse off 
Word 

WIDTH Duration of the pulse in mSec, if channel is 
set to pulse or pulse off.  

Word 

E.1.12 DPCELL  
Object Description Type 
DESC Descriptor String 
MODE Integer mode / field selection for ‘INUSE’ 

f ield. Refer to  DP Modes.  
Byte 

DPTYPE DP stack type. Refer to DP Stack Type.  Byte 
DPCOMODE DP cut off mode. Refer to DP Cutoff Mode.  Byte 
LIVECHK Live/check status. Refer to DP Live/Check 

Mode Selection.  
Byte 

CELL Current active cell.  Word 
INUSE Value copied from MEASURED or 

CHECK as indexed by the MODE field or 
the keypad. 

Double 

MEASURED DP measured value.  Double 
KEYPAD Value used in KEYPAD / KEYPAD-F 

mode 
Double 

CHECK DP for testing.  Double 
CUTOFF Value below which the S600+ does not 

totalize DP measurements 
Double 

FLOWRATE Calculated flow rate Sqrt (DP) * Const Double 
FRCONST Flow rate constant  Double 
SWITCHUP The switch-up point between two input 

cells, expressed as a percentage of the 
range of the lower cell. The S600+ uses 
this value for all cell ranges 

Double 

SWITCHDN The switch-down point between two input 
cells, expressed as a percentage of the 
range of the lower cell. The S600+ uses 
this value for all cell ranges 

Double 

DISCREP The discrepancy allowed between the 
readings of active input cells in the 
operating range. The value is defined as a 
percentage of the high scale value from 
the lower of the two cells. 

Double 

DISCTOUT The period of time during which the S600+ 
ignores the discrepancy between the 
readings of available transducers. When 
the duration of the discrepancy exceeds 
this time limit, the S600+ raises an alarm. 

Double 

HIHILIM High – high alarm limit Double 
HILIM High alarm limit Double 
LOLIM Low alarm limit Double 
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Object Description Type 
LOLOLIM Low – low alarm limit Double 
MODETEXT Mode text String 
OBJTYPE1 Object type for DP cell 1 Word 
OBJTYPE2 Object type for DP cell 2 Word 
OBJTYPE3 Object type for DP cell 3 Word 
OBJTYPE4 Object type for DP cell 4 Word 
OBJTYPE5 Object type for DP cell 5 Word 
OBJTYPE6 Object type for DP cell 6 Word 
OBJINDEX1 Object index for DP cell 1 Word 
OBJINDEX2 Object index for DP cell 2 Word 
OBJINDEX3 Object index for DP cell 3 Word 
OBJINDEX4 Object index for DP cell 4 Word 
OBJINDEX5 Object index for DP cell 5 Word 
OBJINDEX6 Object index for DP cell 6 Word 
HEALTH Health status byte Byte 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

E.1.13 EVENTHIST  
Object Descriptor Type 
EVENT Event type.  Byte 
PRINTED Printed flag Byte 
ID Unique ID Word 
ENRONID Enron Modbus ID Word 
ENRONBIT Enron bitmask Word 

E.1.14 FREQT  
Object Descriptor Type 
DESC Descriptor  String 
TAG Tag name associated with the object String 
HEALTH Measurement status. 0 if OK Byte 
PERIOD Measured period Double 
FREQ Measured frequency Double 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

E.1.15 HART   
Object Descriptor  Type 
DESC Descriptor  String 
MODE Integer mode / field selection for ‘INUSE’ 

f ield. Refer to “HART Modules.”  
Byte 

ID For internal use Double 
TAG Tag (HART revision 5 command 13) String 
HEALTH Measurement status. 0 if OK. Bit 0 is set 

for over range, bit 1 set for under range.  
These are back-calculated from the PV, 
UPRANGE and LORANGE when 
STATUS2 indicates analogue output 
saturation or PV is out of limits.  
Note: Bit 6 is set when nothing is 
connected (Status2=128). 

Byte 
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Object Descriptor  Type 
STATUS2 / 
SECOND_STAT_BYTE 

Second status byte (HART revision 5) Byte 

PVUNIT / 
PV_UNIT_CODE 

Primary variable unit code (HART revision 
5 command 3) 

Byte 

SVUNIT / 
SV_UNIT_CODE 

Secondary variable unit code (HART 
revision 5 command 3) 

Byte 

TVUNIT / 
TV_UNIT_CODE 

Tertiary variable unit code (HART revision 
5 command 3) 

Byte 

FVUNIT / 
FV_UNIT_CODE 

Fourth variable unit code (HART revision 5 
command 3) 

Byte 

UNIVCMDREV / 
UNIV_COMMAND_REV 

Universal command revision (HART 
revision 5 command 0) 

Byte 

TXCMDREV / 
TX_COMMAND_REV 

Transmitter Specific Command Revision 
(HART revision 5 command 0) 

Byte 

SWREV / SW_REV Software Revision (HART revision 5 
command 0) 

Byte 

HWREV / HW_REV Hardware Revision (HART revision 5 
command 0) 

Byte 

STATUS1 / 
FIRST_STAT_BYTE 

First status byte (HART revision 5) Byte 

INUSE Value copied from PV, KEYPAD, 
AVERAGE,  LASTGOOD, or WEIGHTED 
as indexed by the ‘MODE’ field 

Double 

KEYPAD Value used in KEYPAD / KEYPAD-F 
mode 

Double 

ROC The maximum rate at which the ‘INUSE’ 
f ield can change, per second 

Double 

SETPOINT Expected value Double 
DEVIATION Maximum allowed variation from 

‘SETPOINT’ 
Double 

AVERAGE Rolling average of the MEASURED field:  
AVERAGE=(AVERAGE+MEASURED)/2 

Double 

LASTGOOD / 
LAST_GOOD 

Last MEASURED value Double 

HIHILIM  / HH_LIMIT  High – high alarm limit Double 
HILIM  / H_LIMIT  High alarm limit Double 
LOLIM  / L_LIMIT  Low alarm limit Double 
LOLOLIM  / LL_LIMIT  Low – low alarm limit Double 
CURRENT Current mA (HART revision 5 command 3) Double 
PV Primary variable (HART revision 5 

command 3) 
Double 

SV Secondary variable (HART revision 5 
command 3) 

Double 

TV Tertiary variable (HART revision 5 
command 3) 

Double 

FV Fourth variable (HART revision 5 
command 3) 

Double 

UPRANGE  / 
UPPER_RANGE 

Upper range value from HART transmitter 
(HART revision 5 command 15) 

Double 

LORANGE  / 
LOWER_RANGE 

Lower range value from HART transmitter 
(HART revision 5 command 15) 

Double 

UPPERLIM  / 
UPPER_LIM 

Upper Sensor Limit (HART revision 5 
command 14) 

Double 

LOWERLIM  / 
LOWER_LIM 

Lower Sensor Limit  (HART revision 5 
command 14) 

Double 
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Object Descriptor  Type 
WEIGHTED Rolling time/flow weighted average Double 
MODETEXT Mode text String 
UNITTEXT Unit text String 
DESCSHORT Short description String 

E.1.16 HARTTAB  
Object Descriptor Type 
DESC Descriptor String 
POLLFMT Hart module type. Refer to HART Poll 

Format.  
Byte 

MSTMODE Primary / secondary master mode. Refer 
to HART Master Mode.  

Byte 

SWVER Module (P188) software version number Word 
ALTVER Module (P188) Altera version number Word 
ALTCHANS Number of channels supported Word 

E.1.17 IOASSIGN  
Object Descriptor Type 
DESC Descriptor String 
INUSE Current in-use value Double 
MODE Integer mode / field selection for ‘INUSE’ 

f ield 
Byte 

KEYPAD Value used in KEYPAD / KEYPAD-F 
mode 

Double 

ROC Maximum rate at which the ‘INUSE’ field 
can change, per second  

Double 

SETPOINT Expected value  Double 
DEVIATION Maximum allowed variation from 

‘SETPOINT’ 
Double 

AVERAGE Rolling average of the MEASURED field: 
AVERAGE=AVERAGE+MEASURED/2 

Double 

LASTGOOD/ 
LAST_GOOD 

Last MEASURED value Double 

HIHILIM /HH_LIMIT High – high alarm limit Double 
HILIM / H_LIMIT High alarm limit Double 
LOLIM / LL_LIMIT Low alarm limit Double 
LOLOLIM / LL_LIMIT Low – low alarm limit Double 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object  String 

E.1.18 KPINT   
Object Descriptor Type 
DESC Descriptor String 
VALUE Value (1 to 39) Word 
STATUS Status text for VALUE field (1 to 39)  String 

E.1.19 KPINTARR  
Object Descriptor Type 
DESC Descriptor String 
0 Value 0 Word 
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Object Descriptor Type 
1 Value 1 Word 
2 Value 2 Word 
3 Value 3  Word 
4 Value 4 Word 
5 Value 5  Word 
6 Value 6 Word 
7 Value 7 Word 
8 Value 8 Word 
9 Value 9 Word 
10 Value 10 Word 
11 Value 11 Word 
12 Value 12 Word 
13 Value 13 Word 
14 Value 14 Word 
15 Value 15 Word 
16 Value 16 Word 
17 Value 17 Word 
18 Value 18 Word 
19 Value 19 Word 
20 Value 20 Word 
21 Value 21 Word 
22 Value 22 Word 
23 Value 23 Word 
24 Value 24 Word 
25 Value 25 Word 
26 Value 26 Word 
27 Value 27 Word 
28 Value 28 Word 
29 Value 29 Word 
30 Value 30 Word 
31 Value 31 Word 
32 Value 32 Word 
33 Value 33 Word 
34 Value 34 Word 
35 Value 35  Word 
36 Value 36 Word 
37 Value 37  Word 
38 Value 38 Word 
39 Value 39 Word 
STATUS1 Status text for value 0 String 
STATUS2 Status text for value 1 String 
STATUS3 Status text for value 2 String 
STATUS4 Status text for value 3 String 
STATUS5 Status text for value 4 String 
STATUS6 Status text for value 5 String 
STATUS7 Status text for value 6 String 
STATUS8 Status text for value 7 String 
STATUS9 Status text for value 8 String 
STATUS10 Status text for value 9 String 
STATUS11 Status text for value 10 String 
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Object Descriptor Type 
STATUS12 Status text for value 11 String 
STATUS13 Status text for value 12 String 
STATUS14 Status text for value 13 String 
STATUS15 Status text for value 14 String 
STATUS16 Status text for value 15 String 
STATUS17 Status text for value 16 String 
STATUS18 Status text for value 17 String 
STATUS19 Status text for value 18 String 
STATUS20 Status text for value 19 String 
STATUS21 Status text for value 20 String 
STATUS22 Status text for value 21 String 
STATUS23 Status text for value 22 String 
STATUS24 Status text for value 23 String 
STATUS25 Status text for value 24 String 
STATUS26 Status text for value 25 String 
STATUS27 Status text for value 26 String 
STATUS28 Status text for value 27 String 
STATUS29 Status text for value 28 String 
STATUS30 Status text for value 29 String 
STATUS31 Status text for value 30 String 
STATUS32 Status text for value 31 String 
STATUS33 Status text for value 32 String 
STATUS34 Status text for value 33 String 
STATUS35 Status text for value 34 String 
STATUS36 Status text for value 35 String 
STATUS37 Status text for value 36 String 
STATUS38 Status text for value 37 String 
STATUS39 Status text for value 38 String 
STATUS40 Status text for value 39 String 

E.1.20 KPREAL  
Object Descriptor Type 
DESC Descriptor String 
VALUE Value Double 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

E.1.21 KPREALARR  
Object Descriptor Type 
DESC Descriptor String 
0 Value 0 Double 
1 Value 1 Double 
2 Value 2 Double 
3 Value 3  Double 
4 Value 4 Double 
5 Value 5  Double 
6 Value 6 Double 
7 Value 7 Double 
8 Value 8 Double 
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Object Descriptor Type 
9 Value 9 Double 
10 Value 10 Double 
11 Value 11 Double 
12 Value 12 Double 
13 Value 13 Double 
14 Value 14 Double 
15 Value 15 Double 
16 Value 16 Double 
17 Value 17 Double 
18 Value 18 Double 
19 Value 19 Double 
20 Value 20 Double 
21 Value 21 Double 
22 Value 22 Double 
23 Value 23 Double 
24 Value 24 Double 
25 Value 25 Double 
26 Value 26 Double 
27 Value 27 Double 
28 Value 28 Double 
29 Value 29 Double 
30 Value 30 Double 
31 Value 31 Double 
32 Value 32 Double 
33 Value 33 Double 
34 Value 34 Double 
35 Value 35  Double 
36 Value 36 Double 
37 Value 37  Double 
38 Value 38 Double 
39 Value 39 Double 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

E.1.22 KPSTRING  
Object Descriptor Type 
DESC Descriptor String 
VALUE Value String 

E.1.23 LOG  
Object Descriptor Type 
DESC Descriptor String 
TYPE Object type associated with the log, i.e., 

ALARMHIST or EVENTHIST 
Byte 

HEAD Index to the oldest object Word 
COUNT Total number of alarms / events. This may 

be different than the value of Head 
because one event may use several 
EVENTHIST objects 

Word 
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Object Descriptor Type 
MODE Integer mode / field selection for ‘INUSE’ 

f ield.  
Word 

RECORDS Number of ALARMHIST or EVENTHIST 
objects associated with this log 

Word 

E.1.24 MULTI  
Object Descriptor Type 
DESC Descriptor String 
OUTPUT Control value Word 
INPUT Status value Word 
CONTROL Control text String 
STATUS Status text String 

Note: CONTROL and STATUS text result from a Truth Table lookup. 

E.1.25 PID  
Object Descriptor Type 
DESC Descriptor String 
DACCTL For internal use only  Byte 

E.1.26 PIP  
Object Descriptor Type 
DESC Descriptor String 
TAG Tag name associated with the object String 
HEALTH Measurement status. 0 if OK Byte 
GOOD Good pulse counter Double 
BAD Bad pulse counter Double 
DELTAGOOD For internal use Double 
DELTABAD For internal use Double 
FREQ Measured pulse frequency Double 
TIME P144: the time main board last polled the 

I/O module for pulse count 
P154: the exact time the I/O module read 
the hardware pulse counters 

Double 

KFACTOR For internal use Double 

E.1.27 POP  
Object Descriptor Type 
DESC Descriptor String 
TAG Tag name associated with the object String 
FREQ Pulse output frequency. Valid range is 0.5 

to 500 Hertz (this is, 2 seconds to 1 mS) 
Double 

GRABSIZE The number of units per pulse Double 
PREVTOTAL Snap shot taken at last calculation cycle Double 
REM Pulse fraction awaiting output Double 
PULSEOUT Whole pulses awaiting output Double 

E.1.28 PRDTOT  
Object Descriptor Type 
DESC Descriptor String 
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Object Descriptor Type 
ROLLOVER The power of 10 at which rollover occurs Byte 
DECPLACE Number of figures after the decimal point 

stored in the ‘TOTAL’ field, all others are 
held in the ‘REMAINDER’ field 

Byte 

SCALE Not used Double 
PREVIOUS Previous period total Double 
SNAPSHOT Snapshot cumulative at the last period 

end 
Double 

TOTAL Current period total Double 
Val Current period total Double 
REMAINDER Not used Double 
Rem Not used Double 
ALMHEADSNAP The index of the oldest alarm history 

object at the last period end 
Word 

ALMHEADPREV The index of the oldest alarm history 
object at the start of the last period 

Word 

EVTHEADSNAP As ALMHEADSNAP, but for events Word 
EVTHEADPREV As ALMHEADPREV, but for events Word 
ALMCOUNT The number of alarms in the previous 

period 
Word 

ALMCOUNTSNAP The alarm counter at the last period end Word 
ALMCOUNTPREV The alarm counter at the start of the last 

period 
Word 

EVTCOUNT The number of events in the previous 
period 

Word 

EVTCOUNTSNAP As ALMCOUNTSNAP, but for events Word 
EVTCOUNTPREV As ALMCOUNTPREV, but for events Word 
ALMLOG Alarm history – for reports only Alarm 
EVTLOG Event history – for reports only Event 
SNAPTIMETEXT The time when SNAPSHOT was updated String 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

E.1.29 PRT  
Object Descriptor Type 
DESC Descriptor String 
RTDTYP Type of transducer  Byte 
TAG Tag name associated with the object  String 
MODE Integer mode / field selection for ‘INUSE’ 

f ield. Refer to ACD/PRT Modes.  
Byte 

HEALTH Measurement status. 0 if OK Byte 
INUSE Value copied from MEASURED, 

KEYPAD, AVERAGE,  LASTGOOD, or 
WEIGHTED as indexed by the ‘MODE’ 
f ield 

Double 

KEYPAD Value used in KEYPAD / KEYPAD-F 
mode 

Double 

MEASURED Measured temperature  Double 
RESISTANCE Measured resistance Double 
LOCALIB Low engineering value * Double 
MIDCALIB Mid engineering value * Double 
HICALIB High engineering value * Double 
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Object Descriptor Type 
LORESISTANCE Snapshot low resistance * Double 
MIDRESISTANCE Snapshot mid resistance * Double 
HIRESISTANCE Snapshot high resistance * Double 
GRADIENT Calculated gradient * Double 
OFFSET Calculated offset * Double 
OFFSETADJ In-use offset adjust * Double 
COEFF1 Calculated low calibration coefficient * Double 
COEFF2 Calculated mid calibration coefficient * Double 
COEFF3 Calculated high calibration coefficient * Double 
ROC The maximum rate at which the ‘INUSE’ 

f ield can change, per second 
Double 

SETPOINT Expected value Double 
DEVIATION Maximum allowed variation from 

‘SETPOINT’ 
Double 

AVERAGE Rolling average of the MEASURED field:  
AVERAGE=(AVERAGE+MEASURED)/2 

Double 

LASTGOOD Last MEASURED value Double 
HIHILIM High – high alarm limit Double 
HILIM High alarm limit Double 
LOLIM Low alarm limit Double 
LOLOLIM Low – low alarm limit Double 
OFFSETENTRY Operator offset adjust field * Double 
WEIGHTED Rolling time/flow weighted average Double 
MODETEXT Mode text String 
CONVTEXT PRT type String 
ID For internal use Double 
UNITTEXT Units associated with the object String 
DESCSHORT Short descriptor of the object String 

* Fields used for field calibration 

E.1.30 PRV_CTL  
Object Descriptor Type 
DESC Descriptor String 
MODTYP Prover configuration type. Refer to Prover 

(P154) Type.  
Word 

DUALPLSSEL Select dual pulse channel A/B Word 
PLSSTRSEL Multiplexer pls selection Word 
CTLINPSEL Phase locked loop control Word 
SWITCHDELAY Optional switch delay Word 
SWITCHSEL Switch sequence selection. Refer to 

Prover (P154) Switch Sequence Selection.  
Word 

SWITCH Switch status String 
SWITCHSTAT Switch status Word 
STATE Prove state. Refer to Prover (P154) State.  Word 
PLSCNT01 Switch 0 – 1 count data Double 
PLSCNT23 Switch 2 – 3 count data Double 
PLSCNT03 Switch 0 – 3 count data Double 
PLSCNT21 Switch 2 – 1 count data Double 
FLTTM01 Switch 0 – 1 flight time Double 
FLTTM23 Switch 2 – 3 flight time Double 
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Object Descriptor Type 
FLTTM03 Switch 0 – 3 flight time Double 
FLTTM21 Switch 2 – 1 flight time Double 
DCFLTTM Dual chronometry flight time Double 

E.1.31 REP00 – REP39  
Object Descriptor Type 
TIMETEXT Report time string String 
ID For internal use Double 
PRINTED Current printed flag status Byte 
VALID Valid flag  Byte 
FILE Internal report filename String 
DOCKET Unique report docket number String 
0 First placement on the top left of the report  Dynamic 
N Last placement on the bottom right of the 

report 
Dynamic 

E.1.32 SECURITY  
Object Descriptor Type 
DESC Descriptor String 
USERNAME Username String 
PASSWORD Password String 

E.1.33 SYSOBJ  
Object Descriptor Type 
DESC Descriptor String 

E.1.34 TASK  
Object Descriptor Type 
DESC Descriptor String 
USERSRT1 User supplies task argument 1  String 
USERSRT2 User supplies task argument 2  String 
USERSRT3 User supplies task argument 3  String 
USERSRT4 User supplies task argument 4  String 
USERSRT5 User supplies task argument 5  String 

E.1.35 TOTTAB  
Object Descriptor Type 
DESC Descriptor String 
STRCUMINDEX* Cumulative object index for the stream Byte 
STNCUMINDEX* Cumulative object index for the station  Byte 
XXBATINDEX* Batch object index for XXX stream Byte 
XXBATINDEX* Batch object index for XXX station  Byte 
STRMAINTINDEX* Maintenance object for the stream  Byte 
STAMAINTINDEX* Maintenance object for the station  Byte 
STRPRD11INDEX Basetime 1 period 1 object index for the 

stream 
Byte 

STNPRD11INDEX Basetime 1 period 1 object index for the 
station 

Byte 
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Object Descriptor Type 
STRPRD12INDEX Basetime 1 period 2 object index for the 

stream 
Byte 

STNPRD12INDEX Basetime 1 period 2 object index for the 
station 

Byte 

STRPRD13INDEX Basetime 1 period 3 object index for the 
stream 

Byte 

STNPRD13INDEX Basetime 1 period 3 object index for the 
station 

Byte 

STRPRD14INDEX Basetime 1 period 4 object index for the 
stream 

Byte 

STNPRD14INDEX Basetime 1 period 4 object index for the 
station 

Byte 

STRPRD21NDEX Basetime 2 period 1 object index for the 
stream 

Byte 

STNPRD21INDEX Basetime 2 period 1 object index for the 
station 

Byte 

STRPRD22NDEX Basetime 2 period 2 object index for the 
stream 

Byte 

STNPRD22INDEX Basetime 2 period 2 object index for the 
station 

Byte 

STRPRD23NDEX Basetime 2 period 3 object index for the 
stream 

Byte 

STNPRD23INDEX Basetime 2 period 3 object index for the 
station 

Byte 

STRPRD24NDEX Basetime 2 period 4 object index for the 
stream 

Byte 

STNPRD24INDEX Basetime 2 period 4 object index for the 
station 

Byte 

STRPRD31NDEX Basetime 3 period 1 object index for the 
stream 

Byte 

STNPRD31INDEX Basetime 3 period 1 object index for the 
station 

Byte 

STRPRD32NDEX Basetime 3 period 2 object index for the 
stream 

Byte 

STNPRD32INDEX Basetime 3 period 2 object index for the 
station 

Byte 

STRPRD33NDEX Basetime 3 period 3 object index for the 
stream 

Byte 

STNPRD33INDEX Basetime 3 period 3 object index for the 
station 

Byte 

STRPRD34NDEX Basetime 3 period 4 object index for the 
stream 

Byte 

STNPRD34INDEX Basetime 3 period 4 object index for the 
station 

Byte 

DESCSHORT Descriptor String 
* Fields used for field calibration 

E.2 Database Fields 
This section provides an alphabetic list of the database fields.   
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E.2.1 Alarm Text Tables  
Field  Description 
Text_1 Alarm text associated with bit 0 of the alarm object 
…  
Text_n Alarm text associated with bit n of the alarm object 

E.2.2 Batching/Totalisation   
For keypad integer array BATCH-TOT-CTL.  
Field  Description 
0 Stop  
1 Start  
2 Change  

E.2.3 DIGIO Setup Table  
Field  Description 
0 Sense normal 
1 Sense invert 
2 Sense pulse on 
3 Sense pulse off 

E.2.4 DP Stack Type  
Field  Description 
0 Single 
1 Lo hi 
2 Hi hi 
3 Lo mid hi 
4 Lo hi hi 
5 3 Identical  

E.2.5 DP Live/Check Mode Selection  
Field  Description 
0 Select live 
1 Select keypad 

E.2.6 DP Cut Off Mode  
Field  Description 
0 CATS (Common Area Transmission System). Totalisation does not 

occur when the measured DP is less than the defined LOLOLIM 
alarm limit 

1 Normal. Totalisation does not occur when the measured DP is less 
than the CUTOFF value 

E.2.7 Event History Type  
Field  Description 
0 Default type 
1 Double type 
2 Multi input type 
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Field  Description 
3 Multi output type 
4 Keypad int type 
5 Keypad int array type 
6 Security type 
7 Mode type 
8 Text 1 type 
9 Text 2 type 
10 Text 3 type 
11 Message 1 type 
12 Message 2 type 
13 Message 3 type 
14 Reject type 
15 Standard type 

E.2.8 HART Poll Format  
Field  Description 
0 HART poll format CIMAT 
1 HART poll format P188 

E.2.9 HART Master Mode  
Field  Description 
0 Hart primary master 
1 Hart secondary master 

E.2.10 I/O (P144) PID Type  
Field  Description 
0 Pulse 
1 DP stack  
2 Analog In 
3 PRT 
4 External pulse 
5 Download 
10 Pulse square root  
11 DP stack square root  
12 Analog In (square root)  
13 PRT square root  
14 External pulse square root  
15 Download square root  

E.2.11 Prover (P154) Dual Chronometry Switch Pair  
Field  Description 
0 Switch 0-1 
1 Switch 2-3 
2 Switch 0-3 
3 Switch 2-1 
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E.2.12 Prover (P154) Type  
Field  Description 
0 Ball/Bi-directional (BIDI) prover  
1 Uni-directional prover  
2 Compact prover 
3 Master meter prover  

E.2.13 Password Tables   
Object Descriptor Type 
DESC Descriptor String 
USERNAME Username String  
ALPHAPASSWORD Password String 
NUMBPASSWORD Password String 
SEDEV Security level 1 to 9; 1 being the highest 

with full read/write access to all 
parameters.  

String 

E.2.14 Truth Tables   
Field  Description 
Stext1 Text associated with the value field of a KPINT or the text 

associated the input field of a multi.  
Ctext1 Value associated with the output field of a multi.  
Sval1 Value enumeration associated with the text  
Alm_en1 Enables an alarm on digital I/O 
…  
Stext100 Text associated with the value field of a KPINT or the text 

associated the input field of a multi.  
Ctext100 Value associated with the output field of a multi.  
Sval100 Value enumeration associated with the text  
Alm_en100 Enables an alarm on digital I/O 

E.2.15 Turbine Meter Setup Tables   
Field  Description 
DESC Descriptor  
TYPE Type of pulse mode: Single or Dual  
Pulse 
Level 

Level at which the pulse is read: Level A or Level B 

E.3 Mode Tables 
This section provides an alphabetic list of the database fields you can 
access through the Report Editor.   

E.3.1 ADC/PRT/HART Modes (MODE TAB PLANTI/O)  
Number  Description 
0 Measured mode 
1 Keypad mode 
2 Average mode 
3 Last good mode 
4 Keypad fail mode 
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Number  Description 
5 Average fail mode 
6 Last good fail mode 
10 Weighted mode 
12 Weighted fail mode 

E.3.2 CALC/ALM Auto Switch Modes  
Number  Description 
0 CALC1 auto mode 
1 CALC2 auto mode 
2 CALC3 auto mode 
3 CALC4 auto mode 
4 Keypad auto mode 
5 CALC1 force mode 
6 CALC2 force mode 
7 CALC3 force mode 
8 CALC4 force mode 
9 Keypad force mode 
10 Keypad shift mode 

E.3.3 CALC/ALM modes (MODE TAB CALC)  
Number  Description 
0 CALC1 mode 
1 CALC2 mode 
2 CALC3 mode 
3 CALC4 mode 
4 Keypad mode 
5 Average mode 
6 Lastgood 
7 Keypad fail mode 
8 Average fall mode 
9 Lastgood fail mode 

E.3.4 Density Transducer Modes (MODE TAB DENS IP)  
Number  Description 
0 Keypad mode 
1 Dens A mode 
2 Dens B mode 
3 Average mode 
4 Keypad fail mode 
10 Weighted mode 
11 Weighted fail mode 

E.3.5 DP Modes (MODE TAB DP STACK)  
Number  Description 
0 Measured mode 
1 Keypad fail mode 
2 Check mode 
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E.3.6 HART Modes (MODE TAB PLANTI/O)  
Number  Description 
0 Measured mode 
1 Keypad mode 
2 Average mode 
3 Last good mode 
4 Keypad fail mode 
5 Average fail mode 
6 Last good fail mode 
11 Weighted mode 
12 Weighted fail mode 

 

 
 

 



Config600 Configuration Software User Manual 

E-24 Database Objects and Fields Revised January 2023 

 

 

 

 
 

 

 

 
 

 

 

 
 

 

 

 
 

[This page is intentionally left blank.] 

 
 



Config600 Configuration Software User Manual 

Revised January 2023 Peer-to-Peer Link Communications F-1 

Appendix F – Peer-to-Peer Link Communications  
In This Chapter 

F.1 Peer-to-Peer Link Input Functionality....................................... F-1 
F.2 Enabling the Peer-to-Peer Link............................................... F-3 

F.2.1 Configuring the Peer-to-Peer Link .................................. F-4 
F.3 Critical Data ........................................................................ F-9 

F.3.1 Passing an Object from the Duty to the  
Standby S600+ ..........................................................F-14 

F.3.2 Period Object Transfer ................................................F-16 
F.4 Automatic Failover ..............................................................F-17 

F.4.1 Configuring the S600+ for Automatic Failover .................F-19 
F.5 External / Custom Failover Modes .........................................F-25 
F.6 Displays.............................................................................F-26 

F.6.1 Control Displays.........................................................F-26 
F.6.2 Feed-back Displays ....................................................F-27 
F.6.3 Option Displays .........................................................F-28 

F.7 Downloading and Verifying the Peer to Peer Link .....................F-28 

The Peer-to-Peer facility enables you to connect two S600+ flow 
computers together in an application requiring dual-redundancy.  You 
can select one S600+ to be the main fiscal accounting device (the “duty 
machine”) and one S600+ to be the backup device (“standby 
machine”). The failover between duty and standby can be either 
automatic or manual. The Duty / Standby status (D=Duty, S=Standby) 
displays in the bottom right-hand corner of the S600+ front panel. 

This appendix describes the bi-directional communication link between 
the duty and standby computers that allows the duty S600+ computer to 
update the standby S600+ computer with any operator changes made 
locally at the duty S600+ keypad or via the supervisory.  

F.1 Peer-to-Peer Link Input Functionality 
Peer-to-peer link functionality includes:  

 Automatic real-time synchronization of constants (such as the 
keypad K-factor and the orifice diameter) that affect the integrity of 
the metering system.  

 A mechanism to pass operator commands (such as the Batch Start 
command) to the standby machine in real-time.   

 A mechanism to transfer a user defined list of data from the duty 
machine to the standby machine on a regular basis. 

The system uses three processes:  
Event Data  The duty machine uses the event log to identify changes that need 

transferring to the standby machine. When the duty identifies a change 
to a specific data point, the duty machine sends the value in the event 
log to the standby machine. 

Peer Critical 
 
 

 

The duty machine transfers a user defined block of objects to the 
standby machine as part of the main program cycle. It is possible to 
define separate source and destination objects for each data point. The 
critical data transfers as one coherent block at least once every 5 
seconds. 
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Notes:  
 When the S600+ becomes the duty machine, it only starts 

transferring critical data after the re-synchronisation process 
completes. 

 You can only configure the peer critical data via the System Editor, 
and the System Editor is only available after successful completion 
of the RA901 S600+ Advanced Training course.   

Re-sync at Start-up and 
Automatic Re-sync 

At start-up, the peer-to-peer link identifies a list of objects that you can 
change via the front panel / web server. The duty machine sends the 
latest values from this list to the standby machine. The standby 
machine compares the latest value from the duty machine and updates 
values that do not match. 

The automatic re-synchronisation process has two operational 
scenarios: 

 When the duty machine first establishes communications with the 
standby machine, the re-sync takes priority over events / critical 
data. In this situation, the re-synchronisation process may take 
approximately a minute to complete (depending on number of 
streams and such). 

 Once the peer-peer link is operational, the re-synchronisation 
operates in the background by interleaving messages with higher 
priority event log / peer critical data. In this situation, the re-
synchronisation process may take several minutes to complete. 
You enable this via the RESYNC BGRND option. If the RESYNC 
BGRND option is not enabled, then the re-synchronisation only 
occurs when the communications link is (re)-established. 

The automatic re-synchronisation list omits items in the filter list. Only 
constants transfer; commands do not. After all constants transfer, an 
optional “accept constants” command triggers. This causes the standby 
machine to trigger any density constants / keypad composition Accept 
commands.  

Eventing The standby machine has the option to event any changes it receives 
from the duty machine. Note that enabling this option will cause all 
changes to be evented. Therefore, it is recommended that it is not 
enabled if peer critical data is required. 

Changes via Modbus Changes made via Modbus only transfer to the standby machine if you 
enable Modbus eventing via the Modbus Editor. Eventing supports all 
registers. 

Filter List The peer-peer link filter identifies a list of changeable objects from the 
displays and determines whether they should be transferred based on 
their type and the Peer-to-Peer option selection. 

The following items are always excluded from transfer: 

 Cold Start / Warm Start / Backup 

 System / Stream Maintenance Mode and Maintenance Enable / 
Disable 

 Totals Reset 
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 PCSetup Link Enable / Disable 

 Front Panel Disable / Enable 

 Serial Port Settings 

 Download Time Command 
 Version information 

The following items are excluded unless selected in the Peer-to-Peer 
options (refer to Section F.2.1 Configuring the Peer-to-Peer Link for 
more details): 
 PID Commands 

 Valve Position 

 Station / Stream Batch Commands 

 Sampler Commands / Reset Can 
 Prove Commands 

 Flow Switching Commands 

 Peer to Peer Commands / Time Delay 

The following items are always transferred: 
 Keypad Values 

 Modes 

 High / Low Alarm limits 

 ADC / DAC Scalings 
 Proved Data 

 Valve Commands 

 Accept Commands (Density / Composition / KF/MF) – note that 
these commands are always transferred as part of the event data but 
only transferred during re-synchronisation if configured on the 
peer-to-peer options 

 Peer Critical Data 

F.2 Enabling the Peer-to-Peer Link 
You enable the peer-to-peer link with the default settings when you 
create a new configuration file. To enable a peer-to-peer 
communications port to configure peer-to-peer communications:  

1. Select Start > All Programs > Config600 3.3 > Config 
Generator or PCSetup and create a new configuration file.  

2. After you have set up the configuration file, select the Peer to Peer 
Link checkbox in Step 6, Comms Ports.  
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Figure F-1. Select Communications 

F.2.1 Configuring the Peer-to-Peer Link 
To configure the peer-to- peer link in PCSetup:  

1. Select I/O Setup > Comms from the hierarchy menu. The system 
displays the Communication Task configuration screen. 
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Figure F-2. Comms Link with Peer Master Link and Port Settings 

2. Select PEER MASTER LINK in the Comms Links field. 

3. Select the communication Port from the drop-down list box and 
click Setup. A port com setup dialog box displays.  

  

Figure F-3. Port Com Setup Dialog 
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4. Complete the following fields.  
Field  Description 
Baud Rate Indicates the serial transfer rate. Click ▼ to display all 

values. The default value is 9600.  
Data Bits Indicates the number of data bits the port uses. Click ▼ 

to display all values. The default value is 8.  
Stop Bits Indicates the period length. Click ▼ to display all 

values. The default value is 1.  
Parity Indicates the type of parity used to detect data 

corruption during transmission. Click ▼ to display all 
values. The default value is None.  

Hardware 
Handshake 

Sets RTS/CTS handshaking. When you select this 
check box, the Ready to Send (RTS) line fluctuates 
between on and off.   

 RTS On Delay Sets, in milliseconds, the amount of 
time Config600 waits after turning on 
the ready to send (RTS) signal 
before beginning transmission. The 
default is 0. You can change this 
value to optimise communications.  
The default value should be sufficient 
for dial-up modems and EIA-232 (RS-
232) connections. For older radios, 
you may need to set this value to 0.2 
seconds. For newer radios, 0.02 
seconds should be sufficient. 

 RTS Off Delay Sets, in milliseconds, the amount of 
time Config600 waits after 
transmitting a message before 
turning off the ready to send (RTS) 
signal. The default is 0. You can 
change this value to optimise 
communications.  
The default value should be 
suf ficient for dial-up modems and 
EIA-232 (RS-232) connections. For 
radios, a value of 0.01 may be 
appropriate. 
Note:  These variables may change 

based on your situation. 
These are general values 
that you need to assess for 
each circumstance. 

 
5. Click OK. The Peer to Peer PCSetup screen displays.  

6. Click Setup Peer to Peer Options. The Peer Params Setup screen 
displays.  
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Figure F-4. Peer Params Setup screen 

7. Select the appropriate parameters for your peer to peer 
communications.  
Field  Description 
COMMS 
ENABLE 

Enables the peer-to-peer communications link.  

CMD BATCH Synchonises batching-related commands  
If  selected, data items transferred are: 
Station Batch Command 
Stream Batch Command 

CMD SAMP Synchronises sampling-related commands. 
If  selected, data items transferred are: 
Sampler Command 
Reset Can Command 
Note: 
 If  checked then the command to start sampling is 

passed to the Standby machine.  
 If  there is only 1 sampler configured this means 

that both duty and standby will issue grab 
commands unless there is a hardware interlock in 
place to stop this. 

CMD 
PROVER 

Synchronises proving-related commands. 
If  selected, data items transferred are: 
Prove Sequence Command 
Run Command (Bi-Di / Cprv / MM) 
Meter Variables (Bi-Di / Cprv / MM) 

CMD PID Synchronises PID-related commands. 
If  selected, data items transferred are: 
Auto-Manual Command 
Direction Command 
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Field  Description 
Tracking Command  
Manual Position 
Setpoint 

CMD VALVE Synchronises valve-related commands. 
If  selected, data items transferred are: 
Valve Position 

CMD FSW Synchronises flow switching-related commands. 
If  selected, data items transferred are: 
Station Flow Switching Command 
Stream Flow Switching Command 

KP 
DOWNLOAD 

Sets an older peer-to-peer communications protocol.  
Note: Do not enable this command.  

RESYNC 
BGRND 

Perform auto synchronisation in background. Enables 
auto-resychronisation of constants (not command) as 
part of the regular duty cycle. If  box un-ticked, re-
synchronisation only occurs when the communications 
are (re)-established between the duty and standby 
machines. 

ACC Re-synchronisation only. Trigger automatic acceptance 
of  density constants, keypad composition, KF and MF. 
This over-rides ACC DENS, ACC CHROMAT and ACC 
KF/MF. If un-ticked no automatic acceptance occurs. 

ACC DENS Re-synchronisation only. Trigger automatic acceptance 
of  density constants during re-synchronisation. If un-
ticked no automatic acceptance occurs. 

ACC 
CHROMAT 

Re-synchronisation only. Trigger automatic acceptance 
of  keypad chromatograph during re-synchronisation. If 
un-ticked no automatic acceptance occurs. 

ACC KF/MF Re-synchronisation only. Trigger automatic acceptance 
of  KF and MF during re-synchronisation. If un-ticked no 
automatic acceptance occurs. 

CRITICAL Critical data transfer enabled – allows transfer of data 
that is not user enterable (such as FCV Output % to 
allow bumpless transfer on changeover). Can also be 
used to exclude items from transfer using the Peer 
Regular calculation table by configuring the required 
data item as an input only. 

I AM A Alters the timeout period before designating the 
standby machine to be duty. If  ticked the timeout is 10 
seconds otherwise it is 20 seconds. 

EVENTING Enables the eventing of changes of the standby event. 
Note: This can cause the standby event log to fill up if 

used in conjunction with the Peer Critical option. 
EXCLUDE Not currently supported. Do not enable this command. 
DISABLE 
DISPLAY 

Prevents the operator from making changes on the 
standby machineby disabling the front panel and 
webserver. 

Peer Method Indicates how failover from duty machine to standby 
machine occurs. Click ▼ to display all valid values. 

 Auto 
Failover 

Sets the duty machine via an internal 
algorithm. This is the default.  

 Manual 
Failover 

Sets the duty machine manually 
through the front panel or webserver. 

 Digital Input Sets the duty machine using digital 
inputs. 

 Custom Sets the duty machine using a LogiCalc 
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Field  Description 
to create the failover logic. 

 
8. Click OK. The PCSetup screen displays.  

9. Click the Save icon on the toolbar to save the changes to the 
configuration.   

F.3 Critical Data 
You can use the peer-to-peer link to update the standby S600+ with 
critical data that is not operator-enterable, such as:  
 FCV output % to allow bumpless transfer if a changeover occurs. 
 Prover results (such as meter factor or proved conditions). 
 Items specific to individual flow computers; such as ADC 

calibration points.  
Certain data points you must frequently send to the standby 
machine (such as the position of a PID required for smoother 
transaction from manual to automatic mode) or information you 
need to send selectively (such as the ADC Scales, although you 
may need to send other ADC parameters [like keypad values or 
modes] separately). If sending data (such as the position of the 
PID) then it is recommended that EVENTING is disabled on the 
standby machine.  

Note: Totals and time are not supported.    

To send critical data: 

1. Click Start > All Programs > Config600 3.3 > System Editor 
and open the configuration.  

2. Select System > ALARM. The Alarm screen displays.  

3. Create a new alarm object by scrolling down to the last alarm and 
right-clicking in the right frame. A pop-up menu displays.  
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Figure F-5. Pop-up menu on Alarms screen 

4. Select Append to create a new alarm object. An Edit dialog box 
displays.  

5. Select DESC in the Columns pane and enter PEER CRITICAL in 
the Data field.  

  

Figure F-6. Edit dialog (1)  

6. Select Columns > DESC and enter PEER CRITICAL in the Data 
field. 
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7. Select Columns > tab_almtxt_id* and enter 23 in the Data field to 
select the ATXT TAB CALCS. 

 

Figure F-7. Edit dialog (2)  

8. Click OK. The Alarm screen displays. The new alarm object Peer 
Critical appears at the bottom of the screen’s listing.  

 

Figure F-8. Peer Critical Alarm  

9. Select System > CALCTAB to create a new calculations table.The 
CALCTAB screen displays.  
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Figure F-9. CALCTAB screen 

10. Scroll down to the last calculation and right-click in the right 
frame. An Edit dialog box displays  

11. Select Append to create a new calculation object.  
12. Select DESC in the Columns pane and enter SYS PEER 

CRITICAL in the Data field. 

  

Figure F-10. Edit dialog (1) 

13. Select Columns > obj_almitem_id* in the Columns pane and 
select the PEER CRITICAL alarm you previously created. 
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Figure F-11. Edit dialog (2) 

14. Select TYPE* in the Columns pane and enter 621 to display the 
Peer Regular Data point. 

  

Figure F-12. Edit dialog (3) 

15. Click OK. The CALCTAB screen displays. Note the new 
calculation object SYS PEER CRITICAL in the System > 
Calculation list. 
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Figure F-13. Peer Critical CALCTAB Object 

F.3.1 Passing an Object from the Duty to the Standby S600+ 
This example shows how to pass a user-chosen object from the duty 
S600+ to the standby S600+.  

Note: Each computer derives its own totals independently. Copying 
totals from one computer to the other could result in copying 
erroneous data if the totals someone get corrupted.   

1. Double click on the SYS PEER CRITICAL calc table you created 
in the Critical Data section. The Calc Editor opens.  

2. Click  to view the Outputs. 

3. Click  on the right side. A new output should appear in the 
Outputs group with default data.  

  

Figure F-14. Calc Editor Outputs 

4. Click the numbered button on the left side of the newly created 
output. The Connect Wizard displays.  

5. Select System > KPINT > SYSTEM RUN MODE > VALUE. 
This is the location on the duty S600+ that transfers to the standby 
S600+.  
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Note: The selected field– and other similar fields – is only an 
example to illustrate this process.   

 

Figure F-15. Connect Wizard – Assigning an object to an output of the SYS PEER CRITICAL 
Calctab  

6. Click OK to confirm the changes and close the Connect Wizard.  

  

Figure F-16. New Output with Object Assigned  

7. Click  to view the Inputs. 

8. Click  on the right side. A new input should appear in the 
Inputs group with default data. 

9. Click on the numbered button on the left side of the newly created 
input. The Connect Wizard displays. 
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Figure F-17. Connect Wizard – Assigning an object to an input of the SYS PEER CRITICAL calctab  

10. Select System > KPINTARR > PEER SPARE 1 > FIELD 01. 
This is the location on the standby S600+ to which data from the 
Output field transfers.  

11. Click OK to confirm the changes and OK on the Calc Editor to 
confirm and close it. 

12. Open the configuration file in PCSetup and enable the CRITICAL 
peer parameter as in Configuring the Peer to Peer Link. 

13. Add the newly created output to the S600+ displays using the 
Display Editor to see the values being transferred over the peer to 
peer communications link. 

14. Save the configuration file and upload it to both S600+ machines. 

15. Configure one machine as the duty machine and the other as the 
standby machine (as described in PCSetup Editor). 

16. On the Standby S600+ front panel/webserver, navigate to the 
location where you created the new display and the object displays 
with the current second number from the duty S600+. 

F.3.2 Period Object Transfer 
You can configure the system to send objects at specific time intervals, 
in order not to overload the peer to peer link with data that is not of 
very high importance. Use the System Editor to set these time 
intervals:  

1. Click Start > All Programs > Config600 3.3 > System Editor 
and open the configuration 

2. Select the section where the calculation table of type Peer Regular 
you wish to edit the timing is stored. For example, select Stream x 
> CALCTAB and double-click the calculation table STR0X 
PEER PID to open the Calc Editor 
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Figure F-18. System Editor 

3. Click  to view the Outputs of the calculation table 

4. Change the bit number of the output to the desired time interval (in 
seconds) you want the system to use when sending that object 
through the peer to peer link. The default value is 30, which 
corresponds to 30 seconds 

5. Click OK to confirm the changes in the Calc Editor 

6. Save the configuration file. 

F.4 Automatic Failover 
Both the duty S600+ and standby S600+ use digital (status) inputs and 
outputs in the automatic selection process, as shown in Figure F-19. In 
the event of any computer alarm (i.e. any alarm assigned to alarm 
group 1), except for those in the following table, the health input-
output link changes logic state to invoke a failover. On completion of 
the failover, the standby S600+ becomes the duty S600+. 

Note: If you have configured the automatic failover option and it is 
invoked during a prove, the system transfers the values and 
control, but the prove run may fail during changeover 
depending on the prove stage.     

  
Table F-1. Computer Alarms Not Invoking a Failover 

ALARM TYPE ALARM ALARM GROUP 

SYS HOST 

COLD ST 

ALM GRP 1 COMP 

WARM ST 

BATT FAIL 

RESET 

TOT RESET 

TOT ROLL OVR 

TOT ROLL UDR 

PRINTING ERR 
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Figure F-19. Status Input and Output Description  

Figure F-19 shows two computers designated as A and B. In the event 
that computer A fails, computer B takes over the duty role (if computer 
B is itself healthy). Following the changeover from A to B, computer B 
remains the duty machine until computer A again becomes healthy and 
is manually reinstated as the duty machine or until computer B fails. If 
computer B fails and computer A is healthy, then A automatically 
becomes the duty machine. 

Table F-2. Status Input and Output Description 

Input/Output 
Designation  Description 
A Health Indicates the health status for computer A. It is true as long as there are not 

any group 1 alarms set (apart from those indicated in Table F-1). This signal 
is continuously monitored by computer B. If the signal goes down, computer 
B requests to become the duty machine via the I Want Duty output. 

B Health Indicates the health status for computer B. It is true as long as there are not 
any group 1 alarms set (apart from those indicated in Table F-1). This signal 
is continuously monitored by computer A. If this signal goes down, computer 
A requests to become the duty machine via the I Want Duty output. 
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Input/Output 
Designation  Description 

I Am Duty Designates which computer is the duty machine. When it is set high, the 
computer is the duty machine. When set low, the computer is the standby 
machine. This signal goes high after a Duty request has been made if the 
relay is working properly 

I Want Duty Whenever a computer needs to become the duty machine, it asserts this 
signal to make the relay switch and set “I Am Duty” high. The signal is 
asserted only for a period of time that you configure in the PCSetup Editor. 

Peer to Peer 
Comms 

A bi-directional communication link between the A and B computers allows 
the duty S600+ to update the standby S600+ with any operator changes 
made locally at the duty S600+ keypad. The Duty/Standby status displays in 
the bottom right hand corner of the S600+ display (D=Duty and S=Standby). 
This link also updates all settings and values within the Standby computer 
following a communications failure of the peer to peer link, such as following 
computer replacement. 

Process 
Inputs (Field 
I/Ps) 

All f ield inputs connect in parallel to both S600+ computers allowing each to 
perform independent processing and totalisation. Discrepancy checking 
between data reported from the A and B computers is performed elsewhere, 
such as at a supervisory computer. 
Note: If  you power down one S600+ in an Active Duty-Standby 

conf iguration, we recommend either disconnecting socket A (SKT-A) 
f rom the I/O module(s) of the offline unit or using external signal 
isolators when wiring analog inputs. 

Control 
Outputs 
(Field O/Ps) 

All control outputs switch via changeover relay contacts so that only the 
computer with Duty status has actual control of plant equipment. 
Note:  Control Outputs are only used in particular applications (for example, 

when the 600+ sends a DAC signal to an FCV. 
 

F.4.1 Configuring the S600+ for Automatic Failover 
This section shows the necessary steps to configure the flow computers 
to perform Duty/Standby automatic failovers. 

  

Figure F-20. Duty/Standby Connection Diagram  

Step 1: 
Wiring Digital Channels  

Connect Duty/Standby wiring. The following example uses Digital 
Output Channel 4 (SKT C: Pin 36) and Return CH1-4 (SKT C: Pin 35) 
to drive the relay by asserting the ‘I Want Duty’ signal. Digital Input 
Channel 1 (SKT B: Pin 13) and Return CH1-4 (SKT B: Pin 17) are 
used to read the state of the relay which is the ‘I Am Duty’ signal as in 
the previous figure. The channels used in the example were chosen 
arbitrarily. 
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The relay must be a latching double pole double throw (DPDT) relay 
for the Duty/Standby logic to work. 
Each computer requires a pair of digital channels to connect the health 
output of one computer to the health input of the other computer. The 
following example shows how to connect A’s health digital output to 
B’s digital input. The same must be done for computer B. 

  

Figure F-21. Connecting A’s Health Digital Output to B’s Digital Input  

Step 2: 
PCSetup  

After you complete the first step, assign all the digital channels from 
the previous step to database objects. From PCSetup: 

1. Select the I/O Setup > Discrete Inputs to channels. The SYS 
PEER HEALTH and SYS PEER DUTY IO items are currently 
unassigned.  

Refer to Table F-2 and Figure F-19 where: 
HEALTH DO = SYS PEER HEALTH output 
HEALTH DI = SYS PEER HEALTH input (reported from the 
other computer) 
I WANT DUTY DO = SYS PEER DUTY IO output 
I AM DUTY DI = SYS PEER DUTY IO input (the duty / standby 
status from the relay) 

 

Figure F-22. List of Discrete Inputs before Assignment  
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2. Double-click SYS PEER HEALTH and assign it to Channel 15 
of the P144 I/O Board. 

 

Figure F-23. Digital Input Selection  

3. Click OK.  
4. Double-click SYS PEER DUTY IO, assign it to Channel 12 of 

the P144 I/O Board, and click OK.  

 

Figure F-24. SYS PEER HEALTH and PEER HEALTH Object (after assignment to Digital Inputs)  

5. Select the I/O Setup > Discrete Outputs to channels. 

 

Figure F-25. List of Discrete Outputs before Assignment  
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Note: The SYS PEER DUTY IO output signal is asserted whenever 
the owning computer requests duty.   

6. Double-click Channel 3 and select SYS PEER DUTY IO.  

 

Figure F-26. SYS PEER DUTY IO Digital Output Assignment  

7. Select PULSE ON in the Sense field.  
8. Set Pulse Width to indicate the number of seconds the SYS PEER 

DUTY IO signal asserts after receiving a Duty request. The 
minimum is 5 seconds. If this period of time elapses and the 
computer has not become the duty machine, the SYS PEER A 
FAILED alarm triggers.   

9. Double-click Channel 4 and select SYS PEER HEALTH. This is 
the computer’s own health output signal and it is also read by the 
partner computer.  

  

Figure F-27. SYS PEER HEALTH Digital Output Assignment  

10. Click OK.  



Config600 Configuration Software User Manual 

Revised January 2023 Peer-to-Peer Link Communications F-23 

 

Figure F-28. Channel 3 and Channel 4 (after assignment to SYS PEER DUTY IO and SYS PEER 
HEALTH  

Step 3: 
Activating Automatic 

Failover  

You can activate the Duty/Standby automatic failover logic in either of 
two ways: through PCSetup or through the front panel or webserver.  

Using 
 PCSetup 

You can activate the Duty/Standby automatic failover logic in either of 
two ways: through PCSetup or through the front panel or webserver.  
From PCSetup: 

1. Select I/O Setup > Comms. The Comms Link screen displays.  

 

Figure F-29. PCSetup Communications  

2. Click Setup Peer to Peer Options. The Peer Params Setup screen 
displays.  
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Figure F-30. Peer Params Setup dialog  

3. Select Auto Failover from the Peer Method field and click OK. 
Using 

Front Panel/Webserver 
From the front panel and the webserver: 

1. Select TECH/ENGINEER > COMMUNICATIONS > 
ASSIGNMENT > PEER MASTER LINK. The Peer Duty Logic 
page displays.  

PEER DUTY LOGIC 
Status: 
AUTO FAILOVER 
  
P121.2  of  16 

Figure F-31. Peer Duty Logic page 

2. Select AUTO FAILOVER on the PEER DUTY LOGIC page. 
This activates the internal HOT BACKUP logic. 

 

Triggering Duty Status The following situations trigger duty status in a computer: 
 If one of a pair of computers starts first and is healthy, it becomes 

the duty machine when it sees its partner as “unhealthy” (that is, 
turned off). 

 If one of the computers has its alarms cleared first while the other 
one is still unhealthy, then the first computer becomes the duty 
machine.  

 If the computers start exactly at the same time, the one to which the 
relay points at start-up becomes the duty machine, if it is healthy.  

 If the computers’ alarms are cleared exactly at the same time, the 
one to which the relay points becomes the duty machine.  

 If the duty computer becomes unhealthy, it forces the standby 
computer to become the duty computer, if that machine is healthy.  
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 If one of the computers is standby and healthy, you can set it to 
duty status by requesting duty status through the Duty/Standby 
menus.  

 Care should be taken when triggering duty status manually – refer 
to Section F.5 below.   

F.5 External / Custom Failover Modes 
The S600+ provides three additional modes for setting the 
duty/standby computer. These modes determine the duty S600+ using 
an external logic, as opposed to the AUTOMATIC FAILOVER 
method described in the previous sections, (which sets the duty 
machine using an internal algorithm).  

 MANUAL FAILOVER 
You manually determine which computer is duty and which is 
standby by using the front panel or the webserver application. 
There is no automatic failover. To set the duty S600+, select 
TECH/ENGINEER > COMMUNICATIONS > ASSIGNMENT 
> PEER MASTER LINK from the front panel and set the status 
to DUTY on the Peer Status page or select Standby to set it to 
standby status.  

 OPERATOR 
COMMAND 

   
 Status 

CLEAR 
   

Figure F-32. Peer Master Link Operator Command Page 

Notes: 
  The order in which you perform a manual hand-over is 

important. First, set the actual duty computer to standby mode. 
Second, set the other computer to duty mode. If the machine is 
not healthy, the system ignores this command. 

  You should not perform a manual hand-over when the flow 
computer is proving, batching or sampling. If you need to 
perform a manual hand-over during one of these processes, 
you should first abort the process, then perform the manual 
hand-over, and then restart the process.  

 DIGITAL INPUT 
This method enables digital inputs to decide the duty or standby 
status of an S600+. You must connect each input to SYS PEER 
DUTY IO in PCSetup for each computer as described in the 
previous sections.  

 CUSTOM  
This mode uses a LogiCalc to create a failover logic. 
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You can access all three modes through PCSetup, the front panel, or 
the webserver. For example, this procedure uses PCSetup:  
1. Select I/O Setup > Comms from the hierarchy menu. 

2. Select Peer Master Link in the Comms Links field.  

3. Click Setup Peer to Peer Options. The Peer Params Setup screen 
displays.  

  

Figure F-33. Peer Params Setup  

4. Select Peer Method and click OK.  

5. Click OK.  

F.6 Displays 
Select TECH/ENGINEER > COMMUNICATIONS > 
ASSIGNMENT > PEER MASTER LINK to view the status or 
control the Duty/Standby logic. The displays are split in two 
categories: control and feed-back. You can use the control displays to 
configure the way the Duty/Standby logic works. The feed-back 
displays provide useful information about the status of the two 
computers in the context of the Duty/Standby logic.  

F.6.1 Control Displays 
Use the PEER DUTY LOGIC display to select the method the 
Duty/Standby logic uses. You can select AUTO FAILOVER, 
MANUAL FAILOVER, DIGITAL INPUT, and USER. 
PEER DUTY LOGIC 
Status: 
AUTO FAILOVER 
  
P121.2  of  16 
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Use the PEER STATUS page to select the status of the peer to peer 
communications link when the PEER DUTY LOGIC is set to either 
MANUAL FAILOVER or CUSTOM. Otherwise, it only indicates the 
status of the peer to peer communications link. The available options 
are DUTY and STANDBY. 
PEER STATUS 
Status: 
DUTY 
  
P121.3  of  16 

 
Use the OPERATOR COMMAND to issue a ‘Duty’ request to the 
relay. The command can only be SET manually by you. It 
automatically reverts to CLEAR. 
OPERATOR COMMAND 
Status: 
CLEAR 
  
P121.4  of  16 

 
F.6.2 Feed-back Displays 

The I AM DUTY page shows the status of the digital input line 
connected to the SYS PEER DUTY IO object. When the indicated 
value is 0, the computer status as given by the relay is STANDBY. 
When the value is 1, the computer status is DUTY. 
I AM DUTY 
Status: 
0 
  
P121.5  of 16 

 
The MY HEALTH page shows the status of the digital output line 
connected to the SYS PEER HEALTH object. It indicates the health of 
the computer that owns the page. If 0, an alarm that is not in the 
Automatic Failover table triggers and the computer is considered 
unhealthy. It can only be STANDBY. If 1, the computer is considered 
healthy and can be either DUTY or STANDBY. This status is also 
seen by the other peer and based on it, the computer can decide to be 
either DUTY or STANDBY. This status is mirrored on the PEER 
HEALTH page of the peer. 
MY HEALTH 
Status: 
0 
  
P121.6  of 16 

The PARTNER HEALTH page shows the status of the digital input 
line connected to the SYS PEER HEALTH object. It indicates the 
health of the peer. If 0, an alarm that is not in the Automatic Failover 
table triggers and the peer is considered unhealthy. It can only be 
STANDBY. If 1, the peer is considered healthy and can be both DUTY 
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and STANDBY. This status is mirrored on the MY HEALTH page of 
the peer. 
PARTNER HEALTH 
Status: 
0 
  
P121.7  of 16 

F.6.3 Option Displays 
All of the Peer-to-Peer options listed in section F.2.1 are available 
under the TECH/ENGINEER > COMMUNICATIONS > 
ASSIGNMENT > PEER MASTER LINK display – following on 
from the partner health display. These can be used to enable / disable 
peer-to-peer options during run time.  

F.7 Downloading and Verifying the Peer to Peer Link 
To download and verify the peer to peer link:  

1. Click Start > All Programs > Config600 3.3 > Config Transfer.  

2. Configure Config Transfer communications. Refer to Config 
Transfer.  

3. Select the Send tab.   

4. Select a configuration that has Peer to Peer Option enabled and 
click Send.  

5. Connect the two S600+ flow computers using a communications 
cable directly between the two devices.    

6. Download the file to both S600+ flow computers.  
7. Cold Start both S600+ flow computers.  

8. Configure the Duty S600+ from the front panel. Select 
TECH/ENGINEER > COMMUNICATIONS > ASSIGNMENT 
> PEER MASTER LINK and on the PEER DUTY LOGIC 
page, set the Status to MANUAL FAILOVER.   

9. Navigate to the PEER STATUS page and set the Status to DUTY.  
10. Configure the Standby S600+ from the front panel. Select 

TECH/ENGINEER > COMMUNICATIONS > ASSIGNMENT 
> PEER MASTER LINK and on the PEER DUTY LOGIC 
page, set the Status to MANUAL FAILOVER.  

11. Navigate to the PEER STATUS page and set the Status to 
STANDBY.    

Note: On startup, both S600+ flow computers are in Standby 
mode and display an "S" at the bottom of the display in the 
Communications display. A "D" should display after you 
configure one of the S600+ and if the communication is 
working.  
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12. On both machines, navigate to TECH/ENGINEER > 
COMMUNICATIONS > SERIAL PORTS and select the Peer 
to Peer Link Port to use. Verify on the second page that the 
GOOD TX and GOOD RX are increasing. This indicates the 
machines are communicating. 
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Appendix G – Firewall  
In This Chapter 

G.1 Rules File ............................................................................. G-1 
G.1.1 *Filter Keyword .......................................................... G-2 
G.1.2 Default Policies .......................................................... G-2 
G.1.3 User Defined Chains ................................................... G-2 

G.2 Adding Rules to the Chain ....................................................... G-3 
G.2.1 Applying a Rule to a Range of IPs................................. G-3 
G.2.2 Inverting a Rule.......................................................... G-3 
G.2.3 After Checking the Rules ............................................. G-3 
G.2.4 Committing the Rules .................................................. G-3 

G.3 Operational Behaviour ............................................................ G-3 
 
The S600+ firewall keeps out unwanted incoming network 
connections. At its core, the S600+ uses the Linux’s Iptables firewall. 
You can configure the IP firewall rules in a text file specifying which 
connections are to be accepted and which to be rejected.  

This appendix details only the firewall rules for blocking and accepting 
packets to and from a source. There are many other rules that you can 
specify. Refer to the Linux Iptables Firewall documentation before 
making any changes to the configuration text file.  

G.1 Rules File  
The configuration file is a plain text file containing the rules by which 
iptables controls network traffic. You can edit or change the rules 
using a text editor. Place the file that contains the rules in the “Extras” 
folder of an S600+ standard configuration. The file name is 
exfwall.txt. The file loads to the S600+ at the same time as the 
configuration file. The syntax of the rules must be compatible with the 
one that iptable accepts as valid.   
Following is an example exfwall.txt file.  

 
#Example of a exfwall.txt file 
*filter 
:INPUT DROP [0:0] 
:FORWARD ACCEPT [0:0] 
:OUTPUT DROP [0:0] 
:ALLOW_IN - [0:0] 
:ALLOW_OUT - [0:0] 
-A INPUT -j ALLOW_IN 
-A OUTPUT -j ALLOW_OUT 
#ALLOW IN 
#Allow telnet 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 23 -j ACCEPT 
#End of Allow telnet 
#Allow Apache 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 80 -j ACCEPT 
#End Allow Apache 
#Allow Apache Secure 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 443 -j ACCEPT 
#End of Allow Apache Secure 
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#Allow PC Setup 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 6000 -j ACCEPT 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 6001 -j ACCEPT 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 6002 -j ACCEPT 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 6010 -j ACCEPT 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 6011 -j ACCEPT 
-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 6012 -j ACCEPT 
#End of Allow PC Setup 
-A ALLOW_IN -j RETURN 
#END ALLOW IN 
#ALLOW OUT 
-A ALLOW_OUT -d 10.97.41.72 -p tcp -j ACCEPT 
-A ALLOW_OUT -j RETURN 
#END ALLOW OUT 
COMMIT 
#End of the exfwall.txt file 

G.1.1 *Filter Keyword 
The *filter keyword tells the iptables that the following rules are for 
the filtering table. Within each table, there are chains of specifications 
and rules.  

G.1.2 Default Policies 
The next three lines in the example file:  

:INPUT DROP [0:0] 
:FORWARD ACCEPT [0:0] 
:OUTPUT DROP [0:0] 

 
define the default policies of the main firewall chains. A chain is a set 
of rules a data packet must go through. The INPUT chain policy 
(DROP) applies to all incoming packets, the OUTPUT chain policy 
(DROP) applies to all outgoing packets and the FORWARD chain 
policy (ACCEPT is for all packets that go through this machine but are 
not destined for it. A package that is inbound to the INPUT chain is 
DROPped (rejected) unless another rule down the chain lets the packet 
pass through. The square brackets indicate the packet and byte 
counters. These lines should be left as they are. 

G.1.3 User Defined Chains 
The next two lines in the example:  

:ALLOW_IN - [0:0] 
:ALLOW_OUT - [0:0] 

 
are user defined chains for the use of clarity; you can call them 
anything. Both chains contain proprietary rules for the packets that go 
through. 

The next two lines: 
-A INPUT -j ALLOW_IN 
-A OUTPUT -j ALLOW_OUT 
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add the user defined chains to the already existing default chains. A 
packet that goes through the INPUT chain also goes through (-jump) 
the ALLOW_IN chain. 

G.2 Adding Rules to the Chain 
The following lines define the rules that make up the chains.  

-A ALLOW_IN -s 10.97.41.72 -p tcp -m tcp --dport 23 -j ACCEPT 

 
This line tells iptables to add (-A) a new rule to the ALLOW_IN chain 
which catches all packets that have as source (-source) the given IP, as 
protocol (-protocol) TCP and as port (-dport) 23 and to accept them. 

G.2.1 Applying a Rule to a Range of IPs 
To apply a rule to a range of IPs:  

-A ALLOW_IN –p tcp –m iprange --src-range 192.168.1.13-192.168.2.19 –j 
ACCEPT 

G.2.2 Inverting a Rule 
To invert the rule, add an “!”. 

-A ALLOW_IN –p tcp –m iprange ! --src-range 192.168.1.13-192.168.2.19 –j 
ACCEPT 

G.2.3 After Checking the Rules 
The line:  

-A ALLOW_IN -j RETURN 

 
adds a rule that tells iptables what to do after checking all the rules 
defined above for this chain. It returns to the parent chain, in this case 
INPUT. 

G.2.4 Committing the Rules 
The COMMIT keyword tells iptables to commit all the rules specified 
above it to the kernel.  

G.3 Operational Behaviour  
 The S600+ firewall is off (all connections allowed regardless of the 

rules in the exfwall.txt file) when the S600+ is in the Cold Start 
menu. 

 The S600+ firewall is on (connections filter according to the rules 
file) as soon as you leave the Cold Start menu and the unit starts 
metering.  
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Appendix H – CFX Reporting 
In This Chapter 

H.1 Adding CFX Report Functionality to a Configuration File................H-1 
H.2 Enabling CFX at the Stream Level .............................................H-3 
H.3 Changing CFX Settings f rom Config600......................................H-4 
H.4 Regenerating the CFX Report Template .....................................H-5 
H.5 Generating a CFX Report f rom the Web Browser .........................H-5 
H.6 Understanding the CFX File Structure.........................................H-8 
 
 
This appendix describes how to configure and produce reports that use 
the Common File eXchange (CFX) file format from Flow-Cal, Inc.  

Licences This feature requires that you have a license on your S600+. Without a 
license, you cannot generate CFX files. Contact Technical Support for 
further information on purchasing a license key and activating CFX 
functionality.   

Notes: 

 If you need the capability to extract reports for Flow-Cal server 
access, contact Technical Support. 

 When you generate CFX report files from an S600+, ensure that 
the S600+ supports no more than eight (8) meter runs. Do not 
create a 9- or 10-meter run application that also creates CFX files.  

H.1 Adding CFX Report Functionality to a Configuration File  
To add CFX reports to your configuration:  
1. Open the Config Generator.  

2. Follow the usual steps to add I/O modules and stations.  

Note: When you choose a meter type, note that the system 
supports CFX only for ultrasonic gas meters and for 
ultrasonic, turbine, and Coriolis liquid meters.   

3. At the Streams configuration screen, press Options.  

• For a liquid stream, the following window displays:  
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Choose the appropriate option. The CFX option you select must 
match the density option. In the example above, Option2 has 
been selected for density, so you must select CFX Option 2 to 
enable CFX reports on this stream.  

• For a gas stream, the following window displays:  

 
Choose the appropriate option. Choose CFX to enable CFX 
reports on this stream.   

4. Complete the process of generating the configuration.  
 



Config600 Configuration Software User Manual 

Revised January 2023 CFX Reporting H-3 

H.2 Enabling CFX at the Stream Level   
To enable CFX at the stream level:   

1. Open the generated configuration in PCSetup. In the left pane, 
select Reports under System Setup. Using the Base Time 
Reports frame, select the period for the CFX report.   

 
2. Click Add or Configure. The Archive Configuration dialog 

displays, showing a list of available streams with CFX file 
capabilities.  

 
3. Select the appropriate checkboxes to enable or disable CFX 

generation for a specific stream.  
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Note: The dialog also displays standard S600+ period reports for 
the selected period. The Number of reports to save field 
refers to both standard S600+ reports and CFX reports. If 
you select 48, the program generates a total of 48 reports 
(standard reports and CFX reports). Once the system saves 
this number of reports, it overwrites older reports. Plan the 
number of reports you want to save accordingly.  

At any time you can edit or delete the CFX reports in your 
configuration file. Click Configure on the System Setup screen to 
display the Archive Configuration dialog. If you delete a report period 
from the configuration file, you also delete any reports (both standard 
S600+ and CFX) for that period.   

H.3 Changing CFX Settings from Config600   
Using a Config600 menu, you can change some of the data the system 
exports to a CFX report. This menu is available for each stream you 
defined to generate the CFX report (that is, you selected the CFX 
option for that stream in the Config Generator, discussed in Adding 
CFX Report Functionality to a Configuration File).  
The following example shows the CFX menu for stream 1, which is a 
liquid turbine stream:  

 
When you select CFX, the system displays the CFX Settings screen, 
which you use to change the following parameters:  
Field  Description 
Description Provides a description (with a maximum of 77 

alphanumeric characters) of the CFX report.  
Meter Name Indicates the meter generating the CFX report.  
Altitude Indicates the altitude of the meter generating the 

CFX report.  
Latitude Indicates the latitude of the meter generating the 

CFX report.  
Meter Serial Number Indicates the serial number of the meter generating 

the CFX report.  
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H.4 Regenerating the CFX Report Template   
Each time you change the CFX calculation tables (by removing, 
adding, or changing objects or object types), you must regenerate the 
CFX template files. After you finish editing the configuration file 
(using either System Editor or PCSetup), you should regenerate the 
CFX report file template.  

To regenerate the CFX reports:  

1. Open the configuration file (using either PCSetup or the System 
Editor).  

2. Select File > Regenerate. The system displays the Display and 
Modbus Regeneration dialog.  

 
3. Select the CFX Reports checkbox.  

4.  Click OK.  

H.5 Generating a CFX Report from the Web Browser  
To generate a CFX report from the web browser:  
1. Start a new browser session and select the Reports options.  
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2. Select the CFX option. The CFX control page displays, showing 

the available controls for any stream for which you have set the 
CFX option in PCSetup.   
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3. To generate a CFX report for a stream, enter the time range in the 
corresponding input field. The first field indicates the report’s start 
time; the second field indicates the report’s end time. The system 
exports to the CFX report any historical items, alarms, and events 
specific to this stream that were generated during the time range 
you have selected. When completed, your screen might look like 
this for stream 1:   

 
CFX Files and 
Time Stamps 

The time stamp for a generated CFX file is typically several seconds 
after the period closes. For example, a CFX file that contains historical 
flow data, alarms, and events for the hour between 12:00 and 13:00 is 
generated and given a time stamp of approximately 5 seconds after 
13:00 (that is, 13:00:05). To download the CFX file that contains data 
between 12:00 and 13:00, you need to enter 13:00 for the start time 
and 13:01 for the time stamp.  
 

4. Click OK to generate the CFX report for the selected stream. A 
File Download dialog displays.  

 

Note: This dialog may not appear instantaneously. The time the 
system needs to generate a CFX report depends on the 
number of items (including archive items, alarms, and 
events) it must include in the report. The greater the number 
of items, the more time the system needs to generate the 
report, and the longer the wait for this dialog to display.   
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5. Click Save and select a location and file name for the report. The 
default file name is MXX_DD_MM_YYYY_hh_mm_ss.cfx, 
where: 

M is meter 
XX is the meter number 
DD_MM_YYYY is the creation date (day, month, year) stamp 
for the file 
hh_mm_ss is the creation time stamp (hours, minutes, seconds) 
for the file.  

6. Once you save the file, you can open it with dedicated tools.  

H.6 Understanding the CFX File Structure   
As stated previously, the time stamps the system applies to generated 
CFX file reports are typically seconds after the end of the period. 
Understanding how the system creates CFX files can help.   

First, the program creating CFX files uses components which are both 
time-dependent and time-independent:  

 Header (not time-dependent) 
 Meter configuration (time-dependent)  
 Collection of historical items (time-dependent) 
 Collection of alarms (time-dependent) 
 Collection of events (time-dependent) 
 File terminator (not time-dependent)   
When you select a time range for a particular stream, the system 
searches for the newest meter configured for that range and all 
historical items, alarms, and events in that range.  

For example, an “hourly” CFX report contains historic items for one 
hour of flow data. If you specify a start time of 10:00 and an end time 
of 14.01, the system generates a CFX file containing:  

 A header  
 A meter configuration at 14:00  
 A collection of historical items: 

o 10:00 – flow data from 09:00 to 10:00 
o 11:00 – flow data from 10:00 to 11:00 
o 12:00 – flow data from 11:00 to 12:00 
o 13:00 – flow data from 12:00 to 13:00 
o 14:00 – flow data from 13:00 to 14:00 

 A collection of all alarms generated between 09:00 and 14:00  
 A collection of all events generated between 09:00 and 14:00 
 A file terminator    

All data collection begins at 09:00 but because the time stamp in the 
S600+ follows (“trails”) the flow data, flow data starts at 09:00, but the 
report generates at 10:00.  
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Appendix I – Network Printing 
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This appendix provides an overview of the Network Printing function.  

Note: Network printing is available for CPU modules delivered from 
the factory with the binary (“firmware”) at 06.20 or greater. 
Although you can upgrade the binary on old CPU modules, 
network printing requires a factory upgrade of additional 
firmware. No user upgrade of these components is possible. If 
you wish to use network printing with old CPU modules, you 
must return them to the factory for firmware upgrades.   

I.1 Overview  
Network printing enables you to use one or more printers connected in 
the same network with the S600+ to print reports, alarms, events and 
all other S600+-printable documents.   
 

 Caution To ensure MID compliance, do not use network printing when the 
printer is legally controlled. In that case, use a serial printer with 
hardware handshaking.   
 

You can connect to and use a network printer without having to install 
printer drivers. Once a printer is connected to the network and given an 
IP address, you specify that IP address (as part of the printer 
configuration) and start using the printer.   

Note: Advanced printer functions such as support for paper sizes 
other than metric A4 (297mm x 210 mm) or US letter (8.5in x 
11in), paper source, color printing, paper orientation, and so on 
are not currently available with this feature.   

Printer configuration is minimized. Each network printer needs to have 
an IP address and a defined “print task” (reports, alarms, events, or a 
combination of the three). You can easily change these settings at run 
time.  

The S600+ generates reports periodically and generates alarms and 
events as they occur. These are “printing tasks.” You assign each 
printer connected to the S600+ one or more tasks. For redundancy, 
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multiple printers can perform the same task. Report, alarm, and event 
printing can occur automatically and manually (from the front panel), 
since each task has specific triggers for automatic printing: 

 Reports print as soon as they generate. 
 Alarms and events print either as soon as the number of specified 

alarms/events since the last print has occurred or as soon as an 
“elapsed time since the last print” value exceeds the time specified 
in the configuration. 

Network printing does not replace the option to connect a serial printer. 
This option is still available, and you can combine the two printing 
protocols as necessary.   

I.1.1 Supported Printers  
The S600+ uses a generic network printing driver which supports a 
large number of printers by printing files in RAW format. This format 
implies that the file is sent to the printer as the S600+ generates it.   
To determine if the printer is compatible, check whether port 9100 of 
the printer is open and whether the printer accepts RAW protocol.  

I.1.2 Supported Paper Sizes  
Network printing currently supports only two sizes of paper: metric A4 
(297mm x 210mm) and US letter (8.5in x 11in). Further, the function 
supports up to 78 characters per line for A4 paper and up to 80 
characters per line for Letter paper.   

Note: Refer to Section I.5, Editing Report Line Lengths, for 
information on adjusting the line lengths of the two supported 
paper sizes.    

I.2 Configuring Printers from PCSetup 
Select I/O Setup > Comms from the PCSetup menu to define a printer 
as a communications link. Any communication link can be defined as a 
printer link by changing its function to PRINTER.  
For each communication link that you set to PRINTER, you need to 
define the communication protocol and the communication port or IP 
address (depending on the protocol selected).  

Additional printer settings include:  
 Printing task (Alarm, Event, or Report) 
 Trigger type for automatic printing of Alarms and Events (the 

timeout period of number of items)  
 Values for each trigger 

You can configure all the Comms links as printers. However, once you 
define a Comms link as a printer you cannot change it at runtime 
through either the Webserver or the Front Panel.  
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You can also define automatic printing triggers in the Comms menu 
(although this feature is available only for network printers). To enable 
a trigger type (based on a timeout or number of items), set its value to 
some non-zero value.  

Figure I-1 shows a serial printer configured for COM3; compare it to 
Figure I-2, which shows the configuration for a network printer.  

 

Figure I-1. Defining a Serial Printer on COM3 Port 

 

Figure I-2. Defining a Network Printer 
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Figure I-3. Defining Comms Task 20 for the Printer 

I.3 Configuring Printers from the S600+ 
You can also configure a printer from the S600+ Front Panel or 
Webserver.  

I.3.1 Configuring at Runtime  
The system defines printer tasks as Comms links. To change the printer 
communication settings (protocol, IP or port) and the general printer 
options (printing task, trigger value) through the Webserver or the 
Front Panel, you must access the Communications section. 

 

I.3.2 Printer Options  
You can edit printer options (printing task and triggers) through the 
Webserver and Front Panel.  

Printing Task Select a print task by changing the value in the displays from zero (task 
not checked) to a value other than zero (task checked). The system 
then assigns all tasks with a non-zero value to the printer.  

Printing Trigger You cannot edit the printing task directly. By using a non-zero value 
for a trigger value, that trigger value also sets the trigger type.  

For example, if the Timeout trigger value is zero, printing is not 
triggered by Timeout. However, if you change that value to 1 minute, 
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the printer prints new alarms and events every minute, if there are new 
alarms and events.   

I.4 Printing Retries  
While printing, the S600+ performs a number of retries reading the 
response from the printer after sending the print request. During this 
time the printing task does not send any other print requests to the 
printer. There is a one-second delay between each retry.  

By default, the system has a maximum of 10 retries, so there is at most 
a 10-second interval between two print jobs. Depending on the 
network to which the S600+ and the printers are connected, more or 
fewer retries might be needed to be able to complete a print job.  

You can change the maximum number of retries using the System 
Editor. Access the System section and edit the Keypad Integer 
(KPINT) named PRN MAX RETRIES.  

Note: The System Editor is available only with Config600 Pro.    

 

Figure I-4. Redefining Printer Retries 

In case of a printer error, an alarm occurs. The S600+ then tries to 
reprint after a 1-minute wait from the previous failed print attempt. 
Further print attempts continue until the printer recovers from the 
error, the printer IP address changes (and a new printer is assigned), or 
the communication protocol changes.  

I.5 Editing Report Line Lengths  
The Network Printing function currently supports two paper sizes, 
metric A4 (297 mm x 210 mm) and US letter (8.5 in x 11 in). US letter 
paper size is the default. A4 paper accommodates up to 78 characters 
per line, while US letter accommodates up to 80 characters per line. 
This section describes the process you use to adjust the line length for 
printed reports so that report content does not exceed the width of the 
page or the capability of your printer. For example, if your printer uses 
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A4 paper but can only accommodate 36 characters per line, use this 
procedure to adjust the report line length.  
To edit report line lengths:   

1. Access the System Editor application and open the configuration 
containing the reports you want to edit.  

2. Using the left pane, select System > KPINTARR. From the 
resulting screen, double-click the ALARM FORMAT object.  

 

Figure I-5. Selecting the ALARM FORMAT Object 

An Edit dialog displays:  
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Figure I-6. Edit Dialog 

Each item in the Column section is associated with a specific piece 
of information that appears on a report. The information appears on 
the report based on the position you define in the Data field. 
Position 0 appears at the start of the line. If you set a field to -1 the 
system does not include that information on the report. Table I-1 
indicates the values of the fields:  

Table I-1. Field Descriptions 

Field Description 
01 Date; common for all report/log/archive types  
02 Time; common for all report/log/archive types  
03 Computer ID; common for all report/log/archive types  
04 Object descriptor (alarm, archive, report, etc.); common data 

for most messages   
05 Field descriptor (Value, InUse, etc.); common data for most 

messages  
06 Alarm text (HH, LL, H, L, etc.); data for alarm messages 
07 Alarm Status (SET, CLR, ACC); data for alarm messages 
08 Alarm Value; data for alarm messages  
09 Second line of two-line constant change message; data for 

constants change message 
10 Value f ield (that is, the value stored in the Value field for a 

KPINT object); value field for several message types 
11 Total number of characters in a log line; common for all log 

types.  
Note: The value stored in all fields up to 11 must be smaller 

than the value specified in field 11.  
 

3. Edit the value in field 11 and click OK to save your changes.   

Examples The following examples show settings for various kinds of messages.  
 

Alarm archive examples:  
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F1        F2      F3   F4                    F5          F7               F11 
0         11      20   25                    50          63               80 
↓         ↓       ↓    ↓                     ↓           ↓                 ↓ 
06/09/2013 08:48:45 S600 STR01 CORIOLIS FLOW      I/P ERR      CLR               

 
F1        F2      F3   F4                    F5          F7 F8            F11 
0         11      20   25                    50          63 65            80 
↓         ↓       ↓    ↓                     ↓           ↓  ↓              ↓ 
06/09/2013 09:31:49 S600 STR01 SERIAL DENS        L            CLR 50.000000 

 

In the following example Field 03 is set to -1, which means that the 
computer ID does not display. Field 04 was moved forward 3 
characters. 

 
F1        F2     F3  F4                    F5          F7 F8              F11 
0         11      1  22                    50          63 65              80 
↓         ↓       ↓  ↓                     ↓           ↓  ↓                ↓ 
04/09/2013 11:12:55    STR01 SERIAL DENS        L            SET             

Event archive examples: 
 
F1        F2      F3   F4                    F5          F10               F11 
0         11      20   25                    50          63                80 
↓         ↓       ↓    ↓                     ↓           ↓                  ↓ 
06/09/2013 08:48:45 S600 STR01 DENS SEL           VALUE        I/O 

 

 

F1        F2      F3   F4                    F6          F10               F11 
0         11      20   25                    50          63                80 
↓         ↓       ↓    ↓                     ↓           ↓                  ↓ 
06/09/2013 09:31:20 S600 STR01 KP PULSE FREQ      VALUE                          

                         CHANGED FROM  2.0000000E+01  TO  5.0000000E+01  Hz 

                       ↑                                                     
                       F9        
                       25        

 

In the following example Fields 01 and 03 are both set to -1. All other 
relevant fields were set correspondingly to reduce the length of the 
archive line. 

 
F2      F4                F6          F7                F11 
0       11                25          42                60 
↓       ↓                 ↓           ↓                  ↓ 
13:01:37 STR01 SERIAL PRESS  MODE         KEYPAD 

I.6 Network Printing Alarms 
The table below shows the alarms that can be raised as part of the 
network printing functionality. 
Alarm Description 
03 Idle 
05 Error – The file has been sent to the printer, but no job id has been 

assigned so it cannot print. 
06 Not Defined – No network printer has been configured. 
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Alarm Description 
08 Job Cancelled – Printing has been cancelled at the printer. 
09 Job Error – The file has been sent to the printer but has not been 

completed or cancelled. 
11 Not Acc Jobs – Buffer is full so no new jobs can be accepted. 
12 No Net Print – Kernel does not support network printing. 

 

Note: If network printing problems occur (i.e. multiple copies of a 
report), then the printer should be checked for any error 
messages (e.g. low toner) and these issues rectified. The 
FloBoss S600+ assumes any reports sent to the device will be 
printed correctly. 
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Appendix J – Sampling 

In This Chapter 

J.1 Overview ................................................................................. J-1 
J.2 Input / Outputs ......................................................................... J-1 

J.2.1 Sampler Output............................................................... J-2 
J.2.2 Sampler Can Select Output............................................... J-2 

J.3 Sampling Options ..................................................................... J-2 
J.3.1 Sampler Method.............................................................. J-2 
J.3.2 Sampler Mode ................................................................ J-3 
J.3.3 Can Fill Indicator ............................................................. J-4 
J.3.4 Auto Disable ................................................................... J-4 
J.3.5 Auto Restart ................................................................... J-4 

J.4 Sampling Sequence .................................................................. J-5 
J.5 Sampling Alarms .....................................................................J-10 
J.6 Sampling Displays ...................................................................J-11 
J.7 Sampling – System Editor .........................................................J-13 
 

 
This appendix provides an overview of the S600+ sampling 
functionality.  

Station or Stream Based When creating a configuration, you can enable sampling either at the 
stream or at the station to which the stream is assigned, but not both. 

Note: Refer to Chapter 5 Station Configuration or Chapter 6 Stream 
Configuration for details of sampling configuration screens. 

J.1 Overview  
Sampling is the method by which a sample of the product being 
metered is collected in a sample container (can). When the can is full it 
can be removed and sent to a laboratory for analysis. 

Whilst sampling is active, the FloBoss S600+ calculates the frequency 
of the samples (grabs) required to fill the can based on the input 
parameters. You can configure these parameters via the front panel / 
webserver or from a supervisory system.  

Can full indication is provided, and support is also available for dual 
can sampling.  

J.2 Input / Outputs 
You can configure the following inputs and outputs associated with the 
sampler. 

Inputs  In a configuration with sampling, the following inputs can be assigned: 

Can 1 Fill Indication 4-20mA ADC 
Can 2 Fill Indication 4-20mA ADC 
Sampler Flow Rate Low Digital Input 
Sampler Can 1 High Digital Input 
Sampler Can 2 High Digital Input 
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Flow Switch (Flow Prop 3 Only) Digital Input 
Pressure Switch (Flow Prop 3 Only) Digital Input 

 

Notes: 
 Some (or none) of these inputs may be required, depending on the 

sampling configuration. 

 The Can 1 and Can 2 Fill Indication 4-20mA ADC Low and High 
Scale values should be configured to correspond to the Can 
Volume of the sampler. 

 The flow switch and pressure switch digital inputs are not available 
by default. They are specific to the FLOW PROP 3 (ANP 
sampling) functionality and need to be added via the system editor 
if required.  

Outputs  In a configuration with sampling, the following outputs can be 
assigned: 

Sampler Output (Grab Command) Digital Output 
Sampler Can Select Output Digital Output 

J.2.1 Sampler Output 
The S600+ sampler logic sets the Sampler Output (Grab Command) 
digital output to command the sampler to take a grab. The time 
between grabs is called the Grab Interval and is calculated based on the 
Sampler Method selected. 
If the Sampler Output (Grab Command) digital output is configured 
with Sense = Normal, the duration of the grab signal is equal to the 
Minimum Interval value, with a minimum value of 3 seconds. 

If a shorter duration is required, the Sense = Pulse On should be 
selected and the Pulse Width set to the required duration. 

For Flow Prop 3 mode, the Sampler Output duration is dictated by the 
Sampler Pulse Duration (default 3 sec). 

J.2.2 Sampler Can Select Output 
In Dual mode, when Can Selected = 1, the Sampler Can Select Output 
is cleared; when Can Selected = 2, the Sampler Can Select Output is 
set. 

J.3 Sampling Options 
You can configure many sampler options including Sampler Method, 
Sampler Mode, Can Fill Indicator, Auto Disable, and Auto Restart. 

J.3.1 Sampler Method 
The Sampler Method determines the grab interval. Possible options are 
Time Prop, Flow Prop 1, Flow Prop 2, and Flow Prop 3. 
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Time Prop In this mode the grab interval is in seconds.  

The number of grabs required to fill the can is calculated from the Can 
Volume and Grab Volume. 

Number of grabs = Can volume (m3) / Grab volume (m3) 

The Grab interval is then calculated from the Number of grabs and the 
Can fill period.  

Grab interval (s) = Can fill period (hrs) * 3600 / Number of grabs  
Flow Prop 1 In this mode the grab interval is in volume (m3).  

The number of grabs required to fill the can is calculated from the Can 
Volume and Grab Volume. 
Number of grabs = Can volume (m3) / Grab volume (m3) 

The Grab interval is then calculated from the Number of grabs and the 
Can volume.  

Grab interval (m3) = Expected volume (m3) / Number of grabs  
Flow Prop 2 In this mode the grab interval is in volume (m3) and is equal to the 

expected volume (m3).  
Flow Prop 3 In this mode the grab interval is in volume (m3) and is equal to the 

expected volume (m3).  

It also supports the pressure switch and flow switch digital inputs. If 
the pressure switch is set during sampling, sampling will be stopped. 
When the Sampler Output has been set to take a grab, the system 
expects the flow switch to be set.  

J.3.2 Sampler Mode 
The Sampler Mode determines the number of containers used by the 
sampler. 

SINGLE/DUAL In SINGLE mode, the samples are acquired in one can. In DUAL 
mode, the samples are acquired into two cans and the sampler switches 
to the second can when the first can is full (according to the Twin Can 
Changeover Mode selection).  

Twin Can Changeover 
Mode 

You can set the can changeover to AUTO (automatically change over 
to the second can when the first is full) or MANUAL (sampling pauses 
when the first can is full and requires you to change the value of 
Sampler Can Select Output before sampling continues on the second 
can.   

Notes: 
 If sampling is stopped because both cans are full, the Twin Can 

Changeover Mode is set to MANUAL by the system. You must set 
back to AUTO if required. 

 Additionally, the display for Twin Can Changeover Mode must be 
manually added to the displays.  
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J.3.3 Can Fill Indicator 
The Can Fill Indicator is used by the system to determine when the 
sampler container is full. 

Grab Count Uses the number of grabs taken to determine when the can is full.  

Grabs Count and Grab Volume are used to calculate Can Volume 
Filled. When Can Volume Filled is greater than Can High High 
Percent of Can Volume, the Can Full Status is set.  

Digital Input Uses Sampler Can 1 High digital input to determine when the can is 
full.  

Grab Count and Grab Volume are used to calculate the Can Volume 
Filled. When the Sampler Can 1 High digital input (shown as Can Full 
I/O Status) is set, the Can Full Status is set.  

Analog Input Uses Can x Fill Indication 4-20mA ADC input to determine when 
the can is full.  
The Can x Fill Indication 4-20mA ADC input (shown as Can Fill 
Indicator) is used to calculate the Can Volume Filled. When the Can 
Volume Filled is greater than the Can High High Percent of Can 
Volume, the Can Full Status is set.  

 

J.3.4 Auto Disable 
The system stops sampling based on your selection in the Auto Disable 
field. You can select more than one Auto Disable option. 

On Can Full The system stops sampling if the Can Full Status for the current can is 
set.  

The sampling sequence stage number changes to 6, Stopped Can Full. 
Sampling continues on the second can if the Sampler mode is set to 
DUAL, the Twin Can Changeover Mode is set to AUTO, and the 
second can is available.  

On Flowrate Limit The system stops sampling if the stream or station gross volume flow 
rate drops below the Flow Rate Low Limit. 

The sampling sequence stage number changes to 7, Stopped Low 
Flow.  

On Flow Status System stops sampling if the Sampler Flow Rate Low digital input set. 
The sampling sequence stage number changes to 7, Stopped Low 
Flow. 

J.3.5 Auto Restart 
 If enabled, sampling restarts automatically following a pause for Can 

Full, Flowrate Limit, or Flow Status after the condition has cleared. 

If disabled, you must manually restart sampling by setting Start 
Command to Start after the condition has cleared. 
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J.4 Sampling Sequence  
The sampling sequence functions in stages. Table J-1 shows the stages 
involved.  

Note that some of the stages are only applicable to certain sampling 
methods as indicated.  

Table J-1. Sampling Sequence Stages 

Stage Title Description 
0 Idle Wait for a command to start the sequence. 

Clear all sampler alarms. 
Handle reset can volume command. 
Check Operator Commands: 
 If  the Start command has been issued:  

o If  mode is FLOW PROP 3, reset cans, set 
Sampler Output digital output, increment grab 
counters and proceed to stage 8 (Initial Time). 

o Else proceed to stage 1 (Monitor). 
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Stage Title Description 
1 Monitor Monitor sampler status. 

Handle reset volume command.  
Check Operator Commands: 
 If  the Stop command has been issued, proceed to stage 5 

(Stopped Manually) and set ‘Sampler Stopped when 
Flowing’ alarm (if flow is present). 

 If  the Terminate command has been issued, proceed to 
stage 0 (Idle). Note: This is only applicable if mode is 
FLOW PROP 3 and is not available by default. It would 
need to be added via the system editor if required. 

Check Can(s) Full, if set: 
 If  mode is FLOW PROP 3, proceed to stage 0 (Idle). 
 All other modes proceed to stage 6 (Stopped Can Full) or 

stage 13 (Can Switch Over – Dual Can AUTO only).  
Check Low Flow Status, if set: 
 If  mode is FLOW PROP 3, proceed to stage 0 (Idle). 
 All other modes proceed to stage 7 (Stopped Low Flow) 

and set ‘sampler stopped when flowing’ alarm if flow is 
present. 

Check if  grab required (including overruns awaiting output): 
 If  mode is FLOW PROP 3, check pressure switch. 

o If  pressure switch ON, proceed to stage 11 
(Stopped Pressure Switch) and raise ‘Pressure 
Switch’ alarm.  

o If  pressure switch OFF, proceed to stage 9 (Check 
Flow Switch). 

 If  grab required, proceed to stage 2 (Digital Output ‘n’), set 
Sampler Output digital output, increment grab counters 
and increment current can volume (Grab Count and Dig 
I/P).  

 If  no grabs required, stay in stage 1 (Monitor). 
 If  mode is FLOW PROP 1 or FLOW PROP 2: 

o If  number of grabs required > 1, increase overruns 
by (number of grabs required – 1). 

2 Digital Output ‘n’ Synchronize with IO communications 
Handle reset volume command.  
Check Operator Commands: 
 If  the Stop command has been issued, maintain the digital 

output for the configured time then proceed to stage 5 
(Stopped Manually) and set ‘Sampler Stopped when 
Flowing’ alarm (if flow is present). 

 If  the Terminate command has been issued, maintain the 
digital output for the configured time then proceed to stage 
0 (Idle). 

Check Pressure Switch:  
 If  mode is FLOW PROP 3, check pressure switch. 

o If  pressure switch ON, proceed to stage 11 
(Stopped Pressure Switch) and raise ‘Pressure 
Switch’ alarm.  

Allow the command to be registered by the IO handling task. 
Proceed to stage 3 (Minimum Interval). 
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Stage Title Description 
3 Minimum Interval Ensure a delay between sampler pulses.  

Handle reset volume command.  
Check Operator Commands: 
 If  the Stop command has been issued, proceed to stage 5 

(Stopped Manually) and set ‘Sampler Stopped when 
Flowing’ alarm (if flow is present). 

 If  the Terminate command has been issued, proceed to 
stage 0 (Idle). 

Check Pressure Switch:  
 If  mode is FLOW PROP 3, check pressure switch. 

o If  pressure switch ON, proceed to stage 11 
(Stopped Pressure Switch) and raise ‘Pressure 
Switch’ alarm.  

Check Can(s) Full, if set: 
 If  mode is FLOW PROP 3, proceed to stage 0 (Idle). 
 All other modes, proceed to stage 6 (Stopped Can Full) or 

stage 13 (Can Switch Over – Dual Can AUTO only).  
Once the minimum interval between pulses has been reached, 
clear Sampler Output digital output. Proceed to stage 4 (Post 
Pulse). 

4 Post Pulse Post Pulse Output Delay  
Allow the command to be registered by the IO handling task. 
Proceed to stage 1 (Monitor).  

5 Stopped Manually Sampler has been stopped manually 
Handle reset volume command.  
Check Operator Commands: 
 If  the Start command has been issued, proceed to stage 1 

(Monitor). 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
Raise can full alarms if required. 

6 Stopped Can Full Sampler has been stopped – can(s) full 
Handle reset volume command.  
Check Operator Commands: 
 If  the Start command has been issued, proceed to stage 1 

(Monitor). 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
Raise low f low alarms if required.  
If  auto restart is enabled, can is not full, and low flow status clear, 
proceed to stage 1 (Monitor). 
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Stage Title Description 
7 Stopped Low Flow Sampler has been stopped – low flow 

Handle reset volume command.  
Check Operator Commands: 
 If  the Start command has been issued, proceed to stage 1 

(Monitor). 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
Raise can full alarms if required. 
Raise low f low alarms if required. 
If  auto restart is enabled, can is not full, and low flow status clear, 
proceed to stage 1 (Monitor). 

8 Initial Time Monitor for sampler ready feedback  
Flow Prop 3 Mode Only. 
Check Operator Commands: 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
Check Pressure Switch:  
 If  mode is FLOW PROP 3, check pressure switch. 

o If  pressure switch ON, proceed to stage 11 
(Stopped Pressure Switch) and raise ‘Pressure 
Switch’ alarm.  

Check Initial Flow Switch Feedback:  
 If  mode is FLOW PROP 3, check flow switch. 

o Wait for Sampler Pulse Duration to expire (default 
3 sec) then clear Sampler Output digital output. 

o If  Flow Switch digital input set, proceed to stage 1 
(Monitor). 

o If  Flow Switch digital input clear, set Sampler 
Output digital output again and check for Flow 
Switch digital input. 

o Repeat for Initial Actuations (default 5) until Flow 
Switch digital input set. 

If  no feedback received from Flow Switch, proceed to stage 12 
(Stopped Initialise) and set ‘Sampler Failed to Initialise’ alarm.  
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Stage Title Description 
9 Check Flow Switch Monitor Flow Switch status 

Flow Prop 3 Mode Only 
Check Operator Commands: 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
Check Pressure Switch:  
 If  mode is FLOW PROP 3, check pressure switch. 

o If  pressure switch ON, proceed to stage 11 
(Stopped Pressure Switch) and raise ‘Pressure 
Switch’ alarm. 

Check Flow Switch:  
 If  mode is FLOW PROP 3, check flow switch. 

o Wait for Sampler Pulse Duration to expire (default 
3 sec) then clear Sampler Output digital output. 

o If  Flow Switch digital input set, proceed to stage 3 
(Minimum Interval). 

o If  Flow Switch digital input clear for > 1 sec, raise 
‘Flow Switch Fail’ alarm and proceed to stage 3 
(Minimum Interval). 

10 Not Used  
11 Stopped Press 

Switch 
Sampler has been stopped – pressure switch 
Flow Prop 3 Mode Only. 
Handle reset volume command. 
Check Operator Commands: 
 If  the Start command has been issued, proceed to stage 1 

(Monitor). 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
Raise can full alarms if required. 
Check Pressure Switch:  
 If  pressure switch OFF, proceed to stage 1 (Monitor) and 

clear ‘Pressure Switch’ alarm 
12 Stopped Initialise Sampler has been stopped – failed to initialise 

Flow Prop 3 Mode Only. 
Handle reset volume command. 
Check Operator Commands: 
 If  the Start command has been issued, proceed to stage 3 

(Initial Time). 
 If  the Stop command has been issued, proceed to stage 0 

(Idle). 
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Stage Title Description 
13 Can Switch Over Switchover Cans 

Dual Can Mode Only. 
Handle reset volume command. 
Check Operator Commands: 
 If  the Stop command has been issued, proceed to stage 5 

(Stopped Manually) and set ‘Sampler Stopped when 
Flowing’ alarm if flow is present. 

 If  the Terminate command has been issued, proceed to 
stage 0 (Idle). 

Switch Can Selected, switch Sampler Can Select Output. 
Once changeover time has elapsed, proceed to stage 1 (Monitor). 

J.5 Sampling Alarms  
 Table J-2 shows the alarms that can be raised as part of the sampling 

functionality. 

The alarm limits / dead bands are calculated based on the can volume 
and the operator entered percentages.  

High limit = can volume * (can high limit / 100) 

High high limit = can volume * (can high high limit / 100) 
High dead band = can volume * ((high limit – 2.0) / 100) 

High high dead band = can volume * ((high high limit – 2.0) / 100) 

Table J-2. Sampling Alarms 

Alarm Description 
Can x Full Volume greater than or equal to the High High limit (Grab Count, Analogue 

Input). 
Digital input ON (Digital Input) . 

Can x High Volume greater than or equal to the High limit. 
Alarm is cleared when the volume is less than the high dead band. 

Speed In Time Prop mode: The configured time proportional interval is less than 
the minimum interval (This cannot be less than 1 second). 
In Flow Prop 1 and Flow Prop 2 modes: The number of overruns is greater 
than 10. (Alarm cleared when number of overruns is less than 6). 

Stopped The sampler has been stopped but flow is still present. 
Low Flow The sampler has been automatically stopped. 

The f low rate is below the low flow limit. 
Flow Switch Flow Prop 3 Mode Only. 

The sampler has been automatically stopped. 
The f low switch digital input status has been set to OFF for more than the 
permitted time (1 second). 

Press Switch Flow Prop 3 Mode Only. 
The sampler has been automatically stopped. 
The pressure switch digital input status is set to ON. 
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Alarm Description 
Init Fail Flow Prop 3 Mode Only. 

The sampler has been automatically stopped. 
The number of initial grabs taken has exceeded the maximum allowed 
before the flow switch signal is received from the sampler.  

FSW Stuck Flow Prop 3 Mode Only. 
The sampler has been automatically stopped. 
The f low switch has been ON for more than the permitted time (FSW On 
Limit, default 2 sec). 

J.6 Sampling Displays 
 The following table describes the displays associated with sampling. 

Access the displays through the S600+ front panel or web browser.  

Table J-3. Sampling Displays 

Display (SAMP PARAMS) Description 
SAMPLER METHOD Identif ies the sampling method in use as 

described in section J.3. 
SAMPLER MODE Single Can or Dual Can. 
CAN FILL INDICATOR Identif ies the method by which the can full 

indication is obtained (Grab Count, Digital 
input, Analogue input). 

A / DISABLE CAN FULL Auto disable on can full – enable / disable. 
A / DISABLE F/R LIM Auto disable on flow rate limit – enable / 

disable. 
A / DISABLE F/R STAT Auto disable on flow status (Sampler Flow 

Rate Low digital input) – enable / disable. 
A / RESTART Auto restart (following auto disable) – enable / 

disable. 
EXPECTED VOL Volume (m3) over which samples are to be 

taken to fill can – used in Flow Prop modes. 
PERIOD Time (hours) over which samples are to be 

taken to fill can – used in Time Prop mode. 
FR LOW LIMIT Low limit for auto disable on flow rate limit 

option. 
TIME PROP INTERVAL Calculated time (s) between grabs – used in 

Time Prop mode. 
MINIMUM INTERVAL Indicates minimum time (seconds) between 

grabs.  
CAN VOLUME Total can volume. 
GRAB VOLUME  Required grab volume.  
CAN LOW PERCENT Not used.  
CAN HH PERCENT High High alarm value as a percentage of the 

can volume. Used to indicate can full. 
CAN H PERCENT High alarm value as a percentage of the can 

volume. 
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Display (SAMP CONTROL) Description 
START COMMAND Start or Stop sampling command. 

Note:  Following a cold start, Reset Can x 
Vol must be carried out for Can 
Selected before Start sampling 
command will be accepted. (Does 
not apply to Flow Prop 3). 

CAN SELECTED Can 1 or Can 2 (will show can 1 in single 
can mode). 

STAGE No Current sampling stage. 
LOW FLOW STATUS Set to CLEAR when flow above the flow rate 

low limit value, otherwise SET. Also set by 
Sampler Flow Rate Low digital input.  

OVERRUNS In Flow Prop 1 or Flow Prop 2, if number of 
grabs required based on the flow increment 
is greater than 1, overruns will be 
incremented by (number of grabs required -
1). 
Note:  If  sampling has been paused and 

restarted, overruns will still be 
calculated based on the flow 
increment since the last grab was 
taken. 

The sampler will attempt to “catch up” by 
issuing grabs to decrease the number of 
overruns, if permitted by the values of 
Minimum Interval, Expected Volume and 
volume flow rate. 

 

Display (SAMP CAN x) Description 
RESET CAN x VOL Updates Can Fill Indicator and Can Volume 

Recalculates Grabs to Fill Can and Time 
Prop Interval 
Resets Grabs Count, Grabs Remaining, 
Overruns, Can Vol Filled and Can Vol 
Remaining. 
Note:   If  Can Fill Indicator = ANALOG I/P, 

Can Vol Filled and Can Vol 
Remaining are not reset. 

Clears various sampler alarms. 
GRABS COUNT Current grab count. 
GRABS REMAINING Grabs remaining before the can is full. 
GRABS TO FILL CAN Calculated number of grabs to fill the can. 
CAN VOL FILLED Volume (m3) that is currently in the can. 
CAN VOL REMAINING Volume (m3) equal to (Can Volume – Can 

Vol Filled). 
CAN FULL STATUS Set to CLEAR when can is not full, 

otherwise SET. 
CAN FULL I/O STAT Current status of Sampler Can X High 

digital input. Applies when using Can Fill 
Indicator = Dig. I/P. 
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CAN FILL INDICATOR Current value of  Can X Fill Indication 4-
20mA ADC. Applies when using Can Fill 
Indicator = Analog I/P. 

 

J.7 Sampling – System Editor 
For Flow Prop 3 mode, you must configure additional digital inputs 
used by the system for the flow switch and pressure switch. 
For Flow Prop 3 mode, the terminate command must be added to the 
SAMP RUN CMNDS truth table (Ctext 4 = TERMINATE, sval4 = 3). 

Note: System editor is available only with the Config600 Pro software 
and requires completion of the RA901 Advanced Config600 
Training Course. 
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Appendix K – Gas Composition 

In This Chapter 
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This appendix details the options available for Gas Composition 
handling, including single or dual interfaces direct from the flow 
computer to a gas chromatograph. 

The following chromatograph interfaces (Serial or Ethernet) are 
currently supported:   
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 2551 Euro 
 2350 Euro (in SIM2551 emulation mode) 
 2350 USA (in SIM2251 emulation mode) 
 2251 USA  
 Siemens 
 Generic (user-configurable)  
Information on setting up the Serial / Ethernet communications 
interfaces can be found in Section 4.10, Communications Port. 
The following terminology is used within this appendix: 

 GC/chromat – Gas Chromatograph 
 Station – refers to Station functionality in the S600+ 
 Stream – refers to Stream functionality in the S600+ 
 GC Stream – refers to the GC Analysis stream 

K.1 Station/Stream Combinations 
During config generation, various station and metering stream 
combinations are available: 

 Moles at Individual Stream – No chromat handling at the station 
level, all handling is carried out at the stream(s). 

 Moles from Station Only – No chromat handling at the stream 
level, all handling is carried out at the station and data copied to the 
stream(s). 

 Moles from Station Chromat – Interface to chromat is at station 
level and data passed to stream(s). Some handling is carried out at 
stream level. 

The following table describes possible station and stream combinations 
and how they are to be configured in Config Generator and PCSetup. 

These options are also detailed in Section 2.1.4, Specify Stations and 
Section 2.1.5, Define Streams. 

Note: The Config Generation Station options include Single Chromat 
and Dual Chromat. Dual Chromat functions are described in 
Section K.6, Dual GC Handling. 
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Table K-1. Station/Stream Combinations 
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K.2 Gas Composition Modes  
Several modes are available for gas composition. These can be selected 
using Initial Mode on the Station Gas Composition and Stream Gas 
Composition displays in PCSetup, or under MOLE SELECT on the 
flow computer displays. 

The data available on the Gas Composition screen changes depending 
on the selections made. Refer to Section 5.5, Station Gas Composition 
and Section 6.3.4, Stream Gas Composition for more details. 

The following sub-sections describe these modes, which data set they 
correspond to, and how they are processed by the S600+. Detailed 
descriptions of composition processing are given in Section K.4, 
Composition Processing. 

K.2.1 CHROMAT Mode 
In CHROMAT mode, the S600+ reads a gas composition from a GC 
via a Modbus link, with processing and checks optionally applied. 

Note that CHROMAT mode can only be used when the Type (set on 
the Station Gas Composition and Stream Gas Composition screens), is 
set to CHROMAT A (Single / Dual GC) or CHROMAT B / 
CHROMAT AUTO (Dual GC) in PCSetup. 
In CHROMAT mode, the Station or Stream good chromat set (CHR 
GOOD MOLES) becomes the in-use gas composition (CHR SLCT 
MOLES). 

The raw composition set read from the GC passes through several 
validation and processing steps before becoming the good chromat set 
– namely components ordering, high/low limits check, deviation 
checks, normalisation, additional component processing, CX+ 
component splitting, critical and non-critical alarm checks. These are 
described in Section K.3, Chromat Telemetry and Section K.4, 
Composition Processing, Composition Processing. Note, these 
processing steps are user selectable on the Station Gas Composition 
and Stream Gas Composition displays in PCSetup. 

K.2.2 KEYPAD Mode 
In KEYPAD mode, you can enter a fixed gas composition with 
processing and checks optionally applied. 

In KEYPAD mode, the Station or Stream keypad set (KEYPAD 
MOLES) is processed to become the in-use gas composition (CHR 
SLCT MOLES). 
The keypad set is validated against high and low limits before 
becoming the in-use set. Details of this are given in Section K.4.2, 
High/Low Limits.  

It is possible to have an optional user acceptance step before a new 
keypad set is validated. This allows the user to confirm that the correct 
values have been entered before they become in-use. 
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The validated keypad set can be normalised to give a component total 
of 100% before it becomes the in-use set.  
Acceptance and normalisation are configured using Acceptance Type 
(set on the Station Gas Composition and Stream Gas Composition 
screens), in PCSetup. Details of normalisation are given in Section 
K.4.4, Normalisation. The following options are available: 

ACC/COPY  Keypad set components can be changed by the user but will not 
be validated to become the in-use composition until the user sets 
the Acceptance Command. 

 No normalisation is carried out on the validated keypad set 
before it is transferred to the in-use composition. 

ACC/NORM  Keypad set components can be changed by the user but will not 
be validated to become the in-use composition until the user sets 
the Acceptance Command. 

 Normalisation is carried out on the validated keypad set before it 
is transferred to the in-use composition. 

AUTO/NORM  Keypad set components can be changed by the user and will be 
validated to become the in-use composition without the use of the 
Acceptance Command. 

 Normalisation is carried out on the validated keypad set before it 
is transferred to the in-use composition. 

 
If ACC/COPY option is used it is important that the values written to 
the keypad set sum to 100%, otherwise calculations that use the in-use 
gas composition as an input may give errors. 

K.2.3 DOWNLOAD Mode  
DOWNLOAD mode is intended to allow a gas composition to be 
downloaded to the flow computer from a supervisory system via a 
Modbus link.  
In DOWNLOAD mode, the Station or Stream download set (CHR 
DLOAD MOLES) becomes the in-use gas composition (CHR SLCT 
MOLES). 

The download set is monitored by the S600+ and if a change in any 
component is seen, the download set is validated against high and low 
limits before becoming the in-use set. Details of this are given in 
Section K.4.2, High/Low Limits.  

No acceptance step is available before a new download set is validated. 

No normalisation is carried out on the validated download set before it 
becomes the in-use set. 

With no acceptance step or normalisation, it is important that the 
values written to the download set sum to 100%, otherwise 
calculations that use the in-use gas composition as an input may give 
errors. 



Config600 Configuration Software User Manual 

K-6 Gas Composition Revised January 2023 

A timeout may be applied to the download set. The download set 
component values must be updated within the entered D/L TIMEOUT 
value. More details are given in Sections K.2.5, Mode Selection and 
Section K.4.9, Timeouts. 

It is possible to use a Download Flag with the download set. This 
should be added to the supervisory Modbus Map along with the 
download set. If the Download Flag is set to 1 then the download set is 
validated, irrespective of whether any component has changed. Once 
validated the Download Flag is reset to 0. This must be configured 
using System Editor: details are given in Section K.11.5 Download 
Flag. 

K.2.4 USER Mode 
USER mode is intended to allow a fixed gas composition to be selected 
for the purpose of calculation testing. If used for this purpose, it may 
be desirable to have the user gas components on the flow computer 
displays as read-only or with a restricted security level. 

In USER mode, the Station or Stream user set (CHR USER MOLES) 
becomes the in-use gas composition (CHR SLCT MOLES). 

The user set is monitored by the S600+ and if a change in any 
component is seen, the user set is validated against high and low limits 
before becoming the in-use set. Details of this are given in Section 
K.4.2, High/Low Limits.  

No acceptance step is available before a new user set is validated. 
No normalisation is carried out on the validated user set before it 
becomes the in-use set. 
With no acceptance step or normalisation, it is important that the 
values written to the user set sum to 100%, otherwise calculations that 
use the in-use gas composition as an input may give errors. 

K.2.5 Mode Selection  
This section describes mode selection for the gas composition, 
including manual mode selection by the operator and automatic mode 
switching to KEYPAD-FAIL mode, as well as the option to revert to 
the last good chromat set. 

Manual Mode Selection Modes can be selected manually by the user using MOLE SELECT 
on the flow computer display. 
 MOLE SELECT cannot be placed into CHROMAT mode: 

o If no set has yet been received from the GC. 
OR 

o If the latest set read from the GC fails any of the 
configured validation checks described in Section K.4, 
Composition Processing. 
OR 
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o If no new analysis data has been received from the GC 
within the Analysis Timeout time (applies to certain GC 
types, see Section K.4.9, Timeouts). 
OR 

o If communications to the GC have failed. 
 MOLE SELECT cannot be placed into KEYPAD, DOWNLOAD 

or USER mode: 
o If the relevant set fails the high and low limit validation 

checks described in Section K.4.2, High/Low Limits. 
 

KEYPAD-FAIL Mode Under the following conditions, the flow computer will automatically 
switch the gas composition mode to KEYPAD-FAIL and the 
validated keypad set will become the in-use set. Note, if the keypad 
set cannot be validated then the gas composition will remain in its 
current mode and the in-use set will not update.  
 In CHROMAT mode (If the ‘Revert to Last Good after Failure’ 

option is not set in PCSetup): 
o If the latest set read from the GC fails any of the 

configured validation checks described in Section K.4, 
Composition Processing. 
OR 

o If no new analysis data has been received from the GC 
within the Analysis Timeout time (applies to certain GC 
types, see Section K.4.9, Timeouts). 
OR 

o If communications to the GC have failed. 
 In DOWNLOAD mode: 

o If the latest download set fails the high and low limit 
validation checks described in Section K.4.2, High/Low 
Limits. 

 In USER mod: 
o If the latest user set fails the high and low limit validation 

checks described in Section K.4.2, High/Low Limits, the 
mode will remain USER, but the in-use set will not 
update.   

 
Revert to Last Good In CHROMAT mode it is possible for the flow computer to use the 

last good gas composition set read from the GC, if the ‘Revert to Last 
Good after Failure’ option is set in PCSetup, and a good set has 
previously been read from the GC. This will occur in the following 
conditions: 
 If the latest set read from the GC fails any of the configured 

validation checks described in Section K.4, Composition 
Processing. 
OR 
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 If no new analysis data has been received from the GC within the 
Analysis Timeout time (applies to certain GC types, see Section 
K.4.9, Timeouts). 
OR 

 If communications to the GC have failed. 
If the ‘Revert to Last Good after Failure’ option is set in PCSetup 
and no good set has previously been read from the GC, the switch to 
KEYPAD-FAIL mode will be made, as described above. 

Keypad Fail with 
Recovery  

It is possible to configure the gas composition mode handling to 
automatically switch back from KEYPAD-FAIL mode to 
CHROMAT mode when a new valid chromat set is read from the 
GC. This requires the use of System Editor and is described in 
Section K.11.4, Mole Select – Keypad Fail Switchback.  

K.3 Chromat Telemetry  
When Type (configured on the Station Gas Composition and Stream 
Gas Composition screens) is set to CHROMAT A, CHROMAT B or 
CHROMAT AUTO, the Modbus master process interfaces to the GC 
as instructed by the chromatograph data handling software. The 
handling software triggers a controlled, sequential series of polls, 
enabling the orderly acquisition of analysis report data. This handling 
is controlled by the CHROM TELEM calculation table and the poll 
sequences for each GC type are detailed below. 

K.3.1 Telemetry Inputs  
The following objects are inputs to the CHROM TELEM calculation 
table. 

 

Telemetry Mode 
(MODE) Not used 

Chromat Type 
(TYPE) 

Type of  GC (2551 EURO, 2350 EURO, 2350 
USA, 2251 USA, GENERIC, SIEMENS) 

Address  
(SLAVE ADDR) 

This is the slave address of the GC. (Not 
always used, see Section K.1, Station/Stream 
Combinations.) 

Stream 
(CYCLE STREAM) 

This is the GC Analysis stream that the S600+ 
will accept the composition data from (0 = 
accept all streams).  

Analysis Timeout 
(ANALYSIS T/O) 

This is the time (in seconds) during which the 
S600+ expects to receive a new composition 
f rom the GC.  

Mole Order Used to order the Raw Mole % read from the 
chromat. Used as an input when the chromat 
type is set to SIEMENS or GENERIC. Used as 
an output when the chromat type is set to 
EURO or USA, where order is dictated by the 
Component Codes read from chromat. See 
Section K.4.1, Component Ordering. 
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Poll Delay Time interval in seconds between triggering of 
Modbus polls to the chromat. 
(Not available in PCSetup) 

Matched Reset Delay 
(RESET DELAY 1) 

The delay (seconds) in resetting the new data 
f lag, after it has been set by the chromat, when 
the stream indicated by the chromat matches 
the CYCLE STREAM configured in the flow 
computer. 
(Not available in PCSetup) 

Unmatched Reset 
Delay 
(RESET DELAY 2) 

The delay (seconds) in resetting the new data 
f lag, after it has been set by the chromat, when 
the stream indicated by the chromat does not 
match the CYCLE STREAM configured in the 
f low computer. 
Note: If  this value is set to zero, then the 
sequence does not reset the non-matched new 
data f lag.  
(Not available in PCSetup) 

Slave Address 
 

Array of  Modbus slave addresses for GCs. 
Used by Modbus map file as Slave Address 
Object. 

Slave Status 
 

Field of array of Modbus slave statuses for 
GCs. Used by Modbus map file as Slave 
Status Object. 

 

K.3.2 Telemetry Outputs  
The following objects are outputs from the CHROM TELEM 
calculation table. 

Telemetry Stage 
(TELEM STAGE) 

The stage in the telemetry sequence. One of 
the following values: 

 0 POLL IDLE – Idle 
 1 POLL STAT PRE-REP – Poll delay, 

then poll for status data 
 2 WAIT STAT PRE-REP – Wait for 

status data 
 3 POLL CODES – Poll delay, then poll 

for component codes 
 4 WAIT CODES – Wait for component 

codes 
 5 POLL MOLES – Poll delay, then poll 

for mole percentages 
 6 WAIT MOLES – Wait for mole 

percentage data 
 7 POLL CV – Poll delay, then poll for 

auxiliary data 
 8 WAIT CV – Wait for auxiliary data 
 9 FORCE IMMED RESET – Reset new 

data f lag (reserved) 
 10 POST REP POLL STAT – Poll delay, 

then poll again for status data 
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 11 POST REP WAIT STAT – Wait for 
status data 

 12 PROCESS DATA – Process analysis 
data 

 13 POST REP DELAY – Delay after a 
matched report, then poll again for 
status data 

 14 PRE-RESET WAIT STAT – Wait for 
new status data 

 15 RESET REPORT – Poll delay, then 
reset new data f lag 

 16 WAIT RESET – Wait for new data flag 
reset 

 17 NONE MTCH DELAY – Delay after 
unmatched report, then poll again for 
status data 

 18 NONE MTCH WAIT STAT – Wait for 
status data 

 19 NONE MTCH RESET REP – Poll 
delay, then reset new data flag 

 20 NONE MTCH WAIT RESET – Wait for 
new data f lag reset 

Status Request Flag 1 
(TELEM REQ.STAT 1)  

Trigger for Modbus master GC Status Data 
poll 

Moles Request Flag 
(TELEM REQ.MOLES)  

Trigger for Modbus master GC Composition 
Mole % poll 

CV (etc.) Request Flag 
(TELEM REQ.CV)  

Trigger for Modbus master GC Auxiliary Data 
poll  

New Data Reset Flag 
(TELEM REQ.RESET)  

Trigger for Modbus master GC reset New 
Data Flag poll  

Current Report Status 
(CURR REPORT STAT)  

Updated based on the validation status of the 
last result for the GC. Values: 

0 No result (for the configured GC stream) has 
been received since a f low computer cold 
start 

1 Result is for the configured GC stream and 
has passed the configured processing steps 
(see Section K.4, Composition Processing) 

2 Result is for the configured GC stream but 
has not passed the configured processing 
steps (see Section K.4, Composition 
Processing) 

3 A new result has not been received within 
the timeout period (see Section K.4.9, 
Timeouts) 

Good Report Latch 
(PREV REPORT STAT) 

Latched based on the validation status of 
results f rom the GC Values: 

0 No result (for the configured GC stream) has 
been received since a f low computer cold 
start 

1 A result has been received for the configured 
GC stream and has passed the configured 
processing steps (see Section K.4, 
Composition Processing) 
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Raw Status Data GC Status Data from Modbus poll 
Raw Mole % 
(RAW MOLE PCNTS) 

GC Composition Mole % from Modbus poll 

Raw CV (etc.) 
(RAW MISC DATA) 

GC Auxiliary Data from Modbus poll 

Adjusted Moles 
(CURR ADJ.MOLES) 

Ordered GC Composition Mole % with 
normalisation, splits applied, additionals 
added but no limit or alarm checks 

Good Moles 
(GOOD ADJ.MOLES) 

Ordered GC Composition Mole % with 
normalisation, splits applied, additionals 
added, when limit and alarm checks are 
passed 

Alarm Registers Array used to indicate the alarm status of the 
GC handling. Meaning if field indicating 1: 

Field 01 System Alarm (RX Fail) 
Field 02 Conf iguration Alarm (Splits Error, Additionals 

Error) 
Field 03 Critical Alarm (indicated by GC) 
Field 04 Non-Critical Alarm (indicated by GC) 
Field 05 Low Limit Alarm (components 1-16) 
Field 06 Low Limit Alarm (components 17-32) 
Field 07 High Limit Alarm (components 1-16) 
Field 08 High Limit Alarm (components 17-32) 
Field 09 Deviation Alarm (components 1-16) 
Field 10 Deviation Alarm (components 17-32) 

Codes Request Flag 
(TELEM REQ.CODES)  

Trigger for Modbus master GC Component 
Codes poll 

Component Codes  GC Component Codes from Modbus poll 
Ordered Moles 
(GOOD ORDER MOLES) 

Ordered GC Composition Mole % without 
normalisation, splits applied or additionals 
added, when limit and alarm checks have 
passed 

Analysis Time Stamp 
(LAST ANALYSIS AT) 

Time of  the last good analysis from the GC 

Report Flags Used to generate CHROM TELEM report 
Status Request Flag 2 
(TELEM REQ.STAT 2)  

Trigger for Modbus master GC Status Data 
poll (used instead of Status Request Flag 1 
for Chromat Type = USA) 

 

K.3.3 EURO Stages  
The GC telemetry sequence for the chromat types 2551 EURO and 
2350 EURO is described below. The main features of the sequence are: 
 The GC is constantly polled for Status Data. 
 If the New Data Flag is set and the Analysis/Calibration Flag is 

indicating Analysis and the last analysed GC stream matches the 
S600+ stream, then further polls will be issued for analysis data. 
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 The analysis data is processed and validated (see Section K.4, 
Composition Processing). Components are ordered using the 
Component Codes read from the GC. 

 The New Data Flag is reset. 

Note: 
 The chromatograph data handling for 2551 and 2350 Euro 

chromatograph types is identical.  

 In the following description, the time-out period for the GC to 
respond is dictated by the Timeout and Retry Limit values 
configured in the chromat Modbus map Properties.  

Table K-2. Euro Stages 

 Stage Description 
1 POLL IDLE Set next stage to POLL STAT PRE-

REP. 
2 POLL STAT PRE-REP Wait Poll Delay, then set the flag for the 

Modbus master process to poll for status 
data at addresses 3041 to 3061 (CHR 
REQ. STAT 1). 
Set next stage to WAIT STAT PRE-REP.  
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 Stage Description 
3 WAIT STAT PRE-REP Wait up to the time-out period for the GC 

to respond. If no reply has been received 
then set the CHROM TELEM RX FAIL 
alarm and set the stage to POLL IDLE.  
If  a reply has been received and the 
New Data Flag is set and the 
Analysis/Calibration Flag is indicating 
Analysis and the last analysed GC 
stream matches the S600+ stream*, then 
set the stage to POLL CODES. 
If  a reply has been received and the 
New Data Flag is set and the 
Analysis/Calibration Flag is indicating 
Analysis and the last analysed GC 
stream does not match the S600+ 
stream* and the delay for non-matched 
reset is non-zero, then set the stage to 
NONE MTCH DELAY. 
If  a reply has been received and the 
New Data Flag is set and the 
Analysis/Calibration Flag is indicating 
Analysis and the last analysed GC 
stream does not match the S600+ 
stream* and the delay for non-matched 
reset is zero, then set the stage to POLL 
IDLE. 
If  a reply has been received and the 
New Data Flag is set and the 
Analysis/Calibration Flag is indicating 
Calibration, then set the stage to NONE 
MTCH RESET REP. 
If  a reply has been received and New 
Data Flag is clear, then set the stage to 
POLL IDLE.  
* For Station handling, S600+ stream = 0 
will accept all GC streams. For stream 
handling, S600+ stream must match GC 
stream. 

4 POLL CODES  Wait  ~1 second, then flag the Modbus 
master to poll for the component codes 
at addresses 3001 to 3016 (CHR REQ. 
CODES) and set the next stage to WAIT 
CODES.  

5 WAIT CODES Wait up to the time-out period for the GC 
to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE.  
If  a reply has been received, then set the 
stage to POLL MOLES.  

6 POLL MOLES Wait ~1 second, then flag the Modbus 
master to poll for the mole percentage 
results at addresses 7000 to 7016 (CHR 
REQ. MOLE) and set the next stage to 
WAIT MOLES.  
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 Stage Description 
7 WAIT MOLES  Wait up to the time-out period for the GC 

to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE.  
If  a reply has been received, then set the 
stage to POLL CV. 

8 POLL CV Wait ~1 second, then set the flag for the 
Modbus master to poll for CV and other 
auxiliary data at addresses 7033 to 7039 
and 7087 (CHR REQ. CV). Set the next 
stage to WAIT CV. 

9 WAIT CV Wait up to the time-out period for the GC 
to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE.  
If  a reply has been received, then set the 
next stage to POST REP POLL STAT.  

10 FORCE IMMED RESET Currently reserved 
11 POST REP POLL STAT Wait ~1 second, then set the flag for the 

Modbus master to poll for status data at 
addresses 3041 to 3061 (CHR REQ. 
STAT 1). 
Set next stage to POST REP WAIT 
STAT. 

12 POST REP WAIT STAT  Wait up to the time-out period for the GC 
to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE. 
If  a reply has been received and the 
Analysis/Calibration Flag is indicating 
Analysis and the last analysed GC 
stream matches the S600+ stream, then 
set the stage to PROCESS DATA.  
Otherwise, set the next stage to POLL 
IDLE. 
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 Stage Description 
13 PROCESS DATA 1. Reorder the received raw mole 

percentages into S600+ internal 
order using the received component 
codes, starting at 100. 

2. If  configured to do so, check low/high 
and deviation limits. 

3. If  configured to do so, normalise the 
reordered mole percentage set. 

4. If  enabled, apply the additionals. 
5. If  enabled (or dictated by component 

code), apply splits to CX+ 
component. 

6. Copy the processed mole 
percentage set into the CHR ADJ. 
MOLES set. 

7. If  enabled, perform critical alarm 
checks. 

8. If  enabled, perform non-critical alarm 
checks. 

9. If  there are no limit, critical, non-
critical or deviation alarms, then 
mark the analysis as good, copy the 
fully processed mole percentage set 
into CHR GOOD MOLES, copy the 
reordered mole percentages from 
Step 1 into CHR ORDERED 
MOLES, update auxiliary data, and 
update the Last Analysis Time. 

Set next stage to POST REP DELAY. 
14 POST REP DELAY  Wait up to the specified time (delay for 

matched report reset, CHR RF 
DELAY1), then set the flag for the 
Modbus master to poll for status data at 
addresses 3041 to 3061 (CHR REQ. 
STAT 1). Set next stage to PRE-RESET 
WAIT STAT. 

15 PRE-RESET WAIT STAT Wait up to the time-out period for the GC 
to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE.  
If  a reply has been received and the 
New Data Flag is set and the 
Analysis/Calibration Flag is indicating 
Analysis and the last analysed GC 
stream matches the S600+ stream, then 
set the stage to RESET REPORT.  
Otherwise, set the next stage to POLL 
IDLE. 

16 RESET REPORT  Wait ~1 second, then set the flag for the 
Modbus master process to reset the New 
Data Flag at address 3058 (CHR REQ. 
RESET). Set the next stage to WAIT 
RESET. 
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 Stage Description 
17 WAIT RESET Wait up to the time-out period for the GC 

to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE.  
If  a reply has been received, then set the 
next stage POLL IDLE. This is the last 
stage of the normal data acquisition 
cycle.   

18 NONE MTCH DELAY Wait up to the specified time (delay for 
non-matched report reset, CHR RF 
DELAY2), then set the flag for the 
Modbus master to poll for status data at 
addresses 3041 to 3061 (CHR REQ. 
STAT 1). Set next stage to NONE MTCH 
WAIT STAT. 

19 NONE MTCH WAIT STAT  Wait up to the time-out period for the GC 
to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE.  
If  a reply has been received and the 
New Data Flag is set and the 
Analysis/Calibration Flag is indicating 
Analysis and the last analysed GC 
stream does not match the S600+ 
stream, then set the stage to NONE 
MTCH RESET REP.  
Otherwise, set the next stage to POLL 
IDLE.  

20 NONE MTCH RESET REP Wait ~1 second, then set the flag for the 
Modbus master process to reset the New 
Data Flag at address 3058 (CHR REQ. 
RESET). Set the next stage to NONE 
MTCH WAIT RESET. 

21 NONE MTCH WAIT 
RESET  

Wait up to the time-out period for the GC 
to respond. If no reply has been 
received, then set the CHROM TELEM 
RX FAIL alarm and set the stage to 
POLL IDLE. 
If  a reply has been received, then set the 
next stage to POLL IDLE. This is the last 
stage of the cycle where a new report 
has been f lagged by is not assigned to 
this S600+ station or stream. 

K.3.4 USA Stages  
The GC telemetry sequence for the chromat types 2251 USA and 2350 
USA is described below. The main features of the sequence are: 

 The GC is constantly polled for Status Data. The Address Range 
polled is different from the EURO types. 

 If the Last Analysis Start Time Minute has changed and the 
Analysis/Calibration Flag is indicating Analysis and the last 
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analysed GC stream matches the S600+ stream, then further polls 
will be issued for analysis data. 

 The analysis data is processed and validated (see Section K.4, 
Composition Processing). Components are ordered using the 
Component Codes read from the GC. 

Note: 
 The chromatograph data handling for 2251 and 2350 USA 

chromatograph is identical. 

 In the following description, the time-out period for the GC to 
respond is dictated by the Timeout and Retry Limit values 
configured in the chromat Modbus map Properties.  

Table K-3. USA Stages 

 Stage Description 
1 POLL IDLE Set next stage to POLL STAT PRE-

REP. Then set the f lag for the Modbus 
master process to poll for status data at 
addresses 3033 to 3059 (CHR REQ. 
STAT 2). 

2 POLL STAT PRE-REP Wait up to the time-out period for the GC 
to respond. If no reply has been received 
then set the f lag for the Modbus master 
process to poll for status data at 
addresses 3033 to 3059 (CHR REQ. 
STAT 2). If  no reply is received after 4 
attempts set the CHROM TELEM RX 
FAIL alarm and set the stage to POLL 
IDLE. 
If  a reply has been received and the 
Last Analysis Start Time Minute has 
changed and the Analysis/Calibration 
Flag is indicating Analysis and the last 
analysed GC stream matches the S600+ 
stream*, then flag the Modbus master to 
poll for the component codes at 
addresses 3001 to 3016 (CHR REQ. 
CODES) and set the next stage to POLL 
CODES. 
* For Station handling, S600+ stream = 0 
will accept all GC streams. For stream 
handling, S600+ stream must match GC 
stream. 
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 Stage Description 
3 POLL CODES Wait up to the time-out period for the GC 

to respond. If no reply has been received 
then set the f lag for the Modbus master 
process to poll for the component codes 
at addresses 3001 to 3016 (CHR REQ. 
CODES). If  no reply is received after 4 
attempts set the CHROM TELEM RX 
FAIL alarm and set the stage to POLL 
IDLE. 
If  a reply has been received, then flag 
the Modbus master to poll for the mole 
percentage results at addresses 7000 to 
7016 (CHR REQ. MOLE) and set the 
next stage to POLL MOLES.  

4 POLL MOLES Wait up to the time-out period for the GC 
to respond. If no reply has been received 
then set the f lag for the Modbus master 
process to poll for mole percentage 
results at addresses 7000 to 7016 (CHR 
REQ. MOLE). If  no reply is received after 
4 attempts set the CHROM TELEM RX 
FAIL alarm and set the stage to POLL 
IDLE. 
If  a reply has been received, then flag 
the Modbus master to poll for the CV and 
other auxiliary data at addresses 7033 to 
7039 and 7087 (CHR REQ. CV) and set 
the next stage to POLL CV.   

5 POLL CV  Wait up to the time-out period for the GC 
to respond. If no reply has been received 
then set the f lag for the Modbus master 
process to poll for CV and other auxiliary 
data at addresses 7033 to 7039 and 
7087 (CHR REQ. CV). If  no reply is 
received after 4 attempts set the 
CHROM TELEM RX FAIL alarm and set 
the stage to POLL IDLE. 
If  a reply has been received, then flag 
the Modbus master to poll for the status 
data at addresses 3033 to 3059 (CHR 
REQ. STAT 2) and set the next stage to 
POST REP POLL STAT. 
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 Stage Description 
6 POST REP POLL STAT Wait up to the time-out period for the GC 

to respond. If no reply has been received 
then set the f lag for the Modbus master 
process to poll for status data at 
addresses 3033 to 3059 (CHR REQ. 
STAT 2). If  no reply is received after 4 
attempts set the CHROM TELEM RX 
FAIL alarm and set the stage to POLL 
IDLE. 
If  a reply has been received and the 
Last Analysis Start Time Minute has not 
changed, then set the stage to 
PROCESS DATA. 
If  a reply has been received and the 
Last Analysis Start Time Minute has 
changed, then set the stage to POLL 
IDLE. 

7 PROCESS DATA 1. Reorder the received raw mole 
percentages into S600+ internal 
order using the received component 
codes, starting at 100. If received 
component code is less than 100, 
add 100 before processing.* 

2. If  configured to do so, check low/high 
and deviation limits. 

3. If  configured to do so, normalise the 
reordered mole percentage set. 

4. If  enabled, apply the additionals. 
5. If  enabled (or dictated by component 

code), apply splits to CX+ 
component. 

6. Copy the processed mole 
percentage set into the CHR ADJ. 
MOLES set. 

7. If  enabled, perform critical alarm 
checks. 

8. If  enabled, perform non-critical alarm 
checks. 

9. If  there are no limit, critical, non-
critical or deviation alarms, then 
mark the analysis as good, copy the 
fully processed mole percentage set 
into CHR GOOD MOLES, copy the 
reordered mole percentages from 
Step 1 into CHR ORDERED 
MOLES, update the RD and CV, and 
update the Last Analysis Time. 

Set next stage to POLL IDLE. 
* Note: USA option is incompatible with 
using component code 0 for unused 
components in the GC. 

 



Config600 Configuration Software User Manual 

K-20 Gas Composition Revised January 2023 

K.3.5 Siemens Stages  
The GC telemetry sequence for the chromat type SIEMENS is 
described below. The main features of the sequence are: 

 The GC is alternately polled for Status Data and New Data Flag. 
 If the New Data Flag is set, then further polls will be issued for 

analysis data. 
 The analysis data is processed and validated (see Section K.4, 

Composition Processing). Components are ordered using the Mole 
Order entered by the user. 

Note: 
 Config600 does not generate the correct Modbus map file for the 

Siemens type GC. The data handling module sets flags to poll 
Modbus registers. The Modbus map must be configured by the user 
in Modbus Editor. Refer to How To 197. 

 In the following description, the time-out period for the GC to 
respond is dictated by the Timeout and Retry Limit values 
configured in the chromat Modbus map Properties.  

Table K-4. Siemens Stages 

 Stage Description 
1 POLL IDLE Alternate setting the flags for the Modbus 

master process to poll the GC for status 
data (CHR REQ. STAT 1) and New Data 
Flag (CHR REQ. CODES). Then set next 
stage to POLL STAT PRE-REP. 

2 POLL STAT PRE-REP Wait up to the time-out period for the GC 
to respond. If no reply is received set the 
CHROM TELEM RX FAIL alarm and set 
the stage to POLL IDLE. 
When polling for New Data Flag: 
If  a reply has been received and the 
New Data Flag has changed to >= 1, 
then f lag the Modbus master to poll for 
the mole percentage results, CV and 
other auxiliary data (CHR REQ. MOLE) 
and set the next stage to POLL MOLES. 
If  a reply has been received and the 
New Data Flag has not changed, then 
set the next stage to POLL IDLE. 
When polling for status data: 
If  a reply has been received and 
Analyzer Status value < 600, then raise 
CHROM TELEM CRITICAL alarm and 
set the next stage to POLL IDLE. 
If  a reply has been received and 
Analyzer Status value >= 600, then set 
the next stage to POLL IDLE. 
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 Stage Description 
3 POLL MOLES Wait up to the time-out period for the GC 

to respond. If no reply is received set the 
CHROM TELEM RX FAIL alarm and set 
the stage to POLL IDLE. 
If  a reply has been received, then set the 
next stage to PROCESS DATA.   

4 PROCESS DATA If  the last analysed GC stream matches 
the S600+ stream*, then process the 
received GC data: 
1. Reorder the received raw mole 

percentages into S600+ internal 
order using the Mole Order entered 
in S600+. 

2. If  configured to do so, check low/high 
and deviation limits. 

3. If  configured to do so, normalise the 
reordered mole percentage set. 

4. If  enabled, apply the additionals. 
5. If  enabled (or dictated by component 

code), apply splits to CX+ 
component. 

6. Copy the processed mole 
percentage set into the CHR ADJ. 
MOLES set. 

7. If  enabled, perform critical alarm 
checks. 

8. If  there are no limit, critical, or 
deviation alarms, then mark the 
analysis as good, copy the fully 
processed mole percentage set into 
CHR GOOD MOLES, copy the 
reordered mole percentages from 
Step 1 into CHR ORDERED 
MOLES, update the auxiliary data, 
and update the Last Analysis Time. 

Set next stage to POLL IDLE. 
* For Station handling, S600+ stream = 0 
will accept all GC streams. For stream 
handling, S600+ stream must match GC 
stream. 

K.3.6 Generic Stages  
The GC telemetry sequence for the chromat type GENERIC is 
described below. The main features of the sequence are: 

 The GC is constantly polled for Status Data. 
 If the New Data Flag is set, then further polls will be issued for 

analysis data. 
 The New Data Flag is reset. 
 The analysis data is processed and validated (see Section K.4, 

Composition Processing). Components are ordered using the Mole 
Order entered by the user. 
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Note: 
 By default, Config600 will use the 2551/2350 EURO Modbus map 

file for the Generic type GC. If a different map is required, it must 
be configured by the user in Modbus Editor. Refer to How To 158. 

 In the following description, the time-out period for the GC to 
respond is dictated by the Timeout and Retry Limit values 
configured in the chromat Modbus map Properties.  

Table K-5. Generic Stages 

 Stage Description 
1 POLL IDLE Set the f lag for the Modbus master 

process to poll for status data (CHR 
REQ. STAT 1). 
Set next stage to POLL STAT PRE-
REP. 

2 POLL STAT PRE-REP Wait up to the time-out period for the GC 
to respond. If no reply has been received 
then set the RX FAIL alarm and set the 
stage to POLL IDLE. 
If  a reply has been received and the 
New Data Flag is set, then flag the 
Modbus master to poll for the mole 
percentage (CHR REQ. MOLE) and set 
the stage to POLL MOLES. 
If  a reply has been received and the 
New Data Flag is not set, then set the 
stage to POLL IDLE. 

4 POLL MOLES Wait up to the time-out period for the GC 
to respond. If no reply is received set the 
RX FAIL alarm and set the stage to 
POLL IDLE. 
If  a reply has been received, then flag 
the Modbus master to poll for the CV and 
other auxiliary data (CHR REQ. CV) and 
set the next stage to POLL CV.   

5 POLL CV  Wait up to the time-out period for the GC 
to respond. If no reply has been received 
then set the RX FAIL alarm and set the 
stage to POLL IDLE. 
If  a reply has been received, then flag 
the Modbus master to reset the New 
Data Flag at address 3058 (CHR REQ. 
RESET) and set the next stage to 
FORCE IMMED RESET. 

6 FORCE IMMED RESET Wait up to the time-out period for the GC 
to respond. If no reply has been received 
then set the RX FAIL alarm and set the 
stage to PROCESS DATA. 
If  a reply has been received then set the 
stage to PROCESS DATA. 
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 Stage Description 
7 PROCESS DATA If  the last analysed GC stream matches 

the S600+ stream*, then process the 
received GC data: 
1. Reorder the received raw mole 

percentages into S600+ internal 
order using the Mole Order entered 
in S600+. 

2. If  configured to do so, check low/high 
and deviation limits. 

3. If  configured to do so, normalise the 
reordered mole percentage set. 

4. If  enabled, apply the additionals. 
5. If  enabled (or dictated by component 

code), apply splits to CX+ 
component. 

6. Copy the processed mole 
percentage set into the CHR ADJ. 
MOLES set. 

7. If  enabled, perform critical alarm 
checks. 

8. If  enabled, perform non-critical alarm 
checks. 

9. If  there are no limit, critical, non-
critical or deviation alarms, then 
mark the analysis as good, copy the 
fully processed mole percentage set 
into CHR GOOD MOLES, copy the 
reordered mole percentages from 
Step 1 into CHR ORDERED 
MOLES, update the auxiliary data, 
and update the Last Analysis Time. 

Set next stage to POLL IDLE. 
* For Station handling, S600+ stream = 0 
will accept all GC streams. For stream 
handling, S600+ stream must match GC 
stream. 

K.4 Composition Processing 
This section details how the raw composition values are processed, and 
the checks performed before the data can be copied to the CHR 
SELECT MOLES and used in subsequent calculations. 

K.4.1 Component Ordering  
Component ordering is carried out on the raw composition values read 
from the chromat. The chromat logic orders the raw values from the 
Modbus map, to give the correct component values in the flow 
computer. 
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EURO & USA  For the EURO and USA chromat types, the raw values read from the 
chromat are ordered according to the component codes contained in 
the CHR CODES array. This array would normally be read from the 
chromat using addresses 3001-3016 on the Modbus map. The table of 
recognised component codes is shown in Table K-6. Component 
Codes. 
The field of the CHR CODES array gives the component code of the 
raw component percentage in the corresponding field of the CHR 
RAW MOLES array, normally read from the chromat using 
addresses 7001-7016 on the Modbus map. E.g.: 
 If CHR CODES FIELD 01 = 100, the percentage value at CHR 

RAW MOLES FIELD 01 will be assigned to Methane in the flow 
computer component set. 

 If CHR CODES FIELD 05 = 114, the percentage value at CHR 
RAW MOLES FIELD 05 will be assigned to Nitrogen in the flow 
computer component set. 

Note: 
 Any value of component code not included in Table K-6. 

Component Codes will result in the corresponding field of CHR 
RAW MOLES being ignored. 

 For the USA option, if the value of component code read is less 
than 100, the S600+ will add 100 before applying the component 
codes in Table K-6. Component Codes. This means that 
component codes less than 100 must not be used for unused 
component addresses. 

Table K-6. Component Codes 

 

Code Component  Code Component 
100 METHANE  114 NITROGEN 
101 ETHANE  115 CO 
102 PROPANE  116 OXYGEN 
103 I_BUTANE  117 CO2 
104 N_BUTANE  119 NONANE 
105 I_PENTANE  120 OCTANE 
106 N_PENTANE  125 DECANE 
107 NEO_PENTANE  139 HEXANE 
108 C6_PLUS (47/35/17)  140 H2S 
109 C6_PLUS (50/50/0)  144 H2O 
110 C6_PLUS (50/25/25)  145 HEPTANE 
111 C6_PLUS (57/28/14)  146 ARGON 
112 HYDROGEN  150 CX_PLUS (C9) 
113 HELIUM  151 CX_PLUS (C8) 

   152 CX_PLUS (C7) 
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Note: Before splits are applied, C6+ codes are assigned to the 
C6_PLUS field, C7+/C8+/C9+ codes are assigned to the 
CX_PLUS field.  

 
SIEMENS & GENERIC For the SIEMENS and GENERIC chromat type, the order of 

components is defined by the values entered in the MOLE ORDER 
array.  
The value entered for each component corresponds to its position in 
the CHR RAW MOLES array on the Modbus map. If 1 is entered in 
the MOLE ORDER field for Methane, the value of CHR RAW 
MOLES, FIELD 01 will be assigned to Methane. If 14 is entered for 
CO2, the value of CHR RAW MOLES, FIELD 14 will be assigned 
to CO2. 

K.4.2 High/Low Limits 
The various gas composition sets are verified against high and low 
limits when they change in value. 

KEYPAD, DOWNLOAD & 
USER  

If the Check Limits option is enabled: 

 Check all components, plus the calculated component total, 
against the corresponding high and low limits, unless the limit 
value equals 0. 

If the Check Limits option is not enabled: 

 Check the calculated component total against the default high 
limit (102%) and low limit (98%). 

If the check fails, reject the new composition set and raise the 
relevant alarm, if enabled: 

 For the Keypad set, MOLE SELECT K_COMP. 

 For the Download set, MOLE SELECT DL COMP. 

 For the User set, MOLE SELECT USER COMP 

 
CHROMAT When a new analysis becomes available from the chromat, the 

ordered set (before normalisation, splits or additionals are applied) is 
verified against high and low limits. 
If the Check Limits option is enabled: 

 Check all components, plus the calculated component total, 
against the corresponding high and low limits, unless the limit 
value equals 0. 

 Check the field used to read the Un-Normalised Total from the 
chromat against the TOTAL high and low limits, unless the limit 
value equals 0. 
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If the Check Limits option is not enabled: 

 Check the calculated component total against the default high 
limit (100.5%) and low limit (99.5%). 

If the check fails, reject the new composition set and raise the 
relevant alarm, if enabled: 

 If a component or total is less than the low limit, CHROM 
TELEM MOLE LO. 

 If a component or total is greater than the high limit, CHROM 
TELEM MOLE HI. 

Note: 
 For the GENERIC chromat type, the flow computer does not 

calculate the component total, but uses the Un-normalised Total 
read from the chromat as the calculated total. 

 For the SIEMENS chromat type, the flow computer does 
calculate the component total, but does not check the Un-
normalised Total read from the chromat. 

K.4.3 Deviation  
When a new analysis becomes available from the chromat, the ordered 
set (before normalisation, splits or additionals are applied) can be 
verified against deviation limits. 

If the Check Deviation option is enabled and a valid analysis has been 
received from the chromat following a cold start of the flow computer: 

 Check all components, plus the calculated component total, against 
the corresponding deviation limits, unless the limit value equals 0. 

If the absolute value of the difference between the new component and 
the component from the last valid analysis is greater than the deviation 
limit, the check fails. The following alarm is raised, if enabled: 

 CHROM TELEM MOLE DV. 

K.4.4 Normalisation 
When a new analysis becomes available from the chromat, the ordered 
set can be normalised to force the sum of the components to equal 
100%. Normalisation can also be applied to the keypad set. 

Normalisation is configured using Acceptance Type (configured on the 
Station Gas Composition and Stream Gas Composition screens in 
PCSetup). The following options are available: 

ACC/COPY  No normalisation is carried out. 
ACC/NORM & 
AUTO/NORM 

 Normalisation is carried out. 

Normalisation is carried out by calculating a Normalisation Factor 
(NF): 
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𝑁𝑁𝑁𝑁 = 100 �𝐶𝐶𝐴𝐴�  

where ∑ 𝐶𝐶𝐴𝐴 is the sum of the un-normalised components mol %. 

Each normalised component (𝐶𝐶𝐵𝐵) is then calculated using: 

𝐶𝐶𝐵𝐵 = 𝑁𝑁𝑁𝑁 ∗ 𝐶𝐶𝐴𝐴 

K.4.5 Additionals 
When a new analysis becomes available from the chromat, it is 
possible to apply additional components to the set. These are 
components that are not available from the chromat analysis but are 
available from a laboratory analysis.  

In PCSetup, these are entered under Mole Additionals, with H2S, H2O, 
Helium, Oxygen, CO (Carbon Monoxide) and Hydrogen available for 
entry.  
It is assumed that the entered additional components are already 
normalised, but the existing components must be adjusted to ensure 
that the sum of all components is equal to 100%. An additionals 
Normalisation Factor (𝑁𝑁𝑁𝑁𝑎𝑎𝑎𝑎𝑎𝑎) is calculated: 

𝑁𝑁𝑁𝑁𝑎𝑎𝑎𝑎𝑎𝑎 = �100 −�𝐶𝐶𝑎𝑎𝑎𝑎𝑎𝑎� 100�  

where ∑ 𝐶𝐶𝑎𝑎𝑎𝑎𝑎𝑎 is the sum of the additional components. 

Each non-additional component (𝐶𝐶𝐶𝐶) is then calculated using: 

𝐶𝐶𝐶𝐶 = 𝑁𝑁𝑁𝑁𝑎𝑎𝑎𝑎𝑎𝑎 ∗ 𝐶𝐶𝐴𝐴/𝐵𝐵 

Where 𝐶𝐶𝐴𝐴/𝐵𝐵 is the normalised component set, or the un-normalised set 
if normalisation has not been applied. 

If an additionals component is outside of the low or high limit, an 
additionals component is also present in the composition set from the 
chromat, or an additionals component is also defined in the Mole Splits 
set, the MOLE SELECT ADDNLS alarm will be raised. When a new 
analysis becomes available from the chromat, the CHROM TELEM 
CONFIG alarm will be raised and the analysis will be rejected. 

K.4.6 Splits 
If the chromat analysis provides a component that describes the 
combined mol % of heavier alkanes (C6+, C7+, C8+ or C9+), it is 
possible to split this component into individual components (hexane, 
heptane, octane, nonane and decane). Before splits are applied, C6+ 
codes (108-111) are assigned to the C6_PLUS field, C7+/C8+/C9+ 
codes (150-152) are assigned to the CX_PLUS field. 

Splits are configured in PCSetup using the Apply Splits selection and 
the Mole Splits set. The options for Apply Splits are described below. 
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NO SPLITS For GENERIC and SIEMENS chromat types: 
If a component is assigned to C6_PLUS in the Mole Order array it is 
copied to hexane and C6_PLUS is zeroed in the adjusted component 
set. 
If a component is assigned to CX_PLUS in the Mole Order array it is 
copied to heptane and CX_PLUS is zeroed in the adjusted 
component set. 
For EURO and USA chromat types:  
The value assigned to the C6_PLUS component field will be split 
according to the C6_PLUS component code: 
 
𝐶𝐶𝐷𝐷𝐻𝐻𝐻𝐻𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶

𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑁𝑁𝐻𝐻𝐻𝐻𝐻𝐻 

𝐶𝐶𝐷𝐷𝐻𝐻𝐻𝐻𝑃𝑃𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑁𝑁𝐻𝐻𝐻𝐻𝑃𝑃 

𝐶𝐶𝐷𝐷𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑁𝑁𝑂𝑂𝐶𝐶𝐻𝐻 

 

C6_PLUS Code 𝑭𝑭𝑯𝑯𝑯𝑯𝑯𝑯 𝑭𝑭𝑯𝑯𝑯𝑯𝑯𝑯 𝑭𝑭𝑶𝑶𝑶𝑶𝑶𝑶 
108 0.47466 0.3534 0.17194 
109 0.5 0.5 0.0 
110 0.5 0.25 0.25 
111 0.57143 0.28572 0.14285 

 
The output value of the C6_PLUS component will be set to 0.0%. 

The value assigned to the CX_PLUS component field will be 
assigned to a particular component according to the CX_PLUS 
component code: 

CX_PLUS Code 𝐶𝐶𝐷𝐷𝐻𝐻𝐻𝐻𝑃𝑃𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 𝐶𝐶𝐷𝐷𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 𝐶𝐶𝐷𝐷𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 𝐶𝐶𝐷𝐷𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 
150 0.0% 0.0% 𝐶𝐶𝐶𝐶

𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 0.0% 

151 0.0% 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 0.0% 0.0% 

152 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 0.0% 0.0% 0.0% 

 

The output value of the CX_PLUS component will be set to 0.0%. 

 

C6PLUS When Apply Splits = C6PLUS, the value assigned to the C6_PLUS 
component field will be split using the entered Mole Splits values. 
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Figure K-1. Gas Composition – MOLE SPLITS 

𝐶𝐶𝐷𝐷𝐻𝐻𝐻𝐻𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝐻𝐻𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐻𝐻𝐻𝐻𝑃𝑃𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝐻𝐻𝑃𝑃𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶6_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

The output value of the C6_PLUS component will be set to 0.0%. 

C7PLUS When Apply Splits = C7PLUS, the value assigned to the CX_PLUS 
component field will be split using the entered Mole Splits values. 
𝐶𝐶𝐷𝐷𝐻𝐻𝐻𝐻𝑃𝑃𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶

𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝐻𝐻𝑃𝑃𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

The output value of the CX_PLUS component will be set to 0.0%. 
C8PLUS When Apply Splits = C8PLUS, the value assigned to the CX_PLUS 

component field will be split using the entered Mole Splits values. 
𝐶𝐶𝐷𝐷𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶

𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝑂𝑂𝐶𝐶𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

The output value of the CX_PLUS component will be set to 0.0%. 
C9PLUS When Apply Splits = C9PLUS, the value assigned to the CX_PLUS 

component field will be split using the entered Mole Splits values. 
𝐶𝐶𝐷𝐷𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶

𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐻𝐻𝑂𝑂𝐻𝐻𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

𝐶𝐶𝐷𝐷𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 = 𝐶𝐶𝐶𝐶
𝐶𝐶𝐻𝐻_𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 ∗ 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆%𝐷𝐷𝐻𝐻𝐶𝐶𝐴𝐴𝐻𝐻𝐻𝐻 ∗ 0.01 

The output value of the CX_PLUS component will be set to 0.0%. 
C10PLUS Not used (treated as NO SPLITS). 

 

If Apply Splits = C6PLUS but heavier alkanes are assigned to the 
CX_PLUS field, no split processing will take place. The same applies 
if Apply Splits = C7/8/9PLUS but heavier alkanes are assigned to the 
C6_PLUS field. 
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If the sum of the Mole Splits does not equal 100%, the MOLE 
SELECT SPLITS alarm will be raised. When a new analysis becomes 
available from the chromat, the CHROM TELEM CONFIG alarm will 
be raised and the analysis will be rejected. 

K.4.7 Critical Alarms 
When a new analysis becomes available from the chromat, it is 
possible to check if Critical alarms are being indicated by the chromat. 
This is configured in PCSetup using the Check Critical Alarms 
selection. 

When the check is enabled, for the chromat types EURO, USA and 
GENERIC, two fields read from the chromat via Modbus are evaluated 
for the statuses of specified bits, as shown in the following table (fields 
belong to CHR REGISTERS array): 

TYPE Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

EURO 
Field 06  x x x    x x   x x x x x 

Field 07            x x  x  

USA 
Field 14 x x               

Field 15              x  x 

GENERIC 
Field 06  x               

Field 07              x   

 

For the EURO and USA default Modbus maps, the two fields are used 
to read addresses 3046 and 3047. 

For chromat type SIEMENS, the value of Field 01 of the CHR 
REGISTERS array, read from the chromat via Modbus is used to 
check for Critical alarm status. If the value of this field is < 600, this is 
taken to indicate critical alarms. 
For all chromat types, if Critical alarms are indicated then the new 
analysis will be rejected. The following alarm is raised, if enabled: 
 CHROM TELEM CRITICAL. 

K.4.8 Non-Critical Alarms 
When a new analysis becomes available from the chromat, it is 
possible to check if Non-Critical alarms are being indicated by the 
chromat. This is configured in PCSetup using the Check Non Critical 
Alarms selection. 
When the check is enabled, for the chromat types EURO, USA and 
GENERIC, two fields read from the chromat via Modbus are evaluated 
for the statuses of specified bits, as shown in the following table (fields 
belong to CHR REGISTERS array): 

 



Config600 Configuration Software User Manual 

Revised January 2023 Gas Composition K-31 

TYPE Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

EURO 
Field 06 x    x x x          

Field 07              x  x 

USA 
Field 14           x x x x   

Field 15             x    

GENERIC 
Field 06           x x x x   

Field 07                 

 

For the EURO and USA default Modbus maps, the two fields are used 
to read addresses 3046 and 3047. 

For chromat type SIEMENS, there is no check for Non-Critical alarms. 

If Non-Critical alarms are indicated then the new analysis will be 
rejected. The following alarm is raised, if enabled: 

 CHROM TELEM NCRITICAL. 

K.4.9 Timeouts  
The following timeout values are available (dependent on the 
configuration selections made): 

Analysis Timeout – this is enterable via PCSetup and is also 
changeable for a running configuration (if configured on a display). It 
specifies the maximum time (in seconds) that the S600+ will wait to 
receive a new composition from the GC before raising an alarm. If it is 
set to 0, then no timeout checks are performed.  

Download Timeout – this is enterable via PCSetup and is also 
changeable for a running configuration (if configured on a display). It 
specifies the maximum time (in minutes) that the S600+ will wait to 
receive a new composition from the supervisory computer before 
raising an alarm. If it is set to 0, then no timeout checks are performed. 
(See Section K.11.5, Download Flag for details of how to configure the 
Download Flag to prevent the Download Timeout alarm when the 
Download composition set does not change). 

K.5 Auxiliary Data 
Additional data items may also be available from a GC (other than 
mol% data). These are requested once the composition data has been 
received using the POLL CV telemetry message trigger. (For the 
SIEMENS type, the POLL CV trigger is not set, so the request for 
Auxiliary Data should use the POLL MOLES trigger). 
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K.5.1 EURO (2551 / 2350 EURO) + USA (2251 / 2350 USA) 
The auxiliary data is located at the following Modbus addresses: 

7033 – Dry Superior CV – This is read into CHR RAW MISC (FIELD 
01) and by default this is copied to the REAL CV Object 
CALC2 field 

7034 – Saturated Superior CV – This is read into CHR RAW MISC 
(FIELD 02) and is used for information purposes only 

7035 – Real Relative Density – This is read into CHR RAW MISC 
(FIELD 03) and by default this is copied to the REAL RD 
object CALC4 field 

7036 – Compressibility (Z) – This is read into CHR RAW MISC 
(FIELD 04)  and is used for information purposes only 

7037 – Superior Wobbe Index – This is read into CHR RAW MISC 
(FIELD 05)  and is used for information purposes only 

7038 – Un-Normalised Total - This is read into CHR RAW MISC 
(FIELD 06)  and is used in the composition checks detailed in 
section K4.2 

7039 – Molar Mass – This is read into CHR RAW MISC (FIELD 07)  
and is used for information purposes only 

7087 – Dry Inferior CV – This is read into CHR RAW MISC (FIELD 
21)  and by default this is copied to the REAL CV object 
CALC4 field 

K.5.2 SIEMENS + GENERIC 
The Modbus addresses that hold this data will be dependent on the GC 
model. The handling of Dry CV and Real Relative Density will be as 
above providing the Modbus map is configured to use the correct fields 
within the CHR RAW MISC database object. For GENERIC type, the 
Un-Normalised Total is used in the composition checks detailed in 
Section K.4.2, High/Low Limits.   

K.5.3 Station to Stream Copying 
For streams that take their chromat data from a Station, the Auxiliary 
data is updated according to the option chosen in Config Generator. 

Moles from Station Only In-use Station Real Relative Density is copied to CALC4 field of the 
Stream Real Relative Density (CHROMAT mode value).  
Station Superior Chromat Real CV (SUP CHROMAT mode value)  
is copied to the CALC2 field of the Stream Real CV (SUP 
CHROMAT mode value). 
Station Inferior Chromat Real CV (INF CHROMAT mode value)  is 
copied to the CALC4 field of the Stream Real CV (INF CHROMAT 
mode value). 
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Moles from Station 
Chromat 

For matching data sets (when the GC Stream read via Modbus 
matches the configured GC Stream), the Stream CHR RAW MISC 
array is updated with values from the Station CHR RAW MISC 
array. Stream Real Relative Density and Real CV are then updated as 
described in Section K.5.1, EURO (2551 / 2350 EURO) + USA (2251 
/ 2350 USA). 

K.6 Dual GC Handling 
The S600+ also has the option to have Dual GCs at station level. This 
is selected in Config Generator when configuring the station – the 
options are Single Chromat, Dual Chromat, No Chromat. Refer to 
Section 5.5, Station Gas Composition for details on the selectable 
options available. 

When Dual GC handling is selected, the S600+ always polls both 
configured GC’s and processes the composition data based on the Type 
(configured on the Station Gas Composition and Stream Gas 
Composition screens) that is selected. 
These selections are detailed below: 

K.6.1 CHROMAT A  
If Chromat A is selected, the S600+ always uses the composition data 
from GC A as a priority.  

If the link to GC A fails or the composition received is deemed invalid, 
then the composition from GC B is be used provided it is valid (refer to 
Section K.4, Composition Processing for details on the checks 
performed). 

If the composition data from both GC A and B is invalid (or both links 
have failed), then the Last Good data (or Keypad Data) is used 
(depending on the configuration selections made). 
If GC B data becomes valid, this will be used until GC A data is good, 
then GC A data will be used as a priority. 

K.6.2 CHROMAT B 
If Chromat B is selected, the S600+ always uses the composition data 
from GC B as a priority.  

If the link to GC B fails or the composition received is deemed invalid, 
then the composition from GC A is used provided it is valid (refer to 
Section K.4, Composition Processing for details on the checks 
performed). 

If the composition data from both GC A and B is invalid (or both links 
have failed), then the Last Good data (or Keypad Data) is used 
(depending on the configuration selections made). 

If GC A data becomes valid, this will be used until GC B data is good, 
then GC B data will be used as a priority. 
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K.6.3 CHROMAT AUTO  
If Chromat AUTO is selected, the S600+ alternates between using GC 
A and GC B data. The philosophy behind this is that the analysis 
cycles at the two GC’s will be offset from each other. For example, if 
each GC performs an analysis every 20 minutes and these analysis 
have a 10-minute offset from each other the S600+ would receive a 
new analysis every 10 minutes. 

GC A Analysis at 00:00. 00:20, 00:40, etc. 

GC B Analysis at 00:10. 00:30, 00:50, etc. 
S600+ new analysis at 00:00 (GC A), 00:10 (GC B), 00:20 (GC A), 
etc. 
If the link to GC A fails or the composition received is deemed invalid, 
then the composition from GC B will be used provided it is valid (refer 
to Section K.4, Composition Processing for details on the checks 
performed). 

If the link to GC B fails or the composition received is deemed invalid, 
then the composition from GC A will be used provided it is valid (refer 
to Section K.4, Composition Processing for details on the checks 
performed). 
If the composition data from both GC A and B is invalid (or both links 
have failed), then the Last Good data (or Keypad Data) is used 
(depending on the configuration selections made). 

If GC A data becomes valid, this will be used until GC B data is good, 
then the switching between GC A and GC B will restart.  

Similarly, if GC B data becomes valid, this will be used until GC A 
data is good, then the switching between GC A and GC B will restart.  

K.7 Displays 

K.7.1 Default Displays 
The displays for the GCs can be located under one of two places on the 
web server or front panel depending on how the application was 
configured. 

For applications that assign a GC to a station, then the composition 
information can be found under: 

Operator > Station n > Composition  

where n is the station number 
For applications that assign a GC to a stream, then the composition 
information can be found under: 

Operator > Stream n > Composition  

where n is the stream number 

The following table shows the items that are available in the default 
Composition displays: 
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Note: It is recommended that if splits / mol lo / mol hi / mol dev / user 
or download options are selected that these displays are added 
by the user. This can be done by using the Display Editor. For 
more information refer to Chapter 13, Display Editor.  

Item Definition 
Mole Select Selects which composition set is used. 

Details in Section K.2, Gas Composition Modes.  
Acceptance 
Command 

Used to accept a new Keypad moles composition set. 
Details in Section K.2, Gas Composition Modes. 

Keypad Moles Displays the values for the Keypad moles composition 
set. These values can be modified by the user. 

Selected 
Moles 

Displays the values for the Selected moles composition 
set (in-use).  

Telem Stage Indicates the current stage for the chromat task. 
Details in Section K.3, Chromat Telemetry. 

Telem Poll 
Delay 

Specifies the time in seconds to wait between issuing 
polls to the chromat. 
Details in Section K.3, Chromat Telemetry. 

Telem Reset 
Delay 1 

Delay before issuing a reset of the new data flag after a 
new analysis has been received and processed for a 
matching cycle stream. 
Details in Section K.3, Chromat Telemetry. 

Telem Reset 
Delay 2 

Delay before issuing a reset of the new data flag after a 
new analysis has been received and processed but the 
cycle streams do not match, for example on an analysis 
for stream 1 was expected but the chromat indicated the 
analysis was for stream 2. 
Details in Section K.3, Chromat Telemetry. 

D/Load 
Timeout 

Def ines a timeout which, when expired, raises an alarm to 
indicate that the supervisory (Modbus master) has not 
written a new Download composition set in time.  
Details in Section K.4.9, Timeouts. 

K.8 Alarms 

K.8.1 Default Alarms 
The following chromatograph alarms are available: 

Alarm Definition 
CHROM TELEM 
CONFIG 

Occurs when a new analysis is available from the GC, 
but a fault associated with the MOLE SELECT SPLITS 
or ADDNLS alarms is present. 

CHROM TELEM 
CRITICAL 

Occurs when the GC is indicating a Critical alarm. See 
Section K.4.7, Critical Alarms. 

CHROM TELEM 
MOLE DV 

Occurs when a component, or the total, of the new 
composition set from the GC is deviates from the 
previously received value by more than the limit. See 
Section K.4.3, Deviation. 

CHROM TELEM 
MOLE HI 

Occurs when a component, or the total, of the new 
composition set from the GC is higher than the high 
limit. See Section K.4.2, High/Low Limits. 
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CHROM TELEM 
MOLE LO 

Occurs when a component, or the total, of the new 
composition set from the GC is lower than the low limit. 
See Section K.4.2, High/Low Limits. 

CHROM TELEM 
NCRITICAL 

Occurs when the GC is indicating a Non Critical alarm. 
See Section K.4.8, Non-Critical Alarms. 

CHROM TELEM 
REP TOUT 

Occurs when the GC has not indicated that a new 
composition set is available within the timeout period 
specified. See Section K.4.9, Timeouts. 

CHROM TELEM 
RX FAIL 

Occurs when the timeout period for the GC to respond 
has expired. See Section K.3, Chromat Telemetry. 

DL COMP Occurs when that the downloaded set has been rejected. 
This can be because one of the components is outside the 
limits for that component or because the sum of the 
downloaded components is less than 98% or greater than 
102%.  
Note: No normalisation of a download set occurs - the 

downloaded composition is expected to already 
be normalised to 100%. 

DL T/OUT Occurs when the S600+ has not received an updated 
composition from the supervisory system within the 
conf igured Download Timeout period. 

K_COMP Occurs when the keypad entered composition is 
outside the limits set on the Gas Composition page on 
PCSetup. This check applies to the total and the 
individual components.  

MOLE DV Occurs when any component (MOLE DeViation) 
exceeds the deviation limit percentage set up in 
PCSetup on the Gas Composition page. This alarm is 
raised for the complete composition; diagnose the 
component that is in error.  

MOLE HI Occurs when any component exceeds the highest 
acceptable percentage set up in PCSetup on the Gas 
Composition page. This alarm is raised for the 
complete composition; diagnose the component that is 
in error.  

MOLE LO Occurs when any component falls below the lowest 
acceptable percentage set up in PCSetup on the Gas 
Composition page. This alarm is raised for the 
complete composition; diagnose the component that is 
in error.  

MOLE SELECT 
ADDNLS 

Occurs when an additionals component is outside of 
the low or high limit, an additionals component is also 
present in the composition set from the GC, or an 
additionals component is also defined in the Mole 
Splits set. See Section K.4.5, Additionals. 

MOLE SELECT 
DL COMP 

Occurs when a component, or the total, of the 
Download composition set is outside of the low or high 
limit. See Section K.4.2, High/Low Limits. 

MOLE SELECT 
DL T/OUT 

Occurs when the Download composition set has not 
changed within the timeout period specified. See 
Section K.4.9, Timeouts. 

MOLE SELECT 
K_COMP 

Occurs when a component, or the total, of the keypad 
entered composition set is outside of the low or high 
limit. See Section K.4.2, High/Low Limits. 

MOLE SELECT 
SPLITS 

Occurs when the entered Mole splits do not add up to 
100%. See Section K.4.6, Splits.  
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MOLE SELECT 
USER COMP 

Occurs when a component, or the total, of the User 
composition set is outside of the low or high limit. See 
Section K.4.2, High/Low Limits. 

 

K.9 Reports 

K.9.1 CHR TELEMETRY 
By default, when you select a GC, the system does not automatically 
add the GC telemetry report. You must add it manually. 
Once added the report will automatically generate every time a new 
analysis is received (and validated) from the GC. 
To configure the report: 

1. Select System Setup > Reports. The Reports screen opens.  

 

Figure K-2. Add Report – CHR TELEMETRY  

2. Click Add in the General Report section to add the report. The 
Archive Configuration screen opens. 
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Figure K-3. CHR TELEMETRY  

3. Select CHR TELEMETRY in the Archive Period field.  
4. Enter the number of reports you wish to save. 
5. Click OK when you have finished.  

When generated, the report should resemble the following example: 
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Figure K-4. Example Report – CHR TELEMETRY  

Using the Report Editor, you can modify the layout of the report. For 
more information, refer to Chapter 12, Report Editor.  

K.9.2 CHR D/LOAD 
By default, when you select downloaded moles, the system does not 
automatically add the download report. You must add it manually. 

Once added it will automatically generate every time a new 
composition is downloaded from the supervisory. 

To configure the report: 
1. Select System Setup > Reports. The Reports screen opens.  
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Figure K-5. Add Report – CHR D/LOAD  

2. Click Add in the General Reports section to add the report. The 
Archive Configuration screen opens. 

 

Figure K-6. CHR D/LOAD  

3. Select CHR D/LOAD from the list.  
4. Select the number of reports you wish to save. 
5. Click OK when you have finished.  

When generated, the report should resemble the following example: 
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Figure K-7. Example Report – CHR D/LOAD  

Using the Report Editor, you can modify the layout of the report. For 
more information, refer to Chapter 12, Report Editor.  

K.10 Modbus Maps 
This section contains examples of the Modbus Maps that PCSetup will 
generate. 

EURO / USA Types 

The auto generated map for these options is identical and contains all 
Modbus addresses for each GC. The structure of the Modbus map 
takes its definition from the standard Emerson GC Modbus maps 
(SIM_2251 and SIM_2251 UK).  The GC Type selection determines 
which of these addresses is polled for and this is handled internally 
within the S600+, using triggers for individual Modbus messages.  

Each type polls a different range of addresses for the CHR 
REGISTERS data. 
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Type Addresses Message Trigger 

EURO 3041-3061 CHR REQ.STAT 1 

USA 3033-3059 CHR REQ.STAT 2 

 

 

Figure K-8. CHR TELEMETRY  

GENERIC / SIEMENS Types 

The above map is provided by default for these GC Type options – it 
must therefore be modified in line with the specific GC requirements.  

For more information, refer to Chapter 14, Modbus Editor. 

For the required data points and message triggers, refer to How To 
document 197 for SIEMENS and 158 for GENERIC. 

K.11 User Customisation – How Tos 
The following sections describe custom changes to the flow computer 
chromat handling that can be carried out by the user using Config600. 
Some changes may involve the use of System Editor, which requires a 
Pro Licence.  
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K.11.1 SIEMENS GC 
Refer to How To 197 (available from Emerson Support) for details on 
how to configure the SIEMENS GC Type. 

K.11.2 GENERIC GC 
Refer to How To 158 (available from Emerson Support) for details on 
how to configure the GENERIC GC Type. 

K.11.3 Multi-dropped GCs 
Refer to How To 141 (available from Emerson Support) for details on 
how to configure Multi-dropped GCs on a single RS-485 link. 

K.11.4 Mole Select – Keypad Fail Switchback 
Refer to How To 231 (available from Emerson Support) for details on 
how to configure Mole Select to automatically revert to Chromat mode 
from Keypad Fail mode once a valid analysis becomes available. 
(Requires Pro Licence.) 

K.11.5 Download Flag  
Refer to How To 230 (available from Emerson Support) for details on 
how to configure the Download Flag to prevent a Download Timeout 
alarm when the Download composition set has not changed. (Requires 
Pro Licence.) 
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Appendix L – Backup Functionality 

In This Chapter 

L.1 Backup Command.................................................................... L-1 
L.2 Configuration Upload ................................................................ L-1 
L.3 PCSetup / System Editor ........................................................... L-1 
 
 
The backup functionality allows you to save user-configurable items to 
a file stored in flash memory.  

L.1 Backup Command 
On a running S600+, you can execute the backup command to store 
any changes made to user-configurable items.  

The backup command is located under Menu 5 (System Settings) / 
Page 6 (Software Status). When the system Run Mode is changed, you 
have the option of Cold Start, Warm Start, or Backup. 

 
If you select Backup, all the current settings are written to the exback 
file (which is held in flash memory).  

Note: If the running S600+ already contains an exback file, the file is 
deleted and re-created to ensure all data is stored (for example, 
from new displays). 

If the S600+ is subsequently cold started, the changes contained in the 
exback file are used to update the running machine. 

L.2 Configuration Upload 
The configuration from a running S600+ can be uploaded to a PC 
using the Transfer tools (Receive Tab). Refer to Chapter 9 – Config 
Transfer for more information. 

L.3 PCSetup / System Editor 
If an exback file exists and PCSetup or System Editor is used to open 
the configuration, the you are presented with a prompt to Synchronise 
the data. 
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Select Yes to copy data from the exback file into the existing 
configuration and then delete the exback file.  
Note: If you need to recover the original configuration, a copy of the 

deleted exback file is placed in the logs folder and renamed 
backup.log. Additionally, the entire configuration folder is 
copied before the synchronisation occurs and renamed as 
<configuration>_bkup.  

Select No to leave the exback file in the extras folder and to not 
synchronise the data. You will be prompted  to synchrinise the data 
again the next time you open the configuration unless you manually 
delete the exback file.  

L.4 Configuration Download 
The configuration can be downloaded to the S600+ using the Transfer 
tools (Send Tab). Refer to Chapter 9 – Config Transfer for more 
information. 

Note: If the exback file is still present in the extras folder when the 
configuration is downloaded (i.e., no synchronisation has 
occurred), the changes within the exback file will overwrite any 
changes made within PCSetup. 
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